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PREFACE
OBJECTIVES OF THIS BOOK
This text was developed for use in any Introductory Computer course, or Microcomputer Applications course, which focuses on using microcomputers and applications software. The text is
designed to capitalize on the advantages of working in a hands-on , laboratory environment. The
objectives of this book are:
• To provide students with hands-on, practical experience using the Apple Macintosh, as
opposed to merely discussing possible applications.
• To teach students the concepts of how to use the Apple Macintosh operating environment ,
and the major applications including:
•
•
•
•
•

Word processing
Electronic spreadsheets
Database management systems
Business graphics
Hype rCard

• To feature instruction in using today's most widely used commercial applications software
packages including MS-Word 4 .0, MS-Excel 2.2 , File Maker II and HyperCard .
• To provide stude nts with experience in solving the kinds of problems they' re likely to
e ncounte r in today's work environments.

LEVEL OF INSTRUCTION
This book is recomme nded fo r use in any educational or training environment, or for self-study.
It was developed with the one-semester Microcompute r Applications course in mind, but is
equally appropriate for use in any introductory course in compute rs. No previous experience
with computers or programming is required in order to use this book.

MAXIMUM FLEXIBILITY
This text offers coverage of the software packages which have emerged as the market leaders in
their respective applications area. I have written the book to allow flexibility with respect to the
orde r of presentation. You may wish to present applications areas in a different sequence. For
example, you may wish to introduce electronic spreadsheets before word processing. This can be
done without sacrificing continuity.

DISTINGUISHING FEATURES
A Proven Book
The evolution of this text is based on my experience teaching this course, and on the collective
experience of many instructors who have used my other books, and have shared with me their
comments and suggested improvements. I have made every effort to preserve the integrity of
those elements which proved effective in my other publications, and to improve upon those
which did not.
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Disk Included
We are pleased to include a disk which contains the work created in each chapter as it should be
when the student completes the chapter. With these files avai lable, those students who, for some
reason, diverge from the material, will be able to start a new chapter in sync with the text. This
disk also holds the stories and scrapbook files needed for the desktop publishing and database
chapters.

Extensive Actual Screen Illustrations
The instructions for using each specific software package a re fu lly supported with screen
"dumps" which exactly reflect what the stude nts' screen will look like as they execute each
target command. The book includes hundreds of these actual screen illustrations, which clarify
in detail the impact of each operation that the student performs.

Project-Driven Approach
The presentation of concepts unfolds at a measured pace, mi xing conceptual material with
reinforcement through hands-on sessions at the computer. Lasting learning correlates directly
with the amount of time spent using microcomputers in the laboratory environment. Consequently, each chapter is built around a project which serves as the vehicle fo r mastery. My
experience has been that most students will find these projects quite time-consuming. For students who move through this material quickly, you may wish to assign exercises in addition to the
project developed in the chapter. There is a wide variety of exercises at the end of every chapte r
for this purpose.

Business Problem Solving
In virtually every discipline, students need to learn how to apply the microcomputer in o rder
to solve problems. My experience has been that students typically need to know how they
would use microcompute rs, a nd applications software, in a business environme nt. For this
reason , most projects a nd exercises challenge students to solve proble ms from a busi ness
applications perspective.

What To Do-Why You Are Doing It
In contributing to the students' overall comprehension of using microcomputers a nd applications
software, this format helps students understand what actions to take in order to perform the
target function , and the reasons why.

ANCILLARY MATERIALS
A comprehensive instructor's resource package accompanies Macintosh Productivity Tools.
These ancillary materials are available upon request from Boyd & Fraser:

Instructor's Manual
Featuring:
• Lecture outlines for each chapter
• C hapter-by-chapte r objectives and vocabula ry lists
• Answers to end-of-chapte r student exercises

•
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A FINAL NOTE
I drew upon my personal resources and those of my colleagues in the search for the best
approach to the desig n of the text, the software to work with, and the information presented for
each program. While I am satisfied with the result of this effort , there is always room for
improvement. As you use this book, you will undoubtedly become aware of its strengths and
weaknesses. Please do not keep these observations to yourself. It would be greatly appreciated if
you would w rite to me with your experiences in care of Boyd & Fraser Publishing Company.
Thank you for your help, and I am looking forward to hearing from you.
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THE COMPUTER

-

CHAPTER OBJECTIVES

Upon completion of this chapter. the student will:
• Be familiar with the history and development of
computers.
• Understand the input-process-output model of
a computer.
• Understand the major differences among the
three classes of computer:
the mainframe computer
the minicomputer
the microcomputer.

-

1.1 EARLY COMPUTING

Since no wriue n or archaeological proof has been
uncovered to show o the rw ise , it is sa te to assume that
the abac us was probably the first mechanical compu tatio nal device employed by man kind . The abacus
was so easy to usc that it is still in use today in some
pa rt s of the wo rld . However, using the abacus to pe rform a rithme tic s uffe rs from a majo r lack. the inabil ity of the dev ice to sto re inte rmediate results of
complex computations.
The next major ste p toward the mode rn digita l
computer was taken by the French scientist and philosophe r, Bla ise Pascal. Pascal invented a mecha nical
adding machine. What made his machine unique

• Know what a Local Area Network is and why it
can be useful.
• Know what an input device is and be able to
give examples of several devices in common use.
• Know what an output device is and be able to
give examples of several devices in common use.
• Know what mass storage devices are and be
able to give examples of several devices in
common use.

Figure 1.1
An abacus.
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was that it used rotating geared wheels to perform the computations, with the results appearing
in a series of windows on the device.
Figure 1 .2
Pascal 's adding machine.

Figure 1 .3
The Difference Engine.

The development of the computer then languished for 200 years until Charles Babbage
arrived on the scene. Babbage was a professor of mathematics at Cambridge University in
England who wanted to produce mathematical tables more accurate than those available at the
time. In 1822 he began building a device which he called the Difference Engine, and then in
1834 Babbage began work on an Analytic
Engine.
The purpose of the Analytic Engine
was to compute any mathematical function. Babbage's design for the Analytic
Engine embodied many of the aspects
now found in modern computers, such as
memory for variables, a unit for performing computations, a method for inputting
programs and for outputting the results.
Although neither the Difference nor Analytic Engines were ever completed in his
time (the manufacturing technology of
the 1830s could not machine parts to the
tolerances he required), many consider
Babbage to be the father of modern
computing because of the ideas he proposed to use in his inventions.
The next major development in the
hi story of comput ing came about
because of a U.S. government crisis. The results of the 1880 census requi red almost eight years
to compile. It was expected that the census of 1890 would take more than ten years to hand
tabulate, providing useless information since the 1900 census would be underway before the
information for the 1890 census would be available. Herman Hollerith was an agent of the U.S.
Census Bureau at the time and responded to this crisis by inventing a code which could be
punched into cards and a machine to sort and count the cards using this code. The 1890 census
was tabulated in three years with the aid of Hollerith's machines and the Hollerith code.
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Hollerith eventually left the Census Bureau 10 form a company to ma nufactu re and sell his
tabulating machines. After merging with two other companies, Hollerith 's tabulating company
changed its name in 1924 to the International Business Machines Corporation.
Figure 1 .4
Hollerith 's tabulating
machine.

-

1 .2 ELECTRONIC COMPUTING

In the late 1930s people started working on computing machines which made use of electrical
devices rather than pu rely mechanical ones. The first electronic machine was built by John
Atanasoff and Clifford Berry, called the ABC, for Atanasoff-Berry-Computer. The ABC was
followed by Howard Aiken ·s computer in 1944, the Mark I, which used electromagnetic relays
and was a fairly slow machine.
With the outbreak of the Second World War, the military had the need for calculating
ballistic tables for artillery bombardments. John Mauchly and J. Presper Eckert, Jr. , proposed ,
then buil t with Army funding, the Electronic Numerical Integrator and Calculator, called the
ENIAC. The ENIAC contained 18.000 vacu um tubes. In relation to the Mark I, it was fast
because it had no moving parts. It could multiply two numbers in about three one-thousandths of
a second, or about 300 multiplications per second. The ENIAC did, however, weigh approximately 30 tons; it took up about 3,000 cubic feet of space, and it drew 140,000 watts of power
when in operation.
Figure 1.5
The EN/AC computer.
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The major drawback of the ENIAC was that programs were hardwired in. Thus to cha nge a
program, a worke r wou ld have to rew ire the computer.

-

1 .3 THE ELECTRONIC STORED PROGRAM

The next major breakthrough in computing came from John von Neuma nn. Yon Neuma nn
developed the concept of the internally stored program. Programs became a patte rn of zeros and
ones wh ich could be loaded into the computer's memory by using punched cards. The advantage
of this type of computer should be obvious. The computer could be reprogrammed by reentering
the punched cards, rathe r than rewiring the machine. This made program modification faster and
easie r. The compute r von Neuman n built was called the Elect ronic Discrete Variable Automatic
Computer, or EDVAC, and became operational in 1951.
While von Neumann worked on his machine, Maurice Wilkes developed the Electronic
De lay Storage Automatic Calculator, or EDSAC, at Cambridge University, England . The
EDSAC was actually operational in 1949, before von Neumann 's computer, even though it was
built based on von Neumann's principle of the stored program.

-

1 .4 COMMERCIAL COMPUTING

Figure 1.6
A Relay, a Vacuum Tube, a
Transistor a nd an
Integrated Circuit chip (IC).

While the EN IAC, EDYAC and EDSAC computers served definite pu rposes, they were essentially experimental machines. After successfully completing the EN IAC, Mauc hly and Eckert
formed their own company and designed and developed the first commercial computer, the
Universal Automatic Computer, the UNIVAC I. The UNIVAC I was placed in the U.S . Census
Bureau in 1951.
The UN IVAC I was the first of what are now considered to be "first generation., computers.
Programs and data were stored in such computers' main storage and accessed in milliseconds, or
thousandths of a second. These computers also required air conditioning a nd lots of electricity.
Members of this generation of compute rs were programmed in their own language, called
machine language. They were difficult
to p rogram . Most "knowledgeable"
people of the early 1950s felt that the
total de mand for compute rs in the
United States would not exceed ten
mac hines simila r to the UNIVAC I.
It was not until the late 1950s that
the transistor replaced the vacuum tube
in the computer, and the second generation of co mpute rs was int rod uced.
Because the transistor is smalle r, runs
coole r, and has lower power consumption than the vacuum tube, the second
generation computers we re smalle r.
They ran cooler a nd consumed less
electricity than the firs t generation
machines. The transistor was muc h
more reliable than the vacuum tube, so
the computers were less li kely to break
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down. In addition , the time required by the computer to access information in its memory
dropped from milliseconds to microseconds, or millionths of a second.
During this time, the programming languages FORTRAN (FORmula TRANslation) and
COBOL (COmmon Business Oriented Language) were developed. These languages were a major
breakthrough in that they greatly simplified the task of the programmer and reduced the time
required to write and debug a program . The programs in these languages were run th rough a
special program, called a compiler, which turned what the programmer wrote into the machine
language required by the computer. The third generation of computers became available in the mid1960s with the introduction of the integrated circuit. The integrated circuit replaced transistors in
the computer. Again the size, power requirements and heat generated by the computer dropped. At
the same time, hardware reliability and speed increased. Information access time for the computers
using integrated circuits dropped to nanoseconds, or billionths of a second.

-

1 .5 THE MICROCOMPUTER

The fourth generation of computers was spaw ned by the introduction of the Large-Scale Integrated circuit, or LSI. This electronic advance was followed by the Very Large-Scale Integrated
circuit , or VLSI. LSI and VLSI make it possible for a chip manufacturer to put hundreds of
circuits into the space of a few square inches.
In earl y 1975. the first commercially available microcomputer was announced . It was a
hobbyist kit built around the Intel 8080 microprocessor. Programs were loaded with switches on
the front panel of the machine. The computer used an audio cassette recorder as its auxiliary
storage.
In 1977, Steve Jobs and Steve Wozniak
put together the fi rst Apple computer. They
were soon followed by the Commodore PET
computer and the Tandy-Radio Shack TRS80. Today, microcomputers are available
from several major manufacturers, such as
Apple, IBM , Wang, NCR, and Zenith . The
capabilities of these machines are beginning
to rival those of medium and large size computers at a price a small business or the typical household can now afford.

Figure 1.7
Different types of Apple
Macintosh computers.
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1 .6 WHAT IS A COMPUTER?
A computer is essentially a very simple device-a machine designed to follow instructions
mindlessly. In doing this, the computer rapidly performs tasks in a tireless fashion by manipulating bits of information. A BIT is a binary digit , the most fundamental unit of information dealt
with by the computer. You can compare it to an on-off switch . Either a bit is ON or it is OFF.
By combining bits, any information can be represented .
The tasks a computer performs while manipulating these basic units of information may be
simple, such as addi ng two numbers together, or the tasks may be complex, such as monitoring
and controlling an oil refi nery, or in between , such as computing a company's payroll and all the
required taxes.

-

1 .7 THE INPUT-PROCESS-OUTPUT MODEL

Whether a computer adds two numbers together, monitors an oil refinery, or computes payroll
checks, the same elementary three-step process occurs:
I. Information is input into the computer.
2. The computer processes the information.
3. Results of the processing are output.
Figure 1.8 illustrates this basic input-process-output model.
Figure 1.8
Input-process-output
model.

Central
Processing
Unit

If you want your computer to solve the addition problem 2 + 4 = 6, the inputs to the
computer are the two numbers 2 and 4, the process performed is adding these two numbers, and
the output is 6, the result of the addition.
The refinery computer has more complex inputs, such as temperatures and rates of flow.
The process step is much more complicated than a simple addition , involving such acti vities as
the analysis of the temperatures and rates of flow , and making decisions based upon this analysis. The computer's outputs are the actions to be taken resulting from the various decisions at
which the machine has arrived.

-

1 .8 COMPUTING POWER

The computer needed to monitor the oil refinery must perform far more complex processing
tasks than the one used to add two numbers. It is, thus , a more powerful computer. But what is a
powerful computer? For our purposes we will define the power of a computer as being measured
by three things:
I . how fast it performs computations,
2. the memory capacity of the machine, and
3. its computational accuracy.
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In discussing computer power. we ·11 be foc usi ng on processing, the second pa rt of the inputprocess-output model.
T here are three classes of compute r in use today, each with different, overlapping ranges of
power. As technology advances , it is becoming more and more difficult to distinguish a mong the
three classes of computers. These classes a re mainframe compute rs, minicomputers, and
mic rocompute rs.

-

1 . 9 MAINFRAME COMPUTERS
Mainframe computers are the most powerful machines available. They are capable of processing
large amounts of information in a very sho rt time. The internal clock of these machines-which
is somewhat like a metronome in that it gives the computer a beat to operate to- runs very fast.
Not only does a mainframe compute r ope rate quickly, it also usually has a large amount of
internal memory, called Random Access Memory, or RAM, for storage of programs and data.
Figure 1.9
A Cray mainframe
computer.

A ma inframe computer is usually capable of performing arithmetic computations with a
great degree of accuracy. This accuracy is a re flection of the large "word " size of the computer.
A computer word is made up of bits . The more bits in a computer 's word , the more accurate the
mac hine is capable of be ing in its arithme tic operations . Thus, a sixteen-bit word computer is
capable of more accuracy than an e ight-bit word computer, but not as much as a thirty-two-bit
word compute r. The mainframe compute r is also able to service the needs of several programs
runn ing at the same time without a serious drop in overall performance.
Although ma inframe compute rs are fast a nd have large internal memories, they are also very
expensive. Not only do they cost in the mi llions of dollars, but they req uire extensive, and
sometimes very expensive, prepa ration of the facilities in wh ich they are to be housed. In
addition to these "startup" costs, mainframes require relati vely large, ongoing expe nses for
maintenance and a full-time staff to keep the mach ine running.
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1 .10 MINICOMPUTERS
Not every organization needs, wants, or can afford to install and own a mainframe computer.
Nonetheless, many companies still need a fair amount of power in their computer. However, they
may not need all the speed , random access memory, o r accuracy provided by a mainframe.
A compute r that draws eng ineering blueprints needs to work quickly because the volume of
computat ions required to draw a blueprint is very large. On the other hand, the computer that
maintains a company's accounting records must have arithmetic accu racy-everything must balance to the penny. Speed is not a big need; the computer can post accounting entries to its ledger,
or compute payroll, overnight.
Minicomputers cost less than mainframes-typically in the tens to hundreds of thousands of
dollars. These computers may require some special facilities pre paration and usually have an
ongoing maintenance expense. They often do not require full-time operations personnel or the
technical knowledge that keeping a mainframe computer going may require. The trade-off for
these savings in cost and maintenance expense is a drop in the power of the computer. This can
be reflected by a slower rate of computation, a smaller memory, and a noticeable degradation in
performance when too many tasks are simultaneously running on this machine.

-

1 .11 MICROCOMPUTERS

Figure 1.10
A Macintosh
microcomputer.

Microcomputers are the least expensive source of computing power. They a re also the least
powerful type of computer as a class. The cost of a microcompute r system is usually in the
thousands of dollars range.
Microcomputers are relatively slow computers, with more limited memory capacity and fair
arithmetic accuracy. However, recent technological advances have increased the power of these
computers to the point that some are almost as powerful as minicomputers. For the most part,
however, the typical microcomputer user will not need this kind of power.
In addition to being inexpensive, microcomputers offer some advantages over the mainframe
computer and minicomputer. To make mainframes cost-effective to operate, many people use the
large compute rs, frequently at the same time. Airl ines , for example, use mainframes to handle
passenger reservations. If something goes wrong with the mainframe, agents cannot reserve
space, and passengers are out of luck until the problem is diagnosed and the machine put back
into service.
With a microcomputer, only one or two users
are affected by a hardware failure. The seriousness
of the problem may be minimized if these people
have access to other computers while their computers are being repaired. All they need to do is
take thei r data down the hall or next door, a nd they
are back in busi ness. This is not possible with
larger computers, as most companies do not have
several of the same, very costly machines available.
If a corporation does have several mainframes or
minicomputers, computer time probably will not be
available o n them, as they must conti nually be in
use to justify their expense.
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1 .12 LOCAL AREA NETWORKS

While microcomputers are relatively inexpensive, the cost of adding on input and output devices,
or peripherals, can be great. In fac t, some pe ri phe rals such as laser printers or high capacity
hard disk drives can cost more than the microcomputer with which they a re used.
This situation cannot be avoided for the individual user or group of users in a single
company spread th roughout several cities or states. Each location will have to purchase the
expensive peripheral devices needed. However, if the users are all in the same building, or even
in two or three buildings that are physically close togethe r, the local area network, or LAN,
may solve this resource cost problem .
The purpose of a LAN is to provide a physical link between two or more microcomputers
that allows the use rs of these machines to have access to the expensive resources found on a
single machine. Through this link, the compute rs may communicate wi th one another and thus
share data. One location o r computer attached to the network may then be " loaded " with the
pe ripheral equipment. Information may be sent to this machine, whic h then sends it to the
peripheral devices connected to it.
Some network systems use a special device called a server to help them operate the various
input/output devices for the network. The server is attached to the network j ust as the other
computers are attached . Most LANs make use of a disk, or fi le server, which not only controls
the network 's communication to the information storage devices, but frequently controls the
complete network.
FILE SERVER/
PRINT SERVER

WORKSTATIONS

I\

.......::::"
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WORKSTATIONS
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1.13 INPUT DEVICES

So far, we have looked at the capabilities of the three different sizes of computer in processing
information. Now that we' ve seen how the process part of the input-process-output model works,
let's explo re how information gets into the computer so that it can be processed.

Figure 1.11
A LAN configuration.
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1 .14 PUNCHED CARDS AND PAPER TAPE

O ne method of supplying info rmation to the computer is through the punched card. You , as a
programmer or computer user, punch holes into the cards with a keypunch machine. The cards
a re then input into the computer for processing with a card reader and the compute r interprets
the patte rn of holes in each card and acts on the instructions coded into the pattern . The code
used on punched cards today is the same code invented in the 1880s by Herman Holle rith , the
Hollerith code.
Punched paper tape is a similar method for inputting information for processing. Paper tape
is not as bulky as punched cards, but it is almost impossible to make changes in the tape. The
punched paper tape, unlike the punched card, cannot have the letters corresponding to the coded
holes printed on it, which makes it almost impossible to read the tape by eye. To make c hanges,
you must punch a corrected portion of tape, cut the incorrect portion out of the original pape r
tape, then patch the three segments back together. Paper tape is ra rely used for inputting information into computers today.
Fi gure 1.12
A punched card.
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Figu re 1.13
Punched paper tape.

Both the punched card a nd paper tape are input media primarily found in use on mainframe
computers. As a user of a microcomputer, it is very unlikely that you will have to make usc of
e ither of these two media for data input.

-

1 .15 THE LIGHT PEN

The light pen is a method of entering information frequently used by people working with
graph ic images on the computer. The pen is used to point to a spot on the monitor. It may then
" drag" a line connected like a rubber band from that point to another. Or, a line may be added
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between the first point touched by the light pen and a second point. The light pen may also be used to po int to
options from a list of choices, much like checking a box on
a questionnaire.
A bar code reader is a special type of light pe n. It uses
reflected light to scan the bars of black and white lines
comprisi ng the code. Bar codes may be found on many
items. You see them on products in grocery stores. They
are in use on production lines to help track where units are
in the manufacturing cycle. Some airports now put bar
codes onto luggage; this allows automatic equipment to
send the articles to their proper destination in the airport
from the passenger check-i n point .

Figure 1 .14
A barcode.
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1 .16 OPTICAL SCANNERS

An optical scanner looks at the information on a piece of paper and translates it into information
which can be stored by the computer. Some optical scanners are designed to look at photographic,
pictorial, or other graphic information and to send that information to the computer. This is how
the bar codes found on packages are interpreted by computers at many supermarkets.
A specia lized form of scanne r is the Optical Character Reader. This specialized scanner is
designed to read typed or printed letters, such as a page of typed text. The scanner is " taught"
the shape of letters so that they can be correctly sent to a computer.

a

File

Edit

Slyle

Pen
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1 .17 TERMINALS

Today the predominant method of communicating with a large compute r in the business setting
is via a te rminal. You may use either a video display terminal (VDT) or a paper copy terminal.
Both te rminal types have typewriter-like keyboards that the computer operato r uses to enter data
into the computer.
When using a terminal , the user s imply types information into the computer for processing.
This information includes commands to the compute r's control program (called an operating
system) , lines of a program , or data for a pre-existing program to process.

Figure 1.15
ThunderScan for the
Macintosh.
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When you are using a microcomputer, you will
in effect be using a terminal for data input. There is a
minor difference between your " terminal" and the
terminal attached to a mainframe or minicomputer.
Those terminals attached to larger computers are
connected via a cable to a machine which is physically distant from the terminal - a room, floor or
building away. The computer portion of the microcomputer " terminal " is generally within a few feet,
if not inches, of where you are working.

Figure 1 .16
A computer in use.

-

1 .18 OUTPUT DEVICES

After you have input information and the computer
has processed the information, the results must be
output , the third step in the input-process-output
model. The computer can output the results of the
processing operations in several fashions.

-

1 .19 OUTPUT TERMINALS

The terminal, as well as being an input device, is also a major device for viewing the computer's
output. A terminal receives information from the computer and displays this information on its
display device, either a video or printed display.
The problem with a video display terminal is that you cannot take anything with you when
you leave the machine. This makes it difficult to distribute reports or memos. Thus, the printer
is also used as an output device.

-

1 .20 PRINTERS

There are several different types of printer; the selection of any particular one depends on the
volume of information that must be produced on paper and the quality of printing needed. The
letter-quality printer produces type much like that of a typewriter, but the printer is relatively
slow. The dot-matrix printer produces output that many people consider marginally acceptable
at best for business correspondence, but the printers work at medium to high speed. For
extremely high volume printing, there are printers that print a complete 132-character line of text
in under one second . There are even laser printers that can produce a full page of printed output
of very high quality in seconds .
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Figure 1 .17

Printers.

-

1 .21 MASS STORAGE DEVICES

Not all compute r output goes to a termina l or a printer. Much of the output from many programs
or processes is later used as input by other programs. It makes litt le sense to output this information to a te rminal and then have a pe rson reinput the data. It does make sense for the computer to
retain the information in some fashion. Many computers use the mass storage device , a device
for storing both programs and the outputs generated by those programs.
There are many different types of mass storage devices. The characteristics of the dev ices
differ, as do the costs. For example, you may find an inexpensive device that can hold large
amounts of information , but which takes a long time to access the information.

-

1 .22 MASS STORAGE UNITS

Mass storage units are a type of storage device that gives the computer extremely la rge amounts
of data sto rage. Only a small amount of the data is on line (that is, available to the computer) at
any given moment. This means that if you need information fou nd in one of the data cells not
presently in use, the re will be a long delay before the info rmation is ready to be used.
The chief advantage of this type of data storage device is not the speed of access but rathe r
the volume of information that can be stored. This type of device is capable of storing such large
amounts of data that the cost of storage per character stored is small.

-

1 .23 TAPE STORAGE

Magnetic tape is simila r in some
aspects to mass storage units. The
information is stored on tape a nd
available to the compute r only when
the tape is placed on a tape drive , a
piece of hardware that e nables the
computer to read compute r tapes.
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Figure 1.18

A cartridge tape drive.
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Tape holds a large amount of data, but even when a tape is mounted on a tape drive, the time
needed to access info rmation may be great because the data is stored on the tape sequentially. If
data at the end of the tape are needed, the computer must work its way through the whole tape to
find the desired information.
Tape is not very expensive. Likewise, the tape drive is a relatively inexpensive device. Tape
can be a very cost-effective means of storing large amou nts of data , but only if you can afford
the delays in locating the desired information. If you a re using a computer because you require
rapid access to data, then tape is not the proper mass storage device for you. Instead , a disk drive
becomes the most appropriate device.

-

1 .24 DISK STORAGE DEVICES

Two types of disk storage units are available-hard disks and floppy disks. The hard disk is a rigid
plate that has been magnetically coated to store data. The floppy disk is a flexible, portable piece of
plastic that has also been magnetically coated but which holds far less data than the hard disk. Both
are used in conjunction with a disk drive, which reads and stores information on the disk.
Hard disks are capable of storing large amounts of data (millions of characters per disk), and
they provide the computer with rapid access to the information stored on them because the
information is not stored sequentially, as with tape . It can be accessed randomly . In relation to
tape, however, the hard disk is expensive.
The re are several diffe rent types of hard disk available. Some are removable, such as the
hard disk shown in Figure 1. 19. There are also removable disk cartridges. Some disk drives use
a fixed d isk, and the disk drive itself is a sealed unit.
Figure 1.19
A sealed Winchester drive
(leh) and a removable disk
pack (right).
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The tloppy disk strikes a balance between all the mass storage devices. It can store an
acceptable amount of information. ranging fro m 80.000 characters to 1.4 million characte rs
depending upon the particular computer system and the capabilities of the disk drive itself. The
time used by the computer to access the data stored on a fl oppy disk is relati vely short. While a
computer cannot read information from a fl oppy disk as quickly as from a hard disk. floppies
are significantly faster than tape. Finally. the cost of the floppy disk is nominal. and the cost of
the disk drive is also low in relation to that of the other mass storage devices.
The problem with the fl oppy disk is its vulnerability to physical damage and to data loss.
We ' II cover more about floppy diskettes in a later chapter.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.
II .
12.
13.
14.
15.
16.
17.

What was Blaise Pascal's contribution to the developme nt of the modern digital computer?
What are four components of Babbage·s design for his Analytic Engi ne that are found in the modern digital compute r?
What invention of Herman Hollerith is still in use today?
Who built the first machine using electrical rather than purely mechanical devices to perform computations?
What is the name of the computer built by Mauchly and Eckert?
What was John von Neumann 's cont ribution to the development of the modern digital computer?
Which computer was the fi rst of the "first generation .. computers?
What technological development replaced the vacuum tube and led to the development of "'second generation
computers?
What technological development replaced the transistor and led to the development of "' third generation" computers?
What portion of a second is a mill isecond? A microsecond? A nanosecond?
What do LSI and YLSI stand to r?
What are the three general classes of computers in usc today?
What are the criteria used to define computer "'power"?
What class of computer would you ex pect to use to analyze the data collected in a census? Why?
Which peripheral devices may serve as both input and output devices? Why'?
Which mass storage device provides for the fastest access to the information stored on it? Why?
Which mass storage device prov ides for the slowest access to the infor mation stored on it? Why?
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CHAPTER OBJECTIVES

Upon completion of this chapter, the student wi ll :
• Be able to outline the differences among
systems software, development software, and
applications software, and to give examples of
each.
• Be able to explain the function of an operating
system.

• Be able to explain the difference between
interpreted and compiled computer languages.
• Understand the advantages and disadvantages
associated with both interpreted and compiled
computer languages.

-

2.1 SOFTWARE

Despite marvelous technical advances, the computer is not capable of performing a single process without a set of instructions telling it what to do. Indi vidually, these sets of instructions are
called programs. Programs generically arc referred to as software.

BASIC Program

Pascal Program
program Color -TV (autpul)i
var Prlce,Rate real;
Year

1 . 10;

begin

Prlce : •169. 0,
Rate : •0 . 09;
for Year · •1 to 10 do
begin
Prtce . •Pr&ce'C1•Rate);

100
110
I 20
130
110
150
160
170
180

LET P • 169
LET R • 0 09
LET Y • I
LET P • P , <1 • R>
PR1HT Y,P
IF V >• 10 THEH 180
LET Y • Y • 1
GOTO 130
EHD

FORTRAN Program
R • 169 . 00
R • 0 . 09
DO 2 0 .1•1,9
WRITE <3,10lJ,P
10 FORMAT ( 1X ,IT ,2X ,F7 . 2)
20 COHTIHUE
STOP

~rlteln(Vear,Prlce) ;

end
end .

For our purposes. we can define three classes of software. just as there are three kinds of
computers, as we saw in Chapter I . These classes of software are not related to computer type;
versions of each can be found on mainframes. minicomputers. and microcomputers. The classes
of software are systems software. development software. and applications software.

Figure 2.1
Pascal, BASIC, and
FORTRAN programs.
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2 .2 SYSTEMS SOFTWARE

Figure 2.2
Users communicate to the
computer through the
operating system.

Systems software is the class of programs that allows us to use a computer. In short, people
communicate with the computer, and the computer with people, through syste ms software.
Systems software is comprised mai nly of operating
systems, which supervise the overall operations of the
computer including such activities as controlling the
input and output processes. On mainframes and minicomputers, wh ich may perform several tasks simultaneously, the operating system controls which particular
task has access to the various resources of the computer.
At the same time the operating system controls the ove rall flow of information within the compute r. On a microcomputer, the operating system controls the computer 's
communication with its di splay, printer, and mass storage devices, as we ll as receiving and directing the inputs
from the keyboard and other data sou rces.

-

2 .3 THE OPERATING SYSTEM

T he re a re a variety of operating systems in use on computers today. Each has its own advantages
and disadvantages, its own proponents and opponents. The operating system used on IBM-PC
computers and compatibles is referred to as DOS . DOS stands for Disk Operating System. On
the Macintosh, the operating system is simply referred to as "The System." You interact with the
System through a program called "The Finder." The Finder lets you move objects on the
Macintosh's desktop, eject disks from the disk drives, delete files and start programs running.

-

2 .4 DEVELOPMENT SOFTWARE

Development software is made up of programs used to c reate and maintain programs for general
and/or specific purposes. The programs c reated with development software are referred to as
applications software. Programming languages such as BASIC, FORTRAN , COBOL , Pascal a nd
Care examples of development software.
Some people regard certain gene ral purpose softwa re, such as database managers, as development software. This is because applications are written using the programming language
which is an integral part of the general purpose program. It is not at all unusual to find accounting applications a nd other business applications c reated by using a database manageme nt
program!
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Languages range from '' low-level" (very detail ed and concrete) to '' high-level." The lowest
level computer language is machine code, the actual code understood by the computer. Writing
programs in this language is very difficult and time-consuming. High-level computer languages
are easie r to unde rstand and work with because they look and sound more li ke ordinary English.
High-level languages are tra nslated into machine code by systems software programs called
interpreters and compilers. Once the program is translated , the computer is able to execute the
program instructions.
Some languages may be both interpreted and compiled, depending on the particular computer in use, and on the availability of interpreters and compile rs for that language. For example,
there are interpreters and compilers fo r BASIC available for a variety of compute rs , including
the microcomputer.

-

2 .5 INTERPRETED LANGUAGES

An interpreted language operates through a program (the interpreter) whic h translates each line
of a prog ram into machine language. Unfortunately, the computer does not remember a line that
has been translated, so the interpreter must retranslate lines of the program which are performed
more than one time. In addition, each line of the program must be retranslated each time the user
asks the computer to execute the program! An example of a common interpreted language that
you may encounter on your Macintosh is HyperTalk. HyperTalk is the built-in language of
HyperCard , which will be discussed in a
later chapter.
BASIC Program Source Code
The constant translation and retransla500 LET OHELABOR • LABOR!ITE~HOI o HOUR5!1TEMHOI
tion of program lines slows the process of
510 LET OHEMATL • MATL! ITEMHOJ
executing the program because some of the
520 LET OHEUHIT • OHELABOR • OHEMATL
530 PRIHT "THE C T Or OHE",DESCPT!ITEMHOJ ;• IS · •
computer's processing time must be spent
5~0 PRIHT "
BOR :
" ;OHELABOR
550 PRIHT "
TERIAL :
";OHEMATL
performing this translation. The tra nslation
560 PRIHT "
T TAL :
" ; OHE UHIT
process also combines with other factors
570 PRIHT
580 IHPUT "HOW MAHV
which contribute to the relatively (in rela580 LET TOTC05T • 0
590 PRIHT
tion to compiled progra ms) slow execution
speed of a n inte rpreted program .
If an interpreted program runs slowly,
why have inte rpreted languages? Inte rpreted languages can be less frustrating to
Interpreter
work with during the program writing process than a compiled language, especially
for the novice progra mmer. The interpreter
ca n de tec t sy nta x errors (incorrectly
entered program state ments) when the program is executing , and give immediate
Processing
feedback to the use r. The user can then
Unit
easily make corrections to the program,
a nd try to execute it anothe r time, without
the need to "recompile" the program.
This is also true when debugging (the process of correcting logic errors) the program. If the
program is not g iving the correct results, or is gene rally flawed , most interpreted languages in
use today will le t you display values presently stored in the computer 's memory. This is a major
a id when debugging complex programs. One can often determine the location of an error in the
program logic through inspecting the values in the compute r's memory. It is simple to make
corrections, and then have the computer try again. This type of asking the compute r for information is not possible with a compiled la nguage.

Figure 2 .3

The interpreter passes each
instruction one at a time
to the processing unit for
the computer to carry out.
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2 .6 COMPILED LANGUAGES

Figure 2.4

The compiler creates the
compiled program, which
is executed as a unit by the
computer.

A compiled language requires that the program be translated into a perma nent machine code
version , called an object code, before the program is actually executed by the computer. This is
done with a special program called a compiler.
The compiler translates the o riginal program only one time as compared to the continuous
tra nslation and retranslation process of a n interpreter. The completed sto red translation is loaded
into the computer only one time in a form that is ready for use. This speeds the execution of the
program , as the computer is no longer busy performing the translations while the program is
running. Combined with other factors, the overall speed of execution of a compiled program may
be 3 to I 0 to 20 times faster than the same program whe n run by an interpreter.
Unfortunately, to compile a program
successfully one must eliminate all the
BASIC P rogram Source Code
syntax errors in the program statements .
500 LET OHELABOR • LABORIITEMHOI • HOURSI ITEMHOI
Some compilers, when an e rro r is
510 LET OHEMATL • MATLII TEMHOI
520 LET OHEUHIT • OHELABOR • OHEMATL
detected, wi ll immediately stop the compi530 PRIHT "THE COST Of OHE";DESCPTIITEMHDI," IS : "
540 PRIHT "
lation process, while others generate a list
LABOR:
";OHELABOR
550 PRIHT "
MATER IAL.
";OHEMATL
of all the errors located.
560 PRIHT "
TOTAL :
"; OHE UHIT
570 PRIHT
Regardless, when errors a re detected,
580 IHPUT " HOW MAHY DO YOU WAHT TO PRODUCE ?"; OTY
580 LET TOTCOST • OHEUHIT • OTY
you must fix each e rror, and again begin the
590 PRIHT
..-. ..-.
compilation process. The compiler does not
pick up where it left off or at the firs t error.
Rather, it starts compiling the program from
the beginning as if it had never seen the
Compiler
program before. If a syntax error is in the
last line of a 5 ,000 line program, there is
nothing to be done but fix the mistake and
restart the compiler, from the firs t line of
the program. As a result of this type of
problem, compilation can be a tedious proCompiled
Program
cess for the novice as syntax errors a re
Code
found and the compilation interrupted.
Once all the sy ntax problems are
fixed, the programmer is still faced with
debugging the program so it runs correctly
and provides the users with the correct
Processing
information. This can lead to more compiUnit
lations as c hanges made in the original
program, the source code, must then be
implemented in the compiled program. This, of course, requ ires that the program agai n be
compiled. If one is not carefu l, the addition of two or th.rec lines to a program may result in new
syntax errors, requiring more compilations, and adding to the tedium of the process.

l
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2 .7 PROGRAM DEVELOPMENT AIDS AND UTILITIES

While the programming languages form the larger part of the development software class, there
are also other kinds of developmental software. These are programs that have been created to
assist, simplify and speed up the development of programs. They are frequently referred to as
utility software because they are designed to pe rform utilitarian tasks.
One useful development aid is the screen designer program. All the programmer has to do is
place text on the computer's sc reen and define spaces for user-computer interactions to take
place. Once this is done, the screen designer program will write the programming lines needed
in the language of choice, such as BASIC. This speeds development of a program because much
tedious typing can be eliminated, as well as the need to determine manually the location of text
on the screen, and to write the lines of the program to place the text properly !
Another program which is frequently classified as a development aid is the stream editor.
This type of program scans through a file and replaces all instances of a given combination of
lette rs with a new combination of letters. For example , a stream editor can be used to change the
name of a data element, or variable, throughout a complete program .
Sophisticated stream editors will let the user perform this type of operation on character
combinations located in a specific part of each line. For example, you may have a file containing
the results of a consumer survey. A preliminary analysis indicates that you will obtain more
meaningful results if you regroup all the answers for the third question . This, let us say, requires
that you change all the responses for this question which are entered as an "X" into a "Z." The
responses to this question are the third characte r from the beginning of each line in the data. The
stream editor can change all Xs that appear in that spot to Zs without changing any other "X"
responses found elsewhere in the survey responses.

-

2 .8 OPERATING SYSTEM UTILITIES

An operating system utility is used to help you ma nage the operations of the computer and your
information.
A typical operating system utility program is one used to make backup copies of programs,
tapes, or disks. Related to this program is one that compares the original copy of a disk or tape
with the backup copy to e nsure the accuracy of the backup.
Other operating system utilities may be used to manage the space on disk drives or to
control how the computer sends information to a printer.
There are utilities which let you recover information from damaged disks, or even to recover
programs which have bee n erased from the disk! These types of utilities are sometimes classified
as development aids, and are in fact in that gray area between operating system utilities and
development aids.
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2 .9 APPLICATIONS SOFTWARE

Applications software consists of programs that have been developed to perform specific tasks.
Such tasks include formatting the text of a document (i.e. , word processing) , computing and
printing a company 's payroll checks, simulating the flying of an airplane, creating monthly
phone bills or c redit ca rd bills , or monitoring the refining of oil. In each case, the computer has
a specific set of tasks to perform.
The re are also general-purpose application programs. These programs, such as an electronic
spreadsheet or database management system, have specific capabilities that can be applied to a
wide variety of fields of human endeavor. The user of the general-purpose application program
selects and applies those capabilities of the program that fit his or her specific needs. As
mentioned earlier, some general-purpose application programs are used to create other application programs, and a re, therefore, sometimes classified as development software.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11 .
12.
13.
14.
15.

What are the three classes of software defined in the text?
What major purpose does systems software serve in the computing e nvironment?
What is the purpose of an operating system?
What purpose does development software serve in the computing e nvironment?
Why a re some application software programs considered by some people to be development software?
What feature of an interpreted language contributes to slowing down the execution of a prog ram?
What is an advantage of programming with an inte rpreted language?
Why will a compiled program usually execute faster than an interpreted program?
If you execute a bug-free interpreted program fi ve times, how many times will the computer interpret the lines of the
program?
If you execute a bug-free compiled program five times, how many times wi ll the computer compile the lines of the
program?
What is the purpose of using a program development aid?
What is one type of program development aid mentioned in the text, and how does it help the user?
What is the primary purpose of an operating system utility?
What purpose does applications software serve in the computing environment?
What are some typical software applications?
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CHAPTER OBJECTIVES

Upon completion of this chapter, the student will :
• Properly handle a Macintosh diskette.
• Explain the need for the Finder/Operating
System.
• Start the Macintosh running.
• Explain the concept of the Macintosh Desktop.
• Explain the concept of an icon.
• Explain the concept of a folder.
• Move the mouse pointer on the Macintosh
screen.
• Click the mouse button to select/highlight
information on the desktop.
• Use the shift-click to select multiple items on
the desktop.
• Drag (that is, move) items on the desktop.
• Pull down a menu and select a menu item.
• Explain how to use the Command Key (X)
menu equivalents.
• Explain how to eject disks from a floppy disk
drive.
• Use the menu to open or close an icon.

• Double-click the mouse button to open an icon.
• Use the close and zoom boxes on a window's
title bar.
• Change the location of a window on the
desktop.
• Use the size box to change the size of a window
on the desktop.
• Use a window's horizontal and vertical scroll
bars and explain why they are not always
active.
• Initialize a new disk.
• Create a new folder.
• Rename a document or folder.
• Copy documents or folders between two disks.
• Move documents into and out of folders.
• Make a duplicate of an item on the same disk.
• Copy a complete disk.
• Move items to the trash to delete them from a
disk.
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3 .1 BEFORE YOU BEGIN- THE DISK
Befo re you begin work on the compute r, pick up one of your Macintosh diskettes. These disks
have a top a nd a bottom. The disk at the left in Figure 3. 1 is a top view of a disk, while the one
at the right is a bottom view.

Figure 3.1
Th e Macintosh 3. 5 inch
micro-disks.

Look at the top view of the Mac intosh disk . This is the label side. Program disks you
pu rchase will have a label on thi s side. New disks usually do not have a label on them. There is,
however, an indentation in the plastic cover of the disk to guide you for the proper placement of
labels. There is also a metal slide on one end of the disk. It wraps around to the bottom side of
the disk. This slide covers the disk media itself. You should avoid sliding the slide and thereby
exposing the disk media, risking damage to the disk. Under no circumstances should you touch
the disk media. Likewise, never affix a label omo the disk in a fashion that prevents the slide
from freely moving back and forth .
The slide end is the side of the disk that is inserted into the disk dri ve fi rst (Figure 3.2). On
the edge of the di sk is a n a rrow stamped in the plastic to remind you of the proper way to insert
the disk into the di sk dri ve.
Figure 3.2
The proper w ay to insert a
disk into a Macintosh disk
dri ve.

Macintosh Productivity Tools

Now look at the bottom view of the disk. Again, note that the metal slide is present. At the
bottom right corner is the write-protect tab. With the tab in the position shown in the photograph, the tab is covering the write-protect hole and the disk is unlocked, or write enabled. This
means that the existing information on the disk can be changed, new information can be added
and old information removed. If the tab is moved to the opposite position, the write-protect hole
will be exposed and the disk will be locked, or write protected, so that no information can be
changed. When looking at a locked disk, you will be able to see through the write-protect hole in
the disk cover. This is not possible with a write enabled disk. Before continuing, make sure that
the disk you are going to use is write enabled.

-

3 .2 THE PURPOSE OF AN OPERATING SYSTEM

Regardless of the purpose of the particular application or software in use, you must have a way to
communicate with the computer. This is done through the computer's operating system. An
operating system is a program that controls the overall operations of the computer. It accepts
commands you give it and carries them out. It receives all inputs from the input devices and
routes them to their destinations. It receives all outputs from the processors and routes them to
their designated output devices.
For our purposes, the most important part of the operating system is the section that assists
you and your programs in communicating with, and giving commands to, your computer's disk
drives. Consequently, the computer's operating system is frequently referred to as a Disk Operating System, or DOS.
The Macintosh operating system that most users are familiar with is found in two programs
on a System Disk. One part is called ··system," and the other is called .. Finder." The System is
the Macintosh equivalent of a DOS. The Finder is a special user interface program that lets you
manipulate disks and the information found on them. Technically, a boot disk needs only the
System file and a program that has been installed to run automatically (such as the Finder) to be
a boot disk.
For our purposes, we will define a System Start-up disk (or boot disk) to be one that
contains both the System and the Finder files and thereby allows the computer to begin operations and to let you, the user, communicate with the computer. (NOTE: Depending on the
version of the Macintosh System and Finder files you are using, the exact dialogs and order in
which the computer presents them may differ slightly for you throughout this text. The System
and Finder Files in use for this text are System Version 6.0.3.) Remember that there are exceptions to this rule. It is possible to have the System and another application program, rather than
the Finder, be on a start-up disk. You will not, however, be able to load the Finder and interact
with the disk if this is the case. Rather, the application program will start running when the
computer boots-up.

-

3 .3 HOW TO START THE MACINTOSH

The process of turning on your computer, loading the System, and starting the Finder executing
is frequently called booting-up the computer. The term comes from the concept of pulling
oneself up by one's bootstraps. There is a small program in the computer's Read Only Memory
(ROM) which initiates the loading of the System file from the boot disk and starts it running.

25

26

CHAPTER THREE -

USING THE FINDER

The System, when loaded , begins execution of the Finder. In effect, the Macintosh is pulling
itself up by loading the necessary programs to be able to opera te. A System disk is sometimes
refe rred to as a boot disk because it can be used to get the compute r operating when it is first
turned o n in this fashion.

WHAT

To Do

WHY

You ARE DoiNG lr

Turn on the Macintosh. Do NOT yet
insert a disk into the disk dri ve. After a
brie f pause, you wi ll see a grey sc reen
with a picture of a diskeue in the middle. This picture will have a large question mark blinking on it. This means
that the computer is waiting for a boot
disk. If you are using a computer with a
hard disk , the disk wi ll soon be replaced
by a smiling disk. and the computer wi ll
"boot-up ...
Inse rt a boot disk into one of the compuler's floppy disk drives. Do this by
inserting the metal slide end of the disk
into the drive first, label side up (see
Figure 3.2 if you are not sure), then
pushing in the disk until it is grabbed by
the disk drive and di sappears completely
into the disk drive . Under no circumstances should you force a disk into a
disk drive. It should enter the computer's disk drive with a gentle push.

You are booting-up the computer.

If you have two or more floppy disk drives attached to your Macintosh, you may insert the
boot disk into any drive. The computer w ill boot from a system disk regardless of which disk
drive you put it in, the Macintosh does not care. However, it is best to boot from the computer's
internal drive (if it has one built-in disk drive and one attached by a cable), or from the lower
inte rnal drive (if it has two built-in disk drives).
If the Mac intosh you are using has a hard disk, it is most likely that the necessary System
and Finder files are already on the hard disk. After the hard disk reaches its necessary rate of
spin, the Macintosh will automatically boot-up, you will not have to insert any disk. However, if
you do insert a disk into the fl oppy drive before the hard disk is ready, the Macintosh will boot
from the floppy disk rather than the hard disk. This is important. There may be times when you
will want to take advantage of particular resources found in the System file of a floppy disk (you
will see in the next chapter that the type fonts available to you, and special programs called DAs,
are attached to the System file on the start-up disk) , but you do not want to load them permanently o nto your hard disk.
Once the Macintosh has loaded the operating system (the System fi le from the boot disk). it
starts executing the program called the Finder. The Finder is a s pecial program that allows the
user to interact with the Macintosh desktop . It is possible, usi ng a spec ia l menu o ptio n. to tell
the Macintosh to start a different program, rathe r than the Finder. Th is is sometimes the case
with commerc ia lly distributed software, which are common instances of when the start-up disk
contains the System file and a second program othe r than the Finder.
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3 .4 THE DESKTOP AND ICONS

You, the user of the Macintosh, are able to interact with the computer by manipulating objects
you see on the computer's display using the mo use. The Macintosh's screen display is usually
called the desktop. The analogy that is being created is that whe n you work with the Macintosh,
you wi ll work as you normally would at a desk. At your traditional desk or work area you have a
trash can for things you want to dispose of, and a filing system or drawers for things you want to
keep. You have fi le folders for keepi ng documents organized, and information is either put away
in a folder or drawer, or it is sitting open on your desk top.
The same is true of the Macintosh. Look at Figures 3.3 and 3.4. These are the Macintosh
desktop afte r the computer has completed the boot-up process. At the top right of each is a
drawing of a disk. This drawing is called an icon. Icons are graphic representations of objects on
your desktop. This particular one represents your information storage system, the disk drive. If
you are trying to think of the equivalent item in your traditional office, then the disk icon can be
thought of as either a desk drawer, or bette r than that, a file cabinet. In Figure 3.3 the disk is a
micro-floppy, and in Figure 3.4 the disk is a hard disk.
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Figure 3.3
The Macintosh desktop
aher you boot with a
floppy disk. Notice the
icon of the floppy disk at
the top right corner of the
display.

Figure 3 .4
The Macintosh desktop
aher you boot with a hard
disk. Notice the icon of the
hard disk at the top right
corner of the display.
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Other icons wi ll appear on your desktop over time to represent othe r aspects of the
Maci ntosh/ human interface . For example, another icon presently on the desktop is a trash can at
the bottom right. Things you no longe r want to keep on your d isk are moved to the trash can to
be disposed of. Whe n you have created a docume nt with the word processing program , the
stored document , someti mes called a file , wi ll appear as an icon on the des ktop .
As you continue to use the Mac intosh , you wi ll see that everything re lated to it is in some
way graphica lly repre sented through an icon. Every application program has a d istinct icon , as
does eve ry data file created by that program . T hese icons, and manipulating the m with the
mouse, form the core of all Mac intosh acti vities.
The fi nal major feature that you will see appea r on the desktop are windows. T hese a re
viewports into a d isk or doc ument. They can be moved around on the desktop , as well as have
the ir size changed. More will b e discussed about windows when you have some ope n on you r
Macintosh des ktop .
T he mouse is the mai n tool you have fo r working with the icons and information on the
Mac intosh desktop. It is some times called a pointing device, because that is what you do with it.
Notice the arrow near the top left corne r of the desktop. This is the mouse po inter. The move ments of the phys ical mouse on the desktop will move the mouse pointe r on the Mac intosh
desktop. You will spe nd much ti me late r in this chapte r becoming more fa miliar w ith the mouse
and its operation.
Of course, no computer would be complete without a keyboa rd fo r machine/ huma n interact ions. The re are three keyboa rds in use with the Mac intosh today. The two most common are
the sta ndard keyboard (Figure 3 .5) and the extended keyboard (F igure 3.6). T he third keyboard
is found in use on the Mac intosh Plus compute r. T he extended keyboard has its arrow keys
located in a different position, six extra cu rsor control keys between the standard typing keys and
the number pad , function keys on the top , and a duplicate set of control, option a nd command
keys on the right side of the keyboard . T he maj ority of the extra keys found on the exte nded
keyboard a re there fo r when your Mac intosh is e mulating an IBM-PC , on whic h a ll these keys
are standard . Most current Mac intosh soft ware does not make use of these keys. As a conseque nce , you will not have to worry about them if you do not (or even if you do) have the m .
Figure 3 .5
The Standard M acintosh
keyboard.

Figure 3.6
The Ex tended M acintosh
keyboard.
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3 .5 EXPLORING THE DESKTOP

On the desktop you presently can see the disk icon representing your start-up disk. The name of
your start-up disk may be different than that shown in Figures 3.3 or 3.4. If you have a Macintosh with a hard disk, the actual shape of the icon as well as the name of the disk may be
diffe re nt than what is seen in Figure 3.4 (Different hard disk manufacturers each use a different
icon to represent their brand of hardware on the desktop.). It is also possible for the di sk icon to
be open. Thus, the icon itself wi ll have a totally differe nt appearance, and a window will be open
on the screen displaying the contents of the disk (Figure 3. 7). You should also have a trash can at
the bottom right of the desktop. This is a good, out of the way, area of the desk.
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Figure 3 .7
The Macintosh desktop
after you boot with a
floppy disk. This disk is
open. Notice the
appearance of the icon of
t he open floppy disk at the
top right corner of the
display. This is called a
hollow icon.

Notice that there is a difference between the icon for an open disk and the icon for a closed
disk. The closed disk icon has lines drawn on it so that it looks like a disk. The open disk icon is
shaded in appearance. This will be true of othe r icons that can be open or closed while sitting on
the desktop. Closed icons are clear diagrams of the item , open icons are shaded outlines of the
item.
Look at Figure 3.8. Not ice that this desk--top has located on it two disk icons. This was
accomplished by placing a disk into each of the two floppy disk drives attached to the Macintosh.
The top disk is white, while the bottom one is black, o r in inverse. The bottom disk is the
currently selected disk because it is displayed in inverse. If an action that effects a disk is taken,
such as an open or disk eject command , then the selected disk is the one effected. The unselected disk will remain uncha nged in the computer 's di sk dri ve.
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Figure 3 .8
The disk called "System
Start-Up " is de-selected,
while the disk called "Data
Disk" has been selected.
Disks, or text, that have
been selected will appear
in inverse on the
Macintosh display.
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Figure 3 .9
The Macintosh Mouse

USING THE FINDER

As you work with the Macintosh, you will see that any selected item will be highlighted in a
fashion similar to the way the lower disk is in Figure 3.8. If an item, such as an icon on the
desktop, a word with a word processor, or a group of cells with a spreadsheet, is selected, it
will be displayed in inverse. If the item is not selected, it will appear in its normal display
mode.
There are two other items to notice on the desktop. Across the top of the Macintosh desktop
is a list of words. At the left of this list is a miniature icon of the Apple logo. This list is the
menu bar. The Apple logo is a special menu item and will be discussed in more detail later in the
text when Desk Accessories are discussed. Depending on what you are doing at any given
moment, the word options displayed on the menu bar vary. That is, when you are using a
program, such as a word processing program, the menu bar will include different, and probably
more, options than the ones you see displayed by the Finder. More will be said about how to
select items from the menu bar a little bit later in this chapter.
The final item to observe on the desktop is the mouse pointer. At present it is an arrowhead.
The mouse (Figure 3. 9) is used to move the mouse pointer from location to location on the
desktop. When the mouse pointer is positioned at a desired location, then pressing the button on
the mouse itself will cause an action to occur.

-

3 .6 USING THE MOUSE

Figure 3. 10
The proper way to hold
the Mouse.

Before you go any further in this text, you must master using the mouse. Before you begin this
process , note the correct physical orientation of the mouse. The wire that connects the mouse to
the computer (or keyboard, depending on how you have the computer set up) exits the mouse at
its top. Inside the mouse is a ball which rests on the surface of the desk or table you are using.
This ball is rolled around inside the mouse as you move the mouse on the top of the table. The
motion of the mouse is translated into the motion of the ball and tracked by the mouse pointer on
the computer's desktop. In short, there is a physical relationship between the rotation of the ball
and the movement of the mouse pointer on the Macintosh desktop. If you lift the mouse up off
the surface of the table, the mouse pointer will no longer move on the computer's desktop
because the ball will not be turning as you move the mouse. If you run out of room on the
surface of your table to complete a movement of the mouse, it is OK to lift the mouse, move it in
the air, return the mouse to the table top, and then continue moving the mouse to move the
mouse pointer. Because you can lift the mouse off the table top and re-position it, the mouse
does not require a large amount of space on your table top. You simply lift it up, re-position it,
then return it to the table surface to continue the motion of the mouse pointer.
When you hold the mouse, you should hold it with
the connecting wire exiting the mouse away from you
(Figure 3.10). Your index finger will then be in position to press the mouse button. The motion of the
mouse pointer on the screen will match the motion of
the mouse on the table surface. If you move the mouse
right to left on the table top, the mouse pointer should
also move right to left on the Macintosh desktop.
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It is important to keep in mind that the motion of the mouse pointer will be relative to the
top of the mouse where the wire exits to attach the mouse to the computer, and not necessarily
relative to the computer itself. For example, if you hold the mouse with its top at a 45-degree
angle to the base of the computer (this being a comfortable way to hold the mouse without the
need to twist your hand at the wrist), and then move it left and right parallel to the base of the
computer, the mouse pointer will move at a diagonal on the Macintosh's desktop (Figure 3.11).
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Figure 3.11

Moving the mouse when it
is held at an angle will
cause the mouse pointer
to move at a diagonal.

In a similar fashion, if the mouse is held so that its top is parallel to the base of the computer
and again moved left to right, the mouse pointer will move on a horizontal line across the
desktop (Figure 3. 12).
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Figure 3.12

Moving the mouse when it
is held straight will move
the mouse pointer where
you want it to go!
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When you first turned on the Macintosh, if you did not touch anything, the mouse pointer
appeared at the top left corne r of the desktop. Take a moment now to try moving the mouse
pointer on the desktop.

WHAT

To Do

WHY

Start by moving the mouse pointe r from
the top left corner of the desktop to the
trash can icon at the bottom right of the
desktop. From there, move the mouse to
the disk icon at the top right of the desktop. Complete the circuit of the desktop
by moving the mouse to the left so it is
pointing to the apple on the menu bar
(Figure 3. 13).

You ARE DOING

IT

This mouse movement will give you the opportunity to
observe the relationship between the physical mouse and
the mouse pointer on the Macintosh desktop. Be sure to
get a feel for the relation between the distance you move
the mouse and the distance the mouse pointer travels on
the Mac intosh desktop. Later in the text you will see how
to change this relationship.
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Figure 3 .13

This is the path you should
follow as your are moving
the mo use.
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3 .7 DE-SELECTING A ND SELECTING SINGLE ITEM S O N
THE DESKTOP

Now that you know how to move the mouse, you are ready to select ite ms on the desktop.
Selection of an icon is done by pointing to the desired item , that is moving the a rrow point of the
mouse pointe r so it is touching the item , and pressing the mouse button one time and the n
releasing it. This press and release action is called clicking t he mouse.

WHAT

To Do

Place the mouse pointer somewhere on
the desktop patte rn and click the mouse
button once.

WHY

You ARE DoiNG

IT

Since you are not pointing at any icon, everything should
become de-selected (Figure 3.14). This is always the
case with the Macintosh. If you want to de-select a n
icon , or virtually anything, simply move the mouse
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pointer to a different location on the desktop or within the
current window and click the mouse button once.
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Move the mouse pointer so that its point
is touching the trash can, then click the
mouse (Figure 3. 15).
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Now select the disk icon at the top right
corner of the desktop. Start by moving
the mouse pointe r so that it is touching
the icon, then click the mouse button
one time.
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Figure 3 .14

By clicking the mouse in
the middle of the desktop
pattern, everything on the
desktop is de-selected.

Select, the trash can icon. This method of selecting icons
(pointing at one then clicking the mouse) causes only one
icon to be selected at any given time.

.,

Figure 3.15

With the mouse pointer on
the trash can, clicking the
mouse button once will
select the trash can. If
something else had been
selected, it would have
been de-selected by this
action.

The dis k icon will become selected. When you selected
the disk icon, the trash can icon became de-selected. In
fact, a ny other icon on the desktop would have become
de-selected. As stated above, this method of selecting
icons causes only one to be selected at any given
moment.
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3 .8 SELECTING MULTIPLE ICONS ON THE DESKTOP

It is also possible to select more than one icon on the desktop. Having several icons selected at
the same time can be useful. When two or more icons are selected, they form a temporary group
that can be operated on at one time. For example, if you want to move three files from one
location on the desktop to another, they may be grouped, then moved as a single un it. Their
positions relative to one another on the desktop will remain unchanged , but all three will be
moved at once.
There are several ways you can select multiple icons. The first is to hold down the shift key
as you point to a new icon and click the mouse button. This is called a shift-click because the
shift key is being held down while you are clicking the mouse button. Try this.

WHAT

TO

Do

WHY

You ARE DoiNG IT

Select the disk icon by pointing to it and
clicking the mouse button one time.

You are selecting a single item with this method. Any
other selected item on the desktop should become deselected.

Move the mouse pointer to the trash can
icon. Before you click the mouse button,
press and hold down the shift key on the
Macintosh keyboard. While holding
down the shift key, click the mouse button again.

This action, the shift-click, will result in both the trash
can and disk icons being selected (Figure 3.16).
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Figure 3.16

When using the shift-click,
a previously selected item
will remain selected. Thus,
multiple items can be
selected on the desktop.

You may also use the shift-click to selectively de-select icons. If multiple icons are selected,
and you want to de-select only one, shift-click the icon you want to de-select. The other icons
will remain selected!
Another method of selecting multiple icons does not involve the keyboard , but only the
mouse. To use the mouse for this purpose you must move it with the mouse button depressed.
Moving the mouse with the mouse button held down is called dragging the mouse. If you are
moving the mouse without the mouse button held down you are not dragging it, but simply
moving it! The term "drag" is always used to indicate that the mouse button is depressed while
moving the mouse . When you use the mouse to move something on the desktop, you are
dragging the icon with the mouse.
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Dragging the mouse to select multiple icons is a simple process. You start by positioning the
mouse pointer above (or below) a nd to the left (or right, it really does not matter) of one of the
icons to be selected. Then you push and hold the mouse button. While holding the mouse button,
you drag the mouse pointer. This will create a box on the Desktop. Any icon touched or enclosed
by the box when the mouse button is released w ill become selected . Try selecting both the disk
and trash icons with this method.

WHAT

To Do

WHY

You ARE DOING IT

Place the mouse pointer above and to
the left of the disk icon.

This positions the mouse pointer for the beginning of the
selection process.

Push and hold the mouse button.

When you do this, anything that was selected on the
desktop will become de-selected. This is alright.

With the mouse button still pressed,
drag the mouse pointer down toward the
bottom of the desktop.

As you drag the mouse, you will notice that the outline of
a rectangle will begin to form on the desktop (the left
half of Figure 3.17). One comer of the box is anchored
at the location where you started the mouse movement.
The other corner corresponds to the current location of
the mouse pointer. You want to create a rectangle that
touches all the icons you want to select.

Continue dragging the mouse until the
box touches or encloses both the disk
and trash can icons (the right half of
Figure 3. 17).

,

Figure 3.17
The left portion of this
figure shows the
beginning of the selection
box being formed as the
mouse is dragged.
Continue dragging your
mouse so that the
selection box touches both
icons on your desktop, as
shown on the right side of
the figure.

Now release the mouse button.

Both the disk and trash can icons will become selected .
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As you use the Macintosh, you will discover that you will use both of these two methods of
multiple icon selection. Unfortunately, the desired icons sometimes have other, un-desired icons
in between. The dragging mouse method will select the un-desired icons, and you must use the
shift-click method. Recall, that the shift-click method can also selectively de-select icons from a
group of selected icons. That is, if you have selected five icons on the desktop, and want only
four of the five, hold down the shift key and click the mouse pointer on the icon you want to deselect. That one icon will become de-selected, while the remaining four will stay selected.

-

3 .9 DRAGGING (MOVING) ITEMS ON THE DESKTOP

Now that you know how to drag the mouse, it is a simple process to learn how to drag an icon on
the desktop to c hange its position.
To drag an icon, point to it, then press and hold the mouse button, then drag the mouse. An
outline of the icon will move with the mouse pointer. When you release the mouse button, the
icon itself will move to the new position on the desktop.
Try this by dragging the trash can icon to the top of the desktop.

WHAT

To Do

WHY

You ARE DOING IT

Place the mouse pointer on the trash
can .

Position the mouse in preparation to moving the icon.

Press and hold the mouse button.

"Grab" the trash can icon. The click will cause it to
become selected. Since you have not let go of the mouse
button, you are telling the Macintosh that you intend to
do something with this icon.

Drag the mouse toward the top of the
desktop, then release the mouse button
(Figure 3.18).

Move the icon to a new location on the desktop. When
you drag an icon, you will move only its outline at
first. Once you release the mouse button, the icon will
move to the new location on the desktop.
Disk icons and the trash can icon will always return to
their starting place when you restart the computer, or
after you exit an application program. This wi ll not be
true of icons that are attached to a disk, si nce their locations are remembered by the disk on which they are
stored.

You can also drag the icon of the start-up disk to another location on the desktop. Try
dragging this icon to the bottom left corner of the display. When you a re done, your Macintosh
desktop should look something like the one shown in Figure 3.19.

Macintosh Productivity Tools

,

1111

'" 5

Figure 3.18

The trash can, which is the
selected icon, is being
moved. Note that when
moving the icon, only its
outline is moved while you
are holding the mouse
button down. The icon
itself moves when the
mouse button is released.
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Figure 3 .19

The icon of the start-up
disk has been moved to
the lower left corner of the
display.
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3 .10 USING THE MENU BAR

The menu bar is located on the top of the d isplay. Virtually every Macintosh program has a menu
bar also appearing at the top of the desktop. The menu bar is used to select various options as
you are using an application program .
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Regardless of whether you are using the Finder, which you should realize is a specialized
application program , or another application program , the methods available for using the menu
bar never change, although the items on the menu bar will change. The menus are called pull
down menus because you use the mouse pointer to pull the menu down as you would a window
shade.
The Finder menu bar consists of the Apple menu, the File menu, the Edit menu, the View
menu and the Special menu. If you are using a Macintosh II, Ilx, Ilcx or llci with a color
monitor, you may also see the Color menu option on the menu bar. To see the options on a me nu
is a simple process. Start by placing the mouse pointer on the menu item you want to see. Press
and hold down the mouse button to pull down the menu and see its contents.
Before you continue, make sure that nothing on the desktop is selected. You will discover
that, depending on what is selected or open at any given moment, different menu options will be
available. By having nothing selected, and nothing open on the desktop you will have fewer menu
options available. If you have nothing selected on your desktop when you continue, your screen
and menus should closely match the figures in the text.

WHAT

To Do

WHY

You ARE DoiNG

IT

Place the mouse in the middle of the
desktop and click it once.

Clicking the mouse in the middle of the desktop will
leave nothing selected.

Move the mouse pointer to the word
FILE on the menu bar.

Prepare to select an item from the menu bar.

Press and hold the mouse button without
dragging the mouse.

Pull down the File menu from the menu bar (Figure
3.20). (NOTE: If you are using a different version of the
system software, then your menus may not exactly match
those in the text. Do not be concerned. Apple Computer
Inc. frequently updates the system software, changing
menu items, fixi ng bugs, and in general making the operating system work better.)

Figure 3 .20
The Finder's File menu as
it appears when you have
nothing selected on your
desktop.
Get Info
Duplicate
Put RWDIJ

>1<1
>I<D

Pega Setup ••.
Print Directory ...

I 1ect

KE

This type of menu is called a pull down menu, because
the menu appears to be pulled down from the top of the
screen. You have just pulled down the file menu.
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Note that most of the items on the File menu appear to
be "faded," while only two, Page Setup and Eject, are
completely black. Because you have nothing selected on
the desktop at this time, the Macintosh realizes that most
of the menu options available on the File menu would
have nothing on which to operate. Thus, most of the File
menu items are unavailable at this time. These faded out
items are called dimmed. Dimmed items cannot be
selected .
The two menu items that are currently available are Page
Setup, which lets you tell the computer how it is supposed to talk to the printer, and Eject, which lets you
remove the disk from the disk drive.
Keep the mouse button pressed. Drag
the mouse pointer right to the word
EDIT.
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The File menu will disappear and the Edit menu will now
be the pulled down menu (Figure 3.21).
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Figure 3 .21
The Finder's Edit menu.
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Drag the mouse pointer left back to the
File menu .

Once again the file menu will be pulled down.

Release the mouse button.

The File menu will disappear from the desktop.
By releasing the mouse button with the mouse pointer
in the menu bar, no menu item will be selected, and
thus no action will be taken. You could also have moved
the mouse pointer completely out of the menu onto the
desktop to release the button without selecting an action.

In the above exercise, you dragged the mouse pointer across the menu bar with the m ouse
button depressed. You saw that as the mouse pointer moved from one menu name to the next, the
menu that was pulled down changed. You do not have to start at the F ile me nu and drag the
mo use pointer across the menu bar to select a differe nt menu option. For example, to see the
items o n the Special menu , place the mouse pointer o n the word Special in the menu bar and
press the mouse button. The Special menu will be pulled down .
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3 .11 PICKING MENU ITEMS
Now that you know how to pull down a menu, you are ready to use some of the options on the
various Finder menus. Every application program creates its own menu bar. The Finder, being
a n application, has its own me nu bar like any other application program.
To select an option from a pull down menu, start by moving the mouse pointer to the menu
name and pressing the mouse button. This wi ll pull down the menu. With the mouse button held
down, drag the mouse pointer down toward the bottom of the screen so that it passes over the
options on the pulled down menu. As the mouse pointer passes over dimmed menu items,
nothing will happen. However, when it reaches an available item, that item wi ll become selected.
The highlight in this instance is called the selection bar. Once an item is selected, all you need
do is release the mouse button. The selected menu option will activate.
On the other hand, if you continue to drag the mouse to the next menu item without
releasing the mouse button, the selection bar will change with the location of the mouse pointer.
Thus if you miss the desired menu ite m, simply move the mouse pointer back up the menu list to
the desired item.
If you move the mouse off the menu to the desktop, the menu will remain pulled down as
long as you hold down the mouse button. However, nothing will be selected. Returning the
mouse pointer to a new location on the menu bar will cause a new menu to be pulled down. If
you release the mouse button, the menu will disappear.
Try selecting the Eject option on the File menu. This option will work as long as there is a
disk in one of the computer 's disk drives . The disk does not have to be selected . (The exception
is if the only disk you have is a hard disk. You cannot eject the hard disk!)

WHAT

To Do

WHY

You ARE DotNG IT

Position the mouse pointer on the word
File in the menu bar.
Press and hold the mouse button to pull
down the File menu.

Select the File Menu from the menu bar.

Drag the mouse pointer down the File
menu to the word Eject at the bottom of
the menu.

Select the Eject option. Remember, to keep the menu
pulled down you must keep the mouse button pressed.

With the selection bar on the Eject
option (Figure 3.22), release the mouse
button.

After some brief activity on the disk, the Macintosh will
eject it from the disk drive. The Macintosh is updating
the portion of the disk that tells it which icons are open
and where they are located on the desktop. This will happen with any disk that you eject.

Notice that whe n you ejected the disk , its icon on the desktop became d immed. This tells
you that the Macintosh remembers that the disk exists, but that it is not available because it has
been ejected from the disk drive.
Remember that the technique used to pull down menus and select menu options is a constant, regardless of which Macintosh program you may be using . The menu options might
change, but the method for using a menu remains the same.
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Figure 3.22
Using the mouse to select
the Eject option on the File
menu.
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Figure 3 .23
The Command Key symbol.

3 .12 COMMAND KEY MENU EQUIVALENTS

When you pull down some menus you should notice that some of the menu options have a
symbol and letter to their right, while others do not. For example, you can see that this is the
case on the File and Edit menus for many of the options. They do not exist at all on the View or
Special menu. This symbol (Figure 3.23), which looks somewhat like a four-leaf clover, is
called the Command Key symbol. If you look at your Macintosh's keyboard, you will see this
symbol on a key next to the space bar. T his key is called the Command Key. Remember that
there are different Macintosh keyboards . If you are usi ng the standard keyboard you will find
only one Command Key, to the left of the space bar. There is an extra key separating it from the
space bar, the tilde ( -)/accent grave ( ' ) key. If you a re using the extended keyboard you will
find two Command Keys, one on each side of the space bar. They are interchangeable.
The Command Key works in conjunction with other keys on the compute r 's keyboard. They
a re keyboard short-cuts to many menu commands. With them, you can execute a menu command without having to move your hands from the keyboard to the mouse. For the practiced
Macintosh user, this makes using the functions of many program even easier.
To use one of these menu short-cuts, you hold down the Command Key, and while you are
holding it down , press the letter for the desired option.

WHAT

TO Do

WHY

You ARE DoiNG

IT

Push the disk you just ejected from the
disk drive back into the same disk drive.

The disk icon on the desktop will become selected. Since
the disk is back in the disk drive, it will no longer be
dimmed.

Pull down the File menu.

Notice that next to the Eject option is the symbol for
Command-E , :!€E. This means that you do not have to
pull down the File menu and drag the mouse pointer
down to the Eject option to retrieve your disk from the
computer. All you need to do is hold down the Command
Key and press the letter E.
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Release the mouse button.

Do NOT use the Eject option on the menu . Recall that if
you release the mouse with the pointer still in the menu
bar, no action will be taken.

Press XE on the keyboard.

To use a command key letter, press and hold the Command Key. With this key held down, press the desired letter, in this case the letter E. Once again, your disk will
be ejected .

Try another command key equivalent. First re-insert the disk into the disk drive. After the
disk stops, click the mouse button somewhe re on the desktop so th at nothing is selected . Now
use the mouse to pull down the Edit menu (Figure 3.2 1). Notice the ite m near the bottom of the
menu- Select All. This menu item lets you select all the icons in the current window, or on the
desktop if no window is open and selected . Its command key equivalent is XA. Try pressing this
command key. Both the start-up disk and the trash can w ill be selected .

-

3 .13 MORE WAYS TO EJECT A DISK

You now know two ways to tell the Macintosh to eject a disk from the disk drive. They are
essentially the same, since they both make use of the same option found on the File menu . Select
the disk with the mouse pointer, then use the Eject command on the File menu.
The re is another way to eject a disk. You may eject the disk in the inte rnal disk drive by
holding the command and shift keys, and pressing the nume ral I . T he disk in the exte rnal
Macintosh d isk drive is ej ected with command-shi ft-2. If you are using a Macintosh with two
built-in disk drives, the internal disk d rive is the one on the bottom , while the " exte rnal" disk
drive is the one on the top!
The above methods, as you will see when you use them , a ll leave the disk icon on the
desktop. The Macintosh will therefore remember that the disk exists. This is an advantage if you
want to copy items from one disk to another whe n you have only a single disk drive. The
computer will automatically eject a disk and ask for a nother when it is needed.
You may also eject a d isk by dragging its icon to the trash can. When you do this, after the
disk is ejected, its icon will disappear from the desktop. This means that the Macintosh no
longer knows that the disk exists. If you are not expecti ng to make fu rthe r use of a disk during a
work session , this is the prefe rred method of getting your d isk out of the computer. If you leave
the disk 's icon on the desktop, it is possible to do something that will cause the computer to want
it back . For example, if you eject a disk containing an open window, then you close the wi ndow
and finally start a program running found on a second disk, the Macintosh will want the ejected
disk back to update the status of the window you closed.
The re is, of course, a small exception to the rule of how you may eject d isks. You cannot
" trash" a start-up disk to eject it. The disk will be ejected, but its dimmed icon will re main on
the desktop. The Macintosh needs to remember the start-up d isk at all times. After you have
more disks in the computer, you can try ej ecting a disk by dragging its icon to the trash.
If you are using a shared computer, " trashing" the disk is the preferred way of removing a
disk before you leave me machine. This way, the compute r has forgotte n about the disk and will
not ask fo r it back when the next user attempts to do something with the computer.
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3 .14 MORE USES OF THE FILE MENU

So fa r we have been working with closed icons on the Macintosh desktop . To locate application
programs on disks we must ope n up the disk. Recall the a nalogy that the disk icon re presents a
fi le cabinet in an office. To use a document stored in the file cabinet , the cabinet must fi rst be
opened so that the docume nt can be located . The same is true of the disk icon. It must be ope ned
so that we can find application programs stored on the disk.
There is more tha n one way to open an icon. First, t ry opening the disk icon by using the
File me nu.

WHAT

To Do

WHY

You ARE DoiNG

IT

Select the disk icon on the desktop by
pointing to it and clicking the mouse
button once.

You are selecting this icon because this is the one you
want to work with at this time.

Pull down the File menu .

One of the commands on the File menu is Open. Notice
that the Open command also has a command key equivalent, XO.

Use the mouse pointer to select the
Open command (Figure 3.24).

You want the Macintosh to Open the curre ntly selected
item on the desktop.
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Figure 3.24
Using the File menu to
Open the disk icon.
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Release the mouse button.
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Recall that you execute a menu command by selecting it
and then releasing the mouse button.
If you want, use the XO to open the disk , rather than
pulling down the menu. The result will be the same.
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The disk icon will open on the desktop into what is called
a window (Figure 3.25). The re should be at least one
closed icon on the start-up disk. This icon is called a
folder because of its shape and function. More will be
said about folders later in this chapte r. An open icon on
the desktop of any type is called a window.

Figure 3 .25
A typical open window on
the Macintosh desktop.
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Before you continue, look at the disk icon at the lower le ft corner of the desktop. The icon is
now shaded , rather than the nice line picture of the disk to which we have become accustomed.
This is called a hollow icon. This appearance of the icon is to let you know that it is open! All
open icons appear in this fashion on the desktop.

WHAT

To Do

WHY

You ARE DoiNG lr

Pull down the File menu .

You want to execute another command found on the File
menu .

Select the Close option.

Note that the Close option is no longer dimmed. T his is
because you currently have an open window as the
selected item on the desktop.

Release the mouse button.

Close the disk window.

-

3.15 OPENING ICONS WITH THE DOUBLE-CLICK

A second method that may be used to ope n an icon is called double-clicking. This technique
requ ires that you have a nimble mouse button finger. It is a technique well worth maste ring,
since many Mac intosh activities are made simpler by the double-click.
The easiest way to double-click the mouse butto n is to minimize the up and down motion of
your mouse button finger. In fact, your finger need never actually leave the surface of the mouse.
Just press the mo use button , then release your finger pressure o n it so that the butto n clicks up ,
a nd with as little de lay as physically possible, press and re lease the button a second time. In
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short, to double-click , you must click the mouse button two times as fast as possible. Remember
that clicking the mouse means to press and release the mouse button, and not just to press
and hold it, which is the technique used when you want to drag the mouse or an object.
Try using the double-click to open the disk icon. First, position the mouse pointer on the
disk icon, the n double-click the mouse . If you have double-clicked fas t enough, the disk icon
will open. If the icon does not open, then try again . Remember, it is not how HARD you press
the mouse button , but rather how FAST you click it that counts. Additionally, you must not drag
the mouse while trying to double-click.
As you continue to use the Macintosh, you will discover that the doub!e-click is a very
useful technique . It allows you to select and open an item, or activate an option, quickly, with
one motion. You do not have to spend time moving the mouse to an open button on the screen, or
pulling down a menu to select a me nu option. In addition, many options can be activated with the
double-click. Ove rall , your interactions with the computer will be speeded by the use of the
double-click a nd you are strongly encouraged to master the technique.

-

3 .16 THE WINDOW

The window is the fundamental view port into the Macintosh. You should now have the d isk icon
open , so that you are lookjng at the contents of the disk through a window on the screen. (If the
disk icon is not open , place the mouse pointer on the icon and double-click the mouse to open it.
Remember to practice the double-click as much as possible.)
You should start by observi ng the following features of the open window. At the top of the
window is the title bar. The name of the wi ndow is displayed in the window's title bar at all
times. At present, the title ba r is filled with horizontal lines. This indicates that the window is
selected. At the left side of the title bar is a small box. This is the close box, and it may be used
to close a window. (Just as you can use either the menu or the double-click to open an icon, you
may use either the menu o r the close box to close it.) At the right side of the title bar is the zoom
box . It is used to change the size of the window to fill the desktop, or to return it to its o riginal
size. The title bar, close and zoom boxes appear on most Macintosh windows.
ZOOM BOX

Figure 3.26
The features of a typical
Macintosh window.

SPACE IN USE
ONTHEOISK
NUMBER OF ICONS
CONTAINED BY THIS
WINDOW

INACTIVE HORIZONTAL
SCROLL BAR

SIZE BOX

Directly below the title bar on this window is a statJStJcs line. It tells you how many
documents are contained by the current window, how much space on the disk is in use, and how
much is still free.
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WHAT

To Do

WHY

You ARE DOING IT

Select the trash can.

You want to do something with the trash, so it must be
selected.

Double-click the trash can .

Open the trash can icon on the desktop.
Notice that the title bar of the disk window (the one
called System Start-Up) becomes clear, except for the
title of the window, indicating that the window is no
longer selected. The trash is now the selected window
and its title bar has the close box, the zoom box and horizontal lines (Figure 3.27).

.,

Figure 3 .27

The Trash is now the
selected window. The title
bar of the System Start-Up
window is clear, indicating
that it is de-selected.

To re-select the disk window, all you need to do is click the mouse pointer anywhere in it.
Try this now. You may also re-select a window by double-clicking its icon , even if it is a hollow
icon. This is a useful technique in the event that the desired window is completely hidden by
another window. Double-click the trash can icon to re-select the trash window.

WHAT

To Do

Position the mouse on the Trash window's close box.

Figure 3.28

Note that the point of the
mouse pointer is in the
close box. It is the point of
the mouse pointer arrow
that is active.

WHY

You ARE DOING IT

The Close Box is the one located on the left side of the
title bar. We want to use the Close Box rather than the
close option on the File menu. For this box to work, the
point of the mouse pointer must be inside the box before
you click the mouse button (Figure 3.28).
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Click the mouse button once.

The single click will close the window. When you close
the trash , the open disk window will become selected.

Position the mouse on the Zoom Box of
the open disk window.

The Zoom Box is the one located on the right side of the
title bar. It opens the window so that it covers almost the
complete desktop.

Click the mouse once on the zoom box
of the disk window.

The disk window will fully open and your desktop should
look somewhat like Figure 3.29.

r

a

Figure 3 . 29

File

The zoom box has been
clicked, causing the System
Start-Up window to fill the
desktop.

Position the mouse pointer on the zoom
box again.
Click the zoom box.

The window should return to the size and location it was
in before you zoomed it.

This last point should be remembered. You will see in the next sections that the size, shape
and location of windows can be changed in another fashion. When you use the zoom box to
change the window size, it is not permanent. The window will always return to the size, shape
and location it had on the desktop prior to being zoomed.
Let's prove this.

WHAT

TO Do

WHY

You ARE DOING IT

Click the zoom box on the disk window.

Make the disk window fill the desktop.

Click the window's close box.

Close the window.

Re-open the disk icon by using the
double-click method.

This window will open to its original location, size and
shape.
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3 .17 MOVING A WINDOW

The title ba r is used to move the location of the window on the desktop. Recall that to move a n
icon on the desktop you had to point to the icon, press and hold the mouse button, drag the
mouse to the new location, the n release the button. While you were dragging the icon , you only
moved an outline of the icon. It was not until the mouse button was released that the icon itself
moved to the new location .
You move a window using a simila r technique. You place the mouse pointer anywhere in the
title ba r of the window you want to re-locate on the desktop (except fo r in the close o r zoom
boxes, of course). Click and hold the mouse button . Drag the mouse to see the outline of the
wi ndow moved to the new location. Finally release the mouse button a nd the window wi ll move
to the new location on the desktop. When you move a window , you are permanently doing so, at
least until you move it again!
You may move a window to any location you want on the desktop. It is even possible to move
a window so that pa rt of it is off the desktop. It is not possible, however, to move a window
completely off the desktop. A small portion of the title bar will always remain with which you
can select and drag the window.
Try moving the disk window to the top left corner of the desktop.

WHAT

To Do

WHY

You ARE DotNG

IT

Move the mouse pointe r to the title bar
of th.e disk window.
Press and hold the mouse button .

Select the current window. By holdi ng down the mouse
button, you are telling the Maci ntosh that you plan to do
something with the window.

Drag the pointe r toward the top left corner of the desktop (Figure 3.30).

Change the location of the open window on the desktop.
Note that, j ust as when you moved an icon, only an outline of the window moves at this ti me.

Figure 3.30
Notice the outline of the
window as it is being
dragged.
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Release the mouse button.

Releasing the mouse button tells the Macintosh that you
have completed the move. The window wi ll move to the
new location (Figure 3.31 ).
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Figure 3.31
After releasing the mouse
button, the outline of the
window disappears and
the complete window
moves .
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3.18 CHANGING THE SIZE OF A WINDOW
The lower right corner of the window contains the size box. With this box you can make the
wi ndow permanently larger or sma ller. Generally, you may open a window to as la rge as you
want , even covering the disk and rrash icons. This is larger than the zoom box goes, which leaves
space at rhe right of the desktop ro display the disk and trash icons. If you are using a full page
display on your Macintosh, or the larger display of the Macintosh II, Ilx, Ilcx o r Ilci, you will
find that some application programs will not let you make their w indow large enoug h to cover
the complete desktop. This is application specific, however. The smallest you can make a window on the desktop is approximately one inch square. Again, different applications may not let
you make the ir acrive window that small.
Try usi ng the size box to change the size of the disk window.

WHAT

TO Do

WHY

You ARE DoiNG lr

Place the mouse pointer into the size
box at the lower right corner of the disk
window.
Press and hold the mouse button.

Select the size box as the desired act ivity.
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Drag the mouse down and to the left
(Figure 3.32) .

Figure 3 .32
The size box at the lower
right corner of the window
is used to change the
shape of the current
window.
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You are going to make the window tall and skinny.
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Release the mouse button.

Complete the re-sizing of the window. It should now be
tall and skinny (Figure 3.33).

Figure 3.33
The window will change
its shape after you release
the mouse button. You can
see the mouse pointer in
the size box.

Once again, place the mouse into the
size box.
Press and hold the mouse button.

You are again selecting the size box.

Drag the corner of the window toward
the top right corner of the desktop
(Figure 3.34).

You are going to make the window short and fat.
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Figure 3.34

Complete re-sizing the window. It should now be short
and fat.

Release the mouse button.

Now make the window as small as you can. Drag the size box as far to the left and up as it
will go (Figure 3.35) , then release the mouse button. Complete this section by making the
window large e nough so that you can see the icon called Syste m Folder in the window.
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Figure 3 .35
Windows may be made tall
and skinny, short and fat,
large or small.
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3 .19 A BRIEF LOOK AT FOLDERS

One more feature of windows to be discussed is the scroll bar. Before doing so, however, we
must make a minor digression into the topic of folders (more will be said about folders later in
this chapter).
A folder is a device for organizing information stored on a disk. The folder icon looks like a
miniature manila folder.
As you create documents, they will begin to clutter the disk window. To reduce this clutter,
you may put documents into folders. How you group documents into folders is completely up to
you. You may want to group them by class, such as Business Spreadsheets, English Papers,
History Pape rs, a nd Physics Papers . Or you may want to g roup them by program, such as Word
Documents, Excel Documents, and FileMaker Documents.
On the start-up disk you have been using you should find at least one folder, called the
System Folder. (Your system folder may have an icon of a Macintosh on it, similar to the one
seen on the system folder displayed in Figure 3.35. This indicates that the contents of the folder
can be used to boot the computer, making this a boot disk. Older versions of the Macintosh
System software do not include this feature.) The System Folder contains the System and Finder
files needed to start the Macintosh, along with a variety of other system-related documents. The
number of documents found in the System Folder can be anywhere from the minimum of two, to
well over one hundred. Depending on the sou rce of the start-up disk, the System Folder generally holds between ten and thirty-five documents.

-

3 .20 THE SCROLL BARS

Use the mouse to select, then open the System Folder icon on your start-up disk. Do this by
pointing to the folder and double-clicking the mouse. If you are having trouble with the doubleclick, you may select the folder and use the Open option found on the File menu. Notice that
you open a folder in exactly the same fashion as that used to open a disk. You should also
notice that a folder window has exactly the same features as the disk window.

,

Figure 3 .36
The system folder is typical
of an open folder. The
fundamental items making
up this window are the
same as those which made
up the disk window.
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Look below the left end of the title bar to determine the number of items that the folder
contains. In Figure 3.36, the System Folder contains 15 items. You are able to see, however,
only six of these items. Notice that the bars at the right and below the window are now shaded.
These bars are called scroll bars. They let you move (that is, scroll) the information displayed
through the window.
The scroll bars become active only when there is information belonging to the current folder
(or disk) that is outside the opening of the current window and therefore not being displayed.
That is, there is more in the window than can presently be seen! If the window is large enough to
display the complete contents of the folder (or disk), then the scroll bars are clear.
It is also possible for only one of the two scroll bars to be active. For example, if the
window is sized to the complete width of the desktop, but only one inch high, you might see the
vertical scroll bar on the right of the window, but not the horizontal one below the window. This
means that there are more icons "hiding" above or below the current window opening, but not to
the left or right of the current window opening. (If your System Folder does not display active
scroll bars at this time, use the size box to make the window as small as possible. The scroll bars
should then appear.)
Almost every program that uses documents larger than the size of the Macintosh screen uses
scroll bars to let you position the desired portion of the document into the active work window.
Because of this, it is important that you understand the functioning of the scroll bars, and the
various ways in which they can be used.
Think of the scroll bar itself as representing the total possible size of the open document
(right now, this is a folder or disk). Depending on the amount of information not displayed in the
window, the total size represented can be a large or small amount. For example, consider the
vertical scroll bar of a word processor. It represents the total length of the document. If the
document is two pages long, then the scroll bar represents two pages. The middle of the scroll
bar is the position of the page break between the first and second pages. However, if the
document is one hundred pages, this same scroll bar is divided into 100 equal positions. One
quarter of the way down from the top is page 25, while the middle is page 50. You will have the
opportunity to experiment with the word processor's scroll bar later in this text.
The scroll bar on the right of the window, the vertical scroll bar, represents the total possible
height of the item. The one on the bottom, the horizontal scroll bar, represents the total possible
width of the item. The small box, which will be referred to as the scroll box, located on each
scroll bar represents the vertical and horizontal portions of the item that are currently displayed
in the open window.
By looking at the position of the scroll box on the scroll bar, you are able to tell if there is
more of the current item above, below, left or right of the open window. If the scroll box is
approximately centered on the vertical scroll bar, then the window is displaying the middle of the
document. If the scroll box is at the bottom of the vertical scroll bar, then the window is
displaying the bottom or end of the document.
To see another portion of the item in the window, you use the scroll bars. There are three
ways to use the scroll bars. You may click on one of the arrows located at the ends of the scroll
bars. If you click and hold the mouse button, the scroll box will gradually move all the way from
one end of the scroll bar to the other. As it scrolls, you will see the contents of the window pass
by. When you see the item you want appear in the window, simply release the mouse button to
stop the scrolling.
The second method for using the scroll bars is to click on the shaded scroll bar itself. This
will cause the contents of the window to jump, rather than to scroll. Depending on the application program in use, you will see that the actual location of the mouse pointer on the scroll bar
can effect the amount of the jump. For example, if you are using a word processing program or
electronic spreadsheet, the amount the window scrolls when clicking the scroll bar is usually a
screen's worth of information.
The final way to use the scroll bar is to drag the scroll box to the desired location on the
scroll bar. To do this, move the mouse pointer to one of the scroll boxes, click and hold the
mouse button, drag the scroll box to the desired location on the scroll bar, and release the mouse
button.
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You should be getting fairly good with the mouse by now. Before you continue, try using
these three methods of scrolling the System Folder window. If you are using the arrows at the
ends of the scroll bars, you will notice that as the contents of the window scroll, the scroll boxes
change their position on the scroll bar. In Figure 3.37 , the vertical scroll box is near the bottom
of the vertical scroll bar, indicating that we are looking at the bottom of the window. From this it
can be concluded that there are no more icons below the ones displayed. The horizontal scroll
box, however, is only about one-third of the way across the horizontal scroll bar. This suggests
that there are more icons to the right of the open window.
Figure 3.37

The right horizontal scroll
arrow is being used.

"

•

.,

File Edit Ulew ~ ~

Systl
21ttmS 67SK1n

System Folder
1:5ftoms

(

104K~v~fllb~

67:51(1ndlslc

~

~)~

[!g)

Gtntnl

Sol.nd

Scropbook Fll

=r

lu.rPrtp

lutrVrttor

: i ' ,. ' i

i· ; . il~

'i!ll::
~n

:·:

..:::

: -:

..
·: ·

.:::.

::::

::::
::..

-

3 .21 INITIALIZING A DISK

When you purchase a disk it has no information on it. For the Macintosh to be able to use the
disk it must be initialized. This process puts information onto the disk that makes it usable. It
defines the locations on the disk that information can be stored, and creates a special area on the
disk, called the Desktop. The Desktop is a file that contains the names of all the other files and
folders on the disk. In essence, it acts like a table of contents , or di rectory, for the computer,
letting it locate the information stored on the disk. It includes information about whether a folder
is open or closed, and its size when open, and the location of any icons contained by the folder.
This file is updated every time you eject a disk. Because the Desktop file is really the concern of
the Macintosh, it is never actually displayed when the disk is loaded into the computer. It is an
invisible file.

Macintosh Productivity Tools

To initialize a disk is a simple procedure. Insert a new disk into one of the Macintosh's disk
drives and wait a few seconds. Whenever you insert a disk into a Macintosh disk drive, the
computer tries to read the Desktop file. When it fails at this task, a dialog box appears. The
dialog box, sometimes called an alert box depending on its contents, is the Macintosh's main
method of communicating with you when it wants your attention, when it needs information
from you, when it wants to give you a warning, or when it wants you to perform a task. You will
see them frequently when working with the computer. This particular dialog box is asking if you
want to initialize the disk (Figure 3.38).
Figure 3.38
~

Tills disk Is unreadable:

lD

Do you went to Initialize It?

Do not initialize a disk if
you think it is supposed
to already have information saved on it.

As you can see, this dialog box presents you with three options. Each option is enclosed in a
box, and is called a button. Almost every dialog box you see will have at least one button, an
OK or Continue button. To select an action, move the mouse pointer to the desired button and
click the mouse. Also notice that, in this dialog box, the Eject button has an extra outline.
Buttons that are highlighted in this fashion can be activated by pressing the Return key on the
keyboard, in addition to clicking on them with the mouse. This is a style of button that you will
see with many Macintosh applications.
Try initializing a disk now.

WHAT

To Do

WHY

You ARE

DOING IT

Insert a brand new disk into a disk
drive. If you have only one disk drive
available, use the Eject command to
eject the Start-up disk from the disk
drive , then insert the new disk into the
disk drive. The Macintosh will then tell
you when it wants you to insert the startup disk.

After a brief pause, the first dialog box will appear. If
you are not using a new disk, you will not see this dialog
box. In some cases the computer will recognize that the
disk has been formatted, but for a computer other than
the Macintosh. When this occurs, the message will read
"This is not a Macintosh disk: ", rather than the message
"This disk is unreadable:".

Move the mouse pointer to the button
labelled "Two-sided" and click the
button.

Tell the Macintosh that you want to initialize this disk.
Do this ONLY if you really want to initialize this disk. If
you think that there may be other information on this
disk, either for a Macintosh or another computer, then
click the Eject button in the dialog box and do not initialize the disk. (NOTE: If you are going to use this disk in
a Macintosh that has only 400K disk drives, click the
mouse on the one-sided button.)
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Figure 3.39

This disk is going to be
initialized double-sided.
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This disk Is unreadable:
Do you want to Initialize It?
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Move the mouse pointer to the Erase
button and click the button.

Figure 3 .40

Confirm that you want to
erase the disk.

,. li

System Versions 6.0 and later give you one more chance
to change your mind before you initialize the disk. As
this d ialog box says, you are about to erase the disk. Be
sure that you want to continue. If you are using System
Ve rsion 5.0 or earlier you will not see this message.
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MY DISK

Ty pe the words MY DISK at the keyboard to replace
the defau lt (preassigned) name " Untitled··. This will
assign a name to this disk. A disk name may be from I
to- 27 characters in length.
The Mac intosh identifies all disks by the name that you
give the disk. The disk name lets the computer keep track
of more disks than you have disk drives. This lets you
easily copy complete disks when you have only one disk
drive, or copy documents and folders between disks
when you have only one disk drive. You will also find it
is a convenient way to keep track of your disks. If you are
using System Version 5.0 or earl ier you will not see th is
dialog box at this time. It will appear after the formatting
process is complete.

Figure 3.41

Be sure to change the
name you intend to assign
this disk from Untitled to
MY DISK.

,. li

File Edit Ulew Special
•

•••

••

••••••••••

i

•

•

0

i:

••

•

••••••

I~

ll I:II !:II: I! II1I!! Ill!I l:I11111!11:!Ill! I: ll :Ill,

I

OK

:~:~:~:~:~: [
:; :;::::::::
. . ....

i/l,',iillil

Macintosh Productivity Tools

Move the mouse pointer to the OK button on the desktop and press the mouse
button .

Tell the Macintosh that you will keep the name MY DISK
for this disk. Notice that the OK button is highlighted
with the extra outl ine. Remember, you can activate this
button by pressing the Return key. You do not have to
click it with the mouse.
The dialog box will now tell you that the computer is formatting the disk. With older System Ve rsions, the " name
your disk" dialog box follows the fo rmatting process,
rather than preceding it.
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Figure 3 .42

Begin the initialization
process by clicking the
mouse pointer on the OK
button.

Please name this dlslc:

jMY DISK!

After the d isk has been formatted and named , it will appear on the Macintosh's desktop ,
ready for use. If you open the disk icon, you will see that it contains no items, but that some of
its space is a lready in use (Figure 3.43). This occupied space is taken up by the invisible
Desktop file.
Figure 3.43

The newly initialized disk
is empty. Note that 7K is
already in use in this disk,
occupied by the invisible
Desktop file .

...

.....

A nice feature of most Mac intosh programs is that they are able to recognize an oninitialized, o r un-fo rmatted , disk whe n it is inserted into a disk drive . When this happens, the
progra m will interrupt its cur rent task to let the Mac intosh carry out the disk initializatio n
process that you just completed. To you , the user, this means that if your data disk fills up, you
will not be faced with the loss of data if you do not have to have a pre-initialized disk available. A
disk may almost always be initialized when you need it.
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A final reminder about initializing disks. This process erases anything already on the disk.
Permanently! In the normal course of affairs, you need to initialize a disk only one time. T_he
Finder's Special menu contains an "erase disk" option (made available by first selecting a disk
icon on the desktop) that lets you re-initialize a disk, and completely erase its contents. Use this
option with care, and only when you are sure that you want to throw away the complete contents
of the disk.

-

3 .22 FOLDERS

Recall that a folder is a device used for organizing and containing the information on a disk, just
as you use a manila folder to organize and contain information in your office or work area. A
folder will hold whatever you place into it. In fact, you may place folders inside of folders! With
this technique, you can organize your information in any fashion desired.
Once you have a folder, putting documents or programs into it is very easy. All you do is
drag the desired item from its current location to the folder. When the icon of the destination
folder becomes selected, release the mouse button to ·" drop" the selected item into the folder.
You will do this later in the chapter. First, however, you must start by creating new folders.

-

3 .23 CREATING AND NAMING A NEW FOLDER

As with everything else you have been doing, there is more than one method you can employ to
create a new folder on your disk. You may use either the File menu, or a command key
equivalent.

WHAT

TO Do

WHY

You ARE DOING IT

Move the mouse pointer to your newly
initialized disk, MY DISK.
Double-click the mouse.

Open the disk icon. You must have a disk icon opened,
and the window selected , to be able to create a new
folder. Your disk will be empty.

Move the mouse pointer to File on the
menu bar and pull down the File Menu.

The New Folder command is found on the File Menu.

Drag the mouse pointer down to the
New Folder item.

Select the New Folder item on the File Menu (Figure
3.44).

M;~cintosh

,

Productivity Tools

Figure 3 .44
The New Folder command
is located on the File
Menu .

..
..
.::::_.
.

Release the mouse button.

A new folder, called Empty Folder, will appear in the
window of MY DISK (Figure 3.45). Note that the New
Folder item may be selected by using :M:N.

:M:N

Press the :M:N and create a second new folder. This folder
is called Copy of Empty Folder.
The Macintosh will NOT let you use the same name for
two items (folder, document, or application program) in
the same window or folder. You cannot have two folders
called "Empty Folder" ex isting in the disk's window.
You cannot put two word processing documents called
"Term Paper" into the same fo lder! Clearly, the answer
is to change the name of one of the items.

Select the first folder you created (the
one called Empty Folder) by clicking
the mouse pointer on the folder icon.

,. •

File

Edit
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You are going to change the name of this folde r.

,

Figure 3.45
An empty folder has been
created on the disk.
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Word Processing

Type the name " Word Process ing." Th is is the name you
are going to give th is folder. As you type , the new name
will appear under the folder.

Press the RETURN key.

The Return key tells the Macintosh that you are done typing and to record the name . (If you r keyboard has a key
labeled ENTER, do NOT press it since it performs a different function than the one marked RETU RN.) The old
folder name will be replaced with the new name.

Click the mouse on the second folder.

You are selecting the second folder so that you can
change its name.

Misc. Stuff

Type the name " Misc. Stuff" to change the name of this
folder.

Click the mouse in the disk window.

Clicking the mouse pointer on the empty space of the
open window will have the same effect as pressing the
Return key. The folder name will be changed. However,
this action will leave neither folder selected.

.,

Figure 3 .46
The two fo lders have been
re-named.
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T h e tech nique you j ust used to change the name of a folder can be used to change the
name of ANY Macintosh icon . For example, if you want to change the name of your disk ,
select it with a single click of the mouse, type a new name, the n press enter. The same holds fo r
c hang ing the name of a docume nt on the disk , or even the name of an application program !
There are very few limitatio ns on what you choose for a document, folder o r program name. You
are , however, limited to 3 1 characters fo r folder or document names a nd 27 characte rs fo r disk
na mes. Most important , a colon (:) cannot be a part of any name, since it has a spec ial meaning
to the Macintosh in relation to how it stores files on disks a nd in folders.

Macintosh Productivity Tools
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3 .24 COPYING DOCUMENTS/ITEMS
BETWEEN TWO DISKS

Now that you have a second disk initialized and some folders ready, you are able to make backup copies of your documents. You should always make a second copy of any document on
which you are working ON A SEPARATE DISK before you leave the computer. It is a well
known fact that disks fail at the most inopportune mome nt , such as when you are about to print
the final copy of a proj ect you have been working on for the past eight weeks. If you always have
at least two copies of a document on two separate disks you w ill have a bette r chance of
recoveri ng your work when this happens to you.
Whe n you copy a document o nto a second disk, you may place it on the disk at the " top"
level (that is , it will appear w ith any folders you may have on the disk) , or you may place it
directly into a n existing fo lder. If you have folders inside folders , and they are open or visible in
some way, you may even place the document into these inner folders. In fact , you may place the
document into any folder icon that is visible on the Macintosh desktop.

WHAT

To Do

WHY

You ARE DotNG lr

Click the mouse pointer on the disk icon
for MY DISK.

Make sure that you r disk is currently selected.

Drag the d isk window's size box until
only the two new folders are showing in
the disk window.

You wi ll be working with multiple windows open in this
section, and to be able to see their contents at the same
time, they must be sized down.

Drag the window for MY DISK to the
bottom of the desktop.

You are placing this open window at the bottom of the
desktop to make room for the other window that you will
open. Remember, to move a window, put the mouse
pointer on the window's title bar, press and hold the
mouse button, the n drag the outline of the window to its
new location on the desktop. Complete the move by
releasing the mouse (Figure 3.47).

,. •
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Figure 3 .47
Your desktop should look
similar to this.
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Clic k on the title bar of the System
Folde r, found on the start-up disk.

Make the System Folde r acti ve.

C lic k the zoom box on the Syste m
Folder.

Make the System Fo lder fill the des ktop.

Use the s ize box to sho rte n the System
Folder wi ndow e nough so that you can
see the window fo r MY DISK.

You want to be able to see both wi ndows. T he first ite m
you will copy will be placed d irectly into a folder on MY
DIS K. To be able to do this you must be able to see the
destination folder on the desktop.

Locate the icon labelled " F inder" in the
System Folder. C lick it once , and hold
the mouse button down .

You a re going to copy the Finde r from the System Folder
on your start-up disk to the Misc. Stuff folde r on MY
DISK. You have now selected the Finder, a nd you a re
ready to do something with it s ince you have not yet
released the mouse button.

Drag the outline of the Finder icon to
the folder called Misc. Stuff.

Whe n the Fi nde r outline is in the proper location , the
M isc . Stuff folde r will become selected .

.,

Figure 3.48

With both windows visible
on the desktop, you are
ready to copy information
from one disk to another.
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When the destination folder becomes
selected , re lease the mouse button.

Releasing the mouse button tells the Macintosh to move
the icon of the F inde r to the new location. The compute r
immediately realizes that the new location is on a d iffe re nt disk tha n the orig inal. This tells it that you want a
copy of the fi le made and placed a t the destination location. You can see in Figure 3 .49 that the outline of the
Finder icon is over the now selected fo lde r called M isc .
Stuff. In this figure . the mouse button has not yet been
released , thus the Finde r is still selected in the System
Folde r window, and the Misc. Stu ff fo lde r is selected as
the current destination of the copy.
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Figure 3 .49
The Misc. Stuff folder is
selected as the destination
location of the copy.
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When you release the mouse, a dialog box will appear to
let you know how many documents are to be copied.
Newer vers ions of the System file will also give you a bar
chart indicating the prog ress of the copy.
When the copy is completed , you will notice that the
Finder file is still in the System Folder on the disk System Start-Up. Moving a document or application program between two disks always copies it (except in
those instances where the document is copy protected in
some way) , leaving the original copy at its starting location on the source disk.
Double-click the Misc. Stuff folder.

Open the Misc. Stuff folder on the disk MY DISK.
Observe that this fo lder now contains a copy of the
Finder.

Click the C lose box on the Misc. Stuff
folder.

C lose this folder, it is in the way.

Cl ick on the fi le called "Scrapbook
File" found in the System Folder. Hold
the mouse button down.

This time you will copy the Scrapbook file.
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Drag the outline of the Scrapbook File
to the ICON of MY DISK at the top
right corner of the desktop.

Figure 3 .50
Copy the Scrapbook File to
the icon of the disk. Note
that the hollow icon for
MY DISK is selected in this
f igure as the destination
of the copy.

The icon of the disk MY DISK is a hollow icon at the top
right of the desktop. However, you may still put things
onto it for copying purposes. You may always copy to a
disk icon , regardless of whether a window is open or not
for that disk.
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Click on the MY DISK window title
bar.

When the copy is done, make MY DISK the active window. One of the scroll bars should now become active. A
new document has been placed on the disk at the level of
the current wi ndow, but it could not be displayed in the
small opening.

You mai copy anything you want between two disks in this fashion. Simply drag the desired
icon from one disk to another. You may copy documents and applications one at a time , or you .
may copy a folder, which will cause all the documents contained in that folder to be copied with
it. If you have selected several icons, then they will all be copied at the same time. You will see
that the outlines of the icons move together in a temporary group, and will appear on the
destination disk after the copy in the same relati ve positions if you are copying to an open
window .
An important thing to remember about copying files in this fashion is that the files are
added to the already existing contents of the destination disk . If a document name already exists
in the destination window, a dialog box will appear (Figure 3.51) ask ing you to confirm that you
want the item on the destination disk erased before the new copy is placed there in its stead. It is
important to remember that the computer is looking at just the names of the two documents.
Thus, even though one may be an Excel worksheet and the other a Word text document, the
computer will still give you "this warning. All other information on the destination disk will
remain unchanged when you copy documents in this fashion.
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Figure 3 .51
You will see this dialog
box if the destination of a
copy contains any
document of the same
name as one being copied.

Replace Items with the same names
with the selected Items?

l

OK

J (Cancel ]
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3 .25 MOVING DOCUMENTS INTO AND OUT OF
FOLDERS
To move an item into a fo lder involves the same basic process you have used to copy an item
between two disks. The differe nce is that when you move an icon into a folder, or between two
folde rs, on the same disk, the document is not copied. You a re only changing the w indow in
which it wi ll appear.
To place an icon or document into a fo lder, all you need ro do is d rag it from its current
location to the des ired folder. To remove the icon from the folder, drag it out of the folder to the
disk window or to another fo lder o r w indow. The destination folder may e ither be closed or
open.

WHAT

To Do

WHY

You ARE DOING IT

Click on the Zoom box of MY DISK.

Open the disk window. You should now be able to see all
the icons on th is disk. There are the two folders and the ·
Scrapbook file that you just copied from the Syste m
Folder on the sta rt-up disk (Figure 3. 52).

Point the mouse at the Scrapbook file
and click and ho ld the mouse button.

You are going to move the Scrapbook to a new location
on th is d isk.
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Figure 3 .52
There are three items in
this window. The two
folders and the Scrapbook
File that was copied to the
icon of MY DISK.
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Drag the Scrapbook to the Misc. Stuff
folder and release the mouse button.

Figure 3 .53
Note the outline of the
Scrapbook File has been
moved to the Misc. Stuff
folder. When you release
the mouse button, the
Scrapbook icon will
disappear from the
current window.
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Move the scrapbook to the Misc. Stuff fo lder (Figure
3.53). Do not release the mouse button until you have the
Misc. Stuff folder selected, as it is in Figure 3.53.
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Double-click on the Misc . Stuff folder
icon.

Open the Misc. Stuff folder. You can see that the Scrapbook has been added to the contents of this fo lder.

Select both the Finder and Scrapbook
documents.

Now you are going to move both of these documents out
of the folder. Remember that you can select two or more
icons by the shift-click method or by dragging the mouse
over both icons while holding down the mouse button .

With both icons selected, point to the
Scrapbook then cl ick and hold the
mouse button.

You move two or more icons by moving just one of the
selected icons. Other icons in the selected group will
move with the icon you are dragging. In this case, you
have decided to move both icons by moving the Scrapbook icon.

Drag the outlines of the two icons out of
the Misc. Stuff fold er to the disk folder.

You are moving the two icons (Figure 3.55) out of the
Misc. Stuff folder to the open window of MY DISK.
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Figure 3 .55
Since both icons in the
Misc. Stuff folder are
selected, moving one icon
wi/1 move both.

Complete the move of the two icons (Figure 3.56).
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Figure 3 .54
The current content of the
Misc. Stuff folder.
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figure 3 .56
After releasing the mouse
button, both icons are
moved out of the Misc.
Stuff folder. Note that for
the time being, they
remain selected.
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3 .26 DUPLICATING A DOCUMENT OR FOLDER
ON THE SAME DISK

It is always possible that you may want to make a duplicate of a document or file. For example,
you may have a spreadsheet you wa nt to change, but you want to keep the original un-changed.
Or you may have a letter you want to modify slightly and send to a second person, but you want
to also retain the original. As long as sufficient space exists on the disk, this is a simple task.

WHAT

To Do

WHY

You

ARE DOING IT

Move the mouse to the window for MY
DISK.

You are finished worki ng in the Misc. Stuff folder, and
will be working at the disk level.

Click the mouse button once.

You are selecting the MY DISK window, and at the same
time de-selecting the two icons that were copied out of
the Misc. Stuff folder to the disk level.

Move the mouse to the Scrapbook icon.

This is the document you want to duplicate.

Click the mouse button once.

Select the Scrapbook icon.

Pull down the File menu.

The Duplicate command is fo und on the File Menu .

Drag the mouse pointer down the File
Menu to the Duplicate command.

Select the Duplicate command.

Figure 3 .57
Note that you may also use
the X D key to duplicate a
selected icon.

Vor d

Close

xw

Get Info

XI

Findor

Put 11111111.1

Pege Setup •.•
Print Directory ...
E eel

XE

::::::::::

. . .. .
....
...... ....
.......
..
-:-:-:
-:-:
... . .....
.......... ....

:;::::::::

.. . . .

J ; . ; - r - - - - - - - - - - -- - - - ---r:ld*li-J>H>

: ::~: ~ :~: ~ :~: :~

Release the mouse button.

A duplicate of the Scrapbook file, called Copy of Scrapbook File, will appear on the desktop.
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Figure 3.58
A duplicate of the
Scrapbook is now in the
window, along with the
original.
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3.27 BACKING UP A COMPLETE DISK
The most efficie nt way to make sure that you have copied everything you need from one disk to
another is to copy the complete disk , not j ust a single file.
There is a major difference between copying a complete disk and copyi ng just one or two
docume nts. When you copy a complete disk , all prior folders, files or documents on the
destination disk are erased. All the fo lders, files and documents on the source disk (except
invisible files) are then copied to the destination disk.

WHAT

To Do

Close the MY DISK, System Folder,
and Misc. Stuff windows.

WHY

You ARE DotNG lr

Clean up the desktop so that you can see what disks you
have, and where they are located.
Figure 3 .59
Your desktop should look
similar to this figure .
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Place the mouse pointer on the icon of
your START-UP disk and click the
mouse button once.

Make the start-up disk the selected disk.

Press and hold the mouse button, and
drag the outline of the sta rt-up dis k to
the icon of your disk, called MY DISK .

You want to copy the complete d isk. Drag the start-up
disk icon to your d isk icon until your dis k becomes
selected.

Figure 3 .60
The hollow icon of the
System Start-Up disk is
dragged to the disk MY
DISK so that the complete
disk is copied.
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Tell the Macintosh to copy the disk. At the same time,
you are telling it the destination d isk fo r the copy.

Release the mouse button.

You will now see a dialog box asking you to confirm that
it is O K to erase completely the contents of MY DISK
and replace it with the contents of your start-up disk.
Figure 3.61
Confirm that you want to
copy the System Start-Up
disk onto MY DISK.
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Move the mouse pointer to the OK button and cl ick the mouse button once.

Confirm that this is what you want to do. Anyth ing o n
the destination disk, MY DISK in this case, will be
erased!
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The copy process will take several minutes to complete.
If the disk you are trying to copy is ··copy protected,'' it
probably will not copy successfully, o r the software will
not run properly if it does. Remember, copy files and
disks only if they are your own work. It is against the law
to copy commercial programs without the permission of
the company.
Notice that the technique for copying a complete disk does not vary much fro m that used to
copy a sing le file. Drag the icon of the disk you want to copy to the new disk and click on OK .
You may find it adv isable to eject the original disk a nd slide its write-protect tab to the protect
pos it ion before you copy a disk. This way you w ill not accidentally copy your disks in the
"wrong" direction, e rasing your orig inals and replacing them with old back-up copies.

-

3 .28 REMOVING DOCUMENTS FROM YOUR DISK

Sooner or la ter you will want to get rid of o lder documents . This is the purpose of the trash can.
Documents, folders o r prog rams a re deleted from a disk by dragging the m to the trash can that
s its on the Mac intosh desktop. You will discover that when you put something in the trash can,
all you are doing is changing the icon 's location on the desktop, at least until you empty the trash
or ej ect the disk.

WHAT

To Do

WHY

You ARE DOING IT

Close any open windows on your
desktop.

We want to start with a clean desktop. This will ensure
that we are removing the fi les from the back-up disk MY
DISK, and not from the original start-up disk.

C lick and hold the Trash can icon, and
move it to the bottom right of the
desktop.

Return the trash can icon to its original location on the
desktop so that it will be easily accessed.

Open the MY DISK icon by doubleclicking the mouse pointer on the disk
icon.

We want to delete items from the back-up disk, so this is
the one we are opening.
·

Open the System Folder.

We are going to delete something from the system folder.

Locate the fi le called General.

This is the file we want to delete.

Move the mouse pointer to General, and
click and hold the mouse button.

Select the file General.

Drag the General icon to the trash can
at the lower right of the desktop.

Throw away th is document.

With the trash icon selected, release the
mouse button.

Releasing the mouse button wi ll drop the selected icon
into the trash. The General icon will disappear from the
folder, and the trash can will bulge, indicating that it contains at least one item.
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Figure 3 .62

The icon for the General
system document is placed
into the trash. You are able
to tell, in this instance,
that you are working on
your copy of the System
Start-Up disk since the MY
DISK icon is hollow,
indicating that it is open,
while the System Start-Up
disk icon is closed. This
may not always be the
case, however. Always be
cautious when deleting
files from a disk.
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Double click on the trash can icon.
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Look at the contents of the trash can. You wi ll see the
item you j ust threw away.
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Note that even the hollow
(open) icon of the Trash is
bulging, indicating that
there is something in your
trash. You can also see
that the General icon is no
longer in the system
folder.
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Because the item is in the trash can, it is possible to
retrieve it. To do so you simply drag it out of the trash
can window and put it back onto the disk. Do not do this
at this time. We want to dispose of this document.
Once the trash has been emptied , an item can no longer
be retrieved.
Pull down the Special menu from the
menu bar at the top of the desktop.

The Special me nu contains an option for emptying the
trash.

Drag the mouse pointer to the Empty
Trash option.

This option is avai lable only when the trash contains
something. If the trash is empty, the Empty Trash option
will be dimmed.
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Figure 3 .64
A her you empty the trash,
the information you have
thrown out can no longer
be retrieved.
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Release the mouse button.

Empty the trash. The trash can icon will return to normal
size.

Locate the icon fo r the Finde r in the
System Folder on MY DISK.

This is the next item you want to th row away.

Drag the Finder to the trash and release
the mouse button.

Throw away the Finder.
The Macintosh will recognize the Finder as a part of the
operating system. The computer is hesitant to throw away
parts of the operating system or any application programs, so you are now asked to confirm that you really
intend to throw away this document.

Click on OK.

Confirm that you want to throw away the Finder. If you
click on cancel, the Finder will not be th rown out.

.,

,. 4i File Edit Ulew Special

Figure 3 .65
Tell the computer you
really want to dispose of
the Finder.

rr-----------------====----------======--==~~·.~~
=
Are you sure you want to throw away
the system file "Finder"?
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You can throw out folders, as well as individual documents. Just drag the folder to the trash.
Any docume nt contained in the folder wi ll be thrown away with the folde r. If the re a re application programs contained in the folde r, you will receive the same warning message as the one you
saw when throwing out the Finder.
To remove everything on the disk simply select everything on the disk and move it as a group
to the trash. This gives you an empty disk. Another method is to select the disk, then use the
Erase Disk option found on the Special Me nu. As was me ntioned earlier, this option wi ll reinitialize the disk, and should be used with care.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.
II .
12.
J3.
14.
15.
)6.
17.
18.
J9.
20.
21.
22.
23.
24.
25 .
26 .
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38 .

What purpose does the Finder serve?
What does a boot disk do?
What two programs a re found on almost every Macintosh boot disk?
If you have two or more disk drives avai lable on your Macintosh, does it matter which one is used for the start-up disk?
The Macintosh screen is sometimes called a "desktop." What is the name of the graphic depictions of the items located on
the desktop?
What purpose does the mouse serve?
How can you tell when an item on the desktop has been selected?
What do you do to complete a mouse movement on the Maci ntosh screen if you run out of room on your physical desk?
Why is this possible?
How do you select an icon on the desktop?
How do you de-select an icon?
What is the difference between dragg ing and moving the mouse?
Do the d isk and trash icons have fixed locations on the desktop, or can they be moved?
How do you drag an icon on the desktop?
How do you make a pull down menu appear?
Why are some menu items dimmed when you pull down a menu?
How do you select a menu option?
What purpose is served by command-key equivalents?
What is meant by the te rm "double-click"?
What happens when you double-click the mouse poi nte r on a closed di sk icon?
Where are the following located on a selected window: the size box, the close box, the zoom box?
How can you tell a selected window from a n un-selected window?
Where must the mouse pointer be positioned so that you can c hange a wi ndow's location on the desktop?
When you drag a window to a new location on the desktop, must the window remain completely on the desktop, or can it
be positioned so that pa rts are off the desktop?
When do scroll bars become active?
What are the three ways you can use active sc roll bars?
What purpose do dialog boxes serve?
How do you initialize a new disk?
How often do you need to initialize a disk?
How do you create a new folder on a disk?
What can you put into folders?
Must you organize the contents of a folder in any particular fashion?
How do you put items into a folde r?
How do you make a back-up copy of a docume nt?
How many documents can be backed up simultaneously?
What happens to any othe r documents on the back-up disk when you copy documents onto it?
How do you make a back-up copy of a complete disk?
What happens to any other documents on a back-up disk when a complete disk is backed up, rather than a single
document?
How do you remove unwanted items from your disk?
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CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:

• Identify the System folder and the function it
serves.
• Explain the information stored as part of the
System program/file.
• Explain what a font is.
• Explain the difference between a bit-mapped
and laser font.
• Explain the difference between an "outline"
and a "solid" font.
• Define the function of the clipboard.
• Explain what DAs are, and the purpose they
serve.
• Use the following standard DAs:
Alarm Clock
Calculator

•
•
•
•
•
•
•

Chooser
Control Panel
Find File
Key Caps
Scrapbook
Start an application program running.
Exit an application program.
Add fonts and DAs to the System file using the
Font/DA Mover.
Erase/re-initialize a disk.
Use the Finder's View menu.
Change the default start-up.
Use MultiFinder.

-

4.1 THE SYSTEM FOLDER

The System Folder holds a variety of files and info rmation used by the Macintosh's operating
system. Some of the information is used when the computer boots, while other parts of it are
accessed when needed.
In current releases of the Maci ntosh operating system, you may identi fy the system folder by
the miniature icon of a Macintosh that is displayed on it (Figure 4 . 1). Earlier versions of the
operating system do not use this feature. The icon on the outside of the system folder tells you
not only that the folder is the system folder, but also that the disk holding that folder may be
used to boot the Macintosh.

Figure 4.1
Note the miniature icon of
a Macintosh on this folder.
This is a system folder.
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The system folder, to be a bootable disk, must contain at least the System file and one
application, usually the Finder. Beyond these two files, it is possible for the System Folder to
contain a wide variety of ite ms.
Many of the files a re in some way connected with the operating system, a nd are called
System documents . Some common syste m documents are the Scrapbook file, the Clipboard file,
MultiFinder a nd Backgrounder.
Anothe r type of item found in the System Folder is called an INIT (pronounced " in-it"),
which is short for initialization. When located in the boot disk's system folde r, !NITs are loaded
a nd executed during the boot process . INITs are sometimes referred to as Startup docume nts
because they modify the operating system during system startup to perform a specific fu nction.
For example, an INIT that is supplied with the Macintosh operating syste m is called Easy
Access. This INIT lets the user use keystrokes to move the mouse po inte r and/or to perform
functions that normally require the use of the mouse. However, if the Easy Access icon is not in
the boot disk's system folder during the startup process, the INIT is not loaded.
A CDEV (pronounced "see-dev") may also be found in your System Folder. A CDEV is a
Control Panel document. The control pa nel is a desk accessory. More will be said about desk
accessories and the control panel late r in this chapte r.
You will also find a variety of resource files in the System Folder. Resource files are also
called Chooser documents. The Chooser is another desk accessory, and will be discussed in
more detail later in this chapter. A resource file is one that is used by an application program to
accomplish a specific task. The most common resource files are the printe r resources, called
lmageWrite r, LaserWrite r and LaserPrep. Without these printing resources, application programs are unable to output to your printer.
In addition to these files, you may find some special application prog ra ms (such as the
PrintMonitor application used to laser print and work at the same time), temporary files, and
settings files. Temporary files a re c reated by many applications that need a place to temporarily
put information. These files come and go. After you have used Word to write a text document, it
is not uncommon to see a Word Temp file in your Syste m Folder. These temp files may be moved
to the trash at any time.
Settings files hold information about an application program . Their names vary, but usually
include either the word Settings or the word Defaults. The typical information in a settings file
may include whic h options for a specific program you have turned on, or how you want the
program to use the printer. For example, you will see that Word lets you select the level of menus
you want to use, either Short or Full. The type of menu display you choose to use is saved in the
file called Word Settings .

-

4 .2 DETERMINING WHAT IS WHAT IN YOUR SYSTEM
FOLDER
Now that you know there are d ifferent types of files stored in your Syste m Folder, you may be
curious to know how to tell what is what. Unfortunately, you cannot tell by looking at the icon
that an ite m is a Startup Document, a Control Panel document, or a System document.

Macintosh Productivity Tools

One way to find o ut what a pa rtic ula r item is, in the Syste m Folde r, o r a ny other folder for
that matte r, is to use the Get Info comma nd fo und on the Finder's File menu. This comma nd,
which may also be executed with the XI , will display a summary information window of the
currently selected icon.
If you do not yet have your computer turned on , turn it on now and boot it with a System
Start-Up d isk. After the compute r has started , use the mouse pointer to open the disk's System
Folder.

WHAT

To Do

WHY

You ARE DOING

IT

Locate the file called System in the
System Folder. Its icon is that of a
Macintosh computer.

You will be looking at the information window for the
System file.

Move the mouse pointer to the System
file and click the mouse button one
time.

Select the System file.

XI

Get the In formation window for the System file. If you
want, you may also use the mouse to pull down the File
menu , then select the Get Info item. The results will be
the same.
The information you have obtained may be slightly different from what is shown in Figure 4 .2. You can see that .
one of the lines of information displayed in this window
is Kind , and that the System file is a System document.

~

S,.,slom
System Softvart Ytrsio• 6.0 :
Klo"l : S,.,sttm docurntlll
Slu : 371 ,248 b\jtts usod, 3631< on disk

~

.,...,.. : S,.,sltm Start-1Jp, loltmal ~vt

Crnt•tl : Sat, Ac>r 30, 1988,12:00PM
Hodlfld: Moo, Apr I 0, 1989, 8 ::59 AM
Y•rslen: 6 .0 , C01>11rlghl Ac>plo Computtr ,
lr>c. 1983-88

Locate the file labelled Ge neral. Its icon
is also a Macintosh computer.

You now want to get the information for the General file.

Place the mouse pointer on the General
icon and click the mouse button once.

Select the General icon.
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XI

Figure 4.3
The information window
for the General Control
Panel document.

Get the Information window for the General icon. You
can see that this is a Control Panel document (Figure
4.3).

10

Info

0

leot.d
a.ntral
~ S.,sltm Soflv aro Vonion 6 .0
ICt.d: Control Pantl doa.rntnl
Sin: 14,191 bo,ltsUitd , 14Kondi• k

~

Crntod: Sal, AfK 30,1999,12:00 PH
Hodlfiod: Sal, AfK 30, 1999 , 12:00 PH
Yorsioa: 3 .3 , Copvr9>1 AppltC~Itr,
Inc. 1996-98

Use the mouse pointer to close the two
information windows. The close box for
these windows is at the left side of the
title bar, just as it is fo r any other
wi ndow.

You may leave several windows open on your desktop at
the same time, but it is a good idea to close windows
once you are through with them to avoid cluttering up
your compute r desktop.

-

4.3 THE SYSTEM FILE, DAs AND FONTS

T he System File is possibly the most important file fo und in the Syste m Folder. This file is the
Mac intosh ope rating syste m and is executed whenever you turn on the machine. The System F ile
also has installed in it fo nt files a nd desk accessories. Whic hever fonts and desk accessories are
conta ined in the Syste m file whe n you start the computer are available to the applications
programs you then use.
A desk accessory, or DA fo r sho rt (pronounced "D. A .," and not as a one syllable word), is
a specia l program that has been installed into the Syste m File and can be accessed and run even
whe n you a re running anothe r applicatio n progra m. Because they require real space on the d isk,
di ffe re nt start-up disks can have different desk accessories available . Two DAs have a lready been
me ntioned, the Chooser and the Control Panel. T hese two, along with several othe rs, a re s upplied by Apple Computer, Inc. with the operating syste m.
Fonts are descriptio ns of letters that are used as you type. The font files in the System file
define the shape and size of the lettering . Each fo nt in the System file has a name. Some
standard fonts are Helvetica, Chicago, Courier, Times, New Yo rk and Monaco . Many other
fonts are available through a variety of sources, both comme rc ial and free.
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There are two fundamental types of fonts available: bit-map fonts a nd laser fonts . A bitmap font has an exact description of each letter and symbol of the character set in terms of which
dots to print, and which to leave white. Figure 4.4 shows the bit-map of the letter A in the
Chicago font , at a size of 12 po ints. Some of the dots a re turned "on," a nd thus appear black
he re. These are the dots that will print, either on the screen or on the paper. Eve ry font that you
look at on the screen of your Macintosh is a bit-map font. Even laser fonts have bit-map
equi valents that are used for screen display. This is because the resolution (that is , the number of
d iscrete points) of the Macintosh display at 72 dots per inch does not allow the fi ne smoothing
achieved with the typical laser printe r's 300 or more dots pe r inch. Thus , a laser font would be
wasted o n the screen.
Figure 4.4
· - - -- - - - - --

-

~--

This display is from a font
editor. an application
program which lets the
user modify the bit-map of
a font. You can see the
dots that are turned on to
make up the letter A in the
font Chicago, size 12.
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A laser font is also an exact description of each letter and symbol of the character. set. It is,
however, a description in terms of how to draw the letters, rather than which specific dots to
print or not print. Because laser font c haracters a re drawn onto the pape r, you have much more
flexibility in te rms of the size and appearance of the final output. A bit-map font looks best when
used in one of its defined sizes. A laser font may be printed in almost any size and still look
good on the printed page.

-

4 .4 FONT SIZES
As suggested above, when you are using fonts, in addition to defining the shape of the lette r, the
Macintosh fonts also define the size of the lette r. When choosing a size to use fo r a font, you
must conside r the final output device, and whethe r the font is a bit-map or laser font. A bit-map
font looks and prints best when the size used matches a defined bit-map size. It is easy to tell
whic h bit-map font sizes have been defined , and which have not.
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4 .5

The font menu from this
application displays both
the fonts available in the
system file and the sizes
that the program will let
you use.
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When you look at the font size menu , you will notice that the point sizes listed appear in two
type styles-normal solid lettering and outline lettering. Figure 4. 5 shows a typical font menu
with the Helvetica font selected . You can see that the point sizes 10 and 12 are listed in outlined
lettering , while the point sizes 9, 14, 18, 24, 36 and 48 arc in solid lettering. The two outlined
lettering sizes, in this case 10 a nd 12 , are the defined bit-maps for this fo nt. Thus, if you are
using this fo nt to c reate a document , using 10 or 12 point type would produce the best appearing
output. You may, if desired , use one of the othe r sizes. If you do this, the Macintosh will
extrapolate from one of the bit-maps to try to ma ke a pleasing font. Sometimes it works, and
sometimes not. Figures 4.6A and 4.68 show the effects of bit-mat and laser fo nts on the display
and printed page.

9 point
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Figure 4 .6A
Fill £dll rormot Font Document Uttllttos Window
font demo
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Hen t. • ....,. of thl foat tn. 121 paWs.

Here are two fonts as they
will appear on the
Macintosh display in both
an outline and solid point
size
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ThiS IS Ne.._. Yorlc 12 po1nt Us ouUant Slles a rt 9.10. 12. 14 , IS and
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Figure 4 .68
The same text w hen
printed on a laser printer.
The laser font is smoothed,
while the bit-map font
retains its jagged
appearance.

Thas U Tnnesl2 pouu lu oullanc sues~ 9. 10. 12. IC, I I and 24. 11 isa Laic:.t fonl
llcrt ba wnpkolthcfon1 an 127 pouus.

AaBbC
Late r in the text, whe n you are working with Word, you will have the opportunity to
expe rime nt with differe nt font sizes, and you will be able to see first ha nd the effec t of using
outline fo nt sizes and non-outline font sizes. If you have a laser printer available, you will also be
able to determine which of the fonts in your Syste m fi le arc laser fon ts, and which are bit-map
fonts ... simply print a sample of each in a non-outline point size.
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4 .5 THE CLIPBOARD FILE

The Clipboard is a transient storage area. Its contents change constantly. As you work with the
Macintosh, whenever you use a Cut or Copy command (found on the Edit menu of most
software), the information that is cut or copied is placed onto the clipboard. The content of the
clipboard is always the most recent item cut or copied! If you cut a word, it goes to the
clipboard. If you then cut a different word, the first word disappears from the clipboard, to be
replaced by the second item, and so on.
In short, the clipboard is a special memory area. It is actually a file, called the Clipboard
File, found in the System Folder on your start-up disk (Figure 4.7). Even though it is constantly
changing, the clipboard is useful because it is not erased when you exit one program and begin
another. Thus, you can copy a picture in a drawing or painting program, or a chart from a
spreadsheet/graphing program, exit the program, start a word processing program, and paste the
graphic into the written document. At least you can do this if you do not cut or copy anything
else between the time you copy the graphjc in the fi rst program until you paste it into the second
program.
In essence, the clipboard is a special disk file that is accessed by every Macintosh program.
All editing changes go there, and it is a file that you may use to transfer information between two
Macintosh application programs. Many programs have a menu option to " Show Clipboard ." In
fact , you may find this option on the Edit menu of the Finder. Using it, you can see what is in the
clipboard file. Always remember, however, that the contents of the Clipboard are constantly
changing . If you want to trans fer several items between programs, there is another way, called
the Scrapbook, that makes multiple transfers a simple task. The Scrapbook is discussed later in
this chapter.
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4 .6 THE APPLE MENU

Figure 4 .8
These DAs are all supplied
by Apple Computer, Inc. as
part of the Macintosh
Operating System.

,. D
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You have undoubtedly noticed the small apple icon at the left of the menu bar. This icon is the
"Apple" menu , a nd it contains a special selection of options called d esk accessories , or DAs.
Some people refer to the menu as the DA menu. When you pull down this menu, you wi ll see
two sets of things. At the top of the menu is usually a n entry that reads "About ..." , which gives
you information about the program presently in use. You may also see items listed at the top of
this menu to provide help for the c urre nt program. Next, you will see a list of progra m names
that are available. These are the DAs.
Apple Computer, Inc., supplies several standard DAs with the Macintosh operating system.
They are mostly utilitarian in nature, but you may find the Puzzle DA installed on your System
Start-Up disk in addition to the Chooser, Control Pane l and others. Some are very utilitarian in
nature, and you can expect to find them as part of almost every System disk. They are the Chooser,
the Control Panel, Find File , Key Caps and the Scrapbook. DAs, since they are just programs that
can be executed by the Macintosh, can be created to do anything. You may find DAs to play games,
spell check text documents, give you access to a thesaurus, or read a HyperCard stack. Figure 4. 8
shows the DA menu found on the typical Apple supplied start-up disk.
Possibly the most important feature of DAs is that they may be used a t almost a ny time .
Ve ry few programs deny you access to the DA menu. This means that you may use a DA while
you are using another program. For example, you may want to change between a lase r and dot
matrix printe r while you a re working on a document to print a draft copy of your work. This task
is pe rformed with the Chooser DA , which may be selected while you are working on the
document in question. You may want to have the compute r g ive you an alert when a particular
time of day is reached so you can get to class on time . This is done with the Ala rm C lock DA.
These DAs, li ke all others, may be used even while you a re using a word processing or elect runic
spreadsheet program.

-

4 .7 USING DAs

A DA is executed in the same fashion used to select a ny menu option. Pull down the DA menu,
drag the selection bar to the desired item and release the mouse button . The re a re, of course, a
few exceptions to the rule that a DA is al ways accessible. Some application programs will not let
you have access to the DAs when they a re busy performing a special task that requires all of the
Macintosh's attention. This is relatively rare, however.

-

4 .8 THE ALARM CLOCK
The first DA listed on the DA menu in Figure 4 .8 is the Alarm Clock. This is a multifunction
DA . It will display the curre nt time of day as dete rmined by reading the compute r's inte rnal
clock . It also keeps track of the calenda r date. In addition, the Alarm Clock DA will let you set
the computer's system ti me a nd date. Finally, as its name implies, the DA gives you an alarm
that you may set. When the time you have set is reached, the computer will Beep at you once and
cause the Apple icon on the menu ~a r to blink. It will continue blin king until you turn off the
alarm .

Macintosh Productivity Tools

If you have the Alarm C lock DA on your DA menu , you may want to try it now.

WHAT

To Do

WHY

You ARE DoiNG

IT

Use the mouse pointer to pull down the
DA menu.

Pull down the DA menu so that you can use one of the
Desk Accessories.

Drag the mouse pointer down to select
the Alarm clock.

You want to test the Alarm Clock DA. Selecting a DA is
done just as you would select any other menu item.
Figure 4.9
The Alarm Clock DA has
been selected.

Rlarm Clock
Calculator ~
. .' .'
Chooser
.... .
Control Panel
Find File
Key Caps
~s,..,c-.r..,;ap;.,..b..,..o.,..o,...lc,.....,.._..,...,...,.....J. :.::::
=~ :::: ~= ~== ::~:::: :~: ~~=::: ::~: ~. ::~::; =:

n:

Release the mouse button.

,. •

File Edit Ulew Special

Activate the Alarm Clock DA .
Figure 4.10
The alarm clock DA
window as it first appears.

Note the s mall flag to the right of the time d isplay. This
flag is used to further open the window.
Place the mouse pointer on the flag.

You want to open the Alarm C lock window to set the
alarm .
Figure 4 .11
Note that the mouse
pointer is positioned on
the flag.
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Click the mouse button once.

Pull down the flag, which opens the Alarm Clock
window.

Figure 4 .12
The alarm clock DA
window after you have
fully opened it.

You can see that the alarm clock DA window, when open, has three distinct areas. The top
portion displays your compute r 's current system time. You can expect it to be a diffe re nt time
than the one shown in the Figures. The bottom portion displays three icons. From left to right,
they are used to set the computer's clock , date and the alarm clock. As you select each of these
three icons, the center area of the Alarm Clock window will change, showing the c urrent settings
for the time, date a nd alarm .

WHAT

To Do

Move the mouse pointer to the alarm
clock icon at the bottom right corner of
the Alarm Clock window and click the
mouse button once.

WHY

You ARE DOING IT

You want to set the alarm clock. The current alarm
setting will be displayed in the middle portion of the
window.

Figure 4.13
The current setting of the
alarm clock is 12:30 PM.

Move the mouse to the hour value displayed in the center of the window.
Click the mouse once.
Figure 4 .14
With the hour value
selected, you are able to
change the hour that the
alarm will "ring."

Select the hour the alarm is going to go off. As you move
the mouse pointer in this center area of the alarm clock
window, it will change from an arrowhead to a crosshair.

Macintosh Productivity Tools

Change the time that the alarm is to go off to be about 5
minutes later than the time shown in the top portion of
the Alarm Clock window. Simply type the new hour,
then select the minutes and type the new minutes.
Finally, select the AM/PM indicator. Type A for AM or
P to obtain PM. Note how the alarm time is set in Figure
4. 15 in relation to the clock time displayed in the top portion of the window.
Figure 4.15

Note the difference in the
times between the top and
center portion of this
Alarm Clock window.

Move the mouse pointer to the small
switch icon at the left of the time you
have j ust set.

This switch is used to turn on the alarm clock.

Click the mouse button once.

Turn on the alarm. Note that the switch moves to the up
position, and the alarm clock icon at the bottom right
corner of the window changes (Figure 4 . 16).
Figure 4.16

Note that the icon of the
alarm clock is now " on,"
and the switch is up.

Move the mouse to the close box on the
Ala rm Clock window and click the
mouse button once.

Put away the alarm clock.

Even though the w indow has been put away, the clock is still running. After the time passes
between the curre nt time and the time you have set for the alarm, you will hear a single beep
fro m the computer, and the Apple icon on the menu bar will blink, indicating that the ala rm has
gone off. Whe n this happe ns, use the DA menu to once again open up the Alarm Clock DA.
Simply doing this will turn off the alarm. If you do not want the alarm to go off again in 24
hou rs, pull down the flag to open the complete A larm Clock window . Next, select the alarm
icon. Finally, turn the small switch at the le ft of the window to the off position to de-activate the
a la rm.

File Edit

Ulew Spe

s

Figure 4.17

A her the alarm goes off,
you will see a miniature
icon of the alarm clock
blink at the DA menu
position on the menu bar.
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4 .9 THE CALCULATOR

Everyone today knows how to use a calculator. The Calculator DA is a simple fou r-function
calculator. All it does is add , subtract, multiply and divide. When you use the Calculator, you
may use the mouse pointer to press the keypad , o r you may simply type the desired numbers on
the computer's keyboard.

Figure 4 .18
The Calculator DA .

-

4 .10 THE CHOOSER

The Chooser lets you activate resources. For the Chooser to be aware of a resource, the resource
file must be in the System Folde r on your start-up disk. Figu re 4 . 19 shows the icons of some of
the resource files you can expect to see in your system folder.
Figure 4 .19
These are the resource file
icons found in the typical
System Folder. Note that
there are two icons for the
LaserWriter. Both are
required when printing
with a laser printer.

~
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If your compute r is attached to a n AppleShare network, the C hooser is used to activate the
connection between your computer and an AppleShare disk volume. The AppleShare disk volume is a resource for your use.
The most common use of the Chooser is to select the desired output dev ice or printer
resource. It is possible to have more than one printer attached to your Maci ntosh , o r you may be
attached to a network that has multiple printers. The Chooser is used to tell your computer which
printer you want to use at that moment. The Chooser is an important DA to remember when you
a re think ing about printing . The Macintosh formats text in a slightly different fashion for printing on a LaserWrite r printe r than whe n it prints on a n ImageWriter dot matrix printer. W hen you
select a printe r with the C hooser, you a re telling the Macintosh how to format the particular
document.
You can see the effect of selecting the different printers in Figures 4.20 and 4.21. Both
figures are of the same document as it is being written using MicroSoft Word. The ruler line has
been turned on at the top of the text window in each figure. Figure 4 .20 shows document
formatted for the lmageWriter, a dot matrix printer. Note the spacing on the ruler line at the top
of the window. The numeral six (6) is at the right edge of the rule r line partially out of the
window at the top of the display. The triangle at the right edge of the ruler line just below the six
inch point indicates the right margin of the document. Finally, notice the words that e nd each
line: Union, common, to and the .
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File Edit

Format

Font

Utilities Window
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Preamble to the Constitution of th& United States
We, the People of the United States, In Order to form a more perfect Union,
establish Justice, insun domestic Tranquility, provide tor th& common
defence, promote the general Welfare, and secure the Blessings of Liberty to
ourselves and our Posterity, do ordain and establish this Constitution tor the
United States of America.

Figure 4.20
The Preamble to the
Constitution is formatted
by the Image Writer printer
resource in this figure .
Compare the spacing on
the ruler line in this figure
to the one shown in Figure
4.21.

Figure 4.2 1 shows this exact same document with the LaserWriter as the selected printer.
The size of the window is exactly the same as that shown in Figure 4.20. Notice, however, that
the numeral six on the rule r line is no longer next to the right edge of the window. Similarly, the
words at the end of each line have changed. The word Union, which is at the end of the firs t li ne
in Figure 4.20, is at the beginning of the second line in this figure. Similar changes have
occurred throughout the rest of the text.

r
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File Edit

Format

Font Document

Utilities

Window

Preamble to the Constitution of the United States
We, the People of the United States. In Order to form a more perfect
Union, establish Justice, insure domestic Tranquility, provide for the
common defence, promote the general Welfare, and secure the
Blessings or Ub&rty to ourselves and our Posterity, do ordain and
establish this Constitution tor the United States of America.

.,

Figure 4 .21
Here, the Preamble has
been formatted by the
LaserWriter printer
resource. Compare the
spacing on the ruler line in
this figure with the one
shown in figure 4.20.

age t

The importa nce of these changes occur whe n you are try ing to carefully format a document.
If you are goi ng to print it on a n ImageWriter, be sure that you have selected that printe r with the
Chooser. If, on the other hand , you expect to print the document on a LaserWrite r, you must use
the Chooser to select that printe r. The selection of the printe r is best done before you start work
on the docume nt. That way you will not have to re-work parts of the text after you change the
printer type.
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WHAT

To Do

WHY

You ARE DoiNG

IT

Use the mouse pointer to pull down the
DA menu.

Pull down the DA menu so that you can use one of the
Desk Accessories.

Drag the mouse pointer down to select
the Chooser.

You want to select a printer resource before you begin
writing a text document.

,.

Figure 4 .22
The Chooser DA has been
selected.
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Release the mouse button.

Activate the Chooser DA.
In Figure 4.23, the printers available are an Image Writer
and a LaserWrite r.

Figure 4 .23
The typical Chooser DA
window as it first appears.
This computer supports an
lmageWriter. a LaserWriter.
and is attached.to an
AppleShare network.
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Move the mouse pointer to the
LaserWriter icon and click the mouse
button once.

Select the LaserWriter as the desired output device.
Since it is possible to have access to more than one
LaserWriter through an AppleTalk network , the Chooser
asks which printer you want to use . If you have more than
one LaserWriter available on an AppleTalk network, you
will see them listed here.
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The computer in Figure 4.24 is attached to only one LaserWriter printe r, which has been
named simply "Laser Write r II NT." Part of the LaserWrite r installation procedure is to name the
printer. For example, a printer may be named by its physical location, such as "Marketing
Office," or by its owner, such as "Alex's Laser."
Figure 4.24
- - --=---=--- --=--=-=-- -.-.:=-----==
~

~

Select 11 LaserWr1 ter:

Selecting a resource in the
left Chooser box activates
a dialog in the right
Chooser box.

Background Printing:

You should also notice a n option followed by two small buttons-Background Printingwhich may be on or off. Only LaserWriters support this Macintosh feature. This feature causes a
program to send your printed output to temporary sto rage on your disk, a relatively fast process
compared to the time required to send the docume nt to the printer. Whe n this task is complete.d ,
the Macintosh _returns·control to you, and you may once again work on the document. While you
are working,. the computer starts executing a separate program, called PrintMonitor, whose sole
purpose ino print the doc ume nt from the temporary storage while you perform a differe nt task.
Generally, the computer pays more atte ntion to you and what you are doing than to the PrintMonitor program, although you will find that the computer's response to mouse movements and
some of the other actions you perform is slower ·than normal. The PrintMonitor is working
behind the application you are using , and is said to be running in the background. Thus the
option is called Background printing . You may also hear this type of printing referred to as
spooled printing.
Background printing as desc ribed above is only available whe n you are using the MultiFinde r, rather than the Finder, interface program, although there are print spooling programs
available from software vendors other than Apple Computer, Inc. The main feature of MultiFinde r is that it allows the computer to perform multiple si multaneous tasks. If you are using
Multi Finder, you may decide to turn Background printing either On or Off. If you are using the
Finder, the Background Printing On/Off options are dimmed, as in Figure 4 .24 , and the selection is not available to you. More will be said about MultiFinder later in this chapte r.
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WHAT

To Do

Move the mouse pointer to the ImageWriter Icon and click the mouse button
once.

WHY

You ARE DoiNG

IT

You may change the des ired printer at any time. When
you select the Image Writer, a different dialog appears in
the right window of the Chooser. ImageWriter printers do
not have names, as do LaserWriters. You must, however,
tell the computer to which of two possible outlets, called
a port, the pri nter is attached.
Usually an ImageWriter is connected to the printer port
at the back of the Macintosh. If, however, your computer
is part of an AppleTalk network , or you have a LaserWriter attached to your computer in addition to an ImageWriter, your ImageWriter will be connected to the phone,
or modem, port at the back of the computer. This is
exactly the case with the Image Writer in Figure 4.25.
The LaserWriter is connected to the computer via AppleTal k, which uses the printer port. Thus, this ImageWriter
is connected through the Phone port .

.,

Figure 4.25

When you select the
Image Writer printer
resource, you must tell the
Macintosh to which port
the printer is attached.

- - - - - -- - - -= = - _-co_-~

---------------·- - - - -User Name:

I• #··~i•Clilll

Before you continue, select the printer ty pe that you w ill be using. If the computer you a re
working on does not have any printer attached to it, you may still select a printe r so that your
documents are properly fo rmatted. If you select a LaserWriter, the dialog box on the right side of
the C hooser w indow wi ll remain blank, since the computer will not be able to detect any
LaserWriter o n the AppleTalk network. Do n't worry. Even though no s pecific laser has been
s pecified, the Macintosh w ill still fo rmat your work for eventual output on a LaserWrite r.

WHAT

To Do

WHY

You ARE DoiNG

IT

Move the mouse pointer to the Close
Box at the left side of the Chooser window's title bar.

After you have selected a printe r, or other resource , you
are ready to put away the Chooser desk accessory.

Click the mouse button.

Close the Chooser. Since you selected a printer, that
printer resource wi ll be active until you once again
change the selection.

Macintosh Productivity Tools
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4 .11 THE CONTROL PANEL

The Control Panel is used to set the operating environment of your Maci ntosh . It gives you
control over things such as the desktop pattern, the volume of the speaker, the computer's
internal date and time (this is the same date and time you may set with the Alarm Clock DA,
except there is no alarm he re) , and the speed that the mouse pointe r tracks in relation to the
actual motion of the mouse on your desktop.
If you have more than one hard disk attached to your Macintosh, the Control Panel is used to
tell the computer which disk to boot from. This is called setting the Startup device. If you are
using a Maci ntosh II, llx or Ilcx with a color monitor, the Monito rs option of the Control Panel
lets you activate and de-activate color. That is , you may have an application that does not want to
properly use the color display (this happe ns with older application programs written before the
Macintosh II series of computers was available), or you are planning on black and white printed
output and you do not want to be distracted by color options on the screen.
There are other Control Panel devices available with the typical Start-up disk , such as the
Sound and Keyboard devices.
For icons to appear in the Control Panel , they must be in the System Folder of the Start-up
disk. They a re identified as Control Panel Documents in the Get Info window you used ea rlie r.
Remember, these documents a re sometimes called a CDEV, for Control Panel Device.

WHAT

To Do

WHY

You ARE DotNG

IT

Use the mouse pointer to pull down the
DA menu.

Pull down the DA menu so that you can use one of the
Desk Accessories.

Drag the mouse pointer down to select
the Control Panel.

You want to modify the desktop pattern, change the
speaker volume, and adjust the mouse tracking speed.
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Release the mouse button.

Activate the Control Pane l DA .

Figure 4.26
The Control Panel DA"has
been selected.
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Figure 4 .27

The typical Control Panel
DA window as it first
appears. The General
Control Panel Device icon
in the left window is
selected. The right half of
the window is showing the
options you may adjust at
this time.

Figure 4.28

The speaker volume has
been set to its maximum
level, 7. Note the present
mouse pointer is a
crosshair over the slide
control.

!I

Move the mouse pointe r to the box at
the bottom right of the Control Panel
window labelled Speaker Volume.

In Figure 4.27, the Speaker Volume is set at 4 , the midpoint of the volume range.

:5 4 -

25 -

2 1 -

o-

Move the mouse po inter to the s lide control on the speaker volume and press
and hold the mouse button .

Grab the volume slide control.

D rag the slide control to the seven position at the top of the speaker volume
control .

You want to set the compute r 's volume to its max imum
leve l.

Release the mouse button.

When you release the mouse button , the computer will
" beep .. so you can hear the volume you have set.

Press and hold the mouse button.

You are going to re-pos ition the s lide control to once
again change the volume.

Drag the slide control to the zero setting
at the bottom of the volume control.

The zero setting will turn off the sound.

Release the mouse button .

You are turn ing off the computer 's sound. Whe n you
re lease the mouse button. the menu bar will flash. Since
the compute r is unable to attract your attention through
sound , it will now do it by fl ashing the me nu bar when
needed.

Press a nd hold the mouse butto n.

You are going to set the volume one more time.

Drag the slide cont rol to the four setting, or anothe r volume setting if you so
desire .

The middle of the volume ra nge is usually the best,
unless you are in a particularly noisy or extra quiet
setting .

Re lease the mouse button.

You are do ne setti ng the computer's speaker volume.

Figure 4.29

The speaker volume is set
to zero, which turns off
the computer's beep.
Instead, the Macintosh will
flash the menu bar when
it wants your attention.

Fi rst you want to adjust the volume at which the computer " beeps." As you move the mouse pointe r over the
Control Pa nel window, you will see that it turns from the
arrowhead to a cross hair.

Macintosh Productivity Tools

Now you want to change the desktop pattern. This is the dot pattern that is displayed as the
Macintosh's desktop. If yours has not been changed, it is a grey pattern. You can see the
enlarged pattern in the left box of the Control Panel segment labelled Desktop Pattern. The right
box is a miniature representation of your computer's desktop. Note that it even has a small menu
bar. If you are using a color monitor, you will see additional information that lets you control the
color of the dots of your desktop pattern.
You may change the desktop pattern by clicking the mouse pointer (it is still a cross hair
when using the Control Panel) in the miniature menu bar, or by using the mouse pointer to
change the pattern in the left box .

WHAT

TO Do

Place the mouse pointer on the center of
the miniature menu bar of the desktop
pattern box.

WHY

You

ARE DOING IT

You will first change the desktop pattern by selecting one
of the standard patterns. You may cycle through the standard patterns in either a forward or backward direction.
Placing the cross hair on the center or right of the miniature menu bar indicates a "forward" cycle direction.
Figure 4 .30
Note the mouse pointer
cross hair positioned on
the miniature menu bar of
the Desktop Pattern
control section.

Click the mouse button once.

Cycle the desktop pattern to the next standard option.
This is a denser (i.e., darker) pattern.

Click the mouse button 3 more times.

Cycle through three more standard patterns. You should
now have displayed a vertical bar pattern.
Figure 4.31
The current desktop
pattern.

Move the mouse cross hair to the miniature desktop area.

You should have noticed that the actual desktop pattern
has not changed. To make your selection the active
desktop patte rn , you click the mouse on the miniature
desktop.

Click the mouse button once.

Activate the selected desktop pattern.
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Figure 4 .32

The new desktop pattern
has been activated. Note
the position of the mouse
pointer cross hair on the
miniature desktop. This is
where it was clicked to
activate the new desktop
pattern.
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You may also select a desired desktop pattern by editing the pattern as it appears in the left
box of the Desktop Pattern control. When editing, you erase dots of the patte rn by clicking the
mouse on a dot. You add dots to the pattern by clicking the mouse in the white area. Try the
following:
Move the mouse pointer cross hair to the
left box of the Desktop Pattern control.

You are going to edit the desktop pattern.

Click the mouse on the dot at the top
le ft corner of the box.

You are erasing this dot. The effect of this action is
immediately displayed in the sample of the desktop pattern to the right.

Figure 4.33

You have erased a dot that
makes up the current
desktop pattern. The effect
is shown on the miniature
desktop to the right.

Move the mouse pointer cross hair down
to the next dot in the first column.

Position the mouse pointer cross hair to make more edits
to the desktop pattern.

Press and hold the mouse button.

You may erase several dots by holding down the mouse
button and dragging the mouse pointer cross hair over the
dots to be erased.

Drag the mouse down over the next
three dots of the desktop pattern.

When you are done with this step, you should have erased
the top four dots, leaving four dots on the left column.

Release the mouse button.

You are done with this edit.

Macintosh Productivity Tools

Figure 4 .34

The current desktop
pattern you have created.

Move the mouse pointer to the right
column of dots.

You are going to make some changes to the appearance of
this part of the pattern.

Erase the bottom four dots of this
column.

You are completing the edit of the des ktop pattern. The
edited pattern should look like the one shown in Figure

4.35 .
Figure 4.35

The new desktop pattern.

Note that the pattern is only displayed on the miniature
desktop. To make it your active desktop pattern , you must
once again click the mouse pointer on the middle of the
miniature desktop at the right of the Desktop Pattern
control.
Move the mouse pointer cross hair to the
middle of the miniature desktop at the
right of the Desktop Pattern control.

You want to make this new pattern your current desktop
pattern.

Click the mouse button once.

Activate your new desktop pattern.
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Figure4.36

The new desktop pattern
has taken effect.
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Now you a re ready to change the mouse tracking speed. There is nothing in the General
control panel display that lets you perform this task. You must activate the Mouse control panel
display. You can see several icons at the left of the control panel. If you do not see one labelled
Mouse, use the window's scroll bar to move the conte nts of the display until you see what you
are looking for. You will then be ready to continue.

WHAT

To Do

WHY

You ARE DotNG

IT

Move the mouse pointer cross hair to the
icon of the Mouse.

You want to make changes to how the mouse behaves.

Click the mouse once.

Select the Mouse Control. T he content of the right half
of the Control Panel will change. You can see that the
mouse controls are limited to Mouse Tracking and
Double-Click Speed.

Figure 4 .37
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The Mouse control panel
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Move the mouse pointer c ross hair to the
button labelled Very Slow.

You are first going to see the effect of very slow mouse
tracking.

Click the mouse button once.

Select the Very Slow tracking option.

Figure 4 .38

The Very Slow mouse
tracking option has been
selected.

•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'•'
Control Pane l
Houst Troelcing

[2J
(Tab lot)

+®

Ytrv S1ow

lJ ail
(Houst )

0000

Slow

Fut

Macintosh Productivity Tools

Move lhe mouse quickly two to three
inches left and right on your desktop.

By moving the mouse, you can see the mouse pointer
move on the Macintosh display at the same time. Note
lhat there is about a one-to-one relations hip between the
distance lhat you move the mouse and the distance the
mouse pointer moves on the screen.

Move the mouse pointer cross hair to the
Fast button and click the mouse button
once.

Select the Fast mouse tracking speed.
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Move the mouse quickly two to three
inches left and right on your desktop.

Figure 4.39
The Fast mouse tracking
option has been selected.
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Once again, notice the d istance that the mouse pointer
travels in relation to the distance you move the mouse.
Wilh the Fast option selected, short movements of the
mouse produce long movements of the mouse pointer.
Before you continue, select the mouse tracking speed
with which you are comfortable.

You are now done using the Control Panel. Move the mouse pointer to the c lose box at the
to p left corner of the Control Panel w indow and click the mo use to put the Contro l Panel away.

-

4 .12 THE FIND FILE DA

The Find File DA is most useful if you have a hard disk dri ve on your Macintosh. It will ,
however, work o n floppy disks.
Find File looks through all the folders on the dis k searching for a file name that includes the
text you have supplied. Any file nam e that includes what you enter is listed. Clicking on one of
the lis ted names will te ll you where on the disk the file can be found.

WHAT

TO Do

Use the mouse po inter to pull down the
DA menu.

WHY

You ARE DoiNG lr

Pull down the DA menu so that you can use one of the
Desk Accessories.
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Drag the mouse pointer down to select
Find File.

You want to locate a file on your disk.

Figure 4.40

,.Orne Edit Ulew
•' About the Finder •••

The Find File DA has been
selected.
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Activate Find File.

Release the mouse button.

Note that the top left corner of the Find File window displays the name of the disk that will be searched. In Figure 4.41 it is System Start-up. If you have more than one
disk drive currently holding disks, or more than one hard
disk, you may click the mouse pointer on the disk icon to
tell Find File to search a different disk drive. For the
time being, leave it searching your start-up disk.
Figure 4.41
The Find File DA window
as it first appears.
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rapb

Type ··rapb" into the box next to the label "Search for:".
This is the name of a file for which you are searching.

Move the mouse pointer to the icon of
the man running at the right side of the
window.

This button, when pressed, will execute the search. The
button above, currently the selected one, is the Stop icon.

Macintosh Productivity Tools

Figure 4 .42
You are going to search
the disk for a file whose
name contains the string
of characters " rapb."

Click the mouse button once.

Execute the search.
After a brief pause, you will see listed the Scrapbook
File. The letters you entered , rapb, are part of the word
Scrapbook, thus the match. When the search process is
finished , the Macintosh will beep.

r-

j

File

Edit

Ulew

Special

Find File

Move the mouse pointer to the word
Scrapbook in the list of located files and
click the mouse button once.

.,

Figure 4.43
The Scrapbook File has
been located.

Select the located file. T he Find File DA now gives you
the file statistics in the bottom left box, and shows you
the location on the bottom right box of the Find File
window.
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Read the location of the file starting at the bottom of the
list. This file is on the disk called System Start-up, in a
folder called System Folder.
Figure 4.44
The Find Fife DA shows
you the location on your
disk of the file.

Note that Find File has added a new option to the menu bar at the top of the screen, Find
File! Figure 4.45 shows this menu. As you can see, the menu item has a brief "About Find File"
option which describes how the DA works, and two other options. The Search Here option lets
you specify a specific folder to be scanned, rather than a complete disk. This shortens the search
time when working with a hard disk containing many folders and files, but is only helpful if you
know the folder in which to search. The Move to Desktop option is activated only when you have
an item in the list of located files selected . When executed, the selected item is removed from its
folder and placed on the Macintosh desktop, underneath the disk icons.
Figure 4 .45
The Find Fife menu.
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When you are finished using Find File, move the mouse pointer to the window's close box at
the left side of the title bar and click the mouse button once to put away the window.

-

4 .13 THE KEY CAPS DA
The Key Caps DA is used to display avai lable type fonts. To properly make use of this DA the
file Key Layout must be in your System Folder. This file lets the Macintosh determ ine which
keyboard you are using, so it can draw the proper keyboard layout on your screen. Figure 4.46
shows the keyboard layout for the Extended keyboard. Figure 4.47 shows it for the Standard
keyboard. Figure 4.48 shows the keyboard layout for the Macintosh Plus computer. Note that the

Macintosh Productivity Tools

Macintosh Plus keyboard and the Standard keyboard are similar, except for the location on the
keyboard of some special symbols. If you do not have the Key Layout file in your System folder,
you wi ll receive the error message shown at the top of Figure 4.49, and after clicking the mouse
pointer on the OK button, the Key Caps window displayed at the bottom of Figure 4.49.
Figure 4 .46
The Key Caps window for
the Extended keyboard.
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Figure 4.47
The Key Caps window for
the Standard keyboard.
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Figure 4 .48
The Key Caps window for
the Macintosh Plus
keyboard.
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There Is no description for this keyboord.
Moke sure thot the 'Key loyout' file is in
the System Folder.
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Figure 4.49
The Key Caps window will
appear without a keyboard
if you do not have the file
Key Layout in your System
Folder.
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The Key Caps DA serves several different purposes. Because type fonts are installed into the
start-up disk's System file and require real space on the disk, they are not necessarily the same
for all start-up disks. With Key Caps you can discover the names of all the fonts installed on your
start-up disk, and get an idea of what they look like. For most fonts the lowercase and shifted
letters are the same. The letter "a" will remain the same fo r all the fonts, and will be in the
same position on the keyboard.
There are , however, some special fonts that have no letters of the alphabet in them. The
letter a may be a box . The letter b a star. In the case of these fonts, Key Caps is essential for
determining which key produces which character. Two examples of this type of font are the
Symbol font, which has Greek letters and other special symbols , and the Zapf Dingbats font ,
which is a variety of stars, boxes, checkmarks and other decorations.
In everyday use, however, it is of greater difficulty to determine which keys, when pressed
with the Option or Shift-Option key on the keyboard, produce which special characters . Many of
the available type fonts produce special characters and symbols, such as a heavy dot for marking
ite ms in a list, or the copyright symbol. Remembering the key combinations for the less frequently used of these symbols is usually unnecessary. Just use Key Caps!

WHAT

To Do

WHY

You ARE DOING

IT

Use the mouse pointer to pull down the
DA menu.

Pull down the DA menu so that you can use one of the
Desk Accessories.

Drag the mouse pointer down to select
Key Caps.

You want to experiment with fonts.

Figure 4 .50
The Key Caps DA has been
selected.

Release the mouse button.
Figure 4 .51
The Key Caps DA window
as it first appears.

Activate the Key Caps DA.

Macintosh Productivity Tools

The Key Caps DA always starts by showing you the Chicago font. This is a system font. Note that the lettering
used in the menus matches this font.
Also notice that Key Caps has been added to the right
end of the menu bar.
Press and hold down the SHIFT key.

Note that the keyboard layout now shows the letters as
they appear when you press the Shi ft key. Also note that
the Shift key on the keyboard layout is darkened, indicating that it is being held down.
Figure 4.52
The Chicago font appears
first in the Key Caps
window. Here the shift key
has been depressed.

Release the Shift key.

The keyboard returns to lowercase letters.

Press and hold down the OPTION key.

T he keyboard layout now s hows a completely new set of
characters. Many of these characters are defined like this
for other fonts. For example, note that the copyright
sy mbol , © , appears at the location of the lowercase letter
"g". Many fonts include this symbol with Option-g .
Figure 4.53
The Chicago font displayed
with Key Caps while the
Option key is depressed.
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With the OPTION key held down ,
depress the SHIFT key.

The Option and Shift keys used together give you access
to several more special characters.
Note that many characte rs appear to be a box. These are
keyboard combinations which have not been defined for
this font. When printed , they will appear as blank spaces
on the line.

Release the Option and Shift keys.

Return to the normal letters.

Use th-:: mouse to move the mouse
pointer to the Key Caps option on the
menu bar. Press and hold the mouse
button.

Pull down the Key Caps menu .

Figure 4 .54
This is a typical Key Caps
menu. You may have these
fonts, additional ones, or
be missing some of the
ones shown here.

Drag the mouse pointer and the selection bar down to the Helvetica font.

You now want to look at the Helvetica font.

Figure 4.55
Select Helvetica as the
next font to look at.

Release the mouse button.

Make Helvetica the active font for Key Caps.
Note that the keyboard displayed by Key Caps now
changes to display the Helvetica font.

Figure 4 .56
Helvetica is now the active
font for Key Caps.

Macintosh Productivity Tools

Press and hold the Option key.

Many of the same special characters that you saw with
the Chicago font are displayed for the Helvetica font.
Figure 4.57

The Helvetica font in
conjunction with the
Option key has many of
the same special symbols
as seen when you held
down the Option key with
the Chicago font.

As was mentioned earlier, some fonts do not have any lette rs of the alphabet associated with
them, but rathe r symbols. If you have access to an Apple LaserWriter, then you very likely have
the font Zapf Dingbats. You may want to use Key Caps to see what thi s font looks like!
When you are done with the Key Caps DA , use the close box on the window's title bar to put
it away before you continue.
One final note regarding Key Caps. Using this DA , and changing fonts with this DA, has no
effect on the current font in use in the application program with which you are working at the
moment. Key Caps is an information tool , only.

-

4 .14 USING THE SCRAPBOOK

Because you have not yet begun using any Macintosh application programs, you are not in a
position to make use of the Scrapbook . The following section is a brief discussion of how the
Scrapbook DA works and how to use it. Once you have had the opportunity to use some
application programs, you will then be ready to also make use of the Scrapbook.
The Scrapbook, which is accessed through the Scrapbook DA , can store either text or
graphics. Unlike the Clipboard, anything stored into the scrapbook will re main there until you
remove it. You place information into the scrapbook by first copying it to the clipboard . Next you
activate the scrapbook DA. Finally you select the Paste option found on the Edit menu to paste
the contents of the clipboard into the sc rapbook.
Notice in Figure 4.58 on the next page that there is a sc roll bar at the bottom of the
scrapbook. This indicates that there is more than one ite m in the scrapbook. As you add items to
your scrapbook, use the scroll bar to look at them. You can see that this is item 5 of 5 items in
the curre nt scrapbook, as indicated by the 5/5 below the left e nd of the scroll bar. Below the
right side of the scroll bar is an indication of the type of information c urrently di splayed. This
item is a PICT, a special type of file format used for storing some graphic information .
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Figure 4 .58
A scrapbook entry. This
graphic is found in some
of the standard scrapbook
files distributed by Apple
Computer. Inc.

r
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To remove an item from the scrapbook, use the Scrapbook's scroll bar to display the item
you want removed. With the item d isplayed, pull down the Edit menu and select either the Cut or
Clear option.
To paste an item into a document from the scrapbook, use the Scrapbook's scroll bar to
display the desired item. Pull down the Edit menu and select the Copy option. This will put a
copy of the item o nto the clipboard. Close the Scrapbook to return to the document on which you
are working. Finally, select the Paste option of the Edit menu of the application you are using to
restore the item from the clipboard into the document at the cursor location.
Because the Scrapbook is accessed through a DA, anything in the scrapbook can be copied
into the current document on which you are working, assuming the document will accept the
type of information you are trying to load- a spreadsheet will not accept a graphic from a
drawing program, but a word processor will accept a graphic. In short , the Scrapbook retains
information permanently, or at least unt il you erase it, and makes that information available to
any other program you use.
Of course, this is a generality that can often be proved incorrect. The Scrapbook is a file that
you can locate in the System Folder of your start-up d isk. (Remember you were copying it in the
prior chapter!) If you change start-up d isks, you will also be changing Scrapbook files! If you
carry your start-up disk with you as you move from Macintosh to Macintosh, then your Scrapbook file will move with you. On the other hand , if you change computers without changing
start-up disks, your Scrapbook file will change too. If you want, you can copy your Scrapbook
file to a disk, and copy it into the System Folder on the start-up disk you are using before you
begin using a particular application program . Your Scrapbook will then be available .
You will have many opportunities to use the clipboard and scrapbook as you work in this
textbook.

-

4 .15 STARTING AN APPLICATION PROGRAM
You are now ready to begin using application programs on the Macintosh. Starting an application
program running on the Macintosh is called launching a program, and simply requires that you
open the application program's icon. Thus, to launch a program you must exercise the same
skills as required to open a folder.

Macintosh Productivity Tools
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Yo u should remember that there are several me thods you may use to accomplish this task .
First, you may select the icon and then pull down the File menu and select the Open option
located there. Second , a fte r selecting the icon, you may press XO, which is the command key
equivalent to the File menu Open option. Finally, you may position the mouse pointe r on the
icon and use the double-click method to activate the program.

-

4 .16 EXITING AN APPLICATION PROGRAM

Exiting most Macintosh applicatio ns is almost as easy as starting them . The Macintosh convention is to place a Quit o ption on the File menu. Add itiona lly, most programs let you use XQ in
place of pulling down the File menu to select Quit. There are some rare exceptions to this rule.
A very few programs do not have a File menu. Usually, however, you will see a menu ite m on
the menu bar, s uch as C ontrol , or even Quit or Exit, that has the Quit optio n o n it.
Whe n you quit an application, such as Wo rd o r Excel, the program usually checks your
work to see if you have made a ny changes to your work since you last saved it. If you have made
changes, the program will ask if you want to save the work befo re exiting. You may the n c hoose
among Yes, save the cha nges; No, do not save the changes; o r Cancel , I do not really want to
quit the program right now.
In effect , while it is always easy to locate the Quit command o n the File menu , the Macintosh w ill rarely let you ex it a program if you have not saved your wo rk.

-

Figure 4.59
The Font/DA Mover icon.
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4 .17 USING THE FONT/DA MOVER PROGRAM

The Font/DA Mover is a n applicatio n program used to install fonts and desk accessories into the
System fi le. It may also be used to remove them fro m the Syste m file. Re me mber, fo nts and DAs
reside in the System file found in the System Folder o n your sta rt-up disk . For an application to
use a Fo nt , o r for a DA to be available, it must be in the Syste m file at the time the Mac intosh is
turned o n, or be installed by the Fo nt/ DA Mover program .
Befo re you begin this section, locate the Font/ DA Mover on your start-up disk, or o n o ne of
your other disks. You can see what its icon looks like in Fig ure 4 .59 . You may also have
available to you fo nt files and/or DA files. The icons fo r these fLies a re suitcases, as shown in
Figure 4.60 and 4.61. If not, don' t worry. You will learn how to move fo nts and DAs o ut of the
System file and into new Font and DA s uitcases.

WHAT

TO Do

WHY

You ARE DOING

IT

Move the mouse pointe r to the Font/ DA
Mover application.

You want to use the Font/ DA Mover. To start the program
running (remember this is called launching a program),
you may select it then use the File menu Open command ,
o r you may double-click the mouse button.

Double-click the mouse button.

Launch the program using the double-click method. If
you have trouble with the double-click, use the Open
option on the File menu , o r press 31:0.

Figure 4.60
This is a Font suitcase.

m
Fonts

Figure 4 .61
This is a DA suitcase.

m
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There will be a de lay as this program starts executing. It
is reading your start-up disk's System file to determine
which fonts it has installed. When the program is ready,
you should see a display similar to Figure 4.62. The
amount of free space on the disk drive may be different,
as may the name of the dis k itself.

Figure 4.62
The opening Font/DA
Mover display.
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One thing you may notice about the Font/ DA Mover is
that there are no options on the menu bar. Indeed, the
Apple menu is not even present. This is because this prog ram requires the full attention of the computer since it is
making changes to the resources available in the System
file.
The window on the left shows the current fon t list for the
System file. Note that the scroll bar is active, indicating
that there are more fonts to be seen. The window on the
right is empty, since it does not have a file open.
Move the mouse pointer to the Open
button on the right of the Font/ DA
Mover display.

You want to open a font file.

Click the mouse button once.

Tell the Font/ DA Mover to begin the Open process. You
will now see a dialog box showing the available files that
the Font/DA Mover will open. Note that there is a button
labelled New in this dialog box. This will let you create a
new font file.
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Figure 4 .63
This dialog box will let you
open any available font
files, or create a new font
suitcase.
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Move the mouse pointer to the New
button and click the mouse.

You want to create a new font file . You will see a new
dialog box.

Font Xfer

Name the new font file Font Xfer.

Figure 4 .64
Enter a name for the new
font file .
[) ~creen 0
Cl ~creen 1
Cl System Folder

New Font file Neme:
lront Hfe~
Cre11te

Q

1&1 System ...
Eject

[lintel

Move the mouse pointer to the button
labelled Drive and click the mouse
once.

)

Driue ~

If you have two disk drives and a se.::ond disk in the second disk drive , this tells the Font/DA Mover to create the
new font file on your second disk. If you do not have a
second disk in the second disk drive, this button will be
d immed .
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Move the mouse pointer to the Create
button and click the mouse once.

Create the new font file. You will be returned to the starting Font/ DA Mover window. Now , however, the right window tells you the name of the font file it has access to.

Move the mouse po inter lO Chicago 12
in the left window and click the mouse
button.

Select the Chicago 12 font. When a fo nt is selected , it
will be highl ighted in the window , the copy and remove
buttons will become active, and a sample of the fo nt will
appea r at the bottom of the window. Notice that the Copy
button has arrows point ing in the d irection that a font wi ll
be copied. In Figure 4.65 , the font will be copied from
the file open in the left window to the one on the right.

Figure 4 .65
The Chicago 12 font has
been selected. It takes up
3534 bytes of space on a
disk. The copy button will
place a copy of the font in
the Font Xfer file.
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Copy the font from the System file to the Font Xfer fi le.

When the copy is done, the font name will appear in the
destination wi ndow.
Figure 4.66
The font Chicago has been
copied to the font file Font
X fer.
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Courier I 2
Geneue 9
Geneue 10
Geneue 12
Geneua 14
System
on System Stert- Up
1
31K free
(
Close

1

Chlcego 12:

Mouer

I

Aemoue

1

3534 bytes
selected
Help
Quit

K>
Font Hfer
on My Data
97K free
Close

The quick brown foH jumps ouer the lazy do

Macintosh Productivity Tools

Use the scroll bar in the left font list to
display New York 18 and New York 24.

You want to add these two fonts to the Font Xfer font file.

Move the mouse pointer to New York
18 and click the mouse button once.

Select the New York 18 font. The sample of the font will
appear at the bottom of the display and the byte count
will be given for this font.

Move the mouse pointer to New York
24, but do NOT press the mouse button.

You want to move two fonts at the same time.

Hold down the Shift key and click the
mouse button once.

Recall that the Shift-click will let you select multiple
items when using the Finder. It works the same way in
this program. Here you are selecting multiple fonts. Note
that a sample of the font is not displayed, but that the
total byte count of the selected fonts is.

®Font
Desk Accessory

Mauer

0
New York 10
New York 12
New York 14
New York 20

Times 10
System
on system Start-Up
31K free
Close

Figure 4.67
TWo fonts have been
selected for copying to the
Font Xfer file.

>>Copy»

Chicago 12

Q

Remoue
11570 bytes
selected
Help
Quit

Move the mouse pointer to the Copy
button and click the mouse once.

Q

)I

)I

Font Hfer
on My Data
97K free
Close

Copy the two fonts from the System file to the Font Xfer
file.
Removing fonts is easy. However, before you do so, it is
a good idea to make a copy of the fonts you intend to
remove. Thus, if you ever need them back, you will have
them in a font file.

Move the mouse pointer to the right font
file window.

You plan to work with the font file you have just created.

Move the mouse pointer to New York

Select the New York 18 font. Note that the direction the
arrows are pointing on the Copy button has changed. You
may, it should be apparent, copy fonts from the right
window to the left window if desired.

18 and click the mouse button once.
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Figure 4 .68
The New York 18 font in
the font file Font Xfer has
been selected.

®Font
Desk Accessory

0

Mouer

..., ( « Copy«

,.,.~.,..:-:--:-:~-:~"""~"""7C:~=----.-.,g

~:: ~:~~ ::

i'l

New York 20
~
New York 24
]!]
Times 10
0
System
on System Start-Up
31 K free
Close

New York 18:

··=-

Chicago 12
I

r(---=A_e_m_o_
u_e---..

IQ

New York 24

~

4678 bytes
selected

0
Font Hfer
on My Data
6SK free
Close

Help
Quit

The quick brown fox jumps ov

Move the mouse pointer to the Remove
button and click the mouse once.

You want to remove this font from the Font Xfer file.

Move the mouse pointer to the OK
button and click the mouse once.

The Font/DA Mover wants to confirm that you really
want to remove the font from the file. You are telling the
program to continue.

Figure 4 .69
Confirm that you really
want to remove the
selected font from the file .

®Font
Desk Accessory

0
New York 10
New
New
New
New
New
Tim_I!
on!

IQ]

I « Copy« I (Chicago 12

Are you sure you want to
remoue the selected Items?

OK ~~

New York 18:

Mouer

([Cancel

J

The quick brown fox jumps ov

Move the mouse pointer to the button in
front of Desk Accessory at the top of the
display.

Currently, Font is the selected option. You now want to
see which Des k Accessories are installed in the current
system file.

Click the mouse button.

Tell the Font/DA Mover to close the font files and work
with the Desk Accessory files.

Macintosh Productivity Tools

Figure 4 .70
Look at the Desk
Accessories in your current
system file.

Mouer

Open•••

Move the mouse pointer to the Quit
button and click the mouse once.

You do not want to do anything with DAs at this time.
Exit the program.

Working with Desk Accessories is exactly the same as working with fonts. You may copy
them between files and you may remove them . Keep in mind that there is a limit to the number of
fonts a nd DAs which may be a part of a Syste m file. If you are using a floppy disk, the n disk
space will constra in you before the actual limit of allowahle fonts a nd DAs is reached. You are
limited to 15 DAs in a ny system file at any one time. You are more likely to reach this limit whe n
using a hard disk tha n with floppies. The re are, however, ways to circumvent this limit by using
programs such as Suitcase II , which lets you open as many font and DA files as you want.

-

4 .18 HE-INITIALIZING A DISK

There will be times when you want to throw away everything on a di sk. One way that you can do
this is by dragging the complete conte nts of the disk to the trash. You will find , however, that you
do not always recover all the space on the disk in this fas hion. The re is a hidden file on each
disk, called the Desktop, that can grow as files and other information are placed on the disk.
Moving all the files on the disk to the trash does not shrink the Desktop file back to its original
size.
You can, however, have the Mac intosh perform the initialization process on a disk. This will
overcome the proble m of the growing Desktop file.

WHAT

TO Do

Place a disk to be erased into a disk
drive.

WHY

You ARE DOING IT

You must place a disk into a disk drive so the Macintosh
knows that it exists.
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Move the mouse pointer to the disk and
click the mouse button.
Figure 4 .71
The disk to be erased has
been selected.

~ •

File

Edit

Select the disk on the desktop .

.,

Ulew Special
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Move the mouse to Special on the menu
bar.

The option to re-initialize a disk is found on the Special
menu.

Press and hold the mouse button.

Pull down the Special menu.

Drag the mouse down to select the Erase
Disk.

Since a disk is selected on the desktop, the Erase Disk
option is not dimmed.

Figure 4 .72
Select the Erase Disk
option on the Special
menu.
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Release the mouse button.
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Macintosh Productivity Tools

Move the mouse pointer to the TwoSided option.

The Finder is asking you to confirm that you really want
to erase this disk. If you have made a mistake, select the
Cance l button, rather than the two-sided button.
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Figure 4 .73

You want to erase the
selected disk.
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Cl ick the mouse button once.

Begin the erase process. The Finder will tell you the progress of the erase process as it works by telling you it is
Formatting, Verifying and C reating the Directory.
When the erase is completed, you wi ll be returned to the
Finder's desktop.

Move the mouse to the icon of the disk
you just erased and double-click the
mouse button.

The double click will open the disk on the desktop. You
can see that it is an empty disk.
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Figure 4 .74

The newly erased disk is
empty.
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Re member, you should o nly use this procedure to completely erase the contents of a disk .
Anything o n the disk will be permanently lost. As a general r ule, you only need to worry about
initializing a disk when it is new.

-

4 .19 THE VIEW MENU

So far you have looked at the contents of your disks in icon view. T here are other ways to look at
what is on a disk. Each way prov ides you with diffe rent info rmatio n. The icon view, in add ition
to the names of each item , te lls you the number of items in the w indow, how much space is
cu rrently in use on the disk , and how much space is free.
As the numbe r of icons in a window increases, you may find that you want a way to see
more of what you have. This can be especially true if you are using a ha rd disk, wh ich can place
a large number of files and folders within anothe r folder.
The Finder's View menu lets you control the appearance of each window. Be fore you
continue, close all the wi ndows on the Mac intosh's desktop except the System Folder. This is the
one you will use to experiment w ith.

WHAT

To Do

WHY

You ARE DoiNG

IT

Move the mouse pointer to the View
menu on the menu bar.

You are going to change how the System Folder information is displayed in the current window.

Push and hold the mouse button.

Pull down the View menu.

Drag the mouse pointer down to the firs t
entry on the View menu.

You want to view the contents of the System Folder by
small icon, rather than by standard size icon.

Figure 4.75
The View menu. Note that
the "by Small/con " item
has been selected here.
! k"-~·: 1

Kovbo¥d

~

mago..-rltor

Release the mouse button.

[!g)

<l>~

(g

o.ntr•l
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Scnpboolc HI•
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~

tlipbo~rd
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Complete the selection of the view option. The icons now
change to their miniature version. In this view, you can
fit more icons into the same size window by moving them
around.
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File

Edit Ulew

.,

Special

Figure 4 .76
The small icon view of the
System Folder. Here the
icons have not been
re-arranged, but may be.

S stem Folder

Move the mouse pointer to the View
menu and depress the mouse button.

Once again , pull down the View menu.

Drag the mouse down to the " by Name"
option.

You now want to look at the window's ent ries listed in
alphabetical order.

Release the mouse button.

Change the view to alphabetical by name of each entry.

Move the mouse to the zoom box at the
top right of the title bar and click the
mouse once.

Make the window as large as possible, if it is not already
so.

Figure 4.77
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This is the "by Name"
view of the window's
contents. The window's
content is listed
alphabetically py the
names o f the files.

You see that this view of the window prov ides you with
information about the individuals, but does not give you
the status of the disk in terms of space used and space
free .
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Move the mouse pointer to the View
option on the menu bar and depress the
mouse button.

Once again, select the View menu.

Drag the mouse pointer down to the last
option, by Kind .

You now want to change the order in which the information is presented in the window.

Release the mouse button.

Select the by Kind option. The window's entries will now
be ordered by file Kind. Remember that you looked at
the file Kind with the Get In fo command on the File
menu .

Figure 4 .78
The contents of the System
Folder viewed " by Kind."
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You can see that the information in this view is the same
as in the by Name view. Only the order has changed. The
by Date and by Size options have this same effect. That
is, they cause the information to be rearranged in the
window, but you learn nothi ng else about the disk or its
conte nts.
Use the View menu to select the view you like to use. The re are advantages and disadvantages to each view. You must decide which one suits the way you w ill be using the computer.

-

4 .20 USING SET STARTUP

A nice feature of the Macintosh is that it does not have to start by using the Finder. If you want,
you may have a nothe r program designated as the o ne that the computer starts executing whe n it
boots up. If this is the case, you do not even need to have the finder o n the boot d isk. Of cou rse,
by leaving the finder off the disk, you will not be able to exit the program and perform finder
operations.
Generally, the Set Startup option is used when you do not want people to have to learn how
to use the finder, or when the information you want to put on a start-up di sk does not leave room
for both the Finder and the program you want to execute. Set Startup is also used to have the
Macintosh start up using MultiFinder, rather than the Finder. More wi ll be said about MultiFinder later in th is c hapter.

Macint osh Product ivity Tools

To set a particular program to be the startup program, it must reside on the disk you use to
boot the computer. If you are using a flopp y disk system, you may have to remove some items
from your startup disk to make room , such as some control panel devices, printing resources , or
some !NITs. You may even have to remove some DAs or font files from the System file. After
you have completed the Set Startup procedure, you may remove the Finder from the disk and,
depending on available disk space, restore the items you removed earlier.
Before you continue, make sure that the desired program is selected. The Set Startup option
will then know that this is the program you want to execute when you turn on the computer.
When you pull down the Special menu and select the Set Startup option , your display will
appear similar to the one shown in Figure 4. 79. The user here has the option of making the
Finder the start-up program. Additionally, you can see that the MultiFinder button is an available
option. After making his selection, all this user needs to do is to move the mouse pointer to the
OK button and click the mouse.
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Figure 4 .79

The Set Startup screen lets
you tell the Macintosh
which program you want
it to run when you first
turn on the computer.

0
0
0

'•'•' •

•'•'•'
::::::

·:·:·:·:·

r~~f~:~:::::
!•!I:JI

••'•'•'• ~
:::::::::
•'•'•'•'• ~

;:;:;::::

'•'•'•
'• '•'•

-

4 .21 MULTIFINDER
As we mentioned above, MultiFinder is another program you may select to be the startup
program. MultiFinder is a special version of the Finder. To use it successfully your Macintosh
must have at least two megabytes (two million characters) of RAM (random access memory).
(NOTE: RAM and the capacity of a hard disk are in NO WAY related. Your computer may have
a 20 megabyte hard disk, but still only one megabyte of RAM .)
MultiFinder lets you simultaneously execute two or more programs, depending upon the
amount of Random Access Memory (RAM) installed in your computer. You may then jump back
and forth between the programs. In addition , if you are using a laser printer, MultiFinder lets you
print documents while working on another document, or even with another program through
background printing. This was discussed earlier in the chapter when the Chooser was introduced.
The functioning of the Finder type activities that you have learned in this chapter are the
same when using either the Finder or the MultiFinder. Thus, you open folders and launch
programs in the same fashion. New disks are formatted by inserting them into a disk drive.
Menus are selected with the mouse pointer, and so on.
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Figure 4 .80

The MultiFinder icon as it
appears in the System
Folder.

filFil

~

MultiFind~r
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To have your compute r use MultiFinder you must have its icon in the System Folder of your
start-up disk (Figure 4.80) . If the MultiFinder icon is not in your System Folder, then the
MultiFinder button will be dimmed when you use the Set Startup option found on the Special
me nu . Once you have selected the Set Startup option, simply click on the MultiFinder button.
After chang ing the startup from the Finder to MultiFinder, or from MultiFinder to Finder, you
must restart the Macintosh to activate your selection.
When using MultiFinde r, a miniature icon of the program in current use will appear at the
right end of the me nu bar. Figure 4.81 shows the Desktop when MultiFinder is in use on a
Macintosh II , and the Finder is the selected program. The menu bar shows a miniature Macintosh at this time.

Figure 4 .81

The miniature icon of the
Macintosh at the right side
of the menu bar indicates
that MultiFinder is in use,
and that you are using the
Finder, and not an
application.
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You select which program you want to use by one of three methods . You may click on the
miniature icon on the menu bar. When doing this, you cycle through the programs that the
Macintosh is running at the time. The second method involves using program windows. If a
program has a window open on the desktop, and any portion of the window is c urre ntly visible,
then clicking the mouse on that window will select it, and thereby activate the program. Finally,
you may pull down the DA menu, which will now include a list of programs active in the
computer's memory (Figure 4.82). Use the selection bar to choose the program you want.
Figure 4.82

The DA menu when using
MultiFinder includes a list
of the programs currently
in the Macintosh's
memory. You may select a
program to execute as you
would any other menu
option.
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One word of caution about MultiFinder. You must take some responsibility for memory
management. Programs do not always start and take all the memory they will ultimately need. In
this case you must assign the progra m mo re memory. Othe r, usually older, programs will want to
take all the computer's memory. They were not written with MultiFinder in mind. These programs must be told to take less memory.
It is easy to cha nge the amount of memory a progra m will take when it starts running using
the Get Info option on the File menu .
Select the program icon, but do not start it ru nning . Next use the Get Info option found on
the Finde r's File menu (or use :l€I). At the bottom of the information window displayed is a box
whic h lets you change the a mount of memory requested by the program (Figure 4 .83). Apple
Compute r, Inc., recomme nds that you make a back~up copy of any application progra m before
you change its memory requirements, in case something goes wrong. Always close the information window whe n you are th rough with it.

0

Figure 4. 83
The Information window
will let you change the
amount of RAM a program
allocates for itself when it
starts running.
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You can determine how much memory each program is using with the Finder. First make it
active, then use the About the Finder .. . choice showing on the DA menu (Figure 4 .84). Do not
use the About MultiFinde r choice fo r this. It will only tell you the version number of MultiFinder that you are using.
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Figure 4 .84
This is the display you will
see when you select About
the finder....
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You may almost always safely increase the amount of memory a program uses . For example,
by increasing the amount of memory Excel uses you may have a larger spreadsheet, or more
documents ope n simultaneously. MacPaint 2.0 requires extra memory be allocated to it if you
intend to open more than two o r th ree pictures simultaneously. You may not, however, always
safely decrease a program 's me mory requireme nt. Generally, the minimum requirement is set at
the lowest value recomme nded by the program 's authors. Lessening the memory used on prog ram start-up should be done with great care.
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EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.
I I.
I2 .
13.
I4.
I5.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27 .
28.
29.

What about the System Folder icon tells you that the disk is a bootable disk?
When are INIT files loaded?
What does the term DA mean?
Which DA makes use of CDEV documents found in the System Folder?
What is a font?
What are the two fundamental types of fonts available?
What is the difference betwee n an outline font and a solid font?
Which type of font, outline or solid, is the more desirable? Why?
Explain the difference between the Clipboard and the Scrapbook .
Under which menu item on the menu bar do you find DAs?
Where are fonts and DAs stored?
Which DA lets you set the computer's system time , as well as set a periodic alarm as a reminder?
What is the purpose of the Chooser DA?
Is there a difference between selecting an lmageWriter and a LaserWrite r for formatting your documents?
List three things you can change with the Control Panel.
Will the Find File DA work on any disk, or only on a hard disk?
Can the Key Caps DA access fonts that are not installed?
Which file should be in your System Folder for Key Caps to work best?
Which keys are pressed on the keyboard to obtain the special characters that are a part of many fonts?
What are the ste ps required to put information into the Scrapbook?
What are the steps required to copy information from the Scrapbook into your current document?
What does the term "Launching a program" mean, and how do you do it?
On which menu can you expect to find an option to quit an application program?
What is the purpose of the Font/ DA Mover program?
Is there a practical limit to the number of fonts and DAs installed on a boot disk when you are using a floppy disk-based
system? If so, what is the limit?
Is it possible to re-initialize a disk? If so, which me nu is used?
When looking at the contents of a folder, what information is displayed in the Icon View that is not displayed in the Name
View?
What is the purpose of the Set Startup option?
What two things does the MultiFinder let you do that the Finder cannot do at present?

CHAPTER

BEGINNING WORD
PROCESSING CONCEPTS

5

-

CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:

• Explain the concept of word processing.
• Explain the difference between the two major
· types·of word processing programs.
• Start MS-Word.
• Enter text with MS-Word.
• Explain what word wrap is and why it is a
helpful feature of word processors.

•
•
•
•

Explain the function of the cursor.
Move the cursor inside the text.
Insert, replace, and delete text in a document.
Save the d~cument to disk for later use if
needed. ·
• Print the document.

-

5 .1 WHAT IS WORD PROCESSING?

Word processing is the act of using a mechanical device, in our case the microcomputer, to
manipulate (or process) words or text.
Figure 5.1
An IBM DisplayWriter
stand-alone word
processor.
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5 .2 THE WRITING TOOL FOR THE BEGINNER

Word processing allows beginning users to produce error-free final copy with neatly justified
margins and underlined or boldfaced text with their first use of the tool. (Most of this book's text
has left- and right-justified margins, which means that both the left and right margins are
straight. When using a typewriter you usually e nd up with ragged right margins. This paragraph,
by the way, was typed with ragged right margins so that you could see the difference between
justified and unjustified margins. More will be said about justification in a later chapter.)
Initially, it may take as long for the beginning user to enter text into the computer as whe n
he or she was typing on a typewriter. This can depend on typing skills, the difference in the feel
of a computer keyboard versus a typewriter keyboard, lack of fami lia rity with the word processing program, and even lack of familia rity with a computer.

-

5 .3 THE WRITING TOOL FOR THE EXPERT

The expert at the typewriter keyboard will find that he or she can produce finished documents in
much less time with the aid of word processing than was possible with a typewrite r. The action
(the amount of pressure needed to strike the keys) of the computer keyboard is much easier than
that of most typewriters, and there are no moving parts. Overall faster typing speeds are possible
when you don 't have to wait for parts to move.
Figure 5.2
Inside a typewriter. Notice
all t he moving parts!

Possibly the greatest advantage of word processing is how easy it makes it for you to edit a
document electronically. Typographical errors (typos) can be corrected more easily. The word
wrap feature (when a typed word passes the right margin it is moved to the begi nning of the next
line automatically- more on word wrap later in this chapter) eliminates the need for you to use
the return key and wait for the typewrite r carriage to reposition itself for the next li ne of text. It
is a relatively fast and simple process to correct a document on the computer's screen, maki ng
c hanges or corrections before the printing process begins.

-

5 .4 THE PRINTER

A major contribution to the overall speed of document preparation with a word processor is the
printer. Even if you elect to print a draft copy of the document to correct or to send to someone

Macintosh Productivity Tools

else to correct or review, the speed of printe rs today is such that the computer can reprint the
corrected version in almost no time at all compared to the time it takes to retype the document by
hand after you have made corrections. The re are impact printers {printers that put the letters on
the page by physically striking a ribbon and pressing it to the paper) that will print up to 400
characters per second. Laser printers costing under $2500 can print up to eight pages pe r
minute!

-

5 .5 SPELLING VERIFICATION AND THESAURUS

Additionally, a majority of the word processing programs in use today can be used with some
forms of spelling check and thesaurus programs. These programs have dictionaries and thesauruses ranging in size from 20,000 words to 220,000 or more words.
Some spelling check programs are available on-line. You may ask the spell checker to look
up a single word, or to scan a sentence, paragraph or page of your text while you are editing the
document. The spelling check program compares the text of your document against its dictionary. If the words are found in the dictionary, then you have no problems. However, if the re are
words the program does not find in its dictionary, the program (depending on which of several
you are using) will either mark it for you as a "misspelled word," ask you if you want it marked
as a misspelling for future corrections , or even ask you to fix the supposed e rror before the
program continues to check the rest of the document. After the spelling check program ma rks
mistakes, it is a simple matter to return to your word processing program to make the needed
corrections. All this may even be done without ever printing a first copy of the document, again
saving time.
A thesaurus works in a similar fashion. You e nte r a word for which you want a synonym,
and the thesaurus finds and displays alternate words. You may then insert one of these sy nonyms
into your text.
Word includes an on-line spell check program, and on-line thesauruses are available. Neither the dictionary nor the thesaurus are loaded into memory at all times, as they are each quite
large. They are caJied upon on demand. More will be said about the Word spell check feature in
a later chapter.
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Figure 5.3
The Word spell check
program in use.

125

126

CHAPTER FIVE- BEGINNING WORD PROCESSING CONCEPTS

-

5 .6 FORM LETTERS

A word processing program can make a big difference for a small business in the generation of
the ubiquitous form letter. Most word processing programs today are able to merge a mail ing list
into a form letter. All your letter needs is the special codes recognized by the word processing
program in place of the name and address, for example, to tell the program where to enter
names, addresses, or other text. With a little planning, you can even generate a form letter and
include a personal postscript to selected people, all with the help of your word processing
software. With a letter-quality printer, no one will suspect that the same letter has been received
by tens, hundreds, or even thousands of people.
Another method of generating form letters is to save on disk, a group of single parag raphs,
each being different. To write a letter to John Doe, for example, you might select paragraphs
one, five , eight, and twelve. You simply merge these paragraphs together, and add the date,
address, salutation, and closing. While the process of writing the initial group of paragraphs may
be time-consuming, once you have them they need not be entered into your computer again. This
method of letter or document preparation is often called boilerplating. You will see how to
actually create a document in this fashion in the next chapter.

-

5 .7 TYPES OF WORD PROCESSING PROGRAMS

There are two basic types of word processing programs available today for the personal computer. One is the "what you see is what you get" (WYSIWYG) type program, and may sometimes be referred to as a screen editor (although this may depend on the kind of computer you
have) , while the other is usually called a text editor/formatter, or sometimes a line editor/
formatter.

-

5 .8 THE WHAT YOU SEE IS WHAT YOU GET PROGRAM
The " what you see is what you get" word processing program is exactly what it sounds like . As
you write, the prog ram formats your typing so that it appears on the display exactly as it will
when the document is printed. If you want the document to be justified, then the text wi ll appear
j ustified on-screen.
This kind of program frequently does other things for you, such as keep track of how many
lines you have typed. With this knowledge, the program is able to display on the computer's
monitor where one page ends and where the next one begins.
With some of the what you see is what you get word processing programs, as you make
additions or deletions in your text, the margins of the document will begin to lose their nice, neat
appearance. Some lines will become shortened, while others may overflow the right margin.
After you finish editing a paragraph, however, it is a simple matter to have the computer reformat it, which places everything within your desired margins . Other word p rocessors of this
genre keep the paragraphs formatted automatically as you make changes. In either case, when
you are through editing, your document will appear on the computer's display just as the final
output will look when printed.
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Figure 5.4
MS·Word is an example of
a "what you see is what
you get" word processor.

WYSIWYG

pr=.

t..tcrosoft WORD Is an exande of •What You See Is What
You Get• word
prirted, this docunent wll
appear on the page exa as Happears on the dsplay of the
Maciltosh COf11)Uter. Ttis
not oriy the way the text Is
formaHed on the page, but also boldfaced text shows as
boldface, lllderhd text Is underhd. and HIs even possble
to see //4kiziK/ text on the saeenl

-

5 .9 THE TEXT EDITOR/TEXT FORMATTER PROGRAM

The text editor/formatter program takes a different approach to how your document appears onscreen as you write or edit. With this type of progra m your computer's display rarely resembles
the final printed output. You must direct the output formatter of these programs through print
commands, which are part of the text you type, but which do not appear in the final output.

L1 HELEN 55
FILL
JUSTIFY
PARA
Tt"le F'ILL proce:n wall take words from
the nc x t 1 J ne end add the m on t o e s l'\orl l 1 n e
un t 1l the ou t put ltne leng t h u reached
The outpu t lan e length of thh teat wall
be 55 c:harec t ers, as def i ned an the
LIHELEH

f Of'" rna t t i

ng

cotrvnand

to change the output l ane length ,
I would change the value found 1n l hts CorMiand

If I wan t

PARA
PARA co!Miand wt l t cause a new paragraph
Thts means thel'"e wtll be an anden tataon tn

The

the text for the new paragraph
Sorte text formot te,.. ., l!'".ay abo sh p a lane
be tween two p erag,..eph s
. PARA
Tl"te JUSTJF"t CoiM\and W"all cau.,:e the ou t put of
t he text t o be RIVHT JUS1.1f aed
Tht s means the text wall have a str'"atght ,..aght
ma,..gan as does a news paper column

I
HERE IS WHAT THE OUTPUT Or THE TEX T FORMATTER WILL LOOK LI KE.
The rILL p,..ocess wtll tak e word s from the ne•t
l1ne e nd add them onto a s hor-t l ane untt l the output
lane leng t h 1S reach ed . The ou tput I ine lengt h of thls
te xt wa l l beSS charact e rs, as defined an t he LIHEL£H
formettang cotl'llnand If I wan t to chan ge the output la ne
l e ngth, I wou ld cha nge the va l ue found ln thi s command .
Th e . PARA co~~YMnd wi 11 cause a new pa ragraph . Thts
mean s there wa l l bean tnd ent ataon an the text for
the
new paragraph. Some text fo ,.mallers may also sbp
11ne bet ween two pa ragraph 5o
The JUST rrv COITWftand wi 11 cau s e t he 0'1 tpu t of the
te xt
to be RIGHT JUS tified . This me an s the t e xt wi l l
ha ve a st r aight right " argln as does a newspaper
column .

There are , of course, advantages and disadvantages to both types of programs. The editor/
formatter allows easy experimentation with margins and other formatting options, but does not
display the results of your work until you print your document. The what you see editor makes it
si mple to e nter tables and columns of numbers.
As you are working with Word, you will discover that, while it bears no relationship to a text
editor/formatter, it is not 100 percent a what you see is what you get program. Word keeps track
of line le ngths, the number of lines on a page, and similar formatting options. If you want the
document justified, then you will see it justified on the display. Problems with the appearance of
the document sometimes occur when you print. These problems are mostly related to formatting
quirks of the particular printe r you are using. You will see that it is very important to have the
correct printer selected with the Chooser (read about the Chooser DA in Chapter 4) when
formatting and paginating your document.

Figure 5.5
A text formatter program
input, and the formatted
output from the program.
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5 .10 MEMORY OR DISK TEMPORARY TEXT STORAGE

Another distinction between word processing programs relates to how the document on which
you are working is stored and used in the computer's memory and on the d iskette.
Some word processors keep the complete document in the computer's me mory at all times.
This is advantageous when you are looking through the docume nt or inserting (adding) text to
the document, or when you have instructed your word processing program to locate a word or
phrase somewhere in the text. The advantage is speed. You will not have to wait for the word
processor to save one part of the file to your diskette and then load the next part as it searches
through the text for the desired phrase or makes room for the text to be inserted. Although some
disk drive systems are very fast, searching through the computer's me mory will always be faster
than a search through text located on a diskette or hard disk drive.
The disadvantage of the word processors that keep the whole docume nt in the computer's
memory is the forced limitation on the total size of the document. Clearly, if the program wants
to keep the complete document in memory, then the memory available after the word processor
itself is loaded is the size limit of your document. The typical page of single-spaced text with
six-inch lines will require approximately 3K to 3.5K characters of memory (one K represents
1024 c haracters). If your free memory area has room for 32K, your document size is limited to
slightly more than nine of these pages.
When you use a word processor that keeps only a small segment of your document in
memory, you give up some speed in search operations and speed of gross (covering several
pages) cursor movements for ease of page numbering, page breaks and larger overall documents.
This type of program may have greater overall capabilities because minimizing the size of the
program is not as important as with the programs that load the entire document in memory.

-

5 .11 TEXT ENTRY

Text entry is one of the major activities of pe rsons using word processors. It is the act of typing
the document and storing that document on disk. All the typing you do will occur within the text
window.
Since most documents you type will not fit onto the compute r 's monitor in total, the computer's ·display really acts as a window into the text. In fact, that portion of the monitor used to
display the current portion of your work is called the text window, just as the open disk icons are
called disk windows .

-

5 .12 THE CURSOR

The cursor can take on a different form for almost any compute r you use. It commonly appears
as one of the following:
•
•
•
•
•

Solid block
Blinking or flashing block
Solid underscore character
Blinking or flashing underscore character
Blinking or flashing vertical ba r
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The cursor type displayed is usually a function of the computer and not the software being
employed , but it is possible for the software to generate its own unique cursor type. While you
are typing, the cursor used by Word remains the standard blinking vertical bar used by the
Macintosh as its cursor. The Macintosh, and Word , also use a second, special cursor type,
called the 1-Beam (Figure 5.7). This cursor will appear when you use the computer's mouse to
re-position the cursor on the screen, or for performing a variety of other tasks while working
with the document.
Computers use cursors to indicate where the next letter or character you type will appear on
the monitor. This is called the insertion point. Un like a typewriter, on which this spot can be
fairly easily identified, the computer's monitor does not move as you type, hence the need for
the cursor.

-

5 .13 OPENING A FILE

Sooner or later, all word processors will allow you to save your text onto your disk. Some word
processors require that you name the file BEFORE you start the editing process. Others will let
you create the complete document and then name it when you are ready to save it. In either case,
you are said to be opening a file when you furnish the word processor with a name for the
document.
Word will let you create and print a document without ever opening a file on the disk. This
means that you may write a document and never save it! However, it is always a good idea to save
a document before printing it. If you have a hardware problem, it will take less time to recover
from the saved document than to retype it!

-

5 .14 BEFORE YOU BEGIN

When you purchase an application program, such as Word, you are frequently told in the
instructions to make a back-up copy of the program disks. This is not true of every appl ication
you purchase. If the instructions tell you that you are able to make a back-up copy, then making a
single copy in this fas hion is within your legal rights, and indeed it is a good idea. Use the
procedure you learned in Chapter 3 fo r copyi ng disks to make a copy of your original Word disks
before you begi n this section of the text. This copy of the d isks is called a "worki ng copy." After
making the backup, put the origi nals in a safe place and use the working copy. By keeping the
originals safe, if something goes wrong w ith you r working copy, you will be able to make a new
working copy of your software.

Typical cursors you will see
with word processing
programs.

Figure 5 .7
The /-Beam cursor as it
appears on your Macintosh
display.
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5 .15 STARTING WORD

Figure 5.8
The MS-Word program

icon.

~

Microsoft 'Word

Word is distributed o n three disks, the Program disk and two Utilities disks. On the Program
disk you will find the Word program itself and a " Read Me" Word docume nt.
The Read Me document contains the most recent update and release note info rmation fo r the
disks you have. The re a re freque ntly small corrections or changes that are made to a program
that occur after the manual is printed , or e rrors are detected in the manual. The Read Me
document is in effect a n addendum to the program manual.
The Utilities I disk contains the Word help files, dictionaries, glossaries and sample documents . The purpose of the help files should be obvious. They are accessed through the Word
help featu re discussed late r in this chapter. The d ictiona ries are used when you use the Word
Spell Check featu re. The glossaries are stored up phrases or special c haracte rs.
The Utilities 2 d isk contains a variety of utility programs that are not required to ma ke the
Word program run , but which may come in handy at some time. Fo r example , you will fi nd
Word Finde r, a thesaurus desk accessory, on this disk, as well as SuperPaint, a graphics program
which lets you c reate pictures which can be incorporated into your Word documents.
After you boot your Macintosh with a System Start-Up d isk, insert the Word Program disk
into one of the compute r's d isk drives. If you are using a machine with a hard d isk, you will not
need to insert the Word program disk into a disk drive. Rathe r, locate the Wo rd 4.0 folder, and
open it so you can see the Word prog ram icon. Place a disk (see Chapter 3 fo r how to initialize a
new disk) with at least 200K available space into anothe r one of your Mac intosh 's disk drives, if
you have one ava ilable. This disk will be used for saving your work . If you do not have a free
floppy disk dri ve , keep this disk available. You will need it fo r data storage.
In these instructions, [c r] means to push the Return key on your compute r's keyboa rd
(remember, this is NOT the Enter key). A X in front of a letter (e.g. , X X) means to hold down
the Command key whi le pressing the g iven letter. Lette rs enclosed in squa re brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase " C lick the mouse on ...", means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ...", means to
move the mouse po inte r to the specified item a nd double-click the mouse butto n. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed .
Finally, if you want your work to match the figures in the text, be sure to use the Chooser
DA to select a LaserWriter and not an ImageWriter. You may select a LaserWriter even if your
compute r is not actually attached to one. You will not, however, be able to print if this is the
case.

WHAT

To Do

If the disk's icon is closed , double-click
on the icon with the mouse pointer.
Locate the Word program icon inside
the disk window (Figure 5.8). If you arc
using a machine with a hard disk, locate
the Word program icon inside the folder's window.

WHY

You ARE DorNG

IT

Open up the disk icon onto the desktop. If the Maci ntosh
you are using has a hard disk, then open the folder containing the Word program.
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Move the mouse pointer to the Word
icon and double-click the mouse button .

Launch Word. Remember, if you are having trouble with
the double-clic k, you may select the Word icon with a
single click, then use the Open command on the File
menu (or XO) to launch Word.

A fte r a brief pause you will see a blank screen with a menu bar at the top. Below, occupying
the rest of the Macintosh's display, is the text window in which you will be working. It has a title
ba r on top with the name " Untitled l " , scroll bars at the right and bottom, a size box at the
bottom right corner, and an information box at the left side of the bottom scroll bar that says
Page l . If you have already set Full Menus, you will also see the word Normal appear at the
bottom left of the display.

r

,

•

Figure 5.9
Opening Word screen.

---

-

- - - - - - --

-

L
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Note that the standard Macintosh c ursor, a blinking vertical line, is in the top left corner of
the Word text window. Be low the cursor is a short, dark horizontal line. This line indicates the
end of the current docume nt.
Before you begin to e nte r text, you must first set Word's menu level. Word will give you
either " short" or "full" menus. A maj ority of the features you will use a re found on the short
menus, however some are available only on the full menus . When Word is sold, it is set for short
menus, and must be c hanged to full menus.

WHAT

To Do

Pull down the Edit menu.

WHY

You ARE DoiNG

IT

Remember, to pull down a menu, place the mouse pointer
on the desired menu item then press and hold the mouse
button. One of the Edit menu items lets you switch
between the Short and Full menu levels. The last item
reads Full Menus. This means that you are presently
using the Short Menus.
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Drag the mouse pointer down the menu
until Full Menus is the selected item
(Figure 5. 10).

You want to change the menu level to Full Menus.

Figure 5 .10

This is the Edit Menu with
Short Menus selected. The
Full Menus option, shown
selected here, will change
the menus to their full
status.
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Set the menu level to Full Menus. The next time you pull
down the Edit menu, you will see that, in addition to having more items, the option fo r Full Menus has been
replaced by Short Menus. You will also see some changes
to the text editing window. The word Normal will now
appear in the status box at the le ft of the bottom scroll
bar, and a black box will appear at the top of the vertical
scroll bar. These will be explained in later chapters.

Many of the menu options are toggle choices. This means that they operate like an on/off
switch, which is sometimes called a toggle switch. The fi rst time you select an option, it changes
something to its opposite state. If you then select the option a second time, that something is
changed back to its original state. The Short/ Full Menus option is an example of many toggle
choices found on the various Word menus.

-

5 .16 SELECTING A FONT

Before you begin entering text, there are two tasks you should perform. You should use the
Chooser (on the DA me nu) to select the printe r you intend to use for fi nal output , and you should
select the font to be used for the majority of the docume nt.
Recall from Chapter 4 that the printer you select has a direct impact on the formatti ng of the
final document. Thus, if you do not have a LaserWriter available for output, make sure that you
have used the Chooser to select the ImageWriter. If you plan the final output for a LaserWriter,
even if you do not have one attached to the computer you are using, be sure to use the Chooser to
select it, rather than the ImageWrite r.
In a like fashion , it is a good idea to set the starting font before you begin to enter text. If
your final output will be made using an ImageWrite r dot matrix printe r, then the New York font
is a good one to use fo r starters. O n the other hand , if you will be printing your final document
on a LaserWrite r, you will find that the Times font works better.
All the samples in the text are using the Times font for printing on a LaserWriter. Thus , if
you are trying to match the examples exactly, you will have to use the Chooser to select the
LaserWrite r as your printer. The following section will show you how to select fonts.
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WHAT

TO Do

Pull down the Font Menu.

WHY

You ARE DOING
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The Font menu controls both the typeface you will be
us ing and the type size.
If your System File has so many fonts installed that the
list is longer than will fit on the screen, you will see a
small down-pointing arrowhead at the bottom of the font
list. This indicates that more fonts are available by dragg ing the selection bar down to this point on the menu.
When you do so, the Font menu will scroll . As you use
the Macintosh, you will fi nd that this is a feature of many
menus.

Drag the selection bar down to Times.

You want to create a new document us ing the Times typeface. Remember, if you are planning to output this document on an ImageWriter, the New York font will be a
better selection at this time.
Figure 5.11

24 Point
Chicago
Courier
Geneua
Heluetlca
Monaco

The check in front of the
New York font name
indicates that it is the
current font, and will
remain so if you do not
make any changes. In the
figure, the Times font has
been selected and will
become the current font
when the mouse button is
released.

Release the mouse button.

Releasing the mouse button will select the Times type
font.

Once again pull down the Font menu .

You will find that the Times 12-point font is smaller than
the default New York 12-point font. To compensate, you
are now going to change the type size for the Times font
to 14.

Drag the selection bar down to 14 point.

Select the size 14 point. This should be an outline font,
meaning that the computer has a bit-map definition of the
fo nt in this size. Times is also a laser font. Thus, even if
a 14-point outline size is not available, it will still look
good when printed on the LaserWrite r.

Release the mouse button.

Activate the selection.

Figure 5.12
Th e 14-point type size has
been selected. This figure
has this type size as an
outline font. This may not
be true on your computer.

Chicago
Courter
Geneua
Heluetlca
Monaco
New Yorlc:
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5 .17 ENTERING TEXT
Now that you have selected a printer, type font and size, you are ready to begin entering text.
This is the easiest part of word processing. All you have to do is type. Type the following text,
but do not press the [RETURN] key when you are done. Compare what you type to Figure 5. 13.

Word processing is fu n!

Figure 5 .13
Your Macintosh screen
should look similar to this
one. Remember, if you are
using an Image Writer this
line may have a slightly
different appearance.
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5 .18 DISPLAYING THE RULER LINE

The ruler line is present on most what you see is what you get word processors. Some put the
ruler line at the top of the text window, and some put it at the bottom of the text window. Jt
defines the left and right margins of the text you are entering. Frequently you will also see
characters appearing at various positions on the ruler line to indicate tab stops and other positions on the line.
Word does not display the ruler line unless you ask it to . This is done with a command fou nd
on the Format Menu .

WHAT

To Do

Use the mouse to pull down the Format
menu (Figure 5.14).

WHY

You ARE DotNG IT

You want to use a command on this menu.

Figure 5 .14
The Format Menu.
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Drag the mouse down to the first item,
Show Ruler.

You want Word to display the ruler line.

Release the mouse button.

Execute the selected command , Show Ruler. The ruler
line will appear at the top of the text window. (You may
also use the XR key to turn on the ruler line.) The Show
Ruler option is another example of a toggle switch menu
choice. The next time you look at the Format menu, the
choice will have changed to Hide Ruler. XR will still be
the command key equivalent.
Figure 5.15
The ruler line is now
displayed at the top of
the current window.
Remember that this is the
ruler line as it will appear
when a LaserWriter is the
selected printer. The ruler
line for the Image Writer
will have slightly different
spacing.

Word processiDB is fun II
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In addition to the ruler marki ngs at the top of the ruler line, there a re other items of
importance you should now notice. First, you should be able to recognize the tab stop positions.
They are the sma ll arrowheads appea ring be low the rule r markings every half inch. The left
margin point is the two triangles beneath the zero at the left end of the Rule r Line. The right
margin is the triangle located at the six-inc h position on the margin .
Separating the rule r line from the text window is a box that starts with the word "Normal "
followed by a row of small icons. The " norma l" is part of a pull down menu of pre-defined
styles. You will learn more about styles in a later c hapter. The icons are the tab stop icons , the
vertical line icon , the alignment icons, the line spacing icons, the spacing after paragraphs icons,
and the normal paragraph icon. These icons, too , will be discussed in later chapters.

-

5 .19 WORD WRAP

Word wrap is one of the features of word processing programs that helps speed up your text
entry. This feature allows you to type nonstop. The soft ware detects when a word you have typed
extends past the right margin. When this happe ns, that word is automatically moved to the next
line. You do not even have to pause in your typing . As a result of word wrap , the only time you
will ever have to press the return key is to indicate a new paragraph, or to force information to
stay on a single line, such as when you are e nte ring tables or columns of numbers.
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5 .20 THE RULER LINE AND WORD WRAP

To see the effects of word wrap and how the ruler line interacts with your document, add the
following sentence, errors and all , immediately after the sentence you have already entered. You
will fix the errors later. Of course, add a space after the exclamation point ending the first
sentence and before the beginning of this new sentence. When you are done, your screen should
appear similar to Figure 5. 16.
Wrd process1ng allows any person t o type text w1th neately JUStifyed margins,
und e rlines, and boldfacd text .

..

Figure 5 .16

When you have finished
entering the text, your
Macintosh should look
similar to this figure.
Word processing is f'unl Wrd processing allovs any person to type text vith
neataly justifyed margins, mxierlines, and boldfacd text.

Figure 5.17

The current Edit menu
with Full Menus set. Note
that one of the options is
Short Menus, which will
return the menu level to
the initial/eve/.

When you type the word " neately" you will have passed the six-inch right margin. The
word will be moved to the next line for you. Do not press the return key. Word is wrapping the
word that passes the right margin to the beginning of the next line.
After you have finished this paragraph, press the return key twice. You are doing this to
indicate two things. First, you want to start a new paragraph in the document. Second, you want
to separate the two paragraphs with a blank line. If you had not wanted a blank line between the
two paragraphs, you would have pressed the return key only one time. Word does not display
paragraph markers on the Macintosh display. To determine where you have put a return character, or any other special character such as the Tab key, you must turn on the Show , option.
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To Do

WHY

You

ARE DOING IT

Pull down the Edit menu.

You want to execute a command found on the Edit menu.
This menu looks different than the fi rst time you used it.
Because you are using full menus, you now have three
more options appearing on the Edit menu (Figure 5. 17).

Drag the mouse down to the Show ,
option.

Select the show paragraph codes option.

Release the mouse button.

Execute the menu option. In the future , you may use
either the menu or the :M:Y key to turn on and off the
Show , option.

Macintosh Productivity Tools

.,

Word.processing.is.l'unl.Wrd. processing.allovs.any.parsonto. type. text. v ith

neately.justifyad.margins,.Ullfarlila,.m1. boldfacd. tmrt. q
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Figure 5 .18
Note the paragraph
symbols that now appear.
You can also see dots
between each word you
have typed. These indiCDte
where you have pressed
the space bar.

I

t1

With the Show , turned on, you now see the paragraph
symbols at the end of the text indicating where you have
pressed the return key. Note that there are three such
symbols, the third one indicating the end of the
document.
Separating each word you have typed is a raised period.
These indicate where you have pressed the space bar
while typing. At this time, they are not important. However, when you are working with justified text (both the
right and left margin are straight). as you will be in a
later chapter, it will become important to know that the
space that appears between two words is only a single
space!
As you use Word and other special keys, such as the tab
key, you will discover that the Show , command will display them as well.

XY

Word will let you enter new text with the Show 1 displayed on the screen. However, the symbols can be distracting. For now , turn OFF the Show, while you enter
more text. Rather than using the pull down menu, try
using the command key equi valent. If you have trouble ,
pull down the Edit me nu and select Hide , .

XR

As you saw, it is possible to work with the ruler line displayed. It is, however, taking up some of the text window.
For now , turn it off using the command key equivalent.
Remember, the Show/ Hide ruler options can be found on
the Format pull down menu.
Now type the following text. Do NOT press the return at the end of the sentence:

Many word process1ng p r ogram5 have a spelling check program ava1lable that scans the
text and ind1cates words not found 1n 1t5 d1ctionary .

r

•

File Edit

··~

Format Font
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Document

Utilities
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Untitled I

Word processing is fun! Wrd pl"<lC85Sini allows any person to type text vith
mately justifyed margins, umerlines, m1 boldfacd text.
Many vord processing progrmns have a spelling cmck program aVllilable
that scans the text m1 iniicates v ords not foum in its dictionary~

.,

Figure 5 .19
The Macintosh display
after you have typed the
second paragraph.
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5 .21 CURSOR POSITIONING AND MOVEMENT

The text you have e ntered with your word processor so fa r has not been very d ifficult. Even so,
you have made "errors" when entering it. You must know how to move the cursor (the blinking
vertical line) to correct these errors or to make editorial changes.
Cursor move ment abilities make word processing programs very useful. Cursor movement
is the act of moving the cursor from one place in a document to another without affecting the
words on the screen . You can position the cursor at the location of a typing error o r at the
location of a planned editorial change and make the necessary c hanges.
You can position the cursor in the docume nt with the arrow keys fou nd on the bottom right
of the standard or Maci ntosh Plus keyboards or to the right of the standard typing keys of the
extended keyboard. You may also position the cursor anywhe re you want in the text by using the
mouse and the I-beam cursor. The sole limitation on cursor movement with Word is that you a re
only able to place the cursor whe re there is actually text. That is, the cu rsor cannot be placed
past the heavy underscore at the end of the document, or above the first cha racter of the
document.
In a simila r fashion you cannot place it past the last character on any g iven line. If you
appear to be able to move the c ursor beyond the end of a line, the n there are space characters
present after the last visible cha racter on that line . These spaces will appear when you select the
Show , (XY) option.
First , try moving the cursor with the arrow keys found on the keyboard.

WHAT

To Do

WHY

i i i

~+-+-

You ARE DoiNG

IT

This moves the cursor up three lines to the end of the
fi rst paragraph . Note that each a rrow press moves the
cursor up only one line. Word remembers the relative
position of the cursor on each line. Word knows that the
cursor is at about the five-inch point of the ruler line.
(You can verify this by once again turning on the ruler
line with 3t:R.) Thus, when you moved it up three lines
with the up arrow, the cursor tries to remain at the fiveinch point of each line of the text.
+-

This moves the cursor left. Note that each arrow press
moves the cursor le ft a single character.

-+ -+ -+ -+

Document Utilities Window
Untltledt

This moves the cursor right, still only a single character
at a time.

,

This moves the cursor down. Again, you are moving the
cursor only a single line at a time. The left and right cursor movements you entered above changed the cursor's
relative position on the line. It is no longer at the fiveinch point, but nearer to the four and a half-inch point.
Because of this change in relative position, the cursor
should now be positioned in the word "program" .

~ ~ovs any penon to type text vith
1

and boldfll:d tezl.

"'aspellingcblck J:fognunavailabla
mtfoUid in its dicliollliJ'Y.

Figure 5 .20
Note the current location
of the vertical cursor
between the p and r of the
word program.

Macintosh Productivity Tools

Holding down the command key and pressing the left
arrow moves the cursor left a word at a time. These three
word left commands move the cursor so it is positioned
in front of the word "spelling".
The command key and the right arrow moves the cursor
right to the beginning of the next word. The cursor
should now be in front of the "p" of program.
Du ring this time , the mouse poi nter may have disappeared from your Macintosh display. If
you do not see the mouse pointer or I-beam c ursor, to have it return , simply move your mouse on
the tabletop . The mouse will appear. If you had left it positioned outside the text window, it will
re-appear as the familiar arrowhead . However, if the mouse is inside the text window, the cursor
wi ll appear as the I-beam. If you have your mouse pointer positioned outside the text window,
move it into the text window now to get the I-beam cu rsor.
By positioning the !-beam on the docume nt and clicking the mouse , you can move the cursor
location in any size j ump you want.

WHAT

To

Do

WHY

You ARE DoiNG

IT

Move the mouse so that the I-beam
appears in the text window.

Moving the mouse on the desktop after you have been
typing will make the mouse pointer or I-beam appear.

Move the !-beam so that it is positioned
between the " a" and " n" of the word
"any".

You are going to move the cursor from its current location to this new location.

Document

I

Utilities

Window

.,

Untltledt

sing allovs ¥Y person to type text vith
1 m1 boldf'1Ed text.
~a spelling check

Figure 5.21
Place the /-beam cursor
between the a and n of

"any."

Program available

s not foum in its dictionary.

Click the mouse button one time .

Execute the cursor relocation.

Move the I-beam down on the screen.

When you clicked the mouse button, the !-beam blocked
your view of the cursor. If you had typed , the I-beam
would have disappeared of its own accord. You are moving the I-beam now so that you can see that the vertical
blinking cursor did appear at the desired location.

Move the !-beam so that it is between
the " p'" and "e" in the word
" spelling".

You are once again going to move the cursor location.

Click the mouse button.

Move the cursor location.

-

5.22 INSERTING TEXT VERSUS REPLACING TEXT

Now that you know how to move the cursor within your text, you are ready to make corrections
a nd additions to what you have typed . These processes may be pe rformed either by inserting new
letters, words, sentences, and so o n into your text or by replacing existing ones.
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The cursor has been
positioned between the W
and rof Wrd.

BEGINNING WORD PROCESSING CONCEPTS

Insert is just that. When the cursor is positioned in the middle of a word and you type, as
you type the lette rs from the cursor position and to the rig ht in the text will be moved right on the
line to make room for the new characters. Characters are added between the current cursor
location and the character immediately to the left of the current cursor location.
Word's replace process is a combinatio n of a deletio n and an insert. When the replace is
used , selected text is automatically deleted from the document. You are then inserting text at the
location of the deletion. You will discover that this method of replac ing text is used in every
Macintosh applicatio n.

WHAT

To Do

WHY

You ARE

DOING

lr

Move the 1-beam to between the " W "
and " r" of " Wrd", at the start of the
second sente nce of the document.

This is where you will first try to insert text.

Click the mouse button.

Remember, after moving the !-beam, you must click the
mouse to actually move the cursor to the desired location.

0

Add the letter "o" to " Wrd " , which should now read
"Word." The cursor will stay to the right of the new text
you have added.

Figure 5.23

You have fixed the spelling
of this word. Note that the
cursor is after the new
letter you have added to
the word.

format

font Docu
Untlt

fun I Wcj-d procaaing

gins, umerlines, m1

Now o nce agai n look at the text. The "y" in " justifyed " should be an "i." Rather than
inserting an " i" and the n deleting the "y," you w ill simply replace the "y."
Position the !-beam so that it is in front
of the "y'' in "justifyed".

You are preparing to select a letter in the word.

Press and hold the mouse button.

Begin selection of a text item by holding down the mouse
button.

Drag the !-beam over the letter "y" .

Select the "y" .

Release the mouse button.

Complete the selection of the letter "y".

Figure 5.24

The letter "y " has been
selected.

,. •

File

Edit Format

Word prOCSS!ing is fun! Word
neately justified margins, 11M
Many vord processing progra
that scans the text m1 indicate!

Type a letter " i'' . Note that the selected text, the lette r
"y" in this case, is removed and replaced with the text
you have typed .

Macintosh Productivity Tools

,. li File Edit Format

.,

Word processing is funl W
neately jlmif~ margins, uJ

Figure 5.25
The letter "y " has
changed to an "i". At the
same time, all the text has
been de-selected.

Many vord processing pro
that scans the textml. indic;

Dragging the I-bea m over a letter, o r words , of the text is one of many ways you can use to
select text with Word. T he double-click gives you a conve nie nt method for selecting a whole
word.
Move the 1-beam so that it is on the
word " available" at the end of the first
line of text of the second paragraph .

Position the !-beam for selecting text.

,

'"ent Utilities Window
tied I

IJii

illovs any person to type text vith

Q

pldf!cl text.
lliii8 check program av2iable
1.Dld in its dictionary.

Figure 5 .26
Note the position of the
/-beam on the word
available before the
double-click is executed.

Ilm:
!ml
iffii:
um.

:mr

!~~

T he double-click will select the entire word. This is the
word that you are going to replace with new text.

Double-click the mouse button.

r-ent Utilities Window
led I

pov s any person to type text vith
ldf!cl text.

,
01

Figure 5.27
After the double-click, the
complete word has been
selected.

ling check program MUD
1.Dld in its dictionary.

linked to them

Type this text.
When you began typing, the selected word was deleted
from the document. Because this was a deletion of text,
and Word does not know how many characters you intend
to type, it immediately reformatted the text for the rest of
the paragraph when you typed the first letter. The two
words " that scans" are brought up to the line on which
you are typing when you type the " I " of the word
"linked ." T hey return to the next line when you finish
typing the phrase .
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Figure 5.28
This is what your display
should look like a fter you
type the "/" to begin the
word linked. Note that the
complete word "available"
has been removed.

Figure 5 .29
This is what your
document should look like
after you enter the
complete phrase.
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5.23 OTHER WAYS OF SELECTING TEXT

You will have many oppo rtunities to replace words o r phrases in the fas hio n you just tried .
Because using this selectio n replacement techniqut: is a useful feature , Word has several ways
w ith which you can select sectio ns of text. Yo u have already used two methods. F irst, you used
the drag method. That is, you positioned the !-beam cursor at one point in the document , then
held down the mouse button as you moved the 1-beam . This selected the desired letter of the
docume nt .
Yo u also made use of the double-cl ic k to select a specific word of the text. Let's explo re
some other me thods of text selection right now. First , you will see that the drag method used
earlier may be used to select la rge portio ns of the doc ument on whic h you are working.

WHAT

To Do

WHY

You ARE DotNG

IT

Move the 1-beam to the space separati ng
the first and second sentences of the
first paragraph.

This is where you want to place the cursor to try another
text selection method.

Click and hold down the mouse button.

You are beginning the selection process by holding down
the mouse button.

Drag the !-beam right to the word
" text." Do not yet release the mouse
button.

As you d rag the I-beam, text wi ll be selected. Remember
that the Macintosh lets you know something is selected
by displaying it in inverse.

Macintosh Productivity Tools

.

' a

File Edit
-

-

Format Font Document Utilities
- -_ Untitled I

Word processing is fun I
w
A
II
Il!lltely justified margins, umerlines, and boldf!ICd text.

Window

,

EM-with

Many vord processing programs have a spelling check program linked to
them that scans the text and indicates vords not foum in its dictionary.

Drag the !-beam down to the space
between the two paragraphs. Do not
release the mouse button yet.

' a

File Edit

Format

Font

Figure 5 .30
The selected text is
highlighted. Note the
location of the /-beam
cursor between the last
two words on the first line
of the text.

By dragging the !-beam down, it is possible to select a
complete line.

Document

Utilities Window
- -- ---- - --- ----=
- - -- --

,

Figure 5 .31
You can select large
sections of your document
by dragging the /-beam
down.

vord processing programs have aspelliDg
program linked to
them that scans the text an:1 indicates vords not foum in its dictionary.

Drag the !-beam up and posit ion it in
front of the first word of the text.
Release the mouse button.

You can see that you may select by moving the !-beam
forward fro m its anchor point (where the !-beam was
s itting when you pushed down the mouse button) or
backward .

~=======~~

processing
allovs any person to type text vith
margms, umerlines,
and boldf!ICd text.

Many vord processing programs have a spelliDg clB:It program linked to
them that scans the text and indicates vords not foum in its dictionary.

Figure 5.32
You may drag the /-beam
either forward or
backward. The anchor
point, between the two
sentences, has not been
moved.

Drag the !-beam to the left edge of the
letter " n" beginning the word " neately."'

Position the mouse for another type of selection.

Slowly move the mouse left.

Move the I-beam a fraction of an inch to the left. The
!-beam will turn into an arrowhead . It is not the mouse
pointer that you are used to seeing, but rather a mirror
image of it pointing up and to the right, rather than up
and to the left (Figure 5.33).

'

6

File

Edl

~

~==
Many vord pre
them that scans

Figure 5 .33
The /-beam turns into a
mirror image of the
familiar mouse pointer
arrowhead when you
move the curso r to the left
edge of the text window.
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Click the mouse button once.

The single click of the mouse when the mirror image
arrowhead is showing will select the complete line of text
that is being pointed to.

Figure 5 .34
The whole line of text is
selected with a single click
of the mouse button.

Mllll)' vord processing prosrems blve a spe11ins chBck prognm linlted to
them that scans the text m1 iD1icales vords not foum in its dictionary.

Press and hold down the command key
(3€).

You are going to use the mirror image arrowhead together
with the comma nd key.

With the mirror image mouse still showing, press the mouse button once.

The 3€ key used with the mirror image arrowhead will
select the complete document.

Figure 5.35
The complete document
has been selected.
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You may de-select the doc ument, or any selection , by placing the !-beam almost anywhere
on the text and clicking the mouse button once.

-

5 .24 DELETING TEXT

The de lete ope ration is the opposite of the insert operation-it removes text from the document
and the space the text occupied on the line is immediate ly filled in. You have already learned one
way to delete text-the Replace procedure. Select the text you want to remove, then type new
text. You fou nd that the replace operation sta rts by deleting text. If you choose to replace a large
paragraph with a single sentence, then clearly you are deleting text.
You will not , however, always want to replace the text you are removing. In this case, you
just want to delete the text. Word has several ways with which you can remove text from the
document. One way is to select a portion of the text first, and then delete it. The selection may
be as small as a single letter of the document , or as large as the comple te document. Another
way to easily delete small amounts of text is by using the delete, or backspace, key.

Macintosh Productivity Tools

WHAT

To Do

WHY

You ARE DOING IT

Usc the mouse to position the I-beam to
the right of the second "e" in the word
" neately" and cl ick the mouse button
once.

This word is incorrectly spelled. You have now positioned
the cursor.

[DELETE]

The Delete key is found at the top right of the typing keys
to the right of the + I = key. On the Macintosh Plus keyboard, this key is labe lled "Backspace." T his key is the
character left delete, which re moves the letter to the
immediate left of the cursor's location.

If you hold down the delete key, then severa l cha racters wi ll be de leted. T his key, like a ll the
rest o n the Maci ntosh keyboard, will begin repeating when he ld down.
Use the mouse to posit ion the 1-beam o n the word "allows", the third word of the second
sentence.
Double-click the mouse button.

Select the word "allows".
Figure 5.37
The word "allows" has
been selected with the
double-click.

nt Document Utilities Win
Untitled I

[DELETE]

~ •

Figure 5.36
Note the position of the
/-beam.

,. •

(If you are using an extended keyboard , you also have a
key that will delete the character to the right of the cursor
location. This is the key with "del" and an " X" enclosed
in an open right-fac ing arrow.)

Once again press the delete key. The selected word is
removed from the document. Note that the rest of the line
squeezes left to fill in the space vacated by the deleted
word, and that the word " neatly" filled in at the end of
the line of text.

File Edit Format Font Document Utilities Window
Untitled I

Word processing is f'lml Word processingpey person to type text vith neaUy
justified =gins, lm1erlims, and boldfll:d text.

MIUlY vord processing programs haw a spelliDg check program linked to
Umn lbal scans tha taz:t m1 indicates v ords not foUD1 in its dictionary.
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Figure 5.38
The edited text.
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Word will always align the text to fi t within the current margins as soon as you ma ke an edit.
Lines that a re shortened because of an edit automatically have words pulled up onto them fro m the
next line. Lines that overflow the margi n because you have inserted text automatically have words
pushed down to the next line. No special commands o r keystrokes are required. Thus, whe n you
deleted the wo rd " allows", the word " neatly" was pulled up to the now shortened line .

-

5 .25 RESTORING DELETED TEXT

It is also possible to resto re accide ntally removed text. The fi rst option found o n the Edit menu
will co nstantly cha nge to let you know if you ca n undo your last action. At times it will say
" Undo Typing." This mea ns that you can complete ly erase the text you have ente red. The option
w ill change to " Redo Typing" to restore what you have cut. Since you have removed text by
typing new informatio n (the delete key in this case), the menu should read "Undo Typing."

WHAT

To Do

WHY

You ARE DotNG

IT

Pull down the Edit menu.
Drag the pointe r to the first option,
Undo Typing.

Select the Undo Typing option. Note that you may access
the Undo command with the :M:Z key.

Figure 5.39
The Undo Ty ping option
has been selected.

Tabll' ...
6l01111ry ••.

MK

Show 'I

MY

PIISI e U n k '\:f.t
UtHlDh! Lint '\:fJ

Shor t Menus
Preferences •••

Release the mouse button.

Figure 5 .40
The word "allows " has
been returned to the text.
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The word "allows" should return to the document at the
location from which it was deleted. It wi ll be selected, so
that it is easy to see.
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Macintosh Productivity Tools

Pull down the Window menu.

We want to look at the contents of another window.

Drag the mouse down to the Show Clipboard option.

The selection bar should highlight Show Clipboard
(Figure 5.4 1).

Figure 5.41
The Show Clipboard
option of the Window
menu is selected.

Re lease the mouse button.

The clipboard window will open on the bottom of the
computer's display.

~ File Edit Format Font Document Utilities Window

r

Untitled I

Word processing is fun I Word processing allovs any person to type tal vith
neatly justified margins, underlines, mi. boldfllcd text.
~
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Figure 5 .42
The current clipboard is
empty. The Delete key
does not move text to the
clipboard.

Many vord processing programs have a spelling check program linked to
them that scans the text m1 imicates vords not foUD:1 in its dictionary.

..

,

Clipboard

Notice that the clipboard does NOT contain the word ·'allows". Word does not put text that
you remove with the delete or backspace key o nto the clipboard. Text deleted in this fashion is
placed into a current typing buffe r maintained by Word.
Click the mouse pointer on the Clipboard Close Box.

Remember that the close box is the box on the left end of
the window's title bar. Clicking the mouse pointer on this
box will put away the clipboard .
The word "allows" should still be selected . If not, use
the double-click to select it again.

Pull down the Edit menu .
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Drag the mouse down to the Cut option.

Figure 5.43
The Cut option is
highlighted on the Edit
menu. Note that the word
allows is still selected. The
Cut option will operate on
the selected text in the
current document.

This time you will use the Edit menu's Cut option to
remove the text from the document. You can see that you
may use the XX key for the Cut option.
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Release the mouse button.
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Execute the cut. The word "allows" will once again be
removed from the document.

Pull down the Window menu.
Drag the cursor to Show C lipboard.

You once again want to look at the cl ipboard .

Release the mouse button.

The C lipboard window will again be opened on the
screen. This time the word "allows" appears on the clipboard.
Information removed from a document with the Cut command is placed onto the Clipboard.

Figure 5.44
The clipboard now
contains the word that was
Cut from the document.
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Click the mouse pointer on the Clipboard Close Box.

Put away the clipboard.

is easy

Type this new text into the document at the current location of the cursor.
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Figure 5.45

The edited text.

Untltled1

Word processing is fun! Word processing is easy any person to type text vith
neaUy justified margins, underlines, m1 boldfacd text.
Many vord processing programs have a spelling check program linked to
them that scans the text am indicates vords not founl in its dictionary.
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Just as above, this is the Undo Typing key from the Edit
menu. You are undoing the last words you typed. The
undo places the words into the current typing buffer, not
the clipboard.

xz

If you pull down the menu, rather than using the command key, you will see the first option reads Redo Typing , rather than Undo Typing. The Redo Typing
command retrieves the text from the current typing buffer
that was removed with the Undo Typing command.

xz

Once again take out the phrase.

Pull down the Edit menu.
Drag the cursor down to the Paste
option.

The Paste option, which can be activated by the XV key,
inserts into the text the current contents of the clipboard.

Figure 5.46

The Paste option has been
selected.
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Release the mouse button.

The word "allows". which was the last thing to be placed
onto the clipboard with the Cut (XX) command, will be
placed into the text at the current cursor location.

Unlike the current typing buffer, which restores text to the exact spot from which it was
removed, the Clipboard may be used to restore text to any location in the document. You will
have more opportunities to do this in a later chapter.

-

5 .26 SAVING YOUR WORK

An advantage of word processi ng is that if you have to make c hanges to the text at a late r date,
you do not have to retype the complete document. All you need to do is make the needed
corrections. Then the computer retypes the work for you . To have the computer do this you must
first save your work. Once a document has been saved, you can retrieve it at a later date to make
modifications or corrections.
Word has two save options-Save a nd Save As. These are the save options available with
most Macintosh application programs. The Save option is used after you have saved the document at least one time. If you have not saved the document, then Word wi ll ask you to supply a
name fo r it. If you have previously saved the document, the Save option uses the current name of
the document as it appears on the title ba r, and places the document onto the same disk used for
the prior save. The previous version of the document is erased and the copy you are working with
is made current on the disk. You end up with one copy of the document, the most recent version.
The Save As command lets you supply a name for a new document, or change the name of
a n existing document before it is saved. In addition, you may change the folder into which the
document is saved. If you want, you may even eject the floppy disk in the disk drive and change
d isks onto which the document is saved . The Save As lets you do any single one of these actions,
or any combi nation of them. If you are usi ng Save As with a previously saved document, and you
are changing the name , folder or disk for the document, you will end up with two copies of the
document, an older version and the newly edited one. If you use a name that already exists in a
folde r, you will have to confi rm that you want to replace the prior document with the new one.
Recall that the Finder wi ll not let you have two documents with the same name in a single folder.
If you are using a computer with a hard disk and a single floppy disk drive, you may want to
save this document on a floppy disk, rather than on the hard disk. If a floppy disk is not in the
disk drive , insert one now.
If you are using a computer with two floppy disk d rives, and you presently have your system
start-up disk in one, and your Word program disk in the other, have your data storage floppy disk
handy.

WHAT

To Do

WHY

You ARE DOING

IT

Pull down the File menu .

The File menu has both the Save and Save As options
located on it.

Drag the cursor down to the Save As
option.

You want to save the document on wh ich you are working, and give it a name at the same time. You also want
the option of bei ng able to change the disk drive on which
it will be stored.

Macintosh Productivity Tools

Figure 5.47
The Save As option has
been selected.
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Print Merge •••
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~FB
Print...
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When you release the mouse button, you will see the
Save As dialog box. Note that the document you have
been working on does not yet have a name.

Release the mouse button.
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Figure 5.48
The initial Save As dialog
box. You can see that a
disk called " Hard Disk" is
the currently selected disk
drive, and is where the file
will be saved if you do
nothing to change the disk
drive.

=Hord Disk
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(Cancel J

(

Driue
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Type the name of this document. Make it "My First
Document."
If you are us ing a computer with a hard disk drive, and
the name of your hard disk appears at the right of the
Save As dialog box above the Save button, then you
should click the Drive button. This will tell the Macintosh you want to save the document on the disk in the
floppy disk drive. (If you did not put your disk into the
floppy d isk drive as instructed above , the Drive button
will be dimmed!)
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If you are using a computer with two floppy diSk drives,
and your data storage disk is not in either of them, click
on the Eject button. Th is will cause one of the disks to be
ejected from a disk drive. Replace the disk with your data
storage disk.
Figure 5.49
The disk drive onto which
the file is to be stored has
been changed from the
Hard Disk to a disk called
MY DATA. This was done
by inserting a disk into a
disk drive and clicking the
mouse pointer on the
Drive button found in the
dialog box. MY DATA is an
empty disk.

Edit

Format

Font Document

Utilities Window

.,

ecl.to

Saue Current Document as:

IMy First Oocumen~
0

Fast Saue

0

Make Backup

[File Format ... ) Normal

Click on the Save button.

(g) MY DATA
776K auallable
( Saue ~ ( Eject )
(cancel)

~

After you have typed the name fo r the document, and
selected the disk onto which you want to save it, clicking
on the Save button will execute the command, saving the
document onto the disk.

You may a lso, in addition to changing the disk drive onto which the document is saved ,
change the folder on the disk. In the file list window at the top left of the Save As dialog box you
can identify a folder by the miniature folder icon in front of a file name. Addit ionally, the name
is not dimmed, as is a document or application name. If you double-click on a folde r in this list,
you are telling Wo rd to open the folder for you. The contents of the folder wi ll be displayed, and
the folde r's name wi ll appear above the file list.

Figure 5 .50
This dialog box shows
another disk called MY
DATA . It has two folders
that appear in the disk 's
main window. There are
also several files at the
same level on this disk.
The file names are
dimmed, while t he folder
names are not. You may
double-click on a folder
name to make it the
storage location. Your disk
may not look exactly like
this one.
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You may also tell the Macintosh to close the folder. T he folder name above the list of files it
contains is a pull down me nu. Use the mouse to pull it down, and select the desired level. If you
select the botto mmost ite m o n this list , you will be te lling Wo rd to save the docume nt o n the
disk's main window, and not in any fo lder.

,..

.

Edit
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Font Document Utilities
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Window
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eJ Graphics Folder
(g) MY OATH

(g) MY OATH
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Saue Current Document as:

D rns1 ~nul' D Mete Backup
[File Format ... J Normal

Figure 5.51
The folder name at the top
of the file list window has
been pulled down. You can
see that the folder called
Science Project Folder is
inside Cricket Graph Folder,
which is inside the
Graphics Folder found on
the disk called MY DATA.
Your disk may not look
exactly like this one.

l Saue B[ Eject J
(Cancel J

[
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5.27 USING PRINT PREVIEW

As you are working with larger docume nts, you may find it helpful to see what your work will
look like on paper. Ultimately, this w ill require that you print your work. However, Wo rd does
provide you with a shortcut; a way to get a good idea of what your work w ill look like, and what
will be w here on each page before you actually print the docume nt. T his feature is called Print
Preview . Print Preview will fo rmat your document and display it in mi niatu re on your compute r's screen.
You even have the option of working with your document in Page View, rather than in the
_ view you have been using. Page View is the Print Preview screen, enlarged to full size. Page
View will let you see how the document w ill actua lly appear o n paper, displaying the margins,
a nd items such as footnotes as they will actually appear when you create the final printed copy.

WHAT

To Do

WHY

You ARE DotNG

IT

Pull down the File menu.

The Print Preview command can be located on the File
menu.

Drag the mouse down to Print Prev iew.

You want to see what your first document will look like
when printed. Note that print preview may be accessed
with the 3€1 key.

Release the mouse button.

Activate the Print Preview option.
You will now see two " pages" appear on the screen that
represent two sheets of paper. On the le ft one will be the
text you have typed. Since a whole, 8 1/2-inch by 11 -inch
piece of paper cannot be displayed on the 9-inch Macintosh monitor, the pages are reduced in size, with your
typing appropriately shrunk.
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Figure 5 .52
The initial Page Preview
display.
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Note that there are four icons at the left side of the d isplay. They are, starting at the top, the Page Number
Placement icon, which lets you turn on page numbering
and select the location on the printed page fo r the page
number. Beneath the Page Number Placement icon is the
Margi n Set icon. This icon will let you adj ust the marg ins for the complete document. The third icon is for
zooming the display. You may view either two consecutive pages of your work, as you are right now , or only a
s ingle page at a time. Clicking on this icon now wi ll
change the display so that only one page is shown, rathe r
than two. The final icon will let you print the page displayed in the Page Prev iew mode (NOT the complete
document!).
At the top right of the d isplay you can see the Page View
button and the Cancel button.
C lick on the Page View button.

Select Page View.
Note that between the current page number and the word
Normal, found at the bottom left of the text window,
there now appears two arrowheads. These are used to
move the cursor from one page of the document to the
next.
You can see that the scroll bar at the bottom of the window indicates that you are no longer looki ng at the left
edge of the screen .

Move the mouse pointer to the leftpointing arrow on the scroll bar at the
bottom of the display.

You want to scroll the contents of the window. Note the
location of the mouse pointer in Figure 5.54.
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File

Edit Format

Font Document Utilities

Window
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Word processing is fun I Word processing allovs any person to type
neatly justified margins, underliD3S, and boldfl!Cd text.
Many vord processing programs have a spelling cb!ck program linked to
them that scans the text and indicates vords not founi in its dictionaryj

Press and hold the mouse button until
the box on the scroll bar is at the left
edge of the scroll bar itself.

Figure 5 .53
The first look at Page View
for this document. Note
the two arrowheads at the
bottom of the text 's
window. Otherwise, this
view appears the same as
the one you are used to
seeing.

Scroll the window to the left. You will now see the left
edge of the paper, and whe re the text will fall on the
printed page.

.,
Word processing is fun I Word processing allovs any person to
neatly justified margins, unierliDes, mi. boldfliCd text.

Figure 5 .54
After scrolling the window
as far left as possible, you
can see the edge of the
paper.

Many vord processing programs have a spelling check
them that scans the text and indicates vords not founi

Pull down the Document menu.

The Document menu lets you pe rform a variety of tasks
related to the appearance of the document.
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Note that the Page View item has a check mark in front
of it (Figure 5.55) . This indicates that Page View is currently active.

Figure 5 .55

The Document Menu. Note
that Page View is checked,
indicating that the current
document is displayed in
Page View, rather than the
standard editing view.

Drag the mouse down to the Page View
item.

You want to change from Page View to the standard editing view.

Release the mouse button.

You will be returned to the standard editing view. Page
View is a toggle menu item. You may re-enter Page View
at any time by selecting this option. You do not have to
access Page View by using Print Preview. You should
have noticed that Page View may be toggled with the
:K:B key.

-

5 .28 PRINTING YOUR TEXT

All the effort of e ntering a nd editing text would go for naught if you could not then produce a
paper copy of the report , letter, memo, or whatever you wrote. You may find that it is helpful to
print a draft copy of your text to proofread before you print a final copy. This can especially be
true if you have both a n ImageWriter and a LaserWriter avai lable to you. The ImageWriter is not
as expensive to operate, but it is much slower than the LaserWriter. You must also remember that
the two printers will format the docume nts differently. If you intend to c reate a draft copy on the
I mageWriter, use it for checking edito ria l changes, spell ing and things such as overa ll line
spacing . The final copy printed on the LaserWriter will have the lines of text e nd at different
locations, a nd possibly even diffe re nt page breaks.
It is a good habit to save your work be fore you print it. T here is always the probability that
you e ncou nter a proble m with the printing process, one which causes you to have to reset the
computer or that in some fashion causes the loss of data in the computer 's memory. If you have
saved your work, it is a simple matte r to fix the printer problem, then restart the computer,
retrieve the document from the storage disk and once again print the text. If you have not saved
your work, you will have to re-type the document before you can print it.
If you have been following instructions, you should already have your work saved at this
time. If not, be sure to save what you have typed before you continue.
If you do not have a printer attached to your computer, you wi ll not be able to complete the
following steps!!

Macintosh Productivity Tools

WHAT

To Do

WHY

Pull down the File menu.

You ARE DotNG

IT

The Print command ca n be found on this menu .
Figure 5.56
The File menu includes the
Print command, which is
the selected option here.

Drag the mouse down to the Print
command.

You want to c reate a final printed copy of the text.

Release the mouse bunon.

Activate the print command . Note that you may also use
the ~p key to begin the print process.
Depe nding on which printer you are using. you will see
one of two different dialog boxes. Figure 5.57 shows the
dialog box you will sec if you are usi ng a LaserWriter.
Figure 5.58 shows the dialog box you will see if you are
using an lmageWriter.

Edit

Format

Font

Figure 5.57

Document

Leserwrlter "Leserwrlter II NT "
Coples:l•l

Pages: ® Rll

Couer Page:

®No 0 First Page

Peper Source:® Peper Cassette

OK ;J
c=J To: c=J [Cancel ]
6.0

0
0
0

From:

This is the dialog box you
will see if you are using a
LaserWriter printer. The
name of your LaserWriter,
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Figure 5 .58
This is the dialog box you
will see if you are using an
Image Writer printer.
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If you are using an Image Writer, be sure to select the
quality of pri nt. If you select Draft quality, you will not
see any of the fo nt or type size changes you have used.
Using the Faster quality wi ll produce a printed copy of
your document with all the fon t and size cha nges pri nted
as you would expect to see them. Best quality output wi ll
take the longest to print. but will also have the best
appearance.
The LaserWriter gives you several d iffe rent printing
options . The Cove r page is a summary sheet that can be
useful if you a re sharing the printer with many others, or
the printe r is in a location other than where your compute r is, and you must go to it to pick up your work.
Both types of pri nters give you a Pages option. which lets
you select a subset of the document for printing . This is
useful, fo r example . if you want to repri nt the last two or
three pages of a large document.

If you do not have a pri nter attached to your Maci ntosh.
clic k on the Cancel button. T his will terminate the printing process. If you do have a printer, continue.
Click on the OK button.

For now, you want to print the complete document you
have c reated. C licking OK will start the print ing process.

-

5 .29 CLOSING A DOCUMENT
At a ny time, you may stop editing a docume nt a nd start on a new one. Word wi ll let you have
more tha n o ne docu ment ope n simultaneously. T his lets you copy po rtions of text from o ne
docume nt to a nothe r. T hi s is a fo rm of boi le rplating . However, there may come the time when
you have too ma ny docume nts open , or you have un-re lated documents open . In these cases. you
w ill want to close one o r mo re Word fil es.

WHAT

To Do

WHY

You ARE

DOING

IT

XS

Press the command key and the lette r S . This will execute
a SAVE comma nd . Your work may already be saved, but
this w ill e nsure that the most recent cha nges have been
saved.

Pull down the F ile me nu .

You can see that the Fi le menu has a C lose option. Th is
option may be accessed wi th :l€W. The present ly active
window will be closed if you select this option . Remembe r that you can tell which window is active by the horizontal lines in its title bar.

Re lease the mouse button.

Do not use the Close command found on the File menu
a t this time.

Clic k the mouse po inte r on the close
box at the top left of the title bar.

You may also close a window by clicking on its close
box.
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Word processing is fun! Word. processing allovs my person to tfll8 text vith ·

The mouse pointer is
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box.

rmtly jusjified margins, underlineS, and boldflai text.

Many vord processing programs have a spelling check program linked to
them that scans the text arx1 indicates vord.s not found in its dic¥onary~

After you have closed the file , you will see an empty
desktop with the Word menu bar at the top of the screen.
If you are not using MultiFinder, you will not see any
disk icons or the trash can icon. These icons will be on
the screen if you are using MultiFinder.

Figure 5 .60
This is what your
Macintosh display will look
like after you have closed
all the documents you
have been working on.

-

5.30 STARTING A NEW DOCUMENT

As suggested earlier in this chapter, it is possible to work on two or more documents at the same
time. These may be existing documents. or one may be a new document. If you have already
lau nc hed Word , it is a waste of time to exit the program and then re-launc h it to start a new
doc ument. Instead , you may use the New option found o n the File menu.

WHAT

TO Do

Pull down the File menu.

WHY

You

ARE DOING IT

You want to use the New option fou nd on the File menu.
You can see that you may use the :lf:N key to create a new
document , as well as using the pull down menu.
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Drag the mouse down to the New
option .

You will use the Menu at this time.

Figure 5.61
The New option o f the File
menu has been selected.

l>rin t l>rt.>uh.•UJ ••• :•: I
l>rint Ml'rgl' .•.
l>agP. Sotup ...
l>f inL.

Release the mouse button.

ExecUie the New option. A new document will be created. Its name is Untitled2. You are now ready to begin
working on a new document.
If you execute the New command again at this moment.
the next document will be called Unt itled3.

.,

Figu re 5 .62
The new document is
called Untitled2.

I
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5 .31 FINDING ON-LINE HELP
Word has a very useful help fac ility that may be accessed while using the program. You may get
to the Help processor in one of two ways. Help is the first option listed on the Window menu
(Figure 5.63). You may also get to help through the DA menu . When Word is running, the first
item of the DA menu is "About Microsoft Word ...". If you select this option, you will see a small
window which includes the version and date of the program you are using and a Help button
(Figure 5.64). By clicking on the Help button, you will get to the same place as selecting Help
from the Window menu .
Figure 5.63
The Window menu. Note
the Help option is the first
item on this menu.
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Font Document Utilities

Window

Untltled2
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Help;)}

(cancel J
Microsoft Word Uerslon 4.0
Rprll 10, 1989
C> 1987- 1989 Microsoft CDrporatlon

.,

Figure 5 .64
Selecting ' :4bout Microsoft
Word... " on the DA menu
gives you this information.
You can tell that this
information is off the DA
menu, since the apple
menu item is currently
highlighted. Also notice
that there is a Help button
displayed on this
information screen.
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After selecting Help, you will see the Help window (Figu re 5.65). You can see that it is an
outline of topics. All you need to do is locate the desired topic, and then click on the Help
button. You may then return to the Topic outline by clicking on the Topic button, or return to
your work by clicking on the Cancel button.
Figure 5 .65
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The help screen will look
like this the first time you
access it.
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Use the Help facility now to find out about the Ruler Line.

WHAT

To Do

WHY

You ARE DoiNG

IT

Pull down the Window menu.

You will get to Help this time by using the Window
menu .

Drag the mouse down to the Help
option.

Select Help.

Figure 5.66
The Help option on the
Window menu has been
selected.

Release the mouse button.

Activate Help.

Cl ick on the lower part of the scroll bar
that is on the right of the topic outline.

Scroll the topic outl ine until you see the word Ruler
appear.

Click on the word Ruler in the topic
outli ne.

Select Ruler as the topic fo r which you want hel p.
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File Edit Format Font Document Utilities Window

Figure 5 .67
You are going to get
information about the
Ruler since it is the
highlighted topic.
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C lick on the Help button.
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Get the information about the Ruler that is available online. Use the scroll bar to read all of the information.

.,

File Edit Format Font Document Utilities Window
Untltled2
Help
Ruler
The Sllev R•1er/HI.. R•1er commenda (for met
menu) turn the ruler cll1plev on and off.
The default unit or mee~ure 111 ..,.th the Preference~
commend determines the unltaon the ruler.
Word updates aetttngs In the Peregreph, Document, end
Section dialog boxes to renect chln91• mede ualng the
ruler.
The appearance end uae of the ruler depend on the
ecttve ruler ~cale, ..,hlch vou can chlnC)II bV clicking
the ~cale Icon ( w.~).
R•1er ece1ee
llor...1tce1e Zero mark of ruler align...,ith left
merg1n, left column bounderv, or left bounderv of
ooaitioned oeraoraoh. Dotted line indicate~ rioht

Click on the Cancel button .
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Figure 5 .68

I

I

This is the beginning of
the Help information for
the Ruler topic. Note that
the Help button has turned
into a Topic button.
Clicking on the Topic
button will return the help
processor to the help topic
outline.

Page 327
I
I
I
I

I
i

You are done with Help. When you cancel Help, you are
returned to editing your document.

There is a sho rtcut to getting he lp about a n item in the Help top ic outline-double-click on
the topic. This will have the same effect as selecting it. then clicking o n the He lp button.
Remember, the double-click may be used in many places to o pen o r activate a n option.
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5 .32 QUITTING WORD

You have now fini shed your writing session. Befo re you leave the computer. te ll it that you are
finished with the program by quitting. Quitting Wo rd wi ll return you to the Fi nder. O nce you are
working with the F inde r you will be a ble to re move your floppy disk from the d isk d rive.
Wo rd w ill not let you close a docume nt without g iving the program permiss ion if tha t
docume nt has not been saved. Because of this, you cannot q uit the p rogram itself w ithout g iv ing
pe rm iss ion if the document you a re working o n has not been saved . Word cons iders a document
not saved if you have ty ped a t least o ne c harac te r si nce the last time you saved you r work.

WHAT

To Do

WHY

You ARE DOING

IT

X

Type an " x' ' into the new doc ument you have created.

Click on the Close box.

Try s imply closing this document without prev ious ly saving it. You will get the dialog box seen in F igure 5.69.

Figure 5 . 69

This dialog box appears
when you try to close a
document which has not
been saved .

•

r

File

Edit

Format

Font Document

Utilities Window

.,

Untltled2

~
X

-

,

Saue changes before cl osing?

c Yes

(

No

l

(Cancel )

C lick on the Cancel button.

Ca ncel the C lose command.

Pull down the File me nu.

The Quit command is the last item on the F ile menu . You
can see that the Quit command can be activated with the
~Q key.

Drag the mouse down to the Quit
command.

You a re going to Quit Word .

Release the mouse button.

Execute the Quit command . O nce again the d ialog box
seen in Figure 5. 69 appears ask ing if you want to save the
document.
If you click on the Yes button. a nd this is a new docume nt. you will see the dialog box wh ich lets you name
the document and c hange the disk a nd fo lder into which
it is saved . In e ffec t. you would be execut ing a Save As
command . fo llowed immediate ly by the Q uit command .
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Salle
Sa11e Rs ...
Delete ...

Font

88N
880
88W
88S
i)f7

o
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Figure 5.70
The Quit command has
been selected.

Print Pre111ew ... 881
Print Merge ...
Page Setup ...
i)F8
Print ...
88P
Open Mail ...
Send Mall ...
Quit

•• O

If you cl ick on the Yes button and this is an old document. the new version will be saved onto disk before the
program ends.
Finally. if you click on the No button. the most recent
changes to the active document will be discarded and the
program will end.
Click on the No button.

In this case . you do not want to save this document. The
docu ment .. Untitled2 .. will be discarded and you will
soon have the Maci ntosh Desktop displayed on the
screen.

Remember. when you exit the program. if you have not saved your work. Wo rd wi ll ask you r
permiss ion to quit. Always keep in mind that a document is not saved if you have pressed at least
one typi ng key since the last time you saved the work. You may use the mouse and cursor
movement as much as you want wit hout affect ing the Saved status .
If all the documents you have open have been saved befo re you Quit, you will not see the
dialog box shown in Figu re 5.69. There is nothing that may be lost by a failure to save an already
saved fi le, thus the dialog is unnecessary.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.

What is the purpose of cursor movement?
What is meant by the term word wrap?
What is the difference between inserting text and replacing text?
When you save your work with MS-Word. where is the text saved, on the same disk as the program, or on a different
disk?
How do you save your work with MS-Word?
How do you print you r work with MS-Word?
What are some advantages of usi ng a wo rd processor instead of a typewriter to produce documents?
What is the di ffere nce between a screen editor type of word processor and a line editor type of word processor?
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9. Modify the text you wrote this session so it reads as follows:
Word processing is fun! Word processing lets any person type text with neatly justified margins, underlined and boldfaced
text.
Many word processing programs have a spelling check program available which scans the text and indicates words not
found in their dictionaries.
10. Use your word processor to enter and print the following letter:
June 12, 1989
Mr. Fred Jones
Sales Manager
Gizmos and Gadgets, Inc.
137 West Main St.
Los Angeles, CA 90005
Fred:
Thanks one more time for expediting the last shipment of "Super Whatzits." They were the hit of the Homeowner's
Gadget Show.
I' II be in touch.

Sincerely,
Tom Hillski
Distribution Manager
This and That, Ltd.
11. Use your word processor to enter and print the following memo:
TO:
FROM:
DATE:
SUBJECT:

Harold Stien, Telecommunications
George Graham, Data Processing
November 14, 1983
Phone Installation

Alex Jones in Market Research and Mary Anne Peters in Administration have each received personal computers. Their
machines are equipped with internal modems to allow them to communicate with the company mainframe. Please contact
them both to arrange installation of dedicated phone lines in their respective offices.
Thanks.
12. Use your word processor to enter and print the following outline:
MICROCOMPUTER TRAINING SESSION
I.

Introductions
A. Instructors
I. Alice Sykes
2. Marissa Lopez
3. Lester Klien
B. Class introduce Self
1. Name
2. Department
3. Previous computing experience
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II. Hardware
A. The parts of the computer
1. Keyboard
2. Monitor
3. System unit
4. Disk drives
5. Printer
B. Put the computer together
c. Turn computer on
D. Run system tests
III. Floppy Disks
A. What they are
B. Their construction
c. Proper care
D. What not to do with your disks
IV. The Word Processor
A. How to start it
B. Entering text
c. Moving the cursor
D. Editing-insertion and deletion
E. Saving the text
F. Printing the text
G. Quitting the program
V. Training wrap-up
13. Use your word processor to enter and print the following letter:
May 10. 1988
Dear Mom and Dad,
School is going great this year. It looks like I will get all A's and B's. The economics mid-term was a snap. The calculus
mid-term was a bit tricky. but I escaped with an A minus.
Now for the obvious ... send money. I need to buy an airline ticket to get home.
By the way, I have a summer job lined up at the Wolffs Department Store. They must have liked the work I did last
summer, because I have been given a promotion from salesclerk to an area manager.
I'll see you in a few weeks.
Love,
Fred

CHAPTER

INTERMEDIATE
WORD PROCESSING
CONCEPTS
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-

CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:
• Open an existing document.
• Explain the difference between cursor movement
commands and text and window scrolling
commands.
• Center text on a line.
• Move the cursor to the top and bottom of the
display and document.
• Use the find feature of the word processor.

• Change the margins, line spacing, and justification
of the text.
• Define a block as it pertains to word processing.
• Select segments of the text (referred to as a
block), and move, copy, delete and undo the
deletion of the selected segments.
• Make style changes to the text, such as adding
boldface type and underlined type.
• Spell check the text.

-

6 . 1 INTERMEDIATE CONCEPTS

You learned in the last chapter all the basic procedures necessary to create, modify and print a
document. But word processors are capable of performing many more functions than you have
worked with so far.
There are functions that aid in the document preparation process, such as quick cursor
moves. There are functions that allow you to change line spacing and margi ns. And you can
change your text so it is printed with either a ragged right margin or a justified right margin.
Word processors also let you move and copy segments of the text from one location to another
and to jazz up the output with changes in the type style such as boldfacing, underlining,
italicizing it, as well as changes in the size of the type, either bigger than you usually use,
or smaller.
This chapter will explore how these useful tasks are accomplished .
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6 .2 THE TEXT WINDOW REVISITED
Most of the documents you write wi ll not fit onto the Macintosh di splay in tota l. Much of what
you w rite is ei ther above or below the wi ndow holding the document. That portion of the
mo nitor used to display the cu rrent portion of your work is in fact frequently refe rred to as the
text window. It is just like any other window you may have open when using the Macintosh.
Figure 6 .1
The Word text window.

,. It File Edit Format Font Document Utilities Window

.,

I

The re is more than one way to nav igate through the text window. In the previous chapter you
learned about cursor movement. That is the most com mon method and the easiest o ne to re me mber for moving the insertion point (t!lat is, where the next charac te r wi ll appear when you type)
through the text. Using cursor movement , you can push the text in the window up o r down to
allow you to see any portion of your doc ument.
You may, however, dec ide to move the text without moving the c urre nt c ursor locatio n. You
may want to do thi s to chec k what you have written at some other part of the document w ithout
losing your c urre nt insertion point. This is call ed tex t sc rolling.

-

6 .3 CURSOR MOVEMENT COMMANDS VERSUS
TEXT SCROLLING
If you move the cursor to the bottom of the text window, then move it down one more time, the
text wi ll move up a line in the window, a llowing the c ursor to move down. The same is true if
you move the cursor to the top of the window, then up one more line . The text w ill move down
so the cursor can move up. The movement of the cursor has pushed the edge of the text window
e ither up or down .
Text scrolling, on the contrary, moves the text inside the window but does not move the
c ursor off the specific line of text o n which it is located. If, for example, your cursor is located
o n the word "widget," found on the third line of the text window, and you scro ll the text down
one line , the cursor w ill now be on the fo urth line of the text w indow , but still o n the word
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"widget." A new line of text will appear at the top of the text window. The Macintosh word
processing programs will even let you scroll the text so far that you can no longer see the cursor
in the window!

-

6 .4 RETRIEVING EXISTING DOCUMENTS

Start your computer as you did at the beginning of Chapter 5. After you boot your Macintosh
with a System Start-Up disk, make sure that you have the Word Program disk at hand. If you are
using a machine with a hard disk you will not need to insert the Word program disk into a disk
drive. Rather, locate the Word 4.0 folder, and open it so you can see the Word program icon. If
you have two disk drives on your computer, or a hard disk and a floppy disk drive, place the disk
that you used while working in Chapter 5 into an empty disk drive. This disk should have the
document you created stored on it. If you do not have a free floppy disk drive, keep this disk
available. You will need it.
Just as in the prior chapter, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A 3€ in front of a letter (e.g., :M:X) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer 10 the specified item and click the mouse button two times fast. The
word " drag" means to select an item , be it an icon or the menu selection bar, and move the
mouse while the mouse button is pressed.
Also, remember to use the Chooser to select a laser printer if you want your work in this
chapter to closely match the figures.
Before you can experiment with text scrolling, or any other features of Word, you must once
again have a document with which to work. You will therefore start this chapter by loading back
into the computer's work space the document you completed in Chapter 5. There are two ways to
open an existing document when using Word.
First, you may double-click on the document's icon on the storage disk. The Macintosh will
figure out which application program created the document and will automatically launch the
program for you. This will only work, however, if the program can be found in one of the
computer's disk dri ves. If you are using a floppy disk-based computer, you may not always have
the program disk in a disk dri ve, so this method will not work for you. If you have two floppy
disk drives, it is possible to launch an application from one of it's documents if you eject the
System Start-Up disk , and replace it with the program disk, leaving the document disk in the
second disk drive. You will find, however, that the computer frequently requires information off
the Start-Up disk, and that you will do several disk exchanges before the program is running. It
is best to start the application, and then open the document.
The second method available for opening existing documents is to use the Open command
found on Word 's File menu. This command will let you inspect the contents of all the disks in
your computer. It even lets you eject unwanted disks from a disk drive and put different ones in .
Clearly, to use this option, you must first launch the Word application.
If you are using a computer with a hard disk, begin here:

WHAT

To Do

Locate the icon for the document you
prepared and saved at the end of Chapter 5 and place the mouse pointer on the
document.

WHY

You ARE DotNG

Figure 6.2
This is the icon you w ill
see for Word documents.

IT

You are going to launch Word by double-clicking on this
icon. Figure 6.2 shows the icon that Word creates for its
documents. The name of this particular one is My First
Document.

II

MI.! Ftrs1 Dooii'Mnt
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By double-clicking on a Word document, the Macintosh
will look on all available disks for the Word application
program . If found, it will launch Word and open the
document. If the Macintosh is not able to locate the
application program, you will see a dialog box similar to
the one shown in Figure 6.3.

Double-click the mouse.

Figure 6.3
You will see this dialog
box if the Macintosh is not
able to locate the Word
application program to
open the file you are
double-clicking.

The file " Calendar· could not be
opened/printed (the application Is busy
or missing).

If you have the Word application program on your hard
disk, or on a floppy disk currently in one of the computer's disk drives, the program should start, and after a
brief wait, the document you prepared during the last session will appear. You are now ready to begin editing the
document.
Figure 6 .4
The retrieved document
should look somewhat
like this.

r

·-•

File Edit
--

Format

Font Document Utilities Window

--

Word processing is fun! Word processing allovs any person to type text vith
matly justified margins, underlines, and boldfaced text

Mmy vord processiii8 programs have a spelling check program linked to
tbm1 that scans the text mi. indicates vords not found. in its dictionary.

:l€Q

I

This is the Command Key equivalent for the Quit command found on the File menu.
You are quitting now so that you can learn how to use the
Open command. Normally, you would not quit the Word
program after you load the document you want to edit!
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If you are using a computer that has o nly floppy disks, then start he re .
Locate the icon for the Word program.

You will launch the Word applicat ion program by doubleclicking on it.

Move the mouse to the Word icon and
double-click.

The double-cl ick will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu , o r press XO, the command key
equivalent.
After a brief wait , Wo rd wi ll be running, and you will
have a new, untitled document displayed in the window.

Move the mouse to the window's close
box.

r

Remember, the close box is the one found at the left of
the title bar (Figure 6.5).

li File Edit format f ont Document Utilities Window

.,

Untitled I

Q

Figure 6.5

The mouse pointer is on
the close box at the left of
the title bar.

~---------------------1
Cl ick the mouse button once.

C lose the untitled document. You are going to open an
exist ing document. and it is less confusing to work with
only one document active.

' li File Edit Format Font Document Utilities Window

Pull down the File menu.

.,

The File menu has the Open command.

Figure 6.6

Your Macintosh after you
have closed the untitled
document. All that is
showing is the current
menu bar. If you are using
MultiFinder, you may have
other items showing on
the desktop.
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Drag the mouse pointer down to the
Open command.

The Open command lets you open existing documents
found on the disk. Note that the Open command has 3€0
as a Command Key equivalent. You may recall that this
is the same key used by the Finder's Open command.

.,

Figure 6 .7
The Open command has
been selected.

Print Prt'IJit~uJ ... :•:1
Print Ml.'rgl.' .. .
Pn•J•~ Sc1 ur• .. .
Print. ..

Release the mouse button.

Execute the Open comma nd.
After a brief pause, you wi ll see a dialog box similar to
the one displayed in Figure 6.8, although the name of the
disk being displayed and the free space on the disk wi ll
probably be different.

.,

Figure 6 .8
The Open dialog box.
Since Word was launched
from the Hard Disk, this is
the one showing in the
current dialog box.
D Memo~
0 Project ProposDI
0 General Docs

:!1

= Ha rd Dlslc
2571 K DUDIIDble

IGci) l ~

[CDncei J I ~
I

OReDd

Only
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Click the mouse on the Drive button
shown in the dialog box.

The Drive button tells Word to display the document and
folder names found on a second disk currently in your
computer. Thi's may be a floppy disk, or a hard disk. If
you do not have a second disk in the computer, then the
Drive button will be dimmed, and you will not be able to
use it.
Continue clicking the Dri ve button until the name of the
disk that contains your file appears in the dialog box.
Figure 6 .9
After clicking on the Drive
box, the contents of MY
DISK is displayed.

D History Paper
D Math Outline
D My First Document

(g) MY DISK
764K au11i111ble

(~ll ~
I Cancer ] ! ( Driue ]
0

Read Only

You wa nt to open the document you named " My First
Document." By clicking the mouse pointer on the name
in the dialog box. you are selecting this document.

Click on My First Document.

Figure 6.10
The document "My First
Document " has been
selected.

D English Paper

D History Paper
D Math Outline
I

lo

(g) MY DISK
764K au11llable

{~Jj ( Eject

]

!I ( Driue

)

( Cancer]

0

Read Only
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Click on the Open button.

Execute the Open command . After a brief pause while
the computer reads the document, you will see a Word
editing window, with the document displayed in it.
You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the document name, rather than
selecting it and then clicking on the Open button in the
dialog box.

If you do not have the file on any of your disks it will not appear in the file list in the dialog
box. If this happens, you will have to re-type it. Don't forget to choose the Laser Writer printer,
the Times font, and a font size of 14 before you start typing. Here is the current text of "My
First Document" :
Word processing 1s fun! Word process1ng allows any person to type t ext wlth neatly
JUStified margins, underl1nes, and boldfaced text .
Many word processing programs have a spelling check program I inked to them tha t scans
the text and 1ndicates words not found in its dict1onary .

-

6 .5 SCROLLING THE TEXT
Now that you have a document loaded into the Word editor, you are ready to use some of the text
scrolling commands. Remember, the purpose of text scrolling is to move the document in the text
window without moving the location of the cursor.
When you retrieve text from the disk, you should notice that the cursor is placed at the very
beginning of the document.

WHAT

To Do

WHY

Place the mouse pointer on the middle
of the shaded scroll bar at the right of
the text window.
Figure 6.11
Note the location of the
mouse pointer and the
content of the text
window before clicking the
mouse.

You ARE DotNG

IT

This is where you will click the mouse to scroll the
window.

.,
--

---

.~

Word processing is fun! Word processing allovs any person to type text v ilh
neaUy justified lll2lrgins, underlines, and boldf~ text
Many v ord processing programs haw a spelling check progriUlllinked to
them that scans the text am indicates v ords notfown in its dictionary.

i;

!

Macintosh Productivity Tools

Click the mouse in the middle of the
shaded scroll ba r at the right of the text
window.

r

.

You want to scroll the text in the c urre nt window.

.,

~ File Edit Format Font Document Utilities Window
.

-

Figure 6 .12

After clicking the mouse,
the text has disappeared
from the window, as has
the cursor.

--

I I

I

,j:

!'

Yo u may also use the down and up a rrows at the bottom
a nd top of the scroll bar to sc roll the text.
Click and hold the mouse pointer in the
to p arrow of the right scroll ba r.

T his will gradually scroll the text back into the window.
Note. once all the text has returned , that the cursor has
no t cha nged it 's locatio n.

.,
naatly justified margins, umerlinas, am boldfa:ed text
Many vord processing programs haw a spelling cback program linked to
them that scans tm tezl am iMitates vords rx>l fourd in its dictionary~

Release the mouse button.

Figure 6.13

The text has partially
scrolled back into the
current text window. Note
the location of the mouse
pointer in the up-pointing
arrow at the right scroll
bar.

After the text has returned to the text window, release the
mouse butto n .
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Click the mouse in the middle of the
shaded scroll bar at the right of the current text window.

Once again, scroll the text so that it is all out of the text
window.

-+

Press the right arrow on your keyboard. (If you just
re-typed the text, and the cursor is at the end of the document, press the left arrow instead!)
When you press any key, the text will return to the text
window. When you are working with a longer document,
you will discover that the line with the cursor on it will
be placed near the center of the window.

When you are editing a multi-page report or paper, you will find that text scrolling in this
fashion is very useful. Invariably you will find the need to move the cursor to a different location
in the text so you can read what you have written. You will then want to return the cursor to the
end of the text so you can continue to write. Simply scroll the text with the scroll bar. Then press
an arrow key to return to the location in the document at which you are working.

-

6 .6 MORE CURSOR MOVES
As you work with a document, you will frequently find that the cursor is not where you want it
to be. This will be especially true when you are editing a multi-page report or paper. Invariably
you will find the need to move the cursor several paragraphs or pages. Even with shorter
documents, you will want to move the cursor to the end of lines, or from one paragraph to the
next quickly.
Word processors in general allow several types of cursor moves other than the simple line
up/down and character or word left/right discussed in the previous chapter, and Word is not an
exception. The Macintosh arrow keys can be a quicker way to move the cursor one or two lines
than making use of the mouse. There are also moves such as to the top or bottom of the display
or the beginning and end of the line. While it is always possible to use the mouse, sometimes the
keyboard commands are faster.
Moving the cursor to the beginning or end of a long document is a simple process. Use the
scroll bar to display the page where you want to work, then position the !-beam cursor to the
desired location and click the mouse. However, there is a keyboard equivalent command for
moving the cursor to the very start or end of the text. In this section you will explore these and
other keyboard cursor movement options. Please note that all the numeral keys mentioned in this
section refer to the keys located on the number pad at the right side of the keyboard. Using the
number keys found above the standard typing keys will result in the computer beeping at you.
Before you begin this section, make sure that you have positioned the cursor at the beginning
of the text, in front of the word " Word."

WHAT

To Do

WHY

You

ARE DOING IT

The command key with the right arrow will move the
cursor to the right a word. You saw this in Chapter 5.
Here you are moving the cursor right three words.
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Use the numeral 3 found on the number pad for this to
work. This key is equivalent to a Page Down key. If you
are us ing an Apple Extended Keyboard, you may press
e ither this key, or the Page Down key.
When you pressed the Page Down/3 key, the cursor
should have moved to the end of the document. With
longer documents, a new page worth of text would have
appeared , with the cursor placed on the first line displayed in the text window.

9

The number pa d numeral 9 is the oppos ite of the Page
Down command . It is the Page Up command.
Once again, because you are working with a short document , the cursor will simply return to the top of the wi ndow. With a longer document , you would see new text
d isplayed in the window with the cursor placed at the top
of the window.
Press the numeral I found on the number pad . This is
the End of Line key. When you press this key, the cursor
will jump to the end of the current line .

7

The oppos ite of the end of line key is the Beginning of
Line key , the numeral 7 on the number pad. When you
press this key, the cursor will j ump to the beginning of
the current line.
You should note that repeatedly pressing either the end or
beginning of line key will cause the cursor to move to
success ive lines in the text.

3€1

,. •

Closely re lated to the end and beginni ng of li ne commands are the end and beginning of sentence commands.
When hold ing down the command key and pressing the
number pa d numer a l I, you are instructing Word to
move the cursor to the end of the current sentence. The
cursor should now be between the first and second sentences of your text (Figure 6. 14).

.,

File Edit Format Font Document Utilities Window
Mu Flnt Document

Word processing is tunll9/ord processing allows any parson to type tat vith
naaUy justified. margins, UD1arliDes, am boldfaced text.
Many vord proc:essill,f prosrams baw a spel1iDa' cbect prosram liDted. to
tbml thatiCIIDI the tul am iD1icalal vords notfoUid in its dictiomry.

Figure 6 .14
The cursor is now between
the first and second
sentences of the text.

I

Move the cursor to the end of the next sentence.
The oppos ite of the end of sentence command is the
beginning of sentence command , wh ich is the numeral
7 on the number pa d used with the command key. Once
again, the cursor should be between the first and second
sentences of the document.
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The down arrow used with the command key moves the
cursor to the next paragraph marker in the texl. Since
you have pressed return twice between the fi rst and second paragraphs, the cursor is moved to the blank line
between paragraphs (Figure 6. 15). The X2 on the number pad will have the same effect as the X !.
Figure 6.15
The cursor is now between
the first and second
paragraphs.

.

~

-

M First Document

Word processing is tunl Word proc:essing allovs any person to type I8Xl vith
DSBtly jiBtified margim, m!erlines, and boldfiiCed text.

I

Manyvord processing programs have aspellingclvlck progrmnlinked to
tbam that scans the text and iMicales vords not found in its dictionary.

Xt

.,

,. It File Edit Fonnet Font Document Utilities Window

I

The up arrow used with the command key will move the
cursor to the previous paragraph marker in the text.
The cursor should once again be at the beginning of the
document. You may also use 3€8 on the number pad to
achieve this same effect.

The most impo rtant thing to remember is that all of these c ursor movement commands rely
o n the numera ls found on the number pad at the right side of the keyboard . Using the numerals
found above the standard typing keys will result in a beep from the Mac intosh when used w ith
the command key, o r the entry of the numeral into the text if used a lone.

-

6 .7 BEGINNING AND END OF TEXT
Just as you can move the cursor in line or page size jumps, it is poss ible to move it to the end or
beginning of the document with a single command. The cursor s hou ld be at the beginning of the
text.

WHAT

To Do

WHY

You ARE DOING IT

The number pad's numeral 3 used with the command
key will move the cursor to the end of the document.

3€9

The opposite of the end of the document command is the
beginning of the document command, which is the
numeral 9 from the number pad used in conjunction
with the command key.

Because your current text is so short, you wi ll not notice a major difference at this time
between the page up and down commands, and the beginning and end of text commands. When
you create larger documents, the difference wi ll become apparent.
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6 .8 SELECTING LARGE SEGMENTS OF TEXT
Many of the features available with Word operate on segments of your document. As you learn
more about usi ng this application, it will be useful to discover more ways to select segments of
your work.
You have already discovered the drag method of selecting text. Place the 1-beam cursor at
one location in the text, press and hold the mouse button and drag the cursor over the desired
text. The result is a segment of selected text.
You have also seen the effect of the reverse arrow in the left margin, which le ts you select a
line of text, or even the complete document.
There are several other ways available for selecting text. Some involve the use of the cursor
movement commands you have just experimented with , while others make use of the mouse.
When using the cursor movement commands, selection of text is done by simply holding down
the shift key, in addition to any other keys you may be pressing. You will explore these and
several other methods of selecting text in this section.

WHAT

To Do

WHY

You ARE DoiNG

IT

Make sure that the cursor is at the beginning of the document. Remember, the numeral 9 that appears here is the
one located on the number pad.
[Shift]-~t

Hold down the shift key, then give the command to go to
the beginning of the next paragraph, ~!. Since the shift
key is held down , all the text of the first paragraph will
be selected , as shown in Figure 6.16.
Figure 6 .16
After using the Shift-3f J,
all the text in the first
paragraph is selected.

Press the Left arrow key to de-select the paragraph. The
cursor should still be at the beginning of the document.
You want to try something else.
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Hold down the shift key, then give the command to go to
the beginning of the next sentence. Remember, the
numeral I to use is the one located on the number pad.
You will have selected the first sentence of the document.

[Shift]-Xl

Figure 6.17

The first sentence has been
selected.

Word procaaing aUow any pmon to type text with
lllllltly justiti'lld mar,ms, umerlines, and boldfad text
•
Many word p!'OCIISSiJI8 programs haw aspelliDg cla:k propm linked to
limn that scm~ the taxtml iD1icalas words not foUDd in ill dictionary.
Figure 6 .18

Note the location o f the 1beam cursor in the middle
of the word " person."
+-

Press the Left arrow key to de-select the paragraph . You
once again are going to try something else.

[Shift]

Press and hold the shift key. This key is sometimes called
the constrain key. You have been using it to constrain the
movement of the cursor. You will do this one more time.

Move the 1-Beam cursor so it is between
the letters rand s of the word person,
still on the first line of the docume nt.

Remember to keep the shift key depressed. However, do
not press the mouse button yet! Your display should
appear similar to the one shown in Figure 6. 18.

Click the mouse button once.

With the shift key held down , the cursor is stretched to
select all the text between where the cursor was at the
start of the action, and the location of the !-beam when
you click the mouse.
It should be simply noted here that any of the cursor
movement commands discussed earlier in the text , from
the simple arrow key movement to the beginning/end of
text commands, when combined with the shift key, will
select the text over which the cursor passes. Try one
more to prove this.

Figure 6 .19

After clicking the mouse,
all the text between the
starting point o f the
cursor, in this case at the
beginning of the
document, and the 1-beam
is selected.

IIBiltly j\Biified marsms, umerlines, and boldfaced teXl

n to type text with

Many word processing programs have a spelling cla:k propm tinted to
them that scans the taxlml iD1icalas words not foUDd in ill dictionary.

X9

Return the cursor to the beg inning of the document.

[Shift]

Press and hold down the shift key.

Macintosh Productivity Tools

Press the right arrow ten times. As you press th is key, the
text will be selected.
Release the [Shift] key.

r

•

You a re fin ished selecting this text. Release the shift key
to try something else.

File Edit Format Font Document Utilities Window

•

Mg Flnt Document

M++mng is fun I Word proc:essing allovs any pe~n to type text vith
neAtly justified. umrp, underlines, and boldfa:ed text.
Many vord processing programs have a spelling elEct program linked to
tham that scans the tat m1 iil1ic:ales vords not found in its d.ictiomry.

,

Figure 6.20
This tex t was selected by
holding down the shift key
while pressing the right
arrow key. You may also
use the up, down or left
arrow to select text with
the shift key.

3€9

Return the c ursor to the beginning of the document.

Move the !-beam to the left of the second line of text until it turns into the
mirror image mouse pointer.

You now want to try us ing the mouse for selecting text.

,. •

File Edit

ra{

!Word procassing is~
~JIIIdly justified Dill'S!

Figure 6 .21
Note the position of the
mirror mouse pointer
cursor to the left of the
second line of text.

Many vord procassir
tham that ICaJIS the ts:

Press and hold the mouse button.

You want to begin the selection process. The second line
of the document will be selected.

Drag the mouse down to the beginning
of the second paragraph.

You will have selected the last line of the first paragraph,
the blank line between the first and second paragraphs,
and the first line of the second paragraph (Figure 6.22).

Figure 6 .22
The text that has been
selected.

Release the mouse button.

The text will remain selected.
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6 .9 LOCATING SPECIFIC TEXT IN YOUR FILE

Unfortunately, g ross cursor moves may not a lways be what you want. If you are working on a
ten-page report , and you want to make changes on the bottom of page five , getting to the desired
location may take some time. This is true even if you make use of the scroll bar, since you may
not see exactly what you are looking for as the text moves past.
However, the search function of a word processor is capable of relocating the cursor to
s pecific locations with ease. The trick lies in properly defining the location.
For example, you may know that the word " the ir" is near the end of page five. Th is word,
however, may also exist at ten other locations throughout the first five pages of the text. Thus, a
sea rch for this word will yield the first location rathe r than the one on page five.
A better search object would be the phrase " their profits were 10 million." This phrase
exists in only o ne place in the text.

WHAT

To Do

WHY

You ARE DOING

IT

:l€9

Make sure that the cursor is at the beginning of the document. The search process always starts at the current cursor location.

Pull down the Utilities menu .

This menu contains several useful options, including the
Find and Find Again commands.

Figure 6 .23
The Utilities menu. Note
that Find Again is dimmed,
since you have not yet
entered any text to be
found.

~t

u

-

rs

~

~~

Window
Find ••• It
.~
Find flgaln
:·~ll
Change ...
. H
Go To ...
•&
Go Back
~z

•r

Spelling •.•
.L
Hyphenate ...
lndeH ...
Table of Contents ...
Word Count ...
Calculate
Renumber...
Sort

Se lect the Find option and release the
mouse.

·-

T he Find option may also be activated by using the :l€F
key.

Figure 6 .24
The Find dialog box.

Find
Find What:

---------J

I!..U

0 Whole Word 181 Match Upper/Lowercase
(~tart Search )[cancel)
check

Type the text that you want to locate in your document.
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Figure 6 .25

Find

1111

Th e text to be found has
been entered into the Find
dialog box.

Find What: 1
....c_h_ec_~..:....__ _ _ _ __ ___.

0

Whole Word

( Start Search

181 Match Upper/Lowercase

B[Cancel ]
Execute the search. After a brief pause, the word
"check" will be highlighted in the text (Figure 6.26) .

Clic k on the Start Search button.

,.

&. File Edit Format Font Document Utilities Window
My First Document

.,

Figure 6 .26
The word check has been
located in the document .

Woid processing is tun I Word processing allovs any person to type taxt vith
neatly justified JDIU'gim, UIKierl.ines, and boldfa::ed text.

Many vord processiDg programs ba9e a spelling- program linked to
tbam that scans the taxt and indicates words not foum in ils dictionary.
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Find What:

0

I

Icheck

Whole Word

Find

I

181 Motch Upper/Lowercose

Find NeHt ; ) (Cancel)

C lick on the Cancel bunon.

Put away the Find dialog box for now.

A pote ntial pitfall of the search operation results from how Word compares the text you a re
looking for w ith the text in your document. T he word processor does not recognize wo rds as
independent units unless you include spaces in the word you want it to find . Thus, Word will
locate the word "and " imbedded in the word "sand ."

XF

Begin another search operation. This search will start at
the current cursor location and continue towa·rds the end
of the document. The word "check" will appear as the
object of the search since this was the word you entered
for the prior search .

or

Enter the word "or" into the dialog box as the word you
want to locate in the text.

Click on the Find Next button.

Execute the search. The letters "or" will be highlighted
in the word "words" at the end of the text.
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Click on the Find Next button .

Figure 6 .27

r

Word will continue the
search for the next
occurrence of " or" only
with your permission.

•

Execute the same search again. Since the end of the
document is reached, Word wants permission to continue
the search from the beginning of the document (Figure
6.27).

File Edit

Format

Font Document

Utllltle::o Window

.,

My First Document

Word processing is fun! Word processing allovs any person to type text vith
tEaUy ~tifi
·
·
u.
Mmy vord pr
tlEn that scan

-

Lh
I

Yes

,

Continue search from beginning
of document?

(

No

l
Find

I

Find What: lor
0 Whole Word cgJ Match Upper/Lowercase

I

After clicking on Yes, the
next occurrence of " or" is
located at the beginning
of the document.

r

)) (Cancel)

Te ll Word to continue the sea rch. The lette rs " or" will
be highlighted in the first word of the document!

Click on the Yes button .

Figure 6.28

Find ~Ht

a

File

Edit

Format

Font

Document

Utilities

Window

M First Document

v.IJd processing is fun! Word processing allovs my person to type text vith
neatly jurufied margins, underlines, and boldf~ed text

Many vord processing programs have a spelling check program linked to
them that scans the text and indicates vords not found. in its dictionary.

, .•

..::.·==-=-~

Find

- -- - -- -

Find What: l._o_,_q_ _ _ _ _ _ _ ___,

0

l

C lick on the Cancel button .

Whole Word cgJ Match Upper/ Lowercase
Find NeHt

B(Cancel)

O nce again , put away the Find dialog box.

.,
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6 .10 REFORMATTING THE TEXT
Once you have your text written, you may decide to re-organize the way it will look on the
printed page. It is, of course, possible to make these decisions as you ente r the text. The c hoice
is up to you.
The most frequent appearance changes made in a document are in its margins, line spacing,
and j ustification. Word also lets you define the spacing betwee n pa ragraphs. Some people prefe r
to leave a blank line between paragra phs, a nd Word is able to do this for you automatically,
eliminating the need to press the return key two times at the e nd of a paragraph .
Many of the formatting options may be executed by using selections found on the Format
me nu (Figure 6.29). For example, if you want to adjust the margins for the complete document ,
you could select the Docume nt option , and the n adjust the left and right margins in the dialog
box (Figure 6.30). If you j ust wanted to adjust the margins for a single pa ragraph, the n you
would use the Paragraph option, rathe r than the Document option, from this same menu .

~

Font Documen
XR
Show Ruler
r= _______

~

Character •••
Peregreph .••
Section ..•
Document ...

'~

XD
XM

Figure 6.29

The Format menu contains
options that let you
control the overall
appearance of the
document.

£e lls •.•

Position ...

---

Styles ...
Define Styles ... XT
Plain For Style X<) ..
X<)Z
X <)B
IC<)I
X <)U
X<)O
X <)W

..I Plain TeHt

Bol d
11111/t:

llDdiU:IIoa
OlDUIDool

r

r

•

file

MY First Document

·-

Document

I'"' I

neat!

Margins:

Many
them

-

.,

Edtt.JIIIIIII.Font Document Utilities Window

0
0

Top:
Bottom: I In

Mirror Euen/Ddd Margins
Euen/Ddd Headers

I
I•
Number Lines From: I•
Gutter.

Number Peges From:

Defeult Teb Stops:

(

NeHt File ...

)

lo.Sin

Left:

Right:~

l1.251n
l1.251n

•

I
I

181 Widow Control

I
I

Number From:

0

J

(cencel)

(set Defeult)

Footnotes
Position:
Bottom of Pa~e

I
I I

OK

It

121

Restart Each Pege

I

Figure 6 .30

The Document dialog box
lets you control items such
as the complete document's
margins, the default tab
stops and the location of
footnotes.
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It is also possible to perfo rm many of these fo rmatti ng commands in other fashions. T he
simplest alternati ve to use is the docume nt's ruler line. The ruler line lets you change margins,
insert tab stops, adjust the document 's a lig nme nt (ragged right o r justified), cha nge the line
spac ing and the s paci ng between paragraphs. Depending on what portion of the document has
been selected whe n the changes are made, you can effect a single paragraph, severa l paragraphs,
o r the whole document.

-

6 .11 CHANGING THE PARAGRAPH SPACING

It is not uncommon to double-space between the parag raphs of a document , even tho ugh the text
itself is single-spaced . Wo rd has a feature which will automatically double-space between parag raphs for you .
When you c hange the spacing between paragraphs, you are actua lly telling Word to doublespace whenever you press the Return key. Two return c haracters are NOT placed into the document. Word, however, acts as if you pressed return twice.

WHAT

To Do

WHY

You ARE DOING IT

:M:R

Recall from Chapter 5 that this command key will display
the ruler line at the top of the current window. This is the
Show Ruler command fo und on the Format menu .

Select the second paragraph of the
document.

Use one of the methods you have learned to select the
second paragraph of the docume nt. Your display should
look similar to the one seen in Figure 6.3 1

Figure 6 .31
The current text window.

Word processing is t\ml Word processing allovs my person to type text vilh
maUy ju>tified margim, underlines, and boldfllCed text
I
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Figure 6.32
The inter-paragraph
spacing icons.

Note the two icons below the ruler li ne under the five and
one-half- inch point on the line. The left one is currently
highlighted (Figure 6.32).
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Click on the right icon of the two.

This is the icon used to cause a double-space between
paragraphs. You can see by the text selected that the
extra space between paragraphs belongs to the second
paragraph.
Recall that this is the Show 1 command, found on the
Edit menu. Any place where the return key has been
pressed in the document will now show the , symbol. In
Figure 6.33 you can see that the paragraph symbol shows
only once between the two paragraphs.

.,

Word.processing.ist\mi.Word.processing.al.lovs.any.personto.type.text.vith
neatly.justifiedmargim,.und.erlines,.and. boldfi!CE!d text. <f
<(

t I <~•:· -·.·I i f•l'· ···~::ll•;' pr· ·~nlr~· IJ-,..~ ·, :pell!ll~· d•~d: pr,.·~·r.m.lllu:oi t
tiJ~l!c •),-,t :elliS tho t,::t.,·tl,d lll•1tclfJ?~ "1"1 d~ Ibt fv1.U1d tlltf~ dtcft•)!I'tl''i t

Click on the single-space icon.

Figure 6.33

You can see that the
selected paragraph
includes the blank space
between the first and
second paragraphs. It is
also possible to see that
there is only a single f
symbol between the two
paragraphs, even though
it is clearly doubfe·spaced.

Return the spacing between paragraphs to single-space.
Hide the

1 symbols.

-

6 .12 MARGIN CHANGES
Some word processors have you ente r text starting at the extreme left side of the text window.
Others will include the margin in the di splay, so that text is e ntered starting several characters
from the left edge of the display. While either of these two methods is appropriate for most text
preparation, you must adjust the left and right marg ins of the text for items such as block
quotations. Additionally, you may decide that the default line size is incorrect for your particular
need. Again, the answer is to adjust the document's margins.
With the what you see is what you get (WYSIWYG) word processors, you will see the effect
of the margin changes on screen as they are entered. Since Word is a WYSIWYG-type word
processor, you will see the margin changes immediately.
As was mentioned earlier, formatting changes in Word will affect only text that is c urrently
selected, or new text that you type immediately after a format change without changing the
cursor location . For example, if, as you are typing in text, you want to set a margin for only one
paragraph, then you must set the margins back to their original status after the paragraph is
typed. If you fail to do this, you will continue typing with the new margins.
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However, if you want to change the margins fo r a paragraph that has already been typed, you
must select that paragraph fi rst, then make the margin changes. These cha nges w ill affect only
the selected text.

WHAT

To Do

WHY

Select the second paragraph of the
document.

You ARE DoiNG

IT

Use one of the methods you have learned to once again
select the second paragraph of the document. Your display should look similar to the one seen in Figure 6.34.
The Ruler line should still be displayed after you changed
the inter-paragraph spacing.

Figure 6.34
The current text window.

Word proc:essiiJB is t\ml Word proc:essiiJB allovs any person to~ with
Dllll.tly justified margins, UIK1srliDas, and boldf21:ad text.

·:u,:·

: t ,:,·· •·. : I Jl· .,·..
~·t· , t l!r~· h , .."' , :f~lllt:~ .-},,,·!: pr· ·~r.l!rllllu:~c1 t.
lli~I:Jt!J tl :•· ll~::·t!J•·Ii<~ 'l11d 1!:111: 1IJ?S "'< •!.1.; flo •f t• •lU:d llllf3 ,j:,·t: ·~liCII'Y

Note the split triangle under the zero at the left side of
the ruler line. This marks the current left margin.
Move the mouse so the arrow is pointing
to the lower half of the left margin
marker.

When setting the left margin, it is important to move the
margin marker by using the bottom half of the margin
mark. The top half, as you will see, is used to mark the
paragraph indentation.

Figure 6 .35
Note the location of the
mouse pointer in relation
to the left margin indicator
on the ruler line.

Press and hold the mouse button to
select the left margin marker.

You want to change the left margin.

Macintosh Productivity Tools

Drag the left margin marke r to the oneinch mark.

r

Set the left margin to one inc h . Note that in addition to
being able to see the left margin location on the ruler
line, you are told where you are placing the margin at the
bottom left corner of the window, which should read
" I in".

li File Edit Format Font Document Utilities Window

.,

Word processing is fun! Word processins allovs any person to type text vith
neatly justified margins, tmierlinas, m:1 boldfaced text.
l'•J f'l'• '~'o'.'.'l!l;: pr 'o J tilL' h 1"~ ,_·p~lllll~ o:li~d: f'l' !o,l' 1lt1111U'"'j
fl1 :t .'C11..:; t},;. fe::t C1J,j lll•1!C :1"'3 ".'•.•IdS ll• ,t l(•\lf!.J IIlli~ •Jtch•;ll-tl'i

: j tl(' "'•
'1!~11.

Release the mouse button.

f ·

Figure Ei.36

The margins have not yet
been set, since the mouse
button has not yet been
released. Note the "1 in"
at the bottom left of the
display, indicating the
exact location at which the
left margin is to be set.

By releasing the mouse button, the le ft margin will be set
for the selected text.

r-:-----------------------------:.,:-1

Figure 6.37

The left margin has been
set for the second
paragraph of the
document.
Word processing is fun! Word processins allovs any person to type text vith
rmUy justified margins, und.arlinas, m:1 boldfaced text.

Now locate the right margin indicator under the six-inch
ma rk on the rule r line. This indicato r is a single triangle.
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Drag the right margin left to the fiveinch point and release the mouse button.

Figure 6.38
The new margins for the
second paragraph are now
in effect.

r •

file

Edit

Set the right margin to the five-inch mark for the selected
text.

Format Font

Dotument Utilities Window

.,

Word processi.Dg is fun I Word processi.Dg allows any person to type text vith
ratly justified margins, l.Uiderlinas, and boldfaced text.
:1

c,···· .,<J r·r ····::u~. P'

·)... ·l·p

v.,

i

Figure 6 .39
Note the margin markers
are now at their original
locations. You did not
change the margins for
this line of the text.

cJ llr.It·J·~it

tl11!•' :ft.·-· ! .1: t! t
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lli1t'

11t •tt tJ tl''

Move the cursor up one line to the blank line between the
two paragraphs. Note that the left and right margin markers return to their original positions.

li file Edit format Font Dotument Utilities Window

r

.,

Word processi.Dg is fun I Word protesSing allovs any person to type text vith
neaUy justified margins, umerlines, and bold!a:ed text.

I

Many vord proc:essingprograms haw a spelling
check program linked to them that scans the text
and indicates vords not foum in its dictionary.

!

Move the cursor down one line to the beginning of the
second paragraph. The margin markers change to the
current margin settings .

Place the cursor immediately after the
period ending the second paragraph.

You want to see what happens when you add lines to the
document.

[cr] [cr]

Press the Return key twice, adding a blank line at the end
of the document.

Macintosh Productivity Tools

Note that the left and right margin marks are unchanged
after you add the two return characters. The margins are
taken from the current settings as you type.
Figure 6.40
Note the left and right
margins after you have
added two return
characters to the end of
the document.

Word processing is fun I Word processing allovs any person to type text vith
Il!atly justified margins, I.Dlderlines, and boldftK:ed text.
Many vord processing programs haw a spelling
cb!ck program linked to them that scans the text
m1 i.Diicatas vords not foi.Dld in its dictionary.

Drag the left margin to the zero position
on the ruler line.

Return the left margin to its original location.

Drag the right margin to the six-inch
position on the ruler line.

Return the right margin to its original location.

Add this text to your document.

This is my first document.

a

r

File Edit

You have now returned the margins to their original locations. Since the second paragraph was not selected during
this process, its margins have not been affected.

.,

Format Font Document Utilities Window

My First Document
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Word processing is fun! Word processing allovs any personto type text vith
neatly justified margins, I.Dlderlines, and boldftK:ed text.

Figure 6 .41
Your document now looks
like this. Note that the
margins for the last
paragraph match the
original margins of the
document.

Many vord processing programs haw a spelling
cla:k program linked to them that scans the text
and iDiicates vords not foi.Dld in its dictionary.
This is my first docwnent.l

-

Move the cursor up one line. Note that the margins
change to match those of the second paragraph.
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Word processing is tun I Word processing allovs any person to type text vith
neatly justified margins, I.Dlderlines, and boldfeced text.
Many vord processing programs bava a spelling

-

check program linked to them that scans the text
m1 i.Diicatas vords not foi.Dld in its dictionary.

•10

Figure 6 .42
These are the left and
right margin markers for
the second paragraph.
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I

X9

Jump the cursor to the very beginning of the document.
The margins will once again return to their original
settings.

If you want to return the margins of the second paragraph to thei r origi nal status, select the
paragraph, then move the margins back to their starting point.
The important thing to remember is that any change you make to the margins will affect
only the selected text. Once you move the cursor out of the selected area, the margins will return
to their default settings. If you want to change the ma rgins for the whole document, then you
must select the whole document before you make the margin change.

-

6 .13 LINE SPACING
While you are adjusting the ma rgins, you may also want to change from single- to double-space
typing o r vice versa. Most word processors default to single-spaced text when you start a document. Word is no different. You may want to change the line spacing from single to double at the
outset. Ideally, you should be able to mix single- and double-spaced text throughout the complete
document as needed. Word lets you do this if desired .
Just as with margin changes, with the what you see is what you get word processors, you
will see the effect of spacing changes as new text is entered. With the line editor/formatter
programs, you will have to wait for a printed copy to determine the exact effect. Changes in the
line spacing of selected text are displayed on the computer's screen immediately.

WHAT

To Do

WHY

Select the second paragraph, and the
blank line that separates it from the third
paragraph.

You ARE DOING IT

This is the paragraph that you want to change to doublespacing. Just as with margin changes, you must select the
text that you want to affect before making the change.

Figure 6.43

Select this text to be set to
double-spacing.

Word processing is fun I Word processing allovs any person to type text vith
neaUy justified margins, underlines, and boldfaced text.
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Note the row of small icons on the bottom portion of the
ruler line. The first grouping, with arrowheads, are used
to set tab stops. The second grouping is used for formatting, such as cente ring or justifyi ng text. The third grouping is used to set line spacing.

Figure 6.44

T he small icon below the fi ve-inch mark on the rule r line
is the double-space icon. Under the four and one-halfinch mark is the single-space icon, which is currently
highlighted. Between the two is the space and one-half
icon.

llltles Wind~

The mouse pointer is on
the double-space icon on
the ruler line.
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Set the selected text to double-spacing.

Click on the double-space icon.

Figure 6.45

The second paragraph is
now double-spaced.

Word processing is fun I Word processing llllovs any person to VJl8 text vith
neatly justified margins, underlines, and boldfaced tsxt.
t h11" -·

•!'If )>! .,.,•.. Ill -')>!

'<

l UIL' !Jy·~ 1 :f••·lllli<

·!J.. :I: p·· ·::r.l!ll hrJ·,.,if.. tl.~H•II• ,, :c l!J.. tl.·· t.-::t
'l11d

lli•itc th·~ -_,,·til" !1· •l f, •IU!•j

111113 dt•:'t !111'"

This is my first doc\.Dllllnl

Click on the space and one-half icon.

Set the selected text to space and one-half.

Click on the double-space icon.

Once again, set the second paragraph to double-space.

To return the second pa ragraph to single-spacing you would use the same procedure. Select
the desired text , then click on the single -space icon.

-

6 .14 JUSTIFICATION OF TEXT

Text justification is a fea ture that causes both the le ft and right margins of a document to be
stra ight. Newspaper columns a re justified , as is the text in most books.
Word processors justify by add ing blank spaces between words of a short line until the last
character of the last word on that line is at the right margin. Whe n this line is printed , you will
see these spaces. T his process is called filling lines.
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Some word processor/ printer combinations are capable of producing microj usti fied spaced
lines, which minimizes the appearance of the extra spaces between words on filled lines of text.
This is done by adding partial spaces between the letters of words, not just by putting extra full
spaces between words. Some word processor/printer combinations are also capable of producing
proportional spaced lines. This is done by assigning space units to each letter of the alphabet. The
letter "i" takes up less space than the letter " m," for example. When an " i" is printed, no "blank"
space is placed around the letter. Thus, a line containing many letter " i's" will have more letters on
the line than one with many letter " m's," because the "i" requires less space on the line. Most
books are not only justified , but also are printed with proportional spacing. It is worth noting that
the majority of type fonts available for the Macintosh are proportional fo nts. Thus, Word is
performing proportional spacing.
Fonts that are not proportional are called mono-spaced fonts. Monaco is a Macintosh font
that is mono-spaced. If you use this font in your word processor, the text will not be proportionally spaced .
When using a what you see is what you get type word processor such as Word , you can see
the effect of justification on your computer's monitor. The right margin of your document will
form a straight line at the right margin indicator of the ruler line. If you are using a line editor/
formatter word processor, you will have to wait until your document is printed before you can see
the results of the justification process.

WHAT

To Do

WHY

You ARE DOING /r

Select the second paragraph of your
document.

The second paragraph of the text should still be selected.
If not, select it now.

Locate the justification icon on the ruler
line.

The right/left justification icon is below the four-inch
point on the ruler line. The mouse pointer in Figure 6.46
is pointing to it. Of the four justification icons, the left
flush icon is presently highlighted. This is the way most
people type. Next to the left flush icon is the center icon,
followed by the right fl ush icon.

Figure 6.46

The mouse pointer is
pointing to the right/left
justification icon on the
ruler line.
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File
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Format Font Document

Utilities Window

Word processing is fun! Word processing allovs lillY person to type text vith
neatly justified margins, underlines, m1 boldfaced text.
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Click on the right/left justification icon.

Select full justification for the second paragraph.
Figure 6.47
The second paragraph is
now justified. Note that
the ends of the first two
Jines of text line up
underneath the five -inch
margin mark. This is not
true of the paragraph in
Figure 6.46.

Word processing is fun! Word processing allovs any person to type text vith
neaUy justified margins, underl.ines, and boldfaced text.
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This is my first document.

If you want to return a portion of the document to the left flush , then simply select that part
of the text, then click on the left flush formatting icon.

-

6 .15 CENTERING TEXT

It is a simple matte r to ce nter text with Word. Rather than selecting the right/left justification
icon, all you need to do is select the center icon, which is below the three and one-half-inch
mark on the ruler line.
When cente ring text, you must remembe r one rule. The text is cente red between the current margins, and not between the left and right edge of the paper.

WHAT

To Do

You ARE DOING IT

WHY

~

Press the down arrow, to de-select the second paragraph
and place the cursor on the bouom line of the text.

Click on the center text icon on the ruler
line.

The center text icon is directly below the three and onehalf-inch poinl on the ruler line.
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neaUy justified margins, underl.ines, and boldfaced text.
Many vord processing progrmns have a spelli.ng
check program linked to them that sams the text
and iOOicates vords not found in its dictionary.
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This is my first document
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Figure 6.48
The last line of the
document has been
centered.

197

198

CHAPTER SIX- INTERMEDIATE WORD PROCESSING CONCEPTS

You can see that you did not have to select the complete
line to center it.
Drag the right margin marke r to the
three-inch point and release the mouse
button.
Figure 6.49

Afterchanging the right
margin, the text is
centered between the
margins, and not the left
and right sides of the
paper.

,. •

file

When you change the margins, the text will shift so that
it remains centered between the left and right margins!

Edit Format Font Document

Utilities Window

.,
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mi. itdicatss vords DOt found in its dictionary.
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6.16 WHAT IS A BLOCK?
A block to a word processor is a segment of the text on which you are working . People generally
think of a block as a large portion of the text, but it may be a single line, word, or c haracter. In
fact, a block may be a ny portion of the text you want.
When you select text, as you have been doing throughout this chapter, you a re creating a
block of text. You have then performed an action on the block, such as deleting or replacing it.

-

6 .17 WHAT IS A BLOCK GOOD FOR?

A block can serve several other purposes. With some word processors, the text within a block
may be turned into boldface or underscored text. Most word processors let you copy, move, save
or delete blocks. MS-Word is no different.
In general, blocks are useful for both the what you see is what you get word processors and
the line editor/formatter word processors.

Macintosh Productivity Tools

-

6 .18 HOW TO DEFINE A BLOCK

Your computer is not able to read your mind , of course, so you must tell Word which section of
your text you want to treat as a block . You have a lready discovered several d iffe rent ways of
selecting portions of the document. All of these are defining a block of the text. Once the block
has been de fined, you may have Word perform one of several possible functions, such as moving
the text to another location in the docume nt, copy ing the text, dele ting the text altogethe r, saving
it to another document or enhancing the type style in some fashion .
Most word processors allow only one block to be defined at any given moment. Word is no
different. Generally, you should thin k of a block as being dynamic in nature, a lways changing to
suit your present needs .
After you have selected a block of text, Word expects you to perform an action with it
immediately. Thus, a fter you select some text, some action is pe rformed . Afte r the action , the
text may or may not remain selected . Rega rdless, after you pe rform the desired task a nd you a re
ready to continue working, the text must be de-selected.

WHAT

TO Do

WHY

You ARE DoiNG lr

X9

Move the cursor to the beginning of the text.

Press and hold the Shift key.

The shift key, as before, acts as the constrain key, holding
the cursor in place and stretching it to select text.
Pressing the down arrow two times will select the first
paragraph of the document.
You now know yet ar.other way to select text. You could
have accomplished this same task by using the mouse to
drag the 1-beam cursor over the desired text with the
mouse button depressed, or you could have used the
inverse mouse pointer cursor in the left margin of the
document. Any of the methods you have learned to move
the cursor and select text will work.

The text d isplayed in reverse video represents the c urrent block, whic h can be manipulated
in some fashion yet to be decided .
Figure 6.50
The inverse text is
selected, and is the current
block.

Many vord processing programs haw a spelling
chect program linked to tb!m that scans tb! text

IIII1 imitates vords not found in its dictionary.
This is my first documanl
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6 .19 MOVING BLOCKS

Moving blocks of text is pa rticul arly useful during the ed iting process. You can relocate sentences o r paragraphs to fix the flow of the document without retyping the sections involved. In a
similar fashion, tables o r c harts may be moved so that they will not be affected by a page break
when you print the document. When you move or delete a block of text, the hole created is
automatically filled in by the word processor. No special command is needed.
Mov ing a block with Wo rd is performed by using the cut and paste style of editing. T hat is,
the section being moved is removed from the document and then restored to a d iffe rent location
in the text.
Yo u sho uld still have the fi rst paragraph selected as a block for Word. T his is the block you
will be movi ng.

WHAT

To Do

WHY

You ARE DOING IT

Pull down the Edit menu.

This menu contains the commands used to cut and paste
portions of the document. Note that the Cut command
may be executed by pressing XX. While th is menu is
down, note that the Paste option is XV. When restoring
this paragraph to the document, you will use this key,
rather than the menu.

Select the Cut command.

You want to remove the selected text from the document
using the menu.

Figure 6 .51

The Cut command is
selected on the Edit menu.
If no text has been
selected, then this option
will be dimmed!
Format Rgaln
Table •••
Glossary ...
Show 'I

Paste Link
UpdDte Linl:
Short Menus
Preferences •.•
commands •••

Release the mouse button.

When you release the mouse button, the selected text will
be removed from the document and placed into a temporary storage area, called an Undo buffer. Every time you
cut text, the contents of this buffer is changed to hold just
the most recent item cut from your work.
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File

Edit

Format Font Document

.,

Utilities Window

Figure 6.52

When you cut text, it is
removed from the
document.

Many v ord Processins programs have a spelling
check program linked to lb!m that scans the text

m1 iDficates vords notfolliii in its dictionary.
This is my f'JJ'St document

i

I

X3

Move the cursor to the end of the document. This is
where you want the block to appear when it is moved .

[cr] [cr]

Place several blank lines between the last paragraph and
the place you will be putting the paragraph you just cut.

XV

Recall that when you pulled down the Edit menu, you
saw that the Paste option was XV. This option will copy
the contents of the undo buffer back into the current
document. The paragraph removed from the beginning of
the document has now been restored at the end of the
document.
Figure 6.53

The cut text has been
restored at the end of the
document.

Many vord processing programs have a spelling
chect program 1inked to them that scans the text

m1 iiidicales vords not folliii in its dictionary.
This is my first document.
Word procassiDg is fun I Word proc8ISing allovs any person to type text vith
neatly justified margim, UDderlims, and boldfaced text.
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You should note that the text from the buffer has been returned to the document at the
curre nt cursor location, and not at its origi nal location . You can also see that the pasted copy of
the text brings with it the ma rgins and line spacing from its original location. That is, the pasted
pa ragraph did not take on the three inch right margin of the last line, nor was the text cente red .

-

6 .20 COPYING BLOCKS

O f course, sometimes you want to duplicate and not re locate a block. This may occur if you have
tables of numbers with the same column head ings, or if you want to rewrite a paragraph but are
not sure you wi ll want to keep your new work or the orig inal.

WHAT

To Do

WHY

You ARE DoiNG IT

X9

Move the cursor to the beginning of the text.

XV

Paste into the document the paragraph you cut earlier.
This paragraph is still in the copy buffer because you
have not cut or copied any other text .

Figure 6.54
The paragraph is now at
the beginning and end of
the document!

Word processing is tun! Word processing allovs my person to type text vith
naatly jultifiad margins, umarlines, m1 boldfi!Ced text.
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6.21 SAVING BLOCKS AS SEPARATE DOCUMENTS

MS-Word lets the user have seve ral documents open at one time. Whe n you save a selected
segment of a document, you a re actually creating a new document. You have two options when
c reating a separate document from a block of text. You may cut the original portion of text from
the original document, or simply copy it from the original document.
Placing text from one document into another is performed in the exact same fashion as
creating a new document from a block of text. The sole d ifference, in this case, is that you a re

Macintosh Productivity Tools

placing the block of text into existing text, rather than into a new, untitled document. Just as with
the c ut and paste operation you just performed, when pasting text into an existing document from
a second one, the pasted text is placed at the current cursor location.
Use the cursor movement keys or your mouse to place the cursor at the beginning of the
second paragraph, beginning " Many word processing programs . ..". This is the paragraph that
you will save to disk.

WHAT

To Do

WHY

Select the second paragraph of the current document.

You ARE DotNG lr

Use one of the several methods you now know to select
this paragraph. You may use the mouse, or the shift key
in combination with a cursor movement key.
Figure 6.55
This is the paragraph you
want to use to start a new
document.

Word processing is fun! Word processing allovs any person to type text vith
neatly jurtified margins, underlines, mi. boldfaced text.
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Pull down the Edit menu.

The Copy option is on this menu.

Select the Copy command.

This command will place the selected text into the cut/
copy undo buffer, but will not remove the text itself from
the document. The text will be copied into the buffer
without changing the original text in the document. Once
in the copy buffer, the text may be copied to another
location in the current document, or into a different
document.
Figure 6 .56
The copy command has
been selected.

Tabll' .•.

Glossary •.•
Show 'I
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Release the mouse button.

Execute the Copy command.

Pull down the File menu.

This menu contains the options for opening existing files
or creating new files.

Select the New option.

Recall from the prior chapter that the New option will
open a second document. This command can be executed
with the :M:N key.

Figure 6 .57
The New command has
been selected.

Print Preulew ...
Print Merge ...
Page Setup .. .
Print ...

Release the mouse button.

Execute the New command. When you execute this command, you will be looking at a new document.

:M:V

Use the Paste command key. This option is, as you will
remember, found on the Edit menu. You are pasting the
contents of the Cut/Copy buffer into the new document.

Figure 6.58
The new document now
has the selected paragraph
pasted into it.

,

·-·- --Many vQX'd processing programs haw a spelling
check program linked to them that scans the text

m1 iD!.icates vords not foUDd in its dictionary.
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You can see that the formatting of the second paragraph
comes with it when it is pasted into the new document.

XS

You are now ready to save the new document. This is the
command key fo r the Save option fou nd on the File
menu. Since the document is Untitled , you must now
s upply it a name.

TEMP

Type the name for this document, making it TEMP.

Click on the SAVE button.

Complete the save.

Edit

Format

Font

j(g) MY DISK

Document

Utilities Window

I

,

Figure 6 .59
The new document has
been named, and clicking
on the SAVE button will
complete the save process.
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Pull down the Window menu.

This is the menu you used earlier to select the Help
option. At the bottom of this menu are listed all the documents that Word currently has open. The check mark in
front of T EMP indicates that it is the document in which
you are presently working.

Select My First Document.

This is the name of the document you opened·at the start
of this session.
Figure 6 .60
The Window menu shows
you the names of all the
documents Word currently
has open. " My First
Document " has been
selected.

Release the mouse button.

When you release the mouse button, the selected document will appear on the computer's screen. Note .that the
text, which was selected when you created the new document, remains selected.

205

206

CHAPTER SIX - INTERMEDIATE WORD PROCESSING CONCEPTS

-

6 .22 COPYING BLOCKS INTO EXISTING DOCUMENTS

As mentioned earlier, this same procedure may be used to move portions of text between two
documents. The only difference is that, rather than creating a new document as the destination of
the copied text, you use the Open command found on the file menu to open an existing document.
With the two documents open on the desktop, you perform the same basic operations. Use
the Window menu to select the source document. Select the text you want to copy into the second
document. Use the Copy command on the Edit menu (or XC) to put the text into the Cut/Copy
buffer. Once again use the Window menu , this time making the destination document active.
Place the cursor at the location in the document where you want the new text to appear. If you
are moving the I-beam cursor with the mouse, be sure to click the mouse button once to move
the text insertion point to the correct location . Complete the operation by using the Paste command on the Edit menu (or XV) to insert the text from the Cut/Copy buffer into the current
document.

WHAT

To Do

WHY

You ARE DoiNG

IT

Pull down the Window Menu and select
TEMP, then release the mouse.

Make TEMP once again the active document.

Select the complete text.

Use one of the text selection methods you have learned to
select the complete document.

Figure 6.61
The complete document,
TEMP, has been selected.
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XC

Copy the text into the Cut/Copy buffer.

Pull down the Window Menu and select
My First Document, then release the
mouse.

Make the original document active, rather than the new
one.

X3

Use the numeral 3 on the number pad with the command
key to move the cursor to the end of the document. This
is where you want to insert the new text from the document TEMP. You may, of course, use the mouse to move
the 1-beam to the end of the document, then click the
mouse button once.

Macintosh Productivity Tools

XV

Paste the text into the document at the end of the existing
text.
Figure 6 .62

The text is inserted into
the document at the
current cursor location.

Word processing is tunI Word processing allovs any person to type text vith
matly justified margins, uaierlines, and bold.faced text.
I
Many vord processing programs have a spelling
cbact

program linked to Umn that scans the text

and imicates vords not foum in its dictionary.
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6.23 DELETING AND UNDOING DELETIONS OF
BLOCKS

One of the major editing acti vit ies allowed by word processors is the delete process. As you edit,
you may find you want to remove a sentence here or a paragraph the re . The block delete lets you
do this easily. If you are not sure you really want to delete a segment, it is a simple process to
save the block to another document before you delete it. Then, if you decide you do not like the
change, it is equally simple to reinsert the deleted block, thereby restoring the text.
Many word processors even have an " undo" command, which will " undelete" the text you
last removed from the document. You should not rely on the undo feature always to save you
from improper deletions. The content of the undo buffer is not always what you think it is, or
what you want it to be! With Word, the Undo command, found on the Edit menu, varies its
purpose, including actions such as an undo of the most recent paste command and an undo of the
most recent typing.
Before you continue, use one of the text selection options you have learned to select the
paragraph you just added at the end of the document.
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Figure 6 .63

The current selection.
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WHAT

To Do

WHY

You ARE DoiNG l r

[DELETE]

On some keyboards, this key is labelled BackSpace,
rather than Delete. It is at the right side of the numbers
and special symbols keys on the keyboard . Pressing this
key will remove all the selected text.

Pull down the Edit menu.

T he first item on the Edit menu is always the Undo
option, which may be executed by the XZ key. Right now
it reads Undo Typing, since pressing the delete key is
considered to be typing.

Figure 6.64
Note that the first entry of
the Edit menu current ly
reads Undo Typing .

f>Ds1e link
UpdDtl.' llnlc

Short Menus
Preferences •••
Commands •••

Select the Undo Typing command and
release the mouse button.

After you execute this command, the pa ragraph that you
deleted will return. It will be selected .

Pull down the Ed it menu.

Once again, look at the Edit menu. This time, the undo
option at the top should read Redo Typing, and it is still
executed by the XZ key. Selecting it will redo the deletion of the text.

Figure 6 .65
The first entry of the Edit
menu is presently Redo
Typing.

Pos1e link
UpdDh~ llnlc

Short Menus
Preferences•••
Commands •••
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When you are typing (as opposed to deleting as you are
at this moment), you will find that the command definition that defines the XZ makes more sense. As you type,
the option is to Undo what you have typed. If you execute
the Undo, you may then Redo (that is re-type) what you
have deleted by Undoing the Undo!
Select the Cut command and release the
mouse button.

This time, remove the text by cutting it, rather than with
the delete key.

Pull down the Edit menu.

Once again look at the edit menu. The fi rst entry now
reads Undo Cut.

Figure 6.66
The Undo option on the
Edit menu now reads Undo
Cut, but it may still be
executed with the KZ.

Paste Link
Up dDtl• link

Short Menus
Pref erences •••
Commands...

Release the mouse button.

Do NOT yet select Undo Cut.

Move the 1-beam to the top of the text
window and click the mouse.

Reposition the cursor before you undo the cut.

xz

Execute the Undo Cut command using the command key
rather than pull ing down the Edit menu.
When you execute this command, the text will be
returned to the document , but at its original location, not
at the current cursor location! This is true of any of the
undo commands. The undo happens at the location in the
text from which the item was first removed. This is not
the case, however, for the Paste option, which restores
cut text at the current cursor location.
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6 .24 PRINT ENHANCEMENTS

In addition to changing the layout of the document with a word processor, it is also possible for
you to add enhancements to the appearance of the printed text. Typical print enhancements
available in word processing programs are boldface characters, underlined characters, and
superscripted or subscripted characters.
While print e nhancements are easy to insert into your text after the bulk of the document has
been written, it is also possible to enter the enhancements as you are typing . This e liminates the
need to make a special read-through of the text to insert boldfacing, underlining, or other
e nhancements. Of course, this does not eliminate the need to read through the document several
times to check for errors or other problems.
You should also keep in mind that print enhancements such as boldfacing, underlining, or
drawing a box around text will produce their maximum effect if used in a sparing fashion,
causing the effects to stand out in the document.

WHAT

To Do

WHY

Select the first four words of the second
paragraph of the document.

You ARE DotNG lr

" Many word processing programs" should now be
highlighted.

Figure 6.67
This text should be
selected.

Word processing is fun! Word processing allovs any person to type text vith
neatly jmtified margins, underlines, m1 boldfcad text.
~

1 1: .. ' ' ' :

~

: '• r I. •

~ •I

: D . 1.

have a spelling

check program linked to them that scans the text
m1 irdicates vords not foUid in its dictionary.
This is my FIJ'St document.

Word processing is fun I Word processing allovs any person to type text vith
neatly justified margins, Uiderlines, m1 boldhced texl

Pull down the Format menu.

This menu lets you control the appearance of the type
fonts.

Macinto~h Productivity Tools

Figure 6 .68
The Format menu.

Note the Bold option found in the bottom portion of the
menu. It has a two key command key equivalent. The X
key must be used with the shift key. This is denoted by
the large open arrow pointing up.
Select the Bold option and release the
mouse button.

The currently selected text will become boldfaced, but
will remain selected. Note that the word "spelling"
moves to the next line. Boldfaced letters take up more
space on the line than plain text.
Figure 6.69
The selected text has been
boldfaced.

Word processing is tun I Word processing allovs eny person to type text vith
rmlly justified margins, undarlinas, m1 boldf!D!d text.
a
spelling check program linked to them that scans

tba

"¥l

m1 indicates vords ool foi.III1 in its

dictionary.

This is my tirsl documant..
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Double-cl ick on the word "dictionary"
at the end of the paragraph.

You are selecting this word to underline. When you
double-cl icked the mouse button, the previous text was
de-selected.

.,

Figure 6.70

The word dictionary has
been selected.

Word processing is tunI Word processing allovs any parson to type tot vith
nsatly jultified margins, urnerlines, m1 boldfaced text.
YIDy vord proceaiug programs have a

- -I

spelling check program linked to Umn that scans
the tot m1 i.ndicates vords not foum in its

This is my fU'St document.

Pull down the Format menu, select the
Underline option and release the mouse
button.

Underline this word. Note that you may use Shift-3€U to
execute this option.

Double-click on the word " linked".

Select th is word to italicize.

Figure 6.71

The word linked has now
been selected. Note that
the word dictionary is
currently underlined.

r

•

File

Edit Format Font

Document

Utilities

Window

.,

Word processiDg is f'unl Word processing allovs any person to type text vith
matly justified margins, umerlines, and boldfaced tot.
MIDy vord proc:assi.:l..l:rosrams have a

spelling check program~ tb!m that scans
the text m1 imitates vords not foum in iii

liidi21m!This is my first document

Shift-3€1

Rather than using the pull down menu, use the command
key equivalent to italicize this word.

Macint osh Productivit y Tools

Select the text " word processing
programs" .
r

•

File Edit Format

Font

This is part of the text that you have already boldfaced.

Document

Utilities

Window

,

Figure 6.72
Select this text.

Word processing is fun! Word processing allovs any person to type text vith
neaUy justified margins, Widerlines, aDd boldfaced text.
a

Mmy

spelling check program /inl.Wto them that scans

the text aDd imicates vords not fourx1 in its
~x.

This is my f"ll'St document.

Shift-XU

Execute the Underline command key. The text will now
be both boldfaced and underlined.

Shift-XI

Add Italics fo rmatting to this text.

r

•

File Edit Format

Font

Document

Utilities Window

.,

Figure 6 .73
Yo u can add many
formatting features to t he
same selected text.

Word processing is fun! Word processing allovs any person to type text vith
neaUy justified margins, Wlderlines, aDd boldfaced text.
Mmy

spelling check program /inl.Wto them that scans

the text aDd imicates vords not fourx1 in its
~x.

This is my first document

Shift-XU

You may undo a text formatting command by applying it
a second time. Since this text is underlined, applying the
Underline command will cancel the underline.

21 3
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This is the Plain Text command key equ ivalent from the
Format menu. It cancels all formatting commands and
returns the text to a ·' plain" state.

Shift-XZ

Figure 6 .74

The selected text has been
returned to plain text,
with no formatting applied
to it.

8

File

Edit

Format

Font

Document

Utilities

Window

.,

Word processing is fun! Word processing allovs any person to type text. v ith
neaUy justified margins, underlines, and boldfaced text.
Many ''ord rocessuw roNaJns have a spelling
check program !inl'etlto them that scans the lelrt
and indicates vords not found in its dictionan:.

This is my firs t document

I

Word processing is fun! Word processing allovs any person to type lexl vith
neaUy jusllfied margins, underlines, and boldfa:ed leKt

Page

Man

It is important to remember that the print e nha ncements may be undone in e ithe r of these
two fashions: by applying the e nhanceme nt a second time, or by selecting the Pla in option . T he
advantage of the former method is clear if you have severa l fo rmatting options applied , and o nly
want to remove one . Use the Plain Text option to cancel all fo rmatting options.

-

6 .25 THE SPELL CHECKER

One convenient feature of ma ny word processi ng programs is a n embedded spell ing check. T he
spelling check program will scan your docume nt and compare each word in it to a la rge list of
properly spelled words, called a dictionary. Depending on the prog ram , the dic tionary may range
in size from approximate ly 80,000 words to over 220,000 words.
While spell check programs are very handy, they are not infalli ble, and they will not completely replace careful proofreadi ng of the document. For example, the word "there" is properly
spelled and will not be flagged by a spe ll check program , even if you intended to use the word
" the ir". Nor will a ll spe ll check progra ms make assumptions about the capita lization of words.
If you spell check the sentence " i am fine " , no error wi ll be detected.
If you a re using a floppy disk-based computer, the Word dictiona ries are not ava ilable. You
will have to do some disk swapping. Follow the disk swapping requests made by the Macintosh .

WHAT

To Do

WHY

You ARE

DOING IT

X3

Press the command key numeral 3 to move the cursor to
the end of the document.

Drag the right margin indicator for this
line of the text back to the six-inch
point.

Return the right margin to its default setting.

Macintosh Productivity Tools

Click on the text left align icon under
the three-inch point on the ruler.

Return the formatting to left aligned , rather than
centered.
Add the followi ng new text to your document EXACTLY
AS IT IS SHOWN BELOW:

1 typd th1s documnt al by m1self!

•
•

r

File Edit Format Font Document Utilities
My First Document

D
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IZ.

~

(Nor mel
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Ht

14
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I

.,

Window
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Figure 6 .75
The text has been added
to the end of the current
document.

4

I.W

check program linked to them that scans the text
and indicates vords not foum in its dictionary.

I

I typd this documnt a1 by miseIf I

-

i

Pull down the Utilities menu.

The Spelling option is found on this menu. Note that
spell ing may be executed by using the XL key.

Select Spelling and release the mouse
button.

Begin the spelling checker.

Figure 6.76
The Spelling option has
been selected. It may be
executed by using NL.

lndeH •••
Table or Contents •••
Word Count •••
Calculate
Renumber ••.
Sort

X•

After the dictionary is loaded , the spelling check process
will begin .
C lick on Start Check.

To begin the spelling check process, click on the start
check bunon.

C lick on OK.

The spelling check begins execution from the currem cursor location. Since you just added text to the end of the
document, the cursor is at the end . The spell check module has reached the end of the docu me nt and wants your
perm ission to continue the process by jumping to the
document's beginning. By clicking o n OK, you are te lling
it to go ahead.
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After a brief pause, the spelling check program will highlight " typd." Note that it does not stop on " i." " i" is a
correctly spelled word, but it is not capitalized.

Figure 6.77
The spelling check module
has located a suspect
word.

r

•

~

IlL

•

,

File Edit Format Font Document Utilities Window
13~
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!NOr mel
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1 - this documnt at by mlselfl

-

_!IJI!II!IIg_
Open Dictionaries:
MS Dictionary
User I

Words:

I
Unknown Word: typd
Change To:

~

~

IQ

1088

I

1811gnore Words In Hll Caps

I

No Change

J[[ hDngP]

(Suggest) (Cancel)

As you can see, at the bottom of the spell check dialog
box there are several options you may take.
C lick on Suggest.

You are not sure of the spelling, and you want the spell
check module to suggest possible alternative spellings.
After a brief pause, a list of several words will appear in
the left list labelled "Words:" with the most likely word,
in the spell check program 's opinion, at the top. At this
time, this should be the correctly spelled word " typed".

Figure 6 .78
You can see the words that
the spelling checker
suggests in the list of
" Words " at the top left
corner of the Spelling
Check dialog box.

r

•

File Edit Format Font Document Utilities Window

Words:

Open Dictionaries:
MS Dictionary
User I

dyad
dyad
Up

IQ

Unknown Word: typd

088

Change To:
1811gnora Words In Hll Caps
[

No Change

Jlchanga)[sugpCst)

@UiJ

,
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Tell the spell check module to make the correction in the
text for you.

Click on Change.

After a brief pause, the spelli ng checker will stop on
"documnt."

•

r

.,

File Edit Format Font Document Utilities Window
My First Document
r.l

I(]

'Normal
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I~
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I
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·,typed Ulis • • • al by mlselfl
Spelling
Open Dictionaries:
MS Dictionary
User I

Words:

~

I

.a.....!

Figure 6 .79
You can see that the word
"typed" is now correctly
spelled in the text, and
that "documnt" has been
highlighted as incorrectly
spelled.

Q

0

Unknown Word: documnt
Change To:

1088

I

~Ignore Words In Rll Caps

~

No Change

~~(suggest) (cancel)

Click on Suggest.

Have the spell check module suggest the correct word.
Again, the first word on the list is the one you want.

Click on Change.

Tell the spell check module to make the correction in the
text for you.
After another brief scan, the spelling checker will stop
on "al."
· Have the spelling checker suggest the correct word . This
time, the only suggestion is that the word be capitalized!
This is not what you want!

Click on Suggest.

all

Simply type the correct word , all, into the dialog box.
You may always override the suggestions made by the
spelling check program by simply typing into the dialog
box.
t typed Ulis documentI by mtselfl

Figure 6 .80
You may make your own
suggestions if you do not
like the options the
spelling checker gives you.

Spallin
Open Dictionaries:
~
MS Dictionary
User I

Words:
I ll

[

Unknown Word: al
Change To:

._lei.:....~_______.10

88

1811gnore Words In Rll Caps
No Change

)lChangeB(suggest)

~
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Click on Change.

Tell the spell ing checker to make the correction in the
text fo r you, using the word that you have entered.
Afte r another brief scan, the spe lling checker will stop
on " miself."

asdf

Rathe r than asking fo r a suggestion, type this garbage
into the dialog box as the correct spell ing of the word .

Clic k on Change.

Tell the spelling checker to make the correction in the
text for you , us ing the word that you have entered.
The " word " you j ust typed is entered into your document , and the s pell ing check continues.

C lick on OK.

Figure 6.81
The spelling check is over.

Once again the end of the document has been reached .
You are now being told that the spelling check process is
over.
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End of document reeched.

User I

~

0

Unknown Word:
Chenge To:

088

I

1811gnore Words In Rll Ceps
l£onunue £he-ck

J[£

ha:ge-J ( sugges1) (cancel)

lt is important to note at this time that the "i" was not
found as a misspelled word!

Use the command key numeral 9 to move the cursor to
the beginning of the document.
Once again execute the spell ing checker, using the command key equivalent.
After a brief pause, the spell ing checker will locate the
garbage you entered above.
myself

You want to change the garbage to the word " myself."

Click on Change .

Change the word in the document. The spelling check
program will then reach the end of the document.

Click on O K.

Ex it the spelling check program.

Macintosh Productivity Tools

xs

Execute the Save command to save the modified document. Remember that this command may be found on the
File menu.

XQ

Execute the Quit command to exit the word processor.
After a brief pause, the Macintosh desktop will reappear.
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EXERCISES
I.
2.
3.
4.

Explain
How do
How do
How do

the difference between text scrolling and cursor movement.
you move the cursor to the bottom of the screen?
you move the cursor to the end of the document so you can add new text at the end of the existing text?
you open a n existing document?

Assume the following paragraph for questions 5 through 9 :
My Aunt Sally used to love to go to the shore. Of course, you on the West Coast would call it the beach, but it amounts to
the same thing. She loved to walk in the sand a nd play with her dog. After spending a day at this activity, Aunt Sally would
return to her home totally exhausted. The next morning, however, she was ready to return and once again walk on the warm
sand with her dog.
5 . Assume that the cursor is at the beginning of the text. If you then execute a search operation with Wo rd searching for the
text "and," what text will be selected?
6. If you repeat the same search with the c ursor starting at this new location, where will the cursor then stop?
7. If you enter the text to be found as "lDTALLY," will it be found? What happens if you click on the box labelled " Match
Upper/ Lowercase" in the find dialog a nd execute this search again?
8. What if you enter the text to be found as " return "? Will it be found?
9. If you searc h for the phrase " and once," whe re will the cursor stop?
10. When you change the left margin of your document without selecting any text, does existing text be low the point of the
ma rgin change automatically become aligned to the new margin , or do you have to issue a special command to cause this
to happen?
II. If you cha nge the line spacing of your document fro m single- to double-space, can you at a later time change it back from
double- to single-spaced text?
12. If you select the whole document and then change the line spacing from single- to double-space, is the document
displayed as double-spaced on the computer's display?
13. What is the difference between lines of text which have been filled to create justification, and lines which have been
proportional spaced to create justification?
Assume the following paragraph for questions 14 through 21:
There house was warme and cosey, even thoug it was rainning like cats a nd dogs. i was glad to be inside with tern , a nd not
on the rod home.
14.
15.
16.
17.
18.
19 .
20.

When you spell check this text, will it tell you that the first word is incorrect?
When you spell check this text, what will the program tell you about the first word of the second sentence?
What words are suggested options for the word " warme"?
What words are suggested options for the word "cosey"?
What words are suggested options for the word "thoug"?
What words are suggested options for the word " rainning "?
What words are suggested options for the word " te rn"?
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21. Why is the word "rod, not considered a a misspelled word when it clearly should be the word "road,?
22. What is the minimum amount of text that can be selected to be a block?
23. Can you move or copy a block to any location in your document, or only to locations later in the document than the
present location of the block?
24. If you accidentally delete a block of text, but do not realize it for several minutes, what governs whether or not that block
will be in Word's undo buffer?
25. If the text you want to retrieve is not in the undo buffer, how do you get it back into your document?
26. When you move a block of text, what happens to the space that the text originally occupied?
27. When you copy a block of text, where does the copy always appear in the document?
28. Is it possible to copy text from one document to another?
29. Can Word boldface and underline a word at the same time?
30. Are you able to enter print enhancement commands while you are entering the text, or can you only return to existing text
to add print enhancements?
31. Use Word to enter and print two copies-one in justified mode and one in unjustified mode-of the following memo. Be
sure to include the boldface and underlined text:
TO:

Harold Stein, Telecommunications

FROM:

George Graham, Data Processing

DATE:

Nov~mber

14, 1983

SUBJECT: Phone Installation
Alex Jones in Market Research and Mary Anne Peters in Administration have each received personal computers. Their
machines are equipped with internal modems to allow them to communicate with the company mainframe. Please contact
them both to arrange installation of dedicated phone lines in their respective offices.
Thanks.
32. Use Word to enter and print the following brief letter. Don't forget the boldface and underlined words. The body of the
text should be DOUBLE-SPACED:
June 12, 1982
Mr. Fred Jones
Sales Manager
Gizmos and Gadgets, Inc.
137 West Main St.
Los Angeles, CA 90005
Fred:
Thanks one more time for expediting the last shipment of "Super Whatzits!' They were the hit of the Homeowners
Gadget Show. I anticipate that This and That, Ltd., will be able to sell several hundred "Super Whatzits" between now
and the end of the season on July 18th.

rn be in touch.
Sincerely,

Tom Hillski
Distribution Manager
This and That, Ltd.
33. Use Word to print the memo in Problem 31 with a left margin of an extra one inch, and a right margin of an extra one
inch.
34. Use Word to print the memo in Problem 31 double-spaced.

Macintosh Productivity Tools

35. Use Word to enter and print the following outline:
MICROCOMPUTER TRAINING SESSION
I. Introductions
A. Instructors
1. Alice Sykes
2. Marissa Lopez
3. Lester Klein
B. Class introductions
1. Name
2. Department
3. Previous computing experience
II. Hardware
A. The parts of the computer
1. Keyboard
2. Monitor
3. System unit
4. Disk drives
5. Printer
B. Put the computer together
C. Turn computer on
D. Run system tests
III. Floppy Disks
A. What they are
B. Their construction
C. Proper care
D. What not to do with your disks
IV. The Word Processor
A. How to start it
B. Entering text
C. Moving the cursor
D. Editing-insertion and deletion
E. Saving the text
F. Printing the text
G. Quitting the program
V. Training wrap-up

36. Use Word to rearrange the outline from Problem 35 so it appears as follows:
MICROCOMPUTER TRAINING SESSION
I. Introductions
A. Instructors
1. Alice Sykes
2. Marissa Lopez
3. Lester Klein
B. Class introductions
1. Name
2. Department
3. Previous computing experience
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II. Hardware
A. Floppy Disks
1. What they are
2. Their construction
3. Proper care
4. What not to do with your disks
B. The parts of the computer
1. Keyboard
2. Monitor
3. System unit
4. Disk drives
S. Printer
C. Put the computer together
D. Thrn computer on
E. Run system tests
III. The Word Processor
A. How to start it
B. Entering text
C. Moving the cursor
D. Editing-insertion and deletion
E. Saving the text
F. Printing the text
G. Quitting the program
IV. Training wrap-up

CHAPTER

ADVANCED WORD
PROCESSING CONCEPTS

7

-

CHAPTER OBJECTIVES

Upon completion of thls chapter, the student will:

• Explain the difference between a simple find
operation and a find and replace operation,
which is called a change operation by Word.
• Execute a change operation.
• Insert footnotes or endnotes mto the document.
• Draw a border around a paragraph.
• Change the default tab stops and use hanging
indentations.

• Enter a column of numbers using decimal tab
stops.
• Thrn on page numbering.
• Define and use style sheets.
• Create a mailing list file.
• Merge a mailing list with a form letter.

-

7.1 ADVANCED CONCEPTS
In the last chapter you learned how to maneuver through your document, getting from one
location to another in the text quickly and easily. You also learned how to enhance the appearance of the text through format changes and print enhancements.
In this chapter you will learn advanced procedures which will allow you to relocate the
cursor and change the text simultaneously, draw boxes around text and center it on a line, insert
footnotes and create a mailing list.

-

7 .2 FIND REVISITED

In the last chapter you learned about Word 's find option. Recall that the trick to using the find
function is to define properly what you want the word processor to locate. For instance, you
probably do not want to ask the program to find the word "the," because it is too common.
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7 .3 FIND AND REPLACE

The find and replace feature, called " Change" on the Word Utilities menu, performs two
functions. First, it will find a word just as the find operation you saw in Chapter 6 did. Second,
it removes the word or words you asked the program to locate in the file . It will then replace the
deleted text with new words. There are even enhancements to this feature, such as the global find
and replace. This enhancement causes every occurrence of the specified word or words to be
located in your document and replaced with the new text.
Start your computer as you did at the beginning of Chapter 5. After you boot your Macintosh with a System Start-Up disk, make sure that you have the Word Program disk at hand. If
you are using a machine with a hard disk, you will not need to insert the Word program disk into
a disk drive. Rather, locate the Word 4 .0 folder, and open it so you can see the Word program
icon. If you have two disk drives on your computer, or a hard disk and a floppy disk drive, place
the disk that you used while working on Chapter 5 into an empty disk drive. This disk should
have the document you created stored on it. If you do not have a free floppy disk drive, keep this
disk available. You will need it.
Just as in the prior chapter, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer to the specified item and click the mouse button two times fast. The
word "drag" means to select an item, be it an icon or the menu selection bar, and move the
mouse while the mouse button is pressed. Finally, remember that you learned in the prior
chapter that several keys on the number pad perform cursor movement functions. When you see
an instruction to move the cursor, be sure to use the numerals found on the number pad at the
right of the keyboard, and not the numerals at the top of the keyboard!
Before you can execute the Change command, you must first have a document to work with.
This section starts by once again helping you retrieve your document for editing.

WHAT

TO Do

WHY

You ARE DoiNG lr

Locate the icon for the Word program.

You will launch the Word application program by doubleclicldng on it.

Move the mouse to the Word icon and
double-click.

The double-click will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu, or press XO, the command key
equivalent.
After a brief wait, Word will be running, and you will
have a new, untitled document displayed in the window.

Move the mouse to the window's close
box.

Remember, the close box is the one found at the left of
the title bar.

Macintosh Productivity Tools

Click the mouse button once.

Close the untitled document. You are going to open an
existing document, and it is less confusing to work with
only one document active.

Pull down the file menu.

The file menu has the Open command.

Drag the mouse pointer down to the
Open command.

The Open command lets you open existing documents
found on disk. Note that the Open command has XO as
a Command Key equivalent. You may recall that this is
the same key used by the Finder's Open command.

Release the mouse button.

Execute the Open command.
After a brief pause, you will see a dialog box.

Click the mouse on the Drive button
shown in the dialog box.

The Drive button tells Word to display the document and
folder names found on a second disk currently in your
computer. This may be a floppy disk, or a hard disk. If
you do not have a second disk in the computer, then the
Drive button will be dimmed, and you will not be able to
use it.
Continue clicking the Drive button until the name of the
disk that contains your file appears in the dialog box.

Click on My First Document.

You want to open the document you named " My First
Document." By clicking the mouse pointer on the name
in the dialog box, you are selecting this document.

Click on the Open button.

Execute the Open command. After a brief pause while
the computer reads the document, you will see a Word
editing window with the document displayed in it.
You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the document name, rather than
selecting it and then clicking on the Open button in the
dialog box.

If you do not have the file on any of your disks it will not appear in the flle list in the dialog
box. If this happens, you will have to re-type it. Here is the current text of "My First Document":
proce~~ing is
ju~tified margins,

fun! Word proce~~1ng let~ any person type text with neatly
underlined, and boldfaced text .
Many word proce~ ~ i ng programs have a spelling check program ava i 1ab 1 e which scans the
text and indicates words not found in it~ dictionary.
typed thi~ document all by myself!
Word

If you are returning to your earlier text, you should note that the cursor is in the top left
comer of the text window to the left of the W of "Word." You will also note that there is
substantially more text in your document, along with several formatting changes.
If you just entered the text above, use one of the cursor movement options (such as the
mouse, or X9) to jump the cursor to the beginning of the text before you continue.
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Figure 7 .1

Your current document.

r

•

File Edit

Formet Font

Document

Utilities

Window

.,

Word processing is fun I Word processing allovs any person to type text vith
neaUy justified margins, tmderlines, m1 boldfaced text.
Yany vord processing programs haw a spelling
check program linhtlto them that scans the text
and indicates vords not fotmd in its dictiorwv.

This is my fll'St document

I

Word processing is fun I Word processingallovs any person to type tell!. vith
neaUy justified margins, tmderlinas, m1 boldfa:ed text.
Many vord processing programs bava a spelling
check program linked to them that scans the text

WHAT

To Do

WHY

You ARE

DoiNG

/r

Pull down the Utilities menu.

This menu has the Find command that you used earlier,
as well as the Change option.

Select the Change option.

The Change option will locate the specified text, then
replace it with different text.

Figure 7 .2

The utilities menu. The
Change option has been
selected.

Spelling...
an
Hyphenete ...
lndeH ...
Teble of Contents ...
Word Count ...

••
have a

Enter the word, or in this case phrase, you want the computer to locate.

[TAB]

Press the Tab key. The cursor will jump to the next item
in the Change dialog box, Change To.

support a

Enter the word , or in this case the phrase, you want the
computer to use to replace the original text.

Macintosh Productivity Tools
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Figure 7 .3

Change

:>o Find What:
;tiJ Change To:

0

The Change dialog box.

h=a=u=e=a=:==========l

l=l

s_u.:...;pp;_o_rt---!.~------.....1

L..l

Whole Word

181 Match Upper/ Lowercase
Change Rll · J (Cancel )

HStart Search J((hDOIJ P J (

Click on Change ALI.

r

This option tells Word to locate all the occurrences of the
specified text, and to replace it with the new text. After a
brief pause, all the changes will be done. Note that "2
changes" will appear at the bottom left corner of the text
window.

It File Edit Format Font Document Utilities Window
My First Document

,

Figure 7.4

Note that 2 changes have
been made in the text.

!Word processing is fun I Word processing allovs any person to type text vith
neaUy justified margins, underli.Des, and bold.hced text.

Yuy vord processing programs support a

spellinB check program /inhtlto them that scans
the text and ia1icates vords not fouro in its
Change

This

I
I

Find What: lhaue a

Wordproc Change To: !support a
neaUy justi 0 Whole Word 181 Match Upper/ Lowercase
( Stort Search
L

cnanges

Click on Cancel.

.

J(ChongP.J (

ChangeR~

J (cancel]

Close the Change dialog box, and reactivate the document window.

There were two occurrences of the phrase " have a". Both have been replaced with the new
phrase. Scroll up and down through the document to verify this. The fact that both instances of
the original text were replaced suggests that you must be careful when making use of the
"change all " featu re. You may not always want every instance of a word or phrase changed, in
which case you would click on the "Start Search" option. Doing this, Word would have stopped
each time the "search for" phrase was found to ask if you want to replace the located text with
the new text.
There is one easy way to protect yourself against the accidental replacement of all the
occurrences of a word or phrase with unwanted text. Save the document before you execute the
Change procedure. In the event you make an error, it is a simple matter to close the now
incorrect document without saving the changes, then open a clean copy of the text from your
storage disk.
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7 .4 SEARCHING FOR SPECIAL CHARACTERS
The Word program will let you locate special characters in the document, such as a TAB
character or where you have pressed the return key. This is done by entering a special character
into the Find What field of the Find or Change dialog box. It is not uncommon to have to locate
a word that is preceded by a return key, or paragraph mark. Tab characters are also easy to
locate. The paragraph mark is located by entering " p into the Find What box, while the Tab key
is located with " t.

WHAT

To Do

WHY

You ARE

DoiNG IT

X9

Make sure that the cursor is at the beginning of the document. Of course, you may also use the mouse and I-beam
cursor pointer if desired.

XF

Use the Command Key for the Find command.

"p

You want to locate the first instance in the document of a
return character.

Figure 7.5
The current Find dialog
box. You are searching for
the first place in the text
where you pressed the
return key.

lY

Find

I

Find What: l Ap
Ill 0 Whole Word ~Match Upper/Lowen:ase

1~ ( Start Sean:h J(Cancel)
.
-

v

..

Begin looking through the document.

Click on Start Search.

After a brief pause, the first return character will be
located.
Click on Cancel.

Put away the Find dialog box. You can now see where the
first time the return key was pressed in this document.

XY

Thrn on the Show , option (you may find this option on
the Edit menu!). The paragraph symbol at the end of the
first paragraph is now highlighted.

* File

Figure 7.6
Thef symbol at the end of
t he first paragraph is
sel ected.

r

Edit Format Font Document Utilities Window

~·Qiiiiiiiiiiiiiiiiii]M~IYLF~I;~~t]o~o;cu~m~en~tQiiiiiiiiiiiiiiii~
Word.processing.is.funl.Word. processing.allovs.any.Jl&!:SOn to. type.te:r:t. vith
neatly.justified.margins,.uM.ertines,.ml.boldhced.t8ill

q

Yany . vord . processing . programs . support . a
spellins.check. program./1izl'Rtto. them. that.scans.

the . text . and . i.micates . vords . not. foum . in. its.
djctionary.q

XY

.,

Thrn off the Show , option.

~
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7 .5 ADDING FOOTNOTES OR ENDNOTES TO THE TEXT

Many documents that you prepare will require the use of footnotes or endnotes. You may need to
give credit for a quotation appearing in the text, or to supply extra information on a topic that
does not belong in the body of the text. You may want to direct the reader to references on a
particula r topic, or to look at a different location in the document for specific information.
As the name suggests, a footnote will appear at the foot, or bottom, of a page. Word will
atte mpt to put the footnote on the same page as the segment of the text that refe re nces the
footnote.
Endnotes, on the other hand , are collected by Word into one location and printed at the end
of the document.

WHAT

To Do

WHY

You ARE DotNG lr

Pull down the Format menu.

This menu includes the Document command, which lets
you select the ultimate location of footnotes: as footnotes
or endnotes.

Select the Document command and
release the mouse button.

You are going to inspect the options available for the location of footnotes. The Document dialog box will appear.

Document

liM!!

Margins: Top:
Bottom: 1 In

0
0

I

Mirror Euen/Ddd Margins
Euen/ Ddd Headers

&utter:

I

Left:
Right:

1.--------,

OK

I

(§@

181 Widow Control

(Set Default)

Footnotes-----,
Position:
Bottom of Page

Figure 7.7
This is the Document
dialog box, accessed from
the Format menu. You can
see that Footnote control
is located at the lower
right of the dialog.

I
It
::==~
Number From: .._lt_ __.l
Number Lines From: It
::==~
0 Restart Each Page
Default Tab Stops: IO.Sin
Number Pages From:

NeHt File •••

Press and hold the mouse on the open
arrow to the right of the words " Bottom
of Page."

This is a pop-up menu. To use it, you drag the mouse
pointer down to the location you desire for your
footnotes.

Bottom of Page
Beneath TeNt
End of Section
End of Document

Figure 7.8
The footnote placement
menu has been pulled
down, and Bottom of Page
is selected.

Release the mouse button.

For now, do not make a change in the location of
footnotes.

Click on the cancel button.

Exit the Document dialog box without making any
changes.
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X9

Move the cursor to the beginning of the document.
Position the cursor after the exclamation point ending the
first sentence of the document.

Figure 7.9
Note the current location
of the blinking cursor. You
may also use the mouse to
position the /-beam cursor
to this location.

r

•

File Edit

Format

Font Document

Utilities

,

Window

My First Document
Word processing is fun~ Word processing allovs any person to type text vith
maUy justified margins, underlines, and. bold.feced text.

~
r

LL--------~~···~·a-~-~~~=a~~~~~~~w"-~~~-~~~L-------------~

Pull down the Document menu.

This menu contains two references to "foot," the first
being "footer" and the second "footnote."

Figure 7.10
The Document menu.

Select the Footnote option and release
the mouse button.

This command is used to create a new footnote in the
current document. Release the mouse button to execute
this command. Note that you may use the XE key in
addition to the menu to create a footnote.

Figure 7 .11
The Footnote option has
been selected.

Insert Page Break
Insert Graphics
Insert Table ...
Insert lndeH Entry

Click on OK.

~ ....

The footnote dialog box (Figure 7 .12) lets you control the
appearance of the reference mark in the document. For
now, you want to number the footnotes. Clicking on the
OK button will sequentially number the footnotes .

Macintosh Productivity Tools

r
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li File Edit Format Font

Figure 7 .12
The computer's display
after you execute the
footnote option. The
footnote function will
automatically give you a
footnote number.

Word processing is fun I Word processing allovs any person to type text vith
ll!llUy justified n:mrgins, umerlines, and boldfaced tan

181 Auto-numbered Reference
or
Footnote Reference Mart:
....~
Footnote Separators-----------,
L . . l_ _

[Separator ... I [Cont. Separator ... I [Cont. Notice ... I
Word processing is fun I Word processing allovs any person to type text vith
neatly justified margins, umerlines, and boldfaced tan
Many vord processing programs support a spelling

After you click on OK, a superscript numeral I will
appear in the document immediately after the exclamation point, since this is the first footnote in your document. The document window will split, and the cursor
will be in the lower portion of the window, which will let
you enter the text of the footnote.
Pull down the Font menu and select the
Times font, then release the mouse
button.

You want to make sure that the type font used in the footnote is the same as the one used in the body of the text.

Pull down the Font menu and select 12
point, then release the mouse button.

Make the size of the type for the footnote 12 points,
rather than 10.

Credited to John Dough.

This is the text that you want to enter as the footnote. Do
not push the return key at the end of the line. The next
footnote will automatically start on a new line. If you
press the return key now, you will create a blank line
between footnotes.

.,

Figure 7 .13
The footnote has been
entered.

Word processing is funII Word processing allovs any person to type text
vith r~!aUy justified n:mrgins, umerlines, and boldfaced tan

Yany vord processing programs support a
spelling cbBck program JiJ:JhJdto them that scans
the text and i.Diicatas vords not foum il) its
dictionary.
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Use a cursor movement method to place the cursor at the end of the second paragraph,
ending with the word "dictionary,'' in the uppe r portion of the text window. This will be the
location of a second footnote .
Figure 7.14

The /·beam cursor shows
where you will place the
second footno te in this
document.

~ •

File Edit Format Font Document Utilities

Window

.,

M_y First Document

Word processillg is fun II Word processing allovs any person to type tex1
vith neatly justified margim, underlines, and bold.feced text.

Q

Yany vord processing programs support a
spellins check program linhtlto them that scans
tiE text and indicates vords not found in its

XE

This time use the footnote command key.

Click on OK

Create the new footnote entry using the Auto number
default option.
Notice that a superscript numeral 2 appears in the current
document at the location of the cursor, and a superscript
2 appears in the lower portion of the window at the footnote area. Word is keeping track of the number of footnotes you have entered into your text so that they can be
numbe red in sequence automatically.
Even though this text has had its margin changed, Word
will make use of the overall document margins for the
footnote.

Pull down the Font menu and select the
Times font, then release the mouse
button.

Once again, you must adjust the Font to match the body
of the text.

Pull down the Font menu and select 12
point, then release the mouse button .

Make the size of the type for the footnote 12 points,
rather than 10.

Enter the following text for this second footnote:
There are some very c I ever s p e ll1 ng check programs in use today, but they do not check
the writer's grammar .

Macintosh Productivity Tools
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Figure 7.15
Your document should
look like this at present.

Word processiDB is fun II Word processing allovs any person to type text
v ith neaUy justi(sed IIlZII'gins, underli.JEs, m1 boldhced tex1.

Ymy v ord processing programs support a
speUing chack program IJiJbJtlto them that scans
the text m1 iniicates v ords not foum in its
~. 2

scred11Dd., John Douch.
2'Iben en some nzy clrnr spe~ clleck procmm In use 10clay, but tlley do not clleck
Gill 'fthar's CJIIIIIIW.
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7 .6 INSERTING FOOTNOTES BETWEEN EXISTING
FOOTNOTES

It is possible that, afte r reviewing your document, you discover that a footnote has been left out.
It is just as likely that you may add more text that requires a foo tnote somewhere in the text.
When using a typewriter, one proble m with adding new footnotes between existing ones
arises from the footnote sequence number. All following footnotes must be renumbe red by hand .
When using Word, however, if you insert a new foo tnote between existing footnotes, all the
ensuing footnote numbers are incremented by one automatically.
Place the c ursor at the end of the fi rst paragraph, just afte r the period following the word
" text," by using the mouse to move the I-beam cursor, and then clicking the mouse button once.
This is where you will add another footnote. It is, as you can see, between existing footnotes I
and 2.

WHAT

TO Do

WHY

You ARE DOING IT

XE

Use the command key to create a new footnote.

Click on the OK button.

Note that the footnote number inserted into the text by
Word is 2, and that what used to be footnote 2 is now
footnote 3 (Figure 7. 16 on the next page).
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Figure 7 .16
Note that inserting a
footnote between
existing footnotes will
automatically renumber all
the footnotes that follow
the new one.

,.. •

File Edit

Format Font

Document

Utilities Window

,

Word processiJig is tunIt Word proc:assing allovs any person to type tsx1
vith naatly justifl8d JDU"gins, underlines, m1 boldfliCed ten z
Yuy vord processiJig programs support a
spelling check program IJi:Jht/to them that scans

I

the text m1 i.Dhcates vords not found in its
~. 3

This is
I Cieclt\!4

first document.

., .kllm DoQCh.

~
51bm ere JOJDD nJY cllmr spe- cbec:k pmcnms In- rlday, butlbey do rot clleck

a. W.r's CDJIIDlflf.

Pull down the Font menu and select the
Times font, then release the mouse
button.

Once again, you must adjust the Font to match the body
of the text.

Pull down the Font menu and select 12
point, then release the mouse button.

Make the size of the type for the footnote 12 points,
rather than 10.

Enter the following footnote:
Wor d can also outl1ne te xt .

Figure 7.17
djctionm:y.3

The completed footnote.

This is

first

1Cndi1Bcl ., John Douch.

2w0ld c:en el3o ouG!De ~
5Tblm ere some nJY cllmr speiiiDC cbeck pzocnms In- rld&y, butlbey do rot cbeck
1be W.r'IIJIIDIIIIl.

Figure 7 .18
Note the appearance of
the cursor when it is on
top of the split bar.

Move the cursor to the black bar separating the top and bottom portions of the
right side scroll bar.

This bar may be moved up or down to adjust the size of
the split window. It is called the Split Bar. When the cursor is in the proper location over the Split Bar, it will
change shape.

Drag the Split Bar to the up-pointing
arrow at the top of the right side scroll
bar and release the mouse button.

You are through using the split window for the time
being, and want to return the window to a single work
space. When you release the mouse button, the window
will return to its normal state.

Macintosh Productivity Tools
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7 .7 EDITING EXISTING FOOTNOTES

As with any other text you type, it is possible to make errors when entering a footnote. You can
delete and then re-enter the offending note by simply removing the footnote number from the text
and then re-creating the footnote. This, however, can be time-consuming, and it does not guarantee that you will not make another typing mistake. It is much easier to edit the note.

WHAT

TO Do

Move the 1-beam cursor to footnote
number I in the text.

WHY

You ARE DotNG lr

You plan to edit the footnote that is currently number I.
Note the placement of the 1-beam cursor in Figure 7. 19.

,. •

File Edit Formet

Fo11
I

Word procassing is tunI! Word ~
vith neatly justified margins, m:d

Figure 7 .19
Note that the placement
of the /-beam cursor is
touching the superscript 1
in the main text.

..
Double-click the mouse button.

This is one way of opening the footnote area at the bottom of the text window. The cursor will be placed at the
end of the selected footnote , in this case, footnote
number I .

Use standard Word editing to make the footnote read as follows:
Credited to John Q . Dough . He discovered word processing at age 83 and was then able to
complete a book 1n two weeks that he had bee n working on for over 40 years .

1CJ84tM t:l Jolin Q. DoUCh. He 4iscom84 'Wid PrDC8Sib:iC at 1(8 83 eDd VIS1beD. able
t:l c:oJDP• a book In m1 'VIIeks 1b&t 1111 '*1 beeu volll.lnc on for OYH 40 )'MD~

Figure 7 .20
The newly edited
footnote.

ZWord cen elao oU111ne •n
5nen m

JOJDe nJ)' cllnr spellb:IC cbllclr. piOCJIIIIIIn 11M l)day, but they do not cbllclr.

1lle VIim'l CDJD.IIIIf.

Drag the Split Bar to the up-pointing
arrow at the top of the right side scroll
bar and release the mouse button.

Once again, you are through using the split window. You
no longer want to look at the footnotes.

XI

Command-! is the Print Preview command found on the
File menu. While you cannot read the text in this fashion,
you can see what the formatting of the document you
have created will be.
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Figure 7 .21
Print Preview w ill give you
an idea of the overall
appearance o f your
document.

Edit

Format

Fon t

Document

Utilities

Window

.,

-----·
.... ............. .
-·
------- ..._....
,...,.._._
---

::..~!...-~·-·

-----~-~

_.__.

Click on the Cancel button.

Return to the main editing window.

-

7 .8 PUTTING A BOX AROUND A PARAGRAPH

Sometimes boldfac ing o r underlining text is not enough to make something stand out in a
docume nt. To ma ke some text stand out even more , you may want to enclose it in a box. Wo rd
lets you put boxes a round paragraphs of the text. The feature is called borders. In additio n to
being able to put fo ur-sided borders, you may create a "custom" border, turning on and off the
sides of the box in any fas hion you desire.
Use the mouse (or 3€9) to place the cursor at the very beginning of the document. We will
add a title here and create a box around it.

WHAT

To Do

WHY

You ARE DoiNG

IT

[cr] [cr] [cr] [cr]

Press the Return key four times to add four blank lines at
the very beginning of the document. You now have room
to add new text, in this case a title, at the beginning of
the document. You can use this method to add new text at
the beginning of ANY document.

iii

Pos ition the cursor on the second line of the document by
moving it up three lines.

XR

Activate the Ruler Line.

Click on the Center Text icon.

You want to cente r the document title. The cursor will
move to the middle of the line .

Macintosh Productivity Tools

Figure 7 .22

Blank space has been
added to the beginning of
the document, and the
current line of text is set
to be centered.

Word processing is fun II Word processing allovs any person to type text
vith neaUy justified margins, underlines, and bold.feced text. 2
Many vord processing programs support a
spelling check progrmn linltdto !len that scans

Ill! text and irxticates v ords not found in its
~):. 3

Word Processing

r

•

File Edit

Type this text for the title of th is document.

Format

Font Document

Word

Ut ilities

Window

.,

Figure 7 .23

Your document should
look like this.

Processma

Word processing is fun II Word processing allovs any person to type text
v ith neaUy justified margins, underlines, and boldfa:ed text. 2
Many vord processing programs support a
spelling check program linlsdto tb!m that scans

Ill! text and indicates vords not found in its
~. 3

Pull down the Format menu.

This menu has the Paragraph Command.

Select the Paragraph Command and
release the mouse button.

The Paragraph command will let you
place borders around the current
paragraph. This command may be
executed with the XM key.

Figure 7.24

The Paragraph command
has been selected.
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Figure 7 .25
The Paragraph Dialog box.

--.....

Paragraph

Indents
Left:

~
y

Right:
first:

0
0

§

:~.....:··~

OK

[cancel)

Before:

( Apply

After:

Page Break Before
Keep With NeHt 'I

( Tabs ...

Click on the Borders button.

,
•

·-

~

I

0 line Numb Pring
0 Keep Lines Together

) [Borders~~..) (Position ••• )

This button will let you define a border for the
paragraph.

Figure 7 .26
The Paragraph Borders
Dialog box.
•

OK

I

( cancel )

r
~:=;-----.....1

0
0
0
®

Plain BoH
Shadow BoH
outside Bar
Cus t om

Click on the Shadow Box button.

T his will create a box around the current paragraph with
a slight shadow effect.

Click on the double line box at the le ft
of the dialog box.

This will make the line which outlines the paragraph a
double line, rather than a single line.

Figure 7 .27
The borders have been
selected for this
paragraph.

I

OK

I

(c ancel )

I

,..~----.a,...

:==:::;---""

0 Pialn BoH
®Shadow BoH
0 outside Bar
o custom

Click on OK.

Close the Paragraph Borders Dialog box.

Click on Apply.

Apply this change to the current paragraph by clicking
Apply in the Paragraph Dialog box.
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Click on OK.

,.

•

Close the Paragraph Dialog box.

,

File Edit Format Font Document Utilities Window
My First Document
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The title is now
surrounded by a double
line box with a slight
shadow.

•
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I

Word PiOCiiSS§il

I

~

Figure 7 .28
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You can see that the box extends to the left and right margins for this line. The width of the box is controlled by
the margins!
Drag the right margin indicator two
inches to the left.

,.

•

,

File Edit Format Font Document Utilities Window

My First Document
IZ

Nor mel

I

Change the right margin from 6 inches to 4 inches.
Remember that text remains centered between its marg ins. The title of the document will shift left when you
do this.

IIQI

Ht

t.

I

IR:I-~

Word Processinsi

..

14

13

,.

'I!

.a.

15.
-

Fl t::l

__lfi.
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I

Word processing is fun II Word processing allovs any parson to type text
vith ..:...n., imlified maririns. umerlinas arxt boldfs:ed text. z
Drag the left margin indicator two
inches to the right.

11!111

0

Wol

Figure 7.29

The new right margin. The
mouse pointer is on the
right margin indicator on
the ruler line.

~~

ji

~~

d

Make a matching change to the left margin for this line.
Remember to drag the lower portion of the split left margin indicator so that the upper portion moves at the same
time!
Since you have changed the left and right margins for this
line an equal amount, the title is properly centered and
contained in a reasonably sized box.
Figure 7 .30

The nearly finished title.

Word PiOC8SS§i
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Select the complete title.

You are going to do one more thing to this text. To make
any changes, it must be selected. Simply place the mouse
to the left of the title, where it will be a mirror arrowhead mouse. A single click will select the whole line of
text.

Figure 7.31

The title is selected.

Pull down the Font menu.

You are going to change the size of this text.

Drag the selection bar to 24 point.

You want the title in a large type size.

Figure 7 .32

The 24-point size is
selected.

Release the mouse button.

Execute the font size change. The document title will
immediately be displayed in 24-point letters.

Figure 7.33

The re-sized title.

I
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7 .9 CHANGING TAB STOP POSITIONS
You have seen, by looking at the ruler line, that Word has default (that is, preset) tab stop
positions at every one-half of an inch. Each tab stop is denoted on the ruler line by the small
triangle beneath the ruler.
Unfortunately, these tab stop positions are not always the desired ones. It is a relati vely
simple task to change the preset tab stop positions. You may change them for a single paragraph
of your work, or the complete document. Recall that when you made a margin change, it
affected the selected text. The same is true when changing the tab stop locations. If the text is
selected , a tab stop change will affect that paragraph. If the text is not selected when making the
change, that un-selected text will not be affected.

Figure 7.34
The Word tab stops.

Before you begin , look at the four different tab stop types available to you. They are
displayed unde r the rule r line between the one and one-half and two and one-half-inch marks.
From left to right, they are the left align tab stop, the center tab stop, the right align tab stop a nd
the decimal tab stop.
The left align tab stop is the one you may be used to using. All the default tab stops a re of
the left align variety. When you tab to one of these positions, typing continues onward from the
location of the tab stop. The right align tab stop causes what you type to push backwards as you
enter the characters. You will use a right align tab stop when you a re ente ring the page number in
a footer, later in this c hapter. The center tab stop causes text to be centered around the tab
position as you type , rather than between the left and right ma rgin , which is where text is
normally centered . The decimal tab stop causes numbers to line up in neat columns , like this :

67.98
1.05
987.55
1,765,654.2 1

WHAT

To Do

Select all the text, except the document
title.

WHY

You ARE DotNG IT

You want to make a tab stop change and have it effect
everything except the document title.
Note that part of the ruler line becomes shaded when you
make this selection. This is happening because there are
margin, and possibly other, changes withi n the document. Thus, the shaded ruler line is telling you that there
is a format change within the selected portion of the
document .
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.,

Figure 7 .35
You have selected the
complete document,
except for the document
title. Note the shading on
the ruler line.
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Move the mouse pointe r to the left tab
icon.
Figure 7 .36
You are about to use the
Left Align tab stop icon.

This icon is below the one and a half point on the ruler
line.
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•
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Press and hold the mouse b! tton.

Select the Left Align tab stop.

Drag the Left Align tab stop to the 3/8
point on the ruler line.

This position is one tick mark to the left of the half-inch
position on the ruler.

Release the mouse button.

Position the tab stop.

Figure 7.37
The tab stop has been
placed on the ruler line.

Move the mouse pointer to the left tab
icon.

You want to place a second tab stop.

Press and hold the mouse button.

Select the Left Align tab stop.

Drag the Left Align tab stop to the 3/4
point on the ruler line.

T his position is half way between the one-half and oneinch marks on the ruler line.

Macintosh Productivity Tools

Release the mouse button.
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Position the tab stop. When you do this, notice that the
preset tab stop disappears from the one-half-inch mark.

Adding tab stops removes the preset tab stop to the
left of the new tab.
Move the mouse pointer to the left tab
icon .

You want to place a third tab stop .

Press and hold the mouse button.

Select the Left Al ign tab stop .

Drag the Left Align tab stop to the
I 1/8 point on the ruler line.

This position is one mark to the right of the one-inch
mark on the ruler line.

Release the mouse button.

Position the tab stop.

Figure 7 .38
You are now able to easily
see the new tab stop
positions. Notice that the
preset tab positions at the
1/2" and 1" marks are no
longer present.

,.

Press the left arrow to de-select the document. You may
also s imply click the I-beam cursor anywhere in the
document to achieve this same affect.
Look at the ruler line. You can see the three new tab
stops you have placed at the beginning of the ruler.

! !

As you move the cursor down in the text, you can see that
the new tab stops remain on the ruler line. Remember,
this will be true only if you selected the complete document before inserting the tab stop indicators.

Place the cursor in front of the word
"Word " which starts the first
paragraph.

You are goi ng to insert a tab at this location.

[TAB]

Press the Tab key to indent the paragraph. The Tab key is
located next to the letter " Q" on the left s ide of your keyboard , and is clearly labelled "tab."

,. a

File Edit

Format

Font Document

Utilities

Window

!Word processing is fun II Word processing allovs any person to type
text vith neatly justified IDIITgiDs, underlines, 8IX1 boldfaced text.2

Many vord processing programs support a
spelling check program lln.tedto Ulem that scans
Ule text and imicates vords not found in its
. i'

.,

Figure 7.39
The first paragraph is
indented to the newly
inserted tab stop.
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Place the cursor after the last character
of the first paragraph .

You are going to add a new line of text after this paragraph, and use numeric tab stops.

[cr] [cr]

Add a blank line.

Move the mouse pointer to the decimal
tab icon.

You are going to place a decimal tab stop on the ruler
line.

Press and hold the mouse button.

Grab a decimal tab icon.

Drag the decimal tab to the 4-inch mark
on the ruler line and release the mouse
button.

Place the decimal tab stop at the fo ur-inch mark on the
ruler line.

Figure 7 .40

ocument

The ruler line now contains
a decimal tab stop at the
4-inch mark.

Utilities W!!i

lrst Document
il,l..

D:

__jg_

t.
-~ts~d

W:d

-

Fit=l

1

[TAB]

Tab the cursor to the first tab stop position.

The cost of word processing: [cr]

Type this line of text, followed by a return .

[TAB] [TAB] The computer

Type this text, afte r pressing the tab key twice.

[TAB]

Tab the cursor to the decimal tab stop position.

$995.50

Enter this amount. Watch the Macintosh display as you
type. The characters will move left on the screen, rathe r
than the cursor moving right. When you press the decimal point , normal typing will be restored.

Figure 7 .41

Note that the decimal
point is directly under the
tab stop location at the
four-inch point on the
ruler line.

r
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File Edit

format

font

Document Utilities

Window

Word procassing is funll Word procassing allovs any person to type
text vith neatly justifJ.Bd margins, UJX1erlines, m1 boldhw::ed t.ext.2
1bl cost of vord processing:
Tblcomputar

$995.5Q

Ymy vord

[cr]

Push the return key and start a new line.

[TAB] [TAB] The printer [TAB] 350.00
[cr]

Enter the next line. Note that the decimal points line up
in a neat column.

.,

Macintosh Productivity Tools

[TAB] [TAB] The software [TAB]
250.00 [cr]

Enter the last line.

[TAB] [TAB] [TAB] TOTAL [TAB]

Enter a line for the total.

$ 1,595.50

Enter the total cost.

.,

Figure 7 .42

All of the entries line up
on the decimal tab stop.
This is even true for the
total, which included a
dollar sign and a comma.

Word processing is f'unll Word processing allovs any person to type
te:xl vith neatly justified margins, uaierlines, m1 bold.flDld te:xl. 2
Tbec~ofvordp~

The computer
The printer
The softvare

TOTAL

$995.50
350.00
250.00

$1,595.5~

-

7.10 THE HANGING INDENTATION

The hanging indentation, or indent is a useful feature when you c reate lists of information. It is a
form of margin c hange. To create it, you wi ll take advantage of the split left margin indicator to
create a double left margin.
The hang ing indent c reates text that looks like this:

* This is the first hanging indent paragraph . Notice that the left margin of this paragraph is
*

not under the star. T he indentation is, in effect, hanging out backwards into space. Some
people call this a backward inde nt!
Here begins a second hanging indent paragraph. Because the asterisks are hanging out,
each paragraph or point in your list can be located easily.

This same effect can be created by use of the tab key or the space bar. However, problems
will then occur if you edit the text of the paragraphs created in this fashion. You will have tabs or
spaces appear in the middle of paragraphs if you add or remove enough text to effect where the
lines must word wrap. The hanging indent avoids this problem by creating a left margin position
that follows a press of the return key, and a second left margin position that follows text that is
word wrapped. If text is edited , Word knows to wrap the lines to the second left margin that you
have created, rather than the first.
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WHAT

To Do

WHY

You ARE DOING /r

X3

Move the cursor to the end of the document. You may, of
course, use the mouse to position the 1-beam at the e nd
of the document, then click the mouse button once.

Drag the right margin indicator to the
six-inch point on the ruler line.

Reset the right margin to its default location.

Click on the left align icon under the 3
on the ruler line.

Reset the format of the line from centered text to the normal , left aligned text.

[cr] [cr]

Add two blank lines to the end of the document.

Type this brief paragraph. End it by pressing the return key two times. After you press the
return key, a dotted line will appear across the current window. Do not worry about it at this
moment. More will be said about this dotted line at the end of this section.
The following are some benefits of using word processing :

i

Move the cursor up one line. The blank line you are leaving at the end of the document will retain the current line
formatting (the margin and tab stops) , and wi ll be taken
advantage of after you produce a hanging indent.

,

Figure 7 .43
Your document.

..

~~~.m~ 9!..1,1;$.g _w.c?!:~~~ffig; .................. ······ .... .

Drag only the top portion of the left
margin indicator LEFT on the ruler line
three-eighths of an inch.

In effect, you are placing the left margin off the page!
The ruler line will display negative values. Be sure that
you grab only the top half of the left margin indicator at
this time, leaving the bottom half of the margin indicator
at the zero position on the ruler line. When you are done,
your display s hould look similar to Figure 7.44.
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Figure 7.44

Look at the ruler line. It
shows negative numbers.
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Drag the bottom portion of the left margin indicator RIGHT on the ruler line to
the I 118-inch point on the rule r line.

This is the location of the third tab stop that was entered.
Note that the top portion of the left margin indicator
moved with the bottom portion.

r

•

File Edit Format

Figure 7.45

Font

The split left margin
indicator is aligned with
the second and third tab
stop.
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[OPTION] -8

Hold down the Option key and press the number 8 from
lhe numbers found at the top of lhe keyboard. This will
place a bullet character into the document. The Option-8
key produces the bullet character in many of the standard
Macintosh fonts .
Having entered the bullet, you are ready to enter the text.

[TAB]

The Tab key will move the cursor to the next tab stop on
the line. This should be lhe lhird one that you ente red.
This tab position matches the bottom half of the left marg in ind icator.

.,

,. 4t File Edit Format Fon t Document Utilit ies Wi ndow

and imicates vords not foum in its dictionary.

Lo ok at the current
location of the cursor.

i.

i typed this document all by asdtl
......... ...........~~ x~n9.~m~. !l:J;'~. ~m~. ~~~.(~~..9f..l,l.~ ng .~r.~ .P.J;'~.~mg; , ........ .
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I

Figure 7 .46

:
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Now enter the following text, and end by pressing the return key. As you are typing th is line,
the contents of the window will shift back to its normal location:
Faster tex t entry because 1t i5 easter to
typewriters . [crl

Figure 7 .47

The line wraps after the
word "mistakes" with the
left margin indented to the
margin position indicated
by the bottom portion of
the margin indicator.

r

•

File Edit

Format Font

corr~ct

m1stakes than with most

Document Utilities

,

Window

aD1 indicates vords not found in its dictionary.
I type<! tllis document au by asd!l
.Th~J~~9.'ffl~g-~~. 1'9m~. ~m~m~. !?f..~ng.'!'!)?r.~.P.~~~g; ____ ___ _..................... .

•

Faster text entry beCause It Is easier to correct miStakes
than with most typewriters.

i .

When you pressed the [cr] at the end of this item, the cursor returned to its position under
the bullet character you ente red. The return denotes the end of a paragraph. If you had continued
typing without pressing return, the left margin would have remained indented. Since you pressed
return , the next paragraph begins at the farther left margin.
In fact, what is happening at this point is that the top portion of the left margin indicator
represents the position on the line that the cursor will go to immediately after a return characte r
is entered into the text. The bottom portion of the left margin indicator represents the position on
the line that the cursor will go to whe n the text is word w rapped.
Now try ente ring another point in the bulleted list.
[OPTION]-8

Enter a bullet character at the left margin.

[TAB]

Move the cursor to the word wrap left margin position.

Type the following text, but do not press the re turn key:
Faster text entry because you do not have to wait for the
to the begtnntng of each l1ne .

!

typ~w iter

mechanism to ret urn

Move the cursor down to the blank line that you left at
the end of the document. Notice when you do this that
the left margin indicator returns to the zero location. If
you had not left the blank line, then you would have had
to re-set the left margin indicator to zero by hand.

Macintosh Productivity Tools

It File Edit Format Font Document Utilities Window

r

.,

Figur e 7 .48

Note the left margin
indicator on the ruler line.

mi. in1icates vords notfoum in its dictionary.

1typed this document au by asdfl

..Th~J~~9.W}~g.!l:~~.~m~. ~m~m~..Qf..1,1.~P.g.wm:~w.!?9~l!~~~g: ........................ ..... .
•

•

Faster text entry because it Is easier to correct mistakes
than with most typewriters.
Faster text entry because you do not have to wait for
th& typewriter mechaniSm to return to the beginning of
each line.

Now position the cursor in front of the letter "c" beginning the word "correct" in the first
point you entered. You are going to make this phrase read " make corrections to mistakes."
make [SpaceBar]

Type the word "make" in front of the word " correct"
and then press the spacebar. As you are typing, the text is
adjusted. Note that the word "mistakes" is moved to the
next line, but that it stays at the left margin defined by
the bottom half of the left margin indicator.

r;m1

.. Th~J~~~9.mP.g.w.~ .~m~.~~~.~!~..9L1,1.~!P.g.w.Qr.~.P.~!?9.~l!~~p.g: ............... .... ..... ....... !Ji;l:
•
•

Faster text entry because it is easler to make l:;orrect.
mistakes than with most typewriters.
Faster text entrv
use u do
have to
for

!l~i:

·• '

Move the cursor to the end of the word
"correct."

This is where you will add more text.

ions to

Complete the edit.

r

It File Edit Format Font Document Utilities Window

mi. imicates vords not foum in its dictionary.

I typed this document all by asdf I

..Th~J~~9.m~g.w.~.~m~.~~~m~..9f..l,l.~P.g.W:?r.~.P.;-!?9.~l!~ffig: ...... ...................... .. .
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Faster text entry because it is easier to make corrections
t,q mistakes than with most typewriters.
Faster text entry because you do not have to wait for
the typewriter mechanism to return to the beginning o!
each lin&.

.,

Figure 7-49

The word "mistakes" has
wrapped to the indent
position on the next line
of the text.

Figure 7 .50

The completed edit.

249

250

CHAPTER SEVEN -ADVANCED WORD PROCESSING CONCEPTS

Move the cursor to the end of the
document.

Use the cursor movement commands, or the mouse, to
move the blinking cursor to the end of the text.

[cr] [cr]

Press the return key two times.
Now you should pay attention to the dotted line that
appears across the window just above the first item of the
list you have created. This is a page break.

Move the scroll box at the right of the
window to the bottom.

Figure 7 .5 1

The current page number
now reads 2.

r

a

File Edit

•

If you scroll the text up, so that the page break line
moves out of the window at the top, you will see that the
page number indicator at the bottom left of the window
now reads "Page 2," since that is now the page of the
document displayed in the text window.

Format

Font

Document

Utilities Window

,

to mistakes than with most typewriters.
Faster text entry because you do not have to wait tor
the typewriter mechanism to return to the beginning of
each lin&.

-

7.11 FORCING A NEW PAGE

As a stylistic issue you may find it desirable to keep port ions of a document on one page . For
example, you may want the brief list of word processing benefits you have just created to start a
new page. In addition to this example, you may be creating tables or figu res that you do not want
broken over two pages.
The best way to deal with this issue is to tell Word that you want a page break in a particular
location. This is called a " hard " page break. The cu rrent page break, placed by the word
processor, is called a "soft" page break. Soft page breaks, like soft returns at the end of lines,
can change their location depending on the content of the page. A hard page break will maintain
a fixed location in the document.
Use the mouse or the cursor movement keys to position the cu rsor at the left edge of the line
of text beginning " The following are some .. ." . Make sure that the cursor is in front of the word
" The" which starts the line.
Figure 7.52

Note the location of the
cursor in the text.

li!!
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Faster text entry because it is easier to make corrections
to mistakes than with most_ty~writers.

!'I!

~
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WHAT

To Do

WHY

[SHIFT]-[ENTER]

r

•

File

Edit

Format

You ARE DoiNG

IT

Hold down the Shift key and press the key labelled
" enter," found on the keyboard's number pad. This is
NOT the same as the return key.
You have inserted a Hard Page break into the document.
You can see that a hard page break appears as a line of
closely spaced dots across the screen, as compared to the
line of separated dots you saw earlier that denoted a soft
page break.

Font Document Utilities

Window

,

Figure 7 .53
Compare the hard page
break shown here with the
soft page break seen in
Figure 7.52.

following are some benefits ot using word processing:
• Faster text entry because It Is easier to make corrections
to mistakes than with most typewriters.
• Faster text entry because you do not have to wait tor
the typewriter mechanism to return to the beginning of
each line.

If you place a hard page break into the text in either the wrong location, or because of
editing what becomes the wrong location, it is easy to remove. All you need to do is remember
that the hard page break is another character that you have entered into the text. You may use any
technique you are already familiar with for deleting characters to delete a hard page break. For
example, use the mouse to position the !-beam on the line immediately after the hard page
break. Click the mouse button to move the cursor to that location, then press the backspace key.
The cursor in Figure 7.53 is shown in the correct location to delete the hard page break by
pressing the backspace key. You may, of course, select the hard page break line by doubleclicking on it. Then, once again, press the backspace key to delete the page break from the text.

-

7 .12 ADDING PAGE NUMBERS TO THE DOCUMENT
Word does not insert page numbers automatically into your printed document. While not having
page numbers is desirable for documents such as letters, you may want to include page numbers
on longer documents and reports.
You may create page numbers two ways with Word . The easiest is to make use of the Print
Preview/Page View feature to position the page number on the page. You may also include page
numbers in either a running header or running footer. This latter method is discussed in the next
section of this chapter.
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WHAT

To Do

WHY

XI

You ARE DoiNG IT

This is the command key for the Print Preview command, found on the File menu.
Note the four icons at the left of the display. The top one
is used to activate and position the page number in the
document.

Figure 7 .54
The Print Preview display.
Note the icons at the left
of the screen.
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Click on the TOP of the four icons.

This is the page number icon. When you click the mouse
pointer on it, the pointer wi ll turn into the numeral I with
s mall arrows pointing to it.

Move the mouse to position the page
number icon at the top right of the firs t
page of the document.

You want to page number the document , and you want
the page number to be printed at the top right corner of
the page.

Figure 7 .55
The page number icon is
positioned at the top right
of the first page of the
text.

Click the mouse.

Figure 7.56
After clicking the mouse,
the page numbers are
inserted into the
document.
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font

Document

Utilities

Window

By pressing the mouse button once, you place the page
number icon. After a brief pause, the pages will be
redrawn with the page numbers included.

.
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You are through looking at the Print Preview screen.
Clicking on the Cancel button returns you to the normal
Word edit mode.

Click on the Cancel button.

If you decide that you do not like the location of the page number, simply click on the page
number icon at the left of the screen again. After you have activated the page number icon,
position it to the desired location on the page , and click the mouse button. The old location of the
page number will be forgotte n, and the new one you have chosen will take its place.

-

7 .13 HEADERS AND FOOTERS
An alternate method you may use to number your document 's pages is to create running headers
or running footers and include the page number in them. A running header or footer is a line or
two of text that will appear at the top (in the case of a header) or bottom (in the case of a footer)
of each page in the document. If you look at the top of any page of this text, you will see a
running header. T he header on the right side page, the odd page number, is the same throughout
the complete document. The header on the left side, or even page number, changes in every
chapter, but remains the same within a single chapter.
Before you activate either a running header or a running footer, you should delete the page
number you activated through print preview. You do not want both active for aesthetic reasons.

WHAT

To Do

WHY

Pull down the Formal menu and select
the Section command.

Start: I New Page

...

Page Number
1:81 Auto
0 Restart at 1
[1 2 3

!ol 0

The Section dialog box (Figure 7 .57) will let you deactivate automatic page numbering, which is what you turned
on in the last section.

Section
Include EndnDtl.'s

t

Line Numbers

~

&I

From Top:

You ARE DOING IT

IOff

IOI

[ ount by:

I

rrom li.'Ht:

, llu1o

Columns
Number.

FromTop:
~
From Bottom: O.Sin

ID.Sin

I

(Apply J

r-

Header/Footer

l- -1

:-!-

I (Set Default J

From Right : I 0.8191n I

Spacing:

))

(cancel)

iI
~-~

ID.8191n l

OK

Figure 7.57
The Section dialog box.

0

First Page Special

At the top left of the Section dialog box is an outlined
area labelled Page Number. Inside this area is a check
box labelled Auto. The Auto check box is currently
"X"ed, indicating that auto page numbering is active.
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Click on the Auto check box.

Tum OFF auto page numberi ng.

Figure 7.58
Auto page numbering has
been turned off.
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Click on the OK button.

Put away the Section dialog box. You are now ready to
activate a header or footer to contain the page number.

Pull down the Document menu and
select the second item, Open Footer.

You have decided to use a running footer in which you
will include the page number.

Figure 7.59
Open Footer... has been
selected from the
Document menu.
Footnote .••
Repaglnate Now

Insert Page Break
Insert Graphics
Insert Table ...
Insert lndeH Entry

Release the mouse button.
Figure 7.60
You are ready to enter a
new footer into the
document.
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Activate the document's footer.
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You are now ready to enter the text of the running footer.
Word Processing Report

This is the text that you want to appear in the footer.

3€R

Activate the Ruler Line fo r the footer. Look carefully at
the right margin indicator. You can see that there is a tab
stop positioned at the right margin. This is preset to a
right aligned tab.
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Figure 7.61
The ruler line in the footer
is different fro m the
default ruler line in the
main document. Note t he
center tab stop in the
middle of the ruler line,
and the right align tab
stop under the right
margin indicator.

[TAB] [TAB]

Tab the cursor to the right al ign tab stop at the end of the
line.

Page [SpaceBar]

Enter the word "Page" fo llowed by a s ingle space .

Click on the page number icon at the
top left of the footer wi ndow.

The page number icon looks exactly the same as the page
number icon you used on the print preview screen.
When you cl ick on this icon, the current page number
will automatically be inserted into the footer at the current cursor location. The other two icons you see in the
foo ter window will let you place the current date and
time into the footer. These same icons appear in the
header window.
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Click on the left edge of the footer window to select the complete line of text
you have j ust entered.
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Figure 7 . 62
The page number has
automatically been
inserted into the footer.
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Now that you have entered the text into the footer, you
must make its font match your hardware and the rest of
the document.
Figure 7 . 63
The complete line of the
footer has been selected.
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Pull down the Font menu.

The footer is set to the default Word font, which is New
York. You must change this to Times if you are using a
LaserWriter.

Select the Times font and release the
mouse button.

Change the font in the Footer to Times.

Pull down the Font menu.

This time, you are going to change the size of the type.

Select I 0 Point and release the mouse
button.

Change the type size to a smaller point size than the
default that you have been using.

Click on the close box found at the left
of the footer window's title bar.

You are done entering the running footer. Put away the
window and return to the main document editing
window.

xs

Execute the Save command from the File menu to save
the changes you have made to this document.

-

7 .14 MODIFYING AND USING EXISTING STYLE SHEETS

By now you have noticed the word Normal that appears at the bottom of the current document
window (Figure 7 .64). This is a message telling you which style sheet Wo rd is making use of at
the moment. The box below the left end of the ruler line has also displayed the name of the style
sheet in use (Figure 7 .65). A style sheet is a tool for defining formatting commands. You may
use a style sheet to hold ruler line and paragraph definitions, as well as character font and size
definitions. In short, the formatting accessed on the Format and Font menus can be combined
into a single entity, called a style.
Figure 7 .64
The word Normal appears
at the bottom of the text
window, telling you that
the Normal style sheet is
in use.
Figure 7 .65
The word Normal,
indicating the current style
sheet, also appears in the
box at the left end of the
ruler line.
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You have actually seen other preset styles when you used footnotes and footers. You can
change styles within a document, or even change the definition of a style. In this section, you
will have the opportunity to change existing style sheets, as well as create a new one.
The advantage of Style Sheets is that you may apply them to existing text, making that text
conform to the defined style. Thus, you do not have to remember what all the tab stop settings
are for a paragraph, or even which font or type size is in use. All you need to do is select the
desired style and apply it to the text. An equally important advantage is that you may change a
style , and all text that uses that style sheet will change. You do not have to spend time locating all
the places in your document that you want to have match the formatting, as long as the style has
been applied to the text.

Macintosh Productivity Tools

WHAT

TO Do

WHY

You ARE DOING

IT

Place the mouse pointer on the open
down arrow to the right of the word
Normal just below the rule r line.

This arrow key is one way that you can access the list of
styles associated with the current document.

Press and hold the mouse button.

Pressing the mouse button will pull down the list of
styles.

Figure 7 .66
These style sheets are
available in this document.
Normal

footer
footnote reference
footnote text
Normal
number

Release the mouse button.

Do not change a style yet.

3€9

Move the cursor to the beginning of the document.

Double-click on the footnote reference
number I after the first sentence of the
text.

Double-clicking on a footnote reference will open the
footnote window at the bottom of the window.

'

You can see that the style sheet indicato rs no longer read
Normal , but Footnote Text. There is a different style
associated with footnotes than normal text.

4i File Edit Formet Font Document Utilities Window

.,

Figure 7 .67
You can see that Footnote
Text appears at the bottom
of the window and in the
box at the left end of the
ruler line.

Word
Processing
Word processing is fun~ Word processingallovsanyperson to type
text vith neatly justified margins, underlines, m:1 boldfaced text. 2
1Credhed 111 John Q.Douch. He dlsco'lered vord Proc:essiDc at q;e 83 a1ld ""WS then able 111

complela a booli:.ln tvo "fteks that be ba4 been vorldnc on for onr 4l ~m~

ZWord can al3o outiiDe ~ext
311lere are some vezy cllmr spe~ cbeck PJ:OCJ8lllS lD 11se 1Dday, but they do not cbeck

Pull down the Format menu.

T his menu contai ns the command fo r editing sty le sheets.
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Select Define Styles.

The Define Styles command may be executed by using
~.

Figure 7.68
The Define Styles
command has been
selected.

Font Documen
a&R
Hide Ruler
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Se( tion ...

I
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----·------- ~
Styles •••
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Plain For Style 'XQ._
_______________
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r..; Bold
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IJJ

XQZ
XQB
XQ I
XQU
XQD
XQW

Italic
UoderiiDe
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Release the mouse button.

Execute the Define Styles command. After a brief pause,
you will see the Style dialog box for the current document.

Figure 7 .69
The Styles dialog box.

First Document
•footer
•footnote reference
~·footnote teHt
•Normal
•page number

t

OK

I

( Cancel J
[ Rpply J
(Set Default J

Style:

NeHt Style:

Click on the style named Footnote Text.

Oetlne

I

J

I Based on: Ifootnote

Select this style to work with. The check mark in front of
this style indicates that it is the currently active style.
When you select a style , its current definition appears in
the box near the bottom of the dialog box. You are going
to modify this style.

Macintosh Productivity Tools

I

,. ,,. .

Style: footnote

r·~~·

I(

teH~

I

NeHt Style: footnote

0£> tin£>

Fi gure 7.70
The style definition for
Footnote Text.

I Based on: INormal

Pull down the Font menu and select the
Times font , then release the mouse
button.

Make Times the font used in the footnote text definition,
rather than the default New York font.

Pull down the Font menu and select 12
Point.

Make the s ize of the font 12 point, rather than 10 point.

Drag the left margin on the ruler line to
the one-fourth position.

You are going to create a hanging indent for the footnotes, so that the numbers stand out at the bottom of the
page.

Figure 7 .71
Note the position of the
left margin.

.

,.

File Ed I

II
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II
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Drag the top portion of the left margin
back to the zero position on the ruler
line.

Remember, to create a hanging indent you define two left
margin positions. After a return is encountered, the cursor returns to the position of the top portion of the left
margin marker, otherwise it word wraps to the position
of the bottom portion of the left margin marker.

Drag a left align tab stop to the position
of the bottom portion of the left margin
indicator.

Set a tab stop to the same position as the indented left
margin.

Figure 7.72
The left margin indicator
now looks like this.

Make the definition you have created the current one for
this style.

Click on the Define button.

The style definition is now complete. You can see what it
is by looking in the definition box (Figure 7.73).

I

Style: footnote teHt
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0£>th\l'

Nor mal • Font: Times, Indent: Left 0.251n First - 0.251n, Teb
stops: 0 .251n

Figure 7.73
The updated style
definition box reflects the
changes you have made to
the Footnote Text style.
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Figure 7 .74
Note the location of the
curso r.

...... ..............
~*l .,_.blll
_,compiUII I

'Wold can also c
:IIJ'benara some

Click on OK .

Close the Define Styles dialog box.

Move the 1-beam cursor so that it is
between the footnote reference number
and the footnote text , then click the
mouse button once.

You must now add a tab character at this location in each
footnote to get the desired hanging indent.

[TAB]

Insert a tab character.
Move the cursor so it is between the footnote refere nce
number and the text fo r the second footnote .

'Ole 'Yii~:r' s

IFOOtnote

[TAB]

Insert a tab character.

!

Move the cursor so it is between the footnote reference
number and the text for the third footnote.

+- +-

[TAB]

Insert a tab character.

Figure 7 .75
Your footnotes will now
have a hanging indent.

Credned l:l John Q . Do~~&h. He dlsconnd wid processi:n( at ece 83 and "WS 1ben able
10 comple~ e. book in tw veeb lllat be had been w~ on for over«< yem.
2 Wold can abo outline ~xt
s lfhere are some v-eryclev-erspelllllg checkp!O(rams in use 1Dde.y, but they do not cbeck

1

the 'Yii~r's gnmme.r.

Click the I-beam after the sentence
" This is my first document." in the
body of the text.

You are now going to add a new footnote . This will show
you that the style you have defined will take effect in any
new footnote.

XE

Execute the Footnote command.

C lick on OK.

Tell Word to auto-number the footnote. After a brief
pause, footnote fo ur wi ll appear. You can see that the
ruler line now shown is the one that you created fo r
footnotes.

Figure 7.76
Note t he location of the
new footnote. Also, look
at the current ruler line. It
is t he one you just created.

r
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File

Edit

Format

Font

Document

Ut ilities

Window
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This is my first document. •

I

Word processing is fun! Word pr~ssing allovs any person to type text vilh
neatly justified margins, underl.ims, and boldfaced text..
Many vord processing programs support a spelling

.,
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[TAB] But not my last!

Enter this text for the footnote . Don't forget to start it by
press ing the tab key.

Drag the Split Bar on the right scroll bar
to the top of the right scroll bar.

You are now finished with footnotes. Recall that this will
hide them.

-

7 .15 CREATING A NEW STYLE SHEET
Another impo rtant advantage of the Style s heet lies in your ability to create you r own. You do not
need to re ly on Word to c reate them for you. In this section, you will c reate a new style sheet,
based on existing text. You wi ll the n use this style sheet fo r new text.

WHAT

To Do

WHY

You ARE DoiNG IT

X9

Move the cursor to the beginning of the document.

!

Move the cursor down one line into the title of the document.
This command key activates the De fine Styles d ialog
box. As before, New Style is highlighted.
Notice that the style definition box near the bottom of the
dialog box summarizes the fo rmatting changes you made
earlier to this line of text.

Titles

You want to use this style definition as it is. To do so, you
must first assign it a name. Type Titles as the name for
sty le.
Figure 7.77
The style definition box
shows what you have
done to the selected
section of the text. You are
giving it a name.

First Document
NP UO \l lj iP

.p

I

00

•footer
•footnote reference
•footnote teHt
..t•Norm111
•page number

OK

I

[cancel 1
( Rpply

1

(Set OefiiUit
Style: Jmle s

I(

Define

Normel +Font: Times 24 Point, Indent: Left 2 In RiQht 2 in
Centered Border: Top Bottom Left RfQht (Double Shodwed)

NeHt Style: J

I Based on: INormIll
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Click on the Define button.

Figure 7.78

Titles is now a style that
you may use in other parts
of the document.

r

•

Enter the Titles style into the list of styles that this document may use.

File Edit

Word p

Form11t

Font

Window

New Styl.!!.
•footer
•footnote reference
•footnote teHt
.,..•Norm111
•p11ge number

text vith
Style: I Titles
Normal+ font: Times 24 Point, Indent: Left 2 tn Rloht 2 tn
Centered Border: Top Bottom Left Rloht (Double Shedwed)

j B11sed on:INormlll

NeHt Style: lntles

Click on OK.

You are done defining the style.

X3

Move the cursor to the end of the document.

[cr] [cr]

Add two lines to the end of the document.

i

Move the cursor up one line, leaving a blank line at the
end of your work.

Old Style

Type the text Old Style.

Pull down the styles list at the le ft side
of the ruler line.

The Titles style now appears on the list of available
styles.

Select the Titles style.

You want to apply this style to the current paragraph of
your text.

Figure 7.79

The Titles style has been
selected.
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•

File Edit

Form11t F
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footnote text
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Release the mouse button.

Apply this style to the current paragraph.
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File
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Formet

Font

Document Utilities
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Window

Figure 7.80
The Titles style h as been
applied to the current
paragraph.

the typewriter mechanism to return to the beginning of
each line.

I

Old Style

xs

Save the changes you have made to the document before
continuing.

If you want to apply a sty le to several paragraphs or lines of the text , si mply select the
desired text before applying the style. You may also activate a style before you type. There is no
need lO wait until after typing to apply a style.
Remember, if you make a cha nge to the de finition of a style, that cha nge will e ffect all
segments of the document to which the sty le has been applied.

-

7 .16 USING GRAPHICS IMAGES IN YOUR DOCUMENT

Word, like many Macintosh application programs, is able to store information to the Scrapbook
file , and retrieve information from the Scrapbook fi le. The re trieved information may be eithe r
text or g raphic in nature. A sample sc rapbook file has been supplied with the text. To use th is
file , it must be in the system folder o n the start-up disk when you boot the computer. If you do
not have the supplied scrapbook in your syste m folder right now, you may also use the default
scrapbook supplied with your Macintosh.

WHAT

To Do

WHY

You ARE DOING

IT

34:3

Use the command key numeral 3 (on the number pad!) to
move the cursor to the end of the document. This should
be the blank line that you left when you added the title in
the prior section.

[cr] [cr] t

Add two more blank lines, then move the cursor up one
line.

Pull down the Apple menu at the left
side of the menu bar.

Remember that the Apple menu is the Desk Accessory,
or DA, menu. The sc rapbook is one of several DAs supplied by Apple with your computer.

263

264

CHAPTER SEVEN - ADVANCED WORD PROCESSING CONCEPTS

Select the Scrapbook DA and release the
mouse button.

Activate your computer's scrapbook. If you are using the
supplied scrapbook, the firs t entry is a drawing of a pencil. Th is is the picture you want to add to your document.
(If you are not using the supplied scrapbook, select any
graphic that appears in the scrapbook at this time.)

XC

Execute the Copy command fro m the Edit menu. This
will place a copy of the graphic into the Clipboard . As
long as you do not c ut or copy anything else, the graphic
will remain available in this buffer. You may check the
contents of the clipboard at any time by using the
Show Clipboard command found on the Window
menu.

Click on the close box on the scrapbook
title bar.

You are finished with the scrapbook for the time being.
Close the scrapbook to get it out of the way.

XV

Since you already placed the cursor at the end of the
document, you are ready to paste the graphic you have
selected into your work. The Paste command from the
Edit menu will insert the graphic into the text.

Figure 7 .81
The graphic is now a part
of the document.

r

C File Edit Formet Font Document Utilities Window

,

the typewriter mechanism to return to the beginning of
each line .

Old Style

Drag the scroll box in the right scroll
bar to the bottom of the scroll bar.

You want to size this graphic. To do so, you will want as
much of the window avai lable fo r working in as possible.

Place the !-beam pointer in the middle
of the graphic and click the mouse
bunon once.

By cl icking the !-beam pointer on the graphic, you are
selecting it. Note the three small black squares. These are
used for changing the size of the graphic space in the
document. They are called hand les, since they are used
to grab and manipulate the graphic.

Macintosh Productivity Tools

Place the mouse pointer on the handle
at the bottom right corner of the
graphic.

This handle will let you stretch or shrink the graphic both
wider and taller in equal proportions. The handle at the
right side will make the graphic wider, while the one on
the bottom will make the graphic taller.
Figure 7 .82
The mouse pointer is
positioned on the handle
at the lower right corner
of the graphic.

Press and hold the mouse button.

When you press the mouse button, the page indicator at
the bottom left of the window will read as a percent. This
represems how much you are making the graphic bigger
or smaller.

Drag the mouse down and to the right,
making the graphic larger. Do this until
the size indicator at the bottom left of
the window reads 200 %.

You are doubling the size of the graphic.

' It File Edit Format Font Document Utilities Window

L ______

,

Figure 7 .83
The new size of the
graphic will be ZOO % of
the original.
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Release the mouse button.

The graphic will now adjust itself to the new space you
have given it.

3€Z

The UNDO command . If you pull down the Ed it menu,
it reads "Undo resize picture ." You are returning the pictu re to its original size because you don' t want it to be at
200%.

Cl ick on the center text icon underneath
the 3 1/2 point on the ruler line .

This will center the graphic on the line.

.,

Figure 7 .84

The graphic has been
centered. You may also use
the right align text icon to
move the graphic to the
right side of the line.

3€S

Save the changes you have made to this document.

NOTE: YOU M UST HAVE A PRINTER ATTAC HED TO YOUR COMPUTER TO PERFORM
TH E NEXT STEP.
3€P

Execute the Print command from the File menu.

Click on the OK button

Execute the printing task . The final document wi ll look
similar to Figure 7.85.

If you decide that you do not want to include the g raph ic in your document , select it as you
would any other text, and de le te the selection with the backspace key or 3€X, the Cut comma nd.

-

7 .17 THE MAILING LIST

A feature of word processors is the ability to me rge a mailing list togethe r with a form letter for
mass mailing purposes. Word is capable of perfo rming this process.
To perform a merge with Wo rd you must create two documents . One docume nt is the
te mplate of the letter (or memo). It conta ins codes that direct Word whe re to place the names and
addresses, o r othe r info rmatio n, in the document.
The second file you must c reate contains the list of names and add resses, o r othe r information, to be inserted into the primary document.

Macintosh Productivity Tools

Figure 7 .85
The completed document.
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7 .18 CREATING THE MAILING LIST FILE

You will start this exercise by creating the list of names a nd addresses. Before you begin creating
this, it is advisable to close any documents you presently have ope n. Do this now by clicking the
mouse on the close box of each open document.
You will then enter a set of information about each person on the maili ng list. This set of
information is called a record. Each set is broke n into distinct parts, called fields. When you
create the lette r in the next section, you will be telling Word which field to put in specific
locations in the letter. After each letter is printed , a new record is read by the program and the
process is repeated.
The records you will be creating for this exercise wi ll conta in the following fields :
Last Name
First Name
Title
Street Address
City
State
Zip Code
Phone Number
Amount
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WHAT

To Do

WHY

You ARE DOING IT

Click on the current document's close
box.

Put away the document titled My First Document. If you
have not already saved it , you should do so now.

XN

Create a new, untitled document.

lastname,firstname ,title ,street,city,state,
zip,phone,amount [cr]

The first record of the mailing list is called the " Header
Record." It names the fields in the mai ling list so that the
merge program will be able to determine what is what
during the printing process.

Figure 7.86
The header record for the
mailing list.

li File Ed1t Format Font Document Utilities Window

r
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· ccc:-

.,

Untitled I

lastname,!lrst.uame,title,street,city,state,zlp,phone,amount

I

When you are entering the Header Record , be sure to use
all lowercase letters, separate the item names with commas , and complete the entry by pressing the Return key.
You are now ready to enter the mailing list.
Aaron,

Enter the last name of the first person on the mailing list ,
followed by a comma. Do NOT press [cr].

Alice,

Enter this person's first name, again followed by a
comma.

Ms.,

Enter this person's title, followed by a comma.

1405 N. Pepper Ave.,

Enter this person's street address.

Highland Park,

Enter this person's city name .

CA,

Ente r the state.

902 10,

Ente r the Zip code.

213-553- 1234,

Enter the phone number.

75.00 [cr]

Enter the amount and press the return key to indicate the
end of the information for this person.

Figure 7 .87
The first record has been
entered.

r

li File Edit Format Font Document Utilities Window

•

Untitled I

last.uame,!lrst.uame,title,street,city,state,zlp,phone,amount
AAron,Alice,Ms., l405 N. Pepper Ave..Highland Park,CA,90210,213553-1 234,75.00

I

-

.,

~

I
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Smith,Fredrick,Mr.,

Begin the second record.

" 1508 N. Barrington Ave., Apt. 4C" ,

Note that Mr. Smith's address contains a comma. To
include a comma inside a data item, the complete item
must be enclosed in quote marks. Be SURE to do so
here.

Los Angeles,CA,90046,

Continue the information for this record.
Enter just a comma at this point. There is no phone number available for Mr. Smith; however, a space must still
be reserved in the record for this field because the Merge
procedure expects to find the same number of fields in
every record of the mailing list you create.

100.00 [crJ

Enter the amount information for Mr. Smith, indicating
the end of the record with the return key.

Wholstein,John,Mr.,333 W. Broad Rd.,

Begin entering a third record into the mailing list.

Culver City,CA,90123,2 13-6028181,75.00 [cr]

Complete the third, and last, record. Remember to end
by pressing the return key.

xs

You must Save this document.

ClubList

Name the mailing list "ClubList". Before you click on
the Save button, make sure that the drive and folder
names displayed in the dialog box are the ones you want.
If not , make the necessary adjustments to ensure that this
document is saved onto your disk into the appropriate
folder.

Click on the Save button.

Complete the save process.

.,

li File Edit Format Font Document Utilities Wlnddw

r

Club List

1astname,11rstname,title,street,dty,stat.e,zip,phone,amount
Aaron.AUce.Ms., 1405 N. Pepper Ave.,Highland Park,CA,902 10,213553- 1234,75.00
Smith,Fredrick,Mr.; 1506 N. Barrington Ave., Apl 4C,Los
Ange1es,CA,90046u 100.00
Who1steln,John.Mr.•333 W. Broad Rd.,CUlver City,CA,90 123,2 13-6028161,75.00

Figure 7.88

The completed mailing list
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7 .19 CREATING THE MASTER DOCUMENT

To complete this exercise, you will create a short letter to be sent to the people in the mailing
list. Before you begin writing this new document, you may want to put away the c urrent document. Do this by clicking the mouse on the close box found at the left side of the ClubList title
bar.
As you are writing the letter, remember the fields you created and named in the header
record. In the letter, the fields must be referred to by these names, typed in lowercase just as
they were e ntered.
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CONTENTS

FIELD NAME

Last Name
First Name
Title
Street Address
City
State
Zip Code
Phone Number
Amount

lastnam e
firstname
title
street
city
sta te
zip
pho ne
am ount

WHAT

To Do

WHY

You ARE DOING IT

XN

Create a new document.

[OPTION]-\

Ho ld down the option key and press the backslash . You
will see < < appear in your document.

DATA ClubList

Type the word DATA followed by the name of the mailing
list file you created earlier, ClubList.

[OPTION]-[SHIFT]-\

Hold down the option key and the shift key and once
again press the backslash. You will see > > appear in the
document.

[cr]

Press the return key so that this line has no other text on
it.
You have just entered the command that links the letter
you are about to write to the mailing list you created earlier. This command MUST be at the very beginning of
the document. You may not even have a single blank line
in front of it! When the mailing list and letter are
merged , this line will not appear.

Figure 7.89
This is the beginning of
your letter. No other lines
or characters may be in
front o f this command
line, w hich links the letter
to t he mailing list.

a

r

File Edi t

Format Font

Document Utilities

Window

.,

Untltled2
«DATA ClubUst..

I

[cr] [cr] [cr] [cr]

Leave room fo r the letterhead at the top of the paper.

December 3 1, 1988 [cr][c r]

Enter the letter's date.

You w ill now create the inside address. Th is is done by te lling Wo rd to print particula r fields
fro m the Mai ling List File.
T he first line of the inside add ress should contain the title, fi rst na me and last name.
[OPTION]-\

Just as the DATA command is enclosed in the special
symbols < < and > >, so are the field names in the body
of the letter. This allows Word to d ifferentiate text that
you enter from a fie ld name.

Macintosh Productivity Tools

title

You want to start the inside address with the title field.
Remember to enter the field name in all lowercase letters, as you did when you created the header record for
the mailing list file.

[OPTION]-[SHIFT]-\

Finish the field entry in the document.

[SpaceBar]

Add a single space between this field and the next one. If
you do not do this, the two fields will be printed with no
spaces between them!

[OPTION]-\ firstname
[OPTION]-[SHIFT]-\

Enter the merge field name for the first name field.

[SpaceBar]

Again, add a single space to appear between the first and
last name fields.

[OPTION]-\ lastname
[OPTION]-[SHIFT]-\

Enter the merge field name for the last name field.

[cr]

Press return to move the cursor to the second line of the
inside address. This line will be just the street address
field.

[OPTION]-\ street
[OPTION]-[SHIFT]-\

Enter the merge field name for the street address field.

[cr]

Move the cursor on to the third and last line of the inside
address.

[OPTION]-\ city [OPTION]-[SHIFT]-\

Enter the merge field name for the city field.

, [SpaceBar]

Add a comma followed by a single space after the city
field.

[OPTION]-\ state [OPTION]-[SHIFT]-\

Enter the merge field name for the state field.

[SpaceBar]

Add a single space after the state field.

[OPTION]-\ zip [OPTION]-[SHIFT]-\

Enter the merge field name for the zip code field.

[cr] [cr]

Press the return key two times to add a blank line to separate the inside address from the beginning of the letter.

Dear [SpaceBar]

Begin the letter.

[OPTION]-\ firstname
[OPTION]-[SHIFT]-\

Enter the merge field name for the first name field. You
can see that you may use a field more than once inside
the document.

: [cr][cr]

Continue the letter.

Our records show that you donated $

Begin the first paragraph of the letter.

[OPTION]-\ amount
[OPTION]-[SHIFT]-\

Enter the merge field name for the amount field. Note
that you do not need to include in your letter all the fields
found in the mailing list file. The phone number field
will not be used in this letter.
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Finish the letter with the following text:
in 1988 to the Philosophy Club, a non-prof1t organization.
Thank you for your continued support. We hop e to see you at the f1rst club meeting in
January of next y ear .
Sincerely,
H. H. Wabb i t
Executive Director

Figure 7.90
The first half of the
completed master
document. Note the
appearance of the inside
address.

'

•

File

Edit

Format

Font

Document

Utilities

Window

,

«DATA Club List.,

December 3 1. 1988
«title» «firstname,, «lastname»
«Street.,
«<:lty», «State» «ZiP»
Dear «firstname,.:
OUr records show that you donated S«amounl» in 1986 to the
Philosophy Club, a non-profit organization.
Thank you !or your continued support. We hope to see you at the

XS

You must now save the letter.

ClubNote

Name this document ClubNote.

Click on the Save button.

Complete the save operation. Since, when you saved your
mailing list, you confi rmed the location that the file was
to be saved, you do not have to do so a second time.
Word will save this document at the same location as the
last save you execute. Do not close this letter.

-

7 .20 MERGING THE LETTER AND MAILING LIST

You a re now ready to merge the letter and the mailing list. Before you continue, make sure that
the master letter is in the active window . If yuu did not prope rly c reate the mailing list fi le , Word
will give you an error message. If this happens, do not worry, simply check your mailing list and
make sure that each line has the correct data a nd the correct numbe r of commas before you
continue.

WHAT

To Do

W HY

You ARE

DOING

lr

Pull down the File menu.

This menu contains the Print Merge command.

Select the Print Merge command and
release the mouse button.

The print merge dialog box lets you choose between
printing the merged documents immediately, or creating
a new document.

Macintosh Productivity Tools

Click on the New Document button.

Edit

Form11t Font

This option will let you create a new document, called
Form Letters I , which you can then edit as you would any
other Word document.

Document

Utilities Window

,

Figure 7.91
The Print Merge dialog
box.

«DATA Oublisb

OUr records show that you donated Seamount» in 1966 to the

Philosophy Club, a non-profit organization.

If you have an exceptionally large mailing list, or a
med ium sized list and large document , you may not be
able to merge to a new document because of the computer 's memory limitations. If you are merging a document and run out of memory, then you should merge
directly to the printer.
After you click on New Document, the merge process
will begin . Since you are merging a short list, this process should not take very long.
When the merge process has finished , the cursor will be at the beginning of the fi rst
document c reated. You a re now looking at the individual lette r to M s. Alice Aa ron. Word placed
section breaks between each of the three letters.

'

•

File

Edit Form11t

Font

Document Utilities

Window

December 31. 1968

Ms. Alice Aaron
1405 N. Pepper Ave.
Highland Park. CA 90210
Dear Alice:

I

Our records show that you donated $75.00 In 1968 to the Philosophy
Club, a non-profit organization.

,

Figure 7 .92
The merged document.
The section break, a
double dotted line, can be
seen in the next figure.
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Figure 7.93

If you scroll the window,

you can see the section
break, the double dotted
line, which separates two
letters in the merged
document.

r

•

File

Edit

--====-----

Form11t

Font

----- ---=-=-------

Document Utilities

Window

.,

-

Sincerely,

H. H. Wabbit

Executive Director

December 31, 1966
Mr. Fredric)( Smith
1508 N. Barrington Ave., Apl 4C
Los Angeles, CA 90046

Use the cursor movement keys and scroll ba r to look through this document. You will see
that you have created a standard Word document. If you want, you may edit the text, add
pe rsonal notes or othe r info rmation to each of the lette rs, or in some other way edit the three
letters. Merged documents may be printed immediately, saved for later modification and print ing
or simply discarded, depending on your needs.

xs

You want to save the letters for later printing.

Merged Leuer

Name this document Merged Letter.

Click on the Save button.

Execute the Save command .

XQ

Execute the Quit command . Click on the Yes button if
you a re asked to save changes to a document before the
program ends.
After some disk activity, you will be returned to the Macintosh desktop and the Finder.

EXERCISES
1.
2.
3.
4.
5.
6.

What happens when you execute a change command that does not happen whe n you execute a find command?
Explain the difference between footnotes a nd e ndnotes.
Does the text of footnotes appea r at the bottom of pages as you edit the document?
Is it possible to edit a footnote if you find an error, or must it be dele ted from the document and totally recreated?
What happens if you add a new footnote to your document in front of a n existing footnote?
If you activate the paragraph borders, then edit the text by changing the fo nt size, or deleting a word , what happe ns to the
box?
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7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.

Is text centered between the left and right sides of the paper, or between the left and right margins?
Must text be centered after it is entered, or can it be centered as it is typed?
What are the default tab stop positions?
What must you do to the left margin to create a hanging indent?
What is the advantage of using a hanging indent over the tab key or spacebar to create the same effect?
What do you insert into the text to force a page break at a particular location in the document?
Can a forced page break be removed, or relocated, or once in the document must it remain always?
When you activate the page numbering, where will the page number appear on the printed page?
What is a running header?
What will appear on the computer's screen to inform you that a page break has been reached?
How can you tell a hard page break from a soft page break?
When preparing a bulk mailing you must create a mailing list and a form letter. What must be entered into the form letter
to link it to the mailing list?
19. What must be at the beginning of the mailing list file to tell Word how to treat the information in the file?
20. What do the terms record and field mean when applied to a mailing list file?
21. Use Word to enter and print the following letter:
June 12, 1982
Mr. Fred Jones
Sales Manager
Gizmos and Gadgets, Inc.
137 West Main St.
Los Angeles, CA 90005
Fred:
Thanks one more time for expediting the last shipment of Super Whatzits. They were the hit of the Homeowner's Gadget
Show.
I'll be in touch.
Sincerely,
Tom Hillski
Distribution Manager
This and That, Ltd.
22. Use Word to enter and print the following memo:
TO:

Harold Stein, Telecommunications

FROM:

George Graham, Data Processing

DATE:

November 14, 1983

SUBJECT: Phone Installation
Alex Jones in Market Research and Mary Anne Peters in Administration have each received personal computers. Their
machines are equipped with internal modems to allow them to communicate with the company mainframe. Please contact
them both to arrange installation of dedicated phone lines in their respective offices.
Thanks.
23. Put the following footer onto the memo created for Problem 22 and reprint the memo:
Filing Code For This Memo: 14983
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24. Use Word to create and print a simple invoice.

I INVOICE I
Invoice Number 87.458
Date April 23, 1987
TO:

Mr. & Mrs. John Doe
135 Any Sreet
Big Rock, CA 90068

FOR:
1986 Federal Income Tax preparation
1986 State Income Tax preparation
W -4 withholding computation service
1987 Tax Planning

$225.00
100.00
50.00
50.00

TOTAL

$425.00

25. Use Word to create a mailing list file for the following people:
Mary Alice Jones
1458 Barton Ave.
West Orange, NJ 07444
Lasagna

Fredrick Smyth
1212 E. Smitty St.
East Orange, NJ 27455
Fried Chicken

John Bigelowe
77 Live Oak Ln.
Cherry Hills, NJ 07453
Salad

Maureen Dietmann
329 S. Holland Ave.
Foggy Hills, NJ 07431
Soft Drinks

26. Use Word to create the following letter template:
June 28, 1989
<<full name>>
<<street>>
<<city>>, <<state>>, <<zip>>
Dear < < firstname > > :
This is just a short note to remind you that the July meeting of the Bridge Club will be held starting at 12:00 noon on the
18th. Be sure to bring food for the pot luck lunch. My notes of the last meeting have you planning to bring <<food>>.
I'm looking forward to seeing you,
Albert P. Smart
27. Merge the mailing list created in Problem 25 and the letter created in Problem 26 into one document and print it.

CHAPTER

DESKTOP PUBLISHING
WITH MS-WORD

-

CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:

• Define the term Desktop Publishing.
• Follow the planning steps required for desktop
publishing:
ldentify the audience of the publication.
Identify the topic of the publication.
Identify the equipment available for producing
the publication.
• Explain the difference between a serif and sans
serif font and about the different groups of
typefaces.

• Identify the proper typefaces for use with the
publication, both for the body of the
publication and for headlines.
• Explain the fundamental concepts of page
formatting and design.
• Use the side-by-side table capabilities of Word
to create a masthead.
• Create newspaper style multiple-column
documents.
• Reposition art and paragraphs on the page.

-

8.1 WHAT IS DESKTOP PUBLISHING'?

Desktop publishing, simply put, is the creation of a document using the resources of your
desktop computer. People typically think of newsletters and small magazines when desktop
publishing is discussed. However, other documents may be desktop published. You may desktop
publish a resume , a series of graphics, advertisements , reports and more.
In this chapter, you will use the skills you have developed with Microsoft Word to create a
newsletter for the Miniville Corporation. All the stories are written, and all the necessary
artwork is ready; all you will have to do is put them together into a single document and format
the whole thing. You will , however, have to create the newsletter masthead by yourself.
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8 .2 PLANNING-THE FIRST STEP

Just like a ny other document you may want to prepare, you must do a signi ficant amount of
planning before sitting down to the computer to publish. There are several steps in the planning
process. They a re to identify the audience, identify the topic, and identi fy your ha rdware.

8 .3 IDENTIFY YOUR AUDIENCE

When you identify your audience, you are determining who will read the publication. Why do
you want to do this? Different groups of people will expect different designs a nd "looks" of the
document. The best way to do this is to imagine the one person who represents the group for
whom the document is being created . This stereotypical person may be a completely imaginary
person, or may be a real person whom you know.
When determining who your stereotyped reader is, conside r the person 's background, education and age. A publication for an older reader may require larger type to compensate for
vision c hanges. One for a high school reader may require changes in vocabulary.
The audience for the newsletter you are creating in this chapter are the employees of
Miniville Corporation. They range in age from recent high school graduates to people nearing
retire ment age. The education levels of the employees are as diverse as their ages, ranging from
high school to PhD.

-

8 .4 IDENTIFY THE TOPIC

Figure 8 .1
NEW- Portable Hard Dr1ve

20MilymS475
40 MDyus S805

ABC Computing
1354 So. 57th Ave.
Eastonvllle, New Jersey
(201) 555- 3456

When you are identifying the topic, you are determining what the information is that you are trying to convey. This may seem obvious, but it affects choice of
graphics and their placement, headlines a nd overall
layout of the publication.
Consider, for example, a one-page advertising
flyer for a portable hard disk. You may be tempted to
include a graphic of the hard disk sitting next to a
desktop computer. The focus of such a graphic is the
computer (Figure 8. 1), which is not the topic! A better
gra phic is one showing the portable hard disk, with the
computer in the background (Figure 8.2). T he focus is
shifted to the ha rd disk, but you retain the association
with computing .
The Miniville newsletter is a publication designed
to keep the employees current with what is happeni ng
to people within the company, and new events in the
company itself.
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Figure 8.2

NEW!
Portable Hard Drive

20 MBytes $4 75
40 MBytes $805

ABC~ltlng

1354 So. 57th Ave.
Eastonvllle, New Jersey
(201) 555·3456

-

8.5 IDENTIFY YOUR EQUIPMENT

Since you are reading this text, it is fairly likely that you will be using a Macintosh computer for
your desktop publishing. More important, however, than the type of computer you are using is
the type of output you can produce. Do you have only a dot-matrix printer such as an ImageWriter which produces output at 72 dots per inch, or can you produce output on a laser printer at
300 dots per inch? Do you have access to a high resolution typesetting machine, such as a
Linotronic or Compugraphic, capable of producing output in the range of 1200 to 2400 dots per
inch, compared to the LaserWriter's 300 dots per inch? The more dots per inch, the bette r the
appearance of the document.
While spe nding the money fo r laser output is probably worth while, it may not be necessary
to spend $ 12 to $30 per page (plus a job set-up fee) for high resolution output for this publication. Laser output can usually be had for pennies a page!

-

8 .6 PICK A TYPEFACE
Now that you have identified the reader, topic and output device, you are ready to make some
design decisions. The first of these involves the typeface. The typeface is what the letters look
like on the printed page. Combine looks (or style) with size a nd you have a type font.
There a re two typeface decisions you must make. You must choose a typeface for the body
of the document. The body is all the text of the various stories. It is possible to c hoose a diffe rent
typeface for each story, but this is not a good idea. You may want to change the typeface for a
particular story to make it stand out in the publication.
The second typeface decision is for headlines, subheadings and the like. That is, what
typeface should you use fo r the parts of the publication that are not the body?
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One major fac tor affecting the typefaces that you use is the output device. Recall the discussion of bit-mapped and lase r fonts and outline sizes in Chapter 4. If you are using a laser printe r,
it is best to stick with laser fonts. Then, even though you may not have an outline size of a
pa nicular typeface, it will still produce a neat output. It is even possible to create a size th at does
not normally exist, such as 27 point. If you are outputti ng to an ImageWriter, you will be using
bit-mapped fonts. In this case, you should use only fon t sizes for which an outline size exists.
Using a non-outline size produces poor-looking text which may be diffic ult to read.
Basically, using dot-matri x output imposes some severe limitations on the desktop publishing process in terms of the flexibility of type sizes. You do, however, have access to a large
number of bit-mapped fonts. Using a laser printer generally g ives you more flexibility with type
sizes, and produces a cleaner looking final output.
The other distinction between typefaces are those which fall into the class of sans seri f fonts,
a nd those that are serif fo nts.

-

8 .7 SERIF VERSUS SANS SERIF
The serif is the small c ross stroke that appears on the a rms of cenain letters. They improve the
legibility of the letters, and make it easier for your eye when reading the document , helping to
guide your eye over the letters.

Figure 8 .3
The W on the left is from a
font which has serifs. The
serifs help guide the eye
over the text. The Won
the right is from a sans
serif font. It has a more
stark appearance.

ww

Serifs also help you distinguish one lette r from another. An example is the word Illinois,
seen in Figure 8.4 . The sans serif version on the left does not have in it the visual clues to help
d istinguish the capital lette r I from the lowercase letter I. As you can see, a sans serif fo nt does
not have the extra strokes of the serif font.

Figure 8 .4
The wo rd Illinois is an
example of how serifs help
in letter recognition.

-

Illinois Illinois

8.8 GROUPS OF TYPEFACES
Today, it is possible to add some fu rther distinction to the groups of typefaces. Typographers
argue about the actual number of groups of typefaces. He re we wi ll discuss five g roups, sometimes called races or species.
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The first group is called roman. The majority of serif type styles fall into this race. Another
characteristic of the roman typefaces is that the vertical stroke of the letter is generally heavie r
than the horizontal stroke. Figure 8.5 shows the letters E and 0 in a typical roman typeface,
Times. You can easily see that the vertical part of each letter is heavier than the horizontal part.
Times, Bookman , Schoolbook and Palatino are all members of the roman group of typefaces.
More will be said about these typefaces later in this chapter.
Figure 8.5

EO

This is an example of
typical members of the
roman group of typefaces.

The second group of typefaces is the sans serif group. These typefaces have a more modern
appearance a nd reproduce well even in poor printing conditions . Figure 8.6 shows the lette rs E
and 0 in a typical sans seri f font , Helvetica. Avant Garde, Helvetica and New Helvetica Narrow
a re all members of the sans serif g roup of typefaces.
Figure 8 .6

EO

This is an example of
typical members of the
sans serif group of
typefaces.

The square serif group is the third group of typefaces. As the name suggests, the serifs of
this group of typefaces are squared, rathe r than rounded . An approximation of this font is
Bookman Bold , shown in Figure 8.7.
Figure 8.7

WE

The serifs of the Bookman
Bold font are heavier than
those of the serifs found
on fonts of the roman
group of typefaces.

Script, or cursive, style fonts make up the fourth group of typefaces. These are differe nt
from italics typefaces. The purpose of one of these fonts is to appear close to handwriting or
calligraphy. An example of this font is Zaph Chancery, seen in Figure 8.8.
Figure 8 .8
The Zaph Chancery font
looks similar to calligraphy.
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The fifth group of typefaces is called special. It is a catchall group. There are many typefaces that fall into this group, but the majority are bit-mapped fonts. Figure 8.9 shows examples
of some of this group of typefaces.
Figure 8 .9
The majority of special
fonts are bit-mapped. The
Sy mbol and Zapf Dingbats
fonts are exceptions, and
are available as laser fon ts.

This is scan
Symbol

a.~x8c¢Y
ABX~E<Dr
Zapl Dmgbals ·

OO***~I;~l~

¢+++·:·+ <¢-
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8 .9 TYPEFACE FAMILIES
In add ition to groups, or races, of typefaces, there are families of typefaces. A family of typefaces is made up of several typefaces that share the same basic typeface. For example, the Times
typeface fam ily consists of Times Roman, Times Italic, Times Bold, Times Bold Italic, Times
Outline and Times Shadow. Many people tend to think of these as variations on a single typeface, whereas in fact each is a separate and distinct typeface.

-

8 .10 TYPEFACES FOR THE PUBLICATION

T he selection of a typeface is controlled by the purpose of the publication and the audience. If
you are publishing an invitation, you might want to use a script or cursive typeface. If you are
publishing a book for a fi rst grade class, then Bookman is the appropriate font.
The majority of your publications, however, will probably be newsletters. As a general rule,
you should use a se ri f fo nt for the body of this type of publication. You can see that this type of
font improves the readability and appearance of the document. There are times, however, when a
serif font is not appropriate. When the type size is very small, unde r 8 points, serifs tend to
blend into the letters, offering litt le to the appearance of the text. A sans serif font is better in
these cases.
The serif fonts you are most likely to have access to are New York, Times, Bookman ,
Schoolbook a nd Palatino. New York is a bit-map font best used with the ImageWriter dot-matrix
printer.
The shape of the letters of the Times font is virtually the same as the New York font. Times,
however, is designed for laser printers. It is a slightly more compact font. Figure 8.10 shows text
in both these fonts at 24 points, an outline size for each. You can see that the text in the New
York font takes slightly more space on the line than the text set in the Times font.
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The small brown fox jumps
quickly over the lazy dog.
The small brown fox jumps quickly over
the lazy dog.

Figure 8 .10
The top line of text is set
in New York 24 point,
while the bottom line is
Times 24 point.

In fact , the Times font is a very compact font. It uses smaller serifs and narrower horizontal
strokes than other fonts in this group that have been mentioned. Compare the letters in Figu re
8.11. The ones on the top a re in the Times font , the ones on the bottom in the Bookman font.
Note how thin the upper portion of the letter k is in the Times font , compared to the Bookman
font. Also, you can see that the serifs are much less pronounced in the Times font than the
Bookman font. The goal of the Times font is to minimize the space requirements without
sacrificing overall readability. It was designed for newspaper applications, in which space is at a
premium, but readability is still necessary.

klmnoxyz

k l mnoxyz

Figure 8 .11
Compare the size of the
Times characters with the
size of the Bookman
characters.

The Bookman font is a very round font. The font also blends its serifs into the lette rs, rathe r
than attaching them. This can be seen in Figure 8.12, which shows the letter Din the Bookman
font on the left, and the same letter in the Schoolbook font on the right. Notice how the serif on
the Bookman font flows into the letter, while the Schoolbook serif appears to be attached. The
Bookman font is easy to read since it is not very compact. It produces documents that have a first
grade schoolbook appearance. It is a font that is good for publications produced for early, or
inexperienced readers.

DD

Figure 8 .12
The Bookman serifs flow
into the letters, while the
Schoolbook serifs appear
to abutt the letters.

The Schoolbook font is not as round as the Bookman font , but not as compressed as the
Times font. Look at the examples in Figure 8. 13. The word on the bottom is set in the Bookman
font, while the same word in the middle is set in the Schoolbook font. The top line is set in the
Times font. When using the Schoolbook font, more text can be fit into the same space than when
the Bookman fo nt is used . This font is better for the more experienced reader.

Typesetting

Typesetting
Typesetting

Figure 8 .13
The Schoolbook font, in
the middle, is not as round
as the Bookman font on
the bottom, but is not as
compressed as the Times
font on the top.
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The fi nal popula r typeface is Palatino. This font has a personality of its own. Compa re the
Palatino letters on the top of Figure 8. 14 with those of the Ti mes font. Even with its own
personality, this font is not so d iffe rent that it distracts from the text, making it hard to read .
Figure 8 .14

yp
~

The Palatino letters on the
top exhibit a personality
all their own.

yp
Remembe r, selecting the appropriate typeface is affected by the audience of the publication
and the purpose of the publ ication. Once you select a typeface, you should stick to it. For a
newsletter, such as the Miniville Corporation newsletter, the Times font, or one very muc h like
it, is the most appropriate selection.

-

8 .11 TYPEFACES FOR HEADLINES
Typefaces in parts of the publication other than the body of the text a re frequently referred to as
display type. T here are some simple rules for deciding which typeface to use for headlines. They
are:
• Never mix type fonts from the same typeface group. For example, Times a nd Schoolbook
a re in the same group, and should not appear together.
• Never use a typeface fa mily for more than one pu rpose. For example, you may want to
use a sans serif family for the headlines and subheads and a roman typeface family for the
text.
• Allow one typeface fa mily to dominate the publication.
With these rules in mind, and since the Times font has been selected to be used in the body
of the publication, Helvetica will be used for the headlines and subheads in the Miniville Corporation newsletter.

-

8 .12 DESIGN THE FORMAT OF THE TEXT

There are several issues that affect the design of the text. Two of these a re not controllable in
Word, but are in a page layout program. The fi rst is leading (pronounced ledding) and the second
is ke rning.
Leading is the amount of space between lines of text. When using Word you will fi nd that as
the size of the font increases, the amount of leading increases. In multiline headlines this is not
always desirable. We have nominal control over leading through the use of the Paragraph options.
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Figure 8.15 shows the effect of varying the leading of a document. This figure was produced
with a page layout program which allows this type of control with greater precision than is
possible with Word.
The Preamble to the Constitution of
the United States: We the People of
the United States, in Order to form
a more perfect Union, establish Juslice, insure domestic Tranquility,
provide for the common defence,
promote the general Welfare, and
secure the Blessings of Liberty to
ourselves and our Posterity, do
ordain and establish this
Constitution for the United States
of America.

The Preamble to the Constitution of
the United States: We the People of
the United States, in Order to form
a more perfect Union, establish Justice, insure domestic Tranquility,

Figure 8 .15
The leading of the
paragraph on the left is
standard, while this same
paragraph on the right has
extra leading, increasing
the space between the
lines of the text.

provide for the common defence,
promote the general Welfare, and
secure the Blessings of Liberty to
ourselves and our Posterity, do
ordain and establish this
Constitution for the United States
of America.

Kerning is control over spacing between pairs of letters. If you look at the printed page
produced by Word you will see that the letters do not overlap. It is possible to draw a vertical line
between any two letters on the printed page without touching either. For most letter pairs this is
satisfactory. Sometimes, however, a letter pair would look better if the spacing between the two
letters was reduced so that one letter overhangs its neighbor. An example is the word "we" when
it appears at the beginning of a sentence. In this case, the "w" is capitalized, leaving a large
amount of white space under the right edge of the letter before the letter "e" appears. Figure
8.16 shows you how "We" appears when printed by Word. By adjusting the kerning between
these two letters, Figure 8.17 was produced. Again, like figure 8.15, this figure was produced
by a page layout program designed to properly kern pairs of letters such as "We."

We

We

Figure 8.16
This text, printed in 48
point Times, was created
by Word.

Figure 8 .17
This text, like Figure 8. 16,
is 48 point Times. It was
produced by a page layout
program.
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You do have control over the columns that you choose to c reate. You can control the width of
the columns and the space between them . The rule of thumb for column width is that it should
be about I .5 lowercase alphabets of the typeface and size in use. A 1.5 lowercase alphabet is
abcdefghijklmnopqrstuvwxyzabcdefghijklm. Figure 8. 18 shows two sample columns , each a
different width, but each of a different type size, a nd each equally readable. Both are in the
Times typeface.
Figure 8.18
The two paragraphs are
the same, but the column
width has been changed
to reflect the change in
size of the typeface.

The Preamble to the Constitution of the
United States: We the People of the
United States, in Order to form a more
perfect Union, establish Justice, insure
domestic Tranquility, provide for the
common defence, promote the general
Welfare, and secure the Blessings of
Liberty to ourselves and our Posterity, do
ordain and establish this Constitution for
the United States of America.

The Preamble to the Constitution of the
United States: We the People of the
United States, in Order to form a more
perfect Union, establish Justice, insure
domestic Tranquility, provide for the
common defence, promote the general
Welfare, and secure the Blessings of
Liberty to ourselves and our Posterity, do
ordain and establish this Constitution for
the United States of America.
You can see in Figure 8. 19 that the preferred column width changes depending on the
typeface and size in use. The most appropriate column width for Times 10 is about 2.5 inches,
while Schoolbook 10 and Bookma n 10 should be in 3-inch wide columns.
Figure 8.19
As the typeface changes,
so does the ideal column
width.

11
2
3
4
LO
abcdcfghijklmnopqrstuvwxyzabcdcf hijklm
abcdcfghijklmnopqrstuvwxyzabc efghijklm
abcdefghijklmnopqrstuvwxyz bcdefghijklm
abcdefghijklmnopqrstuvwx zabcdefghij~ lm
abcdefghijklrnnopqrstuvv xyzabcdefgl ijklm
11
2
10
3
4
abcdefghijklmnopqrstuvwxy abcdefghijklrr
abcdefghij klmnopqrs tuvwx zabcdefghijk m
abcdefghijklmnopqrstuv xyzabcdefg ijklm
abcdefghijklmnopqrstu wxyzabcde ghijklm
abcdefghijklmnopqrs uvwxyzab< defghijklm
10
11
2
3
4
abcdefgh ljklmnopqrsluVWX) .abcdefghljkl n
abcdefghljklmnopqrstuvw >eyzabcdefghl klm
abcdefghijklmnopqrstu wxyzabcde ghijklm
abcdefg hijklmnopqrst vwxyzabc< efghijklm
a b cdefghijklmnopqr tuvwxyza cdefghijkJ m
10
11
12
3
4

15

Times
Times
Times
Times
Times
15

Schoolbook
Schoolbook
Schoolbook
Schoolbook
Schoolbook

I

16

J

16

I

16

I

I0
I1
12
13
I4

15

Bookman
Bookman
Bookman
Bookman
Bookman
15

!6

IO
II
12
I3
I4

10
11
12
13
14
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It must be emphasized that this width is only an approximation. The column may be up to a
third of an inch narrower or wider than the 1.5 alphabets size and still be a good fit for the
typeface you are using. We will be using the Times font in a 12-point size. You can see from
Figure 8.19 that a column width of about 3 inches is required.
In addition to controlling column width, you may control the space between the columns.
The minimum amount of space needed to separate columns in any publication is one-sixth of an
inch. To a typographer, this amount of space is a pica. For a typical two-column newsletter such
as you are creating, two picas (about 113 inch) is commonly used to separate the columns.

-

8 .13 PAGE DESIGN

There are several important concerns which must be addressed as you complete the design of the
Miniville Corporate newsletter. Not all of these concepts may be implemented using Word. Page
layout programs are much better for doing page design. However, we do have control over a
couple elements of page design when using Word .
The first of the page design elements that can be controlled is margins. Margins should not
be equal all the way around the text. This creates monotony. If you are creating a facing page
publication, such as a four-page newsletter, then the inside margin should be the smallest. The
margins should then get progressively larger, starting with the top margin, followed by the side
margin and then the bottom margin, which should be the largest. For a single sided or front and
back newsletter, the left and right margins should be equal, but the top margin should be smaller
than the bottom margin.
Figure 8 .20
The layout on the left has
margins that are
appropriate for a single
page publication. The
layout on the right uses
margins that progressively
get larger and works for a
publication that will have
facing pages.

Related to margins is the concept of white space. Margins are one form of white space. It is
desirable to have other areas of white space to add proportion to the page and to help organize
the overall arrangement. Do not consider white space to be " leftover" and a waste. In short, do
not try to fill all available space. Word gives you control over the publication's margins, and
some control over white space.
The next important concept of page design is balance. This is an easy concept to understand. A page has an optical center that is about three-eighths from the top. The weight of all the
elements on the page should balance around this optical center. A balanced page gives the reader
a good feeling, while an unbalanced page will make the reader feel uncomfortable . When
dealing with a two page layout, balance may be achieved by considering the two pages as one.
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A page may be symmetrical, or formally balanced. Invitations and graduation announcements typically are balanced in this fashion. Non-symmetrical balance may be achieved by using
dark objects to balance larger paragraphs. A page will either feel balanced to you, or it will not.
Figure 8.21

This page is symmetrical
and in balance.

Mr.

Mrs. Jolin flJoe
request tlie
pfeasure of your
attentfance
at tlie
'WetUing of tlieir flJaugliter
&

Mary !4.nne flJoe
to
Mr. :J-{erman Latimer Smitli
Suntfa.y, !4.ugust 20, 1989
at 2:00 rp),{

The fi nal page design concept to consider here is that of unity. This has been touched on
indirectly in the discussion of typefaces. If you feel the need to change the typeface on a page, be
sure to change to a different typeface group, and select one that compliments the predominant
typeface on the page. Remember, two different typefaces in the same group on a page can give
the reader an uneasy feeling. There are other types of unity, such as unity of shape and tone.
These two items require, more than anything, that you be aware of what you are creating and
maintain a compatibility among the design elements. For example, don't put a round corner box
around a very angular illustration.

-

8 .14 ILLUSTRATIONS

There are many things that are called illustrations. An illustration may be a photograph or a
drawing. Drawings may have shades of gray, or they may be simple line art.
There are several ways that artwork can be created to insert into your publication. The work
you create with a painting or drawing program is easily pasted into either the clipboard or
scrapbook, and from either of these locations into you r publication. Drawings and photographs
may be scanned, and also placed in either the clipboard or scrapbook.
Unfortunately, because creating and inserting graphics into a publication is so easy, these
items can be used inappropriately. Artwork should not distract from the text of the publication,
but rather enhance it. Don't use graphics or artwork to fi ll white space. Use g raphic elements
only after you have considered what you gain by placing it on the page. Be sure that a graphic is
not distracting or superfl uous.
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Figure 8.22
This is an example of
typical line art.

Using scanned photographs poses an additional set of problems. Most printers, including the
300 dot per inch lasers, are not able to produce high quality images, regardless of the quality of
the scanned image. Page layout programs are better equipped to print high resolution scanned
images, but even they leave something to be desired. If possible, have photographs prepared
separately from the publication and paste an image into the final version before it goes to the
printer. Even better, leave a blank spot on the page for the photograph and send the original
photo to the printer with your master publication . Give the printer instructions about which
portion of the picture to print, called cropping, and where in the publication it is to appear.
Leave the rest to your print shop.

-

8 .15 YOUR OWN PUBLICATION

You are now ready to put together a publ ication. As mentioned at the beginning of the chapter,
you are going to assemble a newsletter for the Miniville Corporation. All of the stories have been
written and can be found in the Miniville folder on your data disk. The artwork that is to be
included consists of a scanned photograph and a line art item. Word can retrieve graphic images
only from the clipboard. Consequently, the graphic items may be found in the scrapbook file ,
also on your data disk. Before starting Word, move the scrapbook into the System Folder on your
boot disk so that the Scrapbook Desk Accessory will be able to locate it.
Start your computer as you did at the beginning of the prior chapters. After you boot your
Macintosh with a System Start-Up disk, make sure that you have the Word Program disk at hand.
If you are using a machine with a hard disk you will not need to insert the Word program disk
into a disk drive. Rather, locate the Word 4.0 folder, and open it so you can see the Word
program icon. If you have two disk drives on your computer, or a hard disk and a floppy disk
drive, place the disk that you used while working in Chapter 7 into an empty disk drive. If you
do not have a free floppy disk drive, keep this disk available. You will need it.
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Just as in the prior chapter, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g . , X X) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer to the specified item and click the mouse button two times fast. The
word "drag" means to select an item, be it an icon or the menu selection bar, and move the
mouse while the mouse button is pressed. Finally, remember that several keys on the number
pad perform cursor movement functions. When you see an instruction to move the cursor, be
sure to use the numerals found on the number pad at the right of the keyboard, and not the
numerals at the top of the keyboard!

WHAT

To Do

WHY

You ARE DotNG

IT

Locate the icon for the Word program.

You will launch the Word application program by doublecliclcing on it.

Move the mouse to the Word icon and
double-click.

The double-click will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu, or press XO, the command key
equivalent.
After a brief wait, Word will be running, and you will
have a new, untitled document displayed in the window.

XR

Thrn on the ruler line. Much of what you will be doing

involves the ruler line.

1 option. This will let you see the location of the table you will be creating for the masthead.

XY

Figure 8 . 23

Your starting screen.

Thrn on the Show

'

•

Pull down the Format menu.

File

Edit

Formet

Font

Document

Utilities Window

Before you begin, you are going to change the top
margin.

.,
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Select the Document command.

The document dialog box contains the margin options.
When the dialog box opens, the top margin option is
already selected for you.

.75

Change the top margin to .75, or three quarters of an
inch.
Figure 8 .24
The top margin has been
changed.

Document

I

~Left:
Bottom: ~ Right:

Margins: Top:

OK

I

[cancel)

0
0

Mirror Euen/ Odd Margins 181 Widow Control [set Default)
Euen/Odd Headers
Footnotes
Gutter:
.-I- - - . .
Position:
Bottom of Page
Number Pages From:

11

Number Lines From:
Default Tab Stops:
(

NeHt File...

:===~

I•
I:====:
O.Sin

I

Number From:

0

I•

121

Restart Each Page

I

J

Click on the OK button.

Leave the dialog box.

-

8 .16 THE NEWSLETTER MASTHEAD
The masthead is the title of the publication that is displayed across the top of the first page. The
masthead you will create will include a graphic, in addition to the title of the publication. To
create the masthead , you will create a two-column table. In one cell you will paste the graphic,
and in the other you will type the desired text.
If you do not see the table gridJines whe n you insert the masthead, select preferences, found
on the Edit menu, and click on the Show Table Gridlines box.

W HAT

TO Do

Pull down the Document menu and
select Insert Table.

WHY

You ARE

DOING IT

This command will insert a blank table into the document
at the location of the cursor.
Figure 8 .25
The Insert Table command
has been selected.
Footnote...
Repaglnate Now

XE
XJ

outlining
Page Ulew

XU
XB
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Release the mouse button.

Execute the command. After a brief pause, the Insert
Table dialog box will appear (Figure 8.26).

Figure 8.26

Insert Tllble

The Insert Table dialog
box.

I'

Column Width:
ConiJert From

0

Paragr·aph~

Olab

Click on the OK button.

Figure 8.27

The empty table. Notice
that the right margin
indicator is at the 2 7/8
point. This is the right
margin for the left cell of
the table.

I
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Number of Rows:
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-------===:::;
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0

~ill!.'

b!J Side Only

You do not want to make any changes to the information
in this dialog box. Click the OK button to continue. The
empty table wiJl be displayed.

•

File
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Tables of this sort may be used fo r columns of numbers,
or for placing paragraphs side by side. You are going to
do the latter here, except the left side paragraph will consist of just a graphic. The right side paragraph will consist of text.
Pull down the Apple menu and select
the Scrapbook DA, then release the
mouse button.

This Desk Accessory will let you copy a graphic from the
scrapbook file into the clipboard. Once the graphic is in
the clipboard, it may be pasted into the Word document.
Click on the scroll bar at the bottom of the Scrapbook
window until the line art drawing of an old fash ioned
printing press appears (Figure 8.28).

Figure 8.28

This is the graphic that you
want to place into the
masthead.

Scr11pbook

ill

C

2 /4

D_

I
ePIC, PICT
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XC

Use the Command Key to execute the Copy command
found on the Edit menu. T his will place a copy of the
graphic onto the clipboard.

Click on the close box on the Scrapbook's title bar.

Put away the scrapbook.
The cursor should still be inside the left side box of the
table that you placed at the beginning of the publication.
If not, make sure that it is there before you continue.

XV

Use the Paste command to place a copy of the contents of
the clipboard, which should be the graphic, into the
document at the current cursor location.
Move the cursor to the right side cell of the masthead
table.

r

It File Edit Format Font Document Utilities Window

.,

Figure 8.29
You have the graphic
placed into the masthead,
and are now ready to
enter the text. Notice that
the ruler line now shows a
new line length based on
the left and right margin
of the current cell of the
table.

Hot Off [cr] The Press [cr]

Type the name of the newsletter.

Use the cursor keys to select just the
title you have entered.

You are now going to change the typeface and size of the
newsletter title. Remember, to change the font of some
text requires that the text be selected.
Figure 8 .30
The selected text is ready
for a font change.
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Pull down the Format menu and select
the Character option.

You are going to change the typeface. Rather than pulling
down the font menu to change the font , then pulling down
the fo nt again to change the type size, and finally pulling
down the Format menu to make the text boldface, you are
going to use the Character menu to make several changes
at once to the selected text.

Figure 8.31
The Character command
has been selected. Note
that ND is the equivalent
for this action.

an

-~•~z
-~B

Release the mouse button .

Execute the Character command. You will now see the
Character dialog box.

Figure 8 .32
The Character dialog box.

Character
Size:
( OK J
Iii
111"1121
c
[cancel]

Font:
I New York
Underline:
!None

121

Style
OBold
0 Italic
0 Outline
0Shadow
0 Strikethru
0 Small taps
ORII taps
OHidden

Pull down the Font list by positioning
the mouse pointer on the down pointing
open arrow to the right of a font name
and pressing and holding the mouse
button.

o1or:
!Black

IQI

(Apply)

Position
®Normal
By:
0 Superscript
0 Subscript

c==J

Spacing
®Normal
Otondensed
OEHpanded

By:

CJ

First you are going to select a new font. You now have
the same list of fonts as displayed on the Font menu.
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Charo

-

Font:
New Yorlc

I~

....

Mono co
N Heluetlca Narrow
New Century Schlblc
.;'New Yorlc
Polotlno
Son Francisco
Symbol
Times
llenice
Zopf Chancery
Zapf Dingbats

Figure 8.33
Note the position of the
mouse pointer. By pressing
and holding the mouse
button down, the font list
will be displayed.

.....

Drag the mouse down into the font list
and select the Helvetica font, then
release the mouse button.
Click on the word Bold.

Change the font to Helvetica.
Below the font selection menu of the Character dialog
box is the style box.
You want the text to be bold.
Note that below the word Size, at the top right of the
Character dialog box, is a box that has a selected value.
There is also a pull down menu arrow to the right of the
selected number.

If you pull down the size menu, you will see a list that
tells you which bit-mapped sizes of the selected font are
available.
36

Helvetica is a Laser Font, and may be sized on most laser
printers to any point size between 4 and 127. Here you
are entering a point size without selecting a menu item.
It is important that you remember that the Character
command lets you enter any point size that you want. If a
point size is not available on the Font menu, it is through
the Character command that it may be entered.

Character
Font:
Heluetico

Size:

I

Underline:

INone

fOI!D~
Color:

IQI IBlock

Style

181 Bold
0 Italic
0 Outline
0Shadow
0 Strilcethru
OSmon Cops
ORII Cops
0 Hidden

(

OK

~

IOI (Apply)

Position
®Normal
By:
0 Superscript
0 Subscript L--·---····

r--- j

Spacing
®Normal
0 Condensed
0 EHpanded

J

By:

-.- ---1

!_ j

Figure 8.34
Your Character dialog box
should look similar to this
before you continue.
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Click on the Apply button.

Have Word apply the changes you have made to the
selected text in your publkation.

Click on the OK button.

After you have applied the typeface and formatting
changes, return to editing the text. The masthead text
should still be selected.

Click the center text icon on the ruler
line.

This icon is below what is currently the half-inch mark
on the shifted ruler ljne. The text should now appear similar to Figure 8.35.

Figure 8 .35
The current masthead.

Pull down the Format menu and select
the Paragraph optjon.

This option lets you control the appearance of the
selected paragraph, or group of paragraphs. You want to
add a partial border to what you have created.

Release the mouse button.

Execute the Paragraph command. This command may be
executed by using XM.

Click on the Borders button.

The borders option will let you add lines around the
selected text.

Click on the double line type.

You want to use the double line type.

8

Type the number 8. This number will appear in the spacing box at the bottom of the djalog box. Spacing will add
blank space between the border and the text. Here you
are addjng eight points.

Click on the bottom line of the borders
placement sample.

You want to put the line below the paragraph. Since the
custom option is selected, you may pick only the border
portions that you want. When you select thjs portion, the
8 that you typed will read "8 pt."
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Figu re 8 .36

raph Borders

The border dialog box.
Note the location of the
mouse pointer. This is
where you must click the
mouse to obtain a border
at the bottom of your
selected text.

Q Pieln BoH
Q Shadow BOH
0 Outside Bar
®Custom
Spacing:

:;;l!llli;;;;;;;;;;M;;;;-1--___.

Click on the OK button .

Leave the borders dialog box. The Paragraph dialog box
will still remain on the display.

Click on the Apply button.

Apply the border to the selected text.

Click on the OK button.

Leave the Paragraph dialog box.

l

Move the cursor to below the paragraph.

[cr] The Newsletter of the [cr] Miniville
Corporation [cr] Employees [cr] [cr]
August 1989

Enter this text. Push the return key where you see [c r] .

Select the first three lines.

You are going to change the font and size of the text you
ente red, but the date will have a different size than the
subtitle. Thus, it is not selected here.

r

li File Edit Format Font Document Utilities Window

.,

Figure 8 .37

The new text has been
added to the masthead,
and the text you are going
to work with has been
selected.
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XD

Once again you are going to use the Character d ialog box
to change the selected item.

Pull down the Font list menu and select
Helvetica, then release the mouse.

Change the font to Helvetica.

18

Change the type size to 18 points.

Click on the Apply button.

Apply the style change to the selected text.

Click on the OK button.

Leave the dialog box.

Click on the center text icon on the ruler
line.

Center this portion of the masthead.

Figure 8 .38

The masthead as it
currently appears.

r

li File Edit Format Font Document Utilities Window

.,

'!.

Select the last line of the masthead, the
date.

You are now going to apply a font and style change to this
text.

XD

Use the Character dialog box.

Pull down the Font list menu and select
Helvetica, then release the mouse.

Change the font to He lvetica.

12

Change the type size to 12 points.

Click on the Apply button.

Apply the style change to the selected text.

Click on the OK button.

Leave the dialog box.

Click on the center text icon on the ruler
line.

Center this portion of the masthead.
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Move the cursor to below the masthead .

r

a

File Edit

Format Font

Document

Utilities Window

.,

Figure 8.39
The completed masthead.

The.Newsletter.of.the<l
Mlnlvllle.Corporatlom
Employeesq
q

1980.

[cr]

Add a blank line .
Move the cursor up one line.

XM

You are now going to add a line across the page to separate the masthead from the rest of the newsletter. The
blank line you just added is necessary so that after you
apply a border to the current paragraph you will be able
to work below the border paragraph in the text.

Click on the Borders button.

Select borders.

Click on the heavy line.

This is the second line type down in the column of line
type icons.

Click on the bottom border of the
sample.

You want this border to appear only at the bottom of the
paragraph.
Figure 8 .40

raph Borders

~:L
t-

_______,

....__
Spacing:

c=:J

n OK 1
(cancel)

0Pialn BoH
0Shadow BoH
0 Outside Bar
®Custom

The border dialog boK
with the selections you
have made.

299

300

CHAPTER EIGHT- DESKTOP PUBLISHING WITH MS-WORD

Click on the OK button.

Leave the Border dialog box.

Click on the Apply button.

Apply the border to the selected paragraph.

Click on the OK button.

Put away the Paragraph dialog box.

-

8 .17 NEWSPAPER COLUMNS
Newspaper columns are different from the side-by-side paragraphs that you created for the
masthead. When newspaper columns are in use, text will flow from the bottom of one column to
the top of the adjacent column. This is what we want to happen as we add stories to the Mini ville
Corporation newsletter.

-

8 .18 THE SECTION BREAK
Newspaper columns are created by using section options. If the complete document is to be in
columns, then the section option would be applied at the outset, affecting the whole work. In this
case, however, you do not want newspaper columns in the masthead. Thus, before you change
the section options, you must create a section break.

WHAT

To Do

WHY

You ARE DoiNG IT

Move the cursor below the border paragraph. You cannot
use the return key here!
X-[ENTER]

Figure 8 .41
The section break appears
across the window.

Hold down the command key and press the Enter key
(NOT the return key). This will add a section break to the
document. It will appear as a double line across the page.
Also note that at the bottom of the window is displayed
" PI S I " instead of " Page !." This stands for Page I ,
Section 1.
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xs

Before you continue, save what you have created so far. If
you have problems later this is a good point to return to.

Newsletter

Name the document Newsletter.
If your disk is not selected, click on the disk button to
change the selected disk.

Click on the Save button.

Save your work.

-

8.19 CHANGING THE SECTION OPTIONS

Just having multiple sections does not change anything. Before you continue you must change
how the section you have just created is going to behave within the document. It currently has the
same characteristics as the first section, which are to start at a new page and to enter text into a
single column that occupies the complete width of the page.

WHAT

To Do

Pull down the Format menu and select
the Section option.

WHY

You ARE DotNG

IT

You are now going to change the features of the section.
Since the cursor is below the section break, you are
adjusting the second section of the document. If you had
moved the cursor above the section break you would be
adjusting the first section.
Figure 8 .42
The Section command
has been selected. If you
are using an extended
keyboard, you may access
this menu by using
Option-F14.
Position .•.
Styles •..
Define Styles... XT
For Style Xi)-

Bold
/1111/C

Underline

l!llJilllbG

Xi)Z
Xi)B
Xi) I
Xi)U
Xi) 0
Xi)W
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Release the mouse button.
Figure 8 .43
The initial Section dialog

box.

After a brief pause, the Section dialog box will appear.

~~----

I

&I

Start: New Page
Page Number
ORuto
0 Restart at I

1• 2 3

D

~
Section
Include Endnotps

Line Numbers
! Off

I§I

1:21

Count by:
Fr om lP»t:

L

_~-~-- - ~

I

OK

I

(cancel )
( Apply )
(Set Default)

From Top:

Pull down the Start menu .

From Right:

Header/ Footer

Columns
Number.

Fr omTop:
~
From Bottom: 0.51n

Spacing:

0

Fi rst Page Special

This menu is located at the top left of the dialog box. It
works in the same fashion as the font list found on the
Character dialog box.
At present the section is set to start a new page. This
means that after the masthead is printed, the next bit of
text will start on the next page. This is not what we want
to have happen.

Select No Break.

Figure 8.44
The Start menu is pulled
down and No Break is
selected.

By selecting the No Break option, this section wi ll continue on the current page, rather than going to a new
page.

Start: New Page
Page
ORu
ORe

lrrn

New Column
Page
Euen Page
Odd Page

~ New

LJ:n un ron:
Release the mouse button.

"WI

l n."iin

Complete the selection of the No Break option.
At the bottom left of the Section dialog box you will find
the column options. The number I is currently displayed,
and selected, as the number of columns.

2

Change the number of columns to 2.

[TAB]

The tab key will automatically select the Spacing entry.
T his controls the space between the two columns.

.25

Change the between-column spacing to one quarter of an
inch.

Click on the OK button.

Complete the section changes and put away the dialog
box. The only change you will see immed iately is the
right margin of the ruler line will reposition to reflect the
width of the column.
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Figure 8.45
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The Section dialog box
after all the changes have
been made.
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8 .20 EDITING THE NEWSLETTER'S STYLE SHEET
In an earlier chapter you saw the benefits of Word 's style sheets. Before you add stories to the
newsletter, define the styles so that the stories can be easily formatted.

WHAT

To Do

WHY

You ARE DOING IT

Pull down the Format menu, select
Define Styles and release the mouse
button.

You are going to change the Normal style to Times 12
point from its default settings.

Click on Normal in the style list.

You do not yet want to create a new style. Select Normal
so that it may be modified.

Pull down the Font menu, select Times
and release the mouse .

Change the font to Times.

Pull down the Font menu, select 12
point and release the mouse.

Change the point size to 12 points.

Click on the Justified Text icon on the
ruler line.

You want the text to be justified, rather than ragged right.

Drag a left align tab stop to the 114-inch
point on the ruler line.

Add a tab stop. The default half-inch tab is too large for
the columns you have created (Figure 8.46 on the next
page).

Click on the Define button.

Make the change permanent for this document.

Click on New Style in the style list.

You are going to add a new style to the style list for this
document.

Header

Type "Header" into the style name box. This is the style
that you will use for headlines within the publication.

Pull down the Font menu, select
Helvetica and release the mouse.

Change the font to Helvetica.

Pull down the Font menu, select 14
point and release the mouse.

Change the point size to 14 points.
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Figure 8 .46
The style is ready to be
defined.
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Pull down the Format menu , select Bold
and release the mouse.

Make the font boldfaced.

Figure 8 .47
The style " Header" is
ready to be defined. It
uses the Helvetica font in
14 point, and is in a bold
typeface.

I

Define St les:Newsletter
"'•Normal

ISet Default)

I

II

Style: Header

Define

~)

Normal • font: Helvettce 14 Point, Bold

NeHt Style:

I

I Bued on: INormal

Click on the Define button.

Create the Header sty le for this document.

Click on the OK button.

Close the Define Styles dialog box.

Pull down the style selection box at the
left end of the ruler line, select Normal
and release the mouse button.

After you defined the Header style, the current style was
changed. Return the current style to the Normal style.

XS

Save the changes you have made to the newsletter.

You are now ready to add text to the newsletter.
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8 .21 ADDING STORIES TO THE NEWSLETTER

You are going to add stories using the method you learned in Chapter 6 for moving blocks of text
between two documents. To add a story to the newslette r you will perform the following steps :
•
•
•
•
•

Open the story with the Open command.
Select the complete story.
Copy it into the cut/copy buffe r.
Close the story to return to the newslette r.
Paste the contents of the cut/copy buffer into the newsletter.

WHAT

To Do

WHY

xo

You ARE DotNG IT

This is the Open command from the File menu .
If the Miniville folder is not open in the dialog box,
double-click on it to open the folder. If you do not see the
Miniville folder at all, you may have to click on the drive
option, or eject the disk to place the proper disk into the
disk drive.
The first story that you want to place is called Last
Month Story.

Select Last Month Story and click on
the Open button.

.,

Select

11

The "Last Month Story"
has been selected in the
dialog box and will be
opened when the Open
button is pressed.

Document:

Ie.l Mlnlullle Stories I
0 Big Rl Story
D Deuelopment Story
D Floorplen Ceptlon

D Missing Notice
D Newsletter Logo
D Newsletter- complete

Figure 8.48

(g) MY DRTR
547K IIUIIIIIIble

Open~

( Eject )

( Cencel]

[ Orlue J

(

OReed Only

After clicking on the Open button the story will be in the
open window.
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Figure 8 .49
The reverse mouse arrow
is in the left margin of the
document.
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Move the mouse pointer to the left edge
of the window so that you have the
reverse mouse arrow.

You are going to select the complete story. This is the
first step toward doing this.
Hold down the command key.
When you click the mouse button, the complete document will be selected.

Click the mouse button.

!Last.Mont
q

~·

• .Cb

president.

Cbarl~. ha

Figure 8.50
The complete story has
been selected.

,. a

File

Edit

Format

Font

Document

Utilities

Window

XC

Copy the complete story into the cut/copy buffer.

Click on the current window's close
box.

Close the story since you now have it in the cut/copy
buffer.

XV

Paste the story into the newsletter.

Figure 8.51
The first story is now in
the newsletter.
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Since you changed the definition of the Normal style for
the newsletter, the pasted selection will take on the new
Normal style definition.
Click on the top of the scroll bar at the
right side of the window.

Scroll the window so that you can see the beginning of
the story you placed into the newsletter.
You can see that the story's headline, "Last Month", has
not taken on the Header style. There is no way for Word
to have known that you wanted this one line in a different
style.

Figure 8.52
You have selected the
story's headline so that
the headline style can be
applied to it.

Select the story headline.

You are going to change the style for the headline.

Pull down the style list at the left side of
the ruler line, select Header and release
the mouse button.

Apply the Header style to the selected text.

Figure 8 . 53
The Header style has been
selected from the style list.

Figure 8 . 54
After releasing the mouse,
the style is applied to the
selected text.

X3

Use the 3 on the number pad to move to the end of the
newsletter, which is where you will add the next story.

[cr]

Add a blank line before you add the next story.

xo

Select the Open command.

307

308

CHAPTER EIGHT- DESKlOP PUBLISHING WITH MS-WORD

Select Patent Story in the dialog box.

The Patent Story is the next story to be placed into the
newsletter. You will have to use the scroll bar on the right
side of the file list box to see this story title.

Click on the Open button.

Open the story.

Select the complete document.

Use the reverse mouse arrow, X-mouse click to select
the whole document.

XC

Copy the story into the cut/copy buffer.

Click on the current window's close
box.

Put away the story and return to the newsletter.

XV

Paste the story into the newsletter.

Select the story's headline.

You are going to apply the Headline style to this line.

Pull down the style list at the left side of
the ruler line, select Header and release
the mouse button.

Apply the Header style to the selected text.

XI

Select the Print Preview command. This command is
found on the File menu.
The Print Preview will display in miniature form what
you have created so far.

Figure 8.55
The Print Preview display.
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Format

Font Document Utilities

Print Preuiew: Newsletter
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The Press

--

t:G=

--=

Click on the Cancel button.

Return to editing the newsletter.

XS

Save what you have done so far.

X3

Use the 3 on the number pad to move to the end of the
newsletter, which is where you will add the next story.

[cr]

Add a blank line before you add the next story.

XO

Select the Open command.

Select Missing Notice in the dialog box.

The Missing Notice is the next story to be placed into the
newsletter.

Macintosh Productivity Tools

Click on the Open button.

Open the story.

Select the complete document.

Use the reverse mouse arrow, X-mouse click to select
the whole document.

XC

Copy the story into the cut/copy buffer.

Click on the current window's close box.

Put away the story and return to the newsletter.

XV

Paste the story into the newsletter.

Select the paragraph you just added .

You are Nar going to add a headline to this item. It will
be separated from the previous story by a line, called a
ruler line.

li File Edit Format Font

r

Window

,

Figure 8.56

The last story added has
been selected. Do not
select the f marks above
and below this story.

q
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XM

Select the Paragraph command from the Format menu.

Click on the Borders button.

You are going to place a border above this item to separate it from the Patent Granted story.

8

Enter 8 into the spacing box at the bottom of the Borders
dialog box.

Click on the border above the sample.

You want to add a border above the current paragraph .
Do Naf change the line type for this border. A single
thin line is what is desired here.
Figure 8 .57

The current borders dialog
box.

!.

0

0

Plain BoK
Shadow BOK
Outside Bar

0
® Custom
spacing:

lm•l

Click on the OK button.

Close the Borders dialog box.

Click on the Apply button.

Apply the border to the selected paragraph.

Click on the OK button.

Close the Paragraph dialog box.
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X3

Figure 8.58

The Missing notice
paragraph now has a line
above it.

Use the 3 on the number pad to move the cursor to the
end of the newsletter.
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[cr]

Add a blank line before you add the next story.

xo

Select the Open command.

Select Development Story in the dialog
box.

The Development Story is the next story to be placed into
the newsletter.

Click on the Open button.

Open the story.

Select the complete document.

Use the reverse mouse arrow, X - mouse click to select
the whole document.

XC

Copy the story into the cut/copy buffer.

Click on the current window's close
box .

Put away the story and return to the newsletter.

XV

Paste the story into the newsletter.

Scroll the window using the right scroll
bar.

Scroll the window until you are able to see the headline
of the story you j ust added to the newsletter.

Select the story's headline.

You are going to apply the Headline style to this line.

Pull down the style list at the left side of
the ruler line, select Header and release
the mouse button.

Apply the Header style to the selected text.

XI

Select the Print Preview command. This command is
found on the File menu.
You can see that the last story you entered starts at the
bottom of the left column and flows to the top of the right
column. This is the effect of newspaper style columns.

Click on the OK button.

Put away the page preview box.

XS

Save what you have done if it matches the text. If your
work does not match the text, go back to the last time you
saved the newsletter and try again .

X3

Use the 3 on the number pad to move the cursor to the
end of the newsletter.

[cr]

Add a blank line before you add the next item.
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Figure 8 .59

The current publication.

[Page Uiew]
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Pull down the Apple menu, select the
scrapbook then release the mouse.

You now want to get a graphic from the scrapbook DA to
place into the newsletter.

Click on the scroll bar at the bottom of
the scrapbook until the picture of the
Mississippi River appears.

You are going to place the picture of barges being pushed
up the Mississippi River into the newsletter. This picture
won the annual employee photography contest. It was
scanned and saved in a special format, called PICT, that
Word is able to use and print from.

--------Scrapbook ------ -

3/4

Figure 8.60

You should have this item
in your scrapbook.

MDPl, ePIC, PICT

XC

Copy the picture from the scrapbook into the cut/copy
buffer.

Click on the scrapbook close box.

Put away the scrapbook. The picture is now in the
clipboard.

XV

Paste the picture into the newsletter.

311

312

CHAPTER EIGHT- DESKlOP PUBLISHING WITH MS-WORD

XI
Figure 8.61

The newsletter now has a
photograph.

Preview the newsletter.
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You can see in the preview that the photograph you have
added extends over the right margin of the page. It is also
at an awkward location on the page. Before this is fixed ,
however, add the caption.
Click on the OK button.

Put away the page preview box.

X3

Use the 3 on the number pad to move the cursor to the
end of the newsletter, which is where you will add the
caption.

[cr]

Add a blank line before you add the caption.

xo

Select the Open command.

Select Photo Caption in the dialog box.

The Photo Caption is the next item to be placed into the
newsletter.

Click on the Open button.

Open the caption.

Select the complete document.

Use the reverse mouse arrow, X- mouse click to select
the whole document.

XC

Copy the caption into the cut/copy buffer.

Click on the current window's close
box.

Put away the caption and return to the newsletter.

XV

Paste the caption into the newsletter below the photograph.

XI

Once again preview the newsletter (Figure 8.62).

Click on the Cancel button.

Leave the print preview display.

XS

Save what you have done if it matches the text. If your
work does not match the text, go back to the last time you
saved the newsletter and try again.
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Figure 8 .62

The caption has been
added below the
photograph.
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8 .22 POSITIONING AN ITEM ON THE PAGE

So far you have been adding stories and letting them flow into the defined columns. The last
print preview shows, however, that the photograph is not ideally placed. It will take a lot of
fiddling to attempt to get it placed in the right position if all you do is add blank Hnes or more
story elements. However, Word does have a position option that lets you tell it where on the page
you want a selection to appear. This section will place the photograph and its caption at the lower
right of the page. To start this process, a box will be placed around the photo and caption.

WHAT

TO Do

WHY

Select the photograph and caption.

You ARE DoiNG

IT

Use the reverse arrow in the left margin to select the
photograph and the caption that you have placed under it.
Figure 8.63

The photograph and
caption have been
selected. Do not select the
f below the caption.
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XM

Select Paragraph commands.

Click on the Borders button.

You are going to put a box around the photograph and
caption.

Click on plain box.

You want to add a simple box around the photograph and
caption.

Click on the OK button.

Close the Borders dialog box.

Click on the Apply button.

Add the box to the current selection.

Click on the Position button.

You are now going to adjust the position of the photograph and caption so that it does not fall in the middle of
the right column . You are also going to have Word shift
the photograph left on the page so that it stays within the
margins.

Figure 8 .64
The Position dialog box.
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Pull down the Horizontal options.

First you are going to position the photograph horizontally (left to right) on the page.

Select the Right option and release the
mouse button.

You are going to position the photograph in relation to the
right margin.

Figure 8 .65
The Right option has been
selected.

Horizontal

Ols1ann' l'rom

Click Margin .

Still on the horizontal side of this dialog box, click the
mouse on Margin. You are telling Word to position the
selected text, which includes the photograph, in relation
to the right margin of the document.

Pull down the Vertical options.

These options let you adjust the position of the selection
relative to the top and bottom of the page.

Macintosh Productivity Tools

Select the Bottom option and release the
mouse button.

Position
Horizontel
Reletlue to:
®Mergln
OPege
QColumn

Uertlc:el

IBottom I!Ql

l

OK

You are going to position the photograph at the bottom of
the page.
Figure 8 .66
The completed Position
dialog box.
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Reletlue to:
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Peregreph Width:

Click on the Preview button.

The Preview button in the Position dialog box will take
you directly to the print preview.

.t File Edit Formet Font Ooc:ument Utilities Window

r

Print Preulew: Newsletter

,

Figure 8.67
The current publication
preview.

You can see that the photograph has shifted left on the
page so that it no longer passes by the right margin. You
can also see that the text to the left of the photograph
flows around the picture and its caption.
Click on the Cancel button.

Return to editing the newsletter.

xs

Save what you have done if it matches the text. If your
work does not match the text, go back to the last time you
saved the newsletter and try again.
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8 .23 STARTING A NEW PAGE

The first page of the newsletter is now full. We will start a new page by adding a new section
break.

WHAT

To Do

WHY

You ARE DOING IT

X3

Use the 3 on the number pad to move the cursor to the
end of the newsletter, which is where you will add the
section break.

X-[ENTER]

Hold down the command key and press Enter to add a
new section break.

Pull down the Format menu, select Section and release the mouse button.

You are going to adust the section options for the new
section .

Pull down the Start options at the top
left of the dialog box.

Since the last section was set to No Break, this section is
retaining that style. This needs to be changed.

Select New Page and release the mouse
button.

We want the next story to start on a new page, and not fill
in the white space above the photograph.

Figure 8 . 68

The Section dialog box.
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Click on the OK button.

You do not have to make any adjustments to the numbers
of columns, since it already reads 2.

xo

Select the Open command.

Select Big AI Story in the dialog box.

The Big AI Story is the next story to be placed into the
newsletter.

Click on the Open button.

Open the story.

Select the complete document.

Use the reverse mouse arrow, X-mouse click to select
the whole document.

XC

Copy the story into the cut/copy buffer.

Macintosh Productivity Tools

Click on the current window's close
box.

Put away the story and return to the newsletter.

XV

Paste the story into the newsletter.

Select the story's headline.

You are going to apply the Headline style to this line.

Pull down the style list at the left side of
the ruler line, select Header and release
the mouse button.

Apply the Header style to the selected text.

XI

Select the Print Preview command. This command is
found on the File menu .
Figure 8 .69

The Print Preview display.
Your newsletter now has
two pages.

Hotor

The Press

----- ===

-

If you forgot to add the section break, or change the section to New Page, then you will see the title of the Big AI
story placed above the photograph on the first page. To
fix this problem, add the section break as required and
change the start option to read new page.
Click on the Cancel button.

Return to editing the newsletter.

xs

Save what you have done if it matches the text. If your
work does not match the text, go back to the last time you
saved the newsletter and try again.

X3

Use the 3 on the number pad to move the cursor to the
end of the newsletter, which is where you will add the
next item.

[cr]

Add a blank line before you add the next item.

Pull down the Apple menu, select the
scrapbook then release the mouse.

You now want to get a graphic from the scrapbook DA to
place into the newsletter.
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Click on the scroll bar at the bottom of
the scrapbook until the floor plan for the
new Miniville Corporation plant
appears.
Figure 8.70
You should have this item
in your scrapbook.

You are going to place the floor plan into the newsletter.

Scrapbook

Dey
Cere

Assembly
Aree
Offices

Finishing

4/4

11>Pl, ePIC, PICT

XC

Copy the picture from the scrapbook into the cut/copy
buffer.

Click on the scrapbook close box.

Put away the scrapbook. The picture is now in the clipboard.

Paste the picture into the newsletter.
X3

Use the 3 on the number pad to move the cursor to the
end of the newsletter, which is where you will add the
caption.

[cr]

Add a blank line before you add the caption.

xo

Select the Open command.

Select Floor plan Caption in the dialog
box.

The Floor plan Caption is the next item to be placed into
the newsletter.

Click on the Open button.

Open the caption.

Select the complete document.

Use the reverse mouse arrow , X- mouse click to select
the whole document.

XC

Copy the caption into the cut/copy buffer.

Click on the current window 's close
box.

Put away the caption and return to the newsletter.

XV

Paste the caption into the newsletter below the floor plan.

XI

Preview the newsletter.

Macintosh Productivity Tools

Figure 8 .71
The newsletter has a
problem with the floor
plan!

You can see in the preview that the floor plan you have
added extends over the right margin of the page.
Select the floor plan and its caption.

You are going to position the floor plan.

Pull down the Format menu.

The Position dialog may be reached either through the
Paragraph commands as you did earlier, or directly from
the Format menu.

Select the Position command and release
the mouse button.

Go directly to the Position dialog box.

Font
Hide Ruler
Character •••
Paragraph •••
Section •••
Documen t ••.

Document
8€R
8€0
8€M

( l'IIS •••

Styles •••
Define Styles ••• 8€1
Plein For Style 8€0Plein TeHt
Bold
/1111/C
l!o!l~rl!o~
(I}JJ{l~

8€0Z
8€08
8€0 1
8€0U
8€00
:!€OW

Utilities

Window

,

Figure 8.72
The Position command has
been selected. Note that
behind the menu the floor
plan and caption are
selected. Do not select f at
the end of the newsletter.
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Pull down the Horizontal position menu,
select Center and release the mouse
button.

You are going to position the floo r plan and caption
between the left and right margins of the page.

Click on Margin under the Horizontal
position option.

You want the selected information centered relative to the
margins.

Pull down the Vertical position menu ,
select Top and release the mouse button.

You want to position the floor plan and caption at the top
of the page, even though it is in the newsletter after the
New Addition story!

Figure 8 .73
The settings of your
Position dialog box should
match the settings in this
figure.

Position
Uertlcal

Horizontal

lrop
Relatlue to:
®Margin
OPage
QColumn

IIQJ

Relatlue to:
®Margin
OPage

I

I

OK

[cancel)

[ii"eUD
[ Preulew

·ltl

Paragraph Width:

Click on Preview.
Figure 8 .74
The position of the floor
plan and caption are now
at the top of the second
page of the newsletter.

Go directly to the Print Preview display.

,. •

File

Edit

Print Preulew: Newsletter

P2 S3

Click on the Cancel Button.

You are putting away the page preview.

:M:S

Save what you have done if it matches the text. If your
work does not match the text, go back to the last time you
saved the newsletter and try again.

Locate the New Addition story headline.

Use the scroll bars to locate the beginning of this story.

Macintosh Productivity Tools

Click the mouse in front of the word
New.

Position the mouse at the headline.

Pull down the Format menu, select the
Section command and release the mouse
button.

You are going to modify the section options fo r the
second page.

Change the number of columns for this section back to 1.

. iN·e~

<r
+ c

Irrom

Hll] h t :

1beir-I
'!bey.

Columns
Number:

eddiljj

Spacing:

m .s

l~:. ~~xi~J I

~1 1

I

Figure 8 .75
Change the number of
columns for this part of
the newsletter back to 1.

1o.2s1n 1

Bi(.A
+ Bi(.Al,kDovnu.Al -o.his.friellll3,.i=
'treetce.t vbo.bu.nov.reubed. the.rtpe.c

Click on the Apply button .

Apply this change to the section.

Click on the OK button.

Put away the Section dialog box.

~M

Open the Paragraph dialog box.

Click on the Borders option.

You are going to add a border above the New Addition
story.

10

Make the spacing for the border 10.

Click on the border above the placement
control.

Place the border above the paragraph.

r aph Borders

((LJj
~

'1~~~~·~~

r
~~----~

Spacing:

0
0

Figure 8 .76
The Borders dialog box.
Note that the spacing has
been set to 10.

Plain DoH
Shadow DoH

0 Outside Bar
@ Cust om

lllillllll

Click on the OK button.

Put away the Borders dialog box.

Click on the Apply button.

Apply the border to the selected paragraph .

Click on the OK button.

Put away the Paragraph dialog box.
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31:1

Preview the newsletter.

Figure 8 .77

Edit

The Print Preview of your
complete publication.

Format

Font

Document

.,

Utilities Window

Hot Oil'

Tl» Press

=m=

Click on Cancel.

Leave the Print Preview.

:M:S

Save the newsletter.

:M:P

If you have a printer attached to your Macintosh, Print
the completed publication.
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Figure 8.78
The complete publication.

:M:Q

If you are finished with the publication, quit Word.
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EXERCISES
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11 .
12.
13.
14.
15.
16.
17.

What are the three planning steps that should be carried out to ensure a successful publication?
What is a serif! What purpose do serifs serve?
What are the two typeface decisions you must make?
What are the five groups, or species, of typefaces discussed in the text?
What is a typeface family?
What would be a good typeface to use for a first grade reader? Why?
What are the rules you should employ to help you decide the appropriate typeface for headlines?
What is leading?
What is kerning?
How do you decide the appropriate width for a column?
What are the page design concepts mentioned in the text?
On which menu of MS-Word can you find the Insert Table command?
What are newspaper-style columns?
What is the advantage of newspaper-style columns over the side-by-side columns created with the Insert Thble command?
What is a masthead?
How do you enter a section break into a Word document? What is the value of a section break?
Is it possible to draw a line above or below a paragraph without drawing a complete box around the paragraph? If so, how,
and can the spacing between the text and line be adjusted?
18. Which menu command lets you adjust the position of text on the page?
19. When you adjust the position of an item, can you place it only at the bottom of the page, or may it also be placed in other
locations on the page?
20. Is it possible to change section settings, or do you have to remove the section break and re-insert it?

CHAPTER

BEGINNING ELECTRONIC
SPREADSHEET CONCEPTS

g
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CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:

• Explain what an electronic spreadsheet is.
• Explain what an electronic spreadsheet may be
useful for.
• Start Microsoft Excel running on the computer.
• Move the cursor from one location to another
on the spreadsheet.
• Define the term range.

• Put text, numeric values and simple formulas
into cells of the spreadsheet.
• Change the contents of a ceO.
• Save a model.
• Print the spreadsheet.
• Start a new worksheet.
• Quit Microsoft Excel.

-

9 .1 WHAT IS AN ELECTRONIC SPREADSHEET?

If you have ever taken an introductory accounting class, you know what spreadsheet paper islined paper with a multitude of accounting uses. For example, you may use spreadsheet paper to
create profit and loss statements , balance sheets or accounting journal pages.

z:z.z

Figure 9 .1
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An electronic spreadsheet has some similarities to the physical piece of paper shown in
Figure 9 .1. The computer's memory is arranged into something like a large, invisible electronic
piece of horizontally lined paper with columns drawn on it. This results in an electronic page full
of boxes, or cells, in the machine's memory. The more memory in the computer, the larger this
electronic page can be, which really means that more of the cells making up the spreadsheet may
be filled with information.
Figure 9.2
A spreadsheet screen,
containing the same
information as the piece of
paper in Figure 9. 1.
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This, however, is about where the similarities end. An electronic spreadsheet is capable of
performing the same basic tasks as the traditional spreadsheet paper, holding and displaying
information. Additionally, each box of the electronic spreadsheet is capable of performing a
multitude of other tasks, such as arithmetic, fmding information in other cells, or holding text
display.
What makes an electronic spreadsheet the valuable tool that it is, however, is that it performs
the arithmetic and other numeric operations for you automatically. Indeed, with most spreadsheet programs, you have to go out of your way to keep the program from updating all the
spreadsheet's numeric values when a new number is added to the page. A paper spreadsheet,
alas, can do nothing but display what you have written on it. If you make a change to a paper
spreadsheet, you will have to change other areas of the document that are affected manually.
The ability to perform arithmetic calculations automatically is a major reason electronic
spreadsheets have become one of the most important tools available on computers today. But
their applications in the accounting field are not the sole reasons for their popularity. Indeed,
spreadsheets are in use in a wide variety of fields and endeavors. As previously mentioned, the
cells making up an electronic spreadsheet are capable of performing arithmetic calculations.
These can be simple computations, such as 3 + 5/12. This type of computation is referred to as a
formula. But a formula in one cell can incorporate the contents of other cells in the spreadsheet.
This means, for example, that a cell that we will call A may contain the numeric value 1745, and
another cell, called B, may contain a formula that says something like "Take what is in cell A
and divide it by the value 12.4."
Now recall that arithmetic calculations are performed automatically in a spreadsheet. This
means that cell B will not display 1745/ 12.4, but the arithmetic result of that calculation,
140.7258. However, more importantly, if the value in cell A is changed to 1677. 1, the value
displayed in cell B will automatically be changed to 137.25 without any prompting from you.
It is this ability to automatically carry out computations, and to incorporate the information
found in multiple cells, that has made the electronic spreadsheet the pervasive tool it has
become.
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9 .2 WHY USE AN ELECTRONIC SPREADSHEET?

All this is wonderful, but so what? Well, the phrase is not "so what" but "what if." The
electronic spreadsheet makes playing numerical "what if" games as easy as counting.
"What if" may be considered the task of trying to predict the future. With the electronic
spreadsheet, it is relatively simple for you to create a mathematical model reflecting, for
instance, a company's financial health or some aspect of the company's production. With the
spreadsheet, you can then change values within the model to see how the changes affect the rest
of the organization. This is exercising the "what if' capability of the program.
For example, consider a company with many subsidiaries. While each subsidiary must be
successful on its own, the success or failure of each contributes to the overall health of the parent
company.
Figure 9 .3
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As you can see in Figure 9.3, a change at the bottom level in the Alliance Co. can have an
effect throughout much of the rest of the parent organization. The parent company's officers can
experiment with the cells in the spreadsheet representing the lowest level of the firm to see how
each change affects the firm as a whole.

-

9 .3 BUDGETING

The electronic spreadsheet can also be very useful as part of the budgeting process as well as the
forecasting/planning process, as you saw above. Budgets, of course, are also part of the planning
process. Budgets are "what if" exercises.
A typical budget has major categories and many line items under each of the categories. The
bottom right of Figure 9.4 on the next page shows the advertising budget for XYZ, Inc. This
budget is incorporated into the complete budget for the company, as seen at the top left of the
figure. These are annual budgets, but the spreadsheet makes it simple to break them down into
monthly or weekly budgets, if you so desire.
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Figure 9 .4
The departmental budget
is on the bottom right, and
the company budget on
the top left. Note that the
departmental budget is
part of the overall
_company budget.
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You can extend the monthly budget by placing percentages of the annual total in the monthly
cells and simply entering the annual totals. For example, the XYZ Company may want to spend
25 percent of its advertising budget in November, and 25 percent in December, with the remaining 50 percent to be equally divided over the remaining ten months of the year. The computer
then calculates the values of the advertising and other monthly line items. This type of budget
model can be very useful for a seasonal business, again allowing the "what if' exercises to take
place as a part of the budget process. This is how the budget in Figure 9.5 was created.
Figure 9.5
Departmental budget by
month.
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You can use the electronic spreadsheet as another part of the budget/planning process to
compute line item values needed to make the budget balance or to make predictions of the status
of the profit and loss statement. For example, you may decide on a goal for company profits and
then let the computer determine the necessary sales level to meet that profit goal. You can
continue experimenting with the profit and loss statement through the "what if' exercises.

-

9 .4 MANIPULATING NUMBERS
Another aspect of the electronic spreadsheet that makes it useful is its versatility. Along with
budgeting, planning, and forecasting, you may also use spreadsheet programs for number
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crunching, or mathematically processing numbers. Most spreadsheet programs have built into
them the ability to perform such standard mathematical calculations as square roots, averages,
and logarithms, as well as financial calculations such as internal rate of return and net present
value.
With access to these functions, it is possible for you to use spreadsheet programs to perform
statistical procedures such as regressions or to determine loan payments and interest rates.
Teachers use electronic spreadsheet programs to maintain their class records, while businesses
use them to maintain their business records.
In short, the electronic spreadsheet is a very versatile tool, enabling you to perform almost
any needed combination of calculations. You are limited only by your imagination as to the
potential uses of this type of program.

-

9 .5 BASIC CONCEPTS

An electronic spreadsheet is composed of cells located in the computer's memory and displayed
on the screen. Depending on the design and capabilities of the spreadsheet program, the number
of cells available to you may be small or large. The ultimate number is influenced both by the
size of the program and by the size of your particular computer's memory.
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Unfortunately, the greater the capabilities of the program, the larger the program must be.
This results in less memory space being available for the contents of the spreadsheet. The
sophisticated electronic spreadsheet programs of today, however, are segmented, and only part of
the program is physically in the computer's memory at any given moment, leaving room for
extensive models.
Additionally, it is possible to optimize the memory space available to you by designing your
spreadsheet model to fill cells from the top left and down or from the top left and across,
creating either a tall, skinny model, a short, fat one, or a square one. It is not, however, a good
idea to place information in cells in random places on the spreadsheet page, because the program
must use some of the computer's memory to hold the places of the unused cells above and to the
left of the cells you are using. Even though the spreadsheet program uses memory management
techniques to minimize the memory required for place holding, it can be very costly in terms of
memory if there are many unused cells between the ones you are using and the top left comer of
the spreadsheet. You will find that you will soon run out of memory if you are careless with the
placement of your information within the worksheet.
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9 .6 STARTING MICROSOFT EXCEL

Figure 9 .7

Excel is distributed on three disks, the Program disk, the Help and Examples disk, and a tutorial
disk. On the Program disk you will find the Excel program itself, a sample spreadsheet and a
second program called "Dialog Editor."
After you boot your Macintosh with a System Start-Up disk, insert the Excel Program disk
into one of the computer's disk drives. If you are using a machine with a hard disk you will not
need to insert the Excel program disk into a disk drive. Rather, locate the Excel folder, and open
it so you can see the Excel program icon. Place a disk (see Chapter 3 for how to initialize a new
disk) with at least 200K available space into another one of your Macintosh's disk drives, if you
have one available. This disk will be used for saving your work. If you do not have a free floppy
disk drive, keep this disk available. You will need it for data storage.
In these instructions, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on .. ." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase "Double-click the mouse on .. ." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed.
Finally, if you want your work to match the figures in the text, be sure to use the Chooser DA
to select a LaserWriter and not an ImageWriter. You may select a LaserWriter even if your computer is not actually attached to one. You will not, however, be able to print if thls is the case.

The MS-Exce/ program

icon.
WHAT

Microsoft Exctl

To Do

If the disk's icon is closed, double-click
on it with the mouse pointer.

WHY

You ARE DOING IT

Open up the disk icon onto the desktop. If the Macintosh
you are using has a hard disk, then open the folder containing the Excel program.

Locate the Excel program icon inside
the disk window (Figure 9.7). If you are
using a machine with a hard disk, locate
the Excel program icon inside the folder's window.
Move the mouse pointer to the Excel
icon and double-click the mouse button.

Launch Excel. Remember, if you are having trouble with
the double-click, you may select the Excel icon with a
single click, then use the Open command on the File
menu (or XO) to launch Excel.

After a brief pause you will see an empty spreadsheet on the computer's screen with a menu
bar at the top. The spreadsheet window will occupy the majority of the Macintosh's display. It
has a title bar on top with the name "Worksheet!", scroll bars at the right and bottom, and a
size box at the bottom right comer. The large hollow plus sign in the middle of the worksheet is
the mouse pointer.
Separating the menu bar at the top of the Macintosh display from the Worksheet 1 window is
the cell edit line. "AI" is currently displayed at the left end of this line. As the cell pointer
location changes while you work, thls will change to tell you the cursor's current location. The
formulas that are entered into cells will appear in the box on the right side of thls line as the
cursor is placed on a cell containing information.
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At the bottom of the Macintosh display, below the Worksheet! window , is the status bar.
The word " Ready " is displayed at the left end of this bar. As you work, this , too, will change.
For example, as you pull down and access a menu item, the purpose of the menu item will be
displayed on the status bar.

r

a

WHAT

File Edit

Formula

Format

Data D tlons

TO Do

WHY

Macro Window

.,

Figure 9.8

The opening Excel screen.

You ARE DoiNG IT

Pull down the Options menu.

Remember, to pull down a menu , place the mouse pointer
on the desired menu item and press and hold the mouse
button. One of the Options Menu items lets you switch
between the Short and Full menu levels. The last item
reads Full Menus. This means that you are presently
using the Short Menus.

Drag the mouse pointer down the menu
until Full Menus is the selected item
(Figure 9.9).

You want to change the menu level to Full Menus.

Figure 9.9

Calculation...
Calculate Now X•

This is the Option Menu
when Short Menus are
adive. The Full Menus
option, shown selected
here, will change the
menus to their full status.

~llll \f_

Release the mouse button .

Set the menu level to Full Menus. The next time you pull
down the Options menu, you will see that, in addition to
having more items, the option for Full Menus has been
replaced by Short Menus.
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Many of the menu options are toggle choices. This means that they operate like an on/off
switch, which is sometimes called a toggle switch. The first time you select an option, it changes
something to its opposite state. If you then select the option a second time, that something is
changed back to its original state. The Short/Full Menus option is an example of this.

-

9 .7 NAMING CELLS
Each cell has a name, which you can determine by combining the name of the column with the
name of the row. Each column is given a letter name, such as A or CQ. The first column is A,
the second B, then C, and so on to Z, the twenty-sixth column. The twenty-seventh column
continues with AA, followed by AB, AC, and so on until AZ is reached. Then the columns are
BA, BB, BC, and so on. The naming of the columns continues in this fas hion to the limit of the
number of columns, which is column IV.
Just as the columns have letter names, the rows have names. They are numbered rather than
lettered, starting with 1 and ending with the row limit, row 16384.

Figure 9.10
The bottom right corner of
the spreadsheet. This cell
is called IV16384.

' li File Edit Formula For ma t Data Options Macro Window

.,

Used together, the column letter and row number allow you to identify, or name, any single
celJ of the spreadsheet. All Excel requires is that you, when identifying a celJ for some purpose,
give fi rst the column letter, then the row number. This letter/number combination is the celJ 's
address.

-

9 .8 CURRENT CELL LOCATION

Spreadsheet programs tell you in which cell of the spreadsheet you are presently entering information with the cell cursor, or current cell indicator.
The Excel cursor is an outline that surrounds the complete current cell. In Figure 9.8 the
cursor is in cell Al, while in Figure 9.10, it is in cell IV16384.
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As previously mentioned, Excel also displays the current column and row location of the
cursor at the left of the edit bar below the Macintosh menu bar. This information is useful,
because it is not always easy to determine the cursor's location visually. You will find this to be
especially true when the cursor is positioned at the lower right side of a window and the
gridlines are turned off, which makes it hard to distinguish the current cursor row number from
the row indicators at the left of the screen. You can see in Figure 9.8 that the location Al appears
at the left of the edit bar. This is the starting location of the cursor. In Figure 9.10 the cursor has
been moved to IV16384, which appears at the left of the edit bar.

-

9 .9 MOVING THE CURSOR
Moving the cursor from one cell to another is a simple process. Press one of the arrow keys
found at the right side of the computer's keyboard to move the cursor in a particular direction.
The cursor can be moved up, down, left, or right.
You can also see that the mouse pointer has turned into a large hollow plus sign. You may
position this mouse on any cell and click the mouse button once to jump the cursor directly to
that cell. ln addition, Excel has a GOTO command, which allows you to jump the cursor from
its present location on the spreadsheet to any other cell you have specified, even one outside the
current window.
Before you begin using the spreadsheet, first note the Al at the left side of the edit bar. This
is the current cursor cell location, or address. As you move the cursor during the next exercise,
you will see this location indicator change.

WHAT

TO Do

WHY

Figure 9.11
This is the mouse pointer
when it has been moved
over the active worksheet
window.

You ARE DoiNG IT

Move the cursor down three cells. The cursor should now
be in cell A4, and the cell location indicator at the top
left of the screen should say A4.
Move the cursor right four columns. The cursor should
now be in cell E4, and the cell location indicator should
say E4.

--+ --+ -+ -+
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Figure 9.12
The cursor outline is now
in cell E4, and E4 is
displayed at the left of the
edit bar.

-----!-----+-~

t

Move the cursor up one row. The cursor should now be
in cell E3, and the cell location indicator should say E3.

+- +-

Move the cursor left two columns. The cursor should
now be in cell C3, and the cell location indicator should
say C3.

334

CHAPTER NINE -

BEGINNING ELECTRONIC SPREADSHEET CONCEPTS

Press the left arrow key while holding down the command key. This will jump the cursor left. In this instance,
it will be jumped to column A. The X key used with an
arrow key will move the cursor in the direction of the
arrow until Excel detects a change in the cell from occupied to empty (or empty to occupied).
Pull down the Formula menu.

This menu has the Goto option. This command lets you
jump the current cell pointer to any location on the
spreadsheet.

Drag the mouse down to select Goto.

You are going to jump the cursor to a cell. Note that you
may access this command by using the XG key.

Figure 9.13
The Formula menu. The
Goto command has been
selected.

Define Nome ...
Creete Nemes.. .
Apply

Nam e~ ...

Release the mouse button.

Execute the Goto command. The Goto dialog box will be
displayed, with the cursor blinking in the box labelled
Reference.

F12

Specify cell F 12 as the destination you want the cursor to

GOTO.
Figure 9 .14
The Goto destination has
been filled in.

....
~G..:;..ot.:..:o'--------,.~,..,

l

OK

I~

cencel

t-

Reference: I._F_I-'~---------'

_
~==~====~====~==~____,___c ..:.:::=c~-·-·-----1·----·~~
Click on OK.

Click on the OK button. The cursor will jump to cell
F12. The cell location indicator at the left of the edit bar
should now read F12. Since the OK button is double outlined, you may press the return key ([cr]) instead of clicking the mouse on the OK button itself. Remember, this is
true of any double outlined button.
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Figure 9.15
The cursor is now in
cell F12.

Worksheet I

C

B

D

XG

Execute the Goto command again, this time using the
command key rather than the menu.
The Reference box now reads $A$3 . This is the cell in
which the cursor was located before you executed the
prior Goto command. (The dollar signs have a special
meaning to Excel that will be discussed later in the text. )
If you click on OK now, the cursor will return to that
cell. Excel will always remember the last cell the cursor
was in when you execute a Goto, making it easy to return
to that cell.

Figure 9 .16
,.:.G.::..otc:..:o_ _ _ _ _---cQAI

l

OK

ttJJ

The Goto dialog box Is
now displaying the name
of the cell the cursor
jumped from.

Cencel ]

Reference:

Click on OK.

Return the cursor to the prior cell.
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9 .10 RANGES

Excel gives you the opportunity to make extensive use of ranges when building a spreadsheet. A
cell range is a subset of the complete worksheet. The sole requirement for cells to be a range is
that they be contiguous-that is they touch each other, side to side and/or top to bottom. Corner
to corner does not count. Therefore, a range may be a row, a column, or a rectangle of cells. A
range may not be a triangle or a diamond. For example, a legal range consists of cells C5
through ClO, or cells B3 through G3 . The first is a column, the second a row. Figure 9.17
shows the portion of row 3 from column B to column F selected as a range. Figure 9.18 shows
the rectangular range from B5 to FlO.
Figure 9.17
The cell range 83 through
and including F3 is a
range.
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Figure 9.18
The rectangular range 85
through and including F10.

-

9.11 USING RANGES

You will see that there are many uses for ranges. For example, they can provide named references to areas of your spreadsheet. This is very useful when writing macros.
A selected area of the spreadsheet may also be used to define the current input area. In
effect, when you select a range, you do so by stretching the c ursor over the desired cells. This
selected area then limits the travel area of the cursor until a new range is created, or the current
range is de-activated.

WHAT

To Do

Place the mouse pointer (the open plus
sign) in cell A 1.

WHY

You ARE DoiNG lr

This is where you will start the range.

Macintosh Productivity Tools

Press and hold the mouse button.

Begin the creation of the range.

Drag the mouse down to cell A5. Do
not yet release the mouse button.

Define an input range as being from cell AI to cell AS.
Note that the left end of the status line displays " SR x
1C" to let you know the shape of the range, which is five
rows and one column.
Figure 9.19
The indicator at the left
end of the status line reads
5R X 1C.

Drag the mouse right to cell B5.

You are now creating a range that is five rows deep and
two rows wide.

Release the mouse button.
Figure 9.20
The range A 1 through and
including 85 has been
defined.

Note in Figure 9.20 that the current cell, cell A I , is outlined , rather than solid black like the rest of the range.
[cr]

Push the Return key. The outlined cell cursor will move
down to cell A2.

[cr]

Push the Return key again. The cursor will move down
again.

[cr] [cr] [cr]

Push the Return key three more times. When you press
this key the third time, the cursor will move from cell AS
at the bottom of the range to cell B 1 at the top of the next
column of the range. This will always happen when the
cursor reaches the edge of a selected area of the spreadsheet. If you were not working within a selected area, the
cursor would have continued moving down the A column.
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Figure 9.21
The cursor has moved to
ce/181.

[cr] [cr] [cr] [cr] [cr]

Push the Return key five times. On the fifth push, the
cursor will return to cell A I .

[Enter]

Press the ENTER key, rather than the return key. The
cursor will move right to cell 8 I, instead of down to
cell A2.

[Enter]

Press the enter key a second time. The cursor will move
to cell A2. When the cursor reaches the edge of the
selected area of the spreadsheet, it will move to the next
row.
As long as you have selected a range of cells and you
move the cursor with either the return or enter keys, the
cursor will remain within the selected range.
Press the down arrow to move the cursor to cell A3. The
selected range will become de-selected by using a cursor
movement arrow.

Figure 9.22
After pressing an arrow
key, the selected range
of the spreadsheet is
de-selected.
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(cr] [cr] [cr] [cr]

The return key will continue to move the cursor down the
current column, even when a range of cells is not
selected.

[ENTER]

The enter key, when no range is selected, will not move
the cursor! This is useful. It will let you make changes in
the content of a cell, and enter those changes, without
changing the location of the cursor.
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9 .12 NAMING RANGES
After you have selected a range of cells, as you did above, you may assign this range a name.
This name may then be used as the destination of the Goto command (XG), as well as a variety
of other commands that work on areas of the spreadsheet, such as formatting and printing
commands. You will see how these processes work later in the text.
In this section you wi ll create a named range that will be used to c reate an initial spreadsheet
model. The range will be cell A3 through and including cell B5.

WHAT

TO Do

WHY

You ARE DoiNG IT

Place the plus sign cursor over cell A3.

This cell will be the top left corner of the range you will
be selecting.

Press and hold the mouse button.

Begin selecting the range.

Drag the mouse down to cell AS , then
right to cell B5 .

Select the range to be named.

Release the mouse button.

You have now selected the range of the spreadsheet that
you will name.
Figure 9 .23
The selected range is cell
A3 through cell 85.

Pull down the Formula menu.

This menu contains the Define Names command.

Drag the mouse down to select Define
Names and release the mouse button.

The Define Names command may also be executed by
using the XL key. After you release the mouse button,
you will see the Define Names dialog box.
You can see in the Refers to box of this dialog box the
reference to the selected range. The dollar signs in the
range reference make the cell addresses fixed. More will
be said about the use of dollar signs in cell names later in
the text.
Figure 9 .24

Define Nome

Ill

Q
~

Nome:

II
Refers to:

0

I·SA$3:$8$5

c
(

OK
Cancel

I ( Delete

J

)
)

I

The Define Names dialog
box. There are no names
defined in a new
spreadsheet.

339

340

CHAPTER NINE - BEGINNING ELECTRONIC SPREADSHEET CONCEPTS

InRange

Name the selected range "lnRange."

Click on OK.

Define the range's name.

Move the plus sign mouse pointer to cell
A 1 and click the mouse.

De-select the range by selecting a different cell on the
spreadsheet. We are now going to test the range name we
have just defined.

XG

Execute the Goto command. The Goto dialog box now
contains InRange in a list of places on the spreadsheet at
the top left of the dialog box.

Figure 9.25

In Range appears as a place
on the spreadsheet that
the Goto command knows
about.

~G~o~to~----------T.Q~ (
lnRange ~

OK

~

j
r

( Cancel

Reference:

Move the mouse pointer to the word
InRange in the Goto list.

You are going to go to this range.

Click the mouse once.

The name lnRange will appear in the Reference box.

Figure 9 .26

lnRange has been selected
as the destination of the
Goto command.

6oto
lllll dlliJI'

::!":

I

OK

J

Cancel

Reference:

Click on OK.

The range InRange will now be re-selected.

-

9.13 WHAT TO PUT INTO CELLS

Now comes the fun and the hard part! What do you put into the cells that make up the electronic
spreadsheet? The answer-virtually anything you want. The hard part is to build a spreadsheet
that is accurate and that gives you worthwhile information.

Macintosh Productivity Tools
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9 .14 ENTERING LABEL CELLS
You may put words into cells, which are then considered text or label cells. For example, you
may want to put the word " Sales" on a profit and loss statement or the word "Assets" on a
balance sheet. It is the label cell that allows you to do this. To enter a label cell into the Excel
spreadsheet all you have to do is place the cursor on (in) the desired cell and start typing letters.
To Excel , a label cell is begun by any characte r on the keyboard and contains at least one
non-numeric character. For example, 953A is a label cell , as is MX943. Even entering 3 + 7 is
considered a label cell, since the plus sign is acting as a non-numeric character in this example.
However, entering 374 by itself is not a label celL If you start a cell with an equals sign ( = ),
Excel will expect a formula, or computation cell , which is a numeric value. The formula , or
computation, cell will be discussed later in this chapter.

WHAT

To Do

WHY

You ARE DotNG IT

Make sure that the cursor (the outlined
cell) is at cell A3 of the selected
InRange.

Cell A3 is where you will begin building the spreadsheet.

SALES

Enter the text " SALES" into cell A3 . Several things will
happen as you type this text.
First, the information you are typing will appear in the
cell and on the edit line above the worksheet window.
Second, you should notice that two boxes appear on the
edit line between the current cell indicator on the left and
the cell contents on the right. The box on the left has an
X in it, while the one on the right has a check mark.

'

.t File Edit Formula Format Date Options Macro Window
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Figure 9 .27

The text appears on the
edit line and in cell A3 at
the same time. Note the
two small boxes that have
appeared on the edit line.
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The X box is used to cancel the entry you are making.
The check mar k box is used to place the entry you are
making into the cell. All you need to do is click the
mouse pointe r on the desired box. In both instances there
are alternatives. For the X, or cancel box, you may press
the ESC key on the keyboard. For the check mark, or
enter box, you may press the enter key on the keyboard.
Finally, notice that the word " Enter" will replace
" Ready " at the bottom left of the screen. This is to let
you know that Excel is accepting characters, and that you
must enter the information into the cell before you
continue.
Figure 9 .28
The word Enter is at the
bottom o f the display.
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Press the Return key to enter the text into cell A3 and
move the cursor down to cell A4.
If you press the enter key, rather than the return key, the
cursor will move right to cell B 1. If you press an arrow
key, the range will become de-selected.
It is important to keep in mind that if you a re not working
in a selected range, you may use any cursor movement
key to enter information into the current cell and move
the cursor. For example, you may press the down arrow
to enter information into the cell and then move the cursor down one cell in the column.

Figure 9.29
The text has now been
entered into cell A3, and
the cursor has moved to
cell A4.

COSTS [cr]

Enter the text " COSTS" into cell A4 and move the cursor down to cell AS.

PROFIT [cr]

Enter the text " PROFIT" into cell AS. T he cursor is
moved to cell B3 since the bottom of the input range has
been reached, and the return key wants to move the cursor to the next cell in the range.
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Figure 9.30
The current spreadsheet.

Press the enter key to move the cursor to cell A4.

Look at the edit line above the Worksheet! window. To the right of A4, the cell location
indicator, you can see the word "COSTS." The current contents of a cell will always be displayed next to the cell address whenever the cursor is placed on the cell.
[SHIFT]-[ENTER]

Hold down the Shift key and press the enter key again.
The cursor will return to cell B3.
This is a trick! The enter key by itself moves the cursor
right a cell. The shift key will reverse the direction. Thus
the shift-enter key combination will move the cursor left
a cell. Since the cursor is at the left edge of the range, it
moves to the end of the prior row. If you try the shiftreturn key combination, you will find that the cursor
moves up a cell.

-

9.15 NUMERIC CONSTANT CELLS

You may also place constant numeric values, such as 365 or 12, into spreadsheet cells. This type
of cell is called a value cell , because the entry is a numeric value. To enter a constant value,
simply locate the cursor in the desired cell and type the number.
Another type of value cell is the arithmetic expression, such as 2.3 + 843/6. To enter this
type of information into the Excel spreadsheet, you must start the cell with an equals sign. When
you start a cell with an equals sign, you are telling Excel to perform a computation using the
arithmetic formula you are entering.
When you create a formula, or computation cell, the formula you place in the cell is saved in
the computer's memory, but the numeric value of the expression is computed, and this resulting
value will be displayed within the cell on the computer monitor. Remember, you must start a
computation cell with an equals sign, or Excel will treat it as another label cell.
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WHAT

To Do

WHY

You ARE DoiNG

IT

100 [cr]

Enter the numeric constant I 00 into cell 83 and move the
cursor to cell 84.

70 [cr]

Enter the numeric constant 70 into cell B4 and move the
cursor to cell 85.

= 100-70 [cr]

Enter the arithmetic computation I00-70 into cell 85.
Since you want Excel to perform the arithmetic, you must
start the cell with an equals sign. When you press the
return key, the result of the computation, 30, will appear
in cell 85.

Move the mouse pointer to cell B5 and
click the mouse once.

You are now going to de-select the InRange and look at
the single cell 85.

Figure 9 . 31

..

The edit line shows the
contents of cell 85 as
= 100-70, but the
spreadsheet displays the
resulting value, 30.
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9 .16 YOUR FIRST MODEL
You have now created a very simple model with your spreadsheet program. Unfortunately, it will
not do much for you. You have entered all the numeric cells as numeric constants or arithmetic
formulas with numeric constants. If the sales value changes , you will have to recalculate the
profit by re-entering the complete contents of cell 85 , changing the numbers appropriately. This
is not a very exciting prospect, considering that the reason you are creating this model with a
computer is to avoid extraneous typing and performing tedious arithmetic.

-

9 .17 FORMULA CELLS
Now you will look at the feature that makes an electronic spreadsheet do what it does best. As
part of an arithmetic expression in a given cell, you may also include the address of another cell
(the column letter and row number) .
When Excel finds a cell address in an arithmetic expression, it will replace that address with
the value found in the specified cell . When the value in the cell referenced by the arithmetic
formula changes (for any reason), the value in the cell containing the formula will make a
corresponding change, its value being recomputed based on the new value substituted into the
arithmetic formula in that cell. This change can cause many cells to make corresponding changes
if the cells are linked by the use of cell addresses in the formulas.

Macintosh Productivity Tools

Think back to the ZZZ International spreadsheets found in Figure 9.3 . The grand total for
ZZZ International includes a re ference to the cell containing the total for ZZZ Australia. This
cell refers to the subtotal for the ZZZ Australia portion of the spreadsheet. Finally, this subtotal
includes a reference to the income for Alliance Company. When the income for Alliance
changes, three other values change to reflect the new information.

-

9 .18 CHANGING CELL CONTENTS

As you modify your existing model in these next few steps, you will be making changes to the
present contents of cells . You will see that to make a cha nge in a cell is simple. Place the cursor
on the desired cell and type the new information. When you press the enter, return or an arrow
key, the old cell contents will be replaced by the new information you have typed. Nothing
special is required.
You should also be aware of how you enter a formula . Since you want Excel to perform a
computation , you must start the cell with an equals sign. In some cases, it may then be beneficial
to use parentheses to clarify the order of computation in the formula . Just as in algebra, Excel
will perform computations on items enclosed in parentheses before it performs other computations. For example, the formula = 4/ 2*5 will not give you the same value as the formula
= 4/ (2*5). If you are not sure of the order of calculation, it is always safest to use parentheses.

WHAT

TO Do

WHY

You ARE DotNG IT

t

Move the cursor to cell B4.

= (.7*B3)

This is a formula . The costs for this model will always
be 70 percent of the sales. The sales value is found in
cell B3. Thus the costs are (.7) (seven-tenths or 70 percent) of the sales. At present, the value computed is 70,
the number originally entered, so the number displayed
in the cell will remain unchanged.
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Figure 9.32

The formula you are
entering is displayed on
the edit line and in the
cell. Since you have not yet
entered the formula, its
value has not been
computed.

7

Enter the formula into the cell and move the cursor to
cell B5. You may also use the [cr] at this time.

=(B3-B4)

The profit is the sales minus the costs . This formula
computes this value for us.

[ENTER]

Remembe r, pressing the enter key when no range is
selected will put information into the current cell without
moving the cursor.
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As before, the number presently displayed in the cell
should not change at this time. Notice that the contents of
cell B5 is the formula = (B3-B4), even though the information displayed at location B5 is 30. The actual contents
of a cell are displayed to the right of the cell location
indicator on the edit line above the worksheet window.
Figure 9.33
The cell is displaying the
same value, but its content
is a formula based on two
other cells, rather than on
numeric constants.
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Notice that you entered this cell starting with an equals sign. If you had started the cell entry
with the parentheses or letter B (of the address B4) , Excel would have interpreted the entry as a
label cell. Remember that you must start a computation cell with an equals sign ( = ),even if it is
not using any cell references.
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9 .19 A REAL MODEL

You now have a true model. Use the cursor movement keys to move the cursor to cell B3. This
cell controls the other two values of your spreadsheet. Recall that costs will be 70 percent of
whatever sales are, and that profit is sales minus costs. What if sales were 175 instead of 100?
Enter 175 into cell B3. (Remember, to change the contents of a cell, place the cursor on the cell
and type the new information, ending with the enter key, the [cr] key, or an arrow key.) The costs
should automatically change to 122.5 and the profit to 52 .5.
This type of manipulation shows the true power of the electronic spreadsheet program. You
may create a spreadsheet, frequently referred to as a model or template, to perform simple
calculations as in the model you have just created, or complex ones involving many interrelationships among many cells, and complex formulas. You may then change a few numbers in strategic
locations of the spreadsheet and let the computer recalculate and redisplay all the cells throughout the spreadsheet.
Figure 9.34
The value of cell 83 has
been changed, and the
remaining two values
change automatically.
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9 .20 SAVING YOUR MODEL

AJI the work involved in entering a model would be wasted if you could not store it for later use.
Every spreadsheet program provides some method of storing and retrieving models. Saving a
model requires the use of the menu bar at the top of the Macintosh display. It is not an entry into
one of the spreadsheet cells.
The Save command, as in all Macintosh applications, is located on the File menu. All
commands that interact in some way with the computer's disk drive can be found on this menu.
Once a spreadsheet has been saved, you can retrieve it at a later date to make modifications or
corrections .
Excel has two save options-Save and Save As. The Save option is used after you have saved
the spreadsheet at least one time. If you have not saved the spreadsheet, then Excel will ask you
to supply a name for it. If you have previously saved the spreadsheet, the Save option uses the
current name of the spreadsheet as it appears on the title bar, and places it onto the same disk as
used for the prior save. The previous version of the spreadsheet is erased and the copy you are
working with is made current on the disk. You end up with one copy of the spreadsheet, the most
recent version.
The Save As command lets you supply a name for a new spreadsheet, or change the name of
an existing spreadsheet before it is saved. In addition, you may change the folder into which the
spreadsheet is saved. If you want, you may even eject the floppy disk in the disk drive and
change disks onto which the spreadsheet is saved. The Save As lets you do any one of these
actions, or any combination of them. If you are using Save As with a previously saved spreadsheet, and you are changing the name, folder or disk for the spreadsheet, you will end up with
two copies of the spreadsheet, an older version and the newly edited one. If you use a name that
already exists in a folder, you will have to confirm that you want to replace the prior file with the
new one. Recall that the Finder will not let you have two programs or other documents with the
same name in a single fo!der.
If you are using a computer with a hard disk and a single floppy disk drive, you may want to
save this spreadsheet on a floppy disk, rather than on the hard disk. If a floppy disk is not in the
disk drive, insert one now .
If you are using a computer with two floppy disk drives, and you presently have your system
start-up disk in one, and your Excel program disk in the other, have your data storage floppy
disk handy.

WHAT

To Do

WHY

You ARE DOING IT

Pull down the File menu.

The File menu has both the Save and Save As options
located on it.

Drag the cursor down to the Save As
option.

You want to save the document on which you are working, and give it a name at the same time. You also want
the option of being able to change the disk drive on which
it will be stored (Figure 9.35 on the next page).
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Figure 9 .35

The Save As option has
been selected.

Release the mouse button.

When you release the mouse button, you will see the
Save As dialog box. Note that the spreadsheet you have
been worldng on is called " Worksheet! ".

Figure 9.36

The initial Save As dialog
box. You can see that a
disk calfed "Hard Disk" is
in the currently selected
disk drive, and is where
the file will be saved if you
do nothing to change the
disk drive.

!=HARD DISK

CJ C7 stuff
CJ Figures Folder
CJ HP4D Stuff

DISK

r,jt>ct

""""

Drlue

lei
Saue Worksheet as:
Normal Format

Modell

~=HARD

I

Saue

~

Cancel

l

( Options

Change the name of this Spreadsheet. Make it " Modell."
If you are using a computer with a hard disk drive, and
the name of your hard disk appears at the right of the
Save As dialog box above the Save button, then you
should click the Drive button. This will tell the Macintosh you want to save the document on the disk in the
floppy disk drive. (If you did not put your disk into the
floppy disk drive as instructed above, the Drive button
will be dimmed!)
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If you are using a computer with two floppy disk drives,
and your data storage disk is not in either of them, click
on the Eject button. This will cause one of the disks to be
ejected from a disk drive. Replace the disk with your data
storage disk.

~

I(g) MY DRTR I
lg} MY DATA

Q

0

I

Salle Worksheet as:

IModell

I

Normal Format

EJect

I

Drlue

~
D

Saue
Cancel

I

( Options

Figure 9 . 37
The disk drive onto which
the file is to be stored has
been changed from the
Hard Disk to a disk called
MY DATA. This was done
by inserting a disk into a
disk drive and clicking the
mouse pointer on the
Drive button found in the
dialog box. MY DATA is an
empty disk.

After you have typed the name for the document and
selected the disk onto which you want it saved, click on
the Save button to execute the command, saving the document onto the disk.

Click on the Save button.

You may also, in addition to changing the disk drive onto which the spreadsheet is saved,
change the folder on the disk. In the file list window at the top left of the Save As dialog box,
you can identify a folde r by the miniature folder icon in fro nt of a file name. Additionally, the
name is not dimmed, as is a document or application name. If you double-click on a folder in
this list, you are telling Excel to open the folder for you. The contents of the folder will be
displayed, and the folder 's name will appear above the file list.

I

(g) MY DATA
CJ Biology Folder
CJ History Folder

I
Q

(g) MY DATA
EJect

D letter to IUi1:e
D re~t llocumen1
D Te~t ll'tter

Drllle

0
Salle Worksheet as:
Normal Format

I

Salle
Cancel

( Options

I

Figure 9 . 38
This dialog box shows
another disk called MY
DATA. It has two folders
that appear in the disk 's
main window. There are
also several files at the
same level on this disk.
The file names are
dimmed, while the folder
names are not. You may
double-click on a folder
name to make it the
storage location.
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You may also tell the Macintosh to close the folder. The folde r name above the list of files it
contains is a pull down menu . Use the mouse to pull it down, and select the desired level. If you
select the bottommost item on this list, you will be telling Excel to save the document on the
ctisk's main window, and not in any folder.
Figure 9 .39
The folder name at the top
of the file list window has
been pulled down. You can
see that the folder called
Science Project Folder is
inside Cricket Graph Folder,
which is inside the
Graphics Folder found on
the disk called MY DATA .

0 Cricket Graph Folder
0 Graphics Folder
(g) MY DRTR

(g} MY DRTR

Eject

Drlue

Saue Workshe et as:

(

Saue

J

cancel
Normal FQnnat

[ Options )
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9.21 PRINTING THE SPREADSHEET

Just as with any other computer tool, the spreadsheet would have limited usefulness if you could
not print the results of your work. Spreadsheet programs do allow you to output your model onto
paper. However, you must consider the width of the model in columns and the length of the
model in rows before it is output. Just as the Excel window can show only a portion of the total
spreadsheet, the printed page can hold only a portion of the same spreadsheet.
As with all Macintosh applications, the amount of information you can fit on the printed
page depends on the printer (lmageWriter or LaserWriter), the fo nt in use, and the size of the
font.
If you try to print a spreadsheet wider than what will fit on the page, the program then prints
what will fit on a page and will print the remainder on the next page. Excel has a print preview
feature that lets you determine what your fi nal output will look like.
Excel will print the complete spreadsheet unless you tell it to print only a selected area. The
complete spreadsheet is defined as starting in cell A I and extending to the right to the last
occupied column, and down to the last occupied row. In our present case, this is what we want to
print. However, you will see how to control what is printed.
Obviously, you must have a printer attached to your computer, or on the network you are
using, to print your work.

WHAT

To Do

Pull down the File menu and select the
Print command.

WHY

You ARE DoltvG lr

The Print command will also let you preview the output
before you send it to the printer. Note that you may use
the :ll:P key to activate this command.
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Edit Formula
XN
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xw

Figure 9 .40
The Print command has
been selected on the File
menu.

xs

Saue
Saue As ...

--------------1
XQ

Release the mouse button .

Activate the Print command. After a brief pause, you will
see the Print d ialog box.

lmageWriter
Quality:
QBest
®Faster
0 Draft
Page Range: ® All
O From: DTo:
Copies:
Paper Feed: ®Automatic 0 Hand Feed
D Page Preulew
D Print Using Color

D

D

~rint

®Sheet

0 Notes

l,...o.K-~J
( Cancel)

Figure 9.41
This is the print dialog
box if you are using an
Image Writer dot matrix
printer.

O Both

~.2

LaserWriter "LaserWriter II"
Coples:l• l

xu

Pages: ® All 0 From:

OK

J

CJ To: CJ (Cancel 1

Couer Page: ® No 0 First Page 0 Last Page
Paper Source: ® Paper Cassette 0 Manual Feed
D Print Using Color

D Page Preulew

(

[ Help

1

Figure 9 .42
This is the p rint dialog
box if you are using a
LaserWriter laser printer.
Yo ur p rinter name may be
different from the printer
named here.

~rint

j® Sheet

0 Notes

0 Both

If you are using an Image Writer, click on the Best quality
button before continuing.

Move the mouse pointer to the box
labelled Page Preview and click the
mouse once.

On both print dialog boxes you can see a check box
labelled Page Preview. Clicking the mouse in this box
will place an X in this box, making it active.
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Click on OK.

Begin the Print process. Since you have activated the
Page Preview, the printing process will not yet begin.
Instead you will see the Page Preview.

,

Figure 9.43
The page preview window
shows you what your
document will look like
before you actually print it.

Zoom

) (

Print

... Preview: Page I

Note that the Next and Previous buttons at the top of the
display are dimmed. This indicates that there are no other
pages to be output other than the one you are viewing.
Move the mouse pointer over the preview page.

As you move the mouse pointer over the preview page, it
will turn into a magnifying glass. This is the zoom tool.

Position the magnifying glass at the bottom of the page.

You want to see what is displayed at the bottom of the
page.

Figure 9 .44
Note the location of the
magnifying glass cursor on
the text at the bottom of
the preview page.

Click the mouse button.

Zoom the bottom of the page up to full size so that it is
readable.

Click the mouse button.

After you have read this text, clicking the mouse button
again will return the preview to the full page overview.

Click on the Print button.

If you have a printer available, click on the Print button
to create printed output. When the document is done
printing, you will be returned to the spreadsheet.
If you do not have a printer, click on the Cancel button to
leave the Page Preview window and return to the
spreadsheet.
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A

Figure 9.45

8

This is the output
generated with the Print
command.

1
2

3
4
5

SALES
COSTS
PROFIT

100
70
30

Notice on the output, just as on the page preview, that the
spreadsheet gridlines have been printed, as well as the
column lette rs and row numbers. It is possible to turn
these off to create final output.
Pull down the File menu and select Page
Setup.

The Page Setup feature lets you control a variety of output features. With this option, you can turn the gridlines
and headers on and off, as well as change the text that
appears at the top and bottom of the page, or eliminate it
completely.

IIJig Edit Formula
lieN
lieD
lieW

New...
Open ...
Close
Links ...

Figure 9.46

Page Setup has been
selected.

--------- -

lieS
SIIUe
SaueRs...
S11ue Workspace ...
Delete ...
_ . , _ _ _ _ _M _

_

. , , _ , . ., . . _ __

___ __

Print ...

...-

.....

,.,

Release the mouse button.

v2.7

® us Letter
0 US Leg11J
0 Computer P11per

Orlent11tion

-~

Special Effects:

_____,
lieQ

Activate the Page Setup command.

lm11geWr1ter
P11per:

,

""lieP

,,,,,,

Quit

_

I

0
0

R4 Letter
lntemlltiOnlll fllnfold

0
0
0

11111 Adjusted
50 ~ Reduction
No 611ps Between P11ges

orgln~s~==;----;:::==::;-,
Left: o.75
Right:
D. 75

181 Print Row end

Top:

181 Print lirldllnes

I
I
I
:===
:===
It
I Bottom: I•

OK

I

[ C11ncel)

Column Headings

Figure 9 .47

This is the Page Setup
dialog box if you are using
an ImageWriter printer.
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Figure 9 .48
This is the Page Setup
dialog box if you are using
a Li1serWriter printer.

LeserWrlter Page Setup
Peper: ®US Letter 0 R4 Letter
0 US Legal 0 B5 Letter
Reduce or l'"j'j)ol'l
Enlarge: ~
Orientation

-~

:1.2

0

Tabloid

I

OIC

I

[Cancel]

Printer Effects:
(options]
181 Font Substitution?
Help
181 TeHt Smoothing?
181 Graphics Smoothing?
181 Fester Bitmap Printing?

Mergi~n~==;----;::::==::::;-,
Left: D. 75
Right:
o.75

181 Print Row end

Top:

181 Print Grldllnes

I
I
I
:====~
:====~
I•
I Bottom: I•

Column Headings

You can see that two options appear at the lower right of
the Page Setup dialog box. These control the printing of
the row and column headers and the gridlines.
T his dialog box also gives you control over the page's
margins , and the contents of the header and footer lines.
If you erase the information displayed in the header and
footer boxes, nothing will be printed on the final output.
Move the mouse pointer to the check
box for Print Gridlines, and click the
mouse button once.

Thm off the printing of the gridlines.

Figure 9 .49
The print gridlines option
has been turned off. Row
and column headers,
however, will still be
printed since the X remains
in that check box.

Click on OK.

181 Print Row and
Column Headings
O~rlnt Grldllnes

-?

I

-

You are finished changing the page setup.
When you return to working on the spreadsheet, the
gridlines remain! You have turned them off only for
printing.

XP

You want to look at the page preview again now that you
have turned off the gridlines. The page preview box
should still be checked.

Click on OK.

Look at the page preview. You can see that the spreadsheet gridlines are no longer displayed.
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.,
)(

~Preview:

Zoom

)(

Figure 9 .50
The gridlines are no longer
displayed on the page
preview. If you had
de·selected the print row
and column headings box
in the page setup dialog,
they, too, would be
missing from this display.

Print

Poge I

Click on the Cancel button.

You do not want to print another copy of the spreadsheet
at this time.

XS

Execute the Save command. By changing the Page Setup,
you have made a change to the spreadsheet, and you want
to retain this change. By saving the spreadsheet at th is
time , you are making the setup change a part of the
spreadsheet.
If you do not save the spreadsheet after changing the page
setup, the change will be lost. This is true of a change of
any type. Making a change and not saving the spreadsheet means that the change will be lost.

-

9.22 CHANGING THE PRINT AREA
There may be instances when you do not want the complete spreadsheet to be printed. If this
happens, you must have a way to tell Excel what you want printed. This is done with the Options
menu.

WHAT

XG

To Do

WHY

You ARE DoiNG

IT

The Goto command. Before you change the print area,
you must select the range of the spreadsheet you want
printed.
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Click on InRange in the Goto range list
box.

You want to print only the area of the spreadsheet that
contains information. InRange does not include rows I
and 2 of the spreadsheet.

Click on OK.

Put away the Goto dialog box. The cells A3 through 85
will be selected.

Figure 9 .51
This is the range you now
want to print.

Pull down the Options menu.

This menu contains the Set Print Area command.

Drag the mouse down to select Set Print
Area.

You are going to change the default print area.

Figure 9 .52
The Excel Options menu.
Set Print Area has been
selected.
Display •••
Standard Font ..•
f"riH~Zt.>

l>ont.>s

Protect Document •••
Calculation •••
Calculate Now

Release the mouse button.

Set the selected range of the spreadsheet as the range that
you want printed.
Note that the gridlines around the selected print area turn
into dashed lines. The box that the dashed lines enclose
is the print area you have set.

Figure 9 .53
Look carefully at the
gridline separating row 2
from row 3 of the
spreadsheet. It is a dashed
line. There are several
other dashed lines on the
spreadsheet.
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~p

Execute the Print command. The Page Preview box
should still be checked . It will only become unchecked if
you uncheck it.

Click on OK.

Look at the page preview. You can see that it includes
only rows three through five.

,

,.
)(

Zoom

)(

Figure 9 .54
The page preview shows
that only rows 3, 4 and 5
are to be p rinted. Compare
this figure w ith Figure
9.50, which includes the
first two rows of the
spreadsheet. If you are
having t rouble w i th this
preview, use the Zoom
button, or the magnify ing
glass cursor to get a closer
view.

Print

Q

._ Preview: Page 1

Click on the Cancel button.

You do not want to print the document at tJ1js time.

As you a re working, you may change the print a rea at a ny time. All you need to do is select
a different range of the spreadsheet, then use the Options menu to set the print area. The most
recent print area is the one that is " remembered" for the spreadsheet. The Set Print Area
command is simply placing a special range name into the ra nge name list. The actual range
defined, called PrinLA rea, changes every time you execute the Set Print Area command.

-

9 .23 RESTORING THE DEFAULT PRINT AREA

O f course, there are times when you may want to cancel the print area you have set and return
the spreadsheet to its default print area, the complete spreadsheet. To do this, you must remove
the PrinLArea range fro m the list of defined ranges. The Pr inL Area range, as was mentioned
above, is created automatically by the Set Print Area command that you just used .

WHAT
~L

To Do

WHY

You ARE DoiNG

IT

This is the Define Names command. Recall that it is
located on the Formula menu. If desired, you may pull
down this menu and select the Define Names option,
rather than using the command key.
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You can see that PrinLArea now appears in the list of
defined range names.
Figure 9.55
The current Define Names
dialog box.

Define Nnme
lnRnnge
PrlnLRren

I

OK

(

Cnncel

I
I

Delete

I
Move the mouse so it is pointing at
PrinLArea in the name list box.

You are going to select this range to delete.

Click the mouse button once.

Select the PrinLArea range name.

Figure 9 .56
The Print....Area range has
been selected.

-··

-: ---- =-- ---=

lnRnnge

I

I

OK

I
I

( Cnncel
Delete

I
Click on the Delete button.

The delete button will remove the selected range name
from the range name list.

Click on OK.

You are finished with the Define Names dialog box.

XP

You are going to look at the Page Preview one more time.

Click on OK.

Go to the Page Preview. You can see that rows I and 2 of
the spreadsheet are once again included in what will be
printed.

Click on the Cancel button.

Leave the Page Preview and return to the spreadsheet.

-

9 .24 STARTING A NEW WORKSHEET
There will frequently be times when you want to start a new spreadsheet file. For example, you
may be experime nting with a feature of the spreadsheet prior to creating the model. Or you may
be showing a friend how to use the program .
In either case, it is a simple matter to open a new worksheet. Excel is able to work with
multiple worksheets open. The number of open worksheets is limited by the available memory in
your computer, and the amount of memory any single worksheet is using.
When you work with multiple spreadsheets, you are able to change between the d ifferent
worksheet windows using the window menu. If you find having multiple worksheets open confusing , it is a simple matter to close the first one before opening the second. You may, of course,
close the first one after opening the second if you so choose.
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WHAT

TO Do

WHY

You ARE DOING IT

Pull down the File menu.

This menu contains the New command.

Drag the mouse down the menu to select
the New option.

You are going to open a second worksheet. Note that you
may use XN to execute the New command.
Figure 9 .57
The File menu. The New
command is selected.

Execute the New command. The New dialog box will
appear.

Release the mouse button.

Figure 9 .58

I

rNeu:.
® Worksheet
0 Ch11rt
0 M11cro Sheet

I

OK

[

Cllncel

J

)

The New dialog box.
1H
1ff1-

In addition to being able to create worksheets, the New
command lets you create graphs and macro sheets. Both
these items will be discussed in later chapters in the text.
Of the three things you can create, the Worksheet button
is selected.
Create a new worksheet.

Click on OK.

A second worksheet window will open, called
Worksheet2.

r

•

File
AI

Edit

Formulll

Form11t

D11t11

Options

M11cro

.,

Window

The second worksheet sits
on top of the first.
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C
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Figure 9 .59

F

C!H-------i----

359

360

CHAPTER NINE -

BEGINNING ELECTRONIC SPREADSHEET CONCEPTS

-

9 .25 CHANGING THE ACTIVE WORKSHEET WINDOW

You now have two worksheet windows open. The top one, called Worksheet2, is the active
spreadsheet. You may change the active worksheet in one of two ways. First, you may pull down
the Window menu and select the name of the desired worksheet from the list of available
windows appearing at the bottom of the menu. Second , if any portion of the desired window can
be seen on the Macintosh 's display, you may move the mouse pointer to the area and click the
mouse. Remember, clicking the mouse in a window makes it the active window.
Since the Worksheet2 window was created after the Modell window, it is sl ightly smaller.
You can see the edge of the Modell window to the left and above the current window. Clicking
the mouse in this space will make Modell the active window!

WHAT

To Do

Move the mouse to the left of the Worksheet2 window , but touching the Modell
window.

WHY

You ARE DOING IT

You are going to make Modell the active window by
clicking on it.

Figure 9 .60
Note the position of the
mouse pointer on the
window behind the
Worksheet2 window.

File
A1

Edit Formula Format

B

Data Opt

Worksheet2
C

Click the mouse button.

When you click the mouse once , the Modell window will
become active. It completely hides the Worksheet2
window.

Pull down the Window menu.

Since the Worksheet2 window is completely hidden by
the Modell window, you must access it by using the
Window menu.

Drag the mouse down to Worksheet2 .

You are once again going to activate this worksheet. Note
the checkmark in front of Modell on this menu. This
check mark indicates that Modell is the presently active
window.

Figure 9 .61
The present Window
menu. As more
spreadsheets are opened
on the desktop, this menu
will get longer.

.,

~
Help •••
New Window
Show Clipboard
Show Info
Arrange All

.

Hide
Unhlde •.•
.,...., Modell

-,

...!W.

Macintosh Productivity Tools

Reactivate the Worksheet2 window.

Release the mouse.

As a general note, you should re member that the size of a window on the Macintosh may be
changed to better fit your needs . You may use either the zoom box at the top right side of the title
bar, or the size box at the bottom right corner of the window. If a window completely hides
another, you may use its size box to make it smaller, the reby revealing part of the other w indow.
By changing the size in this fashion, and using the title bar to reposition the two windows, it is
possible to modify the placement of the windows on the Macintosh display so that you may
always see at least some of each window . By doing this, it is a simple matte r to use the mouse
pointer to click on the desired window to change the active window. This eliminates the need to
use the Window menu to change the active window.
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Figure 9.62
This is an example of how
you may want to arrange
several open spreadsheet
windows so that all you
need to do to change the
active window is click the
mouse on the one you
want.
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9 .26 CLOSING SPREADSHEETS

Sooner or later you will want to put away a spreadsheet. You may, as suggested above, not want
to have two open on the desktop at the same time, or you may be getting ready to do something
else with the computer. Like all Macintosh windows, the title bar of the active window contains a
close box. Additionally, the File menu contai ns a close option.

WHAT

To

Do

WHY

You ARE

DoiNG IT

Pull down the File menu.

You can see that the File menu has a Close option. This
option may be accessed with :M:W. The presently active
window will be closed if you select this option . Remember that you can tell which window is active by the horizontal lines in its title bar.

Release the mouse button.

Do not use the Close command found on the File menu
at this time.
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Click the mouse pointer on the close
box at the top left of the title bar.

You may also close a window by clicking on its close
box. You are now closing the Worksheet2 window. The
Modell window will now be active, since it is the only
available worksheet.

Figure 9.63

The mouse pointer is
positioned on the close
box.

Click on the Modell close box.

You also want to put away Modell.
A new dialog box will appear, asking if you want to save
the changes you made in the spreadsheet.

Figure 9.64
If you try to close a

spreadsheet that has not
been saved, you will
receive this dialog box.

l

Yes

J(

The only changes you have made since the last time you
saved Modell were the addition, and subsequent deletion,
of the range PrinLArea.
Click on the Cancel button.

For now, you do not want to close this spreadsheet. If
you click on yes, the spreadsheet will be re-saved and
then closed. If you click on no, the spreadsheet will be
closed without it being re-saved.

-

9 .27 FINDING ON-LINE HELP
Excel has an on-line help facility that may be accessed while using the program. You may get to
the Help processor by using the Window menu .

WHAT

To Do

WHY

You ARE DotNG

IT

Pull down the Window menu.

You access Help by using the Window menu.

Drag the mouse down to the Help
option.

Select Help.
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Figure 9 .65
The Help option on the
Window menu has been
selected.

New Window
Show Clipboard
Show Info
Arrange All
Hide
Untalde •.•

Activate Help.

Release the mouse button.

The initial Help display is a list of topics.
Figure 9 .66
The initial Help window.

Help
INDEX OF HELP TOPICS

Tc>plc ~

AI ert Men"lU

Cancel

Den ned Terms

Preul ous

~

Wl12m
Ktui!!!W

Lo!!Q I -2- 3
Mecro L! broru
Procedures

~ID

NeHt

[ Lotus 123)

•·

Move the mouse pointer over the word
Commands on the topics list.

You want to get help about a command. Note that when
you move the mouse pointer over the topic list, it turns
into a hand with an extended index finger.

Click the mouse button once.

A single press of the mouse button will select the desired
topic. A new Jist of topics will appear.

Scroll the window down until File Page
Setup appears.

You want to fi nd out more about the Page Setup commands. Use the scroll bar at the right of the topics list to
scroll the topics until File Page Setup appears.

Position the mouse pointer over File
Page Setup and click the button once.

You want to fi nd out what help is available for this topic.

Figure 9.67
The Commands topic is
going to be selected when
the mouse button is
pressed.

Alert Mess&[es
cow;ands
De .. d Terms
Functions
Figure 9 .68
You are about to get
information about the
Page Setup command,
which is found on the File
menu.

t-11e upen ffall
~geSetuP..

Fil~ ".'lri nt
File Record Macrc
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Figure 9.69
Part of the help that is
available for t he Page
Setup command.

Help
FILE PAGE SETUP

Nil:-rtJ»II b:ul Rlflr~.
,_..,, FNIIr
T~pe

In the text and be!!der and footer code§ for paQe
numbers and forrnottlno vou 'tlant.
Headers end footers are el'tii!JS 112" from the top or
botlom of the page and 3/ 4" from the side of the p8Qe.

Topics

!:::!

Controls the appeerance oflhe printed wrbheat, macro
sheet, chart, or Hipi+M tttntenb.
• Whenever vou seve a document. the P8Qe Setup
aett11193 are olao HVed.
• For more Information, see File P8l,ll! Setup In the

Cancel
[ Preulous
NeHt

I:,!~

Back
[ Lotus 123 )

'•'

111r#IIU

Determines amount of space bet'tllen the edQe of peper
and the printed document.
'

Click on the Cancel button.

... .

[Qj"

When you are done reading about the Page Setup command, click the mouse on the Cancel button to put away
the Help window and return to the spreadsheet.

-

9 .28 QUITTING EXCEL
You are now ready to quit Excel. You may be ready to stop using the compute r or you may want
to do something else with the machine. If you do want to continue working with something else,
it is a bad habit to simply turn off the computer. Always use the Shut Down option on the
Finder's Special menu . To get this option, you will have to exit Excel.

WHAT

To Do

II'IHY

You ARE DOING IT

Pull down the File menu.

The Quit option is located on the File menu, just as it is
for most Macintosh applica1ions.

Drag the mouse down to select the Quit
command.

You are now going to quit Excel and return to the Finder
desktop. You can see that you may use the XQ key to
execute the Quit command if desired.

Figure 9 .70
The Quit option has been
selected on the File menu.
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Release the mouse button.

Once again, the dialog box reminding you that the
spreadsheet is not saved will appear. Just like all Macintosh applications, you cannot close a document, or exit
the program, without deciding if you want to save the
most recent changes to your work.

Click on the Cancel button.

For now, you do not want to quit Excel.

Click on the Modell close box.

Remember that the close box is at the top left of the window's title bar. You are closing the window without exiting Excel. Again, the dialog box asking if you want to
save the spreadsheet appears.

Click on Yes.

Re-save the Modell spreadsheet.
After the save is complete, the menu bar at the top of the
Macintosh screen will change to reflect the fact that no
worksheet windows are open. Only the File, Edit and
Window options will be showing. Additionally, you will
see an empty desktop. If you are not using MultiFinder,
you will not see any disk icons or the trash can icon.
These icons will be on the screen if you are using MultiFinder.
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Figure 9.71
This is what your
Macintosh display will look
like after you have closed
all the spreadsheets you
have been working on.

: : :

: : :
: :

:

: : :
:

._ Reody

Pull down the File menu.

Once again, you are going to quit Excel.
Note that the File menu is abbreviated , just as is the complete menu bar. The Print, Save and several other commands do not appear. They would be dimmed if they
showed on the menu, since they are meaningless commands when there is no open spreadsheet.

Drag the mouse down to the Quit option
and release the mouse button.

Execute the Quit command to leave Excel. After a brief
pause you are returned to the Finder.
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EXERCISES
1. If you want to enter the text " 1986-87 Fiscal Budget" into a cell of a spreadsheet, do you need to enter a special character
or command to tell Excel that you want to mix text and numbers?
2. If you enter 100/5 into a cell of a spreadsheet, what will be displayed in that cell?
3. If you enter = 500150 into a cell of a spreadsheet, what will be displayed in that cell?
4. What should you enter into a cell if you want it to display a value that is 4.5 times greater than the value displayed in cell
F1 1?
5. What is the name (address) of the cell in the sixth column, fifth row of your spreadsheet?
6. If cell B3 contains the value 300, what will be displayed in the cell FS if it contains the formula = (0.8*B3)?
7. If the cursor is presently in cell M235, what command key do you press to be able to move the cursor to cell AI without
using the scroll bars?
8 . If cell Ell contains the formula =(08 + D9 + DIO), how do you change it to contain the formula =(08 + 09-DlO)?
Build the following spreadsheet model for Problems 9 through 17:
A
I
2
3
4
5
6
7
8
9
10
II
12
13
14

9.
10.
11 .
12.
13.
14.
IS.
16.
17.

B

c

0

E

Jones Co.
Sales Analysis
Gross Sales
Cost of Widgets
Cost of Framitz
Cost of Dingies
Cost of Nuts & Bolts
Cost of Sealant

476000
= (E4*0.315)
= (E4*0.113)
= (E4*0.102)
= (E4*0.122)
= (E4*0 .058)

Total Costs
Profit from Sales

What is the formula for Total Costs? In what cell should you put this formula?
What is the formula for Profit from Sales? In what cell should you put this formula?
What is the present Profit from Sales?
Change the Gross Sales to 500000. What is the new Profit from Sales?
What is the cost of Widgets when Gross Sales are 375000?
What are the Total Costs when the Gross Sales are 525000?
What percent of Gross Sales are the costs of Nuts & Bolts?
What is the cost of Sealant when Gross Sales are 481000?
Change the percent of Gross Sales cost of Widgets from 31.5% to 33.8 %. What are the Total Costs and Profit from Sales
if Gross Sales are 593400?
18. Create the following spreadsheet model with this information:
I) The Cost of Goods is 55 percent of Sales.
2) Salaries are 10 percent of Sales.
3) Overhead is 26 percent of Sales.
4) Other expenses are 4 percent of Sales.
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Use the appropriate formulas to compute the gross and net profit values.
SALES
COST OF GOODS
GROSS PROFIT

500
275
225

EXPENSES
SALARIES
OVERHEAD
OTHER
NET PROFIT

50
130
20
25

19. What is the net profit in the model created in Problem 18 if sales are 879 and the cost of
goods and the expenses remain the same percentage of sales as in this model?
20. What are the salaries in the model created in Problem 18 if sales are 1262?
21. What is the gross profit in the model created in Problem 18 if sales are 682?
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CHAPTER OBJECTIVES

Upon completion of this chapter, the student will:

•
•
•
•
•

Retrieve a spreadsheet from disk.
Explain the concept of the spreadsheet window.
Move the spreadsheet window.
Explain what a range of cells is.
Explain the difference between relative and
absolute cell address copies when replicating
cells.

• Use the relative and absolute cell copy features.
• Use the SUM, AVERAGE, COUNT, IF and
HLOOKUP built-in functions in a spreadsheet.
• Nest functions within other functions.
• Find information about other built-in
functions.
• Print the spreadsheet.

-

10.1 USING THE ELECTRONIC SPREADSHEET
In the last chapter you learned how to start your electronic spreadsheet program, move the
cursor, create a simple spreadsheet model, modi fy that model, print the model and, finally, how
to save the model.
This chapter starts by showing you how to reload the spreadsheet model you built in the last
chapter. After that you will explore more of the fundamental aspects of the spreadsheet window.
Finally, you will explore some of the features of electronic spreadsheet programs that simplify
model building.

-

1 0.2 RETRIEVING A MODEL

The usefulness of the spreadsheet program would be greatly diminished if you could not save
your work onto the floppy disk and retrieve it when you needed it at a later date. In the last
chapter you learned how to save a model. Now you must get that model back to work with it.
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After you boot your Macintosh with a System Start-Up disk, insert the Excel Program disk
into one of the computer's disk drives. If you are using a machine with a hard disk you will not
need to insert the Excel program disk into a disk drive. Rather, locate the Excel folder, and open
it so you can see the Excel program icon. Place a disk (see Chapter 3 for how to initialize a new
disk) with at least 200K avai lable space into a nother one of your Macintosh's disk drives, if you
have one available. This disk will be used for saving your work. If you do not have a free floppy
disk drive, keep this disk available. You will need it for data storage.
In these instructions, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets, (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase " Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase "Double-click the mouse on ..." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed.
Finally, if you want your work to match the figures in the text, be sure to use the Chooser
DA to select a LaserWriter and not an ImageWriter. You may select a LaserWriter even if your
computer is not actually attached to one. You will not, however, be able to print if this is the
case.
There are two ways to open an existing document when using Excel .
First, you may double-click on the document 's icon on the storage disk. The Macintosh will
figure out which application program created the document and will automatically launch the
program for you. This will only work, however, if the program can be found in one of the
computer's disk drives. If you are using a floppy disk-based computer, you may not always have
the program disk in a disk drive, so this method will not work for you. If you have two floppy
disk drives , it is possible to launch an application from one of it's documents if you eject the
System Start-Up disk , and replace it with the program disk, leaving the document disk in the
second disk drive. You will find, however, that the compute r frequently requires information off
the Start-Up disk, and that you will do several disk exchanges before the program is running. It
is best to start the application, and then open the document.
The second method available for opening existing documents is to use the Open command
found on Excel's File menu. This command will let you inspect the contents of all the disks in
your computer. It even lets you eject unwanted disks from a disk drive and put different ones in.
Clearly, to use this option, you must first launch the Excel application.
If you are using a computer with a hard disk, begin here:
Figure 10.1
This is the icon you will
see for Excel spreadsheets.
WHAT

TO Do

WHY

You ARE DotNG IT

Locate the icon for the spreadsheet you
prepared and saved at the end of Chapter 9 and place the mouse pointer on it.

You are going to launch Excel by double-clicking on this
icon. Figure 10.1 shows the icon that Excel creates for
its Spreadsheets. The name of this particular one is
Mode11.

Double-click the mouse.

By double-clicking on an Excel spreadsheet, the Macintosh will look on all available disks for the Excel application program. If found , it will launch Excel and open the
spreadsheet. If the Macintosh is not able to locate the
application program, you will see the dialog box shown
in Figure 10.2.
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Figure 10.2
You will see this dialog
box if the Macintosh is not
able to locate the Excel
application program to
open the file you are
double-clicking.

The file "Modell· could not be
opened/printed (the application Is busy
or missing).

I

OK

)J

If you have the Excel application program on your hard
disk, or on a floppy disk currently in one of the computer's disk drives, the program should start, and after a
brief wait, the spreadsheet you prepared during the last
session will appear. You are now ready to begin modifying the spreadsheet.

'

$

File

Edit

Formula

Format

Oete

XQ

Options Macro

Window

.,

Figure 10.3
The retrieved spreadsheet
should look like this.

This is the Command Key equivalent for the Quit command fo und on the File menu.
You are quitting now so that you can learn how to use the
Open command. Normally, you would not quit the Excel
program after you load the spreadsheet you want to
modify!
If you are using a computer that has only floppy disks, then start here:

Locate the icon for the Excel program.

You will launch the Excel application program by doubleclicking on it.

Move the mouse to the Excel icon and
double-click.

The double-click will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu, or press XO, the Command
Key equivalent.

371

372

CHAPTER TEN -

INTERMEDIATE ELECTRONIC SPREADSHEET CONCEPTS

After a brief wait, Excel will be running, and you will
have a new spreadsheet, called Worksheet! , in lhe
window.
Move lhe mouse to lhe window's close
box.

Remember, lhe close box is the one found at lhe left of
the title bar (Figure 10.4).

Figure 10.4

,.

The mouse pointer is on
the close box at the left of
the Title bar.

•

File

AI

Edit

I

:: ~ ----
\-~Click lhe mouse button once.

Figure 10.5

Your Macintosh after you
have closed the new
worksheet. All that is
showing is the current
menu bar. If you are using
MultiFinder, you may have
other items showing on
the desktop.

,. •

File

Close the worksheet. You are going to open an existing
worksheet, and it will be less confusing to work wilh
only one spreadsheet active.

Edit

I

Window

I

Pull down lhe File menu.

The File menu has lhe Open command.

Drag lhe mouse pointer down to lhe
Open command.

The Open command lets you open ex isting spreadsheets
found on disk. Note lhat lhe Open command has XO as
a Command Key equivalent. You may recall lhat this is
the same key used by lhe Finder's Open command.

Figure 10.6

The Open command has
been selected.

.,
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Release the mouse button.

Execute the Open command.
After a brief pause, you will see a dialog box similar to
the one displayed in Figure 10.7, although the name of
the disk being displayed and the free space on the disk
will probably be different.

' 4i ~Edit

.........

.,
Window

The Open dialog box.
Since Excel was launched
from the Hard Disk, this is
the one showing in the
current dialog box.

Open Docr-u_m_,e_,..,n....t ______.,.........
HRRO DISK

ICJ

0 my stuff

:!1

c= HRRD DISK

CJ Software
CJ System Folder
•

•••

0

....
. . ... .
' . ..

.. . .

Cl Utilities

-:-:-:-:-:

Click the mouse on the Drive button
shown in the dialog box.

'

4i ~Edit

:·:·: ·:·:·

.,
Window
·. .

~l~~~~~~H
... . .

Open Document
'"'I
jg)=...,.M_Y_D__R__
T_,RI

~~nnnn
.... .... ..
. . .. .
....
. . ...
. . .. .

L J IIIOIOIIIJ foldl'l
Cl Graphics Folder
CJ History Folder
D Letter to Alice
D Modelt
D Test Document

. ....
::::::: :::.:: :::::::

. . ...

.-:-:-:-· ·

The Drive button tells Excel to display the spreadsheet
and folder names found on a second disk currently in
your computer. This may be a floppy disk, or a hard
disk. If you do not have a second disk in the computer,
then the Drive button will be dimmed, and you will not
be able to use it.
Continue clicking the Drive button until the name of the
disk that contains your file appears in the dialog box.

. ·'·. ····· ....
· !·.

:!)

:-::

jg) MY DRTR
Eject
Driue

n

Open
Cancel

~J

D

After clicking on the Drive
box, the contents of the
disk called MY DATA is
displayed.
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You want to open the spreadsheet you named " Modell ."
By clicking the mouse pointer on the name in the dialog
box, you are selecting this spreadsheet.

Click on Modell .

Figure 10.9

The spreadsheet
" Mode/1 " has been
selected.
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Click on the Open button.
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Command-?

Execute the Open command. After a brief pause while
the compute r reads the spreadsheet, you wi ll see the
Excel spreadsheet in the current window.
You should remembe r that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the spreadsheet name, rather than
selecting it and then clicking on the Open button in the
dialog box.

When the file is loaded , the c urso r will be placed o n the cell it was in whe n the spreadsheet
was saved. Here, the range A3 :B5 has been se lected , and the cursor is in cell A3.
Figure 10 .10

The spreadsheet you
created has been loaded
back, and the cursor is
placed in the cell it was in
when the spreadsheet was
saved.
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File

Edit

Formula

Format

Data

Options

Macro

Window
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1 0.3 THE DISPLAY WINDOW

Even computers with limited amounts of memory have spreadsheet programs that allow you to
create models much larger than can be displayed on the machine's monitor. As a consequence only
a portion of the total worksheet is viewed at any given moment in the current window. Depending
on how you like to think about things, you could say that to see other segments of the model, the
window is moved around over the whole (stationary) spreadsheet (this is how most people view the
situation) , or that the spreadsheet is moved around under the (stationary) window.
r IV£

1'[AR
101

r

ISCA\. fOUCASt BASCO 0 ., Ill

Figure 10.11

lro(R(AS( I'(IP •CAR

DUUIPl

•£A'i' 0

" 12!

" " Pfi'Qr

" 101

CO, SUI.ftol

..

CD:)[

100

Il l

"

,...

1847

20)0

12'11

Y(AR• l

•(A.I I• 1

<r(AR•l

l (AIIi · <~~

The spreadsheet window
moves over the larger
spreadsheet.

....,

•tAR· ~

---------------------------------------------------------------------,. 1171 ,
ISS•
\10!
111!
•11or SAI..R
" 140
suo
#1)4

" ISS

P•l I
Pll II

suo

,,,.
" l]]

P /1 Ill
#I t T IV

suo
• ISO

• 157

I'(RL• I
MillY II

SUB
" 210

" 211

" 212
" 21J
" lU
" 215

5Dt SEC
lll[tR.,.,I

Lll DIS
Jpo

~Lho

r1AJ
\i(,

ruo
CnP

10

.....

1081

,.

I )I

11 1

107

117

..
...

.,

,.,
..."
II

"

10

"

..
,..

,.,
••
"

...

I )\I

.,

...
..
121

II

10
l7

,.
128

CG

"

"

3&

,.,
,".

.., .......,
"

l <~ Sl

,,,

...,.

,.

•S•

ISS

,

'"
...
"

0
6
7

G

152

GO

139
66

72

167
79

183
86

116

127

ss

'"

187

20S

224

246

269

II

107
20

117
22

128
24

140
26

IS4
28

169
30

8
9
10

12

127

139

IS2

166

182

199

,.13

62

68

81

1S

14

IS

74
16

89
18

97
19

16

"

18
19
20
21

"

76

83

90

98

107

116

200
110
10

220
121

sr-

266
146
13
66

292
160
14

so

242
133
I2
60

321
176
IS
79

II

72

-

1 0.4 MOVING THE WINDOW

No matter how you view the relationship between the window and the spreadsheet page, you are
able, through proper manipulations of the cursor, to see any area of the complete page.
There are several ways you can do this. First, spreadsheet programs allow you to make
direct cursor jumps using the Goto command. You simply Goto a cell that is not currently inside
the window. You used the Goto command in Chapter 9.
The second way is to use the cursor to push the edge of the window. This is done by moving
the cursor to the boundary of the window, then moving it one more row or column in the same
direction. In effect, you are moving the display window either left, right, up, or down, or, if you
like, you are scrolling the spreadsheet page up, down, left, or right underneath the window.
Finally, you may make use of the scroll bars found to the right and below the active
spreadsheet window. The Excel scroll bars work in almost the exact same fashion as the scroll
bars found with any other Macintosh application. By moving the slide box on the scroll bar,
Excel does not take you to the extreme of the spreadsheet. Recall that the limits of the spreadsheet are 254 columns and 16384 rows. The scroll bar has been made less sensitive, moving
only a few rows and columns. You may use the arrows at the ends of the scroll bars to continue
the scrolling process. Once a cell far to the right, or far down is occupied, the distance the scroll
bars will move the spreadsheet is expanded.
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As you can see in Figure 10. 11 , the window is presently displaying columns C through H . If
you want to see column I, you move the cursor right until it is in column H. You then move the
cursor right one more time. Now you will be looking at columns D through I of the spreadsheet.
Columns A , B and C still exist, but they are no longer visible. Of course, you could use the
scroll bar at the bottom of the window to shift the window right (or the spreadsheet left) to be
able to see the desired portion of the spreadsheet.
You use the cursor or right side scroll bar in a similar fashion to see additional rows. The
difference, of course , is to move it vertically rather than horizontally.
When you use the Goto command, if you give a destination cell that is not already inside the
window, the window shifts so that the cursor is placed in one of the four corners of the window.
However, if the destinatio? of the GOTO is inside the window, the c ursor is simply moved to that
location without any change in what is displayed inside the window.

WHAT

To Do

WHY

You ARE

DOING IT

XG

The Goto Command. Remember that this command may
be fou nd on the Formula menu.

A 720 [cr]

Give cell A720 as the destination of the Go to command.
Since the OK button is double outlined, you may activate
it by pressing the Return key, or by clicking on it with the
mouse. Note that when you press the Return key, the cursor is moved to the new location and the whole screen
display changes.

·F igure 10.12
Your Mode/1 spreadsheet
window after you execute
the first Goto command.

r

lit File Edit Formula Format Data Options Macro Window

,

XG

Goto again.

CT123 [cr]

Give cell CTI23 as the destination of the Goto command.
Again, the whole screen changes. The destination cell
(CT123) is placed at the top right of the display.

Macintosh Productivity Tools

r

•

File Edit Formula Format

Data Options

Macro Window

.,

Figure 10.13
The cursor is now at the
top right side of the
display.

XG

Goto again.

CR130 [cr]

Goto cell CR130. This cell is inside the present window.
The cursor is relocated, but the whole window is not
scrolled. Cell CT123 remains at the top right of the
display.
Figure 10.14.
The cursor has moved, but
the content of the window
remains unchanged.

Hold down the Command Key and press the left arrow.
The cursor will move to cell Al30. Recall that this key
combination moves the cursor left until there is a change
from an empty to an occupied cell. Since there are no
cells in use on row 130, the cursor will move all the way
to the A column.
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XG

Goto again.

Al [cr]

Return the cursor to the top left corner of the spreadsheet.

XG

Goto again.

AlOO [cr]

Move the cursor so that it will now be on the last row displayed in the current window.

Figure 10.15
The cursor is on the
bottom row of the current
window.

Press the down arrow five times, using the cursor to push
the window down (or the spreadsheet up). The cursor
should now be in cell K 105.
Press the right arrow ten times, using the cursor to push
the window right. The cursor should now be in cell

Kl05.
Figure 10.16
The current display.
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Window
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You may, of course, use the cursor to push the window either up or left by moving it to the
left or top of the window and then pressing a cursor movement key.
Return the cursor to the A column. It should now be in
cell Al05.
Try moving the cursor LEFT. You cannot. There are no
columns to the left of column A on a spreadsheet. Nothing will happen. You will get the same results if you try
to move the cursor above row I of the spreadsheet.

Macintosh Productivity Tools

-

1 0.5 COPYING CELLS INTO A RANGE OF CELLS

A major aspect of using financial models is to extrapolate a history of financial information in an
attempt to predict where a business may be heading. This means that large portions of models
may effectively be the same in terms of basic relationships.
For example, consider the model you built in the last chapter and retrieved at the beginning
of this chapter. A major assumption when you started building this model was that costs would
always be 70 percent of sales and that profits would always be sales minus costs. You may want
these relationships to hold true if you extrapolate the model for one more year or for twenty.
Because of these constant relationships, it is possible to use the program to copy existing
cells into unused cells and then have it adjust any formulas in the cells to reflect the new
locations of the formulas. For example, if you copy the profit cell from the B column to the C
column, you want the formula in the cell to read = (C3-C4), not = (B3-B4). In fact, when you
do the copy, this is what will happen. This type of adjustment in the cell addresses is called a
relative cell copy.
Another way to think of what is happening when performing a relative cell copy is to view a
cell reference in a formula as a distance specification. If cell G 18 contains the formula
= (0.07*El3), then E13 specifies a distance from G18 . The distance between G18, which
contains the formula , and the referenced cell E13, is left two columns and up five rows. If cell
G 18 is copied to cell M35, the cell reference will be adjusted so that the relative distance
between the new cell (M35) and the one referenced by the formula is kept the same, or two
columns to the left and five rows up. M35 will contain a formula with a reference to cell K30,
two columns left and five rows up.
It is also possible, and sometimes desirable, to copy cells and not have the cell addresses be
changed. This is called an absolute cell copy. You may want to perform this type of copy when
you want to divide the value in a range of cells by the same value found in a single cell . For
example, you would include an absolute address when copying a formula to divide all the
numbers of a profit and loss statement by the gross income figure.
With an absolute cell reference defined in a formula , no matter where the cell is copied , the
reference will refer to the same cell. It is as if a rubber band is linked between the cell and the
one being referenced. No matter which cell the formula is copied into, it keeps the rubber band
attached to the same, absolute, cell.
It is possible to copy a single cell, or to copy a group of cells. In either case the cell or cells
being copied, and the cell or cells being copied into, are ranges. You learned about ranges in
Chapter 9. At that time, you learned how to define a name for a range, and how to input
information into the cells of the range. You also used the Goto command to select a range.

-

1 0.6 USING THE RELATIVE COPY COMMAND

Assume that the model you built in Chapter 9 represents the first year of operations of a
hypothetical company. Further, assume a two percent annual growth rate. The formula to be
placed into cell C3 to compute two percent annual growth can be expressed in different ways,
producing the same result: = (1.02*B3) or = ((0.02*B3) + B3). Now you will extend the model
to show what the sales, costs, and profit will be after fifteen years of operations with an annual
growth in sales of two percent.
Excel has two methods available for copying cells. You may use the Copy command to place
a copy of a cell's contents into the copy buffer. This is followed by the Paste command, which
recalls the information from the copy buffer and places it into the selected area of the spreadsheet. The second method you may use is the Fill command. This is a special case of the copy/
paste sequence. It works only when the destination of the copy is immediately adjacent to the
original cell.
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WHAT

To Do

WHY

You ARE DOING

IT

:M:G

The Goto command.

A I [cr]

Move the cursor to the top left corner of the spreadsheet.
The model you built while working in Chapter 9 should
now be in view in the window.
Move the cursor to cell C3. The sales amount for the first
period is already in cell B3 .

= (1.02*B3) [ENTER]

Enter this formula into cell C3 , and finish by pressing the
enter key. The enter key will leave the cursor on this cell.
The formula you have entered into cell C3 represents 2
percent growth from cell B3 to cell C3. Since cell B3
contains the value 100, cell C3 should now contain the
value 102.

Figure 10.17

The formula you entered
into cell C3 is displayed on
the edit line above the
current worksheet
window.

.. •

File Edit Formula Format
C3
=( 1.02*63)

Dote Options Macro

Window

.,

Modell

c

Place the cursor over cell C3.

You are going to copy this cell into cells 03 through and
including P3. For this first row you will use the Fill
command.

Press and hold the mouse button.

Begin the cell selection process.

Drag the mouse right until you have
reached cell P3 .

Select the range into which you want to copy the formula.
When the cursor reaches the right edge of the window,
the window will scroll. The edit line, just below the
menu bar, will read " I Rx 14C" indicating the siz e of the
selected range.

Figure 10.18

The edit line indicates that
one row by fourteen
columns have been
selected.

,. ti File Edit Formula Format Data Options Macro Window

.,

:( 1.02*63)
Modell
N

0

--- ---------- ! - - - - f -

Release the mouse button.

Complete the selection. Note that the edit line shows that
the current cell is C3. This is the anchor cell of the
range, and the presently outlined cell, even though it is
out of the window to the left.

Pull down the Edit menu.

The Fill command is on the Edit menu.

Macintosh Productivity Tools

Since you have a cell that you want to copy into a row,
you must fill to the right. Note that this command may be
accessed by the XR key. If you had a cell that you wanted
to copy into a column , you would use the fill down command , or XD .

Drag the mouse down to select Fill
Right.

Figure 10.19
The Fill Right command
has been selected.

Posle \p~clal...
Posle link
Delete .. .
Insert .. .

Execute the Fill Right command. When you release the
mouse button, the cells of row 3 will be filled with numbers. You can see that they are increasing in value.

Release the mouse button.

,.

.

Edit

Formula Format
: ( 1.02*B3)

Date Options

Window

Figure 10.20
The row has been filled.

The right arrow key will de-select the row , and move the
cursor right to cell D3. Look at the formula displayed in
this cell. It reads = ( 1.02*C3). The 83 of the cell being
copied was adjusted to become C3. If you move the cursor to the right along row 3, you will see that the cell reference in the formula has been adjusted in each cell.
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Figure 10. 21
The adjusted formula is
now in cell D3.
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Return the cursor to the A column.
Use the mouse to select cells B4
and BS.
Figure 10.22
Both cells 84 and 85 are to
be copied.

You are now going to copy both cell B4 and cell BS.

~ •

File
64

Edit

Formula Format
: (0.7*63)

Data

-¢ -

Pull down the Edit menu.

Before using the Fill command to copy these cells, you
are going to try the Copy and Paste commands.

Drag the mouse down to the Copy
command.

You are going to copy the two selected cells. As with
most other Macintosh applications, the :M:C key will execute the Copy command.

Figure 10.23
The Copy command has
been selected on the Edit
menu.

Ptls 1e ~ ll t>t: i lll...
Pns1e Unk

Insert ...
Fill Right
Fill Down

Release the mouse button.

Figure 10.24
The border around the
cells in the copy buffer
becomes moving dashes.

When you release the mouse button , the two cells are
copied into the copy buffer. The border around the
selected cells will turn into a moving line of dashes .
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Macintosh Productivity Tools

Move the cursor to cell E4. Now that you have the
desired cells in the copy buffer, you must reposition the
cursor. You want to place the copies into cell E4.
Pull down the Edit menu.

The Paste command is on the Edit menu.

Drag the mouse down to the Paste
command.

The Paste command will take the information in the cut/
copy buffer and place it at the current cursor location. It
may be accessed by using the XV key.

Release the mouse button.

Paste the two cells into the spreadsheet. Since two cells
cannot fit into one, the second one spills down into the
next ceiL
Figur e 10.25
The information has been
pasted into the destination
cells.

The Fill Right command will let you copy the contents of
a cell only to a cell that is immediately to its right. You
cannot skip a cell as you did in this example.
Place the plus cursor on cell E4.

You are now going to try filling backwards, from E4
to C4.

Press and hold the mouse button.

Begin the selection process.

Drag the cursor left and down to cell
C5, then release the mouse button.

You are going to try filling into these cells. Cell E4 is the
anchor cell, and its contents show on the edit line above
the window.
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Figur e 10.26
You are going to try to fill
from cells E4 andES
backwards to C4 and C5.
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XR

Execute the Fill Right command . All the selected cells
will become blank.

Figure 10.27
After you execute the Fill
Right, all the cells in the
selected range will be
empty.

Even though the anchor cell was occupied, the Fill Right
command copies the content of the leftmost cell of the
selected range. This was an empty cell, and that is what
was copied!
Select cells B4 and B5.

Now you are going to build the rest of the model. In the
future, you may use the Fill Right command. This time,
however, you are once again going to use the Copy and
Paste commands.

XC

Use the Copy key instead of the menu. The two cells are
now in the cut/copy buffer.

Select cells C4 through P5 .

These cells represent the destination of the copy, where
you want to paste what is in the cut/copy buffer.

Figure 10.28
Part of the selected
destination of the copy/
paste process.

XV

Figure 10.29
The right portion of the
spreadsheet you are
creating is now filled.

Use the Paste command to place the information into the
selected range.

Macintosh Productivity Tools

Return the cursor to cell A4.
Pull down the File menu, select Save As
and release the mouse button.

The Save As command will let you change the name of
the spreadsheet as you save it.
Figure 10.30
The Save As command has
been selected.

When you release the mouse, you will see the Save As
dialog box.
Save this modified version of the original model with the
name Model2. It is always a good idea to save your work
periodically, especially after you have made major
changes, such as the ones you just made. If something
now happens to crash your computer, you will not have to
re-create the work just entered. By changing the name
periodically, you can create a history of the development
of your model.

Model2

Figure 10.31

I(g) MY DATA I
0 Biology Folder
0 Graphics Folder
0 History Folder
D. lt.>t tt.>r to RUce
Ci Mod<ill
D Te~t Oo1:urnent
Saue Worlcsheet as:

!Model~

~

(g) MY DATA

The spreadsheet name is
being changed to Modell.
Using this command, you
may also change the disk
or folder where the
spreadsheet is placed.

EJect
Drlue

15

n

Saue

[

Cancel

I

l

( Options

Click on the Save button.

Complete the save process. Since the Save button has a
double outline, you may press the Return key to execute
this command .
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1 0.7 BUILT-IN FUNCTIONS

In addition to the cell copy procedure , there are other features of spreads heet program s designed
to help building models an easier task. One major group includes a variety of special computational and conditional functions. These functions perform tasks on a range of the s preadsheet
cells.
The functions avai lable to you include mathematical operations, such as summing a range of
cells or giving you the average value of a range of cells. They include financial functions, s uch as
computing the net present value of a cash flow found in several cells. They include conditional
functions which let the program select from two different computations or values based on a
criteria you specify. They even include some statistical functions , such as the standard deviation
of a range of cells. These special functions may occupy a cell by themselves or be included as
part of a n arithmetic expression in a value cell.

-

1 0.8 SUMMING RANGES OF CELLS
Possibly the most frequently used built-in spreadsheet function is the one that sums the values in
a range of cells. The function used to add the values in a range of cells is the SUM function. It is
used to replace a formula such as

(05 + 06 +07 + 08 +09 + 010+011 + 012+ 013 + 014 +DI S+ 016+ 017).

WHAT

To Do

WHY

You ARE DotNG IT

This will move the cursor to cell P4 and scroll the window for you at the same time. You are performing the
same function as X +-, but in the opposite direction.

- t

Figure 10.32

Move the cursor to cell Q3. This is where you will place
the sum of the sales for the 15 years.

r

The cursor is in cell Q3.
This is where you will put
the next formula.
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= SUM(B3:P3)

Macro Window
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---124.337431 ~f>.8241 79 129.360663 131.947876
87.0362016 88.7769256 90.5524641 92.3635134
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This is the Sum function. It means to sum all the cells
listed inside the parentheses. In our case we have specified a range so that all the cells between and including B3
to P3, a fifteen-cell portion of the third row of the
spreadsheet, will be included in the sum.

Macintosh Productivity Tools

You should notice two things in the formula you are entering. First, is the colon which
separates the two cell addresses. The colon is how you can identify a range. Ranges are entered by
specifying the top left cell, a colon, and the bottom right cell of the range. The range from AS
down to 012 would appear as A5:Dl2. Next, you can see that no spaces are entered in the
function . There are none between the word SUM and the left parenthesis, and none inside the
parentheses. If you put spaces after the word SUM and before the left parenthesis, Excel will give
you an error message. The other spaces it will remove when the formula is entered into the cell.

r

Figure 10.33

lit File

Macro

Window

The formula and cell
before the Enter key is
pressed.

Q3
H

::

2
3

124.337431

[ENTER]

r

lit

Enter the formula into cell Q3. The sum will appear. The
cursor will remain in cell Q3 .

Edit

Formula Format
:SUM(B3:P3)

Date

Options

Macro

.,

Window

Figure 10.34
The formula has been
entered into cell Q3.

Model2

[SHIFT]

Hold down the shift key on the computer's keyboard for
the next action.
By holding down the shift key you are anchoring the cursor in its current cell. Pressing an arrow key then lets you
select a range. You have done this same task by using the
mouse.

Mocro

Window

.,

Figure 10.35
Cells Q3, Q4 and QS are a
selected range.
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XD

This is the Fill Down command. It may be found on the
Edit menu, below the Fill Right command .
The two sums will be calculated and placed in cells Q4
and Q5. If you look at the formulas now in these two
cells you will see that you have just executed a relative
copy. The formulas now reflect rows four and five, rather
than the original row three.

Figure 10.36
The results of the Fill
Down command. Cells Q4
and QS now have values in
them.

-

10.9 AVERAGING A RANGE OF CELLS

Another useful built-in function is the AVERAGE function. This computes the arithmetic average of the range of cells. That is, all the numbers in the range of cells are summed and then
divided by the number of cells in the range. Excel counts the number of numeric cells in the list
of cells specified in the function to determine the value to use for the denominator when
computing the average. If you include text cells in the list, or range, of cells for which you want
an average they will have no effect on the computed value!

WHAT

To Do

WHY

You ARE DotNG

IT

-+

Move the cursor right to cell R3.

= AVERAGE(B3:P3)

T his is the Average function. It is averaging all the cells
between and including B3 through P3.

[ENTER]

Enter the function into cell R3. The average of the 15
numbers will appear.

Figure 10.37
The average of the 15 sales
figures is computed in
cell R3.

r
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File Edit Formula

Format

Data Options Macro

:AVERAGE(B3:P3)

Model2
0

p

129.360663 131.947876 1729.34169

Window

.,

Macintosh Productivity Tools

[SHIFT]

Hold down the shift key on the computer's keyboard.

!!

Select the cells R3, R4 and R5.

3€0

Execute the Fill Down command.
Figure 10.38
The results of the Fill
Down command. Cells R4
and RS now have values in
them.

A useful bit of information is the moving average. This takes several periods of numeric
information and g ives an average. The next value in the lis t of moving averages drops the first
value from the ones being averaged, and adds a new number in its place at the e nd of the list. For
instance , the first value for a three month moving average will average the values for months 1, 2
and 3. The second moving average value will average the values for months 2, 3 a nd 4, while the
third will use months 3, 4 and 5.
Now that you know how to use the AVERAGE function, use it to add a three year moving
average to the model being created.

WHAT

TO Do

WHY

You ARE DoiNG lr

Move the cursor to cell A3.

! ! !!

Move the cursor to cell A7.

3 YEAR MOVING AVERAGE
[ENTER]

Label this line of the spreadsheet. Even though a number
starts this cell, since you are mixing it with text Excel
will treat is as a label cell.
You can see that this text is signi ficantly larger than the
width of the A column. Excel will let text overflow into
the adjacent cells as long as these cells are empty.
Figure 10.39
The text has overflowed
into the B column.
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.....

Move the cursor right one cell to 87 . Notice that while
text is currently displayed in the cell, the cell itself is
empty. You can tell this by looking at the left end of the
edit li ne which shows that the cursor is placed in cell 87,
but that nothing is in the cell at present.

..

Figure 10.40

The cell 87 is empty. The
text is overflowing from
cell Al.
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Place the cursor in cell D7 .

= AVERAGE(B3 :D3)

The cell formula will give an average of the first three
years of sales.

[ENTER]

Enter the formula into the cell.

Use the mouse to select the range D7
through P7.

Put the mouse on cell D7, press and hold the mouse button, and drag the mouse to cell P7 before releasing the
button. You can tell that cell D7 is the anchor at the left
end of the range since it appears as the anchor address on
the edit line above the worksheet window.

Figure 10.41
The range Dl through Pl

is selected. Yo u can see
that D l anchors the range,
since that address appears
on the edit line.

Edit Formula Format Data
: AVERAGE(B3:D3)

Options

Macro

Window

,

Model2
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t1
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, ;~:;;;~.824l79
35.8527771 36.5698326

XR

Use the Fill Right command to copy the formula for the
moving average into the selected range of cells.

After the Fill Right command, which you remember is a spec ial case of the copy/paste
procedure, has been executed, move the cursor right on row 7 of the spreadsheet. Confi rm that
the formula has properly adjusted and that the three period average is indeed moving.

Macintosh Productivity Tools

-

1 0.10 COUNTING THE NUMBER OF ENTRIES IN A
RANGE OF CELLS

At times you may need to know the number of non-blank entries in a range or list of cells. The
average function you just used does this. If you are creating your own statistical function, you
may need to be able to do the same. The COUNT built-in function does this for you .

WHAT

To Do

WHY

You ARE DoiNG IT

Move the cursor to cell P7.

...... ...... ...... ...... ...... i i i i

Move the cursor to cell U3 .

= COUNT(83:T3)

This is the Count function.

[ENTER]

Enter the function into cell U3. T he number 17 , representing the number of numeric cells between and including cells 83 and T3 , should appear.

Edit

Formula Format

Data Options Macro

Window

.,

:COUNT(B3:T3)

Model2
R

S

T

u

Figure 10.42
The Count function has
found 17 cells in the range
that contain numeric
values.

1729.34169 115.289446
1210.53918 80.7026123
518.802507 34.5868338

+-

1 [ENTER]

Put a value into cell T3, which is inside the range being
counted. The count displayed in cell U3 should change to
18 because you have changed a blank cell into a nonblank numeric cell.
Enter text into the cell. The count displayed in cell U3
should return to 17. The Excel Count function counts
only numeric cells in the specified range. Text cells are
not included in this count.

WORDS [ENTER]

r

.t File Edit formula Format Data Options Macro Window
T3

WORDS
R

s

Model2

.,

Figure 10.43
The text cell T3 does not
affect the value of the
COUNT function in U3.
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1 0.11 CLEARING A RANGE OF CELLS
You now have information in cell T3 that is not desirable. Let us see how to correctly remove the
conte nts of a cell.

WHAT

To Do

WHY

You ARE DotNG

IT

Move the cursor down to cell T4.
[SpaceBar][SpaceBar] ... [ENTER]

t

Press the space bar at least 25 times before you press the
enter key.
Return the cursor to cell T3 .
Note that the gridline between cells T4 and U4 is now
missing (Figure 10.44). The space characters you have
entered into cell T4 take up space, and are overflowing
into cell U4. By this, it is safe to surmise that the space
character will not clear the contents of a cell! Using the
space simply places a space character into the cell.

Figure 10.44

The space characters are
overflowing into the
neighboring cell.
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[SHIFT]-!

Select cells T3 and T4. You now want to remove the contents of both of these cells.

Pull down the Edit menu.

This menu has the Clear command.

Drag the mouse down to select the Clear
command.

The Clear command, which may be accessed with 3!:B ,
will remove the contents of a cell. You will see that it can
also remove formatting from numeric cells.

Figure 10.45

The Clear command has
been selected.

FIJI Right
FIJI Down

Macintosh Productivity Tools

Release the mouse button.

Execute the Clear command. You will now see the Clear
dialog box.

Click on the All button.

You want to erase everything from the cells.

Click on OK.

Clear the two cells. The text in cell T3 and all the spaces
in cell T4 are removed.

pat a Options
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Figure 10.46
The cells have been erased.
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10.12 A CONDITIONAL ACTION FUNCTION

It is not uncommon to want to have the spreadsheet perform one set of actions if one particular

situation is true, and another set of actions if the situation is false . For example, you may want
the word "PROFIT" displayed when the bottom line of the company's Profit and Loss statement
is positive, and the word " LOSS" displayed if this figure is negative. You may want one set of
calculations performed if the value in a particular cell is greater than that in another cell, and a
different set of calculations performed if this is not the case. This selection of actions is done
with the IF built-in function.

W HAT

To Do

WHY

You ARE DOING

IT

Click the plus sign cursor on cell T3.

You want to enter a formula in this cell. This will
de-select any other cells of the spreadsheet.

= IF(R3 < 120, "LOW" , "OK")

This is the IF function. It has three parts.

The first part, in this case R3 < 120, is a condition to be tested. In the example the test will
tell us if the contents of cell R3 is less than the constant 120. You can specify another cell or
enter a formula for either side of the comparison operator. In addition, you may use other
comparison operators. There are six of these operators, called Boolean Operators:

<>
<
<=
>
>=

equal to
not equal to
less than
less than or equal to
greater than
greater than or equal to

The second part of the function, " LOW" in the example, is the action that the function will
take if the condition being tested is true. This particular action is to display the word " LOW" in
the current cell if the content of cell R3 is indeed less than 120 . The action may also be a
formula or other arithmetic expression. You are not limited to text.

393

394

CHAPTER TEN - INTERMEDIATE ELECTRONIC SPREADSHEET CONCEPTS

The last pan of the function, " OK" in the eKample, is the action that the function will take
if the condition being tested is false. This particular action is to display the word "OK" in the
current cell if the contents of cell R3 are greater than or equal to 120 (the opposite of less than is
greate r than or equal to) . Like the action taken for the true value, this action may also be a
formula or other arithmetic eKpression. You are not limited to teKt.

WHAT

To Do

WHY

Enter the function into cell T3 . The word " LOW" should
appear, because the current value of cell R3 is less than
120.

[ENTER]

Figure 10.47
The If function has been
entered into cell T3.

You ARE DOING IT

r

*

Edit Formula Format Data Options Macro
=IF(R3< 120."LOW","OK")

Window

.,

Model2
S

T

XG

The Goto command.

B3 [cr]

Jump the cursor to cell B3. This cell contains the initial
year's sales value. All the following years grow from this
base.

120 [ENTER]

Change the starting year's sales to 120 . The average of
the 15 years sales will now be greater than the 120 used
in the IF function entered in cell T3.

XG

The Goto command.

T3 [cr]

Jump the cursor to cell T3 . The 15 year average is now
138.347335, and cell T3 displays OK, rather than LOW.

Figure 10.48
The If function now
displays OK, since the
value in cell R3 is greater
than 120.

Formula Format Data Options
: IF(R3< 120,"LOW","OK")
Model2
R

S

Macro

Window

.,

Macintosh Productivity Tools
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1 0.13 LOOKUP TABLES
Lookup tables are very useful when the formula for a value you may need is not easily determined or is derived from a series of IF-type comparisons. You can place the potential values into
a table of numbers and let the computer locate the particular one it needs when it needs it.
An example of a lookup table is the tax table that comes with your Federal Income Tax
forms. At the end of all your calculations , you have a value for taxable income. You then select
the appropriate table (single, married, etc.), and find the range of values in the left column of the
table between which your taxable income falls. Next you follow across the row you have located
to the number of exemptions you have claimed. When you stop, you have looked up your tax. All
you then need to do is compute the amount of additional tax, based on some percent, on the
amount over the bottom number you found at the left column of the tax table.
Let us change the initial assumption regarding this company's growth rate to take advantage
of lookup tables. Rather than fi xing the growth at two percent per year, we will base growth
upon total sales at the end of the year. Here are the new g rowth rate rules we will use:

• If sales are greater than or equal to 80 , and less than 90, the growth in the followi ng
period will be projected to be 3 percent.
• If sales are greater than or equal to 90, and less than 100, the growth in the following
period will be projected to be 5 percent.
• If sales are greater than or equal to 100, and less than 110, the growth in the following
period will be projected to be 9 percent.
• If sales are greater than or equal to 110, and less than 120, the growth in the following
period will be projected to be 7 percent.
• If sales are g reater than or equal to 120 , the growth in the following period will be
projected to be 5 percent.
Notice that this set of rules does not provide for the instance of sales less than 80. In effect,
the rules imply that a sales volume less than 80 is not allowed. You will see that the EXCEL
lookup function handles this case by displaying an error message. We will have to add a rule that
states:
• If sales are greater than or equal to 0, and less than 80, the growth in the following period
will be projected to be 2 percent.
These six rules can be combined into one multi-nested IF function. For example, it might
appear in cell C3 of the current spreadsheet as follows:
= (B3 + (B3*(IF(B3 < 90,IF(B3 > = 80,0.03,0.02),IF(B3 < 100,0.05,
IF(B3 < 110,0.09,IF(B3 < 120 ,0.07 ,0 .05)))))))

Fortunately the table of rules we are using is small, and you can fit the complete fo rmula
into the cell . However, the fact that you can fit the nested IF functions into a cell does not mean
that it is easy to read and interpret rapidly. The way the function in this cell was entered will also
require time to edit in the event you decide to make a change to one of the assumed growth rates.
Additionally, this formula appears in 14 cells of the spreadsheet, each one of which must be
edited!
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One way to simplify the potential editing problem posed by the previous formula is to place
the growth rate percents into cells of the spreadsheet and use these cell names in the formula.
Thus, when a growth rate percent changes, you will have to make only one change to the single
cell containing the particular growth rate. Since the formula contains the cell reference rather
than a numeric constant, the values in the cell will automatically be updated by the change in the
growth rate cell.
If the growth rate percents are placed into row 10 of the spreadsheet starting with column C,
the above formula will look like this:

=(B3 + (B3*(IF(B3<90,IF(B3 > =80, + DlO, + C10),IF(B3 <

100, + ElO,
IF(B3 < 110, + F10,IF(B3 < 120, + G 10, + H10)))))))

It is now easier to make changes to the growth rates, but it is no less difficult to read.
But what if you decide to refine the information in this table? Rather than looking at ranges
of sales that are ten units apart, you may want to look at ranges that are two units apart.
Additionally, rather than looking at a total range that starts with potential sales of 80 and deals
with specific values to 120, you may want to start with 60 and look at values as high as 140. You
will then need 42 rules similar to the six just stated! The six rules required 100 characters for the
desired formula. Nesting the IF functions to complete 42 rules would requi re more characters
than you can put into a cell (the limit to the number of characters a cell can hold is 255,
regardless of whether it is text, a formula, or a numeric constant).
This is the purpose of the lookup function . This function lets you perform multiple IF
comparisons with a single function that is easy to read and understand.

-

1 0.14 THE LOOKUP FUNCTIONS

There are three lookup functions available in Excel, HLOOKUP, VLOOKUP and LOOKUP.
They operate in essentially the same fashion. The difference is how the table is laid out in the
spreadsheet, horizontally (HLOOKUP) or vertically (VLOOKUP). If the values being looked
through (the range of taxable values in the example given earlier) are not adjacent to the results
table, then the LOOKUP function is used. In any of the cases, the table looked into may be
several rows deep or columns wide .
The functions make use of IF rules similar to the ones written out previously. HLOOKUP
searches the top row of a range until it finds a cell containing a value greater than a specified
value. It then moves back one cell, selecting the column with the cell whose value is the highest
number in the range less than or equal to the specified value. It then looks down the rows of the
range to pick a particular value to display.
The VLOOKUP function searches the left column of a range rather than the top row. It then
operates in the same fashion as the HLOOKUP function.
The LOOKUP function decides whether to look in the top row or left column based on the
shape of the lookup table.
In order to use one of the lookup functions, you must have a table of values for it to look
into. You will start this next section by building the necessary table for the HLOOKUP function
to use.

Macintosh Productivity Tools

WHAT

TO Do

WHY

You ARE DOING IT

:W:G

The Goto command.

Al [cr]

Move the cursor to the top left corner of the spreadsheet.

Move the mouse pointer to cell 014 and
press and hold the mouse button.

Move the spreadsheet cursor to cell 014. This is the
beginning of the input range for the lookup table you are
going to build.

Drag the cursor to cell H 15 and release
the mouse button.

This is the range of cells that will hold the initial lookup
table. The outlined cell should still be cell D 14.

r

•

File

Edit

Formul11

)

Form11t

D11t11

s

M11cro

Window

.,

Figu re 10.49
This is the range into
which you will put the
lookup table.

..

80 [ENTER]
90 [ENTER]
100 [ENTER]
110 [ENTER]
120 [ENTER]

This is the top row of the table. These values represent
the sales levels. By pressing the enter key, rather than the
return key, the cursor will move across the selected row,
rather than down the column. When you finish these
numbers, the cursor should be in cell 015.

0.03
0.05
0.09
0.07
0.05

These are the percentage growth rates. The HLOOKUP
function will be used to locate a sales level value in the
first row of the table (D14: H14), and then it will use the
value found directly below it in the table.

[ENTER]
[ENTER]
[ENTER]
[ENTER]
[ENTER]

Figure 10.50
The completed lookup
table.
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Move the cursor to the A column.
i iii i

Move the cursor to cell A9.

GROWTH RATE [ENTER]

Label this row of the spreadsheet.
Move the cursor to cell C9. This is where you will enter
the first HLOOKUP function.

= HLOOKUP(B3,014:Hl 5,2)

This is the HLookup function. It has three parts.

The first part, B3, specifies the cell containing the value being looked for in the table. You
can specify a constant, such as 45 or 19745.04; a cell, such as F9 or Il8; or enter a formula,
such as ((L15*J45)/C 12).
The second part of the function, D14:Hl5, is the range making up the lookup table. The
first row of the range, in this case row 14, is the row that EXCEL searches through for the value
specified in the first part of the function, in this case cell B3. If you were using a vertical
lookup, then the first column is where Excel looks up values, just as with the tax table discussed
earlier. Notice that the range given specifies two rows. This is very important. You would create
an error if you specified a range for the lookup table to be Dl4:Hl4. Always take care when
entering the table range to include aU the rows (or columns when using VLOOKUP) of the table!
The last part of the function, 2, is the row number of the range (or column number if you
are using VLookup) Excel will use to find the value you actually want displayed. In this case,
you are specifying the second row of the range, which is the fifteenth row of the spreadsheet, the
row containing the growth rates.

WHAT TO

Do

[ENTER]

WHY

You ARE DoiNG IT

Enter the function into cell C9. The value 0.05 should
appear. This is the growth rate fo und in cell H15 under
the sales value of 120.

Figure 10.51

The HLOOKUP has been
entered into the spreadsheet. It immediately
locates the desired growth
rate based on the current
sales value in cell 83.

Move the mouse pointer to cell 83 and
click the mouse button.

Move the cursor to cell 83. This cell contains the value
being looked up in cell C9.

Macintosh Productivitv Tools

105 [ENTER]

E nter a new value into cell B3. T he value displayed in
cell C9 should now change to 0 .09. The value 105
matches the rule "greater than or equal to 100, and less
than 1 JO". Thus the HLOOKUP stops at the 100 value
and goes down to the row specified to use the value 0 .09.

Figure 10.52
The value displayed in cell
C9 has changed.

,. It File Edit Formula Format Data Dp

·--

63

105

-------

A

c

B

------~---_!_
I
0.09 1

75 [ENTER]

Enter a value that is smaller than the fi rst value of the
lookup table's sales values.
Excel displays #N/A in cell C9. T he value being looked
for is to the left of the lookup table, or outside the range.
The lookup function does not have a numeric response
for cases similar to this.

Move tl1e mouse pointer to cell C 14 and
click the mouse button once .

Move the cursor to cell C 14.

0 [cr]

Add a new value to the left of the table you c reated earlier. T he cursor should move to cell C IS.

0.02 [ENTER]

Enter the growth percent for sales values in the range
"greate r than or equal to 0 and less than 80."
Cell C9 continues to display the #N/ A message.
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Figure 10.53
The Not Available error
message is still displayed
in cell C9.
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The error message will remain in C9 until you edit the
formula there to include column C in the lookup table.

iii iii

Move the cursor to cell C9. The formula is displayed on
the edit line above the worksheet window.

Move the mouse pointer over the formula on the edit line.

When you move the mouse pointer to the edit line, it will
turn into an 1-beam editing tool.

Select the D which starts the range
definition.

You need to change the letter D to a C, since the lookup
table has been extended left into the C column.

Figure 10.54

,. •

The D has been selected. It
will be replaced with a C.

file
C9

Edit

Formula Format Data Optlof
:HLOOKUP(B3,!114:H 15,2)

rg]0

Mode12 -

c

Replace the D with a C. The range that holds the lookup
table should now read Cl4:HI5.

[ENTER]

Enter the formula into the cell. Cell C9 should now display 0.02.

Figure 10.55

The edited cell now
contains the correct value
from the lookup table.
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File

Edit

Formula

Format

Data

Options

Macro

Window
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Pull down the File menu, select the Save
As option, then release the mouse
button.

You are going to save the model again.

MODEL3 [cr]

Save the current model as MODEL3. You have added a
large amount of new information to the spreadsheet that
you will not want to re-type if something goes wrong in
the next few minutes. You have just established a point to
which you can return if necessary. Additionally, you still
have the previous two versions of your work available to
which you can return if necessary.

Macintosh Productivity Tools
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1 0.15 PERFORMING AN ABSOLUTE COPY

Recall that Excel is able to perform two different types of copy, the relative copy and the
absolute copy. You have already performed several relative copies. Don't forget that using the
Fill Right and Fill Down commands are simply executing special cases of the copy/ paste
sequence. When you performed a copy/ paste, Excel interpreted cell references in the cell being
copied as distance specifications and adjusted them in the destination cells. The distances were
kept the same.
If you now copy cell C9 to cell D9, shown on the edit line in Figure 10.56, this same thing
will happen. Unfortunately, this is not desirable. Try it to see what happens:

WHAT

To Do

WHY

a€C

You ARE DOING IT

Copy the cell into the copy/paste buffer.
Move the cursor right to cell D9.

.

a€V

,.

File

Paste the formula into Cell D9.

Edit

09

•

Formula

Format

Data Options

Mac

:HLOOKUP(C3,014:115,2)

Model3

c

8

Figure 10.56

The formula has been
copied into cell 09, and an
error message, #NIA, is the
result.

2

3
::

5
6

SALES
COSTS
PROfiT

75
52.5
22.5

76.5
53.55
22.95

7

: .:
:~ I 0

GROWl'if RATE

Notice that the formula in cell D9 , shown on the edit line in Figure 10.56, thinks that the
table being used by the lookup function is to be found in cells D14:115. This is not the case. The
lookup table has not moved from cells CI4:Hl5 just because you copied a cell that uses it! Here,
then, is a use for the absolute copy. When you copy cell C9 , the fi rst cell reference should be
copied in the usual fashion , however, the table must be made into an absolute reference.

WHAT

To Do

WHY

You ARE DoiNG IT

+-

Return the cursor to cell C9. You will have to make some
changes to this cell before you attempt to copy it again.

Place the mouse pointer on the formula
in the edit bar in front of the C specifying the beginning of the lookup table
range.

You will start your edit here.
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Push the mouse button down and drag
the 1-beam over the lookup table range
specification.

You are going to replace the complete specification.

Figure 10.57
The specification of the
lookup table has been
selected.

Replace the range specification with the absolute reference. The dollar sign in front of the column name in a
cell reference tells Excel to keep the column letter constant whenever the formula is copied. In a similar fashion, the dollar sign in front of the row number in a cell
reference tells Excel to keep the row number constant
whenever the formula is copied.

$C$14:$H$15

Figure 10.58
The edited cell before
pressing return.
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[ENTER]

Enter the change into the cell.

Select the range C9 through P9.

Select the complete row so that the formula can be
copied.

XR

The Fill Right command.
De-select the row. The cursor should be in cell D9.

Figure 10.59
The growth rate changes
in cell G9 to 0.03.

,.

Note that the growth rate changes in column G from 0.02
to 0 .03. This happens because the sales value in cell F3
is greater than 80!
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XG

The Goto command .

83 [cr]

Jump the cursor to cell 83.

100 [ENTER]

Enter a new sales starting value . The growth rates shown
in row 9 should change.

'

.

Edit

Formul11 Form11t
100

011111

Options

M11cro

Window

.,

Figure 10.60

The growth rates have
changed to 0.09.

Model3

c

D

102
71.4
30.6

104.04
72.828
31.212

E

106.1208
74.28456

0.09

Move the cursor to cell C3. You have not yet changed the
formulas for the sales computations to take into account
the new, variable growth rates.

= (83*C9) + 8 3 [ENTER]

This formula will now use the growth rate found in cell
C9 to compute the amount of growth, and add it to the
prior period 's sales to determine the current period's
sales.

[SHIFT]-X-+

You are going to copy this formula for all the years.
Holding down the shift key while jumping the cursor to
the right will select all the cells from C3 through R3.

[SHIFT]- +- [SHIFT]- +-

Press the s hift-le ft arrow 2 times so that the selected
range ends at column P. The range is still anchored in
cell C3. Remember, you can tell the anchor point by
looking at the edit line.

XR

The Fill Right command.

.....

De-select the row, placing the cursor into cell 03 .
Return the cursor to the A column.
Figure 10.61

The current model uses the
lookup table to control the
growth rate.
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Pull down the File menu, select the Save
As option , then release the mouse
button.

You are going to save the model again.

MODEIA [cr]

Save the current model as MODEIA. You have once
again made major changes to the spreadsheet that you
will not want to re-create.

In addition to varying the growth rate, it is reasonable to assume that the cost percent will
not remain a constant seventy percent. It may go down as sales increase because of quantity
discount purchases. It may go up , however, because of increased labor rates.
Let us enter a very gradual decrease in the cost percent based on the sales volume.

WHAT

To Do

WHY

You ARE DoiNG IT

Move the mouse pointer to cell A14 and
click the mouse button.

Move the cursor to cell A 14. First you are going to modify the table you created earlier. You will start by entering
row labels to clarify the information in the table.

SALES LEVEL [cr]
DESIRED GROWTH % [cr]
EXPECTED COST % [ENTER]

Enter labels to tell you what each row of the table means.
T hese labels are NOT part of the lookup table you created. They are simply for clarification for someone looking at the spreadsheet.

Select the range C16:H16.

You are going to enter the cost percents into this row of
the table.

0.70 [cr]
0 .69 [cr]
0.68 [cr]
0.67 [cr]
0.66 [cr]
0.65 [cr]

Enter the expected cost percents.

Figure 10.62

The cost percents have
been entered.

Move the cursor to the A column.

rr t t n

Move the cursor up to cell A 10.

COST%->

Label this row of the spreadsheet and place the cursor
into cell 810.

= HLOOKUP(B3 ,$C$14:$H$16,3)

This is the formula for this cell. It looks up the sales
amount to determine the percent of sales that costs will
be. Note that the last element of the HLOOKUP function
is 3, which points the function to the expected costs percent row, the third row of the lookup table!

[ENTER]

Enter the formula into the cell .

Select the range 810 through P10.

You are going to copy the formula in cell B 10 for all the
years.

Macintosh Productivity Tools

a€R

The Fill Right command.
De-select the row and return the cursor to the A column.

r

j

File Edit

Formula Format

Data Options Macro

Window

,

Figure 10.63
The cost percent row has
been copied.

Move the mouse pointer to cell B4 and
click the mouse button.

Move the cursor to cell 84. You must change the cost
formula .

= (BlO*B3) [ENTER]

Rather than using the constant 70 percent figure for
costs, use the cost percent found in cell B10.

[SHIFT]-a€-+

You are going to copy this formula for all the years.

[SHIFT]- <- [SHIFT]- <-

Press the shift-left arrow 2 times so that the selected
range ends at column P.

a€R

The Fill Right command.
De-select the row and return the cursor to the A column.

r

li File Edit Formula Format Data Options Macro Window

.,

Figure 10.64
The cost percent is now
used by the model.
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Pull down the File menu, select the Save
As option, then release the mouse
button.
MODELS [cr]

You are going to save the model again.

Save the current model as MODELS.

In addition to protecting yourself at this time against making a mistake in e ntering formulas,
you will soon print what you have created . It is always a good idea to save your work befo re you
print it. If you experience printe r proble ms and have to restart the computer, you will not have
lost your work!
You may also wa nt to take a mome nt to move the cursor around on the spreadsheet you have
created. Make sure that you understand the purpose of each formula, and how each formula
works.

-

1 0.16 NESTING FUNCTIONS

Although you used the IF function earl ier in this chapte r to d isplay text in a cell, this function,
and a majority of the spreadsheet built-in functions, are inte nded to output nume ric info rmation.
Because of this, a fu nction may be viewed as if it we re just a nother numbe r when you construct a
formula in a cell .
This mea ns two things-a function may be included as pa rt of a formula a nd a function may
be used within another function.
An example of the first situation might be a formula such as =(84* 100 + @SUM
(F4 :FIO)) . Here is a n example of a formula that makes use of the IF function:

=((M3 + lS)/(IF(M3 =0 , 1,M3)))
As you know , di viding by zero is frowned upon. This formula will look at the value of cell
M3 before it executes the division. If the value is zero, it will divide by I . If the value is not
zero , it will divide by the value found in cell M3 .
Functions inside functions behave in a similar fas hion. You have seen one possible example
of this in the IF function shown earlier in this chapter. Here is an example that selects a value
based on what is found in a lookup table:
IF(HLOOKUP(M 18,AA1 :AJ IS,KIO) < V 14,B45,C45).
The cell references K 10, V 14, 845 and C45 in this formula may be replaced with a more
extensive expression, including another function, of course! For example, you may use something such as :
IF(HLOOKUP(F4S ,AAI :AL20 ,COUNT(Fl :F20))> SUM(BlO:B35),
AVERAGE(M 19: M35) ,1F(Q 13 *4 5 > SUM(Ll2:S 12),AVERAGE(N35 :N55),AX 18))
This extensive formula fi rst looks up a value in the range AA I :AL20 and compa res it to the
sum of the range B 10:835 . If this value in the range is greater than the sum , this cell wi ll display
the average of the range M 19 :M35. However, if the sum is greater than the value looked up, the
second IF is executed , picking between the average of the range N35 :N55 and the value of cell
AXI S.
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1 0.17 OTHER EXCEL BUILT-IN FUNCTIONS

Excel has ma ny more functions in addition to the ones just discussed . They are divided into
several classes:
•
•
•
•
•
•
•
•
•
•
•

Database Functions.
Date and Time Functions.
Financial Functions.
Information Functions.
Logical Functions.
Lookup Functions.
Mathematical Functions.
M atrix Functions.
Statistical Functions.
Text Functions.
Trigonometric Functions.

The scope of this text does not allow a discussion of each of these functions. However, it is
worth knowing how to use these functions.

WHAT

To Do

WHY

You ARE DoiNG

IT

XN

You are going to create a new spreadsheet. Do this so that
you will not accidentally make changes to your current
model. The New dialog box will appear.

Click on OK.

Since the Worksheet button is already selected, clicking
on OK will create a new worksheet for us.

Pull down the Formula menu.

This menu contains two paste functions, paste name and
paste function. Paste name is dimmed, since you have not
created any range names in this spreadsheet.

Drag the mouse down to Paste Function.

You want to paste a function into the new spreasheet.
Note that there is no command key equivalent for this
operation.
Figure 10.65
The Paste Function
command has been
selected.

Create Names ...
RPI>IIJ Name~ .. .

Replace...
Select Specllll •••
Show Actlue Cell
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Release the mouse button.

Figure 10.66
The Paste Function dialog
box.

Execute the Paste Function command. You will now see
the Paste Function dialog box.

,

wu1"'anaa'L

1-

""""

1-1-

·---

· ··-r

a.

t---+-

Peste Function

I

OK

(

Cancel

ACOS()
AND()
ARERS()
AS IN()
RTRN()

--- 1
I -·
--·-·
-··-,__.

--

CJl Peste Arguments

....__

1-b
Click on the Paste Arguments check
box.

By turning on this check box , Excel will place the function into the cell, and show you what information is
expected by the function to make it work.
You may use the function list in two ways. You may use
the scroll bar to scan the complete list of functions, or
you may type a single letter to jump the list to a part of
the alphabet.
Type the letter I. The function list will scroll to the
beginning of the l's, which is the IF function.

Figure 10.67
You have scrolled the
function list to the
beginning of the l's.

WUfll~lllliH.£

Peste Function
FIHEDO
FU()
GROWTH()
HLOOKUP()
HOUR()
~ Peste Arguments

Click on OK.

Figure 10.68
The arguments required by
the IF function are
displayed for you to edit.

'
I
~

(

OK

Cancel

,
-

--

I --

--

Paste the IF function into the spreadsheet. Since you have
checked the Paste Arguments box, you will be given a
function on the edit line with its argume nts filled in. You
must now change the arguments to real information.
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Click on the X box on the left of the
edit line.

This is the cancel entry box. You are not going to enter
the function at this time.

You have access to all the Excel functions through the Paste Function command. With the
Paste Argument box checked you can even get an idea of what type of information the function
needs to produce the correct information for you .
You can get more information about the functions by using the Excel Help feature. You have
explored this feature before, looking at help for the Commands. Now let's try getting help for a
function.

WHAT

To Do

WHY

Figure 10.69
The mouse pointer's index
finger is pointing to
Functions.

You ARE DOING IT

Pull down the Window menu , select the
Help command then release the mouse.

Start the Help function. You will now see the initial help
topics list.

Place the mouse pointer on the word
Functions in the topic Jist and click the
mouse button.

You want to get help about the Excel functions.

After clicking the mouse, the topics list will change to a
list of the Excel functions.
Figure 10.70
The functions topic list is
now available.

•

WORKSHEET FUNCTIONS

6nnJd1ll function oro\lli!W1

~~~

~l
AN

~1

409

it

~ma1noroes

r~J!f

r"nl IIMU/ \

You may scroll through this topics list, or you may type a
letter to jump to the desired part of the alphabet.
Jump to the beginning of the I's. Once again, you have
located the IF function.
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[cr]

Press the return key to see the help for the IF function.

Figure 10.71
Part of the help
information you will get
for the IF function.

r

•

File

Edit

Formula

Format

Data

Options

Macro

Window

.,

----------- - - - - - - - ~--

I FOoviceLtnt,nl ..-tf_true ,velu...ifJelae)
Gl<m veln-iLtrue If loglcel_test Is TRUE.
Gl<m veln-ifJelaelf loglceLtest Is FALSE.
If omitted, velue-tLfelse Is assumed to be FALSE.
• Use IF to meke condftloneltests of cell values end
formulas.
The outcome of the 10111ceLtest determl nes the vel ue
given by the IF funcll~.
The vel ae-iLtrue and vel ue..ifJelae arguments
can be any velue.
• Up to seven IF functions can be nested as
velue_tf_trae end vel ue-tf_felae arguments to
construct more elaborate tests.

Click on the Cancel button.

When you are done using help, put it away by clicking on
the Cancel button.

Click on the Worksheet2 close box .

Put away this worksheet. Since you did not make any
changes to any cells, the new worksheet is simply thrown
away. If you did put information into a cell of this worksheet, you will either have to save it or discard it by clicking on the appropriate button in the dialog box that
appears. You would click on Yes to save the spreadsheet,
or No to throw it away.

-

1 0.18 PRINT YOUR SPREADSHEET MODEL

You now have a much more complete model than you did at the end of Chapter 9. It is once again
time to print your work. Of course, you must have a printer attached to your computer to print
your work.

WHAT

To Do

WHY

You

ARE DOING

IT

XP

Execute the Print command found on the File menu.

Check the Page Preview box.

If you want to preview the document before you print it,
make sure that the Page Preview box is checked in the
Printer dialog box.

Click on OK.

Begin the Page Preview.
Note that the Next button is not dimmed, as it was at the
end of Chapter 9. This means that you should expect
more than one page of output.
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Figure 10.72
The first page o f the page
preview .

.. Preview: Page I

Click on the Next button.

Look at the second page of the Page Preview. Both the
Next and Previous buttons are now active.

Click on the Print button.

After you are finished looking at the Page Preview, print
the spreadsheet by clicking on the Print button.
If you do not have a printer, or do not want to print your
spreadsheet at this time, click on the Cancel button.

:M:S

Make sure that all changes to the spreadsheet have been
saved. This time you are using the save command without
changing the name of the spreadsheet.

:M:Q

Quit Excel and return to the Macintosh Finder.

EXERCISES
I . When you retrieve a spreadsheet from diskette, in what cell is the cursor placed when the spreadsheet is completely
loaded?
2 . How many columns and rows a re d isplayed in the spreadsheet window when you fi rst start the program running?
3. Can the following list of cells be defined as a legal cell range?
Cl, D l , E l , F l , G l , C2, D2, E2, F2, G2, C3 , D3, E3 , F3, G3
4. Can the following list of cells be defined as a legal cell range?
CI,C2,C3,C4,C5, D I , D2 , D3 , D4 , D5
5. Can the following list of cells be defined as a legal cell range?
D6 , D7,E7 , D8, E8,F8, D9,E9, F9, G9
6. What special character must be added to a cell form ula to make a cell reference copy in absolute mode, rather than
relative mode?
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You should have built the following spreadsheet for Problems 9 through 17 of Chapter 9. If you have, retrieve it for Problems 7
through 17. If you do not have it available, build it now for the following problems.
A
1
2
3
4

c

B

D

E

Jones Co.
Sales Analysis
Gross Sales

476000

5
6
7
8
9
10
11
12
13
14

= (E4*0.~15)
= (E4*0.113)
=(E4*0.102)
= (E4*0.122)
= (E4*0.058)

Cost of Widgets
Cost of Framitz
Cost of Dingies
Cost of Nuts & Bolts
Cost of Sealant
Total Costs
Profit from Sales

7. Use the SUM function to compute this spreadsheet's Total Costs.
8. Add the following percent cost table for this model:
1

2
3
4

5
6

I

J

K

L

M

SALES->
Widgets
Framitz
Dingies
Nuts & Bolts
Sealant

450000
0.340
0.120
0.106
0.128
0.060

475000
0.330
0.113
0.105
0.125
0.060

500000
0.315
0.113
0.102
0.122
0.058

525000
0.300
0.109
0.098
0.119
0.058

9. Replace the formulas in cells C6 through C 10 with a formula to select the percent cost of the line item based on the Gross
Sales figure. Thus, if the Gross Sales are 475000, the percent of Sale for the cost of Framitz is 11.3. What is the formula
you are using? Can you use the Copy command to copy this formula into all the required cells?
10. If Gross Sales are 465000, what will be the cost of Dingies?
11. What will the total costs be if Gross Sales are 495000?
12. What will the Profit from Sales be if Gross Sales are 522500?
13. What happens to the cost figures when Gross Sales are greater than 525000?
14. What happens when you enter a Gross Sales figure of 375000? What can you do to prevent this from happening?
15. What percent of Gross Sales are the costs of Nuts & Bolts when Gross Sales are 493724?
16. What is the cost of Sealant when Gross Sales are 481000?
17. Make the Gross Sales 480000. Print the spreadsheet and the percent cost table.
18. Create the following spreadsheet:
JAN
SALARIES
300
RENT
75
INSURANCE 25
POSTAGE
5
TRAVEL
75
MISC.
20
TOTAL

500

19. Extend the spreadsheet you created in Problem 18 for 12 months with the following changes: (1) increase salaries 1/2 of a
percent per month, (2) increase rent 1 percent per quarter (that is, in April, July, and October), and (3) decrease travel 10
percent in July. HINT: If the January insurance value is in cell B4, then by placing = B4 into cell C4, you will cause the
value to appear in the C column unchanged.
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20.
21.
22.
23.
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Add to the spreadsheet created in Problem 19 totals and averages for each of the items.
What will the salaries value be after 10 months (November)?
Print the modified spreadsheet created in Problem 19.
Load the spreadsheet model you created for Problem 18 of Chapter 9. If you do not have it available, build it now for the
following problems. Here is the information:
1)
2)
3)
4)

The Cost of Goods is 55 percent of Sales.
Salaries are 10 percent of Sales.
Overhead is 26 percent of Sales.
Other expenses are 4 percent of sales.

Use the appropriate formulas to compute the gross and net profit values.
SALES
COST OF GOODS
GROSS PROFIT

500
275
225

EXPENSES
SALARIES
OVERHEAD
OTHER
NET PROFIT

50
130
20
25

24. Use the IF function for salaries. Keep salaries at 10 percent of sales as long as sales are less than 600. Once sales reach
600, salaries should become 12 percent of sales.
25. Use the IF function for overhead. Make overhead 24 percent of sales as long as sales are less than 550. Once sales reach
550, overhead should drop to 22 percent of sales.
26. What are the salaries, overhead and net profit if sales are 575?
27. What are the salaries, overhead and net profit if sales are 625?

CHAPTER

ADVANCED ELECTRONIC
SPREADSHEET CONCEPTS
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CHAPTER OBJECTIVES:

Upon completion of this chapter, the student wiU:
•
•
•
•
•
•

Divide the spreadsheet window into "panes!'
Format tbe spreadsheet cells.
Insert rows into the spreadsheet.
Delete columns from the spreadsheet.
Move cells of the spreadsheet.
Use named ranges.

• Demonstrate automatic and manual
recalculation.
• Discuss the ramifications of recalculation order,
column order, row order, and natural order.
• Know what to avoid when using a spreadsheet.

-

1 1.1 THE ELECTRONIC SPREADSHEET EXPERT

By now you should be very familiar with the workings of the electronic spreadsheet and modeling. This chapter will introduce you to a few other operating tasks that will make using the
electronic spreadsheet much easie r. You will learn about spreadsheet recalculation. You will also
learn how to format the information on the spreadsheet, lining up decimal points, and in general
making your work look attractive.

-

1 1.2 SPLITTING THE WINDOW

There are times when you may want to view the conte nts of columns A, B, C, P, Q and R, or
some other combination of columns or rows that are widely separated and therefore will not fit
into the spreadsheet window. You know that if you attempt to move the window to see columns P,
Q, and R, you will not be able to see columns A, B, and C. Of course you may print the
spreadsheet, but you may not have a printe r available, or you may simply want to see what is
happening in the right portion of the spreadsheet while you work on the left portion. Printing in
this latter case is probably not appropriate.
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You can deal with th is proble m by splitting the window. Most e lectronic spreadsheet programs w ill allow you to split the viewing window into two halves . You can control what is
displayed in each of the two wi ndow panes independently.
When you split the window , all you are changing is what is be ing viewed and not any of the
relationships a mong the cells of the spreadsheet. You a re not creating two separate spreadsheets.
Thus, if the conte nts of cell AS affect the contents of a cell in column K, a nd the window is split,
a cha nge in AS will still cause the conte nts of the cell in column K to change.
You can split the window between any two rows by splitting the window horizontally or
between a ny two columns by splitting the window vertically. Excel eve n lets you split the window
horizontally and vertically at the same time.
Whe n you split the window between two columns or rows, all that you are defining is the
amount of space for each window pane, and not what will always be d isplayed in that pane. You
may change the contents of a window pane by scroll ing the pane with the cursor or scro ll bars in
the same fas hion as you scro lled the unsplit window. It is possible to display the same thing in all
the pa nes, or to have the top pane display rows 41 through 49 while the bottom one displays rows
I through 10!

-

1 1 .3 SYNCHRONIZED WINDOW SCROLLING

When you split the window into two panes, you wi ll see that the window sc rolling is unaffected.
Fo r example, if you split the window horizontally, the top a nd bottom panes can scroll vertically
independent of one another. However, the two windows will scroll horizontally together.
Thus, if you sc roll horizontally to column AF, both the top and bottom pane will show
column AF. However, you may scroll the top pane to show row 4S and the bottom pane to show
row 972 .

-

1 1 .4 RETRIEVE THE SPREADSHEET

Afte r you boot your Macintosh with a System Start-Up disk, insert the Excel Program disk into
one of the compute r's disk dri ves. If you are using a machine with a ha rd disk you will not need
to insert the Excel program disk into a disk drive. Rather, locate the Excel folde r, and open it so
you can see the Excel progra m icon. Place a di sk (see Cha pter 3 for how to initialize a new disk)
with at least 200K ava ilable space into another one of your Mac intosh 's disk drives, if you have
one available . This disk will be used for saving your work . If you do not have a free floppy disk
drive , keep this disk available. You will need it for data storage.
In these instruc tions , [cr] means to push the Return key on your compute r's keyboa rd
(remember, this is NOT the Enter key). A X in front of a le tte r (e.g., X X) means to hold down
the Command key while pressi ng the given le tter. Lette rs e nclosed in squa re brackets (e.g.,
[TAB] o r [ENTER]) mean to push that key on the keyboard , and not to type out the word.
Fina lly, the phrase "Click the mouse on
means to move the mouse pointe r to the specified
means to
item and push the mouse button once. The phrase " Double-click the mouse on
move the mouse pointe r to the specified ite m and double-click the mouse button . The word
" drag" means to select an item, be it a n icon or the menu selection bar, and move the mouse
while the mouse button is pressed.
Finally, if you want your work to match the fig ures in the text, be sure to use the Chooser
DA to select a LaserWriter and not an Image Write r. You may select a LaserWrite r even if your
compute r is not actual ly a ttached to one. You will not, however, be able to print if this is the
case.
00 . "

00

."
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If you are using a computer with a ha rd disk, begin here:

WHAT

To Do

WHY

You ARE DotNG

IT

Locate the icon for the spreadsheet you
were working on in Chapter 10 and
place the mouse pointer on the icon.

You are going to launch Excel by double-clicking on th is
icon. It is called Model5.

Double-click the mouse.

By double-clicking on an Excel spreadsheet, the Macintosh wi ll look on all available disks for the Excel application program. If found, it will launch Excel and open the
document. If the Macintosh is not able to locate the
application program, you will get an error message.

If you have the Excel application program on your hard
disk, or on a floppy disk currently in one of the computer 's disk drives , the program should start, and after a
brief wait, the spreadsheet you saved at the end of Chapter I 0 will appear.
If you are usi ng a computer that has on ly floppy disks, then start here:
Locate the icon for the Excel prog ram.

You will launch the Excel application program by doubleclicking on it.

Move the mouse to the Excel icon and
double-cl ick.

The double-cl ick will launch the application. If you have
trouble with the double-cl ick, you may also select the
program's icon with a single cl ick, then use the Open
option on the File menu , or press ~0 . the command key
equivalent.
After a brief wait, Excel will be running, and you will
have a new spreadsheet, called Worksheet I , in the
window.

Move the mouse to the window's close
box.

Remember, the close box is the one found at the left of
the title bar.

C lic k the mouse button once.

Close the worksheet. You are going to open an existing
worksheet , and it will be less confus ing to work with
only one document active.

~0

Execute the Open command. This command is found on
the File menu.
After a brief pause, you will see the Open dialog box.

C lick the mouse on the Drive button
shown in the dialog box if your disk is
not displayed in the dialog box.

T he Drive button tells Excel to display the document and
folder names found on a second disk currently in your
computer. This may be a floppy disk, or a hard disk. If
you do not have a second disk in the computer, then the
Dri ve button will be dimmed, and you will not be able to
use it.
Continue cl ick ing the Drive button until the name of the
disk that contains your fi le appears in the dialog box .

C lick on Model5.

You want to open the spreadsheet you named "Model5 ."
By clicking the mouse pointe r on the name in the dialog
box, you are select ing this document.
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Click on the Open button.

Execute the Open command. After a brief pause while
the computer reads the spreadsheet, you will see the
Excel spreadsheet in the current window.
You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the spreadsheet name, rather than
selecting it and then clicking on the Open button in the
dialog box.

Figure 11.1

-

This is the horizontal
window split control.

11.5 SPLITTING THE WINDOW VERTICALLY

You a re now ready to split the spreadsheet window. In this section you will split the window
vertically.
The window split controls are found at the to p of the sc roll bar at the right side of the
wi ndow (Fig ure 11.1), and at the left of the scroll bar at the bottom of the w indow (Figure
11.2). They are the heavy black ba rs found at the two locations.
Figure 11.2

This is the vertical window
split control.

WHAT

To Do

Place the mouse pointer over the vertical
window spl it control.

WHY

You ARE DoiNG

IT

T he vertical split control is at the bottom left of the current spreadsheet window. When the mouse is in the
proper position, it will change to the window split tool.

Figure 11 .3

The mouse pointer, now
located over the vertical
window split control, has
changed to the split tool.

'""Reedy

Press and hold the mouse button.

To split the window, you must drag the split control to
the desired location.

Drag the mouse right to split the window in half.

You are going to split the window into two equal panes.
As you drag the window split control, a heavy line will
drag across the spreadsheet with it (Figure 11.4). This is
to let you know where the split wi ll occur.

Figure 11 .4

The heavy vertical line
indicates where the
window will split if you
release the mouse button.
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When you have the heavy line between columns C and D,
the approximate center of the window, release the mouse
button to split the window vertically.

Release the mouse button.

*

r

File

Edit

formule

formet

D11t11

Options

Mecro

Window

.,

Figure 11 .5
The window has been split
vertically. Note that there
are two scroll bars at the
bottom of the window,
but only one at the right
of the window.

. .i.

Afte r you have split the window, you can see that the
scroll bar o n the right side, controlling vertical movement
of the window, is unchanged . However, the scroll bar on
the bottom of the window, controlling horizontal movement of the window, has been split. Thus, you are able
to scroll each pane left and right independently. However,
they will scroll up and down together.
Move the mouse pointer to cell A I in
the left pane and click the mouse
button.

Place the cursor in cell AI.

-+ -+

Move the cursor right two cells to cell C 1. When you do
this, the left pane will scroll , and the cursor will now
appear in both the left and right pane!

r

*

File

Edit Formulll

Formet

D11t11

Options

Mecr o

Window

.,

Figure 11.6
You now have the cursor
displayed in both panes of
the window.
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Move the mouse po inte r to cell E l in the
right pane and click the mouse button.

Figure 11 .7
The cursor is now in the
right pane.

Move the cursor to cell E I in the right window.
The cursor will disappear from the left pane , since cell
E I is not curre ntly displayed there.

Edit formula

format

Data Options Macro

Window

,

ModelS

c

D

109
73.03
35.97

118.81
78.4146
40.395

You can see that moving the cursor between windows is
simply a matter of positioning the mouse pointer in the
desi red pane and clicking the mouse button.
Move the cursor to cell A I in the right window pane.
Use the mouse to drag the scroll box
under the left window pane all the way
to the left end of the scroll bar.
Figure 11 .8
The scroll box on the left
scroll bar is being moved
all the way to the left end
of the scroll bar.

You are scrolling the left window using its scroll bar.

:: ..ll.. _!__ _ _
:; 17

\[

~:

JH:!:n::i ,

.. Reedy

When you release the mouse button, both the left and
right window panes should be displaying the same
information.
Figure11 .9
The two panes of the
window are showing the
same portion of the
spreadsheet.

r

•

File Edit formula

format

Data Options Macro Window

,
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ABC CO. [ENTER]

Enter text into cell A I . Note that the text appears in both
windows, and the edit line, even though the active pane
is on the right. This offers proof that you are in fact looking at the same cells of the same spreadsheet.
Move the cursor to the right. You will see that only the
right window scrolls, meaning that it is the currently
active window pane.

Position the mouse pointer over the window split control at the bottom of the
window.

You are going to clear the split window.

Drag the window split control left until
it passes the row numbers at the left of
the spreadsheet.

To clear the split window, you must return the window
split control to its original location. As you drag the split
control, the heavy line will once again appear.

Release the mouse.

When you release the mouse, the window will return to
its original form.

-

11.6 FORMATTING THE INFORMATION ON THE
SPREADSHEET

Now that you can manipulate the spreadsheet a nd its contents, it is time to make it look better.
You do this by formatting the numbers and text and adjusting the column widths.
You control the format of the cells by fi rst selecting the desired range. The appropriate
format is then applied to the information. There are formats for numbers, so that you can set the
numbers to integers or set them with two digits to the right of the decimal point. There a re
alignment formats, such as right or left placement in the cell. And you can also control how
wide a column is, or how high a row is. Of course, like most Macintosh applications, you may
control the font, font size and style (such as boldface or underline).

-

1 1.7 FORMATTING THE ENTIRE WORKSHEET

When you apply a format to a spreadsheet, you must fi rst select the range of cells that you want
formatted . It is possible to format portions of the spreadsheet , or even the complete spreadsheet.
So far in this text you have been selecting ranges by keeping the mouse pointer inside the
spreadsheet. You may also select ranges, or the whole spreadsheet, by using the border cells.
Be fore you begi n the formatting process, add the years to this spreadsheet.

WHAT

To Do

WHY

You

ARE DOING IT

Move the mouse pointer to cell B2 and
click the mouse button.

Position the cursor at cell B2.

1970-+

Enter the year for the first column of the model as 1970
and move the cursor to cell C2.
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Figure 11 .10
You must put the window
split control back at the
left side of the spreadsheet to clear the split.
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=( I+ B2) [ENTER]

Ente r a fo rmula into cell C2. 197 1 will be displayed.

Select the range C2 through P2 .

Select the row to the right of and including cell C2. This
is where you will place the year labels.

XR

The Fill Right command , which may also be found on
the Edit menu.
De-select the row and return the cursor to cell B2. The
years are now numbered 1970 to 1984.

Figure 11 .11

Macro Window

The years are now
numbered.

.,

Now you are ready to fo rmat the spreadsheet info rmation.
First , however, you will learn some selection techniques.
Position the mouse on the B column
name box above the B column.
Figure 11 .12

Note the position of the
mouse pointer on the 8
column name box.

You are going to select the complete B column.

,.

~~.
::

Click the mouse button once.
Figure 11 .13

The complete 8 column has
been selected.

•

File

B2

Edit Fonnull

I
B E:!l

I

19

c

1
~

This will select the B column.
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You can tell that more than a range, which includes part
of the B column, has been selected because the B column
name box is also part of the selected range . Any time the
border cell is included in a selection area, the complete
column or row has been selected .
Position the mouse pointer over the row
5 box and click the mouse button.

Select the complete row 5 of the spreadsheet.

Figure 11 .14
Row 5 has been selected.

Position the mouse pointe r in the empty
box at the top left corner of the spreadsheet window.

This box is used to select the complete spreadsheet. Do
not confuse it with the close box above it on the title bar!
For the sake of this text, we will call it the Select All
box.

,. j

File

Click the mouse button once.

r

It File Edit Formula Format Data

+
3

Note the position of the
mouse pointer. This box
will let you select the
complete spreadsheet.

I

AS

:~
:~

Figure 11 .15

Edit

~~.f!L- .
~e. --

Select the complete spreadsheet. Now you are ready to
begin formatting information.

Macro

Window

.,

Figure 11 .16

The complete spreadsheet
has been selected.
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Figur~

Pull down the Format menu .

This menu contains the commands for fo rmatting information on the spreadsheet.

Drag the mouse down and select the
Number command .

You want to change how the numbers are formatted on
the spreadsheet.

11.17

The Number formatting
command has been
selected.

Border •..
Cell Pr otection••.
Row Height •••
Column Width•..

Release the mouse button.

You will now have the Format Number dialog box.

C lick the mouse on the second format
down in the form at list.

This format, which appears as simply a 0 in the list, is
the integer fo rmat.

Figure 11.18
The integer format has
been selected.

Format Number
General

(!

OK

(

Cancel

0.0 0
#,##0
# ,##0 .00
$# ,##0 ;($#,## 0)
$#,##0 ;(Re d)($#,## 0)
$#,##0.00 ;($#,##0 .00)

,
)

Oe le l e

Format:

C lick on OK.

Figure 11.19
The numbers have all been
formatted as integer
values.

Apply the integer format to the spreadsheet. All the numbers on the spreadsheet will be displayed as integers at
this time.

Ions Macro

Window

.,

Macintosh Productivity Tools

Look at the lookup table in the range C 14:H 16. The percents are now displayed as either 0
o r 1. Excel has rounded the values of these cells to display them as integers. Values greater

than or equal to 0 and less than 0.5 are rounded down to 0, while values greater than or
equal to 0.5 round up.

XG

The Goto command.

Rl [cr]

Move the cursor to the right end of the spreadsheet. You
can see that the format affected all the cells containing
numbers.

Move the mouse pointer to the Select
All box and click the mouse button.

Recall that we are calling the border box above the row
indicator and to the left of the column indicator the Select
All box. You are re-selecting the complete worksheet.

Pull down the Format menu , select the
Number command, then release the
mouse button.

Once again, you want to change how the numbers are formatted on the spreadsheet.

Click the mouse on the third format
down in the format list.

This format, which appears as 0 .00 in the list, is the format for displaying two digits to the right of the decimal
point.
Figure 11.20

Formet Number
General
0

The two digits to the right
of the decimal point
format has been selected.

Formet:

Apply the format to the spreadsheet. The appearance of
all the numbers will change to the new fo rmat.

Click on OK.

r

a

File

Edit Formulll

Formet

D11t11 0 tlons Mecro

Window

,

Figure 11.21

The numbers have all been
formatted with two digits
to the right of the decimal
point.
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Return the cursor to the A column . You can see that all
the values of the spreadsheet are now displayed with two
digits to the right of the decimal point.
Figure 11 .22
The complete spreadsheet
has the new format.

.,

li File Edit Formula Format Data Options Macro Window
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11.8 FORMATTING A RANGE OF CELLS

It is not, unfo rtunately, accepted practice to format years to two decimal positio ns. You saw,
however, that if you changed the fo rmat fo r the complete spreadsheet to integer, the rest of the
values on the s preadsheet also c hanged to integer. This may be equally undesirable. The solution
is to fo rmat a specific range of cells.

WHAT

To Do

Move the mouse pointer to the row two
border and click the mouse button once.

WHY

You

ARE DOING

IT

Select the second row of the spreadsheet. T his row contains the years.

Figure 11.23
The second row of the
spreadsheet has been
selected. This is the range
that is to be formatted.

Pull down the Format menu, select the
Number command , then release the
mouse button.

You want to change how the numbers in the second row
of the spreadsheet are formatted.

Click the mouse on the second format
down in the format list.

Remember that this format, the 0 format, will give you
integer values.

Macintosh Productivity Tools

Click on OK.

r

.t

File Edit Formula

Apply the format to the selected row of the spreadsheet.

Format

Data

Options Macro

Figure 11 .24
The years now have an
integer format, while the
rest of the spreadsheet
retains the format with
two digits to the right of
the decimal point.

Window

Another format that you can use to e nhance the appearance of this spreadsheet is the Percent
format. Again, you do not want to apply this format to the complete spreadsheet, but to a
selected range.

WHAT

To Do

WHY

.t

File Edit Formula

IT

This range is the percents found in the lookup table.
Select even the first row of the table (cells C 14:H 14),
which is the sales values, to be fo rmatted at this time so
you can see the e ffect of the percent format on these
values!

Select the range C l5:HI 6.

r

You ARE DoiNG

Format

Data Options

Macro

Window

,

Figure 11 .25
You are going to format
the lookup table.

427

428

CHAPTER ELEVEN -ADVANCED ELECTRONIC SPREADSHEET CONCEPTS

Figure 11 .26
The two percent formats
that are defined in the
format list.

Pull down the Format menu , select the
Number command, then 00 release the
mouse button.

You are going to fo rmat the selected numbers.
Use the scroll bar to look at the available formats. You
will see two percent formats. They are 0 % and 0.00%.
The first will format the values to percent, but display no
digits to the right of the decimal. T he second will display
two d igits to the right of the decimal.
When formatting percents, a value of 0 .05 displays as
5.00%. A value of 5 displays as 500.00%. Be careful
how you enter the values into cells that you will format
for percent display.
Unfortunately, you want to format the percents to show
only one digit to the right of the decimal po int.

0.0 %

Figure 11 .27
The format you want to
use is now in the dialog
box.

Type the desired format, which is 0.0% , into the dialog
box.

Fonn11t Number
$#,##0 ;(Red)($#,##0)
$#,##0.00 ;($#,##0.00)
$#,##0.00 :IRed)($#,##0.00)
0"
0.00"
O.OOE+OO
m/ d/yy
d-mmm-uu
rorm11t:

Click on OK.

I

OK

[

Cancel

(

Dele te

I)
1
1

·' !

Io.o'?.j

I

Execute the format. T he lookup table now displays the
values as percents, and not as decimal values. Do not
worry about row 14. You will fi x it later. Do note the
effect of the percent fo rmat on these values.

Figure 11 .28
The format has been
applied to the selected
cells. Note the effect of the
p ercent format on row 14.

Place the mouse pointer on the border
for row 9, press the mouse button and
drag the mouse down to select row 10
as well.
Figure 11 .29
7\.vo rows have been
selected.

You can select more than one row or column by dragging
the mouse over the desired border cells .

Macintosh Productivity Tools

You now want to fo rmat these rows, which display the
percents used in the sales and costs rows.
Pull down the Format menu , select the
Number command , then release the
mouse button.

You are going to fo rmat the selected numbers.

0.0 %

You still want only one digit displayed to the right of the
decimal in the percent format.

Click on OK.

Execute the format. The two rows now display the values
as percents, and not as decimal values.
Figure 11 .30
The format has been
applied to the selected
rows .

-

1 1.9 CLEARING A FORMAT

You may now reasonably ask why were some format commands applied to rows, while others
were applied to ranges. In this case there was no reason except to provide an example. However,
when you build your own spreadsheets, you must consider what you are fo rmatting with some
care. A format is applied to a cell , regardless of the content of that cell.
Except for the ra nges you have formatted , the complete spreadsheet now has a format of two
d igits to the right of the dec imal point. Le t us now confirm this.

WHAT

To Do

WHY

You ARE DotNG

IT

X <-

Move the cursor to the A column. This will scroll the
window so that columns A through F are showing.

Place the mouse pointer into cell B I and
click the mouse button.

Move the cursor to cell B I.

89 [ENTER]

Enter the value 89 into cell 81. It will be displayed with
two digits to the right of the decimal point as 89.00.
Figure 11.31
The value 89 takes on the
form at that was applied to
this cell.

XB

Clear this cell by using the Clear command found on the
Edit menu.

XG

The Goto command.

Ul [cr]

Move the cursor to cell U I.

429

430

CHAPTER ELEVEN - ADVANCED ELECTRONIC SPREADSHEET CONCEPTS

Move the cursor down to cell U2 .
Recall that when you formatted the years to integer, you
formatted the complete row of the spreadsheet.
89.3 [ENTER)

Figure 11 .32
The value 89.3 takes on
the format that was
applied to this cell.

Pull down the Edit menu.

Enter this value into cell U2. It will be formatted integer,
and 89 will display.

u
89
7.00

Recall that the Clear command is on this menu.

Drag the mouse down to the Clear command and release the mouse button .

Execute the Clear command from the menu , NOT by
using the XB key. You now have the Clear dialog box,
which lets you select what you want cleared in the cell.

Click the Formats option.

You want to clear only the format applied to this cell
without removing the value.

Figure 11 .33
The Formats option has
been selected in the Clear
dialog box.

Click on OK.

Cle11r
QRii

~FOrtnlllS
Formu111s
QNotes

I

OK

(

C11ncel

J

I

The integer format will be re moved from this cell. The
value will now be displayed as 89.3.

Figure 11.34
The format has been
removed from cell U2.

You may remove the format from any cell or range in this
fashion, returning it to the default start-up format used by
Excel.
XB

The Clear command executed with the command key will
still remove the contents of the cell.
Move the cursor left to cell T2.

Macintosh Productivity Tools

89.3 [ENTER]

Put this value into the cell. It still retains the integer
format.

pel:.
u

T

--

89

- - _,

UJ;

17.00

Figure 11 .35
The cell to the left of the
one you have cleared still
retains the applied
formatting .

XB

Clear this cell .

89.3 [ENTER]

Once again, put this value into cell T2. The integer formatting is still applied to the cell. The XB key clears
only the formula or content information, and not the formatting information .

XB

Clear this cell.

XG

The Goto command.

A I [cr]

Return the cursor to cell A I.

-

11 .10 INSERTING BLANK ROWS INTO YOUR
SPREADSHEET

You have a fairly decent lookjng spreadsheet. The years are readable and it is clear what values
are percentages. All the columns for the rest of the data displayed are neatly lined up on the
decimal points. Now is the time for the finishing touches.
This spreadsheet would be much easier to look at if a blank row existed between the "Year"
row and the "Sales" row. If you had planned this when you started workjng on the spreadsheet
model, you would not need to add a row now. Unfortunately, you may not always have perfect
planning, or you may simply decide to add something.
When you add a row or column to an existing spreadsheet, Excel will adjust all the existing
formulas to reflect the data 's new locations. Thus, if cell F3 contains a formula that refe rs to cell
07 and 07 becomes 08, the formula in cell F3 will now refer to cell 08 .
Excel lets you insert a cell in the middle of a row or column. Thus it is possible to push a
single column down in the spreadsheet, without affecting all the other columns of your work. In
the example, however, you will insert a row the complete width of the spreadsheet.

WHAT

To Do

WHY

You ARE DOING

IT

Move the mouse pointer to the border
for row three and click the mouse
button.

Select the complete third row. You want to insert a row
the complete width of the spreadsheet.

Pull down the Edit menu.

This menu contains the Insert and Delete commands.

431

432

CHAPTER ELEVEN -ADVANCED ELECTRONIC SPREADSHEET CONCEPTS

You are going to insert a new row at the current location
of the selected cells, row three of the spreadsheet. You
can see that the Insert command may be executed by
using the ~l key.

Drag the mouse down to select the
Insert command .

,.

Figure 11 .36

The insert command has
been selected.

.

Fill Right
Fill Down

Release the mouse button.

Figure 11 .37

The new, empty row has
been inserted into the
spreadsheet.

'

•

Whe n you release the mouse button, a new row wi ll be
inserted into the spreadsheet. This row is inserted above
the selection. Since row three is currently selected, the
new row is inserted above row three, and below row two.

File

Edit

Formula

Format

Da ta

Options Macro

Window

.,

Use th e a rrow keys to move the cursor a round the spreadsheet. You will find that the
formulas in the cells have all bee n adjusted to re flect the new row. For example , the formula fo r
the Profit in cell 86 is no longer =(8 3- 84) , but rather = (84- 85) . T his c hange in the formula
was done automatically whe n you inserted the row.

Macintosh Productivity Tools

-

1 1.11 PUTTING LINES ACROSS THE SPREADSHEET

Another e nhancement you may wish to add is a line between the "Cost" and "Profit" rows.
Again, this is something you do to make the spreadsheet look nice.
Excel performs this task by activating lines a round the cells. You may control which lines
are turned on around any cell of the spreadsheet, or any range of the spreadsheet. To draw a line
across the spreadsheet simply entails turning o n the appropriate set of lines. These lines are
referred to as borders.

WHAT

To Do

WHY

You ARE DotNG IT

Move the mouse pointer to the border
for row five and click the mouse button.

Select the complete fifth row. You want to underline this
row of the spreadsheet.

Pull down the Format menu .

This menu contains, in addition to the number formatting
commands, the Border command.

Drag the mouse down , select the Border
command, then release the mouse
button.

Select the Border command.

Figure 11 .38

The Border command has
been selected.

After you release the mouse button, you will receive the
Borders dialog box .
Click the mouse on the Bottom check
box.

You want to activate the border on the bottom of the
selected cells.

-Borderooutllne
OLeft
0Right
OTop
181 Bottom
0Shede

Click on OK.

I(

Figure 11 .39
OIC

Cancel

J
)

The Bottom box has been
activated.

..

Apply the bottom border to all the cells of row 5.
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De-select the row. The cursor will be in cell A5.

Figure 11 . 40
After activating the border,
you can see the grid
between rows five and six
is now solid, rather than
dotted, as it has been up
to the present.

Pull down the Options menu.

To make it easier to see the border you have just added,
you are going to turn off the gridl ines on the display. You
have already done this for the printed output, but it did
not change the display!

Drag the mouse down to the Display
command , and release the mouse
button.

Activate the Display command .

Figure 11 .41
The Display command has
been selected.

Protect Document•••
Calculation •••
Calculate Now
Workspace•••
Short Menus

You will now see the Display dialog box. This dialog box
lets you turn off and on several items, as well as change
the color of items if you are using a color monitor or
printer.
Figure 11 .42
The Display dialog box.

Display
OFormulas
181 Grldllnes
181 Row & Co mn Headings
181 Zero Ualues

!tu

I

.(

OK
Cancel

,
)

r~ldllne & Heading Color

• D [!] [[] [!] [!] IBJ [II
Click on the Gridl ines check box.

® Automatic 1

Turn off the display of gridlines by removing the X from
the check box.

Macintosh Productivity Tools

Click on OK.

Put away the Display dialog box. The gridlines are no
longer displayed on the spreadsheet. You can now clearly
see the border line separating rows five and six.

Date Options

Macro

Window

.,

Figure 11 .43
The border line between
rows five and six is easy to
see when the gridlines are
turned off.

Pull down the File menu , select Save
As, then release the mouse button.

You are going to save the edited version of this spreadsheet with a new name.

Model6

Name this spreadsheet "Model6."

Click on the SAVE button.

Execute the Save procedure. Remember that you may
press the return key to complete the save process because
this button is double outlined.

-

11.12 MOVING CELLS OF THE SPREADSHEET

It is not uncommon to discover that the original location of some information on your spreadsheet may no longer be optimal as the spreadsheet is developed. Sometimes, the problem may be
solved by splitting the spreadsheet window as you have already done. You may also discover that
you have entered several rows of information in the wrong order, or that a different order makes
better sense to the reader of the spreadsheet. Splitting the window will not help in this case!
This problem can be solved by re-entering the information into the correct cells or by
moving the information to the desired location. If the information is simple, or there is not a lot
of it, you may find it easier to just retype the contents of the cells. However, if there are many
formulas involved, or even a single complex one, you risk the danger of introducing errors as
you re-enter the formulas. It is safer to move these cells to their new location, rather than
retyping them.
When you move a cell, the contents of the cell being moved are ERASED from the original
cell and placed into the destination cell. If there is information in the destination cell, then it will
be lost! The move procedure does not add rows or columns to the spreadsheet; thus you may
need to insert a blank row or column before you execute the move.

WHAT

To Do

WHY

You

ARE DOING IT

XG

You are going to Goto the cell you want to move.

T4 [cr]

Goto cell T4. This cell contains the IF function you created earlier.
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XC

First, you are goi ng to try copying this cell .

XG

Goto the destination of the copy.

A l4 [cr]

This is where you want to place the copy of cell T4.

XV

Paste the copy of cell T4 into cell Al4 . When you complete the copy procedure you will receive an error message, #REF. Excel has tried to adjust the cell reference
in the copied cell. It wants to refer to a cell that is to the
left of the spreadsheet. Because this is not possible, you
received the error message.

Figure 11 .44
After you copy the cell,
Excel will display an error
message.

Clearly, you do not want to use the Copy command at
this time.

XG

Once more , you are going to position the cursor on the
cell you want to move.

T4 [cr]

Goto cell T4. You want to move the same cell you tried
to copy.

XX

This is the Cut command found on the Edit menu.

XG

You are once agai n going to move the cursor to the destination cell.

Al4 [cr]

This is where you want to place the moved copy of the
cell.

XV

Paste the contents of the cut/copy buffer into cell A 14.

Figure 11 .45
The cell has been moved,
rather than copied. The
reference is not adjusted.

The IF function in cell A 14 is now the correct one , and
the information displayed is " OK", since the sales in the
fifteenth year are well over 120. Notice that the version
of this cell that was copied into cell Al4 has disappeared.
Remember, this Move sequence does not insert a row or
column into the spreadsheet. It replaces the contents of
the destination cells. The prior information in cell A 14
was replaced.

Macintosh Productivity Tools

A key feature of the process you just completed is that the
cell references are NOT adjusted as they are when you
copy or fill a cell.

3€G

The Goto Command.

U 1 [cr]

You want to see the right portion of the spreadsheet you
have created.
You can see that cell T4 is now empty.

r

•

Edit

Formul11

Form11t

R

2351 .30
1533.71
817.59

s

D11t11

Options M11cro

Window

,

Figure 11 .46
You can see that cell T4 is
empty.

Model6
T

156.75
102.25
54.51

You should also notice that cell U4 , which contains the
example of the COUNT function , now displays 4.00.
Position the mouse pointer on cell U4
and click the mouse button.

Edit

Move the cursor to cell U4.
The COUNT function is now counting the occupied cells
in the range A4:B 14. The cell that anchored the range of
cells being counted was moved , and the anchor moved
with it! You must always be careful when moving cells
(as compared to copying cells) to prevent this type of
change to your model.

Formul11 Form11t D11t11 Options

M11cro Window

: COUNT(A4:B 14)
R

s

Model6

235 1.30
1533.71

T

u

y

,

Figure 11.47
The count function in cell
U4 has changed the range
of cells being counted to
A4:814.

4,001

Move the mouse pointer to the edit line.

You are going to change the argument of the Count
function.

Select the range definition on the edit
line.

You are going to change A4:BJ4 to read B4:T4.
Figure 11 .48
Select the range reference
on the edit line.
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B4:T4

Enter the new range into the formula.

[ENTER]

Enter the new formula into the cell. The count will return
to 17.

-

11.13 DELETING EXTRA ROWS OR COLUMNS

After you have moved a cell or range of cells, you may then use the row or column delete
command to remove the now extra row or column . You must be careful , however, not to de lete a
row or column that contains information. For example, if your work is contained in the range AI
through H20 and you move the range A5 through F5 , you must make sure that 05 and H5 a re
not referred to by a formula in another cell before you delete row 5. If you do delete row 5, and it
is re ferenced , then you may tota lly scramble your spreadsheet.

W HAT

To Do

WHY

You ARE DoiNG

IT

Move the mouse pointer to the S column
label box.

You are going to select the complete column.

Click the mouse button.

Select colu mn S of the spreadsheet. This is the column
you want to delete.

Figure 11 . 49
The 5 column has been
selected.

Pull down the Edit menu.

The Delete command is, like the Insert command ,
located on the Edit menu.

Drag the cursor down to select the
Delete command, then release the
mouse button.

Execute the Delete command to remove the selected
column from the spreadsheet. This command may be
executed with the ~ key.

Macintosh Productivity Tools

Figure 11 .50

The Delete command has
been selected.
Cut
38H
38C
Copy
Pas1e
:J(:U
Clear...
388
Pas1o Spei:I<JI ...
Pas1e Link

38 1

After you release the mouse button, the S column will be
removed from the spreadsheet. All columns to the right
will be moved one column to the left.
Move the mouse pointer to cell T4 and
click the mouse button.

Move the cursor to cell T4. The Count function now
occupies this cell.
Notice that the range in the COUNT function has been
adjusted from B4:T4 to B4:S4. Excel knows that a
column has been removed from the range, and it is
adjusting for this fact.

File

Edit

Formula Format Data
:COUNT(B4:54)

Options

Macro

Window

Model6
S

u

T

y

,

Figure 11 .51

The count function has
been adjusted to take into
account the deleted
column.

I 7,001

Move the cursor to cell A I.
Pull down the File menu, select Save
As, then release the mouse button.

You are going to save the edited version of this spreadsheet with a new name.

Model?

Name this spreadsheet "Model?."

Click on the SAVE button.

Execute the Save procedure.
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1 1.14 NAMED RANGES

You have already had some exposure to the na med range feature of Excel. You defined a range in
Chapter 9 for input purposes. The ability to assign a name to any range is a useful feature of
Excel. If the na med range is a single cell , then you may use the name of the cell in a fo rmula
rathe r than the cell address. In a similar fashion, if the named range is a ra nge, then you may use
the name of the range in a formula when it is appropriate.
This feature lets you do several things . First, you can internally document the spreadsheet
you are c reating. You can make the formula for the Profit in cell B7 read = (Sales_Vol-Costs)
rather than (B4- B5). In seve ral weeks, which of these two will be easier to interpret?
By using named ranges you will be able to ente r the range na me directly into a formula or a
command that requires it by using the Paste Name command found on the Formula menu. This
can be easier than trying to remember the cell addresses. You a re also able to use the Apply
Names command to replace cell addresses with the defined range names .

-

1 1.15 DEFINING AND USING RANGES
Remembe r, to define a range, you first select it. Then you use the Define Name command found
on the Formula menu. You will see that you may use the XL key as a shortcut to pulling down
the Formula menu to access the Define Name command.

W HAT

To Do

Move the mouse pointer to cell B4 and
click the mouse button.

WHY

You ARE DotNG IT

Select cell B4, the sales fo r the starting year.
This key is the Define Name command found on the Formula menu.
Note that the cell reference reads = $B$4. Recall that the
$ means absolute reference. Thus, wherever you use the

range name you are about to create, it will always refer to
cell B4.
Figure 11.52
The Define Name dialog
box. Note that the
referenced range reads
= $8$4.

0

Define Neme

lnRange
Neme:

I''"'

Refers to:

I

OK

(

Cancel

)

(

Delete

)

I·SB$4
Sales_ Vol

~

((

Type the name "Sales_Vol" for the range name. Range
names may be up to 255 characters long. They must
start with a letter of the alphabet, and may then
include letters, digits (0 .. 9), an underscore character
(_)or a period (.) . Spaces are not allowed.

I
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Define Name

1111

lnRange

~

Name:

l sales_Uo~
Refers to:

lfi

c(

OK
Cancel

I ( Delete

Figure 11 .53
The name of this cell will
be Sales_ Vol.

I
I

I

I·SB$4

Click on OK.

,

Complete this range name definition.
Move the cursor down one cell to 85.

~L

The Define Names command.

Costs

Enter Costs as the name for cell 85.

Click on OK.

Complete the range name definition.

Select 84 in the formu la on the edit
line.

You are going to replace this cell reference with its range
name.
Figure 11 .54
Cell 84 has been selected.

Pull down the Formula menu.

The Paste Name command, found on this menu, will let
you insert range names into formulas.

Drag the mouse down and select Paste
Name.

This command is only active when you have defined
names. You can see that it does not have a command key
equivalent.
Figure 11 .55
The Paste Name command
has been selected.

O~tin~

Nome ...

£ n.•n tl.•

Name~...

RppltJ

Name~ .•.
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Release the mouse button.

Activate the Paste Name dialog box.

Click on Sales_ Vol.

You want to replace the cell address in the formula,
which is 84, with the name of the cell.

Figure 11.56
Th e range name Sales_ Vo l
has been selected.

Pest e Name
Costs
lnRange

F

c

J

OK
Cancel

l

( Pa~tP li~ t )

'"\

In

Click on OK.

Replace 84 with the selected range name.

[ENTER]

Press the enter key to complete the editing of the cell's
formula.
You can see that the value displayed has not changed, but
that the edit line now displays Sales_ Vol in the formula ,
rather than 84 .

Figure 11.57
The formula now uses the
range name, rather than
t he cell address.

,.

•

:

File Edit Formula Format Date
BS
1 1 : (B I I • Sales_Vol)
~

\--!- ABC CO.

::t-!:: 3

:! t--"4 SALES
~! 1"""5 COSTS

\_.,,!.,.

PROFIT

c

~

L

M odel7

1970

1971

100.00

18 :00

_ft

!lUI

_: ~. UU

.03

35.97 .......

Editing each cell in this fashion can be time-consuming ,
as well as cumbersome. Fortunately, you can have Excel
substitute appropriate range names for cell addresses.
Move the cursor down to cell B6, which contains the formula for the profit.
Pull down the Formula menu.

You are going to use a command from this menu.

Drag the mouse down and select Apply
Names.

This command will replace cell addresses with a matching range name. Thus, if cell A 1 is named "Start", and
is used in a formula, this command will replace A 1 with
" Start" in that formula.

Macintosh Productivity Tools

Figure 11 .58

~

~
l

(J

For mat Oat
Paste Name•••
Paste Function •••
R•~lt>rl'nce

:Jl:T

~

Define Name ••• X L I
Create Names•••

0

3
7

Not e •••

(

I

T

L

The Apply Names
command has been
selected.

X6
6oto •••
XH
Find•••
Replace •••
Select Special•••
Show Rctlue Cell

~·

:)
l

.........!

Execute the Apply Names command. This command
does not have a command key equivalent. You will now
see the Apply Names d ialog box.

Release the mouse button.

You can see that the fi rst name of the names list, Costs,
is the only one selected. If you execute the command
now, only references to cell 8 5 will be replaced by the
range name Costs. References to cell 84, which has been
named Sales_Vol, will not be changed.

I

Apply Nemes

OK

I

( Cancel

lnRange
SalesJol

to

Figure 11 .59
The initial Apply Names
dialog box.

(Options >>)

1811gnore Relatlue/ Rbsolute
181 Use Row and Column Names

[SHIFT]

Hold down the Shift key.

Move the mouse to the last name in the
list and click the mouse button.

Since the Shift key is held down, the selection will be
stretched from its original location to where you clicked
the mouse. You are selecting all three range names.

I

Figure 11.60
OK

))

Cancel )
(Options »)
1811gnore Relatlue/Rbsolute
181 Use Row and Column Names

All the names in the list of
range names have been
selected.
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Execute the Apply Names command.

Click on OK.

After a brief pause, the formula in cell 86 will change.
The cell references will now be replaced by the appropriate range names.
Figure 11 .61

r

The formula in cell 84 now
uses the range names,
rather than the cell
addresses.

•

i::: ±
r-4->+
\-t--

Formula Format Date
I =(5Gies_Voi-Costs)

Edit

File

I

86

,.

Model1

c

B

ABC CO.

SALES
COSTS
PROFIT

I

1970

1971

100.00
67.00

109.00
73.03
35.97

~~. DUI

(
_\

Select the range C 15:H1 7.

This is the lookup table you created for determining the
sales growth rate and the cost percents.

XL

The Define Names command .

ControLTable.

Name this range ControL Table.

Figure 11 .62
The range C15:H17 is being
named.

r

•

File

Edit Formula

Format

Date

Macro

I

Window

OK

I ( Cancel
' - - - - - - - ' - - - - ' ( Delete

Click on OK .

Complete the name de finition.

Select the range C I5 :Hl5 .

This range overlaps the control table range. It is the first
row of the control table .

XL

The Define Names command.

.,

Macintosh Productivity Tools

Sales_Control.

Name this range Sales_Control.

.,

Figure 11.63
The first row of the
ControL Table is given its
own name.

Costs

In Range
Sales_Uol

67.0~

Click on OK.

Complete the name definition. Once again , note that this
range overlaps the control table range.

XG

You want to Goto a defined range .

Click on the name ControL Table.

You want to Goto the ControLTable range.

C lick on OK.

Complete the Goto command . The control table range
should now be selected.

Pull down the Format menu.

You are going to change the format of how these numbers
are displayed.

Drag the mouse down to the Number
command and re lease the mouse button.

You want to apply a new numbe r format to the selected
range.

0%

You want to continue to have these values displayed in percent format, but you do not want to have a digit displayed
to the right of the decimal point. If desired, you may use
the scroll bar at the right side of the format list to locate
this format , then click the mouse on it to select it.

Click on OK.

Apply this new format to the selected range. The sales
dollar amounts in row 15 of the control table are also formatted to percent. T his is not desirable.
Figure 11 . 64
The first row of the control
table is not properly
formatted.
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XG

The Goto command.

Click on the name Sales_Control.

You will reformat this range, which is the first row of the
control table.

Click on OK.

Complete the Goto command.

Pull down the Format menu.

You are going to change the format of how these numbers
are displayed.

Drag the mouse down to the Number
command and release the mouse button.

You want to apply a new number format to the selected
range.

Click on the first format in the list that
starts with a $.

You want to apply a format to this range that will display
a $ as part of the number. This format does not include
any digits to the right of the decimal point. The second
part of this format will cause negative numbers to be displayed enclosed in parentheses. If you have a color monitor or printer, you may want to use the format that
includes [Red] . This will display negative numbers in
red, rather than the standard black.

Figure 11.65
The currency for no digits
to the right of the decimal
point has been selected.

Format Number

OK

0.00
#,##0
#,##0.00
I

(

Cancel

(

Dele1e

,

$#,##0 ;(Red)($#,##0)
$#,##0.00 ;($#,##0,00)
$#,##0.00 ;(Red)($#,##0.00)

01.
Format:

Click on OK.

Apply the format to the selected range. The prior formatting for the range is overridden, and the currency format
is applied to the cells. Since the Sales Control range is
not the exact same range as the Control Table range, the
cells in rows 17 and 18 do not have their formatting
changed.

Click on the Select All box.

Select the complete spreadsheet.

Pull down the Formula menu, select the
Apply Names command, then release
the mouse button.

You want Excel to replace all the cell references with
their appropriate defined range names.

Click on the first range name in the list,
press and hold the [SHIFT] key, then
click on the last name in the list.

You want to apply all possible names to the selected
spreadsheet.

Macintosh Productivity Tools

Format

Data

Apply Names
fontrol r.rhlt•
(0\1\

lnHdrHJP
SdiPL(nntrol
SaiPs_llol

Options Macro

I
r!1

H

Window

.,

Figure 11 .66
All the range names in the
name list have been
selected.

OK

( Cancel
( Options »)

'"'

1811gnore Relatlue/ Rbsolute
181 Use Row and Column Names

Click on OK.

Execute the Apply Names command.
The Goto Command.

AI [c r]

Move the cursor to the A column.

Pull down the File menu , select Save
As, then release the mouse button.

You are going to save the edited version of this spreadsheet with a new name.

Model8

Name this spreadsheet "Model8."

Click on the SAVE button.

Execute the Save procedure.

-

1 1.16 CHANGING THE WIDTH OF A COLUMN

The re are many times whe n you will want to have a column be w ider than the default width. At
other times, you may want a column to be narrower. This is a simple task.

WHAT

To Do

WHY

You ARE DOING

IT

Move the mouse pointer to cell Al6 and
click the mouse button.

Move the cursor to cell Al6.

GROWTH PATTERN I [ENTER]

Enter this text into cell Al6.
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-+

Move the cursor to cell Bl6.

1 [ENTER]

Enter the value 1 into this cell. This will be used to determine the row number of the lookup table in which this
pattern can be found. If another growth pattern is
inserted into the table, it will be assigned a value 2, and
so on.

Pull down the Format menu, select
number, then release the mouse.

You want to change the default format for cell B 16.

0

You want the format to be integer.

Click on OK.

Execute the format change.
Because cell B16 is no longer empty, the text in cell A16
cannot be completely displayed.

Figure 11.67

The complete contents of
cell A 16 are no longer
displayed.

Figure 11.68

Move the mouse pointer to the vertical
line separating the A and B border cells.

The lines separating the border cells can be used to
change the width of columns. When the cursor is in the
proper location, it will change its appearance (Figure
11.68).

Press and hold the mouse button.

When you press the mouse button, a line will extend
down the window at the current column width. The
actual value for the width will be displayed at the left end
of the edit line.

The cursor changes shape,
indicating that it may be
used to change the width
of a column.
Figure 11.69

The mouse button has
been pressed. The current
column width is displayed
on the edit line, and the
actual column can be seen
on the display.

Macintosh Productivity Tools

Drag the mouse right until the width
reads 14.00 on the edit line.

You want to change the width of this column to 14.00.

r

•

File Edit Formula Fo~
(
Width: 14.00 I
I I

A
::
:: ,....!.... ABC CO.

:: ~

>+

·:

Release the mouse button.

SALES

Figure 11 .70

The width of the column is
going to be set to 14.

LJI

I

1970 ~
100.00

l

The column will stretch to the newly defined width.
Figure 11.71

The A column has been
made wider. If you turn on
the spreadsheet gridlines
(the Display command on
the Options menu}, the
change in column width
will be more obvious.

Move the mouse to the border of the 8
column.

You are going to select several columns of the spreadsheet.

Press and hold down the mouse button,
drag the mouse right to column P, then
release the mouse button.

Select columns 8 through P. The A column is not
selected. It has its own width.

Pull down the Format menu.

This menu has an option that lets you control the width
of columns. You could have used it to change the width
of column A, rather than stretching the column.
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Select the Column Width option.

You want to change the width of all the selected columns.
Note that the standard column width is 10.

Figure 11.72

The Column Width
command has been
selected.

7

Change the column width for the selected columns to 7.

Figure 11 .73

The Column Width dialog
box. Note that the
Standard Width box
is not checked.

Column Width:

0

Click on OK.

r:r=::J n

Standard Width

I

OK

Cancel

E xecute the column width change.
Return the cursor to cell A I.
You can see that all the selected columns are narrower
than they were originally.
If you want to change a column back to its standard
width , select the Column Width command , then check
the Standard Width box before clicking on the OK
button.

Figure 11.74

The columns have been
made narrower.

r

•

File Edit
AI

Formula Format Data Options Macro
ABC CO.

Window

ModelS
B

C

D

E

f

G

1970

1971

1972

1973

1974

1975

100.00
67.00
33.00

109.00
73.03
35.97

118.81
78.41
40.40

127.13
82.63
44.49

133.48
86.76
46.72

140.16
91.10
49.06

It is possible to hide a column by making it's width 0.
Move the mouse pointer over the separator line in the border between columns
D and E.

You are going to hide column D by making its width 0 .

Press and hold the mouse button.

Select this column border.

Drag the separator left until the width
reads 0.

When the width of a column is zero , the lines showing
the current column width will disappear from the
window.

.,

Macint osh Productivity Tools

r

File Edit
Widt h: 0.00
•

Formula Format
ABC CO.

Da ta

Options

Macro

Window

.,

The edit line tells you that
the width o f the column is
being set to zero.

ModeiB - - -- - - -- - -- A

B

C

D

E

1970

1971

1972

1973

1974

1975

127.13
82.63
44.49

133.48
86.76
46.72

140.16
91.10
49.06

100.00
67.00
33.00

109.00
7 3.03
35.97

11 8.81
78.4 1
40.40

Release the mouse.

F

Figure 11 .75

G

The D column will disappear. Note that this has no effect
on the computations.

Edit Formula Format
ABC CO.

Data

Options

Macro

Window

.,

Figure 11 .76

The D column has been
hidden.

ModelS
A

B

c

E

F

G

H

1970

1971>

1973

1974

1975

1976

127.13
82.63
44.49

133.48
86.76
46.72

140. 16
91.10
49.06

147. 17
95.66
51.51

100.00
6 7.00
33.00

109.00
73.03
35.97

Select columns C and E.

Now you want to get the column back. Select these two
columns by clicking in the border above the C column,
and dragging the mouse right to the E column.

Macro

Window

.,

Figure 11 .77

By drag selecting columns
C and E, you have also
selected column D.

Pull down the Format menu, select
Column Width, then release the mouse
button.

You are going to change the column width for the
selected columns. The hidden column is in the range of
the selection.

7

You are going to set the columns to 7, just as before.

Click on OK.

When you click on the OK button, the hidden column
will return , since it's width has also been set.
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1 1.17 CHANGING THE HEIGHT OF ROWS

Figure 11 .78

Note the position of the
mouse pointer.

Just as you are able to adjust the width of a column, you can adjust the height of a row. You no
doubt noticed the Row Height command on the Format menu while you were adjusting the width
of the columns. This is the command that is used to make rows taller, or shorter. Of course, you
may stretch a row using the same technique you used to stretch a column.

WHAT

To Do

W HY

You A RE DOING IT

Position the mouse pointer over the line
separating the 6 and 7 border cells.

You want to adjust the height of row 6. The mouse
pointer will change to the stretch tool.

Press and hold the mouse button.

Two lines, one above and one below row 6, will appear
across the width of the window. The value 13 .00 will
appear on the edit line, indicating the standard row
height.

Fi gure 11.79

The standard row height is
13.00.

Drag the mouse down until the height
reads 17 .00, then release the mouse.

,. •

File

Edit

Height: 13.00

I l

Adjust the row height to 17 .00.

Figure 11 .80

The row height has been
adjusted. You can see the
additional row height
space by comparing the
border cell for row 6 with
the other border cells, or
by turning on the
spreadsheet's gridlines.

-

11.18 CHANGING THE TYPE FONT

Like most Macintosh applications, Excel gives you full access to the different typefaces and .t ype
styles. If you want, you can make parts of the spreadsheet boldfaced, and other parts in a
different type font.

Macintosh Productivity Tools

WHAT

TO Do

WHY

Click on the A column border cell.

You ARE DOING IT

Select the complete A column.
Figure 11.81

You are going to change
the type style of all the
cells in the column A.

Pull down the Format menu .

You have seen that this menu is used to change the
appearance of the spreadsheet.

Drag the mouse down to the Font
command.

You are going to change the font.

Figure 11 .82

The Font command has
been selected.

Release the mouse button.

Font
Ruant Garde
Bookman
Cairo
Chicago
Courter

olo

When you release the mouse button you will get the Font
dialog box.

tyle
OBold
0 Italic
0 Underline
0Str1keout
OOutllne
0ShadOW

€

OK

,

( Cancel
181 Standard
Font

Figure 11.83

The Font dialog box .
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Scroll the font list in the left window
until you see Times.

You are going to change the type font for column A to the1
Times font.

Click on Times in the font list.

Select the Times font.

Click on Bold in the style box on the
right.

In addition to changi ng the font , you want to change tht;
style to display the text in the column in boldface.

Figure 11 .84
Changes have been made
to the Font dialog box.

Font

Style----.

San Francisco

181 Bold ~
0 Italic
0 Underline
0 Strikeout
0 Outline

S mbol

0Shadow

Click on OK.

Apply the font changes to the selected cells.
Clear the selection. You can now easily see the effect of
the font change.

Figure 11.85
The type font for column
A has been changed to
Times Bold. You did not
change the point size.

-

11.19 AUTOMATIC VERSUS MANUAL SPREADSHEET
RECALCULATION

All the value cells of Excel spreadsheets are automatically recalculated (or updated) whenever a
single cell entry anywhe re in the spreadsheet is c hanged . This is referred to as automatic recalc ulation. The opposite state, in which the updated values are computed only when you manually
tell the spreadsheet to do so, is called manual recalculation.

Macintosh Productivity Tools

As the model you create or manipulate gets larger, the time the program needs to recalculate
all the value cells can become correspondingly large, measurable in seconds or minutes, rather
than in tenths of seconds. This delay can be bothersome. Excel lets you turn off the automatic
recalculation feature. With automatic recalculate off, you may freely enter values and formulas
into cells with no recalculation delay.
When you use the spreadsheet in this fashion, however, the values displayed will not be
correct until recalculation occurs. To remedy this, you must give the manual command to cause
the program to recalculate the spreadsheet values.

-

1 1.20 CHANGING THE RECALCULATION STATUS
You are now going to change the recalculation mode from automatic to manual. Remember,
manual recalculation means that you cannot be sure that the spreadsheet will be displaying
accurate numbers until after you tell it to recalculate.

WHAT

TO Do

WHY

You ARE DotNG IT

Pull down the Options menu.

Recall that this menu lets you control the print area and
display features. It also lets you control the recalculation
status .

Drag the mouse down to the Calculation
command.

This command lets you turn off and on automatic recalc ulation. It does not have a command key equivalent.
Figure 11 .86
The Calculation command
has been selected.

Dlsptey•••
Stenderd Font •••
rrPPZP PonPS

Release the mouse button.

You will see the Calculation dialog box when you release
the mouse button .

455

456

CHAPTER ELEVEN - ADVANCED ELECTRONIC SPREADSHEET CONCEPTS

Click on Manual in the calculation box.

Figure 11 .87

The spreadsheet will recalculate only when you tell it to
after you check the Manual option. T his will save you
some time when editing large spreadsheets.

I(

r(:elculetl on
0 Aut omatic
0 Automatic EHcept Tables
Manuel

The Manual option has
been selected in the
Calculation dialog box.

'I

0

Iteration
Maulmurn 11 era11on~:

I• DO

MnHimum [ hftnge:

,0.001

OK
Cancel

,
)

I
I

Sheet Options
0 Precision as Displayed
181 1904 Date System

Click on OK.

Put away the dialog box, making the change in the calculation status.

Move the mouse pointer to cell B4 and
click the mouse button.

Move the cursor to cell B4.

150 [ENTER]

Enters 150 into sales for the fi rst year. Notice that no
other numbers change. This is the result of setting the
spreadsheet to manual recalculation. At the same time,
notice that "Calculate" appears at the bottom of the display on the status line. This is an indicator that the
spreadsheet must be recalculated to display its values
accurately.

figure 11 .88

The spreadsheet has not
updated its values since it
is set to manual
recalculation. Excel is
telling you not to trust the
values displayed by
showing the word
Calculate at the bottom of
the display.

'

•

File Edit

Formula Forma t

Date

Options Macro

109.27
67.0~

126.4 7

.,

133.59

9. 0~

9.0~

7 .0~

5 .0~

5 .0'1!;

67. 0~

66.0~

65 .0~

65 .0~

65 .0~

$0

$80

$90

2~

3~
69~

5~
68~

70~
;! •

1 18.31

Window

$100
9~
67~

I:!.

Calcul ate
Pull down the Options menu.

Look at this menu. You can see that the re is a command
called Calculate Now. This command is used to tell Excel
to recalculate the spreadsheet. It can be executed by
pressing the :11: = key.

Release the mouse button.

Do not execute the command by using the menu.

Macintosh Productivity Tools
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Hold down the command key and press the equals sign.
This forces the spreadsheet to recalculate all the values.

s Macro Window

65.0~

5. 0~
65. 0~

I 57.63

165.51

173.78

182.47

5.0~
65.0~

5 . 0~
65. 0~

5 .0~
65 .0~

5. 0~
65 . 0~

,

Figure 11 .89

The spreadsheet has
recalculated. The word
Calculate is no longer
displayed on the bottom
of the screen since the
spreadsheet Is up to date
In Its recalculations.

Pull down the Options menu, select calculation, then release the mouse button.

You are going to return the calculation mode to
automatic.

Click on the automatic button.

Return the recalculation status to automatic by clicking
on automatic in the Calculation dialog.

Click on OK.

Put away the dialog box.

Pull down the File menu, select Save
As, then release the mouse button.

You are going to save the edited version of this spreadsheet with a new name.

Model9

Name this spreadsheet "Model9."

Click on the SAVE button.

Execute the Save procedure.

XQ

Execute the Quit command to leave Excel and return to
the Macintosh's desktop.

EXERCISES
l. If rows 1 through 18 are displayed on the spreadsheet window, and you split the window horizontally between rows 9 and
10, which rows will be in the top pane, and which in the bottom pane?
2. Can you split the Excel spreadsheet horizontally and vertically at the same time?
3. If you format the cell B4 to display two digits to the right of the decimal point, what value will be displayed if you enter
10.455 into the cell? What if you enter 10.456? What if you enter 10.454?
4. If you format the cell B4 to display no digits to the right of the decimal point (i.e., integer format) , what value will be
displayed if you enter 189.93 into the cell? What if you enter 189.43? What if you enter 189.99?
5. If a cell contains the formula =SUM(ClO:C22) , and two rows are inserted at row 17, what will the formula read after
you insert the rows?
6. What is the difference between moving a cell and copying a cell?
7. What special character must be added to a cell formula to make a cell reference copy in absolute mode, rather than
relative mode?
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8. Must the special character you add to a cell formula for absolute mode copies be placed in front of the column name and
the row number, just the column name, or just the row number?
9. If a cell contains the formula = HLOOKUP(G22,Ll :P5,3), and a row is added to the spreadsheet at line 2, what will this
formula read? Will any changes have to be made to this formula? If so, what are the changes?
10. If a cell contains the formula = SUM(M20:M45}, and three rows are removed from the spreadsheet at row 29, how will
this formula change?
11. If a cell contains the formula = SUM(E6:E10}, and column G is deleted from the spreadsheet, how will this formula
change?
12. If you assign a name to a cell, how do you make the name appear in a cell that references the named cell?
13. If you assign a name to a range, how do you make the name appear in a cell that references the named range?
14. Is is possible to change the width of a single column of the spreadsheet from the preset width to something else?
15. Must a named range be a unique range, or can it overlap with another named range?
16. What is the advantage to using named ranges rather than cell references?
17. Break-even analysis is used to compute the number of units of a product a company must sell before it starts making a
profit on the item. The formula for the break-even point is
Break-even Point

= Fixed Costs I (Selling Price- Variable Costs per unit)

Create a spreadsheet as follows to compute the break-even point. Use it to answer Problems 18 through 20.
(NOfE: xxxxx represent numbers you enter.)
FIXED COSTS
ADMINISTRATIVE
ADVERI'ISING
INSURANCE
OfHER

xxxxx
xxxxx
xxxxx
xxxxx

1tYfAL

xxxxx

VARIABLE COSTS PER UNIT
xxxxx
LABOR
MATERIAL
xxxxx
OVERHEAD
xxxxx
1tYfAL VARIABLE
COSTS PER UNIT

xxxxx

SELLING PRICE
PER UNIT

xxxxx

UNITS NEEDED TO SELL TO BREAK-EVEN xxxxx
18. What is the break-even point in Problem 17 for the following costs:
Administrative
Advertising
Insurance
Other
Labor/unit
Material/unit
Overhead/u~t

Selling Price/unit

400.00
175.00
45.00
22.00
1.25
3. 75
0.67
7.22

19. What is the break-even point if Administrative costs drop from 400.00 to 350.00?
20. If administrative costs remain at 350.00, but labor/unit increases to 1.45, what will the break-even point be?
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21. Create a spreadsheet to compute the cost of a picnic. On the menu are (1) hamburgers, (2) hamburger buns, (3) potato
salad, (4) bean salad, (5) chocolate cake, and (6) lemonade. You have seven pounds of hamburger, costing $2.49 per
pound, and with this you can serve 25 people. Twenty-four hamburger buns cost $4.25. There is also a large bowl of
potato salad, which costs $5 and will serve 15 people, and a medium bowl of bean salad, which costs $8 and will serve 10
people. There is a cake big enough to serve 30, and it costs $12. Finally, you have three gallons of lemonade, which is 48
servings and which costs $3. How much does a meal of one hamburger with bun, a serving of bean salad, a slice of
chocolate cake, and two servings of lemonade cost?
22. What will be the cost if the person wants potato salad instead of bean salad?
23. How much would a meal cost if a person asked you for one of everything?
24. If you sold everything at a mark-up of 25 percent over your cost, what is your selling price for each item on the picnic
menu?
25. If you manage to sell everything at the 25 percent mark-up, what is your gross income (total income from sales)? What is
your net income (gross income less expenses)?
26. What is your net income if you sell the following at 25 percent mark-up and everything else at 5 percent below your cost:
18 hamburgers with buns
2 hamburgers without buns
12 servings of potato salad
10 servings of bean salad
24 slices of cake
41 servings of lemonade

CHAPTER

BUILDING MACROS WITH
ELECTRONIC SPREADSHEETS

12

-

CHAPTER OBJECTIVES:

Upon completion of this chapter, the student will:

• Create and execute a command macro.
• Create and use a function macro.
• Create a macro to add a menu item to the Excel
menu bar.

• Make a macro load and execute automatically
when the spreadsheet is loaded.

-

12.1 WHAT IS A MACRO?
Very simply put, a macro is a program . Macros are stored up commands , keystrokes and
customized menus. In effect, you are sto ring the necessary actions in a separate macro spreadsheet that is connected to the spreadsheet itself. You then tell Excel to execute this sequence of
stored instructions on demand. Your macros can manipulate the cells of the spreadsheet, use
information found in them , format cells , print spreadsheets, :;tnd even create new menu bar
entries or a new spreadsheet. You can write a macro program to automate the performance of
any task that Excel can do.

-

1 2.2 WHY CREATE A MACRO?
You repeat many tasks when working with electronic spreadsheets. One action you perfo rm with
relative frequency is printing the spreadsheet. While this is not a difficult task, it is possible to
automate the selection of print areas and the execution of the print command itself. You may also
find it beneficial to take over control of the spreadsheet at times and not require the user of a
model you have created to know a great deal about how to use Excel, o r how to build spreadsheets. Again , automating spreadsheet functions through the use of macros is the answer.
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A macro can be created to perform a variety of tasks, as simple or as complex as you desire.
A macro may contain commands such as the Goto command, cursor movement commands such
as moving the cell pointer with the arrow keys, cell entries, or anything else you might type from
the keyboard. When you tell Excel to perform a particular macro, it executes the commands and
keystrokes that have been stored for that macro one at a time. This type of macro is called a
Command macro, since it is a sequence of stored commands.
You may also create a second type of macro, called a Function macro. You have used
functions already. You have used functions such as SUM , AVERAGE and HLOOKUP. The
function macro is a function that you create. For example, you may have a complex formula that
you want to be able to use in several spreadsheets . You could put the formula into a function
macro, and then use it whenever you want.

-

1 2.3 CREATING MACROS TO EXECUTE SIMPLE TASKS

Both command and function macros are placed in the cells of a special type of spreadsheet,
called a Macro Sheet. Thus, to create a macro for a spreadsheet you must first create a macro
sheet. The advantage of placing the macros on a separate document is that they may be used with
multiple spreadsheets. All you have to do is keep cell references (or range names) consistent
among the different spreadsheets.
Once you have created a macro sheet, you enter the commands and actions you want the
macro to carry out into the cells of the macro sheet. After you have typed into the cells the
actions you want performed, you may tell the macro sheet the name of the macro. This is done
with the named range feature. From then on, when the spreadsheet is active, all you need to do is
enter the macro name to execute the macro.

-

1 2.4 RETRIEVE THE SPREADSHEET

Before you begin to make a macro, start Excel and load the spreadsheet that you completed in
Chapter II. To do this, boot your Macintosh with a System Start-Up disk, then insert the Excel
Program disk into one of the computer's disk drives. If you are using a machine with a hard disk
you will not need to insert the Excel program disk into a disk drive. Rather, locate the Excel
folder, and open it so you can see the Excel program icon. Place the disk that has your saved
model into another one of your Macintosh 's disk drives, if you have one available . This disk will
be used for saving your work. If you do not have a free floppy disk drive, keep this disk
available. You will need it for retrieval and storage.
In these instructions , [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g. , XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on . .." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on .. ." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed.
Finally, if you want your work to match the figures in the text, be sure to use the Chooser DA
to select a LaserWriter and not an lmageWriter. You may select a LaserWriter even if your computer is not actually attached to one. You will not, however, be able to print if this is the case.
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In this sectio n you will , after loading the spreadsheet, name several ranges. This will be
done before you begin to actual ly create the macros . You will see that the macros created in this
chapte r will make use of the ranges you name.
If you are using a computer with a hard disk , begin here:

WHAT

To Do

WHY

You ARE DOING lr

Locate the icon fo r the spreadsheet you
were working on in Chapter 11 and
place the mouse pointer on the icon.

You are going to launch Excel by double-clicking on this
icon. It is called Model9.

Double-click the mouse.

By double-clicking on an Excel spreadsheet , the Macintosh will look on all available disks for the Excel application program. If found, it will launch Excel and open the
docume nt. If the Macintosh is not able to locate the
application program, you will get an error message.
If you have the Excel application program on your hard
disk, or on a floppy disk currently in one of the computer's disk d rives, the program should start , and after a
brief wait, the spreadsheet you saved at the end of Chapte r 11 will appear.

If you are using a co mputer that has only floppy disks, then start here:
Locate the icon for the Excel program.

You will launch the Excel application program by doubleclicking on it.

Move the mouse to the Excel icon and
double-click.

The double-click will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu, or press :1€0, the command key
equivalent.
After a brief wait, Excel will be running, and you will
have a new spreadsheet, called Worksheet! , in the
window.

Move the mouse to the window's close
box.

Remember, the close box is the one found at the left of
the title bar.

Click the mouse button once.

Close the worksheet. You are going to open an existing
worksheet, and it will be less confusing to work with
only one document active.

:l€0

Execute the Open command. This command is found on
the File menu.
After a brie f pause, you will see the Open dialog box.

Click the mouse on the Drive button
shown in the dialog box if your disk is
not displayed in the dialog box.

The Drive button tells Excel to display the document and
folder names found on a second disk currently in your
computer. This may be a floppy disk, or a hard disk. If
you do not have a second disk in the computer, then the
Drive button will be dimmed, and you will not be able to
use it.
Continue clicking the Drive button until the name of the
d isk that contains your file appears in the dialog box.

Click on Model9.

You want to open the spreadsheet you named " Mode19 ."
By clicking the mouse pointer on the name in the dialog
box, you are selecting this document.
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Execute the Open command. After a brief pause while
the computer reads the spreadsheet, you will see the
Excel spreadsheet in the current window.

Click on the Open button .

You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the spreadsheet name, rather than
selecting it and then click on the Open button in the dialog box.
Be fore you continue, you are going to c reate some named ranges. These will be used in the
printing macro and the goto macros you a re going to c reate in this chapter.

WHAT

To Do

WHY

You ARE DOING IT

Pull down the Formula menu.

T his menu has the Define Name command located on it.

Drag the mouse down to select Define
Name.

This command lets you name areas of the spreadsheet.
Note that this command can be selected with the XL key.

Figure 12.1
The Define Name
command has been
selected.

Apply Nemes•••
Note ...
Goto...
886
Find...
88H
Replace...
Select Special ...
Show Rctlue Cell

Execute the Define Name command. You will see the
Define Name dialog box. The text in the Name box
should be selected , as it is in Figure 12.2.

Release the mouse button.

Figure 12.2
The Define Name dialog
box.

liD

Define Nome

ControLlable
Costs
lnRonge
Soles_Control
SolesJol

~

~
Nome:

UniiMMI
Refers to:

lo

I · SRSI

I

,

c(

Cancel

)

(

Delete

)

OK

I

HOME [TAB]

Type the word HOME into the Name box, then press the
TAB key. You are going to name cell AI "HOME".

= $A$1

If the "Refers to" box does not have this text in it, enter
this text.
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Figure 12.3
The current Define Name
dialog box.

ControLTeble
Costs
lnRenge
Seles_control
Seles_Uol

Click on the OK button.

Add the name HOME to the list of names.

XL

The Define Name command.

The_ Model

Enter " The_Model " into the Name box of the Define
Name dialog box.

[TAB]

Move the highlight to the Refers to box.

=$A$! :$P$11

You want this name to refer to the range A I :P 11 .
Remember that the dollar signs make this a fixed
reference.

Click on the OK button.

Add the name " The_Model" to the list of names.

XL

The Define Name command. You are going to define
another name.

ModeLControl

Enter "ModeLControl" into the Name box of the Define
Name dialog box.

[TAB]

Move the highlight to the Refers to box.

= $A$15: $H$17

You want this range to refer to the control table and to
include the row labels found in column A.

Click on the OK button.

Add the name " ModeLControl" to the list of names.

Pull down the File menu, select Save As
and release the mouse button.

You want to save the changes to the model before you
continue.

ModellO

Name the model ModellO.

Click on the Save button.

Execute the Save command.

These defined ranges will be used by the macros you are going to create. It is important to
note that you do not have to define names in this fashion. You may use the cell addresses if you
want. However, if for some reason the range definitions change, you would then have to modify
the macro. By using range names in this fashion, the macro will not have to be changed if the
ranges change. For example, consider what might happen if three more growth patterns and two
more cost percent patterns are added to the range ModeLControl. By using named ranges, all
you need to do is make sure that the range reference is correct. No changes need to be made in
any macro that uses this range.
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1 2.5 CREATE THE MACRO SHEET
You are now ready to create the mac ro sheet. Remember, Excel puts macros on a separate
document so that you may use your macros for multiple spreadsheets. In this section you are
creating the special macro sheet.

WHAT

TO Do

WHY

You ARE DoiNG IT

Pull down the File menu.

The File menu contains the New command.

Drag the mouse down to select the New
command.

You are going to create a new document. There is no separate New command fo r macro sheets. All new documents (Spreadsheets, Macro sheets and, as you will see
later in the text, Charts) are created with the New command. Note that you may use the XN key to execute the
New command, rather than using the pull down menu if
you so desire.

Figure 12.4
The New command has
been selected on the File
menu.

Release the mouse button.

Execute the New command. After a brief pause, the New
dialog box will appear.

Move the mouse to Macro Sheet and
click the mouse button.

You want to create a Macro sheet. If you fail to do this,
Excel will create a new spreadsheet, rather than a new
Macro Sheet.

Figure 12.5
The New dialog box. The
Macro Sheet button has
been selected.

Click the mouse on the OK button.

~·ii,

QWorksheet
0 Chart
Macro Sheet

I(

OK
cancel

,
I

Create the new Macro sheet. A new window, titled
Macro l , will appear.
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r

a

File

Edit

Formule

Formet

D11t11

0 tlons

Metro

Window

.,

Figure 12. 6
The Macro Sheet has been
created. You can see part
of the Mode/10 window
behind the Macro 1
window.

-

1 2.6 YOUR FIRST COMMAND MACROS

When you create a Macro, the commands are placed in a column of the Macro sheet. No e mpty
cells are placed between commands, si nce that wi ll stop the macro's execution. It is also a good
habit to place the macro's name into the first cell of the macro.
In this text we are going to place a ll the macros in the A column of the Macro sheet. This is
not, however, a requirement. You may place your macros in any column of the Macro sheet that
you want.
In summary, a macro occupies multiple cells in a column of the macro sheet. The first cell
should be the name you want to assign the macro. Below this cell are the cells of the macro. All
the macro cells begin with an equa ls sign, indicating that it is a function or computation , and not
simply text to be displayed. Each macro command is then a one-word action followed by information e nclosed in parentheses . Some of the macro commands are made more readable by
separating words with periods. Thus, rather than the command SETPRINTAREA, you will see
the command SET.PRINT.AREA.
The first macro that you create will make use of the Goto command fou nd on the Formula
menu. Recall that this command, which can be executed with the 3€G key, lets you jump the
cursor to any location or named reference on the spreadsheet. The cursor should be in cell A I of
the Macro 1 sheet.

WHAT

To Do

Control [crJ

WHY

You ARE DOING IT

This is the name by which this macro will eventually be
known. You should get into the habit of assigning a name
to all your macros, since it will make remembering them
easier.
By pressing the return key after entering this text , you
will move the cursor to cell A2.
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= FORMULA.G01D
("ModeLControl")

Enter this macro command into cell A2. In Figure 12.7
you can see that the [cr] has not yet been pressed. You
want the macro to execute the Goto command, found on
the Formula menu. When it executes, you want the Goto
command to select the area of the spreadsheet called
ModeLControl. Remember that you earlier defined several range names. This is the first of these that are now
going to be used by your macros.
It is important to note that the range name in the
FORMULA.G01D command , ModeLControl here,
must be enclosed in quote marks, because it is a range
name, and not a direct cell reference. You may replace
range names with direct cell references, which consist of
the spreadsheet name and cell address separated by an
exclamation point. For example, the ModeLControl
range may be entered as Model!O!$A$1S:$H$17. If you
do this you run the risk of needing to make major
changes on a macro sheet if range definitions change, or
if you change the name of the spreadsheet. Use range
names whenever possible.

Figure 12.7

Cell Al on the Macro 1
macro sheet will contain
this command. The return
key has not yet been
pressed.

r

:

File
A2

.

·: ~

[cr]

•

~
3

.

Edit

-

=RETURN() [cr]

Formula Format Date Options Macro
~ :FORMULA.GOTO("ModeLControq
Mecrol
B

A

,

Window

c

lror

-

,_

Enter the command into cell A2 and move the cursor
down to cell A3.
Enter the Return macro command into cell A4. All
macros must end with e ither the RETURN or HALT
command to return control of the spreadsheet to the user.
If you forget this command you will receive an error
message from Excel when the macro is executed.
Don' t forget to include the parentheses after the
RETURN command. Even though there is no information enclosed within them, they must be included. They
are part of the command.

[cr]

Move the cursor down to cell AS.
You are going to write a second macro, starting in cell
AS. You should always separate macros by at least one
blank cell . Doing so makes the macro sheet a little bit
easier to read. More important, the blank cell halts
macro execution. The Cell A4 serves this purpose for us
here.

Model [cr]

Name this macro Model. The cursor will move down to
cell A6.

= FORMULA.G01D("The_Model")
[cr]

You are placing another Goto macro on the Macro 1
sheet. The command is placed into cell A6.
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=RETURN() [cr]

Complete this macro. You now have two macros on the
Macro! macro sheet.

[cr]

Move the cursor down to cell A9. Again, you are leaving
a blank cell between two macros.

Home [cr]

This macro will be named Home. The cursor is moved to
cell AIO.

= FORMULA.GOTO(" HOME") [cr]

The action of this macro starts in cell A 10. The cursor
will be moved to cell A 11 .

=RETURN() [cr]

Complete this macro. You now have three macros on the
Macro 1 macro sheet.

,. It File Edit Formula Format Data 01
A12

J

I

Figure 12.8
The current Macro1 macro
sheet has three macros.

Macro! I
A

8

1 Control

Z

3

\1

; fORMULA.GOTO( .. Mode1-C2,!!; --- -H------•RETURN()

5

Model

6

•fORMULA.GOTO( lheJ1odel

t ·::~JL
I 0 •fORMULA
:-:-::
.GO
::T':O
::-r.
( .'""
tll
:::-:M
'""E
'"=
· .) .-+ - -- 11 •RE' RN
12

-M- -------·---------n ::

=--===-=

16

Pull down the Window menu, select
Modei!O at the bottom of the menu, and
release the mouse.

Activate the window called ModeiiO. When you release
the mouse, the spreadsheet window containing your
model wi ll move to the fro nt , on top of the Macro! window. Remember that you may also click the mouse on
any visible portion of an inactive window to activate it.
Figure 12 .9
Mode/10 has been selected
on the Window menu.

Pull down the Macro menu.

This menu contains the command you need to execute a
macro.
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Select the Run command.

This is the command needed to execute a macro. Note
that it does not have a command key (X) equivalent.

Figure 12.10
The Run command found
on the Macro menu has
been selected.
St~ t llt~eo nl<!r

fl e l<tl it•<! II<H ortl
RF. 7F.

Macro i!AI

Figure 12.11
The Run dialog box. The
macro to be executed has
been entered in the
Reference box at the
bottom of the dialog.

Ql

tn

Enter the location of the macro that you want executed.
This location consists of two parts, separated by an excla
mation point. The first part of the location, Macro I, tells
Excel the name of the Macro sheet that is holding the
macro you want executed. The second part of the location, A I , tells Excel in which cell of the macro sheet the
macro begins.

Run

10
Run

-

,

----

~·

(

OK
C11ncel

)

Reference: M_a_c_r_o_l_lR_l.:..l- -- -- - - - - - '
L
l
.

C lick the mouse on OK.

Execute the macro. The range ModeLControl will be
selected.

Figure 12.12
After the macro executes,
the named range in the
Goto command is selected.

s M11cro Window

67.0'JI&

9.0'JI&
67.0'JI&

109.27

116.31

126.47

133.59

9.0'JI&
66.0'JI&

7.0'JI&
65.0\l

5.0'JI&
65.0'JI&

5.0\l
65.0\l

.,
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Pull down the Macro menu , select Run
and release the mouse.

You are going to execute another macro.

Macrol!AS

You want to execute the second macro you entered, which
starts in cell AS.

Click on the OK button.

Execute the macro. The spreadsheet from cell A I
through cell PII is selected.

Pull down the Macro menu, select Run
and release the mouse.

You are going to execute your last macro.

Macrol!A9

The macro that starts at cell A9 of the macro sheet will
return the cursor to cell AI .

Click on the OK button.

Execute the macro. The cursor will return to cell A I,
which was named HOME.

Pull down the Window menu , select
Macro! and release the mouse.

You want to activate the Macro! window.

Pull down the File menu , select Save As
and release the mouse button.
Macsl

You want to save this macro sheet.

Click on the Save button .

Save the macro sheet you have created.

Name this macro sheet Macsl.

-

1 2.7 NAME THE MACROS

Just as you may name cells and ranges of your spreadsheet models, you may name the macros
that you create. This will make it easier to run your macros, si nce you will not have to remember
where you have placed them on the macro sheet.

WHAT

TO Do

WHY

Use the mouse to select ce ll A I of the
Macs I macro sheet.

,.

•

File Edit

AI

Formula Format

You are going to assign a name to the macro that starts in
cell Al. This macro will be called Control, since that
name already appears in the cell.

Dl

I Control

I

M1
A

1
2

~
4
5
6

r-J8
9

rto

contra!
•FORMULA.WIU\ r!C!!JOI. on
•RETURN(

Model
•fORMULA.GOTIKll\!J1ode1
':'_RETURN(
Home
;FORMULA.GOTO "I«<ME"

You ARE D OING IT

----

Figure 12.13
The first cell of the macro
that you are going to
name has been selected.
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XL

Use the Define Name command. This command is found
on the Formula menu. Notice the Define Name dialog
box that appears has info rmation that you did not see
when you were using this command with a spreadsheet.
The name "Control" appears in the Name area of the
dialog box. Since you have selected cell A I, the refers to
portion of the dialog does not need to be changed.

Click the mouse on the Command
button.

This button is located in the lower portion of the dialog
box in the area labelled Macro. You are doing this to tell
Excel that you are defining a Command macro. A function macro can also perform some tasks, but when it is
done it tells the spreadsheet some information, usually
the results of computations.
When you clicked on the Command button, the
Option+ X Key box of the dialog box became active. You
may assign your own choice of command key equivalent
for your macros. To distinguish your command keys from
the ones normally used by Excel, you must use the
Option key with the X.

Move the mouse to the Option + X Key
box and click the mouse button once.

You are going to enter a letter into this box.

c

Enter a lowercase "c" into the box.

Figure 12.14
The Define Name dialog
box used with the Macro
sheet asks for additional
information. This figure
shows the name you have
assigned this macro, and
that the Command button
has been selected.

·-

-

Define Name

I

Name:

IControl

Delete

I

I·SRSI
Optlon+X Key:

I
I

Canc:el

Refers to:

® Command

I

OK

EJ 0

None

Click on the OK button.

Complete the dialog box.

Use the mouse to select cell A5 of the
Macs I macro sheet.

You are going to assign a name to this macro.

XL

The Define Names command. The name Model wi ll
appear in the Name box on the Define Name dialog.

Click the mouse on the Command
button.

Tell Excel that the named cell is the start of a command
macro.

Click the mouse in the Option + :M: Key
box.

You are going to assign a key equivalent for this macro.

m

Enter a lowercase "m" to be the Option +X key
equivalent.
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Click on the OK button.

Complete the dialog box.

Use the mouse to select cell A9 of the
Macs I macro sheet.

You are going to assign a name to this macro.

XL

The Define Names command. T he name Home appears
in the Name box.

Click the mouse on the Command
button.

Tell Excel that the named cell is the start of a command
macro.

Click the mouse in the Option +X Key
box.

You are going to assign a key equivalent for this macro.

h

Enter a lowercase " h" to be the Option + X key
equivalent.

Click on the OK button.

Complete the dialog box.

xs

Save the changes that you have made to the Macs 1 macro
sheet.

Pull down the Window menu , select
ModellO, then release the mouse
button.

The worksheet must be active so that you can try using
the names of the macros, rather than entering their cell
addresses.

Pull down the Macro menu , select the
Run command , then release the mouse
button .

You want to run one of the macros. The Run dialog box
now lists the macros you have named .

Run
Run
c MacsiJControl
h Macsi JHome
m MacsiiModel

Q

(

~
Reference:

I

OK
Cancel

,

Figure 12.15

The Run dialog box shows
the three macro names.

l

0

II

I
You can see the Option +X Key equivalent letters that
you have assigned the three macros in front of each
macro name.

Click the mouse on the third macro in
the list.

This is the Model macro.

Figure 12.16

The Model macro has been
selected.
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C lick on the OK button .
[OPTION] [SHIFT]

~C

Execute the macro. The model will be selected.
Hold down the option key, the shift key, and the command key, then press the letter " C ".
The computer will beep at you, and nothing will happen.
When you defined the equivalent key, you used a lowercase letter "c" . Holding down the sh ift key is telling
Excel to look for a macro with a capital " C " as the
equivalent.

[OPTION]

~c

Try executing the macro again. Hold down the Option
and Command keys, then press a lowercase "c".
The selected area of the spreadsheet should change to the
table at the bottom of the window.

[OPTION]

~h

Use the macro you have defined to return the cursor to
cell A I.

-

1 2.8 A MACRO TO PRINT
You are now ready to c reate a macro to print your spreadsheet. This macro will save the model
before it begins the print process so that if you have problems your work w ill not be lost, then it
sets the print area, and finally executes the print command.

WHAT

To Do

WHY

You ARE DoiNG

IT

Pull down the Window menu, select
Macs I then release the mouse.

Make the macro sheet active.

C lick the mouse in cell A 13.

This is where you will start the mac ro.

PrLModel [cr]

This will become the name for this macro. The [cr] will
move the cursor to cell A 14.

= SAVE() [cr]

This is the Save macro command, and should be entered
into cell Al4. It is the same as using the Save command
found on the File menu , or as using the ~S key. T he cursor will be moved to cell A 15.

= FORMULA.GOTO("The_Model ")
[cr]

You are going to set the print area to be just the model
showing the computations and the growth and cost rates.
The control table will not be printed. This command
should be ente red into cell A 15, and the cursor is moved
to cell A l6.

= SET.PRINT.AREA() [cr]

This is the macro command for the Set Print Area command found on the Options menu, and should be put into
cell A l6. The cursor will be moved to cell A I? when you
press the [cr] .

= PRINT(I , I , I , I , FALSE,,) [cr]

This is the Print command, and should be in cell A 17.
As you can see, there are several items of info rmation
you must supply this command.

Macintosh Productivity Tools

The first of the four I 's controls whether you want to
print all the pages, or a range of the pages. By entering a
I as the first item here you are selecting the print all
pages choice. Because of this, the next two I 's are
ignored. If you had entered a 2 at this point, you would
be telling Excel that you want to print a selected subset of
the pages. The next two 1 's then tell Excel at which page
to start printing and at which page to stop.
The fourth one is the number of copies you want printed.
In this case, just one!
There is no fifth value. It is reserved for the IBM-PC
version of Excel. Thus the two commas with nothing
between them.
The sixth position, in this case the word FALSE, controls
whether you want to see the print preview. False means
you do not, whereas entering TRUE means you want to
see the print preview.
We want Excel to ignore the remaining arguments to this
command. Their spaces must be reserved , however, and
thus the three commas after the word False. The arguments correspond to the Parts option, the Print Using
Color option, and the Sheet Feed option.
= FORMULA.GOTO("HOME") [cr]

After printing, you want the cursor to return to cell Al.
This command should be entered into cell Al8, then the
cursor moved to cell Al9.

"'DELETE.NAME("PrinLArea") [c r]

You should recall that, when you set the print area, a
name called "PrinLArea" is added to the defined names
list. This macro command will remove this name from
the names list. It is similar to using the Define Name
command, selecting the name and then clicking on the
De lete button. This command should be placed into cell
Al9.

=RETURN() [cr]

Remember, you must always end a macro with a
RETURN command. This command should be in cell
A20.
Figure 12 .17
The A column of your
macro sheet, called Macs1,
should now look like this.
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Select cell A 13.

You are going to assign this macro the name PrLModel,
which is fou nd in th is cell.
The Defi ne Name command. The name PrLModel, short
for Print the Model, should appear in the Name box of
the Define Name dialog box.

Click on the Command button.

Remember that you must tell Excel that you have created
a command.

Move the mouse to the Option+ :M: Key
box and click the button.
M

You want to assign an equivalent key.

Figure 12.18
The completed Define
Name dialog box.

iD

Use a capital letter "M", rather than a lowercase letter.

,

Define Name

Control
Home
Model

N11me:
IPrLModel
Refers to:

I

OK

(

Cllntel

)

(

Delete

)

I

I =SR$13

Mlltro-------------------------------------,

0

Function

® Comm11nd Option+X Key:~ 0 None

C lick on the OK button.

Complete the dialog box.

:M:S

Save the changes you have made to the Macs I macro
sheet.

Pull down the Window me nu , select
Model 10 and release the mouse.

You want to try this new macro. The Spreadsheet window
must be active.

Pull down the Macro menu, select the
Run command and release the mouse .

Begin execution of a macro . You can see that the macro
you have added is now in the list of macros in the Run
dialog box.

Figure 12.19
The Run dialog box shows
the new macro.

I

.

-

Run
c MIICSIIControl
h MlltSI!Home
m MIICS11Model
M MIICS11PrLModel
Reference:

Run

~

I

~--------------------~

Click on the Cancel button.

Cancel the Run command. You are going to try using the
key equivalent.

[OPTION] [SHIFT] :M:M

Hold down the Option, Shift and Command keys, then
press the "M". Excel will print the spreadsheet. If you
forget to hold down the Shift key, you will be executing
the macro to select the model. If this happens, you will
not see the pri nter dialog appear.
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If you do not have a printer attached to your computer, or
you have chosen the LaserWriter and you have only an
ImageWriter, you will receive an error message from the
Macintosh. To continue, click on the OK button. Excel
will then give you a Macro error message. Click on the
Continue button.

-

12.9 CREATING A FUNCTION MACRO

A function macro is used to simplify your model building. You may use a function macro to
summarize an arithmetic formula on the spreadsheet and make it easier to use. When you do
this, the function name appears in a cell of the spreadsheet. When the function is executed ,
information is sent to the macro sheet holding the function. The formula is computed by the
macro sheet, and the answer is passed back to the cell in the spreadsheet that used the formula.
For example, you may want to make a function called Profit that performs a subtraction equivalent to the computation found in cell B6 of the current spreadsheet. That is, the Profit function
will take two values, called arguments, and subtract one from the other. The result of the
subtraction is sent back to the spreadsheet by the RETURN command. The arguments are placed
between the parentheses when you enter the function. For example, the IF function that you used
in an earlier chapter has three arguments: the comparison, the computation if the comparison is
true , and the computation if the comparison is false. The Profit function you will create will have
only two arguments: sales and costs.
The advantage of using a function is that it can the n be used in othe r spreadsheets. You do
not have to recreate the formula. This can be a time saver when you build complex spreadsheets
that use the same computations over and over.
You should note that while the function you are about to create will work, it is be ing created
here to be an example of functions, and not of good style for creating spreadsheets. You will
probably agree that the formula that is presently in cell B6 is easy to read , and not particularly
difficult to enter. Keep this in mind as you work this section of the text.

WHAT

TO Do

WHY

You ARE DOING IT

Pull down the Windows menu, select
Macs I and release the mouse button.

Make the macro sheet, Macs l , the active window.

Scroll the window so that you can see
empty cells below the PrLModel
macro.

You are going to put this function into cells below the
PrLModel macro.

Move the mouse pointer to cell A22 and
click the mouse.

You are going to start the function in cell A22.

Profit [cr]

Enter the word Profit into cell A22 and move the cursor
to cell A23. Profit will be the name of the function.

=ARGUMENT(" sales") [cr]

The first step to building a fu nction macro is to define the
arguments, or information, that it will· need. Here, the
first number accepted by the Profit function will be the
sales value. When the function macro is executed , whichever value appears first in the list of arguments will represent "sales" to the funct ion. The cursor should end in
cell A24.
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=ARGUMENT("costs") [cr]

T he second number that appears in the argument list will
be used by the Profit functio n to fill in the "costs" value.
The cursor should end up in cell A25.

= (sales-costs) [cr]

Enter the computation that the function is to carry out
into cell A25 , and move the cursor to cell A26.

= RETURN(A25) [cr]

The RETURN command ends the macro. In this case,
you want the fu nction macro to report back the results of
the computation that is carried out in cell A25 .

Figure 12.20
The Profit function macro
is in cells A22:A26.

,. •

File Edit Formula Forn
A27

l

l

JRN(

~.. ·

': . . !

.• Reedy

Click the mouse on cell A22 .

Select cell A22 before you name the macro.

a€L

The Define Name command . Profit should appear in the
name area of this dialog box.

Click on the Function button.

Remember that this is a fun ction, not a command. The
Option+ a€ Key box wi ll remain dimmed , since command keys are not appropriate for functions.

Click on the OK button.

You are done naming this fu nction.

a€S

Save the modified Macs l macro sheet.

Pull down the Window menu , select
ModellO and re lease the mouse button .

Reactivate the spreadsheet window.

Click the mouse pointer on cell B6 .

This cell is where you wi ll test the funct ion you have just
created.

= Macsl !Profit(B4,B5) [ENTER]

You must tell Excel where to find the function, Profit. It
can be found on the Macs I macro sheet. Remember to
separate the location of the function from the function
itself by the exclamation point. Use the enter key to keep
the cursor on cell B6.
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Figure 12.21
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197

100.00
67.00

109.00
73.03
35.97

118.8
78.4
40.4

3~

col

The Profit function has
been entered. There is no
change in the result, since
the Profit function
performs the same task as
the original formula did.

-

1 2.10 ADDING AN ITEM TO THE MENU BAR

It would be nice to be able to access the macros that have been created through a menu. This is
especially true if you create a large number of macros. While the Option+ X key equivalent is
handy, you may not always remember what to use for which macro. Thus, a menu would be
valuable.
You may add an item to the menu bar by using a macro. To do this, you must first create the
menu information in cells of the macro sheet , then create the macro to add the menu to the menu
bar. The menu information uses two columns of the macro sheet. The first e ntry of the left
column holds the name of the menu. Below the name a re the cells holding the text which is to
appear when the menu is pulled down , that is, the commands. To the right of each command
description is the name of the command macro to be executed when the item is selected.

WHAT

To Do

WHY

You ARE DoiNG IT

Pull down the Window menu, select
Macs l and re lease the mouse button.

Activate the macro sheet window.

Move the mouse to cell A30 and click
the mouse button.

Select cell A30. This is where you will begin the menu.

MyMenu [cr]

Enter MyMenu into cell A30 and press [cr] to move the
cursor to cell A3l. This is going to be the name of the
menu when it is added to the menu bar.

Select cells A31 :B34.

This is where you will enter the rest of the menu
information.

Home the Cursor [ENTER]

The first command on the menu will return the cursor to
cell A I. Place this text into cell A3 I , then press the
[ENTER] key to move the cursor ri~ht to cell B31.

Home [ENTER]

This is the name of the macro you wrote to move the cursor to cell A l. It will be executed when you select the
" Home the Cursor" command on the menu MyMenu.
Press [ENTER] to move the cursor to cell A32.

Select the Model tENTER)

The next command on the menu will select the Model.
After you press [ENTER], the cursor should be in cell
B32.
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Model [ENTER]

This is the macro you wrote to select the model. Put its
name in cell 832, and move the cursor to cell A33.

Select the Control Table [ENTER]

The th ird command on the new menu will select the Control Table.

Control [ENTER]

Place the name of the macro into cell 833, then move the
cursor to cell A34.

Print the Model [ENTER]

T his is the last ite m you will place on your menu.

PrLModel [ENTER]

The name of the macro to be executed is placed into cell
834.
You have now laid out the information for the menu. The
left column of in fo rmation are the commands as they will
appear when the menu MyMenu is pulled down. The
right column are the names of the command macros to
be executed by each respective command on the new
menu.

Figure 12.22

The menu information has
been entered into the
macro sheet.

You must now create the macro that identifies the menu
to Excel, and makes the menu appear on the menu bar at
the top of the Macintosh display.
Click the mouse on cell A36.

This is where you will put the macro to add the menu.

AddMyMenu [cr]

This will be the name of the macro. The cursor wi ll
move to cell A37.

= ADD.MENU(l ,A30:834) [cr]

The ADD. MENU command will add a menu item to the
specified menu bar. The arguments of the command are,
first , the number of the menu bar where the menu is to
appear. The value I, which you entered here, selects the
menu you see when working with Worksheets and Macro
sheets, and Full menus have been selected. If you want to
add a menu to the Chart menu, you would use a 2 instead
of a I.
The second item, A30:834, tells Excel where on the
macro sheet to find the information that describes the
menu. This range includes the cell that h'olds the name of
the menu, cell A30.

=RETURN() [cr]

Don't forget the return CO!llmand in cell A38 to indicate
the end of the macro.
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[cr]

Place the cursor into cell A40 on the macro sheet . You
are going to create one more macro.

ZapMyMenu [cr]

This will be a macro to remove the menu from the menu
bar.

= DELETE.MENU( l , " MyMenu") [cr]

Enter this command into cell A4 1. As you can see, there
are once again two arguments for this command. The
first tells Excel which menu bar has the menu you want
to remove , and the second argument gives the name of
the menu to be removed.

=RETURN() [cr]

End the macro in ce ll A42.

Figure 12.23

The macros to add and
remove the menu item
have been entered.

C lick on cell A36.

Select cell A36. You are going to define the macro names
for Excel.

XL

The Define Name command. AddMyMenu should
appear in the Name box.

C lick on the Command button.

This is a command macro , not a function macro.

C lick on the OK button.

You do not want to assign an Option + ~ Key for this
macro. It will not be used that often, so you are going to
save your letters.

Click on cell A40.

Select cell A40. You are going to define this macro 's
name for Excel.

XL

The Define Name command. ZapMyMenu should appear
in the name box .

Click on the Command button.

This is a command macro , not a function macro.

Click on the OK button.

You do not want to assign an Option+~ Key for this
macro. It wi ll not be used that often, so, once again, you
are going to save your letters.
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XS

Save the changes you have made to the Macs I macro
sheet.
You are now ready to add the menu to the menu bar.

Pull down the Window menu , select
ModeiiO then release the mouse.

Make the spreadsheet the active window.

Pull down the Macro menu , select Run
and release the mouse.

You are going to execute the AddMyMenu macro. Since
you did not assign this macro an Option+ X Key, you
must use the Run command to execute it.

Clic k on the Add MyMenu macro name.

This is the macro that you want to run.

Figure 12.24
The Run dialog box. Note
that the AddMyMenu
macro does not have a
letter in front of it since
you did not assign an
Option + :K Key to the
macro.

Run

·R·u~nii:Qri!ll.ll;llllllll••l§J l

OK
( Cancel

c MacsiiControl
h MacstiHome

J

Reference:

Click on the OK button.

Figure 12.25
MyMenu appears on the
menu bar.

'*

Execute the macro. MyMenu will appear at the right end
of the menu bar.

File
66

Edit

I

Formula

Format

Data

I :Mecs 11Proflt(B4,B5)
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Macro

Window

MyMen
II
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This menu works just like the standard Macintosh menus. Use the mouse to pull down the
me nu a nd select the item you want. Execute the item by releasing the mouse butto n. Let 's try
executing some of the comma nds on the menu to make sure that you have properly created the
me nu.

WHAT

To Do

WHY

You ARE DOING IT

Pull down MyMenu .

You are going to try the commands on the menu you have
just c reated .

Drag the mouse down to the third
option, Select the Control Table.

You are going to select the control table at the bottom of
the spreadsheet.

Figure 12.26
The Command "Select the
Control Table " has been
selected.

Release the mouse button.

Execute the command . The control table at the bottom of
the display should become selected.
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[OPTION] :M:h

This is the keyboard equivalent for the Home macro. The
cursor will return to cell A l.
Just because you have placed an item on an active menu
does not disable the Option+ :M: Key to activate that
command.

Pull down the Macro menu, select Run
and release the mouse.

Select ZapMyMenu in the macro list.

You want to run a macro.
Scroll the macro list window to make the ZapMyMenu
macro name appear.
You want to remove the menu .
Figure 12.27

Run

rR~u:-:n:-:-:--:-:-:-----:-~-----..,..
c MIICSIIControl
h Mecsi!Home
m MIICSIIModel
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~

OK

The ZapMyMenu macro
has been selected.

J
~

( Cancel
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Click on the OK button.

Execute this macro. The MyMenu menu will be removed
from the menu bar.

-

12.11 MAKING A MACRO EXECUTE WHEN THE
SPREADSHEET LOADS

Having a macro execute when the spreadsheet loads, called an autoexec macro, can be very
helpful. For example, you may always want the menu MyMe nu added to the menu bar. This can
be done by making the macro AddMyMenu execute whenever the spreadsheet model is loaded
into Excel.
Additionally, since you have changed the formula in cell B6 to use a macro function (you
remembe r the Profit function) , it is desirable to have the macro sheet loaded so that the function
can be used by the spreadsheet. Always keep this latter fact in mind when creating functions.
That is, the macro sheet must be loaded with the spreadsheet for the functions defined o n it to be
available. If you load just the spreadsheet, and not the mac ro sheet, Excel will not know how to
evaluate the function.
Making a macro into an autoexec macro simply requires that a special name be defi ned in
the spreadsheet that is to load the macro. At present, you should have the spreadsheet ModellO
displayed as the active window. If not, use the window menu to make ModellO the active
window.

WHAT

TO Do

WHY

You ARE DotNG

IT

:M:L

The Define Name command.

auto_open

This is the special range name that tells Excel to automatically load a macro sheet and execute a macro. Enter it
into the Name box on the Define Name dialog. Make
sure that you enter this name using lowercase letters and
a single underscore to connect the two words. If you do
not do this, the autoexec macro will not work.
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[TAB]

Move the selection to the " Refers to" box.

= Macsl !AddMyMenu

This is the name of the macro sheet, and the name of the
macro to be executed.

Figure 12.28
The Define Name dialog
box that you are creating.
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Cancel
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Click on the OK button.

Save this name .

:M:S

Save the spreadsheet changes.

Click on the spreadsheet close box.

Pur away this spreadsheet. You are going to try opening it
to see if the menu gets loaded automatically. The Macs I
macro sheet should still be open.

:M:S

Make sure that the macro sheet has been saved.

Click on the macro sheet close box.

Put away the macro sheet. When the Model!O spreadsheet is opened the macro sheet also should get loaded by
the autoexec macro feature.

3€0

The Open command.
Locate the spreadsheet called Model!O in the d ialog box
and select it.

Figure 12.29
Mode/10 has been selected
in the dialog box.
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Open the Modei!O spreadsheet.

Click on the Open button.

After a brief pause you will see a dialog box that asks
"Update references to unopened document?" This message is a result of using the Profit macro function . The
macro sheet has not yet been opened, so that the Profit
function is not available to the spreadsheet.

Update references to
unopened documents?

~

Click on the Yes button.

I

Yes

I

No

Figure 12.30
You will see this alert
message because the Profit
function macro has not yet
been loaded.

Let Excel update the references. If you quickly look at
cell 86 while the loading process continues, you will see
the REF# error message appear. Don' t worry.
Once the spreadsheet has been updated, it will load the
Macs I macro sheet. You will see it become the active
window.
After another pause you will see MyMe nu added to the
menu bar, and the spreadsheet will return to being the
acti ve window. Finally, since the Profit function is now
available in the computer's memory, the fu nction is prope rly evaluated in cell 8 6.

XS

Save the model one more time.

XQ

Quit Excel and return to the Macintosh Finder.

EXERCISES
l.
2.
3.
4.
5.
6.
7.
8.
9.
10.
II.
12.
13.
14.
15 .

Where should you put the name of a macro?
Explain the differe nce between a Command macro and a Function macro.
Are macros placed on a spreadsheet document or a macro sheet docume nt?
What is the advantage to placing mac ros on a macro sheet rather than on a spreadsheet?
Which menu command is used to create a macro sheet?
What is the macro statement used to execute the Goto command?
If you have defined a range called " RighLSide" , write the macro that will select this range. Name the macro GoRight.
What command must end every macro?
What is the command used to name a mac ro?
If you have not assigned a name to a mac ro using the Define Name command, how can you get Excel to execute the
macro?
When you enter the location of a macro that you want executed by Excel , what character separates the name of the macro
sheet from the cell address that starts the macro?
What is a n advantage to nam ing a macro?
Can you assign a Command Key (X) equivale nt to your macros?
Can you assign a n Option+ Command Key (X) equivalent to your macros?
When you use a keyboard equivalent to execute your macro , does it matter if you press a capital letter when the name was
assigned using a lowercase lette r?
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16. Using the spreadsheet you were working with in this chapter, create a macro to print only the first three years of the sales
projection, rather than the complete sales projection.
17. Using the spreadsheet you were working with in this chapter, create a macro to print the range ModeLControl.
18. Add the two macros you created in Problems 16 and 17 to the menu you created in this chapter.
19. Create a new menu for the spreadsheet you used in this chapter. The menu should be called Printlt. On the menu should
be the following commands:
Print the Complete Spreadsheet
Print the Sales Projection only
Print the Sales Projection with costs/growth %
Print the current Control Table
20.
21.
22.
23.

Create a macro that will add the print menu you created in Problem 19 to the menu bar for the spreadsheet.
Create a macro that will remove the print menu you created in Problem 19 from the menu bar for the spreadsheet.
What is the name you must assign a macro to have it loaded automatically when the spreadsheet is loaded?
Create a function macro, to be called BrkEven, for the break-even formula:
Break-even Point = Fixed Costs I (Selling Price- Variable Costs per unit)

24. Use the BrkEven function you have created to compute the break-even when Fixed Costs are $2295.00, Selling Price is
$14.95, and the Variable Cost per unit is $100.00.
25. When you define a menu, must the menu options be in adjacent columns or in consecutive rows of the macro sheet?
26. When you define a menu, where is the name of the macro to be executed by an option placed?
27. Must a named range be a unique range, or can it overlap with another named range?

CHAPTER

DATABASE MANAGEMENT
SYSTEMS CONCEPTS

13

-

CHAPTER OBJECTIVES:

Upon completion of this chapter, the student will :

• Define database.
• Define database management system (DBMS).
• Give at least three reasons why a database
management system should be used.
• Differentiate among menu-driven DBMS,
command language driven DBMS, and
programming languages.

• Describe the difference between hierarchical/
network type DBMS and relational type
DBMS.
• Define files, records and fields.
• Define key fields.
• Describe the different data types.

-

13.1 WHAT IS A DATABASE?

A database is a collection of related information.
You have probably been exposed to a database of
one kind or another at some time, perhaps one like
the simple database pictured in Figure 13.1 , a mailing list that is stored on index cards, or one more
complex such as as the database in Figure 13.2 on
the next page, a filing cabinet containing personnel
information. In either case, the purpose of the database is the same: to keep track of interrelated information in an organized fashion. Databases are
generally organized so that it is simple to find the
information you need within the database quickly.

Figure 13.1

A mailing list database
stored on index cards.
James Frank 11 n
'f043 State St.
Los Angeles, CA
00000

I
Joseph John
2432 Palm Dr .
Los Angeles, CA
00000

I
Joan Herschel
14 Date St .
Los Angeles, CA
00000
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Figure 13.2

A common and extensive
database.

In addition to keeping track of related information , you will frequently want to do things to
or with the information maintained in the database. If, for example, the database consists of
personnel information, you may want the computer to combine th is information with a database
that keeps track of hours worked to produce pay checks and tax information.
As the amount of information in your database grows, both in pieces of information being
retained pertaining to a single item and to a number of related items, the difficulty involved in
performing the needed operations on the data increases, as well as the time needed to perform
the operations. For example, if the information in Figure 13.3 is used to create W -2 forms at the
end of the year, the Internal Revenue Serv ice will want to receive the data in taxpayer ID order,
while the Postal Service will want the envelopes to be mailed to the employees in Zip Code
order. While sorting the information found in Figure 13.3 into these categories is a small task, it
becomes a huge, time-consuming chore for a large corporation. Enter the database management
system!
TIME CARD
EMPLOYEE
I . D.

WEEK

. -ooo1. -

WI THHOLDING

317

0002

317

000 3

AMOUHT

PERSOHHEL fiLE

17
.__...:3.:...
~...-EMP

317

000~

1. 0 .: 0001~
919-79 oooo
HAME :
JOHES, HAMILTOH
ADDRESS :
10 PLE SAHT STREET
BACK BY, MA 01101

ss• ·

.,_,___,.,_
10 0001

nt

)t.UUJ'ACT\Jli iiC

co.

2Uo COIIClUS STUrt
IOSTO!f. ~ OUU

Figure 13.3

These are some items you
may find in a personnel
database. The arrows
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13.2 WHAT IS A DATABASE MANAGEMENT SYSTEM?
Rather than use index cards, today's database management systems utilize computers. All the
information to which you must have access is stored in one or more computer data files.
However, the key purpose of a database management system is not to store but to manage the
information, as suggested by the name of the system. The efficient management of the data
makes using a computerized database management system worthwhile.
The computerized database management system g ives you a simple way to:
I.
2.
3.
4.

Create data files.
Enter data into the files.
Remove data from the files.
Manipulate the data to obtain summaries, reports or other needed information in a timely
fash ion.
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1 3.3 WHY USE A DATABASE MANAGEMENT SYSTEM?

Of course, you can collect and summarize data without the computer. The computer-run database management system, however, is capable of producing information for you when you need
it. This is why a computer database management system can be valuable. It provides you with
the same basic features as a manual information system. However, it can extract the exact
information you need from the data much faster than it can be done by hand, and it can compile
or rearrange the data in a different order for you equally as fast. Frequently these other "views"
of your information will provide you with different insights into the meaning or relationships of
the information with which you are working.
In addition to ease of access to the information, a database management system can produce
other benefits. Because a good database management system is flexible, many different applications within an organization can be served by the same data file, thereby minimizing the duplication of stored data. This singular treatment will increase the accuracy of the information,
because it needs to be entered into the system only one time and corrected or updated in only one
place rather than in several files. The computer also imposes discipline that contributes to
accuracy. For example, the typical database management program will not allow letters of the
alphabet to be entered into portions of the database that are strictly numeric.
A good database management system can provide for data security, preventing sensitive
information from being accessed by unauthorized personnel, by requiring passwords and data
encryption schemes.
What many people like most about database management programs is the speed with which
these applications can be made operational. The database management program performs some
of the most difficult aspects of program writing-working with data files. This includes such
tasks as reordering the data when needed, removing unneeded information, and recovering
vacated disk space. Creating programs with a high level programming language such as
COBOL, BASIC or PASCAL can be time-consuming, whereas a one- or two-word command in
a database management system will accomplish the same thing.

-

1 3.4 TYPES OF DATABASE MANAGEMENT SYSTEMS

Several types of database management systems are available today:
I. Menu-driven systems.
2. Program-driven systems.
3. Command language driven systems.

-

1 3.5 MENU-DRIVEN SYSTEMS

Some database management systems are completely menu-driven. This means that you are
constantly presented with a list of choices-a menu. You make a selection based on the activity
you want to carry out at that time.
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Figure 13.4
A menu-driven database
management system.

• • • • • • • DATA BA SE MAHAGEMEHT I • •, • • •
APPLE COI'II'UTER I NC
CURRENT DATA BAS£ : BIRTHDAYS
CURRENTLY COHTA INS : 32 RECORDS
ROOM FOR 488 MORE RE CORDS
THE
1
2
3
4
S
6
7
8
9
10

PRIHTER I S OFF
SELECT DATA BASE
SEARCH AND/OR CHAHGE DATA
ENTER RECORDS
DELETE RECORDS
REPORT
SORT
TURN OH PRIHTER
TURH orr PR I HTER
Ll ST ALL RECORDS
QU I T

WHICH

Menu-driven systems a re gene rally very simple to use. However, if you a re limited to using
the program only as the menus dictate, the program may be limited in its capabilities. If you a re
concerned only with the filing of bits of information, such as mai ntaining a telephone directory,
this type of syste m is usually adequate.

-

1 3.6 DATABASE PROGRAMMING LANGUAGES

Some systems, in addition to the menus provided, also give you access to your database through
programming languages . These la nguages a re specific to the database management system . They
usually feature statements that provide you with easy access to, and manipulation of, the data
files. This is not usually true of a sta ndard programming language, in which you may have to
write a complex program to perform the task of a single statement in a database programming
language.
Figure 13.5
A portion of a dBASE Ill
PLUS program.

STORE •F. TO IS.JmDY
DO 1111 Ll ,HOT •If.JJ'ADY
STORE I I TO GUll
u SAY 'DtRII "X" to nn 1t011 OR •p• TO PROCEED > ' GET co_o11 PICT ',,
IF GO 011 : 'X'

ldl'

ifrlltALL

OOIF
IF GO 011: 'P'
STORE •T. TO IS.JIADY
DIDIF
DIDDO
flll CWR
f 11'31 SAY 'lilt'
sroit I TO IlliG COOIII
IF .JtOT.nLE('CIJIIMUBF'>
u2it14 SAY 'UIIABLI TO LOCATE THE IIORX FILE!!! PLEASE RE-LOAD n. •
sto ' ' TO GO 011
ldl,22 SAY 'Pms AKEY ro mulllt TO THE IIlii > ' CEt ~-011 Plct .,.
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The database programming languages provide the user and the program author with the
greatest flexibility possible for using and manipulating the data files. You can usually control
what is displayed on the computer's display, how and when the information is used and manipulated, and who can gain access to the info rmation. You can use this type of system to develop
complex accounting systems, inventory management systems and more.
While total program developme nt may take less time when you use a database management
system, writing programs in a database programming language may be just as difficult as writing
programs in a standard programming language. Many of the data file input, output, and manipulations are easier, but pla nning, documentation and development are still ma ndatory for writing
in database progra mming languages.

-

1 3.7 COMMAND LANGUAGES

There is a point between the solely me nu-driven system and the database programming
language-the database management system command language.
A command language allows you to have access to , and to manipulate, the data files without
the inte rvention of me nus. This provides the more sophisticated user with a greater degree of
control a nd more flexibility tha n the menu-driven systems. It does not, however, provide the total
freedom available when writing a program in the database programming la nguage.

-

1 3.8 FILE ORGANIZATION

The database manageme nt systems available today arrange their data files in one of two methods:
hierarchical/ network or relational.
The hierarchical/network systems form a strict relationship among the records making up a
si ngle file. This relationship is defined by a record pointer field. This system is fine if you have
fully planned all desired elements of the data for recalling individual records that make up the
database. For example , if a database consists of worker numbers , names, addresses and pay
rates, the worker number, name and pay rate may be information by which you want to recall the
data, while the address is not. However, if you require information (such as age in the example)
from a hierarchical/network system to which you have not provided an access link, the database
management system wi ll not find it. To find this information, the person using the database must
add new pointers to the file or restructure the existing pointe rs in the file so that the records can
be recalled by the desired piece of information.
HIERARCHICAL DATABASE
PLEASE LIST PARTS FOR VEHDOR CODE 93

VENDOR
CODE
A2
83
Cl

03

Figure 13.6
Hierarchical database
structure.
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Figure 13.7

Network database
structure.

HETWORK DATABASE
PLEASE LIST PARTS FOR VEHDOR CODE 83
XYZ MAHUFACTURIHG
IRVIHE PLAHT

XYZ MAHUFACTURIHG
IRVIHE PLAHT
PART• : BC011
DESCRIPTIOH: DIHGBAT
QTY: 32
XYZ MAHUFACTURIHG
IRVIHE PLAHT
PART• : CC001
DESCRIPTION : RIHGCAT
QTY : 1000
XYZ MAHUFACTURIHG
IRVIHE PLAHT
PART• : CCOOS
DESCRIPTIOH : ROHGDOG
QTY : 1000

In contrast to the hierarchical/network system , the relational database management systems
allow any relation you desire to exist among the several fields that constitute the database record.
It is a simple matter to find existing information in such files after the initial creation of the
database. Because of this, the relational database management system is simple to use. It is
becoming very popular in businesses today.
Figure 13.8

Relational database
structure.

PART •

AOOOI
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8CO I I
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DIOO I
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E3333

DESCRIPT I ON

WIDGET
FRAM I TE
DING8AT
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CODE

QTV
IN· STOCK

LAST QT V
ORDERED

PLEASE L IST PAR TS FOR VENDOR CODE 83

PART S REQUESTED BY VEHDOR CODE 9 3
PART •

DESCRIPTI ON

CCO OI

RI HGCAT
RO NGDOG

OT V

-8COI---DIHG8AT
------ ---I
32
ccoos

LAST
COST
22 . 9S
12 . 37
47 . 82
43 . 00
8S . OO
123 . 00
6S . 70
13S . 99

I0
1000
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13.9 FILES, RECORDS AND FIELDS

A database consists of data files of information. For example, a file may contain information
about the ite ms a company has in its inventory (Figure 13.9).
Figur e 13.9

PART •

DESCRIPT ION

An inventory file.
AOOOI
A0023
BCOII
CCOOI
CC005
DIDO I
D l 201
E3333

WIDGET
FRAM ITE
DIHGBAT
RIHGCAT
ROHGDOG
FIDGET
GIDGET
OOWSIT

1/EHDOR
CODE
A2
A2
83
83
83
Cl
Cl
03

QTV
IH·STOCIC
455
652
32
I0
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s
20
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LAST QTV
ORDERED
1000
1000
100
500
1000
1500
500
750

LAST
COST
22 . 95
12 . 37
47 . 82
4 3 . 00
85 . 00
123 . 0 0
65 . 70
135 . 99
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Files are built from records. A record contains all the information for a specific entry in the
database. To continue with the inventory database example, a single record of this file represents
the information for a single inventory item (Figure 13. 10) .
PART •

DESCR I PTI OH

1/EHDDR
CODE

OTY
I H-STOCK

LAST OTY
ORDERED

LAST
COST

----------------·
- -·- -------·-·-----------·
- --------·22-. 95·-·A0001
WIOOET
A2
1000

Figure 13 .10
An inventory record.

~55

A0023
BC011
CC00 1

ccoos

01001
D1201
E3333

tRAMITE
DIHGBAT
RIHGCAT
ROHGDOG
r IDGtT
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5
20
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500
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1500

1~3 . 00
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65 . 70
135 . 99

soo

12 . 37
n . 82
~3 . 00

8S . 00

Finally, records are built up from fields, the specific ite ms of information about the record.
T he fields of the inventory record include part number, cost, vendor code and quantity on hand
(Figure 13. 11).
PART•
AOOO 1
A0023
BC 01 1
CC001
CC005
D100 1
D1201
E3333

DESCRIPTIOH
WIDGET
FRAMITE
DIHGBAT
RIHGCAT
ROHGDOG

FIDGET
GIOOET
DDW5 1T

IIEHDOR
CODE
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A2
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QTY
I H- STOCK

LAST QTY
ORDERED

~ss
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1000
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1500
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5
20
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soo
750

LAST
COST

Figure 13 . 11
A field.

22 . 95
12 . 37
H . 82
~3 . 00

85 . 00
123 . 00
6S . 70
135 . 99
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1 3.10 KEY FIELDS

When working with data you are usually most concerned with the information in specific fields.
Some fields are more important than others; a nd most databases have a field or fields which
uniquely identify the record you are working with. These fields are key fields . A part number
field is usually a key field in an inventory database, and it is key for two reasons. First, to you it
is an important, or key, item of information. Second, and this is more important to the database
management system than it is to you, the part numbe r field provides a unique access point to
each specific record of the file much in the way a key opens a specific lock on a door.
The other fields of the record contain important information , but they do not provide a
unique access point to the data for the database management program. The description of a part
may be important to the customer, but it usually does not give easy or unique access to the data.
A hardware store stocks many different types of nails. The word " nail " would not be suitable
key field information .

-

1 3.11 DATA TYPES

Fields may be made up of one of several types of data. Every database manageme nt program has
some standard data types. These a re the numeric, text, and date data types. Additional data types
that you may frequently encounter include picture (or graphic), calculation, logical, memo (or
note) and summary.
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Nume ric fields will always contain data in the form of numbers and will never contain letters
of the alphabet. Another characte ristic of numeric fields is that they a re used in computations.
Figure 13.12
Some typical numeric
fields.

Figure 13.13
Some typical computations
for a rep ort.

QUAHTITY OH HAHD :
COST:
HUMBER OF PAGES :
HUMBER SOLD :

500
25 . 00
-4-48

50000

TYPICAL COMPUTATIOHS
VALUE Or IHVEHTORY • SOO. OOO.

(VALUE • IHVEHTORY • COST>

TOTAL SALES .

<SALES • HUMBER SOLO • COST •

I ,000.000

~RKUP>

Text fields, sometimes called characte r fields, conta in information comprised mainly of
letters of the alphabet. It is possible fo r a text field to contain numbers, but the numbers are not
usable in computations. This is because computers store numbers in nume ric fields diffe re ntly
from the way they store numbers in text fields. An example of a text field that is all numbers is a
telephone number because you do not perform arithmetic with the information in the field. That
is, if the phone number is 202-555-4567, you do not want the results of the computation ((202555)-4567) stored as the phone number.
Date fields contain dates. While the dates are displayed on the compute r's sc reen or printed
report in a fashion people expect, such as 06/30/50 or January 6, 1987, they are not stored in the
compute r in this fashion. The dates are converted into a number, usually a julian date, which
then allows date arithmetic. (Date arithmetic is especially important in accounting applications.)
Some database management systems have othe r special-purpose field types available. Some
may include the data types already mentioned: picture (or g raphic), calculation (or computed),
logical, memo (or note) a nd summary.
Memo o r note fields contain large amounts of text. The info rmat ion in these data fields is
printable, but frequently that is all that you may do with it. Thus, you may not search the large
text field for keywords or other information . Because of this they have limited value.
Logical fields contain one of two values, either T RUE or FALSE . Clearly, these fields
contain neither numbers nor characters, but a value, each of which represents a condition. Each
ite m is in either the TRUE state or the FALSE state.
A picture field , as its name suggests, holds a graphic. You may want to put photographs of
people into such a field if it is included in a personnel fi le.
Figure 13.14
Some typical character
fields.

Figure 13.15
Some typ ical logical fields.

TYP ICAL CHARACTER riELDS
HAME · - --------------------_
STREET
: ___________________
CITY : _____________________ _
STATE ·
ZIP CODE : _________ _
PART DESCRPTH . ____________ _

TYP ICAL LOGICAL FIELDS
(all are answered w1lh YES or HO)
MARR I ED :
EMPLOYED :
COLLEGE GRADUATE :
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The calculation, or computed field holds the result of performing arithmetic operations
between two or more existing fields of a record to create the contents of a third field in the
record . Consider, for example, a database that is used to keep track of a meter. The "startvalue"
field of this database is the meter reading at the beginning of the day. The " end value" field is the
meter reading at the end of the day. Thus, the " amntused" field is the result of the computation
"end value mi nus startvalue".
Other types of fields that a program may make use of include currency fields and time
fields. Currency fields are used by some database management programs to readily identify that
particular field type. Whenever a data item from a currency field is displayed, it includes a
dollar sign. The user will know that the information being displayed is monetary in nature. If the
dollar signs are not displayed, then the info rmation may not refer to money. Time fields keep
track of the time.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.

What is a database?
What four things should a Database Management System let the user do?
What are the three types of database management systems generally available today?
There are two common types of file organization methods, what are they?
What is the key purpose of a Database Management System?
Aside from ease of access to information, what other benefits does a good database management system provide the user?
What is the difference between a hierarchical/network database system and a relational database system?
What is the unit of information that is combined to make up a database file?
What is the unit of information that is combined to make up a record?
There are several different types of data which may be contained in a field. What are the most common?
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CHAPTER OBJECTIVES:
Upon completion of this chapter, the student will:

• Create a database in an electronic spreadsheet.
• Sort the data in a spreadsheet database.
• Extract records from the spreadsheet database.

• Access records in the spreadsheet database
randomly.
• Print the spreadsheet database.

-

1 4.1 SPREADSHEET DATABASES

The data management function of electronic spreadsheets is similar in concept to, but different in
execution from, a disk-based database such as FileMaker II , the program you will be using later
in this text, or one of the other database management programs available fo r the Macintosh, such
as dBASE Mac, 4th Dimension or Omnis. The maj or differences are:
• The complete database is loaded into the computer's memo ry in the spreadsheet.
• Only one database may be active at one time.
• The database fu nctions act more li ke list managers (hence the name data management
functions, rather than database functions) and are not relational in nature.
• A user does not define data ty pes (e.g., Text or Numeric).
Because the complete database is loaded into the computer's memo ry, some operations can
be very fast when compared to disk-based databases. Fo r example, sorting a database in the
computer's memory takes much less time than sorting it on the disk. The amount of time
required for the disk dri ve to turn , and the disk read/write heads to move, is eliminated with the
spreadsheet data manager.
However, because the complete database is loaded into the computer 's memory, the size of a
spreadsheet or database with a sophisticated program such as Excel is limited to the available
Random Access Memo ry (RAM ) in your computer. A fair portion of your computer's RAM is
occupied by the program, so expand ing the memory of your Macintosh is strongly recommended
if you intend to use a database of several hundred rows or more (or a large spreadsheet model).
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1 4.2 CREATING THE SPREADSHEET DATABASE

Because Excel is primarily an e lectronic spreadsheet progra m, the database information is
placed in the spreadsheet cells. The rows of the spreadsheet act as records of the database, and
the columns act as the fields. Each field name is placed at the top of the column containing the
field. Do not put any blank rows in the database, or between the row containing the field names
and the first record. The sample database you will build places the database starting in the A
column at row one, but this is not mandatory.
You sta rt the creation of your spreadsheet database by defining the fields you want to use.
You do this by placing the field names at the tops of the columns. Thus, the columns a re the
fields. After e ntering the field names, you e nter the data into the columns. Each row is a record.
When you are done, select the complete database range and, using the Define Name command,
assign it the special name, " Database." You may use the fo rmatting commands of the spreadsheet to adjust the display of nume ric fields, or columns. Also, you may adjust the width of the
columns to control the amount of info rmation that can be displayed in any single column,
especially text columns.
After you have entered the information, defined the range and made a ny aesthetic adjustments, you may perform a variety of operations on the data. You may perform ordinary spreadsheet type operations, suc h as computing a cell based on the values in other cells, or summing a
range of cells. You may perform what-if operations if the cells are appropriately set up. You may
graph the data, visually showing the re lations among fields of the database. And you may
perform database operations such as sorting and selecting data.
The example you will build will be to compute wages for hourly employees.

-

1 4.3 CREATING AN EXCEL DATABASE

Afte r you boot your Macintosh with a Syste m Start-Up disk, insert the Excel Program disk into
one of the computer's disk drives. If you a re usi ng a machine with a hard disk you will not need
to insert the Excel program disk into a disk drive. Rather, locate the Excel folder, and open it so
you can see the Excel progra m icon. Place a disk (see Chapter 3 for how to initialize a new disk)
with at least 200K available space into anothe r one of your Macintosh's disk drives , if you have
one available. This di sk wi ll be used for saving your work. If you do not have a free floppy disk
drive, keep this disk avajlable. You will need it for data storage.
In these instructions, [cr] means to push the Return key on your computer's keyboard
(remembe r, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the g iven lette r. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
" drag " means to select an item, be it an icon or the menu selection ba r, and move the mouse
while the mouse button is pressed.

WHAT

To Do

If the disk 's icon is closed, double-click
on it with the mouse pointe r.

WHY

You ARE DOING IT

Open up the disk icon onto the desktop. If the Macintosh
you are using has a hard disk, then open the folder containing the Excel program.
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Locate the Excel program icon inside
the disk window (Figure 14. 1). If you
a re us ing a machine with a ha rd disk ,
locate the Excel progra m icon inside the
folder's window.
Move the mouse pointer to the Excel
icon a nd double-click the mouse button .

Figure 14.1
The MS-Excel program
icon.

Launch Excel. Reme mber, if you are having trouble with
the double-cl ic k, you may select the Excel icon with a
single click, the n use the Ope n command on the File
me nu (or XO) to launc h Excel.

[CAPS LOCK]

Press the Caps Lock key. This places the compute r into
aJI capital lette rs mode. Depending on whic h model of
Macintosh a nd keyboard you are using, " CAPS " may
appear in the lower right corner of the display.

LAST [c r]

Ente r the field name LAST in cell A I a nd move the cursor to A2 by pressing the [c r] or the down a rrow (~) key.
You will put people 's last names into the A column of the
spreadsheet and call this field LAST. The names of the
fi elds do not necessarily need to be entered in all capitals. but it will be easie r to remember this way.

SMITH [cr]
COOPER [cr]
JONES [cr]
DOE [cr]
CORNFELD [c r]

These a re the values for the LAST field. The field name ,
LAST, is at the top of this column , and the data for the
field a re in the column below the field name.

,. •

File Edit Form.(
A7

~;

+

::

ll._

;:

--+

1

3

I

I

)

Figur e 14.2
The first field has been
entered for five records.

B
LAST
S_Mai;;:THi;;;---+---\
COOPER

Move the cursor to the B column.
Hold down the command key and press the up arrow .
Th is will j ump the c ursor to the top of the B column, cell
B I . You may, of course, click the mouse on cell B I.

HOURS [c r]

This is the name of the second field. After you e nte r th is
field name , move the cursor down to cell B2.

35 [cr]
39 [cr]
37 [cr]
33 [cr]
36 [cr]

Ente r the values for the HOURS field . This field represents the numbers of hours worked in a week by each
e mployee.

--+

Move the cursor to the C column.

Microsoft Exce1
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Xt

Hold down the command key and press the up arrow.
This wi ll jump the cursor to the top of the C column,
cell C I.

RATE [cr]

This is the name of the third fie ld . End by placing the
cursor into cell C2.

4.55
4.55
4.75
4.85

[cr]
[cr]
[cr]
[cr]
4.92 [cr]

The RATE field is the hourly pay rate for each employee.

-+

Move the cursor to the D column.

Xt

Hold down the command key and press the up arrow.
This will jump the cursor to the top of the D column,
cell D I.

EARNINGS [cr]

This will be the last field you will create.

= (82*C2) [cr]

The EARNINGS field is computed. It is the hours times
the rate.

Select cells D2:D6.

These are the cells that you will put the earnings value
into.

Figure 14.3

Select this range of cells so
that you can use the Fill
Down command to
complete the database.

XD

This is the Fill Down command. Recall that it is located
on the Edit menu. It will copy the contents of the top cell
of the range , D2, into the remainder of the range.

Select cells Al:D6.

This is the complete database. You must assign it the
range name Database before continuing.

Figure 14.4

The complete database has
been selected.

Macintosh Productivity Tools

Pull down the Data menu.

This menu has many commands that operate on a database within Excel.

Drag the mouse down to Set Database.

This command will define the selected range as a database fo r Excel. After using it you will find that a range
called " Database" has been defined in the Define Names
list of range names.
Figure 14.5
The Data menu has been
pulled down and the Set
Database command has
been selected.

Sort ...

Series...
Teble •.•

Parse.•.

Release the mouse button.

Define the selected portion of the spreadsheet as a database for Excel.
The Save command.
Name this worksheet DB I.

DBI

Before you click the mouse on the Save button, make
sure that the proper disk has been selected. Use the Drive
button in the Save dialog box and the Eject button as
needed until your disk is showing.
Click on the Save button.

Complete the save process. If you have problems working
with the database, you will be able to return to this point
without having to recreate the information.

-

14.4 SORTING THE SPREADSHEET DATABASE
One of the most useful data management functions is to re-arrange the data into a different o rde r.
Disk-based database management progra ms perform this task , and so does the Excel database
manager. When you do this , all the fields of the database records will become re-arranged a lo ng
with the field on which the sort is based .
When you sort the rows of an Excel database, you must take care not to include the fi rst
row. This row holds the field names, and is not really part of the data. If you include the fi rst
row in the range when sorting the database , the field names will get sorted into the data .

WHAT

XG

To Do

WHY

You ARE DOING IT

The Goto command.
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Cl ick on Database.

You want to select the complete database. The first sort
you will do will include the first row of the database. As
previously mentioned , th is is wrong.

Click on the OK button.

Complete the selection of the complete database.

Figure 14.6
The complete database has
been selected.

Pull down the Data menu and select the
Sort command.

The Sort command will let you sort, or rearrange, the
information.

Figure 14.7
The Sort command has
been selected.
Find
EHtract •••
Delete
Set Database
Set Criteria

Series•..
Table•••
Parse •••

Release the mouse button.

Execute the Sort command. After a brief pause you will
see the Sort dialog box.

Figure 14.8
The Sort dialog box. Note
that Excel does NOT give
you any warning that the
first row of the Database
range has been included in
the information to be
sorted.

Sort

I OK,)
( Cancel )

®Ascending

0 Descending

2nd Key---,

3rd Key---,

®Ascending
Descending

0

0

®Ascending
Descending

The initial Sort dialog box does not need to be changed.
The Sort By box lets you sort either rows or columns.
Si nce a record of the database is in a row, we want to rearrange the rows.

Macintosh Productivity Tools

The three Key boxes control the order that the rows are
to be sorted into. Only one key is necessary. The 2nd and
3rd keys produce secondary sorts. For example , if your
data has 30 people named "Smith", you would make the
field containing the First Name the 2nd Key. When the
sort is done, all the Smiths would be togethe r, and then
alphabetized by their first name (the 2nd key).
The l st Key box has been filled by Excel with $A$ 1,
which is the column holding the Last Names (the A
column) and the row starting the data to be sorted (the 1st
row). Finally, we want the records sorted alphabetically,
from A to Z. If you check the Descending button, the
records will be sorted in reverse alphabetical order, from
Z to A.
Click on the OK button.

Execute the Sort.
You can see the effect of including the row containing the
field names in your sort. This row of information has
been moved to row 5 of the database.
Figure 14.9
The first sort has been
done wrong! Note that the
field names are in row 5,
rather t han at the top of
each field.

Pull down the Edit menu.

Recall that the Edit menu frequently has an Undo
command .

Repeat Sort

Figure 14.10
The top of the Edit menu
shows the command Undo
Sort.

Cut
Copy
I'ISSI<l

Clear...
l'oste S(lPt:lal...
Pos1e Link
Delete•.•
Insert•••
Fill Right
Fill Down

Excel does include an Undo Sort command.
Drag the mouse down to Undo Sort and
release the mouse button.

When you undo the sort, the database will return to its
original order. Most important, however, is that the field
names are returned to the top of the database where they
belong.
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Remember the Undo Sort command. It may come in
handy in the future .
Select cells A2 :D6.

This time you are going to correctly sort the records by
not including the field names in the rows to be sorted .

Figure 14.11

You are going to sort only
the data this time. The
Field names at the tops of
each column are not
included in the rows to be
sorted.

Pull down the Data menu, select Sort
and release the mouse button.

Once again you are going to execute the Sort command.
The Sort dialog box now has cell $A$2 showing for the
1st Key.

Click on the OK button.

Execute the sort.

Figure 14.12

The correctly sorted
database.

Pull down the File menu , select Save As
and re lease the mouse button.

You are going to save the sorted database with a new
name.

DB2

Name the database DB2.

Click on the Save button.

Complete the Save command .

If you have trouble with Undoing the incorrect sort, or you want to try the sort again, close
the current wo rksheet and use the Open command on the File menu to load the initia l file , saved
as DB I. The n try the sort ope ration again .

-

1 4.5 SELECTING RECORDS IN THE SPREADSHEET

As you will see, a disk-based database ma nager also lets you select records from the database
based on a selectio n crite ria. For example, you may want to see o nly the records that include the
word " nail " in a descriptio n field. At the same time, you may want to see o nly two o r three of
the fields of the complete database, which may include 25 to 30 fields . Both of these procedures
are a simple task for the database management program.
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In a similar fashion, you may have the Excel data manager select records out of the database
for you. All you need to do is specify the field name upon which you are basing the selection and
the value for which you are selecting. This information is , of course, placed into spreadsheet
cells where the program can get at it. Finally, you must specify an area of the spreadsheet in
which the selected records are to be placed. This area also defines the subset of the fields you
want to see.

WHAT

TO Do

WHY

Click the mouse on the 1 in the border
to the left of the first row.

r

•

File Edit

AI

Formule

Formet

You ARE DOING IT

Se lect the first row of the spreadsheet. Remember, if you
click in the border, you select the complete row or
column.

Dete Options

Mecro Window

,

LAST

Figure 14.13
The complete first row has
been selected.

082
B

XC

The Copy command. You are going to copy this row of
the spreadsheet.

Click the mouse on the border at
row 10.

Select the complete row 10 of the spreadsheet.

XV

The Paste command. You have now copied the field
names to the tenth row of the spreadsheet.

r

•

Edit

Formule Formet

Dete Options Mecro

Window

,

Figure 14.14
The field names have been
copied to row 10 of the
spreadsheet.

Click on cell A II .

Place the cursor into cell A 11 , directly below the cell
which contains the text " LAST".

CO* [ENTER]

This specifies the values that you want to select for, and
is sometimes called the selection criteria. The selection
criteria is placed directly below the field name that is
controlling the selection.
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Here you are telling Excel that you are looking for a
value in the LAST field that starts with CO. T he * is
called a wildcard character. From the location of the *,
any character matches. Thus, COABCDEF and COOPER
and CORNFELD all match this selection criteria.
Select the cells AIO:Ail.

Now that you have entered information for the selection
criterion, you must tell Excel the range that contains the
criterion.

Pull down the Data menu and select Set
Criteria.

This command will place a range into the Defined Names
list called Criteria.

Figure 14.15

The Set Criteria command
has been selected. You can
see that cells A 10:A 1 are
selected. They will be the
criteria.

EHtrect ...
Delete
Set Detebese

Sort ...
Series•••
Table •••
Parse ...

Release the mouse button.

Set the selection c riterion to be the range A lO:All. You
are looking for any records in the database in which the
data in the LAST field starts with CO.

Move the mouse to cell A 13 and click
the mouse button once .

Move the cursor to cell Al 3.

LAST-+

Put the field name LAST into cell A 13 and move the cursor right to cell B 13.

EARNINGS [ENTER]

Put the field name EARNINGS into cell Bl3 .

Select the range Al3:Bl3.

These two field names will be used to select the fields
you want listed. They represent the information you want
copied to the output area for records matching the selection criteria.

Figure 14.16

The database is ready to
perform a selection.

r

•
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Pull down the Data menu and select
Extract.

The Extract command will copy the desired fie lds,
LAST and EARNINGS in this case, for all the records
that match the selection criteria that has been set up ,
LAST = CO*. Note that you can execute this command
with the XE key.
Figure 14.17
The Extract command has
been selected.
Find
Delete
Set Database
Set Criteria
Sort •••
Series•••
Table•••
Parse •••

Execute the Extract command. You will now see the
Extract dialog box.

Release the mouse button.

EHtract

0

Unique Records Only

C lick on the OK button.

I

OK

0

Figure 14.18
The Extract dialog box.

[ Cancel )

You are not worried about unique records at this time.
Cl ick on the OK button to execute the extract. After a
brief pause, two records will be placed in the output area
below the two field names in row 13.
Figure 14.19
The results of the Extract
command.
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Click the mouse pointer on cell Bll.

This is the cell below the field name HOURS .

<35 [ENTER]

Enter the less than sign, followed by 35. You want to find
all the records in which the hours worked are less than 35.

Select cells BIO:B II.

You must select the cells you want fo r the criteria range.

Pull down the Data menu , select Set
C riteria and release the mouse button.

Set cells BIO:Bll as the new criteria range .

Figure 14. 20

The new criteria range will
be cells 810:811.

Select the range AI3:BI3.

Once again select the two fields you have specified for
the output area. Do not worry about clearing the contents
of the cells below the two output field names.

XE

Execute the Extract command .

Click on the OK button.

Complete the Extract command.
After a brief pause, the two records that were selected by
the first Extract command are replaced by two new
records.

Figure 14.21
TWo different records meet
this selection criteria.

Select the range A IO:B II.

You will try one more extraction command using a combination of the two selection criteria you have already
created.
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Figure 14.22

This range of cells will
make the new selection
criteria.

Pull down the Data menu, select Set
Criteria and release the mouse.

Make these two criteria a combined selection c riteria.

Select the range A l 3:813.

Once again select the two fields you have specified fo r
the output area.

~E

Execute the Extract command.

Click on the OK button.

Complete the Extract command.
The output area will be erased. No records are selected
because there are no last names beginning with CO for
which the hours column contains a value less than 35.

-

14.6 RANDOM RECORD ACCESS IN THE SPREADSHEET
DATABASE

The spreadsheet data manager is also able to locate records in the database without extracting
them. As you may have surmised, the extraction process requires that you have a place to put the
matching records that are located. This may, or may not, be a problem, depending on the actual
size of the database and the amount of memory available to the spreadsheet.
The Find operation does not have this problem. It locates the desi red records in the database
area based on the selection criteria and highlights the desired records one at a time.

WHAT

TO Do

WHY

You

ARE DOING IT

Select the range 810:811.

You are going to set the selection criteria to something
that will result in records being found.

Pull down the Data menu , select Set
Criteria and release the mouse.

Set the selection criteria to find records for people with
hours less than 35 .
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Pull down the Data menu and select the
Find command.

The Find command will locate the records in the database, but does not put a copy of the located records into
an output area. Note that you may execute this command
by using the 3€F key.

Figure 14.23
The Find command has
been selected.

Delete
Set Database
Set Criteria
Sort ...
Series•.•
Table.. .
Parse .. .

Release the mouse.

Figure 14.24

Execute the Find command . The fi rst record which meets
the current selection criterion is found . The found record
is highlighted (Figu re 14 .24). Notice that nothing has
been placed in the output range. Find locates, but does
not extract, records.

,.

The first record has been
found.

•
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to v1ew

The down arrow will find the next record which meets
the current selection criterion.
There are no more records which meet the selection criteria, so Excel " beeps" when you attempt another FIND
at this time.
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Pull down the Data menu.

Note that the Find command now reads Exit Find. It may
still be executed by using the XF key.
Figure 14 .25
The Find command
changes to Exit Find while
a find is in process.
EHtrac:t •••
Delete
Set Database
Set Cr1ter1a
Sort •••
Series •••
Table•••
Parse•••

Drag the mouse down to Exit Find and
release the mouse button.

Exit the find process.

Pull down the File Menu, select Save As
and release the mouse button.

You are going to save the modified spreadsheet.

DB3

Name the spreadsheet DB3.

Click on the Save button.

Complete the save process.

To print the information in your Excel database, use the same sequence of steps that you use
to print a n Excel spreadsheet. Remember, to print everything, simply select the Print command
found on the File menu. To print only a portion of the spreadsheet, select the desired range, then
use the Set Print Area command before you execute the Print command. All you need to
remember is that the Excel database is an e nhanceme nt of the spreadsheet, and all spreadsheet
operations are allowed.

-

1 4.7 A DIFFERENT LOOK AT THE DATABASE

In addition to the way you have been working with the database, Excel will let you use a database
form . This can sometimes be helpful, since you do not have to keep track of the database range.
The database form lets you locate records , de lete the m, and add new ones to the database. To use
the Form command, you must have a database range defined. You may do this with the Set
Data base command, or by using the Define Names command.
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WHAT

To Do

WHY

Pull down the Data menu and select the
Fonn command.

You ARE DoiNG IT

This command is the fi rst one on the menu.

Figure 14.26
The Form command has
been selected on t he Data
menu.

Find
MF
EHtnu:t ••• ME
Delete
Set Database
Set Criteria

Sort ..•
Series •••
Table•••
Parse...

Release the mouse button.

Figure 14.27
The Excel Database Form.
You are looking at record
one of the database. The
top right corner of the
Form window tells you 1
of 5, meaning record 1 is
displayed and there are 5
records in the database.

r

j

Execute the Form command. It will take Excel a few seconds to build the fo rm. Don' t worry.

*

"'file Edit Formula

~A5

Format

Data Options Macro

.,

Window

D83
I of 5

(
(
(

New
Delete
R e~ ton•

I Find Preu

f

)
)
)
)

( Find NeHt )

• For Hel p on dlelog settings, press Commend-?

(

Criteria

)

I

EHit

)

-

..

Note that the first three items of the database have boxes
around them, while the last, EARNINGS, does not have
a box. This last field is computed, while the first three
are input by the ·use r.
Click on the Find Next button.

When you activated the form, you were looking at the
fi rst record of the database . This button will move you to
the next record. The Find Prev button will move you
backwards through the database .

Click on the Crite ria button.

You want to see what happens when you enter a selection
criteria.

[TAB]

Move the blinking cursor to the HOURS field input box.

Macintosh Productivity Tools

Once aga in , you want to identify those people who have
worked less than 35 hours.

<35

.

--

-

083

Criteria

LRST:
HOURS:
RRT£:
EARNINGS:

Figure 14.28
The Selection Criteria has
been specified.

- -- - -

1<35

~===:

Clear
Restore

I.______,

( Find Preu

1

( Find NeHt

1

Form
[Hit

C lick on the Form button.

Return to the Form from the Criteria specification screen.

C lick on the Find Next button.

This w ill locate record 3 in the database. Note that the
hours are 33, which is less than the spec ified 35.

LRST:

Figure 14.29
The third record matches
the current selection
criteria.

3 of 5
New

HOURS:

Delete

RRT£:
EARNINGS: 160.05

( Find Preu

1-

llfui!ite!J ( Criteria

1

[Hit

C lick on the Find Next button again.

The next record that matches the selection criteria is
record 4, with hours of 27.

C lick on the Find Next button again.

The computer will "beep" at you . Even though you are
looking at record 4, there are no more records that match
the selection criteria. Thus, the beep.

C lick on the New button.

You want to add a sixth record to the database.

ALBERG [TAB]

Enter the last name. Press the Tab key to move the cursor
to the Hours field.

37 [TAB]

This person worked 37 hours. Press Tab to move the cursor to the Rate field.
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4.65

This person earns $4.65 per hour.

Figure 14.30
The database form has
been filled out for a new
record.

083
LRST:
HOURS:
RRTE:

IRL8ER6
137

New Record

1
1
Restore 1 _
( Find Preu 1
( Find NeHt 1
( Criteria 1
(
[Hit
1
New

:==::====:

Dele1e

4_.6_5_ __.

._I

ERRNIN6S:

Click on the New button.

Figure 14.31
The new record has been
added to the database. It
can be seen behind the
input form in row 7 of the
spreadsheet.

This will add the record to the database. Excel will then
present you with the empty New Record form for another
record .

,. ~

File
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Edit

Formula
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Data _Options

083
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II
I
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Dele1e
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1
( Find NeHt 1
( Find Preu

Click on the Exit button.

Exit the database Form mode.

XG

The Goto command.

Click on Database.

You want to select the complete database.

Figure 14.32
Database has been
selected in the Goto names
list box.

Goto
Criteria

~

I

OK

( Cancel

.,

~
Reference:

Macro

(

Criteria

(

[ Hit

I
1

1

1-

Macintosh Productivity Tools

Click on the OK button.
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Execute the Goto command.
Because you added the new record through the database
Form, the database range has extended itself automatically. It now includes row 7 of the spreadsheet.
Figure 14.33

The complete database has
been selected.

Pull down the File menu, select Save As
and release the mouse button.

You want to save the modified database.

DB4

Name this database DB4.

Click on the Save button.

Complete the Save command .

3€Q

You are through with the Excel database.

It is worth noting that if you continue to add records to the database through the database
Form , you will run into occupied cells. When this occurs, Excel will tell you that it cannot
extend the database, and you will not be able to add more records. If you a re building a
functional database, it is therefore a good idea to put criteria ranges and output areas either above
or to the right of the actual database. With this design, the database should not run into a ny
occupied cells of the spreadsheet.
Finally, remember that the form may be used for browsing th rough the database by using the
Find Next and Find Previous buttons, and for locating subsets of the database by using the
C riteria button.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
I0 .
I I.

Does the database in the Excel spreadsheet program require that the data types be pre-defined?
How big can an Excel spreadsheet database be?
When creating an Excel spreadsheet database, whe re is the information stored?
Whe re are the field names placed in an Exce l spreadsheet database?
How wide can you make a text column/field?
Must a database be in a specific location in the spreadsheet, or may it be placed at any location in the spreadsheet you
desire?
W he n you sort an Excel spreadsheet database, are a ll the fields of the database re-arranged with the sort-key column, or is
only the sort-key column re-arra nged?
W he n selecting a subset of records from the Excel spreadsheet database, you must first use the Set Criteria command.
What purpose does this command serve?
How does the Extract process know wh ich fields of the Excel spreadsheet database you want displayed in the output area?
Is it possible to c reate selection criteria that select no records from the database?
How does the Excel spreadsheet database Find operation diffe r from the Extract operation?
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12. Use Excel to create the following inventory database:

Part No.
B877
B510
B302
C213
C897
B512
B340
A902
C878
C764
D229
C387
A874
C315
A392
A103

On Hand

Description
Yellow Highlighters
Red Permanent Markers
Red Felt-tip Pens
Phone Message Pads
Inter Office Memo Pads
Black Permanent Markers
Black Felt-tip Pens
9 x 12 Manila Envelopes
8.5 x 11 White Unlined Pads
8.5 x 11 Lined Writing Pads
8 oz. Styro. Coffee Cups
5 x 7 Yellow Lined Note Pad
5 x 7 Manila Envelopes
4 x 5 White Note Pads
4 x 5 Manila Envelopes
#9 Envelopes

Reorder

Cost

2
12
12
24
12
24
48
25
12
48
100
12
25
24
25
500

1.95
1.65
0.75
0.87
1.75
1.65
0.75
0.07
1.67
1.55
0.05
0.95
0.05
0.73
0.04
0.04

3
7
16
26
15
11
27
76
9
31
62
28
21
13
53
1210

13. Sort the database you created in Exercise 12 so the information is listed in Part Number order.
14. Add another column to the database you have created, titled VALUE. The entries in this column are computed by
multiplying the number in the ON HAND column times the number in the COST column. At the bottom of the new
VALUE column, compute the sum of the values, giving the total value of the inventory on hand.
15. Use the extract feature to find the inventory items in the database with the number on hand below the reorder point.
16. Use Excel to create the following birthday database:

17.
18.
19.
20.

Last

First

Phone

Jones
Ettinger
Carey
Ackerman
Perryman
Kemp
Litton
Malone
Diller
Shepherd
Berkett
Wong

Mary Anne
Alice
Fredrick
George
Edward
Robin
Joseph
Florence
Janice
Harold
Gregory
Jenny

415/678-1212
805/864-5741
415/339-1239
415/653-9640
213/564-7686
805/239-1282
213/681-4760
415/931-3151
805/413-0891
213/872-1171
415/751-5476
805/321-9812

Birth Month

Day

September
January
October
April
June
May
February
January
October
September
September
March

6
11
22
27
18
3
21
28
3
2
19
17

Sort the database you created in Exercise 18 into order by Last Name.
Use the Extract operation to select the people with a birthday in September. How many are there?
Use the Extract operation to select the people with phone numbers in the 805 area code. How many are there?
Sort the database into order by birth month. What is the order that the months are displayed (January, February, March,
etc., or some other order)?
21. Add a sixth column to this database, called MONTH NUMBER. Place in it the number of the birth month. That is, place
a I in the column if a person's birth month is January, a 2 if it is February, and so on.
22. Sort the database into order based on the MONTH NUMBER column. Now in what order are the months displayed? Are
the people's birthdays necessarily in chronological order?
23. Sort the database into order based on the MONTH NUMBER as the primary sort key and the day as the secondary sort
key. Does this put people's birthdays into chronological order?
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CHAPTER OBJECTIVES:
Upon completion of this chapter, the student will:

•
•
•
•

Start FileMaker.
Create a database file.
Add entries into the database file.
List/display the file contents.

• Edit/correct file entries.
• Print the file contents.
• Exit FileMaker.

-

1 5.1 STARTING FILEMAKER II

FileMaker II is distributed on two disks, the Program disk and the Examples disk. On the
Program disk you will find the FileMaker II program itself and the FileMaker help file. The
Examples disk contains a variety of sample database files.
After you boot your Macintosh with a System Start-Up disk, insert the FileMaker II Program disk into one of the computer 's disk drives. If you are using a machine with a hard disk you
will not need to insert the FileMaker program disk into a disk drive. Rather, locate the FileMaker folder, and open it so you can see the FileMaker program icon. Place a disk (see Chapter
3 for how to initialize a new disk) with at least 200K available space into another one of your
Macintosh's disk drives, if you have one available. This disk will be used for saving your work.
If you do not have a free floppy disk drive, keep this disk available. You will need it fo r data
storage.
In these instructions , [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., X X) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed.

518

CHAPTER FIFTEEN -

BEGINNING DATABASE MANAGEMENT SYSTEMS CONCEPTS

WHAT

TO Do

WHY

If the disk's icon is closed, double-click
on it with the mouse pointer.

Figure 15.1
The FileMaker II program
icon.

------

F;leMaker II

You ARE DotNG

IT

Open up the disk icon onto the desktop. If the Macintosh
you are using has a hard dis k, then open the folder containing the FileMaker II program .

Locate the FileMaker II program icon
inside the dis k window (Figure 15 . 1). If
you are using a machine with a hard
disk, locate the FileMaker II program
icon inside the folder's window.
Move the mouse pointer to the FileMaker II icon and double-click the
mouse button.

Launch FileMaker II . Remember, if you are having trouble with the double-cl ick, you may select the FileMaker
II icon with a single click, then use the Open command
on the File menu (or XO) to launch File Make r II.
After a brief pause while the program loads, you will sec
a dialog box similar to the one shown in Figure 15 .2.
FileMaker wants to know the name of the database file to
be opened.

Figure 15.2
The beginning FileMaker
display.
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Click on the New button.
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Since you do not have a database file. clicking on the
New button will tell FileMaker that you want to create a
new database fi le .
You will now see the New File dialog box. If your disk
name does not appear at the top of this dialog box, click
on the Drive button. If the Drive button is dimmed , insert
a disk into the disk drive so that FileMaker can read it. If
all the disk drives in your computer are full , then use the
Eject button in this dialog box to free up one of the disk
drives, then insert your data di sk into the now empty dis k
drive.

Macintosh Productivity Tools

Figure 15.3
The New File dialog box
shows the disk MY DATA is
in one of this Macintosh's
floppy disk drives.

Ijg) MY DRTR I
CJ Misc. Things
0 Spreadsheet Models
CJ Word Processing Oocum...

Q

jg) MY DATA
Eject
Drtue ~]

Neuo

Create a new file named:

Cancel

Inventory File

Enter the name " Inventory File" into the name box at the
bottom of the New File dialog box (Figure 15.4).
Figure 15.4
The file name "Inventory
File" has been entered into
the dialog box.

Create a new file named:
llnuentory

Fll~

Cancel

Click on the New button.

Clicking on the New button will create the file.
Because this is a new database file, you will now see the
File Definition dialog box.

,

•

File

E d i t - -G<tdgeh

rormot

custom

.,

Window

lnuentory File
Field Definition

Q

0
Field name:

I'

I

Field type:
@TeHt
ONumber
ODate
0 Picture
0 Calculation
osummary

XT
XN

xo

XP
XC
acs

[
(

En triJ Up tlons
flef01mulale

1
1

( Ot-sele<t) (

OK

)

( Ot>ll'tl' ) (

~Hit

l

Figure 15.5
The File Definition dialog
box is empty for a new
file.
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1 5.2. PREPARING TO DEFINE A DATABASE

Now that you have FileMaker II running, and an empty database file has been c reated, you are
ready to define the contents of the file. This file will contain the information you want to keep
track of. When you create a file, you must the n enter into your database management program
the structure or organization of the data. That is, you must tell the program what each field is to
be called and the type of data it is expected to hold. This organization of the file fields is
sometimes called the " file structure" or the "file dictionary."
How you define the fie lds of your database is probably the single most important factor
affecting the successful use of the database management program.
Before you actually begin creating the file, you must consider how muc h space to allocate
for each field on the computer 's sc reen, the font characteristics of the fields , the type of data to
put into each field and formatting of the information.
As you make your decisions about all these factors, you must balance your desi res between
wanting to plan for all possible information a field may hold (for example, if one of the fields is
to hold last names, do you leave space for a last name of over 30 characters-hyphenated names
can be long) and the limitations of the program you are using . Some database programs limit the
number of fields you may use to build a record . They may also limit the total number of
characters that make up a record, regardless of the number of fields within that record. FileMake r does not have these limitations, but you must still consider the storage media you will be
using.
Frequently, the most important consideration when planning the file's organization is the
capacity of the disk you are using combined with the anticipated number of records in the file. If
each record requires 1000 bytes of disk storage, then a disk with 80K (8 1920 bytes) of free space
will be able to hold a file with only 8 1 records. If the record requires only 750 bytes, this same
free space will be able to store 109 records! Even a large-capacity hard disk does not have
infinite space. You should also keep in mind the space requirements of picture fields. If you are
using MacPaint® graphics, the space requirement of a picture field is relatively small , a nywhere
from about 500 bytes to about 2000 bytes per record for a graphic that is about two square
inches. On the other hand, if you are storing detailed scanned images, or color images , you can
expect the field to require between 10,000 a nd 30 ,000 bytes per record for the same two square
inch image.
Another important consideration deals with the difficulties you may encounter when you try
to change the field definitions of an existi ng database file. This task is not impossible, but it
requires time a nd effort to add information to a fi le when a new field is added. With this in
mind, you should remember to consider how many othe r ways the information in the database
may be used. Maybe one or two small pieces of information included with a file will eliminate
the need to keep other files with duplicate information .
The file you will create here will be an inventory database. It will conta in item code
numbers, descriptions, costs, re-order information, a nd a graphic of the item.
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1 5.3 HOW TO DEFINE THE FIELDS FOR FILEMAKER II
You should still have the File Definition dialog box displayed o n the Macintosh's screen. If not,
redo the steps in the first section of this chapter until your screen matches Figure 15.5.

WHAT

TO Do

Inventory Code

WHY

You ARE DoiNG

IT

Enter the name of the first field into the Field name box.
This field will hold unique information for each record of
the database-a code number to identify each inve ntory
item in the file.
The button for the Text Field type should be selected.
Since you want this field to be a text, or character, field,
you do not have to do anything else to this field definition. You should note that in add ition to be ing able to
click on the Text button, XT may be used to select the
Text Field type.

r

li File Edit

.,

Window
Field Definition

Figure 15.6
The Field Definition has
been completed for the
first field of the database.

lo
Field neme:
llnuentory Cod~

Click on the OK button.

FJeld type:
®TeHt
QNumber
QDete
QPic:ture
0 Celc:uletlon
osummery

rntrtJ Options
XT
XN
XD
XP
ace
acs

nefmmulafe
(Deselect) (
( OPII.'tl'

)(

OK
[Hit

I
I
~)
)

You are done defining the contents of this field.
When you click on the OK button, the field name you
have defined will appear in the field list box at the top of
the current dialog box. "Text" appears afte r the field
name to remind you of the data type assigned to the field.
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Click on Inventory Code in the field list
at the top of the dialog box.

Figure 15.7
The field definition has
been completed. The
Inventory Code field is
now part of the file, and
has been selected in the
field list at the top of the
dialog box.

You now want to tell FileMaker that the information in
this fie ld will be unique in each record. This will prevent
the acc idental entry of two items with the same part
number.

' li File Edit

,

Window
Field Definition

Field name:

Field type:
@TeHt
ONumber
ODate
0 Picture
0 Celc:ulatlon
osummery

Entry Options
XT
XN
XD
XP
XC
xs

flefotmula1e
[Deselect) [

Ok

-[ Delete ) [

EHit

C lick on the Entry Options button.

When a field has been selected in the field list, this
button is turned on. You will see the Entry Options dialog
box.

Click on the box labelled "Unique value
only" at the right of the dialog box_

This selection will tell FileMaker to not allow two
records with the same inventory code number in the fi le.

Figure 15.8
The Unique value only box
has been checked on the
Entry Options dialog box.

.,

' li File Edit

Entry Options for "lnuentory Code"
Auto-enter In eac:h new record:
0 Todey's date
0 R new serial number.
ODete:

0 Display 11 list of ualues:

Require field to c:onteln a:
OUel ue
~Unique ualue only
[jEwlstlng uelue only
0 Numeric: uelue only
0 Uelue In range only
from:

I?=====~

to:._l_ _ _ _ __.

I
0 Look up uelue from another file [Change Lookup J

~ [cancel)

C lick on the OK button.

Return to defining fields.

Description

Ente r the name of the second fiel d . This fi eld will hold a
long desc ription of the item.

Macintosh Productivity Tools

Click on the OK button .

This field is also a text field. You do not need to do anything else to this field .

Cost

Enter the third field name . This field will hold the cost
of the item.

Click the mouse on the Number button.

This field will hold a number, rather than text. Note that
you may optionally use XN to select the Number field
type.

Field name:

Field type:
OTeHt
®Number
{1oate
OPicture
0 Calculation
osummary

XT
XN

Figure 15.9
The Cost field will hold
numeric information.

XD
XP

XC

xs

Click on the OK button.

Complete the field definition. You can see that Number
appears as part of the field definition in the field list at
the top of the dialog box.

Quantity On Hand

This is the next field name. This field will hold the number of units of the item that are in the stockroom.
The Number field type should still be selected, since that
was the last field type you created .

Click on the OK button.

Add this field to the field list.

Minimum Stock

The fifth field being added to the database. This field
will hold the value that represents the minimum number
of the particular item that must be in the stockroom.
When the number of units of this item in the stockroom
falls below this value, it is time to order more.

Click on the OK button .

Again , this is a numeric field . No further changes to the
field definition are necessary since the prior field was
defined as a numeric field . Clicking on the OK button
adds the field to the field list.

Reorder

The next field name. This field will tell us when the
number of units of a particular item falls below the minimum stock level in the stockroom.

Click on the Calculation button.

This will be a calculated fie ld. You want to have the database automatically tell you when a part should be reordered. You will see that you cannot enter the information
into calculated fields, FileMaker computes the information for you.
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Cl ick on the OK button.

Figure 15.10

Enter the field name and type into the fie ld list. You must
now define the calculation for FileMaker in the d ialog
box that automatically appears.

.,

4i Fil e Edlt.llllll G<~dgoh rormot Custom Window

r

.

When creating a calculated
field you must tell
FileMaker how to calculate
the information for the
field. This dialog box lets
you do this task.

lnuentory File

~
Celculetlon Result Is:
OTeHt ®Number

Reorder •

QDete

II
I
lnuentory Code
Description
Cost
Quantity On Hand
Minimum Stock

~

0000
c:J~00

0000
8@00
i(j

(!JEJ~

~

~
(

OK

ebs 0
euerege 0
count()
date(,.)
DeteToTeHt
dey 0

l

(

~
I

0

Cancel

I
1

l

The functions and comparison (or Boolean) operato rs that
you may use are found in the two sc roll lists at the right
side of the dialog box. The one on the right is the list of
functions, and the one on the left is the list of comparison
operators.
Click on the Text button.

This button is at the top of the dialog box under the heading "Calculation Result is:". Even though the computation will be numeric , the information displayed will be
text.

Use the scro ll bar of the fu nctions box
until the " if(,)" function appears.

The computation to be entered must determine if the
stock on hand is below the reorder point. Thus, we want
to use the IF fun ction. You may either type the function,
or use the functions list to have the compute r enter a shell
of the func tion for you. You want the computer to enter
the function's shell for you.

Place the mouse pointer on the " if"
function and click the mouse button
once.

When you cl ick the mouse, the " if(,)" fu nction will be
added to the formula definition box at the top of the current dialog box.

Figure 15.11
The " if(,)" function has
been aoded to the formula
definition for this field.
Note, also, that the Text
button has been selected
at the top of the dialog
box.

Calculation Result Is:
@TeHt QNumber ODete

Reorder •

I"P
lnuentory Code
Description
Cost
Quantity on Hend
Minimum Stock

~

0000
c:J~00

0000
8@00

~

eHtend 0
FU (,.)
If(,~
lnt (
left (,)
length 0

I
~
II I

I I
I I
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The "if' function requires three items of input, called
arguments, for it to operate. The first argument is a comparison, such as "Age greater than 45." The second argument tells FileMaker what to " do" when the comparison
is true. Thus, if the information in the Age field for a
specific record is 55, the second argument of this function will control what information is displayed. The final
argument tells FileMaker what to "do" if the comparison
is false. Thus if the Age field for a specific record is 28,
this third argument will control what is displayed.
Click on the "( )" button on the image
of the number pad.

The number pad, at the lower center of the dialog box,
lets you enter parts of the formula without using the computer's keyboard. Using this button will keep the parentheses balanced. The cursor will be between the
parentheses.

Click on the field name "Quantity On
Hand" in the left scroll box.

By clicking on a field name you are adding that field into
the computation.

Click on the minus sign(-) on the
image of the number pad .

The field must perform some arithmetic.

Click on the field name "Minimum
Stock".

Add this field name to the formula.

Move the cursor so that it is positioned between the right
parenthesis and the first comma found in the " if"
function.
Figure 15.12
Note the position of the
cursor between the right
parenthesis and the first
comma.

Click on the < sign at the bottom of the
Boolean operators list.

This is the " less than" symbol.

Click on the 0 on the number pad.

The comparison is now complete. It will subtract the
minimum desired stock level from the stock on hand, and
compare the result to the constant value, 0.

-+

Place the cursor between the two commas of the "if(,)"
function. This is where you will place what you want to
have displayed in the field if the comparison is true, i.e.,
the result of the computation is less than zero.

"Reorder"

When the comparison is true, the number of units in
stock of the particular item has fallen below the minimum
number to keep on hand, and it is time to reorder. Thus,
we want the word Reorder displayed. Be sure to enclose
this word in quote marks as you enter it here.
Move the cursor right so it is positioned between the second comma and the closing parenthesis.
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" OK"

This is the text to d isplay when the comparison is fa lse,
meaning the stock level matches or is greater than the
minimum number to keep on hand.
This completes the formula for the Reorder field .

Figure 15.13
The formula for the field
Reorder has been
completed.

Click on the OK button.

You have defined the field and are ready to continue with
the next field in the fi le.

Last Order

This is the seventh field. It will show the date the last
time this item was restocked.

Click on the Date button.

This is a date field.

Click on the OK button.

Enter the fie ld into the database.

The Item

Ente r the eighth field name. This field will hold a picture
of the item.

Click on the Picture button.

Make the data type for this field into Picture .

Click on the OK button.

Enter the field into the database.

Figure 15 .14
The field definitions you
have entered so far.
Field Definition
TeHt
Unique
TeHt
Number
Number
Number
• If ((Quentlty On lend - Minimum Sto
Dete
Picture

Value

Enter another field name. This will be a computed field,
giving the value of the inventory item.

C lick on the Calculation buuon.

Tell FileMaker that this will be a computed field.

Click on the OK button .

Enter the field name.
You must now te ll FileMaker the fo rmula for this field .

Macintosh Productivity Tools

Click on the Cost field.

This is the first item in the formu la.

Click on the asterisk (*) on the number
pad area of the dialog box.

The asterisk means mult iply to the computer.

Click on the Quantity on Hand field.

Complete the formula with this field. The cost times the
number in stock will tell you the dollar value of the
inventory item.
Figure 15.15
The formula for the Value
f ield.

ODate
Cost • Quantity On

Click on the OK button.

Complete the field defi nition.

Total Inventory

This will be the last field in the database.

Click on the Summary button.

This field will hold summary information. The information computed by this field will come from a summary of
the active records in the database, rather than from a single record of the database. Just like the calculation fields.
you do not enter the info rmation into the field, it is automatically computed fo r you.

Click on the OK button.

Enter the field into the database. You will now see the
Summary Formula dialog box.

Summary Formula:
Total lnuentory •
@Total of
0 Ruerage of
0 Count of
OMinlmum
OMaHimum
0 Standard Oeulatlon of
0 Fraction of Total of

The Summary Formula
dialog box.

Description
Cost
Quantity On Hand
Minimum Stock
Reorder
last Order
[The Item

~Running total

Scroll the field list in the dialog box
until you see the Value field.

You want to keep the total inventory value displayed on
the computer's screen at all times.

Click on the Value field.

This is the field you want summarized.

Click on the Running total box at the
bottom of the dialog box.

You want FileMaker to maintain the total as information
is entered.
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Click on the OK button.

Complete the definition of this field.
Field Definition

Figure 15 .17
The current field list box
now shows the two new
fields.

Cost
Quantity On Hand
Minimum Stock
Reorder
lest Order
The Item
Ualue
~otel lnuentory

Click on the Exit button.

Figure 15.18
The data entry screen for
the database file you have
created.

Number
Number
Number
• If ((Quantity On Hand - Minimum Stock
Date
Picture
• Cost • Quantity On Hand
~
• Total of Ualue (running) ~

You are done defining the fields of this database file.
After a brief pause, the preset data entry screen will
appear.

.
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15.4 CHANGING THE DATABASE STRUCTURE

There is always the possibility that you may make a mistake when entering the structure of a
database file. It is also not uncommon to discover that, despite your best planning effort, you
forgot a field, or you want to change the name of a field . This is relatively easy to correct.
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WHAT

TO Do

WHY

You ARE DOING IT

Pull down the Select menu.

This menu lets you select what you want to do with the
database fil e.

Drag the mouse down to the Define
command.

The Define command le ts you re turn to the Field Definition dialog box.

Figure 15.19
The Define command has
b een selected on the Select
menu.

Release the mouse button.

lletlnd
l'lnd fill
Sort...

>ll<ll
:li<t;
38S

Layout

38L

Return to the Field Definition mode.
You may now add more fields to the file. or change the
names of existing fields.

Cl ick on the Cost field.

You want to change the name of this fie ld.

Our Cost

Change the name of the field to Our Cost.

r

•

File Edit

,

I G<Jdgeh rormat Custom Window

Figure 15.20
The field name will be
changed.

lnuentory File
Field Definition

~

Unique

I nuentory Code
Description

TeHt
TeHt

Quantity On Hand
Minimum Stock
Reorder
Lest Order
The Item

Number
Number
• If ((Quantity On Hand - Minimum Stock
Date
Picture

Field name:

Field type:
OTeHt
®Number
OOete
0 Picture
0 Calculation
osummery

lour Cos~

Click on the OK button.

I

XT
38N
380
XP
XC

xs

(
(

Entry Options
RefOJmula1e

(Deselect) (

( Delete

l(

OK
[Hit

1
1

l
l

The field list now shows the change in the name.
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Click on the Exit button.

Figure 15.21
The new data entry screen.

r

Once again you are done defining the fields. Note that
the default data entry screen now has the field Our Cost,
rather than the field Cost.
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15.5 MODIFYING THE DATA ENTRY SCREEN

The default data entry screen is adequate for most purposes. However, you may want to make
changes to it. One change that you do want to make at this time is to the field called " The Item ."
Recall that this field is the picture field. It's default size will not hold much of a picture, and
must the refore be modified.

WHAT

To Do

Pull down the Select menu, drag the
mouse down to Layout.

WHY

You

ARE DOING

This command lets you change the size of the fields on
the entry form and rearrange them. You can see that you
may execute this command with the XL key.

Figure 15.22
The Layou t command has
been selected.

IT

Find
RPtlnd
Find All
Sort...

XF
>J::R
>l!<&
XS
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Release the mouse button.

Execute the Layout command. The sc reen will immediately cha nge to the Layout mode.
The Layout sc reen shows the c urrent sizes of each field
in the database. Inside the field you can see the field
na mes. The font that appears at this time is the defa ult
fo nt for each fie ld. At the bottom right corner of each
fi eld is a black box. This is a ha ndle that lets you change
the s ize and s hape of the field on the computer's sc ree n.
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Figure 15.23
The Layout screen. You can
now see the sizes of each
field. The field names
appear within each field.
Note the handle at the
bottom right corner of
each field.

v....

J

lthi tern

(Yilut........ J
(TibJ.Imttl!ij

Place the tip of the mouse poi nte r on the
black box of The Item field.

You arc going to change the size of this field.

Last C.lnler

Theil-

!.~l>l.UIUII!.

!l::m

Figure 15.24
Note the position of the
mouse pointer on the
handle of The Item field.

... . ...... . .. .,I

P ress and hold the mouse button.

You a re going to drag the field's handle to reshape the
field.

D rag the mouse down until the bottom
borde r of the field touches the dashed
line at the bottom of the screen.

You a re ma king the field into a squa re o n the screen.

(LaSEOI'dii ............. J
The • - ~
~T~h&i::;~em====;----'I
il
J
v.... (Y.alut........ J

Last <>Nor

lfl.eld...... l

~--~~~~:]::

-

_ _ _ !{ _________ ______ _

" g''''. . .

v

Figure 15.25
Drag the handle of The
Item field to the dashed
line above the bottom of
the screen.
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Release the mouse button.
Figure 15.26
The field has been
reshaped.

Complete the reshaping of the field.

Lneld. .....l
f~Jl ...

Click in the middle of The Item field.

You want to select the complete field so that you can
make a change to the fie ld's format.

Figure 15.27
The complete field has
been selected.

Pull down the Format menu and d rag
the mouse to the Format Picture
command.

Figure 15 .28
The Format Picture
command has been
selected.

The picture field will do one of two things to your picture. It will e ither make the graphic fit into the space you
have laid out, or it will leave the picture its original size,
the field then acting as a window to the g raphic.

custom
Font
FontSize
style
Rllgn

l

••
••

Format Number ...
Format Date ...

Release the mouse button.

Repeat ...

't

Line Width
Line Pattern
Fill Pattern

••
•

Execute the command.
You will now see the Format Picture dialog box.

Click the mouse on the second option,
Show as much of the picture as fits.

This option will not shrink or enlarge the picture to make
it fit into the field space you have provided. The picture
will now be displayed in its original s ize.

Macintosh Productivity Tools

0 Shrink or enlarge picture to
~Show

Figure 15.29
The Show as much of the
picture as fits option has
been selected.

fit

as much of the picture as fits
~

[cancel)

Click on the OK button.

You are done with this dialog box.

Click the mouse on the side of the form.

You want to de-select the field you have been working
with .
You now have a minor problem. This f ield overlaps the
Value field and the Total Inventory field on the screen.
They must be repositioned.

Click on the Value field.

Select this field. If you position the mouse outside the
field , you will not get it selected when you click the
mouse.
Figure 15.30
The Value field has been
selected. Note the location
of the mouse. This is
where it was when the
mouse button was clicked
to ensure that this field
was selected.

Press and hold the [SHIFT] key.

You now want to select more information, and keep the
current fie ld selected. Remember that the Shift-click will
let you do this.

Click on the word Value to the left of
the data entry area.

The field labels must also be moved.

Release the [SHIFT] key.

You no longer have to hold down the shift key. You are
going to move these two items first.

IUIUIUI
LFJ.eJ.d. ..... a

Figure 15.31
The information to be
moved has been selected.
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Place the mouse pointer on one of the
two selected items and press and hold
the mouse button .

You are going to drag the two selected items.

Drag the two items to the right of the
picture field.

Place these two items to the right of the picture field .
Line them up so that the tops of these items are approximately at the top of the picture field outline.

Figure 15.32
The Value field has been
moved.

: II
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lit J l

~ I ~li!\YQI"lQ.

Total .._ery
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4
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n

Click on the label Total Inventory.

Figure 15.33
The Total Inventory label
has been selected.
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llnu:em
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~l..ast~

Last Order

10

This item and its data entry field will be moved
separately.

!DIDIO!
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Drag the label to the right. below the
Value fie ld.

Place this field label below the Value field.

Click on the Total Inventory field.

Select this field. It is the last item that must be moved.

Drag the selected field to the right, and
below the field label.

Place this field below its label to the right of the picture
field.

Figure 15.34
The completed file layout.
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1 5.6 PUTTING INFORMATION INTO THE DATABASE
A database would not be of any value if it did not have information in it. After you have defined a
database file , you are ready to enter the information you have on hand. When you enter the first
group of information, you should attempt to ente r it in a logical order. For example, if the key
field of the file is a person's last name, you might want to enter the records in alphabetical order
by last name.

-

1 5.7 ENTERING DATA INTO THE FILEMAKER II
DATABASE FILE
You a re still looking at the Layout for this file. Before you enter data, you must select the Browse
mode, which lets you enter and modify the data.

WHAT

TO Do

WHY

Pull down the Select menu and drag the
mouse down to Browse.

You ARE DoiNG

IT

The Browse command lets you enter new data into the
fL!e, as well as look through and change the existing data.
It can be executed by using the XB key.
Figure 15.35
The Browse command has
been selected.

Release the mouse button.

Execute the Browse command. The Layout form will disappear and you will return to the Browse fo rm. The field
outlines will no longer be visible on the screen.

Place the mouse pointer about one inch
to the right of the Inventory Code field
label.

You must now activate the data entry mode.

r

•

File

Edit

Select Gadgeh

rormDt

lnuento

R__.cls :

Custom

File

Window

.,

Figure 15 .36
Note the location of the
mouse pointer, about one
inch to the right of the
Inventory Code field label.
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The field outlines of the data entry form will appear. The
first field will be outli ned with a solid line, while the rest
will be outlined by a dotted line.

Click the mouse button.

Figure 15.37
The data entry form. The
cursor is in the data entry
area for the first field of
the database, Inventory
Code.

IIi File Edit Select

r

G<ldge 1i

=

Format

lnuento

Custom

Window

.,

File

1""""toryCIHie

DescripiiH
Our Cost
R•cords :
1

[-·····--~---~====--=-:-----·-~----]
c·····-"1

Quantity On Hud

I

t.laimuD Stoct

[

I

J

Reorder
last Order
The lieD

r~-L______

Yalue
Totala.'IUtory

ILl e••..,••

As you use FileMaker, you will discover that you can
click the mouse in any field to activate the data entry
form . Be careful when doing this. The solid outli ne of
the field indicates that it is the acti ve, or selected, field .
This is where information will be placed when you type.
You should make sure that the correct field has been
activated.
AF I03

Enter the first inventory code number.

(TAB]

The Tab key will move the outline for the active field
from the current field to the next one on the data entry
form. The data entry area for the Description field should
now have a solid outline.
If you make a mistake while entering data into a field,
you may press the [SHIFT]-[TAB] key to move the
selected data entry field backward to the previous field ,
or you may position the mouse over the desired field and
click the mouse button. Once the solid outline is on the
desired field, use the arrow keys to move the cursor left
or right. or the backspace key to delete characters.

Hand Saw [TAB]

Enter the description for this inventory code number and
move the selected field on to the Our Cost field .

13.87 [TAB!

Enter the cost of an AF I03 into the Our Cost field and
move the selected field to the Quantity on Hand field.
When you press the Tab key, the Value field at the right
of the form will display a 0. Remember that th is field is
computed from the Our Cost and the Quantity on Hand
fields. Partial information is now avai lable, so the field is
trying to compute the requested information, using a zero
where data is not available.
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S File Edit Select

G<tdgeh

lnuento
lna.tooy ~

- - - - -- - - - - -- ---~-

~rrA.,..F1'"0""3--_------

[~1~3.~
87~==];----------

Rocords :

I
I

-ltyO•IIeH

..aJ•••StMII

I
~

rL====----=] ---·

Lest Onler
lhelt. .

[I:]

File

Figure 15.38
The data entry form you
have filled out so far. Note
the 0 to the right of the
Value field label.

jRarid Saw

DtscrlptiH
OwCoR
1

,

Format Custom Window

Browst

6 [TAB]

Enter the number of AF103s that are currently on hand.
The Value field will , when you press the Tab key, change
to 83.22, the result of the computation of cost times
quantity on hand.
You should also note that the Reorder field now says OK.
FileMaker is assuming a value of 0 for the Minimum
Stock field, and 6 is greater than 0.

,

It Select G<tdgeh Format Custom Window
lnuentory File
laftatoryCo4e
Descriptloll

OW CoR
Oooutlty Oa H ......... stMII

..........

LutOnler
lhelt. .

IAF1 03
IRaridsaw
113.87
16

I

-----

l:!li

_____

~

Figure 15.39
The Value field now shows
83.22, and the Reorder
field says OK.

.l
]

I
I
I

OK

-

I

-l

Yal•

83.22

TotaiJ!lptory

5 [TAB]

Enter the minimum stock value. The Reorder field should
remain OK.

5/l5/86 [TAB]

Enter the date of the last order. Note that you do not need
to type the leading zero for a month or day number Jess
than 10, but that you do need to type the slashes separating the parts of the date.
You are now ready to insert a graphic into the picture
field. The graphics for this database are in the scrapbook
file. If you are not able to locate the specific graphics,
make sure that the scrapbook file supplied for this chapter is in the System Folder of your boot disk.

Pull down the Apple menu, select the
Scrapbook and release the mouse.

The Apple menu holds the DAs. The Scrapbook is one of
the desk accessories that you have already used.
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C lick on the Scrapbook scroll bar until
the graphic seen in Figure 15.40
appears.

This is a picture of the item. a hand saw.

Figure 15.40
The scrapbook holds all
the pictures for this
database.

10

Scrapbook

ePIC, PICT

1 /14

3l:C

The Copy command from the Edit menu. This will place
the graphic into the clipboard file.

Click on the close box on the sc rapboo k
title bar.

Put away the scrapbook.

Cl ick the mouse on the pictu re field .

When you activated the scrapbook . the data entry mode
of FileMaker was turned off. You must click the mouse
at the location of the picture field to return FileMaker to
data ent ry mode.

3l:V

The Paste com mand will place the graphic that is curre ntly in the cl ipboard into the picture field of the
database.

Figure 15.41
The graphic is now in the
field, and the record is
complete.
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If you have made a mistake while entering data for this
record, use either the Shift-Tab key, Tab key or the
mouse to select the field with the error. Then edit the
contents of the field by selecting and replacing the information, or backspacing to remove text.
Before you continue, look at the top left of the Inventory File window . This area tells you
some information about the file you are using. The item that looks like a book on its side tells
you how many records are available in the current browse view. At present you can see a 1 on
the center page. The number that appears in this space indicates the current record number in the
file of the entry that is displayed on the computer's monitor. You will also see, as records are
added to the file, that the top and bottom pages of the book will have " writing" on them. This
indicates that there are more records in the file. When one of these pages is blank, as they both
are now, the n there are no more reco rds in that direction in the file. That is, there are presently
no records in the file before the current record on the screen , and none after the current record
on the screen.
Below the book icon is the word " Records:" , and then, again, the number 1. This number
always represents the total number of records in the database file, regardless of the status of a
find command which selects a subset of the ftle , as will be di scussed in a later chapter. Finally,
to the right of the book is a vertical bar. When more records are in the database, and more than
one are available in the current browse view, you will see a slider appea r. This slider may be
used to jump to records.

WHAT

TO Do

WHY

You

ARE

DoiNG

Figure 15 .42
The book icon tells you the
number of available
records in the file.

IT

You are now ready to add another record to the database
file .
Pull down the Edit menu.

This menu contains the command for adding a new
record.

Drag the mouse down to select the New
Record command.

This is the command for adding records. It may be executed by using the XN key.
Figure 15 .43

t:ut
[OPIJ
l'os f e

:•:H

:•:C
:•:lt

[ ll'ftf
Sele< tAll
t>osf <i m11 o
l'osf e llafe

fJil'W JndPH •••
Rt>ploce
RPIOokup

Duplicate
Delete Record
Delete Multiple
Omit RPcord~ •••

:•:fl
:•:'

:•::•:1
:•:·

XD
XE

:•:O

The Edit menu has been
pulled down and the New
Record command selected.
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Execute the New Record command. A new, e mpty record
will be placed into the file.

Release the mouse button.

Note that the first field of the record has been selected
fo r input. Also note that the book, at the left of the layout, now indicates that there are two records in the file.
You can also see that the top page of the book has "writing" on it, meaning that there is at least one record in the
database fi le available to you in front of the current
record. Finally, note that a sl ider has appeared at the bottom of the slide bar to the right of the book.
Figure 15.44
A second record has been
created for the file . Note
that the top page of the
book at the left of the
screen now has writing
on it.
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File Edit Select Gadgeh Format Custom Window
lnuento File

B!
-2

Records :
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l•ftMoryc.4e
DuortptiM
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The-

I

AFI03 [TAB]

Try to enter a duplicate part number. FileMaker will display an error message (Figure 15.45) .

Figure 15.45
The Inventory Code field
was set up to be unique,
meaning that the file
should not contain more
than one record w ith any
specific Inventory Code.

lnuentory File
........tory Code

lA I"l u~
OM-------~·-

D-

~

" lnuentory Code" Is defined to
contain unique ualues only. Allow
this duplicate ualue7

00

(cancel)
J

C lick on the Cancel button .

You do not want to add a duplicate part.

Double-click on AFI03.

Select this code so that it gets replaced.

PL208 [TAB]

E nter the second Inventory Code.

Hack Saw [TAB]

Enter the Description.

7 .92 [TAB]

Enter the Cost.

3 [TAB]

Enter the Quantity On Hand.

-.
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7 [TAB]

Enter the Minimum Stock level. Note that the field Reorder now states "Reorder" rather than " OK" s ince the
number of units in stock is below the minimum desired
level.
Figure 15.46
The Reorder field now
displays " Reorder".

.......,..., C4Hie

DenrlpdM

OwCest
Qe•tlty0•"-'11
Mooi•••Btoolt

..........

Luton...

5/27/86 [TAB]

Enter the Last Order date.

Pu ll down the Apple menu, select the
Scrapbook DA and release the mouse
button.

You are now going to get the picture of the Hack Saw out
of the Scrapbook file.

Click on the scroll bar until the picture
of the Hack Saw appears.

Locate the graphic of the Hack Saw.

XC

Copy the graphic to the Cli pboard.

Click on the Close box at the top left
corner of the scrapbook title bar.

Put away the scrapbook file .

Cl ick the mouse in the a rea of the picture field.

When you executed the scrapbook, the data entry mode
of FileMaker was interrupted . Clicking on a field entry
location re-activates the data entry mode.

XV

Paste the Graphic into the picture field.
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Create a new record .

:.1

Figure 15.47
The second record is
complete.
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BT400 [TAB]
Step Ladder [TAB]
39 .95 [TAB]
2 [TAB]
l [TAB]
4/30/86 [TAB]

Enter the text information for the third item.

Pull down the Apple menu, select the
Scrapbook DA and release the mouse
button.

You are now going to get the picture of the item out of the
Scrapbook file .

Click on the scroll bar until the picture
of the Step Ladder appears.

Locate the graphic of the Step Ladder.

XC

Copy the graphic to the Clipboard .

Click on the Close box at the top left
corner of the scrapbook title bar.

Put away the scrapbook file .

Click the mouse in the area of the picture field.

Re-activate the data entry mode.

XV

Paste the Graphic into the picture field to complete the
third record .

Figure 15 .48
The third record of the
Inventory File is complete.

r

.,

File Edit Select Gttdgoh Format Custom Window
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Rocords :
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79.9

Tetai~-MY

186.88

XN

Create a new record.

RM305 [TAB]
Hammer [TAB]
8.91 [TAB]
4 [TAB]
3 [TAB]
51I /86 [TAB]

Enter the text information for the fourth record of the
file.

Pull down the Apple menu, select the
Scrapbook DA and release the mouse
button.

You are now going to get the picture of the item out of the
Scrapbook file .

Macintosh Productivity Tools

Click on the scroll bar until the picture
of the Hammer appears.

Locate the graphic of the Hammer.

~c

Copy the graphic to the Clipboard.

Click on the Close box at the top left
corner of the scrapbook title bar.

Put away the scrapbook file .

Click the mouse in the area of the picture field .

Re-activate the data entry mode.

~v

Paste the Graphic into the picture field to complete the
fourth record.

~------------------------------------------------------~~~

Figure15.49
The fourth record of the
Inventory File is complete.

.._.,c.- IIIY13os
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~N

Create a new record.

JTl31 [TAB]
Paint Brush, 4" [TAB]
2.75 [TAB]
24 [TAB]
35 [TAB]
7/22/86 [TAB]

Enter the text information for the fifth record of the file.

Pull down the Apple menu , select the
Scrapbook DA and release the mouse
button.

You are now going to get the picture of the item out of the
Scrapbook file.

Click on the scroll bar until the picture
of the large paint brush appears.

Locate the graphic of the large paint brush.

~c

Copy the graphic to the Clipboard .

Click on the Close box at the top left
corner of the scrapbook title bar.

Put away the scrapbook file.

Click the mouse in the area of the picture field.

Re-activate the data entry mode.
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XV

Figure 15.50
The fifth record of the
Inventory File is complete.

Paste the Graphic into the picture fie ld to complete the
fifth record.

a

File

Edit

la'ftMONYCMe

IJT131

~ ~~~E~6~~~~~~~4•r===============~

Rocords :

:5

O...Cest

12.75

G•Mtltyo• .._.

124

....._SIMk

135

IIHrHILut OrMr

I
I
I

Reorder
~r>ml1~----,

11MI·-

v.a..

66

, ......ftMOry

288.52
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Create a new record.

JT031 [TAB]
Paint Brush, I " [TAB]
2.05 [TAB]
15 [TAB]35 [TAB]
7/22/86 [TAB]

Enter the text information for the sixth record of the file.

Pull down the Apple menu, select the
Scrapbook DA and release the mouse
button.

You are now going to get the picture of the item out of the
Scrapbook file.

Click on the scroll bar until the picture
of the small paint brush appears.

Locate the graphic of the small paint brush.

XC

Copy the graphic to the Clipboard.

Click on the Close box at the top left
corner of the scrapbook title bar.

Put away the scrapbook file.

Click the mouse in the area of the picture field.

Re-activate the data entry mode.

XV

Paste the Graphic into the picture field to complete the
sixth record.
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Figure 15.51
The sixth record of the
Inventory File is complete .
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You a re now done e ntering the initial information into the Inventory file.
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1 5.8 LOOKING AT YOUR FILE

Now that you have the information you want in your file , you can begin to make use of it. The
most fundamental thing you can do with your database is to look at all the information it is
presently holding. The typical database management program will spew back the information it
is holding in the order it is entered, and FileMaker II is no exception. This order is called the
physical order of the data. If you had entered the information into the part file in part number
order, then it would be listed in part number order. As it is, the information in the part file will
be displayed in the order in which it is presently found in the file.
The easiest way to look at your information is to browse through it by clicking the mouse on
the pages of the book at the left side of the Inventory File window. This book now shows the top
page as being "written" on, the bottom page blank, and the number 6 on the center page.
Recall that the written-on pages of the book indicate there are more records in the file in that
"direction," and that a bla nk page means there are no more records in that particular "direction "
in the file. Thus, the blank page at the bottom of the book in Figure 15.52 means that there are
no more records available in the file after the one we are looking at. However, the written-on
page at the top of the book suggests that there are records to be found by looking before the
current record.

WHAT

To Do

Click on the written-on page at the top
of the book.

WHY

You ARE DoiNG

IT

You may use the book to browse through the database file
one record at a time. By clicking on the top page of the
book you should now see record 5 in the window.

Figure 15.52
The book at the left side
of the file's window.

r

•

File

Ed

I

Rtoords:
6
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Figure 15.53
The book indicates that
you are looking at the fifth
record of the file. Note the
location of the mouse
pointer. This is where it
was clicked to browse
backwards in the file.

File E

II

Rooords:
6

Note that the book now has both the top and the bottom
pages written on, indicating that there are records both
before and after the current record. Also, note that the
slide on the slide bar has moved up from the bottom.

Figure 15 .54
Note the position of the
mouse pointer on the slide
control.

Figure 15.55
The slide control was
" grabbed" by the mouse
when the mouse button
was pressed.

,. •

Move the mouse to the slide control.

You want to go directly to the first record of the file. You
will do this by d ragging the slide to the top of the slide
bar.

Press and hold the mouse button.

When you press the mouse button, the slide control will
turn white (Figure 15.55), indicating that you have properly positioned the mouse to move the slide.

Drag the slide up to the top of the slide
bar.

As you drag the slide control up, the current record number in the center of the book will change. When the slide
control is at the top of the slide bar, the record number
will read I .

Release the mouse button.

While the record number changed, the record being displayed did not. Releasing the mouse button will tell FileMaker to display the desired record, number 1 in this
case.
You may select any record in the file in this fashion by
releasing the mouse button when the desired record number is displayed in the book .
You should now note that the book shows the top page
blank, and the bottom page written on. This means that
there are no more records earl ier in the file to look at ,
but that there are some later in the file.

Figure 15.56
The book now appears as
it will when you are
looking at the first
available record of the
database file.

,. •

File E

Rooords:
6
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1 5.9 A SECOND WAY TO LOOK AT THE FILE

There may be times whe n you will want to look at, or use , the data in a different format than the
layout you first created. Frequently, it is desirable to look at the information in a column form .
FileMaker lets you create multiple layouts for your database files. You will now make a column
layout for the Inventory file you have created.

WHAT

To Do

W HY

You ARE DOING IT

~L

The Layout command. Remember that this command is
found on the Select menu.

Pull down the Edit menu.

Near the bottom of the Edit menu you should now see the
command New Layout. This command has replaced the
New Record command, since you are working in the layout mode, rather than the data entry mode. As you use
FileMaker, note that the commands on the Edit menu
change to reflect the current mode you are using.

Drag the mouse down to select the New
Layout command.

Note that the New Layout command can be executed with
the ~N key.
Figure 1 5 .57
The New Layout command
has been selected.
(U t

:•:tl

[Oilfj
Peste
[IPIIr
Select All
l'llSI 6 01110
PllSi e 0<116
UiPill I OdPH .•.
RPploce
RPiookup .

:•:c
acu

Duplicate
Ot~ IP tP l <1yout
OPIPtP MultipiP
Omit RPcord~...

Release the mouse button.

8CR

:·:·
:•::•:I

:•: ..

:•:E
:•:O

Execute the New Layout command. You will now see the
New Layout dialog box.
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Click on the Columnar report layout
button.
Figure 15.58
The New Layout dialog
box. The Columnar report
layout button has been
selected.

You want to build a columnar report.

Cr eate a new layout which Is a:

0

Standard layout

<11 Columnar report layout

0 Label layout
0

Blank layout

Click on the OK button.

Create the new layout. You must now select the fields you
want to appear in the columnar report, and the order you
want them placed on the layout.

Click on Inventory Code in the Field
List window at the left of the dialog
box .

This is the first field you want to include in your columnar layout.

Figure 15. 59
This dialog box lets you
select those fields you
want to have included in
the columnar layout. Here,
t he Inventory Code field
has been selected.

Field List
"'!;
Description
Our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order
The Item

Click on the Move button.

Figure 15.60
The Inventory Code field
w ill be the first field in the
columnar layout. The Clear
button is now active in the
dialog box . Clicking it will
clear all fields from the
Field Order list at the right
of the dialog box.

Field Order
(II.' or

I'F'~!h

(» Moue » )

·~~~'I

:a

OK

~~
!!!!

[)

Cancel

Copy this field name into the Field Order list at the right
side of the d ialog box. You may double-click a field in
the field list to select and move it to the field order list
automatically.

Field List
lnuentory Code
Description
our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order
The Item

;!:!:

Clear
M~ l.'

OK
Cancel

Field Order
lnuentory Code

Macintosh Productivity Tools

C lick on Description in the Field List
box on the left.

You want to add this field to the columnar layout.

C lick on the Move button.

Place the field into the Field Orde r box.

Click on lhe Our Cost fie ld in the left
box.

You want this field in the new layout.

Click on lhe Move button.

Place the field into lhe Field Order box.

Click on T he Item field atlhe bottom of
the left box.

This is the picture field. You want to place it on the new
layout.

C lick on lhe Move button.

Place lhe field into the field orde r box.

Figure 15.61
Field List
lnuentory Code
Description
Our Cost
Quentlty on Hend
Minimum Stock
Reorder
Lest Order
The Item

Cleer

;!::!

:I Lii~

j

(

OK

)

Cencel

)

Click on lhe OK button.

r

These are the fields you
have selected for the new
layout.

You do not want to place any more fields on this layout at
present. The new layout will be displayed on lhe screen.

.,

~ File Edit Select

Figure 15.62

The layout has been
created. Note that the
book at the left of the
layout has a 2 on the
center page. You are
looking at t he second
layout. You may browse
through the layouts you
create in the exact same
fashion as you would
through the records.

Lfleld. .. .;J

!fi-JI___ ..

Field Order
lnuentory Code
Description
Our Cos.t
~he Item

:

,•

::
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This is the Browse command fou nd on the Select menu.
You are leaving the layout description mode and returni ng
to the data entry and view mode using the current layout.

XB

Figure 15.63
The initial column layout
you have created.

.,

" li File Edit Select G11dgeh rormut Custom Window

,..
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Rocorcls:
6

l nuento

File

.laD!!SnY£dl.
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AF103
Pl208
BT400
~305

HandSaw
Hack Saw
Stepladd&r
Hanmer

JT131
JT031

Palrt Brush, 4"
Palrt Brush, 1"

13.87
7.92
39.95
8.91
2.75
2.05
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n1
@?"

·~

II

liiil

Cl,

~

Look at the picture field at the right side of the layout.
The pictures are all squashed into the default space fo r
the field in the layout.

Figure 15.64
Note the location of the
mouse pointer.

XL

Return to the Layout mode, you are going to fix the
appearance of the pictures.

Move the mouse to the word Body found
at the left edge of the layout.

The Body line controls the spacing between each record
when you return to the Browse mode.

Drag the Body line down about an inch
and a quarter.

To drag the body line, press and hold the mouse button.
then drag the mouse down.

Figure 15.65
Drag the Body line down
to about this point.

" li rue Edit
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Release the mouse button.

,. •

r~sa

File Edit

Select

When you release the mouse button , the white space representing a single line on the column layout will expand.

Format

Custom Window

,

Figure 15.66
The space for a single line
of the body has been
expanded.

...

Move the mouse to the handle at the bottom right of The Item fie ld .

Recall that the handle at the bottom right of the field
space in the layout lets you adjust the shape of the field.

Drag the handle down to the Body line.

You want this field to fill the vertical space you have
created.

Click in the middle of The Item fie ld
space.

Select the field. To change how the picture is formatted
in the field, you must select the complete field.
Figure 15.67
The Item field has been
selected. Note the shape
of the field.

Pull down the Format menu , select Format Picture and release the mouse.

You are now going to tell FileMaker that you do not want
the picture adjusted to fit the space.

Click on the Show as much of the picture as fits button.

Recall that thi s button tells FileMaker to use the field as
a wi ndow over the picture, and not to adjust the picture
to fit in the window.
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Click on the OK button.

Retu rn to the Layout screen.

XB

Return to the Browse mode. Note that the pictures are cut
off in their fields. The field space created here is not as
large as the one initially created when this file was
started. If you want to see the complete picture you must
make the field larger, or you must change the fo rmat for
the picture field back to its original status. The pictures
will then be distorted, but you will see the whole picture.

Figure 15.68
The modified Browse
display of the file.

r

a

File Edit Select

G<tdgeh

rormn t

lnuento

Custom

Window

.,

File

Rooords :

'
Pl208

Hack saw

7.92

BT400

Step Ladder

39.95

You may click on the book at the left side of the window
to scroll through the database, or you may use the standard Macintosh scroll bar found at the right side of the
window.
XL

Return to the Layout mode.

Click on the top page of the book.

You want to return to the original file layout. Just as
clicking on the book when in Browse mode scrolls
through the records, clicking on the book in Layout mode
scrolls through the file's layouts. You should now have
the original layout back on the Macintosh's display.

XB

Return to the Browse mode.

-

15.10 EDITING/MANAGING THE DATA IN YOUR
DATABASE FILE

Keeping the information in your database accurate and up to date is very important. If you are a
decision maker, and if the database you are using does not have correct information, you cannot
make correct decisions. (Your decisions may be purchase decisions if your database is you r
company's inventory. If your database is a birthday list with the last present you bought people ,
then you will be deciding on the next present you buy.) Surely, one of the most important
activities involving the use of a database is correcting and updating the information it contains.

Macintosh Productivity Tools

As you w ill see in a later chapter, it is possible to remove unwanted records completely from the
database. Right now, however, we will content ourselves with editing the database you have
created .

WHAT

To Do

WHY

You ARE DOING IT

Drag the slide on the slide bar to the
first record.

You want to change the first record of the database.

Click the mouse on the word Hand in
the Description field.

You want to change the description to read "Saw, Hand".
Start by selecting the field.

r

a

File Edit Select Gadgeh Formet Custom Window
lnuento File
--

Double-click on the word Saw.

.,
~~

Figure 15.69
The Description field of
the first record has been
selected.

Recall from what you learned about word processing that
double-clicking on a word will select the word. Saw, and
the remainder of the field, will be selected.
Figure 15.70
The word Saw has been
selected.

~wMwyC~
='A~F1=0~3================•-==:J
DesOI'Iptl-.
OwCest

Remove the selected text with the Cut command from the
Edit menu.
+- +- +- +- +-

Position the cursor in front of the word Hand.
Figure 15.71
Note the posit ion of the
vertical cursor in front of
the word Hand in the
Description field.

3€V

Paste the word you cut back into the description at the
new location.

, [SpaceBar]

Add a comma and a single space to complete the edit of
the field.
Figure 15.72
Th e Description field for
the first record has been
edited.
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Click on the bottom page of the book.

You want to edit the next record of the database file. This
is the record for the Hack Saw.

Double-click on the word Saw in the
Description field.

You are going to perform the same edit. Select the word
Saw.

XX

Cut the word from the field .

+- +- +- +- +-

Position the cursor in front of the word Hack.

XV

Paste the word you cut back into the description at the
new location .

, [SpaceBar]

Add a comma and a single space to complete the edit of
the field.

Figure 15.73
The Description field for
the second record has
been edited.

' c
i

•;-

File Edit Select
.

Gt1dge h

Form11t custom

lnuento

Window

File

~1t
~

You should realize that you may edit the records of the database using any legitimate Macintosh editing technique. Thus, you may drag the 1-beam cursor over text you want to replace or
dele te . Or you may position the cursor with the mouse, clicking the mouse button to insert the
cursor in the desired location . As you have seen , the standard Edit menu commands of Cut and
Paste are available, as well as the Copy command if you want to duplicate information from one
field to anothe r, or from one record to anothe r.

-

1 5.11 PRINTING YOUR DATABASE FILE

W hile being able to have rapid access to the data on the computer is frequently e nough for most
uses, there are many times when you will want to have a printed copy of the info rmation at which
you are looking.
If you do not have a printer attached to your computer, executing the Print command will not
ha rm you or the database, but it will waste some of your time while the computer looks for the
printer (if you are using a LaserWriter) or attempts to print (if you are using an ImageWriter).
You may, of course, execute the Preview command without a printe r attached to your machine.
FileMaker formats the output to match the current layout in use. Since you are presently
using the original layout , that is the for mat in which the file will be printed. If you want to obtain
a columnar report, the n you must switc h to the columna r layout that you created .

Macintosh Productivity Tools

WHAT

To Do

WHY

You

ARE DOING IT

Pull down the File menu .

The File menu has both a Print and a Preview command.

Drag the mouse down to the Preview
command .

Before you print the database, use the Preview command
to see what it will look like on the printed page. Note that
you can execute th is command with the XU key.

~Edit

Figure 15.74

Select
New ...
Open •••
Close
Password •••
..IEHCIUSIUe

The Preview command has
been selected .

xw

Paper Sizes •••
Page Setup •••
XP
Print •••

Input From •••
output To •••
Saue a Copy •••
Recouer •••
Quit

Execute the Preview command.

Release the mouse button.

Edit

XQ

,

Select

The initial Preview screen.

Preulew:

••-...,c.Descrlplleol

Ow Cost
Q•-tlty 0. HaM
......._SIHt

lleerdw

L-Ooder

Figure 15.75

AF103
Saw, Hand
13.87
6

(NeHt Page)
(PageJI•I
OReduced

5
OK

5115186

~
(

EHit
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It is difficult to tell much from this initial prev iew screen.
There is, however, a Reduce check box that will make the
preview fit on the screen.

Click the mouse on the Reduce check
box.
Figure 15.76
Th e reduced page preview
gives you a better idea of
what the printed page will
look like.

r •

You want to look at a complete page at once.

----·
-· -=----·
-- -'=it:J
-..
-=~

Click on the Next Page button.

.,

Edit Select Gadgeh rormot eustom Window
lnuentory File
Preulew:
(NeHt PegeJ
[PegaJI•I
~Reduced

[Hit

Look at page two of the Preview. Continue clicking on
the Next Page button until the third page is reached.
When the last page has been reached , the Next Page
button will dim. You can also see that there is not a
Previous Page button. It is, however, possible to return
the Preview to a prior page.
Enter a I mto the box to the right of the Page button.

.,

Figure 15 .77
You are telling the Preview
command which page you
want to look at next.

Preulew:
(Nt~llt Potjl' )

(Pege)ill]

181 Reduced
Click on the Page button.

After a brief wait, the fi rst page of the print preview will
be displayed. You may use the page numbe r box and page
button to move around large reports by selecting the page
you want to see and then clicking on the Page button.

C lick on the Ex it button.

Leave the print Preview.

XL

Select the Layout mode.
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Click on the bonom page of Lhe book.

You want to use the second layout that you created.

xu

Execute the Preview command . You do not have to return
to Browse mode to print.

~

Edit

Select

Gadgets

Fonnat

.,

custom Window

r!l File

-- - --

..

~

Preulew:

(Nett t l'oge )

n:::

•

(PageJI•I

..

181 Reduced

~

Figure 15.78
The Preview of the file in
the second layout you
created. Since you earlier
checked the Reduce box,
this preview is already
reduced. If you click on the
Reduce box now, the
Preview will expand back
to full size.

(Hit

i

I
..

~

Click on Lhe Exit button.

Return to the Layout mode.

Pull down the File menu, select Lhe
Print command and release Lhe mouse
button.

Now you are ready to print your database. You want to
pri nt the current layout. As with many other Macintosh
programs, the Print command may be executed with the
XP key.
You will now see the Print dialog box. If you are using
an ImageWrite r, your Print dialog box will appear similar
to Figure 15.79. If you are using a LaserWriter, your
Print dialog box will appear similar to Figure 15.80 on
Lhe next page, although Lhe name of the LaserWriter will
probably be differe nt from the name of the printer in this
figure.

lmageWriter
Quality:
Page Range:
Copies:
Paper Feed:

0

Best
® Rll

®Faster

0 Draft

0 From:

To:

®Automatic

O Hand Feed

0

Number pages from:

D

D

X
2.7 ··-·O•IC-~J
(Cancel J

E:J

Print: ® Records being browsed
0 Current record
0 Blank record, showing fields with: ® BoNes
0 Field definitions

0

Undertlnes

Figure 15.79
This is the dialog box you
will see if you are using an
Image Writer.
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Figure 15.80

This is the dialog box you

LaserWr lter "LaserWrlter II"

will see if you are using a

Coples:l • l

Pages: ® All

Couer Page:

® No 0 First Page

LaserWriter.

:1.2

Paper Source: ® Paper Cassette

0
0
0

From:

(

OK

J

CJ To: CJ (Cancel )

Last Page

Help

Manual Feed

Number pages from: ~
Print: ®Records being browsed
0 Currant record
0 Blank record, showing fields with: ® BoHes
0 Field definitions

0

Underlines

For both types of printers, you can see that the options at
the bottom of the Print dialog box are the same. Do not
change anything since you want the complete database
file printed.
Click on the OK button.

Execute the Print command.

-..... --·- --

Figure 15.81

This is the output
generated by the Print
command above.
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15.12 FINDING HELP

File Maker has an o n-line help facility. He lp is found in the file called FileMaker He lp. This file
may be accessed at any time w ith the Help command.

WHAT

To Do

Pull down the Apple menu.

WHY

You ARE DOING

IT

The Help command is found on the DA menu.

Macintosh Productivity Tools

You can see that Help can be accessed by using the
3€/ key.

Drag the mouse down to select the
Help ... option.

,. 11:1 File
Iii

Edit Selec
Rbout FlleMalcer ••• )\

Figure 15.82
The Help option on the DA
menu has been selected.

Sulttase II
X IC
Calculator+
Camera
Chooser
Control Panel
Dlsklop
Find File
Key Caps
Scrapbook
SmartScrap'"

Release the mouse button.

Look at the initial help display. This dialog box gives you
a brief overview of using FileMaker.

Click on the Open Help File button.

If the overview does not give you enough information,
then you may open the Help file by clicking on this
button.

Pull down the Custom menu.

This menu lists a variety of topics. Select the one you
want, and FileMaker locates the correct records in the
Help database file.

Drag the mouse down to Defi ning
Fields.

You want the help fo r this topic.

Window

,

Figure 15.83
The Custom menu as it will
appear when the Help file
is active. Defining Fields
has been selected.

Rddlng and
•6
Finding Records
Sorting Records
X7
Rrranglng Information
XB
•9
Printing and Preulewlng
EHchanglng Data Between Flies
Rutomatlng Commands
Keyboard Shortcuts
FlleMalcer on 11 Network

Release the mouse button.

Obtain the help for this topic.

Click on the close box at the left of the
FileMake r Help window.

When you are done with help, close the help fi le by
clicking on the close box found on the help file's title bar.
T he Inventory File you have been working with will once
again be active.
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1 5.13 QUITTING FILEMAKER II
You now know how to create a database file, display the contents of the file on the Macintosh's
screen, print the file , and make corrections to the ftle. Unlike the other Macintosh applications
discussed earlier in this text, FileMaker does not have a Save command. Because it is a diskbased database, information is constantly being saved . However, not a ll the data is necessarily on
the disk. Some may be in temporary storage in the computer's memory.
To ensure that all the data is saved, all you have to do is close the file 's window. This is done
by using the Close command on the File menu, or by simply clicking the mouse on the close box
found at the left of the window's title bar. If you are going to then Quit FileMaker, you may
simply quit the program, since that, too, will close any open window.

WHAT

To Do

Pull down the File menu and select the
Quit command at the bottom.

WHY

You ARE DotNG /r

Since you are going to quit, let the Quit command close
the database file window for you.

Figure 15.84

The Quit command has
been selected.

Peper Sizes ...
Page Setup ...

Print...

88P

Preulew •••

XU

Input From .. .
Output To ...
Seue a Copy ...
Recouer •••

Release the mouse button.

Execute the Quit command. After a brief pause, you will
return to the Macintosh Finder.

EXERCISES
I . When defining a database file , must you tell FileMaker the type of data that a field will contain, or do you let the program
figure this out for itself?
2. When defining a database file, must you tell FileMaker the number of characters or digits to allow for a specific data
field?
3. When you list or browse through you r database file, in what order will the records appear?
4. After you have entered information into your database file, is it possible to make changes to the data, or are you stuck with
the information you entered?

Macintosh Productivity Tools

5. Create a database, called MAIL LIST, with the following information/fields:
Last Name
First Name
Street Address

City
State
Zip Code

6. Enter the following information into this database:

7.
8.
9.
10.
11.

LAST NAME

FIRST NAME

ST. ADDRESS

CITY

ST

SMITH
JONES
RABINOWITZ
SMITH
PETRO
ALEXANDER
DOE
ZABRISKI
KIELLOR

FRED
MARY
ABE
MAY
CAROL
JOAN
JOHN
FRED
ARNOLD

123 ANY ST
398 LOW AV
12 KILLDEER
317 E. 32 ST
812 MAYNARD AV
873 HIGH ST
931 NORTH ST
120 PARK AVE
205 BOARD WALK

LA
LA
NEW HAVEN
NEW YORK
NEW VILLE
NEW HAVEN
LA
NEW YORK
SMOKE RISE

90200
90313
CT 20913
NY 10019
CA 93013
CT 20915
CA 90203
NY 10017
NJ 07321

ZIP

CA

CA

What data type should the zip code be, numeric or text? Why?
What data type should the street address be, numeric or text? Why?
If a phone number field had been included in this database, what data type should it be? Why?
Make a printed list of the database you have just created.
Create a database, called VENDORS, with the following information/fields:
Vendor Code
Company Name
Address
City
State

Zip Code
Phone
Name of Contact Person
Date of Last Purchase

12. Enter the following information into this database:
VENDOR COMPANY
AAIOO
OA100
SE100
PA100
TTIOO
BA100
BWIOO

ADSANNON

ADDRESS

1333 W CAHUENGA
BLVD
OUTSIDE ADS
451 LOS ANGELES ST
STRAWS, ETC
1705 W. 28 ST
PAPERS, INC
422 PASS AVE
TRI-TONES
1895 RIVERSIDE
BLVD
BURBANK ARTS 105 ALAMEDA AVE
BARE WOOD
7755 SUNSET BLVD

CITY

ST ZIP

HOLLYWOOD

CA 90068 213/851-6333 JANE

LOS ANGELES
LOS ANGELES
BURBANK
BURBANK

CA
CA
CA
CA

BURBANK
HOLLYWOOD

CA 90059 818/512-1212 MONTY
CA 90068 213/876-4673 DAVE

90007
90007
90059
90059

PHONE

213/746-1212
213/473-7677
818/841-5234
818/833-1092

CONTACT

ALEXANDER
DON
ALICIA
ANNIE

LAST
PURCHASE
06/10/87
06/15/87
05/11/87
05/12/87
07/02/87
05/22/87
06/11187

13. Make a printed list of the vendor database you have just created.
14. What order are the records of the vendor database printed?
15. Is there a relation between the order the vendor records are printed and the vendor code? Why or why not?
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CHAPTER OBJECTIVES:

Upon completion of this chapter, the stude nt will:

• Define the difference between the logical order
of records and the physical order of records in
a database file.
• Make a sorted list of a database file.

• Select specific records of the database for
listing.
• Select specific fields of the database for listing.
• Delete records from the database.

-

1 6.1 WHY USE A DATABASE MANAGEMENT SYSTEM
REVISITED

A pri mary reason for using a database ma nagement syste m is to give you easy access to the
information maki ng up your database. In the last chapter you learned how to open a database
file , how to enter information into that file a nd how to list back the information in the file, both
on the computer's display and on the printer.
While these procedures a re useful , you will rare ly find that you always have the data in the
order you want it. For example, you may have a database with people's names entered in
alphabetical orde r by last name. This may be fine for most of your purposes. However, when you
run a mailing list from thi s database, you will want the labels printed in z ip code order. In this
chapte r you will learn how the data in your files may be reordered.
To ca rry the example above a little further, assume that your database consists of more than
100,000 names of people from all over the United States. You may want to send out a mailing to
only those people livi ng in a specific city or sta te. This chapte r will teach you how to enhance
your use of the database management syste m through record selection procedures to accomplish
such tasks.
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1 6.2 REARRANGING THE RECORDS OF THE DATABASE

In Chapter 15 you created a database that contained stock item codes and some related information. You did not enter this data in strict code number order. The first item code number was
AF103, the second PL208, then BT400, RM305 , JT131 and JT031. This order of information is
the physical order of the data. As you could see when you browsed through or printed back your
database, the records were listed by the physical order in which they were entered.
The present order of this file, however, makes little or no sense. The file is not in item code
number order, nor is it in cost order, nor in order by any other field!
There are two methods of rearranging the data that are generally employed by database
management systems-sorting and indexing the data.

-

1 6.3 SORTING THE DATABASE

Sorting the database is the process of physically reordering the information. The sort is based on
a sort key, which is a field or combination of fields in the database, such as the last name field.
Sorts may be in ascending order (smallest to largest) or descending order. When you use a
database. management system that sorts the database, you will see that frequently it will create a
second copy of the file in sorted order. If this is the case, you should always check to make sure
that the disk you are using has sufficient free space before you continue. You must have at least
as much empty space on the disk as you have space in use by the files you are going to sort,
because the sort procedure will double the space requirements on the disk. FileMaker, however,
does not sort in this fashion.

-

1 6.4 INDEXING THE DATABASE

The indexing process is also based on a sort key. When a database management system indexes a
file , it creates and manages a separate index of the data. This index tells the program what order
to use records in the data file.
One useful result of indexing files rather than sorting them comes from the fact that the
records in an indexed file do not change their physical order.

-

1 6.5 THE RELATIVE ADVANTAGES OF SORTING AND
INDEXING

Both methods of rearranging the records in your database file have their own relative advantages
and disadvantages.
The main advantage of sorting a large database is that the new physical order Jets you access
the info rmation in the file sequentially (that is, in the sorted order) and very rapidly. The disk
drive does not have to work hard to scan through the records.
The problem comes when you add a new record into the database file. If the new record is
added onto the end of the file, it will most likely not be in the correct sorted location . Thus, to
process the data, you will have to sort the file again. For large database files, the sorting/
resorting process can take a long time.

Macintosh Productivity Tools

Some database management programs let you insert records into the middle of the file.
When you do this, the database management program must first add a new record onto the end of
the ftle, then shift all the records that follow the desired location of the new record "down" one to
make space for the new record in the middle of the file. Depending on the size of the file and the
location of the new record, this can be relatively time-consuming. Regardless of the time this
process must take, you are the one who must determine the proper location in the database for the
new record. If you are careless and put the new record in the wrong location in the file, you will
either have to re-sort the ftle, or in some other fashion rearrange the records to get them into the
correct order. FileMaker, however, always adds new records onto the end of the database.
Indexing overcomes the problem of the new record. When you add a new record to an
indexed file, the database manager will update the file's index so that the new record appears
immediately in the proper "location," even though the record is usually added physically to the
end of the file. You do not have to worry about your skills at alphabetizing, because the computer is taking care of this task for you.
Indexed files, however, are not ideal for sequential processing. The disk drive's read/write
heads must constantly be moved between the index and data to locate the next sequential record.
Thus, while the update time required is less when using an indexed file, sequential access of the
indexed file is generally slower than sequential access of a sorted database.
FileMaker performs an operation that is partially indexing and partially sorting. When you
sort the file, the records retain their original location in the database in the fashion of an index
file. Thus the file can be "unsorted" if you want. However, unlike a true indexed file, when a
new record is added to the file, the sorted list is not updated automatically.

-

1 6.6 RETRIEVING A DATABASE FILE

After you boot your Macintosh with a System Start-Up disk, insert the FileMaker II Program
disk into one of the computer's disk drives. If you are using a machine with a hard disk you will
not need to insert the FileMaker program disk into a disk drive. Rather, locate the FileMaker
folder, and open it so you can see the FileMaker program icon. Place the data disk you used with
Chapter 15 into another one of your Macintosh's disk drives, if you have one available. If you do
not have a free floppy disk drive, keep this disk available.
In these instructions, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase "Double-click the mouse on ..." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed.
There are three ways to open an existing database file when using FileMaker II.
First, you may double-click on the file's icon on the storage disk. The Macintosh will figure
out which application program created the ftle and will automatically launch the program for
you. This will only work, however, if the program can be found in one of the computer's disk
drives. If you are using a floppy disk-based computer, you may not always have the program disk
in a disk drive, so this method will not work for you. If you have two floppy disk drives, it is
possible to launch an application from one of it's documents if you eject the System Start-Up
disk, and replace it with the program disk, leaving the document disk in the second disk drive.
You will find, however, that the computer frequently requires information off the Start-Up disk,
and that you will do several disk exchanges before the program is running. It is best to start the
application, and then open the document.
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Figur e 16.1
This is the icon you will
see for FileMaker database
files.
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Indeed. this is the second method for opening an existing database file. When you launch
FileMaker you will immediately see the Open dialog box. You may recall when you fi rst started
FileMaker at the beginning of Chapter 15 that you were asked for a file , even though you had not
yet created one. This was the Open dialog. Once FileMaker is running, you may use the Drive
and Eject buttons on this dialog box to select the disk that has your file , and then open that fi le.
The third method available for opening existing files is to use the Open command found on
FileMaker's Fi le menu. This command will return you to the Open dialog box you are familiar
with to let you access your database files. The advantage of this command is that you may open and
use multiple files. Clearly, to use this option, you must first launch the FileMaker application.
If you are using a computer with a hard disk , begin here:

WHAT

To Do

WHY

You ARE DOING IT

Locate the icon for the database file you
created in Chapter 15 and place the
mouse pointer on it.

You are going to launch FileMaker by double-clicking on
this icon. Figure 16. 1 shows the icon that FileMaker creates for its database files. The name of this particular one
is Inventory file.

Double-click the mouse.

By double-clicking on a FileMaker database, the Macintosh will look on all available disks for the FileMaker
application program . If found. it will launch FileMaker
and open the database. If the Macintosh is not able to
locate the application program, you will see the dialog
box shown in Figure 16.2.

Figure 16.2
You will see this dialog
box if the Macintosh is
not able to locate the
FileMaker application
program to open the file
you are double-clicking.

The file " lnuentory File" could not be
opened/printed (the application Is busy
or missing).

~

Figure 16.3
The retrieved datab ase will
return in the layout you
last used.
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If you have the FileMaker application program on your
hard disk, or on a floppy disk currently in one of the
computer's disk drives, the program should start, and
after a brief wait, the database you prepared during the
last session will appear. You are now ready to work with
the file (Figure 16.3).
XQ

This is the Command Key equivalent for the Quit command found on the File menu.
You are quitting now so that you can learn how to use the
Open command. Normally, you would not quit the FileMaker program after you open the file you want to use!

If you are using a computer that has only floppy disks, then start here:
Locate the icon for the FileMaker
program.

You will launch the FileMaker application program by
double-clicking on it.

Move the mouse to the FileMaker icon
and double-click.

The double-click will launch the application. If you have
trouble with the double-click, you may also select the
program's icon with a single click, then use the Open
option on the File menu, or press XO, the Command
Key equivalent.
After a brief wait, FileMaker will be running , and you
will see the Open dialog box.

Click on the Cancel button

Do not yet open a file.

,. It File Edit Sele< t Gadgeh Format Cu~tom Ullndolll

Pull down the File menu.

.,

The File menu has the Open command.

Figure 16.4
Your Macintosh after you
have cancelled the dialog
box. All that is showing is
the current menu bar, with
all the Menus dimmed,
except for the File menu.
If you are using
MultiFinder, you may have
other items showing on
the desktop.
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Drag the mouse po inter down to the
Open command.

T he Open command lets you open existing database files
found on disk. Unlike many othe r Macintosh applications, there is no Command Key equivalent for the Open
command.

Figure 16.5
The Open command has
been selected.

l>oper Siz e~ ...
l>oge Se tup •••
:•:P
l>rint ...
l>n..ulew ... :•:U
Input From .••
Output To ...
Sa1•e a Copy ••.

Rec:ouer•••
Quit

Release the mouse button.

XQ

Execute the Open command.
After a brief pause , you will see the Open dialog box that
you just cancelled. It should appear similar to the one
displayed in Figure 16.6, although the name of the disk
being displayed and the free space on the disk will probably be different.

Figure 16.6
The Open dialog box.
Since FileMaker was
launched from the Hard
Disk, this is the one
showing in the current
dialog box.
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CLick the mouse on the Drive button
shown in the dialog box.

The Drive button tells FileMaker to display the database
file and folder names found on a second disk currently in
your computer. This may be a floppy disk, or a hard
disk. If you do not have a second disk in the computer,
then the Drive button will be dimmed , and you will not
be able to use it.
Continue clicking the Drive button until the name of the
disk that contains your file appears in the dialog box.
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Figure 16.7
After clicking on the Drive
box, the contents of the
disk called MY DATA is
displayed.
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You want to open the database you named "Inventory
File." By clicking the mouse pointer on the name in the
dialog box , you are selecting this database.

Click on Inventory File.

Figure 16.8
The database " Inventory
File" has been selected.

I(g) MY DRTR I
D lntiPflllliiJf iiP
Cl Misc. Things
Cl Spreadsheet Models
Cl Word Processing Docum •••

00

(g) MY DATA
Eject
Drlue

It ]

[ Network )
Open
Cancel

Click on the Open button.

Execute the Open command . After a brief pause while
the computer reads the database, you will see the database displayed in the last layout that you used.
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You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the database name, rather than
selecting it and then clicking on the Open bunon in the
dialog box.
Figure 16.9
The database you created
has been opened and is
displayed in the second
layout that you created.
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16.7 CREATE A NEW LAYOUT

Before you begin sorting the database, you should create a layout that will let you see the
majority of the fields in the database at ail times. This format w ill make it easier to see what is
happening in this chapter.

WHAT

To Do

WHY

You ARE DOING IT

Select the Layout mode. You are going to create a new
layout that will let you see most of the fields in the
database.

XN

You are going to c reate a New layout.

Click on Columnar report layout.

This will be a columnar layout.

Click on the OK bunon.

You must now select the fields you want to include in thjs
layout.

Click on Inventory Code in the Field
List.

This is the fi rst field you want in the layout.

Click on the Move bunon.

Put the field into the Field Order list.

Click on Description in the Field List.

The next field to be added to the layout.

Macintosh Productivity Tools

Click on the Move button.

Put the field into the Field Order list.

Click on Our Cost in the Field List.

The next field to be added to the layout.

Click on the Move button.

Put the field into the Field Order list.

Click on Quantity On Hand in the Field
List.

The next field to be added to the layout.

Click on the Move button.

Put the field into the Field Order list.

Click on Minimum Stock in the Field
List.

The next field to be added to the layout.

Click on the Move button.

Put the field into the Field Order list.

Click on Reorder in the Field List.

The next field to be added to the layout.

Click on the Move button.

Put the field into the Field Order list.

Click on Last Order in the Field List.

The next field to be added to the layout.

Click on the Move button.

Put the field into the Field Order list.

Field List
lnuentory Code
Description
our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order
IJbe Item

~

Clear

M'fl.'
OK

a

File Edit

Figure 16.10

You are done defining this layout.

,

Select

.

__

:

:::.

LFJ.el.d.......
!~~SL

This is the list of fields you
want to include in this
layout.

~

to

Cancel

Click on the OK button.

~

Field Order
lnuentory Code
Description
our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order

. ·:
:

..

Figure 16.11
The layout that you have
created. The Reorder and
Last Or der fields appear
below the Inventory Code
and Description fields. The
layout is too wide to fit on
a page at present.
Depending on your printer,
you may experience a
slightly different initial
layout at this point.
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Figure 16.12
The Inventory Code field
being made narrower.

As you can see in Figure 16. 11, the layout you have created shows two fie lds in the first two columns. The layout
is too wide for the page. This needs to be fi xed .
Position the mouse pointer on the handle
for the Inventory Code field , press and
hold the mouse button.

Recall that the black box at the bottom right corner of the
field box in the layout mode is called the handle and is
used for changing the shape and size of the field.

Drag the handle left until only the word
Inventory shows in the field.

You are making this field narrower.

Release the mouse button.

Complete the change of size fo r this field.

Drag the Description field left next to
the Inventory Code field .

Move the next fie ld left, but do not change its size.

Select the handle of the Our Cost field
and drag it left so only the words Our
Cost show in the field .

Make this field narrower.

Drag the Our Cost fie ld left next to the
Description field.

Move the field over.

Use the scroll bar at the bottom of the
window to s lide the layout left until you
can see the next fields.

You need to be able to see the fields to adjust their sizes.

~

Figure 16.13
The window has been
scrolled so that the next
two fields are in view.

r

,

It File Edit Select

Select the handle of the Quanfity On
Hand field and drag it left so only
"Qua" shows in the field.
Drag the Quantity On Hand field left
next to the Our Cost fie ld.

~

Make this field narrower.

Move the field over.

-
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Macintosh Productivity Tools

Select the handle of the Minimum Stock
field and drag it left so only " Mini"
shows in the field.

Make this field narrower.

Drag the Minimum Stock field left next
to the Quantity On Hand fie ld.

Move the field over.

Drag the Reorder field up to the top line
of fields and place it next to the Minimum Stock Field.

This field must be placed on the first line of the desired
output.

Select the handle of the Reorder field
and drag it left so only Reorder shows
in the field.

Make this field narrower.

Scroll the window back using the scroll
bar at the bottom .

You shou ld now have all the fie lds in view.

,. •

File Edit
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Gadgets Format Custom
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Figure 16.14
All the fields are in view in
the window.
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Select the handle of the Last O rder field
and drag it left so only Last Order
shows in the field.

Make this field narrower.

Drag the Last Order field right and up ,
placing it to the right of the Reorder
field .

Place this field on the same line as the other fields in the
layout.

Move the mouse pointer to the word
Body in the box at the left of the layout.

You are goi ng to change the line spacing.
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Drag the Body line up until only one
line of text for the record is d isplayed.
Figure 16.15
The modified layout.
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Make the layout single spaced .

.,

File Edit Select

•

. .:
LFJ.el.d. ...1 1

.
:

::

; :

f~<f!L __

Select and move the column headings in
the header area of the layout to match
what you see in Figure 16. 16.

The column headings, which come from the field names,
may be moved in a fashion similar to the fields
themselves.

Figure 16.16
The column headings have
been rearranged to be
over the appropriate data.

3€B

Figure 16.17
All the selected
information is now visible
in the current layout.

Leave the Layout mode and enter the Browse mode. All
the selected fields of the data base are now visible.
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1 6.8 SORTING THE FILEMAKER II DATABASE

Now you are ready to sort your database. FileMaker uses an internal index to sort your database.
No new files are created. However, even though an index is being c reated , the term used in the
program is Sort. Do not confuse the term and the apparent outcome with what is actually
happening. When you sort the database with FileMaker, the original physical orde r of the data is
not lost, since you are, in fact, using an index to view the data in a new order. Thus, it is an easy
task to return a FileMaker database to its original order by "unsorting" it , as you will soon see.
More important, the sorted order is not kept up to date if new records are added to the database .
You must then re-sort the file to have it displayed in the desired orde r.

W HAT

TO Do

WHY

You ARE DOING IT

Pull down the Select menu.

This menu has the Sort command located on it.

Drag the mouse down and select the
Sort command.

This command may be executed by the XS key.

G4dge
...-&rowse
Find
Rt>tlnd
Find fill

XB
Xf
>li< R
#&

Layout

XL

Figure 16.18
The Sort command has
been selected.

Denne •••

Release the mouse button.

Execute the Sort command . After a brief pause you will
see the Sort dialog box.

Click on the Inventory Code field name
in the field list box at the left of the dialog box.

You want to order the file by the Inventory Code number.
Note that the order of the sort is controlled by the two
buttons at the bottom of the dialog box. Ascending Order
is selected, which will sort the Inventory Code numbers
from smallest number to the largest. Since they all start
with a letter of the alphabet, this sort will be in alphabetical order.

Field List

Sort Order
(ll'IU

Description
't
Our Cost
Quantity On Hand
Minimum Stock
Reorder
Lest Order
The Item

[» Moue

»1

Sort

~

[

Un~or t

(

EHit

1
1'---------~

® Ascending Order
0 Descending Order

Figure 16.19
The Sort dialog box. The
Inventory Code field has
been selected in t he Field
List box.
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Click on the Move button.

Place the Inventory Code field into the Sort Order list at
the right of the dialog box. When you do this, you will
see an icon in front of the field name. This icon shows
that you have selected an Ascending Order sort for this
field.

Figure 16.20
The Inventory Code field is
in the Sort Order list. The
Inventory Code will be
sorted in ascending order.

Field List
lnuentory Code
Description
Our Cost
Quantity On Hand
Minimum Stock
Reorder
Lest Order
~e Item

Sort Order
Clear

J _. lnuentory Code

M!tVe

Sort
Un~ort

[Hit

® Ascending Order
0 Descending Order
Click on the Sort button.

Execute the sort. You will see a message telling you that
the sort is in progress briefly displayed on the screen.
When the sort is done, the Browse mode will return.
Note that the word Sorted now appears below the book at
the left of the window.

Figure 16.21
The database has been
sorted in order of the
Inventory Code field.
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You want to execute a new sort. The Sort dialog box will
appear.

Click on the Clear button.

You do not want the file sorted based on the Inventory
Code field. The Clear button will clear any information
from the Sort Order list at the right of the dialog box.

Click on the Our Cost field.

You want to sort the database using the cost of the items.

Click on the Move button.

Place the Our Cost field into the Sort Order list.

Macintosh Productivity Tools

Execute the sort. The file will now be displayed in order
based on the cost of each item, least expensive to most
expens ive.

Click on the Sort button.

Figure 16.22

The new sorted database.
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Drag the slide to the bottom of the slide
bar.

2.75
7.92
8.91
13.87
39.95
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35
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5127186
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You are going to add a new record to the daLabase.

,. •

File Edit

Bi
Rooords :

6
Sorttd

Select

Figure 16.23

The slide control has been
moved to the bottom of
the slide bar.

lam.WY.
JT031
JT131
Pl208
f:t.t1305
AF103
BT400

XN

Add a new record. Note that as soon as you perform this
command, the word sorted, shown under the book, is
placed into parentheses. This indicates that the file is no
longer totally in sorted order.

JA103 [TAB]
Saw, Coping [TAB]
2.50 [TAB]
7 [TAB]
10 [TAB]
611 1/ 86

Enter the info rmation for this new record. Since this layout does not include the graphic field, you are not able to
add the graphic of the Coping Saw at this time. When
you change the layout in use to the original one, you will
be able to place the graphic, which is in the scrapbook.

C lick the mouse in the white space
below the list.

You want to be able to look at the fi le without maldng
changes to the data. T he outlines of the fie lds will disappear, indicating that you are no longer in dala entry
mode.
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Look at the current list of the database on the Macintosh
d isplay. The newly added record is NOT automatically
sorted into the correct place in the list.
Figure 16.24
Th e current database fife
has the new record at the
end o f the fist. It is not in
order.
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The Sort command from the Select menu.

Click on the Sort button.

You do not want to change the Sort Order list, you just
want the compute r to re-sort the file.
After a brief pause, the sort will be done and the newly
sorted file will be displayed on the screen. The part you
just added will be in the proper location based on its cost.

Figure 16.25
The coping saw appears as
t he second item in the fist,
since its cost faffs b etween
that of the one inch paint
brush and the four inch
paint brush.
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3€S

The Sort command from the Select menu.

Click on the Clear button.

Clear the sort order list.

Click on the Unsort button.

You want to look at the file in its original order. Clearing
the sort order will not unsort the file. Only the Unsort
button will return the file to its physical order.
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Figure 16.26
The Unsort button is about
to be pressed.

Figure 16.27
The file is now displayed
in its physical order.
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1 6.9 LOOKING AT SUBSETS OF YOUR FILE

So far you have looked at every record in your database. With a small file , this is not a problem.
Unfortunate ly, a database may contain hundreds or thousands of records. When this is the case,
it is not practical to look at the complete database when you may be interested only in the
information contained in a few records.
You may te ll FileMake r not to list the complete file by specifying a find criteria to be in
e ffec t for the browse process . A find crite rion may be thought of as the dec ision rule you want
the compute r to use when deciding whether or not to display the contents of a particular record.
You may specify crite ria such as " part numbe rs that begin with the letter J." It is also possible to
combine two or more field contents to create selection criteria, such as " quantity on hand less
tha n minimum reorde r point, and cost less than 10.75 ."
Depending on the strategy you use when c reating your find criteria, you may have very few
o r ve ry many records output. The idea behind find c riteria is to develop the m so that the
program will display j ust the records you want. This can be done with a little bit of practice and
thought on your part.
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1 6.10 SELECTING RECORDS WITH FILEMAKER II

You will discover that FileMaker II is not case-sensitive when performing record selections. If
you have entered all the records using lowercase letters in the Inve ntory Code field (such as
" jtl31 " instead of " JT131 ") , then even if you enter your find criteria as a capital J, the records
starting with a "J" will be found. Of course, the opposite is true. If you entered the information
with all capital letters, and you enter the find criteria in lowercase, the records will still be
located.

WHAT

To Do

WHY

You ARE DoiNG IT

XS

Before performing the Find operations, we want to order
the database.

Click on Inventory Code in the Field
list.

We want the database to be displayed in order by inventory code.

Click on the Move button.

Place the field name into the Sort Order list. Leave the
Ascending button selected.

Click on the Sort button.

Sort the database.

Pull down the Select menu and select
the Find option.

The Find command is located on this menu. It can be
executed by using the XF key.

Figure 16.28
The Find command has
been selected.

Gadg€
.~Browse

188

Rl'tindot *R
Find fiJI *r,

Sort •..

185

Layout

Ill

Define ••.

Release the mouse button.

Execute the Find command. You will now see the Find
dialog. The Find dialog makes use of the current layout.
Note that the cursor is blinking in the Inventory Code
field.
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Figure 16.29
The Find dialog screen. It
makes use of the current
Layout. You can see that
the selected field is
Inventory Code, and that
the cursor is in t his field.
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JT

Type the letters " JT" into the Inventory Code field. You
are telling FileMaker that you want to see onJy those
records with an Inventory Code that starts with JT. You
are not yet using any of the Boolean symbols found under
the Find button at the left of the display.
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File Edit Select GaJ

II
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.IIJIISilY~

Figure 16.30
The letters JT have been
entered into the Inventory
Code field of the find
screen.
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IJll
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ODmlt

(
Click on the Find butto n.

Find

)

Execute the fi nd. After a brief pause, two records will be
displayed on the screen.
Figure 16.31
The Find command has
selected two reco rds.
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There are several things you should note about this
screen. First, look below the book at the left of the
screen. The number of records is 7, but the number
found reads 2 . You can see that the book shows a blank
page at the top, and a page with writing on the bottom .
Click on the bottom page of the book.

Even though you can see both records on the screen with
the current layout , you may still make use of the book to
browse in the records. Note that now the bottom page of
the book is blank. As " Found : 2" suggests, there are
only two records active in the database at the moment.
You should also notice that the two records are not in the
proper sorted order based on the Inventory Code. The
JT03 1 should be listed before the JT 131 , instead of how
you see these records on the screen. The Find operation
returns the database to its physical order. You must now
execute a Sort command to properly order the selected
records.

XS

Execute the Sort command. You selected Inventory Code
to be the field on which to sort order earlier. It should
appear in the Sort Order list.

Click on the Sort button .

Re-sort the list.
The two selected records are now listed in the correct
order based upon the ir Inventory Codes. You can also see
the word Sorted appear at the left of the window below
the 2 that gives the number of records found .

Figure 16.32
The word Sorted appears
at the left side of the
window with the other
information about the
database.
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XF

Execute the Find operation again.

Click on the field for Reorder.

Even though this is a computed field, you may use it for
Find criteria.

reorder

Enter the word Reorder into the field. You now want a
list of those records that have parts that should be
reordered.
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Figure 16.33
The word REORDER has
been entered into the
Reoder field, the second
from the right in the
current layout. Remember
that the case of the letters
does not matter to
FileMaker.

Omit

Click on the Find button.

•

r

File Edit

Select

Complete the Find command . Four records will be
selected, but again they will not be in sorted order. Since
the only other information that will appear in the Reorder
field is the word "OK," you could have performed this
search by entering only an "R" in the field . That would
have been enough to allow FileMaker to select the
desired records.
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Figure 16.34
After the Find button has
been clicked, four records
are selected from the
database for display.
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XF

You are going to execute another find.

JT

Enter JT into the Inventory Code fie ld .

Click the mouse on the Reorder Field .

You are going to use two Find crite ria on a single search
request. When you do this, the two criteria are combined
with an "AND" operation by FileMaker.

reorder

Enter " reorde r" into this field. You want to locate those
records that have an Inventory Code that starts with " JT"
AND must be reordered.
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Figure 16.35
You are entering two Find
criteria.
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Click on the Find button.

Execute the Find operation.
Two records have been found by this Find command .

Figure 16.36
7\vo records are found
because both Find criteria
must be true for a record
before it is made available
for browsing.

r

It File Edit Select G<tdgeh rormot Custom Window
:• i --- - --- lnuento File
- -~ --

Palrt Brush, 4"
Palrt Brush, 1"

JT131
JT031

FOW>d :
2

_--

:.1

2I!SU1 Mn!MW ssm
LJSS Ord"
illlllllY..QalfiH IIUlHE

DtscdMIII
Rooords :
7

.,

2.75
2.05

24
15

35
35

Reord& 7122186
Reord& 7122186

XF

You are going to try another Find operation.

Click on the Last Order field.

You are going to do a find based on the information in
this field .

Click on the
screen.

< button at the left of the

This is the " Less Than" button. You may also type this ,
or any of the symbols at the left of the window , from the
computer's keyboard.
You want to find only those items with a last order date
before 6/ l/86.

6/l /86

Figure 16.37
The Find criteria has been
created.
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Click on the Find button.

Figure 16.38
Four records have been
found with a last order
date prior to June 1, 1986.
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Execute the fin d. The re are fo ur records that contain a
last order date prior to 6/1 /86.
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You are going to try another Find operation.

Click on the = button at the left of the
screen.

This is the " Equal To" button. The
the Inventory Code field.

5115186
5127186
4130186
511186

= should appear in

Macintosh Productivity Tools

You want to locate all the records that have an Inventory
Code equal to JT.

JT

,. '

File Edit Select Gadget·
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Rtqutsts :
I

Figure 16.39

The current Find criteria.
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Click on the Find button .

Execute the Find.
FileMaker will tell you that there are no records that
match this Find criteria.
Figure 16.40

The Find criteria does not
locate any records.

No records match this request.

This happens because the equal operator told FileMaker
to look for records in which the Inventory Code was
exactly JT, and nothing else. There are no such records.
Click on the OK button.

You want to try again.

[BackSpace] [BackSpace] [BackSpace]

Erase the information in the Inventory Code field. You
are going to try a new find with a new Find criteria.

A

Enter an A into the Inventory Code field, which should
be the selected field.

Pull down the Edit menu and drag the
mouse down to New Request.

The New Request command lets you combine multiple
Find criteria in an OR fashion , rather than in the AND
fashion that you used earlier. You can see that the XN
key will execute this command.
Figure 16. 41

The New Request
command has been
selected.
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Release the mouse button.

Figure 16. 42
A second find criteria is
being added to the current
find criteria. The two will
be combined in an OR
fashion, not an AND
fashion.
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Execute the command. A Find request form wi ll be
added to the display.
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Enter a 1 into the Inventory Code field of the second find
criteria.

Click on the Find button.

Execute the Find command.
Four records will be found. One that starts with an "A",
and three that start with a " 1".

Pull down the Select menu and drag the
mouse down to the Find All command.

This command will cancel the current Find crite ria , and
once again display the complete database. This command
may be executed with the XG key.

Figure 16.43
The Find A ll command has
been selected.

Release the mouse button.

Execute this command. All the records of the database
will be displayed.

It is important to remember that when you enter information into two or more fields of a
single Find request fo rm, the di ffe rent items a re combined using the Boolean AND operation.
That is, each criteria must be met for a record to be selected. When you want to combine two or
more criteria in an OR fashion, then you must add selection requests. A record that matches on
a ny single selection request will the n be selected. This should be evident from the last selection
you made. It is impossible for an Inventory Code to start with both a 1 AND an A . Clearly, the
selection that was made was for records that started with either a J OR an A. It is also possible to
use the multiple requests to make a selection such as the records with an Inventory Code starting
with A OR the records in wh ich Our Cost is greater than 35.00.
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1 6.11 MODIFYING THE FIELDS USED IN A LAYOUT

Just as you may want to look at selected records of the database file, you may want to look at
selected fields . In addition to a database containing thousands of records , it may contain information you do not always want to see. For example, if you have a pe rsonne l file , you may want to
list just employee ID numbers and names when creating an e mployee list, and not include the
people's c urre nt salaries.
You have seen that you can, with relative ease, add a new Layout to a database file to meet
specific needs. Sometimes it is easie r to duplicate an existing layout and then modify it to obtain
the info rmation you want, rathe r than to create a completely new layout. In this fashion, you can
easily select the contents of any g iven display.

WHAT

To Do

WHY

You ARE DoiNG

IT

XL

Return to the Layout mode. You should have layout 3 displayed. If not, use either the book or the slide bar to display Layout 3.

Pull down the Edit menu and drag the
mouse down to Duplicate Layout.

This command will make a copy of the current layout and
add it to the file. It can be executed with the XD key.
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Release the mouse button.

Figure 16.44
The Duplicate Layout
command has been
selected.

~A
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Execute the command. The layout will appear
unchanged , but by looking at the book and the information below it yuu can see that the number of layouts is
now 4 , and you are using the founh layout.
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File
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Figure 16.45
You are now using the
fourth layout.
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Click on the Last Order field.

Select the rightmost field of the current layout.

[SHIFT]

Hold down the shift key for the next group of mouse
clicks. You are going to click the mouse on several other
items. By holding down the shift key, you are extend ing
the selection.

Click on the Reorder field .

Select this field.

Click on the Minimum Stock field.

Select this fie ld.

Click on the label for the Last Order
field.

Select the label at the top right of the layout.

Click on the label for the Reorder fie ld.

Select this label.

Click on the label for the Minimum
Stock field.

Select this label.

Release the shift button.

You are finished selecting items.
You now have six items selected.

Figure 16.46
Note the six items of the
layout that have been
selected.

l:ustom Window

.,

XX

This is the Cut command from the Edit menu . The
selected items wi ll be removed from the layout.

Move the mouse to the Field tool at the
left of the window.

The Field tool is used to add fields to a layout.

Press a nd hold the mouse button.

When you press the mouse button, you will see a box and
line displayed on the screen starting at the Field tool.

Figure 16.47
The mouse pointer is on
the Field tool and the
mouse button has been
pushed. Note the outline
of a box with the line
going out of it to the
right.

Drag the mouse to the right of the
Quantity On Hand field in the layout.

:·.
I

!

As you drag the mouse, the box and line will disappear
until the mouse is on the white a rea that is the usable
space of the current layout.

Macintosh Productivity Tools

It is importa nt to place the box so that it is not touching
the dashed line representing the bottom of the layout's
header.

om Window

.,

Figure 16.48
Note the placement of the
box between the header
and body dashed lines.

Release the mouse button.

Place the field holder on the layout. When you release
the mouse button a field list will appear at the left of the
screen.

Click on the Value field.

You want the field you have just placed on the layout to
be the Value field. Remember that this field is computed
by multiplying the Our Cost field times the Quantity On
Hand field.

Figure 16.49

lnuentory Code
Description
Our Cost
Quantity On Hand
Minimum Stock

The field list has appeared
and the Value field has
been selected.

Cl ick on the OK button.

Make the new field on the layout be the value field. The
word Value will appear inside the field you have added to
this layout.

XB

Return to the Browse mode. The value should now be the
rightmost column on the report (Figure 16.50 on the next
page).
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Figure 16.50
The modified layout has
some of the fields from
the earlier layout and the
field you j ust added.
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It is important that you place the new field so that it is
not touching the dashed line representing the bottom of
the header. If your Browse mode view looks simil ar to
Figure 16.5 1, then the fie ld you have added is touching,
or above , the dashed header line.
Figure 16.51
The shaded box represents
the field you have just
added. If your display
looks like this, rather than
like Figure 16.50, you have
placed the field too high
on the layout.

r
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To fix this problem is easy. Return to the Layout mode by
pressing XL, then drag the field down. If you are having
trouble placing the field in the exact location you want ,
then pull down the Gadgets menu and look at the Invis ible Grid command.
If there is a check mark in front of this command, it is
active. Drag the mouse down to se le~t Invisible Grid ,
then release the mouse to turn off the Invisible Grid . The
Invisible Grid causes new fields and other items you
place on a layout to jump to certain locations. By turning
it off, the items you are placing will no longer jump to
the invisible grid . Note that you may turn the Invisible
Grid on and off by using the XY key.
After you have re-located the new field, press XB to
return to the Browse mode.
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1 6.12 REMOVING RECORDS FROM YOUR DATABASE

Sooner or later you will want to re move records from the database. This may be for any of
several reasons. For example, a store may decide to stop stocking a partic ula r ite m, a nd the refore
it should be dropped from the inventory file. Or, you may need more space on the disk, fo rcing
you to re move unneeded or unused information.
You delete a record by using the Delete Record command while it is the c urrent record being
displayed in the Browse mode. If you are looking at the file in a columnar list layout, you can tell
which one is the curre nt record by looking at the numbe r displayed in the center of the book. It is
also possible to tell the current record by observing the black bar in the space that separates the
records from the book and othe r icons on the left of the window . This bar is placed opposite the
current record . To observe the movement of this bar, click the mouse on the RM305 Inventory
Code. The black bar moves down next to the fourth record . Now click on the AF103. T he black
bar will move to the fi rst record . Finally, click in the white space below the last record of the
file . The selection bar will move to the last record of the file. Of course, you may use the book
or selection ba r to change the curre nt record number.
It is also possible to dele te a group of records. This is done by using the Delete Multiple
command. All the records selected and available fo r browsing are then deleted . You control
which records are selected and active by using the Find command that you learned earlie r in this
chapter.
It is important to remember that, no matter how you delete the records, either singly or in
g roups, once they a re deleted , the deleted records cannot be recovered . If you want some
information restored , you must manually reente r the data.

WHAT

To Do

WHY

You ARE DotNG IT

Move the mouse to the left of the Inventory Code BT400.

This is the record for the step ladder. It is the one you are
going to delete.

Click the mouse.

Make the third record the selected record. This is the
record you want to delete.

,. It File Edit Select Gadgeh

rormot Custom Window
lnuento File

JIDII"YCtll

RtspdMJt•
~cis :

7
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AF1 03
PL208

Saw, Hand
Saw, Hack

BT400
~305

Step Ladder
Hamner

JT131
JT031
JA103

Palrt Brush, 4"
Palrt Brush,,.
Saw, Coping

~
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13.87
7.92
39.95
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6
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4
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83.22
23.76
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35.64
66
30.75
17.5
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Figure 16.52
The third record is the
active record. Note the
location of the mouse
pointer to the left of the
BT400 code. This is where
the mouse was clicked to
move the selection.
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Pull down the Edit menu and drag the
mouse down to the Delete Record
command.
Figure 16.53

This command will delete the currently selected record
from the database. Note that you may execute this command by pressing the X E key.

..Select (iadgeh
Undo
:•:z

The Delete Record
command has been
selected.

:•:H
:•:C

rut

[OPIJ
Paste
£tear
SeJe( tAll
P~tstc Ditto
Paste Date
UIPW lndPH •.•
RPplftC8
Relookup

:•:l•
:•:R
:•:'
:•::•:t

:·:·

New Record
ICN
Duplicate Record lCD
Delete Multiple "
Omit Records •••

lCD

Activate the Delete Record command. You will now see a
new dialog box. With this dialog box, you have the
opportunity to cancel the current delete command.

Release the mouse button.

Figure 16.54
The dialog box you will
see after you have
executed the Delete
Record command.

Permanently delete this record7
(Delete)

Confirm that you want to delete the current record. T he
record will be removed, and the database will return to
six records in size.

Click on the Delete button.

Figure 16.55
The database is once again
only six records. Note that
the BT400 no longer
appears in the file.
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XF

The Find command.

JT

Enter the text " JT" into the Inventory Code selection
field.

Click on the Fi nd button.

Return to the Browse mode. Only two records should
now be displayed.

Pull down the Edit menu and drag the
mouse down to Delete Mult iple near the
bottom of the menu.

T his command , which does not have a command key
equivalent , will remove from the database all the records
that are currently active. At present , this is two records,
since they were Found by the Find criteria.
vnuu

[ ut
(opy
Pnste
[ll•nr
Select Rll
Pnsl e Ditto
Pnste Dat e
U I ~W lnd~H •••

RPptoce
RPiookup

-

·· ~

:•:H

:•:c

:•:I•

Figure 16.56
The Delete Multiple
command has been
selected.

:•:fl
:•:'

:•:-

:•:I

:•:c:

New Record
XN
Duplicate Record XD
Delete Record
XE

Release the mouse button.

Execute this command . You are asked if you really want
to delete the two records that have been found .

Permanently delete the 2 records
that were found?
[Delete)

Click on the Cancel button.

(cancel~

Figure 16.57
The Delete Multiple
command deletes all the
records that can be
browsed through at the
moment. If a Find is in
effect, then the Find limits
the number of records that
can be deleted. If no Find
is in effect, the Delete
Multiple command will
delete all the records in
the database file .

You do not really want to delete these two records.
A word of caution when using the Delete Multiple command. If you have failed to specify a Find criteria, meaning that the complete database is active, this command
will delete every record of the file.

:M:G

Execute a Find All command to activate the complete
database fi le before you quit the program .

XQ

The FileMaker Quit command . You are done working
with the database file and you are returned to the
Macintosh Finder.
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As previously mentioned, it is important to remember that, once a record has been deleted,
it cannot be undeleted . The Undo command is not activated after you delete a record. When you
a re going to pe rform a Delete Multiple command, make sure that you look at the records that are
to be deleted before executing the command. This will save you many hours of work re-building
a file from which you have deleted the wrong records.

EXERCISES
I . When you browse a subset of the database, are the un-l isted records deleted from the database?
2. Is it possible simultaneously to select a subset of the database for display and a subset of the database's fields, or are these
selection processes mutually exclusive?
3. If a database file has a date type field called DATEI NV, how do you select only those records with a date prior to 6/ 15/85?
4. If a database file has a text type field called CITY, how do you select o nly those records where the city is
WORTHINGTON?
5 . If a database file has a field called IS OK, how do you select only those records in which this field has the value TRUE?
How do you select only those records in which this field has the value FALSE?
6. Are records that a re deleted from the master database file stored in some other file for later use, or are they gone forever?
7. What should you do BEFORE you delete records from the database fi le?
8. In what situation is it possible to retrieve records that have been deleted from the database file?

If you d id not create and enter the mailing list database in Exercises 5 through 10 of Chapter 15 , do so now.
9. Print the MAILIST data base in sorted order based on the last name field.
10. Print the MAILIST database in sorted order based on the zip code field.
II. Delete aU the people from the MAILIST database living in CT and print the database in physical e ntry order.

If you did not create and ente r the vendors database in Exercises II through 15 of Chapter 15, do so now.
12. Print the VENDORS database in sorted order based on the vendor code field.
13. Print the VENDORS database in sorted order based on the zip code field.
14. Print a list of the VENDORS database, in sorted order based on the company name. Print only the compa ny name, name
of the contact and the phone number.
15 . Print a list of the vendors found in Burbank, CA. Print only the company name and street address.
16. Open the Inventory File that you have been working with in this chapter. Add the picture of the Coping Saw to the field
The Item for the record with the Inventory Code JAI03 .

CHAPTER

ADVANCED DATABASE
MANAGEMENT SYSTEMS
CONCEPTS

-

CHAPTER OBJECTIVES:
Upon completio n of this chapter, the student will :

• Create custom layouts for the database.
• Create and modify a script to automate
database processing functions.

-

17.1 WORKING WITH YOUR DATABASE MANAGEMENT
SYSTEM

Afte r you boot your Mac intosh with a System Start-Up disk, insert the FileMake r II Program
disk into one of the compute r's disk drives . If you are using a mac hine with a hard disk you will
not need to insert the File Maker program disk into a disk drive . Rather, locate the FileMa ke r
folder, and ope n it so you can see the File Ma ke r program icon. Place the disk that has your
database into anothe r one of your Mac intosh's disk drives, if you have one avai lable. If you do
not have a free floppy d isk drive, keep this d isk available.
In these instructions, [c r] means to push the Return key on your computer's keyboard
(reme mber, this is NOT the Enter key). A~ in front of a lette r (e.g . , ~X) means to hold dow n
the Command key while pressing the gi ven lette r. Lette rs enclosed in square brackets (e.g.,
[TAB] or [ENTER)) mean to push that key on the keyboard , a nd not to type out the word.
Finally, the phrase " C lick the mouse on .. ." means to move the mouse pointe r to the specified
item and push the mouse button once. The phrase " Double-click the mouse on .. :· means to
move the mouse po inter to the specified item and double-clic k the mouse button. The word
" drag" means to select a n item, be it an icon or the menu selection bar, and move the mouse
while the mouse button is pressed .
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If you are us ing a computer with a hard disk, begin here:

WHAT

Figure 17.1
This is the icon you will
see for FileMaker database
files.

~

lnvtnton,t

To

Do

WHY

You

ARE DotNG IT

Locate the icon for the database fi le you
created in Chapter 16 and place the
mouse pointer on it.

You are going to launch FileMaker by double-clicking on
this icon. Figure 17 . I shows the icon that FileMaker creates for its database files. The name of this particular one
is Inve ntory fi le .

Double-click the mouse.

By double-clicking on a FileMaker database, the Macintosh will look on aU available disks for the FileMaker
application program. If found , it wi11launch FileMaker
and open the database. If the Macintosh is not able to
locate the application program, you wi11 see the dialog
box shown in Figure 17.2.

Fi~

Figure 17 .2
You will see this dialog
box if the Macintosh is not
able to locate the
FileMaker application
program to open the file
you are double-clicking.

The file "lnuentory File" could not be
opened/printed (the application Is busy
or missing).

I

OK

I

If you have the FileMaker application program on your
hard disk, or on a floppy disk currently in one of the
computer 's disk drives, the program should start, and
after a brief wait, the database you prepared during the
last session wi11 appear. You are now ready to work with
the file.

If you are us ing a computer that has only floppy disks, then start here:
Locate the icon for the FileMaker
program.

You will launch the FileMaker application program by
double-clicking on it.

Move the mouse to the FileMaker icon
and double-click.

The double-click wi11 launch the application. If you have
trouble with the double-click , you may also select the
program 's icon with a single click, then use the Open
option on the File menu, or press XO , the Command
Key equivalent.
After a brief wait, FileMaker wi11 be running , and you
wi11 see the Open dialog box.

Click the mouse on the Drive button
shown in the dialog box.

The Drive button te11s FileMaker to display the database
file and fold er nam es found on a second disk currently in
your computer. This may be a floppy disk, or a hard
disk. If you do not have a second disk in the computer,
then the Drive button will be dimmed , and you wi11 not
be able to use it.

Macintosh Productivity Tools

Continue clicking the Drive button until the name of the
disk that contains your file appears in the dialog box.
Click on Inventory File.

You want to open the database you named " Inventory
File." By clicking the mouse pointer on the name in the
dialog box, you are selecting this database.

I(g) MY DRTR I
II

IIII'PIIIOI lj I tiP

:!1

(g) MY DRTR

Figure 17 .3
The disk MY DATA contains
the Inventory File, which is
selected here.

CJ Models
Eject
Orlue
( Networtc

Cancel

Click on the Open button.

Execute the Open command. After a brief pause while
the computer reads the database, you wi ll see the database displayed in the last layout that you used.
You should remember that the double-click is often a
shortcut to the Open command. You could have doubleclicked the mouse on the database name, rather than
selecting it and then clicking on the Open button in the
dialog box.

-

17.2 CUSTOMIZING THE LAYOUT SCREENS

It is not uncommon for you to want to have more information o n the computer's screen when
entering data than is displayed by the FileMaker standard layout screen. For example, you may
want mo re descriptive information or a longer prompt than simply the field name. At other times
you may want to enter or update only a selected subset of a database file 's fields. You have
already performed the latter task by defining multiple layouts for the database. Recall that in the
last chapter you added a new record to the file using the third layout. T his layout did not include
the field called " The Item," which is the picture of the item. You should have discovered that you
can return to the record using a different layout and add the missing information.
In this chapter you will make a new layout for this file. The layout will include graphics,
text, and modifications of the way the data is displayed on the screen.
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WHAT

To Do

WHY

You ARE DoiNG

IT

XL

Activate the Layout mode.

Drag the slide next 10 the book to the
top.

Select Layout number I . This is the layout that was created when you first created this database.

Figure 17.4
This layout wifl be used as
the basis for a new layout.

'
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Pull down the Edit menu, select Duplicate Layout and release the mouse
bullon.

Make a copy of the default layout. Your file now has fi ve
layouts. When the duplicate process is complete. the new
layout. number five, will be selected .

Click on the label Inventory Code.

Select the label for the firs t field.

XX

Use the Cut command to delete th is text.
Before you begin placing text. you are going to change
the auributes of the font.

Pull down the Format menu and select
the FontSize command .

When you select this command , a list of the available font
sizes will be displayed to the right of the menu.

Figure 17.5
The FontSize command has
been selected, and the list
of available font sizes is
displayed on a sub·menu.

6 Point
8 Point
A) IPaJibl{l

0ID IPmlbiU

Format Nnonn,A.-..• ~ OJZ!Jiaamt
0IQ IPaJibl{l
format Date ...
Format Picture ... om IPmlbiU
Repeat •••
3liQ IJiaamt
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Drag the mouse pointer right onto the
list of font sizes, and then down to the
12-point option.

You wa nt to make the text you are going to place on the
layout into 12-point text.

Figure 17.6
The 12-point option has
been selected.

Format N
Format Date •••
Format Picture ...
Repeat ...
Line Width
Line Pattern
FIJI Pattern

Release the mouse buuon.

Change the font size to 12 point.

Pull down the Format menu and select
the Style command , then drag the
mouse right to Plain Text.

You do not want the text you will be typing to be in
boldface.

Figure 17.7
The Plain Text option on
the Style sub-menu has
been selected.

Format NulmnRr..~
Format Date ...
Format Plcture ... l.J!!!!!!!!!.~
Repeat ...

Release the mouse buuon.

Make the text Plain.

Pull down the Format menu and select
the Align command, then drag the
mouse right to the Left option.

You are going to change the text alignment from flush
right to flush left. Thus, text will type for you in the
normal fashion.
Figure 17.8
The Align Left option on
the Align sub-menu has
been selected.
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Release the mouse buuon.

Set the text alignment to left.

Click on the la rge A at the le ft of the
screen .

This is the text tool. I! wi ll le t you add text to the layout.
The mouse po inter tool will no longer be se lected . As
you move the mouse over the layout . you will see a n
I-beam rathe r than the mouse arrow po inte r.

Figure 17.9
The text tool has been
selected.

Pos ition the I-beam under the word
Header and cl ick the mouse.

You are going to enter text at this location .

Code

Type the word "Code". This text will be placed onto the
curre nt fil e Layout.

Figure 11.10
The label "Code " has been
added to the current file
layout.

r
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File Edit

Select

Gadgets Format Custom Window
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File
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@.sij@!On..... ........................................J

Click on the mouse a rrow 1001.

You are done with the text, and you want to return to
using the mouse po inter.

P lace the mou'se on the handle of the
Inve ntory Code fie ld .

You are going to adjust the s ize of this field .

Drag the ha ndl e left until just the word
Inventory is s howing in the field.

Make the field smaller.

Drag the field left and place it next to
the label fo r the fi eld .

Move the placement of the field le ft so that the re is room
fo r more info rmation 10 the right of the field .

Clic k on the field label " Description ."

Select this label. You are not going to dele te it, but you
do wa nt to change the text style.

Pull down the Formal me nu , select
FontSize , then select 12 Point from the
sub-menu and release the mouse.

The change to the ove rall text style did not change the
ex isting text. Cha nge the point s ize for this text to 12
point.

Pull down the Fo rmat menu, select
Style. then select Plain Text from the
sub-me nu and release the mouse.

Re move the bo ldface auribute

Drag the Descriptio n field label up and
place it to the right of the Inventory
Code field.

You are going to place the description to the right of the
code number.

Drag the Descri ption field up and place
it to the right of the Desc ription label.

Place the fi eld next to the label on the top of the layout.

10

this text.
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,. li File Edit Select Gadgets Format Custom Window

.,

Figure 17.11
The first line of the layout
has been completed.

lnuentory File
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Select the Our Cost label.

You are going to delete this label.

XX

Cut this label from the layout.

Select the text tool at the left of the
layout.

You are going to ente r new text.

Pull down the Format menu , select
FontSize, the n select 12 Point from the
sub-menu a nd release the mouse.

Change the point s ize for the text you are about to ente r
to 12 point.

Pull down the Format menu , select
Style , then select Plain Text from the
sub-menu and release the mouse.

Remove the bold face attribute to this text.

Pull down the Format menu, select
Align , then select Left from the subme nu and release the mouse.

You want the text left aligned as it is ente red.

Click the 1-beam under the Inventory
Code field .

You are going to place this text be neath the Inventory
Code field.

Cost

Type the word "Cost."

Select the mouse pointe r tool at the left
of the layout.

You are done typing this text.

D rag the handle of the Our Cost field
left so only O ur Cost is displayed.

Make the Our Cost field smaller.

Drag the O ur Cost field up and left,
placing it next to the Cost label.

Position this field on the layout.

C lick on the Our Cost field so it is
selected.

You a re going to cha nge the formatting of the fie ld.

Figure 17.12
The Our Cost field has
been selected so that a
formatting change can be
made to it.
N

Pull down the Format menu , select
Align, then select Right from the subme nu and release the mouse button.

Change the formatting of the number to be right aligned
in the field.

Pull down the Format menu and select
Format Numbe r.

You a re going to change how the number is displayed,
which is d iffe rent fro m whether it is displayed at the left
or right of the field (Figure 17.13 on the next page).
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Figure 17.13
The Format Number
command has been
selected on the Format
menu.

Line Pattern
Fill Pattern

Release the mouse button.

Execute the command. You will now see the Format
Number dialog box.

Click on the "Format with" button.

Change the formatting from none to a formatting option.

Click on the check box in front of
Notation.

You want a dollar sign to appear in front of the number,
since this is a dollar value. The Dollar button should
already be selected.

Click on the check box in front of Fixed
number of decimal digits.

You want all the values entered into this field to always
display two digits to the right of the decimal point, even
if the numbers are zeros.
With these formatting changes, if you enter a 2 into this
field, the value will be displayed as $2.00.

Figure 17.14
The completed Format
Number dialog box.

0

Unformatted number
®Format with:
0Commas
181 Notation: ®Dollar 0 Percent
181 FIHed number of decimal digits:
0 Format as Yes I No

1•1

Click on the OK button.

You are done formatting this number.

Select the Quantity On Hand label.

This is the next item you are going to change.

XX

Delete this label from the Layout with the Cut command.

Click on the text tool.

You are going to add new text to the layout.

Pull down the Format menu, select
FontSize, then select 12 Point from the
sub-menu and release the mouse.

Change the point size for the following text to 12 point.

Pull down the Format menu, select
Style, then select Plain Text from the
sub-menu and release the mouse.

Remove the boldface anribute to this text.

Pull down the Format menu , select
Align, then select Left from the submenu and release the mouse.

You want the text left aligned as it is entered.

Macintosh Productivity Tools

Click the I-beam to the right of the Our
Cost field.

You are going to place the text next to the Our Cost field.

Number In Stock

Enter the text "Number In Stock" to be the label for the
field on this layout.

Click on the mouse arrow pointer tool .

You are going to work with the mouse pointer tool.

Drag the Quantity On Hand field up and
to the right of the label you just entered.

Position the field next to the new label.

Select the Minimum Stock label.

You are going to change this label.

:I€X

Delete this label from the Layout with the Cut command.

Click on the text tool.

You are goi ng to replace the label with new text.

Pull down the Format menu , select
FontSize , then select 12 Point from the
sub-menu and release the mouse.

Change the point size for the foll owing text to 12 point.

Pull down the Format menu, select
Sty le, then select Plain Text from the
sub-menu and release the mouse.

Remove the boldface attribute to this text.

Pull down the Format menu , select
Align, then select Left from the submenu and release the mouse.

You want the text left aligned as it is entered .

C lick the !-beam below the text "Number in Stock".

You are going to position this field beneath the Quantity
On Hand field.

Minimu m Needed On Hand

Enter the label for this fie ld.

C lick on the Mouse Arrow tool.

You are going to use the mouse to drag a field.

Drag the Minimum Stock fie ld up and
to the right of the label you j ust entered.

Position the field next to the new label. You r screen
should match Figure 17. 15.
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Figure 17.15
Your screen should appear
similar to this figure.
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Hold down the [SHIFT] key.

You are going to select several items. By holding down
the shift key, you will be able to click on more than one
item on the layout without losing prior selections. When
you hold down the shi ft key and click the mouse on
items, you are said to be "Shift-clicking" on the item.

Click on the Reorder field.

Select the Reorder field.

Click on the Reorder fie ld label.

Select the field 's label.

Click on the Last Order field.

Select the Last Order field.

Click on the Last Order fie ld label.

Select the field 's label.

C lick on the Value field.

Select the Value fie ld .

Click on the Value field label.

Select the field 's label.

Click on the Tota l Inventory field.

Select the Total Inventory field.

C lick on the Total Inventory field label.

Select the fie ld 's label.

Click on the The Item field label.

Select the label for the The Item field. Do NOT select the
field itself.

Release the [SHIFT] key.

You are done selecting fields.

Figure 17.16

You should have selected
all of these items on the
layout.

~
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......

Cut all of the selected fields. You do not want them used
on this layout.
Select The Item field.

You are going to re-position this field .

Drag the selected field up and to the
right so it is beneath the Minimum
Stock field.

Position this last field on the layout.

In thi s section you changed the display attributes of the label text. You may also c hange the
font , poi nt size , sty le and a lig nment of the text used in fields. Select the field, then use the
Format menu to c hange the desired type style attribute.

Macintosh Productivity Tools

' a

File

Edit

.,

Select

Figure 17.17
Your Macintosh 's screen
should look similar to this
figure.
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17.3 ADDING GRAPHICS TO THE LAYOUT

You have now seen how to rearrange a layout and how to change the labels that are placed by the
fie lds. You may use the text tool to place any type of text on the layout. You are not restricted to
plac ing labels for the fields .
In addition to the text tool that you used in the last section , there are four graphic tools
available: the line, rectangle, rounded rectangle a nd oval. One potential problem that people may
have is locating fields on the screen. You have seen that the field outlines are hidden unless you
are in a data entry mode. In this section you will use the graphic tools to highlight the locations
of the fields .

WHAT

To Do

Click on the rectangle tool.

WHY

You

ARE DOING IT

You are going to start by drawing rectangles around the
fie lds.
Figure 17.18
The rectangle tool has
been selected.

As you move the mouse pointer onto the layout area, the
mouse wi ll turn into a cross hair.
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Position the cross hair above and to the
left of the top left corner of the The
Item fie ld.
Figure 17.19

You are going to draw a rectangle around the field that
holds the graphic of the inventory item.

~ O rl MCUIO

(lf1U.JAU'A i t.¥.':N

Note the location of the
cross hair near the The
Item field.

Press and hold the mouse button.

You are going to drag the cross hai r to make a box.

Drag the cross hair down and to the
right.

Make a recta ngle around the field.

Figure 17 .20
The cross hair has been
dragged over the field, but
the mouse button has not
yet been released. Th e
dotted line shows the
out line of the rectangle
you are drawing.

Release the mouse button.

Complete the rectangle. Note that you now have a double
line around the field. The inner line represents the
boundaries of the fie ld, while the outer line is the rectangle you just drew. Both boxes have a handle with which
you can change the item's size and shape.
Use this procedure to draw rectangles around all the
fields on the data entry fo rm. When you are done, your
layout should appear similar to Figure 17.2 1. Note the
double lines around each fie ld. The inner lines represents
the boundaries of the fields, while the outer lines are the
rectangles.

Figure 17.21

Window

The rectangles have been
placed around all the
fields.
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Return to the Browse mode .
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Figure 17.22
When you first return to
the Browse mode you will
see a single outline for
each field. This is the
rectangle that you have
created around them.

~-~~------~

•

.. ....... . .. . .. . .. . ............. .. . .. . . ..... . .. . ...... .. .. . ....
Click the mouse pointer inside one of
the fields.
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File
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Edit
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Activate the data entry mode. Note that the double line
around each field returns.

Format

Custom Window

File

..,

Figure 17.23
FileMaker is in data entry
mode, and the fields are
now outlined and
displayed inside the
rectangles you created.

RtcOI"ds :

6

If you are care fu l, you can place the rectangles directly
on top of the field outlines. When you do this you will
not see the double lines when you are us ing data entry
mode.

3€L

Return to the Layout mode. You are now going to add a
graphic to the layout.
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Pull down the Apple menu , select the
Scrapbook and release the mouse
button.

Activate the scrapbook.
Use the scroll bar to locate the picture of the pliers (Figure 17.24).

Figure 17 .24

Scrapbook

The pliers has been located
in the Scrapbook.

~
12 ~mm~~~~iii~~mmmnlii!I!MIIiilllll.iMii#l ~ill&lllltllllli!l21
10/14

ITi'IC, ePIC, PICT

XC

Copy the picture to the clipboard.

Click on the Scrapbook close box.

Put away the scrapbook file .

XV

Paste the picture onto the layout. The graphic will appear
in the cente r of the current layout.

Figure 17.25
The graphic of the pliers
has been pasted onto the
current layout.

Use the mouse pointer to drag the
graphic left to the cente r of the white
space .

Place the graphic in the center of the unoccupied space
on the layout.

Macintosh Productivity Tools

C lick on the text tool at the left of the
layout.

You want to add some text, as well as the graphic, to the
layout.

Pull down the Format menu , select the
FontSize option, then a size of 18 point.

You want to make the lettering large.

Pull down the Format menu , select the
Style option, then the Outline option.

You want the text to be outlined.

C lick the mouse pointer above the
graphic.

Place the beginning of the text you want to type .

J-M-R HARDWARE

Type this text.

Click on the mouse pointer tool.

You are done typing text. Use the mouse pointer to drag
the text you have entered and position it above the graphic
of the pliers. The layout you have created so far should
appear simi lar to Figure l7 .26.

.,
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Figure 17 .26
The current layout.

~
Lfl.elii.... O!I
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Figure 17.27

. !· :

C lick on the oval tool.

You are going to add an oval to the layout.

Pull down the Format menu and drag
the mouse down to Fill pattern.

The Fill patterns will appear to the right
of lhe menu . These are lhe patterns available to "color in" the inside of objects,
such as rectangles and ovals. The check
mark is next to the None option, which is
why the rectangles you placed around the
field entry areas are transparent. You may
apply a fi ll pattern to an object after it is
created by selecti ng the object, then
changing the fill patte rn . Right now you
are setting the fill pattern before creating
the graphic object.

The fill patterns you may
select from for "coloring
in" graphic objects.

Custom I
Font
FontSize
Style
Rllgn
Format Number .. ,..,_,.,.I
Format Date ...
~ormat Picture...
Repeat ...

~:~: ~~:::rn

:
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Drag the mouse right to the patterns,
then down to the fifth pattern in the left
column.

You want to fill the oval with this pattern.

Figure 17 .28
The fifth pattern is being
selected.

Format Number ..
Format Date ...
Format Picture...
Repeat...
Line Width
Line Pattern
f11l Pi! II I' In
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~
~
~
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~
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Release the mouse button.

Select this pattern for filli ng graphic objects.

Position the mouse pointer below and to
the left of the graphic of the pliers.

You are going to begin drawing the oval at this point.

Press and hold the mouse button.

Activate the d rawing mode.

Drag the mouse to the right and down.

As you drag the mouse, a rectangle will appear. The oval
will be placed inside of the rectangle.

Figure 17 .29
As you draw a graphic
object, you will see a
rectangle. The object will
be drawn inside the
rectangle.

Release the mouse button.

Figure 17.30
The graphic has been
created and filled with the
desired pattern.

LHel.d......l

r.;fil ...

,-----,
L_

- -- - -+

After you have positioned the mouse pointer to the bottom right corner, releasing the mouse will draw the
graphic inside the rectangle.

Lnel.d. .....l

If you do not like the position or size of the object you
have c reated, you may click on the mouse pointer arrow
tool, and use it to move the object, or to grab the object's
handle to change its shape. You may also change the fill
pattern of an existing object by selecting it, then selecting
a new fill pattern using the Format menu .

Macintosh Productivity Tools

Cl ick on the text tool.

The text tool is the large letter A in the tools box. You are
going to add more text to the layout.

Pull down the Format menu , select the
FontSize option, then select 24 point
from the FontSize sub-menu.

You want to make the text you are about to type 24 point.

Pull down the Format menu, select the
Style option, the n select Bold from the
Style sub-menu .

You want the text to be boldfaced.

Pull down the Format menu, select the
Style option, then select Outline from
the Style sub-menu.

In addition to boldfaced, you want the text you are going
to type to be outlined.

Click the 1-beam cursor below the oval
you have created.

You are going to type the text below the oval.

J-M-R

Type this text.

Click on the Mouse Pointer tool.

You are going to move this text with the mouse pointer
tool.

Click on the text you just typed.

Select the text.
Figure 17.31

The text has been selected
using the mouse pointer
tool.

Drag the text up and position it in the
center of the oval.

You want the text to be placed in a location other than the
one where you originally typed it.

Click the mouse pointer outside the
oval.

You want to de-select the text.

Figure 17 .32

The completed graphic.

You may add other graphic items to layouts when appropriate, or design on-screen forms or output forms.
~B

Return to the Browse mode. Use the book or slide bar to
look through the database. Note that the graphics you
have added (the rectangles around the fields, the pliers
and the text) do not change as you go from one record to
the next.
You want to add a new record to the database using the
current layout. You should be add ing record seven.
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ABlOl [TAB]
Pipe Wrench [TAB]
8.62 [TAB]
6 [TAB]
3 [TAB]

Enter the text data for the seventh inventory item , the
pipe wrench.

Pull down the Apple menu , select the
Scrapbook and release the mouse.

Activate the Scrapbook. You need to get the picture of the
pipe wrench for this record .
Locate the picture of the pipe wrench using the scrapbook's scroll bar.

XC

Copy the picture to the clipboard .

Click on the scrapbook's close box.

Put away the scrapbook.

Click on the picture field .

Recall that the data entry mode is terminated when you
activate the scrapbook. Click on the destination field at
this time to reactivate the data entry mode.

XV

Paste the picture of the pipe wrench into the field .

Figure 17.33
The completed record.

r
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Window
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17.4 CUSTOMIZING A LAYOUT FOR A REPORT

In addition to being able to custo mize a layout fo r an input or browse display, you may customize
a layout for output purposes. Here you will create a layout that will be used to list the items that
need to be re-ordered.

Macintosh Productivity Tools

WHAT

To Do

WHY

You ARE DoiNG

IT

XL

Return to the Layout mode.

XN

It is possible to modify an existing layout, but this time
you want to create a new layout. The New Layout command may also be found on the Edit menu. You will see
the first Layout design options dialog box.

Click on Columnar report layout.

This will be a columnar report.

Click on the OK button.

After telling FileMaker that you want a columnar report,
you must specify the fields to be in the report. The Field
selection dialog box will appear.

Click on Inventory Code in the Field
List box.

This will be the first field you want to have appear in the
report .

Click on the Move button.

Place the field into the Field Order list.

Click on the Description field in the
Field List box.

This is the second field you want on the report.

Click on the Move button.

Place the field into the Field Order list.

Click on the Our Cost field in the Field
List box.

The third field for the report.

Click on the Move button.

Place the field into the Field Order list.

Click on the Quantity On Hand field in
the Field List box.

The fourth field for the report.

Click on the Move button.

Place the field into the Field Order list.

Click on the Last Order field in the
Field List box.

The fifth field for the report.

Click on the Move button.

Place the field into the Field Order list.

Fiel d List
lnuentory Code
Description
Our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order
[he Item

!:::!

Clear

.,

L3!iJ

;·
,,

OK
Cancel

Field Order
lnuentory Code
Description
Our Cost
Quantity On Hand
Lest Order

Q

0

Figure 17.34
Your Field Selection dialog
box should appear similar
to the one shown here.
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Clic k on the OK button .

Figure 17 .35
The sixth layout has now
been created.

You are done selecting fields. Layout number six will be
created.

tt

r

File

Edit
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Select
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Click on the Our Cost field .

You are going to change the formatting for this field.

Pull down the Format menu and drag
the mouse down to the Format Number
option, then release the mouse button.

You want to change how the numbers are displayed in this
column of the report. The Number Format d ialog box
will appear.

Click on the Format With button.

You want formatting to be done.

Click on the Notation check box.

You want dollar signs to be placed in front of the numbe rs. T he Dollar button should already be selected.

Click on the Fixed number of decimal
digits check box.

You want two digits to the right of the decimal point.
Thus, values such as $2 will appear as $2.00

Figure 17.36
The completed Format
dialog box.

0

Unformatted number
®Format with:
ocommes
181 Notation: ®Dollar 0 Percent
181 FIHed number of decimal digits:
0 Format as Yes I No

1•1

Click on the OK button.
Hold down the [SHIFT] key and click
on the Quantity On Hand field.

You are simultaneously going to apply a formatti ng
change to both the Hour Cost and Quantity On Hand
fields.

Macintosh Productivity Tools

Figure 17.37
1\.vo fields have been
selected for formatting .

Pull down the Format menu , drag the
mouse down to the Align option, then
select the Right option.

You want these numbers to be right justified in their
columns.

Figure 17.38
The Align Right option has
been selected.

Custom Window

Release the mouse button .

Complete the formatting of the columns.

Scroll the window using the scroll bar at
the bottom of the layout window.

You need to see the last two fields in the ir entirety to
complete the next task.

· s

File

Edl! _Select -~~~~l!_E!_ts

Format

Custom

Window

lnuentory File

' l!i

.. ·..
::.

: ·:;.
:

:·
I[ ] Lovout

i

·:

. .·

: :~

::,:::·

I !C':L

. ::

. :::::

Figure 17.39
The layout window has
been scrolled so that the
last two columns of the
report are visible. You can
see that the text in the
Hour Cost and Quantity On
Hand fields is now right
aligned.
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Grab lhe handle on lhe Quantity On
Hand field and drag it left so only lhe
word Quantity shows.

This field is too wide. You are making it narrower.

Drag the Last Order field left next to the
Quantity On Hand fie ld.

Reposition the Last Order column of lhe report.

Click on the Text tool.

You are going to modify the column heading fo r the
Quantity On Hand field. You must use lhe Text tool to do
this.

Click the 1-beam mouse just to the left
of the wo rd " On " in the Quantity On
Ha nd field label.

You are going to delete the fi rst word of this column
heading.

Figure 17.40
Note the location of the
/-beam. Click it here.

[BackSpace] [BackSpace] ...

Press the backspace (or delete) key until the word Quantity is erased.

Click on the Mouse Pointer tool.

You now need to reposition several column headings.

Drag the Last Order column heading
le ft.

Position this column heading over its field.

Drag the Our Cost column heading
right.

Position this column heading over the right side of its
fie ld.

Figure 11.41
The right side of the layout
you are working on.

' a

File Edit

Sele ct

68

.,

Scroll the window back to its original
position.

You now need to see the left side of the layout.

Position the mouse pointer over the
Header box at the left side of the layout.

You are going to change lhe size of the space reserved fo r
the report header.

Macintosh Productivity Tools

Figure 17.42
Note the location of the
mouse pointer.

Press the mouse button , then drag the
Header box down to the location of the
footer and release the mouse button.

You are adding about half an inch to the header.

-
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~~~

Figure 17.43
The header has been made
larger.

Hold down the [SHIFT] key and click
the mouse on all the column headers.

You are selecting all the column headers.

Drag the column headers down about
one half inch.

Reposition all the column headers, making space for new
items above them in the header area.
Figure 17 .44
There is now room for new
items in the header above
the column headings.

Click on the top of the book.

Return to Layout 5. You are going to copy some items
from this layout.
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Click on the " J-M-R •· inside the oval.

You are going to copy the text and oval to the header
space of layout 6. Start by selecting the text.

Figure 17 .45
The J-M-R text has been
selected.

[SHIFT]-click on a part of the oval.

Hold down the shift key and click the mouse on part of
the oval to simultaneously select it with the text.

Figure 17.46
Both items are now
selected.

:l€C

Copy the selected items to the clipboard. Th is is the
Copy command found on the Edit menu.

Click on the bottom page of the book.

Return to layout six .

:l€V

Paste the text and oval onto the current layout.

Figure 17.47
The oval and the text are
now on the current layout.

Drag the selected oval and text to the top
left corner of the header space.
Figure 17.48
The oval and text have
been repositioned.

File

Edit

Position the selected items at the top le ft side of the
header.

Select

Gadgets
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---~-- ---··...

.
:.:

::: :
Click the mouse pointer to the right of
the copied graphic.

De-select the " logo" you have just added to this layout.
You are next going to make some text formatting changes,
and you do not want them to modify the text displayed on
the logo.

Macintosh Productivity Tools

Cl ick on the Text tool.

You are going to add text to the header.

Pull down the Fo rmat menu , select the
Fo ntS ize option, then select 14 point
fro m the size sub-menu.

You want the text to be in 14 point.

Pull down the Format menu , select the
Style option, then select Plain Text from
the style sub-menu .

Make sure that you do not have boldface, or other style
options chosen.

C lick the 1-beam to the right of the logo.

Position where you want the text to be placed .

REORDER LIST

Type this text.

Click on the Mouse Pointer tool.

You are done with this layout.
Select the Browse mode. All seven records of the database should be displayed at this time.

' a

File

Edit

Select

~0

Figure 17.49
The Reorder List as it is
currently displayed.

-

17.5 COMPLETING THE REPORT

You are now faced with a minor problem. Yo u mus t execute a Find command to have Filc Maker
select only those records that display REORDER in the Reorder fie ld. Recall that the F ind
com mand requires that you ente r in fo rmation into the fields to be used in the command . Reorder
is not o ne of the fields displayed or used in this layout. To have FileMake r select the correct
reco rds, you will have to return to a layout that conta ins the Reorder fie ld, execute the find , and
then return to layout 6 to see the results .
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WHAT

To Do

WHY

You ARE DorNG IT

3€L

Return to the Layout mode.

Drag the slide control on the slide bar
up to the top of the slide bar.

The slide bar is next to the book. It is a fast way to move
among the different layouts. You want to select the first
layout, which includes the Reorder field .

3€F

The Find command, found on the Select menu. Note that
you do not have to return to the Browse mode to begin
the Find command. This happens automatically.

Click on the Reorder field.

You are going to make a selection based on the content of
the Reorder field.

R

Enter just the letter "R" . If an item is to be reordered,
this field will start with an R, otherwise it will start with
an 0. This Find command will select only those records
that contain the word reorder in th is field.

Figure 17.50
The criteria for the Find
command has been
specified.
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Click on the Find button .

Figure 17.51
After the Find executes,
four records are selected.

Execute the Find command.
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File
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Found :
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After the Find command completes, four records will be
selected. You are, however, looki ng at layout I.
Return to the Layout mode.

Macintosh Productivity Tools

Drag the sl ide control on the slide bar
down to the bottom of the slide bar.

Return to the sixth layout, the Reorder List.

3€B

Return to the Browse mode. Since a Find is in effect,
only the four active records will be displayed on the
Reorder List.

.,

Figure 17.52
There are now only four
records shown on the

REORDER LIST

Reorder List.

Rocords :

7
FOW\d:
4

JT131
JT031
JA1 03

Paint Brush, 4"
Paint Brush, 1"

Saw, Coping

$2.75
$2.05
$2.50

24 7122186
15 7122186
7 6111186

You want to sort the list into Inventory Code order.
Inventory Code should already appear in the Sort Order
field . If not , cl ick on the Clear button, then Invento ry
Code in the Field list and finally the Move button.
Click on the Sort button.

Execute the sort and return to the Browse mode.

Figure 17.53
The sorted Reorder List.
REORDER LIST

Rocords :

7
Found :
4
Sorttd

JT031
JT131
PL208

It

PaintBrush, I "
Palrt Brush, 4"

Saw, Had<

$2.05
$2.75
$7.92

15 7122186
24 7122186
3 S/27186

i ..

If you have a printer available , you can print this layout to generate a hardcopy report of the
Reorder List .
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1 7.6 SCRIPTING AND THE CUSTOM MENU

It is certainly easy to select the sixth layout to c reate a Reorder List fo r the hardware store.
However, you must take care to re member to execute the correct Find command before you make
the list. If you forget, you will be telling the owne r of the store the wrong information.
One way to make sure that you generate the correct report is by using a script. A FileMaker
sc ript is a set of sto red settings and actions to perform on the settings. You may optionally have
the script name added to the C ustom me nu. This is useful for freque ntly executed scripts.
An example of a use for a script may be the creation of mailing labe ls from a database fi le .
The script can:
•
•
•
•
•

re-execute a Find command,
re-execute a So rt command ,
cha nge the paper size and printer settings to a custom value,
print the mailing labels, and
return to the display you were looking at before executing the script.

A script is created in two steps. Fi rst, you perfo rm the tasks yourself. This will set up
information that File Maker reads and stores. Afte r pe rforming the desired task you c reate the
script. The script saves all the relevant settings and re-creates them when the script is executed.
You will see that some end results may require multiple scripts. This is true of the task you have
completed . O ne script must be created for the record selection process, and a second sc ript must
be created fo r the report.

-

1 7.7 CREATING A SCRIPT
You should currently have the sorted Reorde r List d isplayed on the computer's sc reen. You will
create a script to duplicate this report. It will take two sc ripts to complete . Just as you had to
change the layout to perform the selection of records for the reorder list, your scripts wi ll have to
pe rform the same task. After the records have been selected, you will have the script return to
the Reorder List layout and sort the records.

WHAT

To Do

Pull down the Custom menu.

WHY

You ARE DOING

IT

Scripts a re both created and executed using this menu.
Since you have not yet created any scripts, this is a short
menu. As you create scripts and place them on the menu,
more items will appear on the Custom menu.

Figure 17.54
The initial Custom menu.

Drag the mouse down to Scripts and
release the mouse button.

Execute the Scripts command . You can see that you may
execute this command by using the XH key. You will
now see the initial Scripts dialog box.
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Figure 17.55

The initial Scripts dialog
box is empty.

Scripts

1Q

( Perform J

New
( [ hllfll]l.'
OI.'IP.t~
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Click on the New button.

EHit

You a re going to create a new script. You will now see
the Script Control dialog.
Figure 17.56

Script Name

The starting Script Control
dialog box.

When performing this script, automatically:
181 Switch to the Layout
181 Restore the Page Setup
0 Restore the Input Order & Input from 11 rue
181 Find: ®Restore the Find Requests & Find
0 Find Rll
181 sort: ® Restore the Sort Order & Sort
ounsort
OPreulew
0 Restore the Output Order & Output to a file
181 Print
0 Switch bact to the original layout
0 Perform another script
181 1nclude In menu
(,....---0-K--.
Cancel

The script control commands perform the following tasks :
• Switch to the Layout : This command causes the layout in use when the script is created to
be made the active layout.
• Restore the Page Setup: This command causes any printer setup in use when the script is
c reated to be restored.
• Restore the Input Order and Input from a file: This command is used to input records to
the current fi le from a second FileMake r file. You may also use it to input records into the
c urrent file from a text file.
• Find : You may optionally have all the records found by selecting the Find All button , or
have the Find that is in e ffect whe n the script is created be restored and executed.
• Sort: You may unsort the records, or activate the sort that is in e ffect when the script is
created.
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• Preview: This command will activate the Print Preview command from th e F ile menu.
• Restore the Output Order and Output to a file : This command will let you output the
current database file to a new file. You may optionally output the file to a text file for use
in another Macintosh application.
• Print: As you may suspect, this will send the active informatio n to the printer using the
selected layout.
• Switch back to the original layout: This command will restore the layout you were using
before the script was executed.
• Perform a nother script: This command lets you sequentially link scripts so that several
tasks may be performed .
Reorder List 2

Change the Script Name to "Reorder List 2". Since the
database is at the desired ending state, the final script in
the sequence of scripts to duplicate the report is being
c reated fi rst. This will be the second of two scripts
needed to re-create the reorder list. The order in which
scripts are created generally does not matter. However,
since the first sc ript in the sequence you are creating will
link to this one, this script must be available when you
ultimately create the first one in the sequence.

Click on the Find check box.

Turn off the Find command . The Find will be performed
by the first script in the sequence.

Click on the Preview check box.

This check box will cause the Print Preview to be
activated.

Click on the Print check box.

Remove the check from the Print check box. You do not
want the list to be printed at this time.

Click on the Include in menu check box.

Remove the check from this check box. You do not want
this script to be displayed on the menu. Only the first of
the two scripts will be on the menu.

Figure 17.57
The completed Reorder List
2 script.

Script Name

IReorder List~
When performing this script, automatically:
181 Switch to the Layout
181 Restore the Page Setup
0 Restore the Input Order & Input from a me
0 Find: ® Rt.>store the rind Rt.>qut.>sh I)" Find
QFind fill
181 Sort: ® Restore the Sort Order & Sort
QUnsort
181 Preulew
0 Restore the Output Order & output to a rue
0 Print
0 Switch back to the original layout
0 Perform another script
(\Include In menu
(
OK
Cancel

,--------

Click on the OK button .

You are through creating this sc ript. You will be returned
to the initial Script dialog. Reorder List 2 now appears
on the list of scripts.
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Click on the Exit button.

Before you create the first script in the sequence you
must set it up.

XL

You must change the Layout in use .

Drag the slide control up to the first
layout.

You are going to use the first layout again. Remember,
the slide bar is next to the book at the top left of the file's
window.

XF

Execute the Find command.

C lick on the Reorder fiel d .

You are going to place the selection criterion into this
fie ld.

R

Enter an R into the Reorder field.

Click on the Find button.

Execute the Find command. You are re-executing the
Find command to re-do the first part of the script.
Beneath the book at the left of the window you should
now see that four records have been found.
If you have trouble with this Find command, remember
that it is the same one you performed for the prior section
of this text. You may want to look back at that part of the
text and at the figures to check your work.

XH

r

You are now ready to create the first script in the
sequence. This is the Script command . It is still the only
option you can see on the Custom menu if you elect to
use the pull down me nu at this time.

a

File Edit

Select

.,

Window

The Scripts dialog box
shows the Reorder List 2
script.

Scripts

Reorder List 2

Figure 17.58
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[Hit

The initial script you created, "Reorder List 2" , will
show in the Scripts lists of the Scripts dialog box.
Click on the New button.

You are going to create a New script.

Reorder List

Enter the Script Name.

Click on the Sort check box.

You do not want this part of the sequence of scripts to
perfo rm the sort. You will let the second script perfo rm
this task.

Click on the Print check box.

You do not want this script to print the records.
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Click on the Perform another script box.

You want to link this script to the second part of the
Reorder List scripts.
Leave the Find check box marked . The main purpose of
this part of the script is to perform the record selection.
Also, leave the Include in the menu box checked. This is
the script title that you want to have appear on the Custom menu.

Figure 17 .59
The completed Reorder List
script.

Script Name

IReorder List
When performing this script, automatically:
181 Switch to the Layout
181 Restore the Page Setup
0 Restore the Input Order D' Input from a file
181 Find: ® Restore the Find Requests 0' Find
Q Find Rll
0 Sort: 0 llest ore tt1e ~o rt Order D" Sort
® 1Josm1
0 Preuiew
0 Restore the Output Order D' Output to a file
0 Print
0 Switch bact to the original layout
181 Perform another script
1811nclude In menu
~,--KJ-:o:7.K:--'
Cancel

Click on the OK button.

You are done with this script. You will now see a list of
available scripts to select from for the next script to be
performed in sequence. This should consist solely of the
first script you created. Now you can see why, in this
case, you had to create the second script in the sequence
before you created the first. The script had to be available
for this dialog box.

Click on Reorder List 2.

By selecting this script, you are telling FileMaker to run
the Reorder List 2 script when it completes the Reorder
List script. Thus, the first script you created will be executed second.

Figure 17.60
Reorder List 2 has been
selected as the script to
automatically follow the
Reorder List script.

Edit Select

Ga dget~

r ormD t

Windt

Choose the script to be performed neHt:
llt•otlll•t l "I !

Click on the OK button.

You are done selecting scripts.

Click on the Exit button.

You are done creating the scripts. You will be returned to
the current browse display.
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1 7.8 EXECUTING A SCRIPT

Scripts may be executed in two ways. If you direc ted FileMaker to put the script on the Custom
menu , you may execute the script by selecting it from the menu. You may also execute a script by
using the Scripts command on the Custom menu.

WHAT

To Do

WHY

You ARE DoiNG IT

This is the Find All command found on the Select menu .
All the records in the database should now be active.

XL

Change to the Layout mode.

Click on the bottom page of the book.

Change the active layout to layout 2 .
You are now going to test the script you have created. To
make sure that it performs as you expect, you have
changed the status of the database to something other
than the starting or ending point of the script.

Pull down the Custom menu.

You want to execute the script. Note that the Custom
menu now has the script name " Reorder List" added to
it. This script can be executed by using the XI key. The
first nine sc ripts that you add to the menu are assigned
the command keys X I through X9.

XH

Figure 17.61
The Custom menu now has
a new entry.

XI

Drag the mouse down to the Reorder
List com mand and release the mouse
button.

Execute the script that you have created.

After a brief pause, the Print Prev iew will appear, with
the Reorder List report displayed . If you had selected the
Print command as a script option, then the reorder list
would now be printing.
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Figure 17.62
The Print Preview screen
generated by the script. In
this case, the Reduced box
has been checked by the
user.

r

•

File Edit

Select

6<1dgeh

f"ormot

Custom Wlndlllll_

Jnuentory File

---= -=!

Preulew:
(Nt>nt PDgl.'J
(PageJI•I

181 Reduced
~
(Hit

Click on the Exit button.

You are done with the Print Preview.

~H

Execute the Scripts command. Recall that this command
is on the Custom menu.
You will now see the Scripts dialog box.

Click on Reorder List.

Figure 17.63
The Reorder List script has
been selected and the
Perform button is now
active.

Click on the Perform button.

This is the name of the script you want to execute. When
you select this script, the Perform button will become
active.

Scripts
(Perform J

This is the second method for executing scripts. You may
not want to put all your scripts onto the menu. By using
the Scripts command , you can execute any script you
have created.
After n brief pause while the scripts execute, the Print
Preview screen will once again be displayed.

Click on the Exit button.

Exit the Print Preview and return to the browse mode .

-

1 7.9 EDITING SCRIPTS

There are times when you will want to change a script. You may want to change the sort order,
de-activate or activate printing, or change the Find criteria. To do one or more of these tasks you
may either delete the script and re-create it, or you may simply edit it.
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WHAT

To Do

WHY

You ARE DOING IT

~s

You want to change the sort order that this script uses.
Before editing the script, you must perform the desi red
task. Remember, this sets up the information that the
script stores for later play-back.

Click on the Clea r button.

You are going to completely change the sort order. The
Clear button removes a ll prior sort information.

Click on Our Cost in the Field List.

You want to sort the Reorder List based on the cost field.

C lick on the Descending Order button.

Before you place the Our Cost field into the Sort Orde r
list , change the order in which the sort will happen.
You want the items listed from most expensive to least
expens ive.

Click on the Move button.

Place the Our Cost field into the Sort Order list.

Field List
lnuentory Code
Description
Our Cost
Quantity On Hand
Minimum Stock
Reorder
Last Order
~e Item

Figure 17.64
The new sort has been
defined. Note that the
Descending Order button
has been selected for this
sort.

Sort Order
~

Clear

.._ Our Cost

Unsort
[Hit

0

Rscendlng Order

®Descending Order

Click on the Sort button. Execute the
sort.

The four records will now be listed in a new order.

~H

The Scripts command.

Click on Reo rder List 2.

You are going to make a change to the Reorder List 2
script.

Scripts
JI Pollll•r II\ t 2

-- -

1::!1

[Perform J

Figure 17.65
The Reorder List 2 script
has been selected.

Reorder List

New
[ Change~

C lick on the Change button.

You want to change the script. The script options dialog
box will be displayed.

Click on the Continue button.

You do not want to change any of these options (unless
you want to acti vate the Print option). You may, of
course, e lect to change some of these items in the future.
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Whe n you cl ick o n the Co ntinue butto n you w ill see a
new dialog box. This d ialog box lets you select which
c hanges you want to impleme nt. To make a c hange you
click o n the appropriate Replace butto n.
C lick on the Replace button for So rt
O rde r.

You wa nt to replace the o riginal sort o rder with the curre nt so rt order, descending based o n the Our Cost field.
All o ther settings are left unchanged.

Figure 17.66
Make the change in sort
order take effect by
clicking on the Replace
button for the Sort Order
option.

The following Information Is needed to perform this
script. You can either:
• Keep the Information already saued for t his scri pt.
• Replace It with t he Information currently In use.

Layout:
Page Setup:
Input Order:
Find Requests:
Sort Order:
Output Order:
NeHt Script:

® Keep
® Keep
@Kee 11
® Kee11
O Keep
®Kee11
® Kee11

O Replace
0 Replace
0 Rl'Jlloce
0 ltl'pll1ce
<i_ Replace
0Rl'pl oce
0Rt>plnce

Click o n the OK butto n.

Make the change permanent. You will be returned to the
Scripts dialog box.

Click o n the Exit button.

You are done maki ng changes to the scripts.

XI

Execute the edited script.
Afte r a brie f pause, the Print Preview w ill be d isplayed .
Leave the P rint Preview and return to the Browse mode.
You can see that the fo ur selected records a re sorted in
descend ing o rde r based o n the item cost.

Click o n the Exit butto n .

Figure 17 .67
The Reorder List is now
sorted based upon the Our
Cost field and in
descending order.
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1i File Edit Select G
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REORDER LI ST

Rocords :

7
FOI.Ild :
4
Sorttd

XQ

JT131
JA103
JT031

Palrt Brush, 4'

Saw, Coping
Pairt Brush, 1'

$2.75
$2.50
$2.05

24 7/22186
7 6/11186
15 7/22186

Use the Quit co mmand , whic h may be found o n the F ile
me nu , to exit FileMa ke r and return to the Macintosh
F inder.
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EXERCISES
1. What can you do to find out the names of the fields and their associated data types in a database file if you know only the
name of the database?
2 . Can the data entry screens you create be used for reports as well as for adding more records to the database?
3. Can the data entry screens you create be used for editing the database file as well as for adding new records to the
database?
4 . Can a report format be used when selecting a subset of records to be printed , or must all the records of the database be
printed with a report?
5. How many times may a report fo rmat be used to generate a report before you have to re-create it?
6. Can you use line drawing tools to put boxes on a custom designed data entry screen?
7. Is there a limit to the amount of text that you put on a custom designed data entry screen?
8 . Create a script to print mailing labels from the database you created and worked with in the exercises at the end of
Chapters 15 and 16.
9. Design a data entry form for the mailing list database.
10. Use your mailing list data entry form to change the address for May Smith to 417 E. 32 St.
11. Use your mailing list data entry form to change the zip code for John Doe to 902 12.
12. Modify the script you created in Exercise 8 to print the mailing labels in zip code order. How did you accomplish this
task?
13. Modify the script you created in Exercise 8 to print the mai li ng labels in last name order. How did you accomplish this
task?
14. Create a report of the vendor file you created in the exercises at the end of Chapters 15 and 16 listing the company name
field , the name of the contact and the vendor code.
15. Create a report of the vendor file to list first the vendor code, then the company and address. Report the vendor file using
this form in vendor code o rder.
16. Create a data entry form for the vendor file.

CHAPTER

BUSINESS
GRAPHICS CONCEPTS
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CHAPTER OBJECTIVES:

Upon completion of t.his chapter, the student will :
• Explain the difference between business
graphics and freeform graphics.
• Explain the meaning of freeform graphic art,
bar charts, line charts, pie charts, and text ·
graphics.
• Explain why graphics are useful in a business
environment.

·. ·• Explain. t~e-different computer graphic display
methods pr:esently available, and when to use
the various ·tyf)e.S~
• Explain what slideshow computer graphics are.

-

18.1 WHAT IS A GRAPHIC?

You can see examples of graphics everywhere you look around you. For example, the station
identifiers on TV shows are graphics, as are the illustrations in magazines and the comic strips
in newspapers. Most of the graphics you see are either drawings, photographs, or some similar
type of picture (Figure 18. 1) and are called freeform art or commercial graphics. They are
intended to convey a message about a specific product or idea, and are often intended to sell that
product or idea.
Figure 18.1

THE COMPUTER STDPPE

This Week's
Clone Special

$1195
complete!

148 COMPONENT WAY

SUITE 7

IRVINE

You might see this type of
advertisement- a graphicin a magazine or
newspaper.
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Business graphics are also inte nded to convey information. The purpose of a business
graphic, however, is to convey relationships between or among kinds of nume ric information .
For insta nce, a pie chart (Figure 18.2) shows the relative proportions of ite ms making up a
whole. Line charts (Figure 18.3) show trends. A bar chart can show tre nds or relationships
among values (Figure 18.4). In all these cases, however, as different as the graphs may be, the
purpose is to convey to the viewer info rmation about numbers. In short , comme rcial graphics
sell ideas or present information , while business graphics present numbe rs so that large amounts
of information may be taken in at a single glanc~ a nd those numbers can be compared.
Figure 18.2
A pie chart.

Figure 18.3
A line chart.

Figure 18.4
A bar or column chart.

Macintosh Productivity Tools

-

1 8.2 WHAT ARE THE BASIC BUSINESS GRAPHICS?

Besides the pie chart, the line chart, and the bar chart some other types of business graphics you
may want to employ include the X-Y or scatter graph (Figure 18.5) and the area fill graph
(Figure 18.6).
Figure 18 .5
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Figure 18.6
An area fill graph.

A nonnumeric business graphic is the text o r word graph, which is a graphic composed
primarily of words. These graphics are used as title pages in presentations, as substitutes for note
cards for the presenter (Figure 18. 7), or to put the key ideas of a presentation in front of an
audience.

SALES LEADERS
PRIMARY CHARACTERISTICS OF SALES LEADERS

•
•
•
•
•

Thorough knowledge of product
Know how to build rapport with the customer
Resourceful
Can establish priorities
Follow-up

Figure 18.7
A text graphic.
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The easiest numeric business graphic to create involves only a sing le set of information, and
transforms those values into either a line or bar chart: for example, the number of new housing
starts per month for the last 24 months. This single group of 24 numbe rs can be plotted as a line
graph or as a bar graph.
Sooner or later, however, you can expect to need a graph comparing two sets of information:
for example, comparing the number of new housing starts per month with the Consumer's Price
Index. A single line or set of bars cannot show the desired comparison. Another requireme nt for
this type of graph may result if you want to compare the sales of an item by sales regions for a
period of several months or quarters. These graphs are called multi-line or multi-bar graphs .
Frequently the information can be more meaningful to the viewer if the chart displays not
only the comparative data, but the totals of the data as well. Thus , you might want to add
together the regional sales figures into a single bar, but build the bar out of changing color
segments, each color representing one of the sales regions. This type of g raph is called a stac ked
bar. When a line chart is used for this purpose, it is called an area fill c hart.
While it can take many hours for a person to plan and draw complex graphs such as these,
they are as simple for the computer to create as the single line or ba r chart .

-

1 8.3 MULTI-LINE/MULTI-BAR GRAPHS

A multi-line or multi-bar graph is, as suggested above, a graph showing more than one set of
numbers.
When such a graph is c reated, the computer must scale the X- and Y-axis ranges of each set
of numbers in the graph to the largest and smallest common values. For example, if the largest
value found in one set of numbers is 150, and the largest value found in the second set is 250 ,
then you can expect the Y-axis scale to extend to a value of 250.
Once the computer determines the common scales of the two or more sets of numbe rs to be
graphed , each line or bar is d rawn. To help you distinguish between the lines, especially if they
cross one another, the points of each line are marked with different symbols, such as boxes for
one line and plus signs for another. It is also possible for the li nes to be drawn with different
patterns, suc h as dots for o ne line and dashes for another. If you are using a color output device
for your graphs, the lines may be of diffe rent colors.
If you are looking at a multi-ba r graph, each set of bars will be filled with a different pattern
of lines, called c rosshatching. Thus, the line, or bars, representing the sales of widgets in the
West will have one hatching pattern while the line, or bars, for the East wi ll have a diffe rent
patte rn. A legend, or key, is then created by the compute r to show which pattern is which.
Whe n you create a multi-line or multi-bar graph , you must take care to ensure that the
magnitude of the values in each set of numbers is the same. If the range of one set of numbers is
from 90 to 110, while the range of the second set is from 0 to 1, the second line, or set of bars,
will almost merge with the Y-axis near zero. The two ranges are several magnitudes apart,
creating this proble m.
When you encounter a situation such as this, you can adjust one set of values so they more
closely match the other set. For example, you may use logarithm functions, or multiply the
smaller set of numbe rs to make the m larger, or divide the larger set to make them smaller. In the
e nd, the relative mag nitudes of the sets of numbers are the same. This tactic is a compromise.
The resulting g raph cannot show the magnitude of the difference between the two ranges .
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1 8.4 STACKED BA R AND AREA FI LL GRAPHS

The multi-bar/line type of graph shows a comparison of sets of values on the same scale .
Another way to compare the values in two or more sets of numbers is to show their relative
impact on the total of the numbers. As mentioned earlier, you may want to show the relative
amount of sales by a given region when compared to total sales for all the regions. This is the
function of the stacked bar and area fill graphs.
With the stacked bar and area fill graphs, the values in the multiple sets of numbers are
summed to find the extent of the scale. Afte r the first set of values is graphed, the values are
added to the values of the second set of values. This gives the points to be graphed on the Y-axis
fo r the second set of numbers. This process continues until all the sets of numbers are graphed,
each set on top of the prior one. That is, the bars, instead of appearing side by side, are stacked
one on top of another. With an area fill graph, two lines may touch if a value in the second (or
third, and so on) set of numbers is zero. They will never, however, cross. The scale is still
cumulative.

-

1 8.5 WHY USE GRAPHICS?

But why should you go to the trouble of creating a single business graphic, let alone a complete
slideshow, for a presentation?
The phrase "a picture is worth one thousand words" can be as true in business presentations
as it is in any other field. Many people feel that a single graphic is worth a thousand pages of
computer output.
Figure 18.8 displays the numeric info rmation that makes up the chart seen in Figure 18.9. If
you have only two minutes to discuss the information in a meeting, which graphic will convey
the information in a fashion so that the viewers will both understand and retain the highlights,
the list of numbers or the chart? The chart, of course. The important values stand out , and your
viewers can easily evaluate the remainder of the information in relation to these important
values. Consider how much more value this same process would have if the numbers filled
several pages of computer output. The ease with which the graphic information can be digested
makes its value immediately apparent.
Figure 18.8

Annual Rainfall

Los Angeles
New York
New Orleans
Seattle
Las Vegas
Rapid City

1978
25
137
210
195
15
208

1979
28
149
302
209
19
315

1980
18
182
331
233
19
320

1981
22
129
287
222

17
299

The columns of numbers
make it difficult to spot
t rends, abnormalities, or
make quick comparisons.
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Figure 18.9

Tota l Annual Rainfall

The chart lets the viewer
quickly interpret the
information.
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18.6 CREATING GRAPHICS

The re are several ways to create business graphics with a microcompute r. One way is to write a
program to draw exactly the graphic you desire. This, however, is time-consuming, a nd the
graphics commands vary greatly among the computers and output devices available . This means
that eve ry time you use a di ffere nt compute r or a different output device, you will have to make
potentially major modifications to the program you have written.
For almost every microcomputer capable of supporting graphics the re are many programs
available that will allow you to c reate freeform art. Additionally, many programs c reate business
graphics fo r these machines. Some of these programs do nothing but create g raphics, while in
others the graphics available are part of a multifunction program. These graphics programs,
which may cost three to five hundred dollars , are usually able to create many diffe rent types of
graphs from the same data , and can output the graph on many d ifferent output devices. The
money you spend in your ti me to custom write a progra m to draw a graph and output it to a
printe r or plotter will probably match , if not pass, the cost of buying a program to perform these
tasks fo r you.
As a rule, the programs that do noth ing but graphics (whic h wi ll be referred to as standalone graphics programs) have greater graphics capabilities and more flexibility when it comes
to the creation of business graphics. However, the graphics modules of the multifu nction programs are very easy to use, and the data to be graphed is readily available .
Regardless of the type of graphic program you use, before you can create a business
graphic, you must know what the numbers are to be graphed. If you are using a multifunction
progra m, then the values to be g raphed are probably available or can be easily c reated through
spreadsheet manipul ations. Once the values are displayed , then they may be graphed.
If you a re using a stand-alone graphics program, your data will have to be entered by hand
or come from some other source. Many stand-alone graphics programs are capable of reading
data from the more popula r electronic spreadsheet programs, thereby eliminating the need to
hand ente r data and giving you relatively easy access to the extended capabilities of this type of
program.
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Regardless of whether you are using a multifunction program or a stand-alone business
graphics program to draw your charts, once the numbers are in the compute r, the machine does
all the rest of the work for you. Possibly the most important of the things that the computer does
for you is scaling, which is the determination of the low and high values for the Y-axis (the
vertical axis) and the space between the marks on the Y-axis, both physically on the graph as it is
drawn and numerically. You wi ll probably find that the scale the computer selects is close to, if
not even exactly, the one you would select , although some graphics programs always select 0 as
the low value for the Y-axis, even if all the values are in the thousands or millions. Most business
graphics programs will allow you to make major c hanges in the appearance of theY-axis scale, if
you so desire.

-

1 8.7 METHODS OF PRESENTATION

The re are several methods avai lable for displaying
graphics in a meeting or classroom setting. The
hand drawn flip chart (Figu re 18. 10) will probably
never disappear. However, there is not presently a
method available for easily and inexpensively transferring computer-generated graphics to the display
page without losing some detail. Thus , we will concentrate on other methods of displaying computergenerated graphics.

-

1 8.8 COMPUTER DISPLAY

The first, and generally readily available, method of displaying compute r graphics is on the
computer's monitor. Some computers a re capable of creating graphics d irectly on the primary
display, such as the Macintosh family of microcomputers. Others , such as the IBM-PC , require a
graphics display monitor.
The major disadvantages of usi ng the compute r to display the graphics in a meeting or
classroom are the need to move in and set up the computer, and the small size of the computer
display, which limits visibility when group size is more than about three people. Additionally,
there is a potential delay when drawing complex graphics. This problem, however, depends
greatly on the business graphics program in use. The advantage of using the computer in this
fashion is the abi lity to generate new graphics, or to modify existing ones, to meet the dynamic
needs of the meeting participants.

Figure 18.10
The hand drawn flip chart.
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Closely related to the use of the computer in the meeting or classroom is the use of large
screen video projection (Figures 18.11, 18. 12, 18.13, and 18.14) to supplement or replace the
compute r's small monitor. One still has the disadvantages of the need to supply a computer in the
meeting and potential delays in drawing the graphics. However, with large screen projection, the
viewing problem is eliminated , and the advantage of dynamically adjusting the graphics used is
avai lable. Relatively new to the video projection market is the Liquid Crystal Display (LCD)
panel (Figures 18. 13 and 18.15). This is a device which simply sits on top of a standard
overhead projector. The graphics screen of the computer is displayed on the LCD , which acts
like an overhead transparency.
Figure 18.11
Sony 1020Q projector... a
full color projector costing
around $8000.

Figure 18.12
Electrohome EDP-57... a
monochrome projector
costing around $5000.

Figure 18.13
A Liquid Crystal Display
(LCD) projection pad being
placed on an overhead
projector.
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Figure 18.15
The Kodak Datashow LCD
Panel System. LCD panels
cost between $800 and
$2000.

-

1 8.9 PHOTOGRAPHIC TECHNIQUES

If using the compute r is not desirable, or the hardware and/or needed software are not available,
there are also photographic methods avai lable. These methods produce a 35mm slide of the
computer's display. This slide is then used in a standard 35mm projector, such as a Kodak
Carousel Projecto r.
There a re several different methods for taking a photograph of the computer's g raphic
di splay. First, simply point a camera at the screen and click away. This method, however, can
give poor results if it is not done with some care (Figure 18. 16). The best way to do this is to
work in a darkened room, with the camera on a tripod, and use a slow shutter speed to compe nsate for the TV scan rate (use I /30th or I/ 25th). The results will be dramatically improved
(F igure 18. 17).
Figure 18.16
It is easy to take a poor
photograph of a computer
display.
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Figure 18.17
With a tripod, slow shutter
speed, and a darkened
room you can obtain an
acceptable photograph of
your computer's display.

Making a room dark to photograph a computer display may not always be convenient or
possible. It is then time to invest in a little hardware. The least expensive device available for
simplify ing the taking of photos from the compute r's monitor is a simple cone made by Kodak
(Figure 18.18). To take a photograph, the cone is held over the computer display with a camera
attached on the end. The re a re several simila r devices ava ilable, with the primary d ifference
being the quality of the standard camera that comes with the unit.
Figure 18.18
The Kodak Cone can be
used to photograph the
monitor of any computer.

A minor be nefit of using one of the cone devices, or of simply taking pictu res in a darkened
room, is that a special gra phics display is not necessary if you wish to photograph the text
display of your computer. However, when it comes to color graphics, you may want more control
over the situation. Photographing the computer display will give you a picture exactly as it
appears on the screen. If you are unhappy with the color balance of your g raphics display
monitor, there is nothing that can be done.
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For more control of the results, you must acquire a computer video recorder, usually called
a film recorde r. Again, there are several avail able ranging in cost a nd capabilities (Figures 18.19
and 18.20 are typical).
Figure 18.19
Celtic Technologies Video
Recorder - $2500-$3000.

Figure 18.20
Polaroid Pallette $1500-$2000.

The film recorder uses a video signal taken directly from lhe computer. The camera a nd
le nsing are built in. With these devices, you have control over colo r balance, hue and tint, j ust as
with a television . You cannot, however, see the results of your adjustments until lhe film is
developed. This is because these devices use a high quality black and white data monitor, which
is photographed th rough colored filters. When you make a color adjustment , you are simply
adjusting the re lative exposure time through the various fil ters.
One of the advantages of using graphics
with a microcompute r is the speed with which
Figure 18.21
they can be created and modified . With the
A polaroid processor and
photographic technology available today it is
instant film.
even possible to have your slides ready in less
than te n minutes. Polaroid makes 35mm slide
film , which is processed in one minute (Figure 18.21). The extra time is needed to put
the resulting slides into slide mounts. There is
an initial investment in a processor and slide
mounte r of under $ 100 , and an ongoing
investment in film. However, the unit can
come in ve ry handy for those last-minute
re ports or classroom presentations.
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If you prefer to use an overhead transparency projector rather than 35mm slides, there are
ways of creating the overhead slides from your computer graphic. The first is to blow up your
35mm slide. Again, Polaroid makes a device called a PolaPrinter (Figure 18.22), which can take
any 35mm slide and give you an eight-by-ten print or transparency in a matter of minutes. Again
there is an initial investment in hardware of several hundred dollars, and an ongoing expense of
about $15 per print or transparency.
Figure 18.22
The PolaPrinter.

-

1 8.10 HARDCOPY GRAPHICS OUTPUT
Of course, there are alternative methods for creating overhead transparencies. They all involve
some hardware and some patience, but you are likely to have access to some of the needed items.
The most common graphics hardcopy output device is the dot-matrix graphics printer, such
as an Apple ImageWriter printer (Figure 18.23). These printers are relatively common, and
most graphics packages and multifunction programs are able to print graphics using them.

Figure 18.23
An Apple Image Writer II
dot-matrix printer.

~~

i

i
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Figure 18.24
A variety of graphic
printers.

The graphics pri nter ta kes the lines and bars of a graph and prints them on sta ndard paper in
black and white (Figure 18.24). De pending on the program a nd the speed of the printer, printing
a business graphic may be a brie f or time-consuming process . The quality of the output is also
dependent upon the ribbon and the weight of the pape r. Wh ile the maj ority of g raphics printers
in use today a re able to print only one color (black), multicolor printers are beginning to appear.
They a re capable of c reating accepta ble color graphic output, although the colors te nd to have a
flat and un-saturated appearance.
Figure 18 .25
A color graphics printer.
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After you have printed the graphic, you may, of course, include it directly in the re port.
Additionally, through xerographic or thermal processes, it is possible to create a n overhead
transparency of the graph (Figure 18.26). Once you have made a transparency, it is possible to
add colors with transparency pens (Figure 18.27) or with sheets of colored gels that stick to the
transparency (Figure 18.28).
Figure 18.26
Xerox and thermofax
graphics.

Figure 18.27
Vis-a-vis pens are used to
hand color an acetate
transparency.

Finally, you may have access to a digital plotter (Figures 18.29 and 18.30). These devices
draw the graphic on a sheet of paper using mult icolored pens. There are even pens, avai lable for
most plotters, which are designed to draw directly onto plastic sheets for overhead projection
(Figures 18.3 1 and 18.32).
Figure 18.28
Color may be added to a
transparency with Zip-0Tone stick on gels.

Figure 18.29
HI P 7470A two-pen plotter.
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Figure 18.30

Tektronix Plotter.

Figure 18.31

Paper plot of a bar chart.
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1 8.11 SLIDESHOW GRAPHICS

A useful way of presenting g raphics is the slideshow. When you hear this term, you may th ink of
the 35mm slide and slide projector. While this type of visual aid is far from obsolete, the
computer display and the wide variety of video projection technologies available today make it
possible to use the computer as the slide projection system . In essence, the graphics on the
computer's disk are the slides in the slide tray, and the computer and video display system a re the
slide projector.
The advantage of projecting by computer over using 35mm slides is the ease with which you
can update you r presentation. Once you understand how to generate computer graphics, all you
need is a few minutes before a presentation to make a cha nge or create a new graphic for a
specific aud ience.

647

648

CHAPTER EIGHTEEN -

BUSINESS GRAPHICS CONCEPTS

To do this you must use a slideshow-type program (such as PowerPoint from Microsoft,
Aldus Persuasion, or Cricket Presents), which lets you c reate and store a series of graphics on
your floppy diskette. Some of the programs let you enter numeric information and specify a
graph type ; the program the n draws the graphs on request. Other types of programs let you
create freeform graphs and text charts, which require that you draw your charts by hand. Some
slideshow prog ra ms combine both of these capabilities, and will draw graphs from numbers you
provide or let you ente r freefo rm graphics and text. All of these programs wi ll let you import
graphics through the Maci ntosh clipboard.
When you use one of these programs, the computer stores all the graphic information on a
diskette. When you need to make your presentation , the compute r 's monitor acts as the projection screen, and the program projects the graphics on it. You have full control ove r the prese ntation and can use the computer's keyboard, or, with some programs and projection syste ms , a
35mm slide projector remote control, to advance to the next slide. Some of the slideshow
graphics programs allow you to back up slides or even jump around in your slide tray (the floppy
disk) randomly picki ng the pictures to fit the flow of the presentation.

EXERCISES
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11 .
12.
13.
14.
15.
16.
17.
18.
19.
20.

Why should anyone want to use business graphics instead of simply displaying the numbers the g raphs represent?
Give three examples of graphics that you might encounter on a daily basis.
Name three of the basic business graphic types.
Whe n trying to compare data, should you use a single- or multi-bar (or line) graph?
If the information from several sets of data is more meaningful as a set of total values, but you still want to show the values
of the individual.sets, which type of graph should you prepare?
What is meant by the term "scaling"?
What do you think will happen if you graph two sets of data, one in which the values are in the range 5 to I 0 and the other
in which the values a re in the range 2700 to 3000?
Why use a business graphics program, which may cost several hundred dollars, instead of simply writing a program to
draw the desired graph on you computer?
From which type of program would you expect to have greater graphics capabilities and overall graphics flexibility: a
multifunction program or a stand-alone graphics prog ram? Why do you think th is is the case?
If you are using a multifunction program to c reate graphics, do you expect that you will have to enter the specific values to
be g raphed, or do you expect that the values displayed by the multifunction program are the ones that you can graph?
What a re three possible methods for displaying your compute r graphics?
What are the disadvantages of using the computer itself for the display of the graphics?
What is an advantage of using the computer itself for the display of the graphics?
If you are photographing the compute r's display to produce slides, is a special graphics monitor requi red? If so, which
type is best?
Do you think that you will have more control over the photographic process if you use a film recorder or if you use a
photographic cone? Why?
Can graphics be printed on dot-matrix type printers?
After you print a g raphic, can anything be done with the output other than include it in your report or document?
What do you think the advantage of using a digital plotter may be over using a dot-matrix printer for creating hardcopy
output of your graph?
What are the similarities between a computer slideshow system a nd a 35mm slide presentation system?
What are the differences between a computer slideshow system and a 35mm slide presentation syste m?

CHAPTER

USING SPREADSHEET
BUSINESS GRAPHICS
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CHAPTER OBJECTIVES:

Upon completion of this chapter, the student will:

• Create single line and single column graphs.
• Create multi-line and multi-column graphs.
• Create stacked column charts.

• Create pie charts..
• Copy a chart to the Scrapbook.
• Print the charts.

-

19.1 CREATING GRAPHICS WITH YOUR ELECTRONIC
SPREADSHEET

It is fairly easy to create business graphics with ExceL Before you can create a business graphic
with Excel, you must create a spreadsheet so that you have numbers to graph. This is the most
difficult part of the graphing process! If you do not have the numbers, there is nothing to be
done.
If you have not yet used Excel , return to Chapter 9 and become familiar with the program
before you begin creating graphics. If you have not used Excel for several weeks, and you are a bit
unsure about its operations, you will benefit from a review of the earlier chapters detailing its use.

-

1 9.2 BUILD THE SPREADSHEET

After you boot your Macintosh with a System Start-Up disk, insert the Excel Program disk into
one of the computer's disk drives. If you are using a machine with a hard disk you will not need
to insert the Excel program disk into a disk drive. Rather, locate the Excel folder, and open it so
you can see the Excel program icon. Place a disk (see Chapter 3 for how to initialize a new disk)
with at least 200K available space into another one of your Macintosh 's disk drives, if you have
one available. This disk will be used for saving your work. If you do not have a free floppy disk
drive, keep this disk available. You will need it for data storage.
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In these instructions, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while press ing the g iven letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key o n the keyboard, and not to type out the word.
Finally, the phrase "Click the mouse o n ..." means to move the mouse pointer to the specified
item a nd push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse pointer to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it an icon or the menu selection bar, a nd move the mouse
while the mouse button is pressed.

Figure 19.1
The MS-Excel program
icon.

WHAT

Microsoft Exc.l

To Do

If the disk's icon is closed, double-click
on it with the mouse pointer.

WHY

You ARE DOING IT

Ope n up the disk icon onto the desktop. If the Macintosh
you are using has a hard disk, then open the folder containing the Excel program.

Locate the Excel program icon inside
the disk window (Figure 19. I ). If you
are using a machine with a hard disk,
locate the Excel program icon inside the
folder's window.
Move the mouse pointer to the Excel
icon and double-click the mouse button.

Launch Excel. Remember, if you are having trouble with
the double-click, you may select the Excel icon with a
single click, then use the Open command on the File
menu (or 3€0) to launch Excel.

After a brief pause you will see a n empty spreadsheet on your Macintosh's screen . Before
c reating a g raph , you must create a spreadsheet from which the graphics portio n of Excel will
work. This is what follows.

WHAT

To Do

Select the range A I :B4.

WHY

You

ARE DOING IT

This will be the initial input range.

Figure 19.2
The initial input range has
been selected.

[cr]

Move the cursor to cell A2. You will be using row I for
the year column headings.

SALES [cr]
COSTS [crJ
PROFITS [cr)

Enter the row labels in column A and move the cursor to
cell B I.

1980 [crJ
105 [cr]
= (0. 75*B2) [cr]
= (82-B3) [cr]

Enter the first year's infor mation. The cursor will end up
in cell A I.
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Figure 19 .3
The spreadsheet you have
created so far.

C lick the mouse pointer on cell C I .

You are going to continue e ntering information in th is
cell.

= (l+Bl ) [cr]

Enter a formula for the year. 1981 will appear in cell C I.

Select the range C I: F I .

You are going to use the Fill Right command to fi ll in the
year column labels.

:M:R

The Fill Right command. Remember that this command
may be located on the Edit menu. You should now have
the years 1980 through 1984 in row I.

Select the range C2:F2 .

You are going to use this range to enter the sales growth
computations. Each year will be different, so you are not
going to use the Fill Right command .

= ( 1.04*B2) [cr]
= ( I. II *C2) [cr]
= (0.91 *02) [cr]
= ( 1.03*E2) [cr]

Enter the sales for the years 1981 through 1984 as a percentage of the prior year's sales. These formulas are
enten::d into cells C2, 02, E2 and F2 , the selected range.

Select the range B3: F4.

You are going to use the Fill Right command to complete
the spreadsheet model.
Once again execute the Fill Right command to complete
the entry of all the values.

Figure 19.4
The spreadsheet y ou have
created so far.

Click on the Select All box.

Remember that the box to the left of the A column indicator and above the row I indicator will select the entire
worksheet.

Pull down the Format menu , select the
Number option and release the mouse
button.

You want to format all the numbers so the spreadsheet is
easier to read.

Select the second item in the Format
Number list of options, the 0 format.

You want to apply the integer format to the complete
spreadsheet.
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Click on the OK button.

Apply the fo rmat to the complete spreadsheet.

Click the mouse pointe r on ce ll A I.

De-select the spreadsheet. You a re now ready to begin
graphing.

Figure 19.5
The completed
spreadsheet.

~s

The Save command from the File menu. Save your work
so that you do not have to re-create it in the future.

For Graphing

Name this spreadsheet " For Graphing".
Click on the Drive and Eject buttons as necessary to
make your disk appear in the dialog box.

Click on the Save button.

Complete the Save command.

-

19.3 CREATING A SINGLE VARIABLE CHART

You are now ready to begin creating g raphics w ith E xcel.

WHAT

TO Do

Select the range A I : F2 .

WHY

You ARE DotNG

IT

This represents the information that you wi ll chart. When
you c reate a chart with Excel, you fi rst select the info rmation to be charted, as you have here, and then you tell
Excel to create the chart.
Excel knows that the fi rst row of the selected range will
be used for the labels on the X-axis of the graph. This is
because you have selected more columns than rows. If
you select more rows than columns, the left column of
the range will be used fo r the X-ax is labels.

Figure 19.6
The selected range will be
graphed.
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Pull down the File menu.

Note that the New com mand is on this menu. You have
seen that this command is used to create new spreadsheets and macro sheets. It also is used to create charts.

Drag the mouse down to the New
command .

The New command may be executed by using the
XN key.

Figure 19.7
The New command has
been selected.

Saue
xs
SaueRs ..•
Saue Workspace .••
Delete ...
Page Setup ...
Print...
XP

Release the mouse.

Execute the New command.
After executing the New command you will see the New
dialog box.

C lick on the Chart button.

You are goi ng to create a new Chart at this time.

-Ne~

0 Worksheet
~hart
aero Sheet

Click on the OK button.

SALES

0

Cancel

J

I

Figure 19.8
The New dialog box. The
new Chart button has
been selected.

Create the chart. After a brief wait you will see the chart.

Chart Format Macro

140
120
100
80
60
40
20

I(

OIC

Figure 19.9
The chart has been
created. You can see that
the years, the top row of
the range being graphed,
are labeling the X·axis .
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As you look at the first chart, also notice that the Menu
bar across the top of the Macintosh screen has changed .
Several options are gone, and Gallery and Chart now
appear.
C lick on the Zoom box at the top right
corner of the Chart I window .

Figure 19.10
The Zoom box is found at
the top right corner of the
current window's title bar.

C licking on this box will make the chart fill the complete
Maci ntosh screen.

!at

Macro

Wlndo

~

Note that there is a check mark in front of the Column
option indicating that this is the current chart type.

Pull down the Gallery menu .

Figure 19.11
The Gallery menu has been
pulled down.

Chart
Area ••• It
Bar•••
~olumn..•
Line •••
Pie•••
Scatter•.•
Combination..•
Preferred
Set Preferred

Drag the mouse down to the Line
opt ions and release the mouse button.

Figure 19.12
The Line chart gallery.

r

•

File

You want to change the chart type to Line. You will now
see a gallery of several different line chart types from
which to choose.

Edit i@,i§i!i Chert Format

Macro

,

Window

I

I

3

OK

J

Cancel

1

NeHt •••
( Preulous ...

8

1980

1981

1982

., For Help on diD log settings, press Comm!lnd-?

1983

1984

1
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C lick on the OK button.

r

•

File

Edit

I

Gallery

The first line chart is currently selected . and this is the
one you want to use. Afte r a brief pause, the chart will
change from a Column chart to a Line chart.

Chart

.,

Format Mac:ro Window

The chart has been
changed to a Line chart.

I
Chart I

I ll

Figure 19.13

SALES

140

_._

120
100

eo
60
40

It

20
0
1980

1981

1982

1983

I

~Reedy

Pull down the Gallery menu , select the
Column option and release the mouse
button.

r

File

•

Edit

Chart

-

1984 R!i
.J

You want to return the chart to a Column chart format.
The Line chart is fa irly dull .
The Column gallery will now be displayed.

.,

Format Mec:ro Window

Column

r:-littA.

Fi"gure 19.14

The Column chart gallery.

I

OK

I

Cenc:el
NeHt •••
( Preulous ... )

·~~~

0+---------~----------+---------~----------~
1980
1981
1982
1984
1983
~For

Help on dtelog settings. press Commend-?

C lick on the OK button.

The first column chart is selected, and the original chart
will return .
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1 9.4 LABELING THE CHART

This c hart was easy to create, but it is lacki ng labe ls and other identifying information to make it
more understandable for the person looking at it. For example, does the Y-axis re present hundreds of dollars, thousands of dollars, millions of dollars, or something else altogether?

WHAT

To Do

WHY

Click on the title SALES at the top of
the chart.
Figure 19.15

The chart title has been
selected, and the text
appears on the edit line
below the menu bar.

" .t

File
T itle

You ARE DoiNG

IT

You are going to start by changing the chart 's title.

Edit

Gallery

I

I

Chert

Format

Macro

Window

SALES

E!ll

Chart1

When you select an editable chart item, the information
you can edit will appear on the Excel edit line, immediately below the menu bar.
Double-click on the word SALES on the
edit line.

Select this text. You are going to change it.

Figure 19.16

The chart title has been
selected on the edit line.
[][][]

I:JIAleD

[][][]

Sales History [cr]

Ente r this line of text.

Figure 19.17

The chart title has been
changed.

"

•

File

Edit

Gallery

Chart

Format

[]

[]

Macro

Window

[]

e&eles H1 stonD
[]
[]
lJ

Pull down the Chart menu.

This menu lets you add text and other items to the chart.
You want to add labels to the X- andY-axes.

Drag the mouse down to the Attach Text
command.

This command will let you create a chart title , an X-axis
label, a Y-axis label and even attach a label to a point on
the chart.
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Figure 19. 18

The Attach Text command
has been selected.
Rdd Legend
RHes•••
6rldllnes •••
Rdd Ouerley
XR
Select Chert
Select Plot Rree
Protect Document•••
Celc:ulete Now
Short Menus

18•

Execute this command .

Release the mouse button.

You will now see the Attach Text To dialog box.
The Va lue Axis is the Y-axis for the c urre nt chart. Excel
refers to the Value and Category axes, rathe r than the
X- and Y-axes because it is possible to rotate the charts.
c hanging the meaning of the X- a nd Y-axes. However, the
Value axis a nd Category axis meaning will never change.

Click on the Value Axis button.

-Rttec:h TeHt To
0 Chert Title
~Uelue RHIS
Cetegory RHIS
0 Series end Dete Point

Setie~ Numbet~

I=:::=J

l'oiot

[=:::=J

N umbeJ~

Click on the OK button .

c[

OK

Cencel

,

Figure 19.19

The Value Axis button has
been selected.

)

Create the Value axis (Y-axis at this time) label.

Figure 19.20

The Y-axis label has been
created. It 's preset value is

140
120
100
DD 80
00
DD 60

lt-40
20
0
1980
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Double-click on the " Y " on the ed it
line.

You are going to change the Y-axis label .

Millions of$ [cr]

Change the text to " Mill ions of$". Leave the label
selected. You can see that the label you have added takes
up horizontal space. At this time a horizontal label does
not create too much of a problem. However, it may at a
future time. Take the time now to change it to a vertical
label.

.,

Figure 19.21
The label you have just
added is horizontal, taking
up space.
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Pull down the Format menu.

This menu lets you control a variety of fo rmatting
options.

Drag the mouse down to the Text
command .

You want to modify the format of the selected Y-ax is
label.

Figure 19.22
The Text option has been
selected on the Format
menu.

Mlltr
P11ttems...
Font •••

MOU I.'

Sl2e

Release the mouse button.

You will now see the Text Alignment dialog box.

Click on the Vertical Text check box at
the lower left corner of the dialog box.

You want to change the text from its present horizontal
form to a vertica l fo rm.

Macintosh Productivity Tools

TeHt Rllgnmentt------,
rflorlzontal rtJertlcai-OLeft
OTop
® Center
® Center
0 Right
0 Bottom

I

Figure 19.23
The Vertical Text check box
has been selected.

I

OK
Cancel

[Patterns... )

~

Uertlcal TeHt
0 Automatic TeHt
181 Rutomouc ~izl.'

Cl ick on the OK bunon.

Font••.

Execute the change of formauing. The Y-axis label will
change to vertical.

Figure 19.24
The Y-axis label is now
vertical.
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Pull down the Chart menu. select the
Attach Text option and release the
mouse button.

You now want to label the X-axis.

Click on the Category Axis bunon.

You are going to attach a label to the X-axis.

Click on the OK bunon.

The preset X-axis label will appear below the X-axis.

Select the X on the edit line.

You are going to change the label from X to something
else.

Year [cr]

Change the X-axis label to read " Year".
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Click the mouse below the newly created X-axis label.

Figure 19.25

The complete chart. Note
the location of the mouse
pointer below the X-axis
label.

r

You want to de-select everything. Clicking the mouse in
the middle of the chart will still leave something selected .
If you click below the X-axis label you have just c reated
you will be outside of any possible part of the chart.

.,
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You want to save this chart. Charts are created in their
own document and must be saved independent of the
spreadsheet.

SALES HISTORY

Name this chart Sales History.
Click on the Drive and Eject buttons as needed to have
your disk drive name show in the dialog box.

Click on the Save button.

Complete the Save command .

Click on the zoom box at the right side
of the title bar.

Return the chart window to its original size. You s hould
now be able to see the spreadsheet window beneath the
chart window.

Click on the spreadsheet window .

Make the spreadsheet the active window.

-

1 9.5 CREATING A PIE CHART
Remember that a pie chart is used to show the relative proportions of items to the whole.

WHAT

To Do

WHY

You ARE DotNG lr

Select the range A I : 84.

You will create a pie chart from this range.

XN

The New command . The New d ialog box will appear.

Macintosh Productivity Tools

Figure 19 .26
The selected range, A 1:84,
will be used to create a pie
chart.

C lick on the Chart bunon.

You want to create a new chart.

Click on the OK button.

Create the chart. This chart will be titled Chart2 , and
will be a column chart.

Chert

Format

Mec:ro Window

Figure 19.27
The current chart. Since
there were more rows
selected than columns, the
left column was used to
label the X-axis points.

1980
120
100
80

60
40

20
0

C lick on the zoom box at the right side
of the chart title bar.

Expand the chart to fi ll the window.

Pull down the Gallery menu and select
the Pie option.

You want to change the chart into a pie chart.

Chert
Rree•••
Bar•••
.fColumn •.•
Line •••
Sc:etter.~

Combination•••
Preferred
Set Preferred

Figure 19. 28
The Pie option has been
selected on the Gallery
menu.
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Release the mouse button .

Figure 19.29
The Pie chart gallery. Pie
type 1 is selected.

'

•

You will now see the Pie chart gallery. Pie type number
I will be selected.

File

Chart

Edit

Format

Macro

Window

Pie

0

I

OK

(

Cancel

1

1
( Preulous ... 1
(

SALES

NeHt...

COSTS

.. For Help on dialog settings. press Command-?

Click on the OK button.
Figure 19.30
The chart is now a pie
chart.

r

Change the chart to a Pie cha rt.

•

File

Edit

Gallery

Chart

Format

Macro

.,

Window

Chart2
1980

m

, Ready

Pull down the Gallery menu , select the
Pie option and release the mouse button.

You want to change the pie type to one with exploded
s lices. An exploded slice is one pulled out of the rest of
the pie for emphasis.

Click on pie chart type 3.

Pie chart types 3 and 4 have exploded sl ices.

Macintosh Productivity Tools

Figure 19.31
Pie chart type 3 has been
selected.

Format Macro

Click on the OK button.

r

Create the pie chart.

.,

It File Edit Gallery Chert Format Macro Window

Figure 19 .32
The pie now has an
exploded slice.

Chert2
1980

The slice that has been exploded is not the one you want
to have exploded! You want the smallest slice, representing the profits, to be the exploded slice.
Click on the right-hand slice.

r

Select the exploded slice. Handles will appear around the
slice.

.,

It File Edit Gallery Chert Format Macro Window
S 1P 1

:SERIES("For Grephlng'l$6$1 ,'For Graph1ng'I$A$2:$A$4,
'For Graph In '1$6$2:$6$4,1)
1980

~Ready

-

Figure 19 .33
The exploded slice has
been selected.
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Return the exploded slice to the rest of the pie.

Drag the slice left.

Figure 19.34
The exploded slice has
been returned to the rest
of the pie.

r

.,

ti File Edit &ellery Chart Format Macro Window
51 PI

:5ERIE5("For Grephlng'I$B$ 1;For Grephl ng'I$A$2:$A$4,
'For Grephin '!$B$2:$B$4,1)
1980

•

.._Reedy

C lick on the smallest slice and drag it
out of the pie.
Figure 19.35
The smallest slice has been
exploded out of the pie.

r

E xplode this slice of the pie.

.,

li File Edit G11l1ery Ch11rt Form11t Mlltro Window
51 P3

10

:SERIES('For Grephlng'I$B$1 ; For Grephtng'I$A$2:$A$4,
'For Grephi n '!$B$2:$B$4, 1)
1980

m

.._Reedy

Pull down the Chart me nu . se lect the
Attach Text option and release the
mouse button .

You a re going to label this slice.

Macintosh Productivity Tools

-Attach TeHt To
0Chartntle
0 Uo tu~ RltiS
0 [ o t~gory R11is
® Series and Data Point
Series Number:

II

Point Number:

~

Figure 19.36

I

OK

I

(

Cancel

1

The Attach Text dialog
box.

I

The Series and Data Po int button has been selected. You
are labeling the third point of the first series.
Click on the OK button.

Add the label. T he value 26 wi ll appear, which is the
number that the slice represents.

Double-click on the 26 on the edit line .

You want to change the text.

Profits

Enter the text " Profits" for the slice label.
Figure 19.37
The label is going to be
changed from "26 " to
" Profits".

[cr]

Make the change.

Click on the largest slice.

You are going to label this slice.

Pull down the Cha rt menu, select the
Attach Text option and release the
mouse button.

You are going to label this slice.

Click on the OK button.

The label 105 will appear by the largest slice.

Double-click on the 105 on the edit line .

You want to change the text.

Sales [cr]

Change the text to read "Sales" .

Click on the Sales pie slice a second
time .

You want to make another change affecting this slice.
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This option will let you change the fill pattern used for a
slice.

Pull down the Format menu and select
the Patterns option.
Figure 19.38

The Pattern option has
been selected.
TP.IIt •••

S<DIP ...
Legend•••

Meln Chert..•
UuPrloy ...
Moue
Size

Release the mouse button.

Figure 19.39

The Patterns dialog box.

r

Execute the Patterns command. After a brief pause, the
Patterns dialog box will be displayed.

4i File Edit Gallery Chert
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Click on the third pattern from the right
in the Area Patterns portion of the dialog box.

Figure 19. 40 .
A new fill pattern has been

selected.

Getkground Colo

I

-

..

This dialog box lets you control the border of the selected
item on the top half of the dialog, and the fill pattern on
the bottom half. If you are using a color monitor, you
may change the colors of items and see the result on the
Macintosh's screen. You are changing the fill pattern so
it is not solid black.

0 lnuert If Negatlue

Macintosh Productivity Tools

Click on the OK button.

a

File Edit
SIP I

Change the pattern of the selected slice.

Gallery Chert Format Metro Window
: SERIES('For Grephtng'l$6$1 ,'For Grephlng'I$A$2:$A$4,
'for Graphin '!$6$2:$6$4,1)

.,

Figure 19.41

The Sales slice now has a
new fill pattern.

1980

Sties

-

.. Ready

Click on the remaining pie slice.

You want to label the last slice.

Pull down the Chart menu , select the
Attach Text option and release the
mouse button.

You are going to label this slice.

Click on the OK button.

The label 79 will appear by the slice.

Double-click on the 79 on the edit line.

You want to change the text.

Costs [cr]

Change the text to read "Costs".

Click at the left edge of the window.

De-select all parts of the chart.

r

a

File

Edit

.,

Gallery Chert Format Metro Window

The completed pie chart.
Note where the mouse
pointer was clicked to deselect the complete chart.

Chert2
1980

Sties

.. Ready

Figure 19.42

-
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XS

The Save command. Remember, a chart is a separate
entity from the spreadsheet and must be independently
saved.

PIE CHART

Name this chart PIE CHART.
The correct disk drive should be displayed in the dialog
box. If not, use the drive and eject buttons to have your
disk showing in the dialog box.

Click on the Save button.

Save the spreadsheet.

Click on the Zoom box at the right of
the title bar.

Return the chart to its original size. You should now be
able to see the spreadsheet behind the pie chart.

Click on the spreadsheet.

Make the spreadsheet the active window.

-

19.6 MULTI-LINE/MULTI-BAR GRAPHS

Recall that the purpose of multi-line a nd multi-bar graphs is to produce a comparison between
two or more sets of data, o r to show a relationship among two or more sets of data.
In the section that follows you will create a multi-data set graph to show the relations hip
among sales, costs and profits.

WHAT

To Do

Select the range Al:F4.

WHY

You ARE DotNG lr

You are going to chart all the data.

Figure 19.43
All of the woric on the
spreadsheet has been
selected.

XN

T he New command.

Click on the Cha rt button.

You are going to create a new chart.

Cl ick on the OK button.

Create the chart. It will be titled Chart3.

Cl ick on the zoom box at the right s ide
of the title bar.

Make the chart fill the complete screen.

Macintosh Productivity Tools

r

•

Fila Edit

,

&ellery Chart Format Metro Window

Figure 19.44
The chart has three sets of
data plotted.

Chart3
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With several different columns (as you have created
here) , bars or lines, it may become confusing as to which
column , bar or line represents which set of numbers.
This situation is rectified by the addition of a legend to
the chart.
Pull down the C hart menu and select the
Add legend option.

This command is used to add a legend to a chart.

Figure 19.45
The Add Legend option of
the Chart menu has been
selected.

AHes •..
Grldlines ...
Add Ouerlay
Select Chart
MA
Selett Plot Area
Protect Document ...
Calculate Now
Short Menus
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Execute the Add Legend command. After a brief pause,
a legend wi ll appear on the right side of the display.

Release the mouse.

Figure 19.46
A legend has been added
to the graphic.
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The legend labels of sales, costs and profits were taken
from the text information found in the first column of the
range used to create the chart. In this case the legend
labels are found in cells A2 , A3 and A4 . As with the first
chart you c reated, the X-axis labels, the years, are taken
from the first row of the range used to create the chart.
Click on one of the bars displayed for
the Sales figure.
Figure 19.47
The first data series has
been selected. Note the
white boxes on the
columns representing the
Sales figures.

,. s

File Edit
S t P3

iO

Select the first data series.

Gallery Chart Format Macro Window
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Macintosh Productivity Tools

Pull down the Format menu , select the
Patte rns option and release the mouse
button.

You want to change the fill pattern .

Click on the third fi ll pauern from the
right in the lower portion of the d isplay.

You are re moving the solid black paue rn .

Click on the OK buuon.

Complete the change of fill pauern . The Sales columns
will take on the new fill pauern .

r

.,

lit File Edit Gallery Chart Format Macro Window
S I P3

:SERIES('For GrDphlng'I$A$2,'For Graphtng'l$6$1 :$F$1,
'For Grcphtn 'I$B$2:$F$2,1)
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Figure 19.48
The fill pattern for the
Sales values has been
changed.
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Pull down the Chart menu , select Attach
Text and release the mouse button.

You are going to add text to the chart.

Click on the Chart Title button.

You are going to place a title on the chart.

Click on the OK buuon.

Add the title. The preset text is " Title".

Double-click on the word Title on the
edit li ne.

Select the text to be changed.

Sales History [cr]

Change the text to Sales Histo ry.

Pull down the Chart menu , select Attach
Text and release the mouse buuon.

You are going to add more text to the chart.

Click on the Value Axis button .

You are going to label the Y-axis

Click on the OK buuon.

Add the label. The preset text is " Y".

Double-click on the leuer Y on the ed it
line.

Select the text to be changed.

Millions of $ [c r]

Change the text to Millions of $.
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Pull down the Format menu , select the
Text command and release the mouse
button.

You are going to change the Y-axis label to vertical
positioning.

Click on the Vertical Text box.

Set the·text to vert ical.

Click on the OK button.

Exit the dialog box.

Pull down the Chart menu, select Attach
Text and release the mouse button.

You are going to add more text to the chart.

Click on the Category Axis button.

You are goi ng to label the X-axis

Click on the OK button.

Add the label. The preset text is "X " .

Double-click on the letter X on the edit
line.

Select the text to be changed .

Year [cr]

Change the text to Year.

Figure 19.49

The chart has been
labeled.
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XS

The Save command.

BAR CHART

Name this chart BAR CHART.

Click on the Save button.

Complete the Save command .

Pull down the Gallery menu, se lect the
Line option and release the mouse
button.

You want to look at this chart in another format.

Macintosh Productivity Tools

C lick the mouse button on line chart
type 4.

This line chart includes gridlines.
Figure 19.50
Line type 4 has been
selected.

Create the multi-line chart fro m the multi-bar chart.

Click on the OK button.

r
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Figure 19.51
The same data is now
displayed as a multi-line
chart.
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Pull down the Gallery menu , select
Column and release the mouse button.

You are going to return the chart to a Column format.

Click on Column chart type 4.

This format will overlap the columns of the chart.

Macro

Window

Figure 19.52
Column type 4 has been
selected.
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Click on the OK button.

Figure 19.53
The overlapping column
chart format has been
selected.

r

Create the overlapping column chart. Note that the fi ll
style change you made for the Sales values has been lost.
T his happens whenever you change chart types. Keep this
in mind. You should change fill styles after you have
selected the chart type.
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19.7 STACKED BAR CHARTS

As you saw when creating the multi-line a nd multi-bar graphs, this type of g raph s hows a
comparison of sets of values on the same sca le. Another way to compare the values in two or
more sets of numbe rs is to show their re lative impact on the total of the numbers and still display
the amount each figure is contributing to the total. This is the function of the stacked bar c hart.
This is the type of graph you will create in the following section.

WHAT

To Do

Click the mouse on one of the columns
representing Sales.

WHY

You ARE DoiNG

IT

You want to remove this series of information from the
chart. This series represents a row of data in the middle
of the chart range.
The graph you are now c reating , to show the relation
between sales and costs , should not include the sales values, because the cost value plus the profit value should
equal the sales value. You do not want to double count a
number in the graphing process.

Macintosh Productivity Tools

,.

•

.,
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Figure 19. 54
The Sales columns have
been selected
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Select the series description on the edit
line.

,. •

File Edit 611llery

[BackSpace]

Ch11rt fonn11t

-

IQi

..

You are going to edit the complete description for this
column of the graph.

M11cro Window

.,

Press the backspace or delete key on the keyboard to
erase the description of the column.

.,

[crj

Fi gure 19. 55
The complete series
definition has been
selected.

Figure 19. 56
The series definition has
been removed.

Enter the empty line as the description for this series of
data. T he chart will change to display j ust Costs and
Profits.
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Figure 19.57
The chart now has only
two sets of data displayed,
Costs and Profits.

r
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Pull down the Gallery menu , select
Column and release the mouse button.

You are going to use a new Column chart type.

Click on Column type 3.

This is a stacked column chart.

-

Figure 19 .58
Th e third column style has
been selected.

Click on the OK button.
Figure 19.59
The stacked column chart.

r

C reate the chart.
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Macintosh Productivity Tools

Pull down the File menu, select the Save
As command and release the mouse
button.

You do not want to use the Save command , since that will
change the saved chart called BAR CHART to the current
chart.

STACKED

Name this chart STACKED.

Click on the Save button.

Complete the Save command.

-

19.8 SAVING A CHART IN THE SCRAPBOOK

Yo u should recall that it is possible to add a g raphic to your Word documents. You did this task
earlier in the text by importing the g raphic thro ugh the scrapbook. It is possible to include an
E xcel chart in a Wo rd document by first placi ng the chart into the scrapbook , and then retrieving
it while usi ng Word.

WHAT

To Do

Pull down the Edit me nu.

WHY

You ARE DotNG

IT

Look at the Edit menu. Since you have not selected any
part of this chart, the Cut, Copy and Paste commands are
all dimmed. There is nothing available on which these
commands can operate.

Chart

:•:z
Repeat Column
[ut

£opy
PDs1e
[IPDr•••
PDS1 e

aY

Figure 19.60

The commands on the Edit
menu are all dimmed.

:•:It

:•:C
:•:l•

:•:D

Release the mouse button.

You cannot do anything with the Edit commands at this
time.

Click the mouse pointer above the
columns of the current chart.

Select the complete chart. You will see the word Chart
appear to the left of the edit line, and handles will appear
around the complete chart (Figure 19.61 on the next
page) .
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Figure 19.61

The complete chart has
been selected. Note the
location of the mouse
pointer in this figure . This
is the area that the pointer
was positioned when the
mouse button was clicked.
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Figure 19.62

The dashed line
surrounding the complete
chart indicates that it has
been copied to the
clipboard.

%
j

T he Copy command. If you pull down the edit menu , you
will see that this command is no longer dimmed. Whe n
you execute this command, a dashed line will appear
around the complete c hart, indicating that it has been
placed into the clipboard fo r copyi ng.

"' •

File Edit &allery Chert
Chert

Format

Macro

.,

Window

STACKED
0

0

0

sales Htstorv
H

I

140
120
100

0

On

80

0

60

.COSTS

0

40
20
0
$

1980

1981

1982

1983

Veer
0

0

.

, Re11dy

Pull down the Apple me nu, select
Scrapbook a nd release the mouse
button .

PROFITS

Activate the Sc rapbook.

1984
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The Paste command from the ed it menu. This will place
the chart into the scrapbook.

r
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Figure 19.63

The chart is now in the
scrapbook.
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Click on the close box on the scrapbook's title bar.

Put away the scrapbook. This chart is now available to
you to paste into a Word document or any other application that accepts graphic information from the scrapbook.

-

1 9.9 PRINTING YOUR CHARTS

Figure 19.64

The value of the graphics you have created would be greatly reduced if you could not output them
onto paper or some other form of hardcopy, such as acetate film for an overhead transparency.
This last section helps you generate the printed copy of your graph.
To continue with this section, the computer you a re us ing MUST have a pri nte r o r plotter
attached. If you attempt to print/ plot without one of these devices attached, you will waste some
time while the computer looks for the printer.
You are going to print the c urrent chart first. This is the Stacked cha rt that you have been
worki ng with.

Page Setup on the File
menu has been selected.

XS
Seue Rs ...
Seue Wortcspece..•
SIIU8

Delete•••
WHAT

To Do

WHY

You ARE DotNG IT

Pull down the File menu and select Page
Setup.

You want to make a change in the page setup before
printing the chart.

Release the mouse button.

Activate Page Setup (Figure 19.65 on the next page).
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Figure 19.65
This is the Page Setup
dialog box you will see if
you have selected an
Image Writer printer using
the Chooser.

I

lmageWrlter
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0 International Fanfold [Cancel]
0 Computer Paper
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Figure 19.66
This is the Page Setup
dialog box you will see if
you have selected a
LaserWriter printer using
the Chooser.

IZ'-------,

0 Screen Size
®Fit to Page

0 Full Page

I
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Laserwrlter Page Setup
5 .2
OK
Paper: ® US Letter 0 R4 Letter 0 Tabloid
(Cancel]
0 US Legal 0 BS Letter
Printer
Effects:
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Help
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Orientation
181 Graphics Smoothing?
181 Faster Bitmap Printing?

Ill~

Margin~·~==:;----;:===:;.,

Figure 19.67

Left:
Top:

The Landscape orientation
has been selected.

:=lo=
.7=
5=~1

I•
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Click on the sideways orientation icon.

Th is orientation, called Landscape orientation, will print
the charts sideways on the page. The o rig inal o rie ntation,
called Portrait o rientation, will print a s maller chart on
the page .

Click on the OK button.

Leave the Page Setup dialog box.

Orientation

lii]

Right:

I Bottom: I•

Slz- - - - - - - ,
0 Screen Size
®Fit to Page
0 Full Page

The P rint command , fo und on the File menu.
Click on the Page Preview check box at
the lower left corner of the dialog box.
Figure 19.68
This is the Print dialog box
you will see if you are
using an Image Writer
printer.

You want to see what your output will look like before
printing it.

lmageWrlter
Quality:
®Best
Page Range: @All
Copies:
Paper Feed: ®Automatic

D

~Page

Preulew

0 Faster

0

0 From:

To:

D

0 Hand Feed

0 Print Using Color

Droit

D

x2.7

~.....o.."- "'1
(Cancel]
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Figure 19.69
This is the Print Dialog box
you will see if you are
using a LaserWriter printer,
although your printer
name may be different.

You want to see what the chan will look like.

~------------------------------------------------------~,~

Figure19.70
The Page Preview display
for the current chart.

!J.i.i.i.i.~
C lick on the Print bul!on.

If you have a printe r attached to your computer, print the
chart. Othe rwise, cl ick on the Cancel bul!on.

Figure 19.71
The output generated
when you print the chart.
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It is a simple matter to print the other two charts you c reated . Start by making the one you
want to print active using the Window menu , as shown in Figure 19.72. When the desired chart
is active you must once again select the Page Setup command on the File menu to change the
printing orientation to Landscape. Finish the task by selecting the Print comma nd, also found on
the File menu , or by pressing the XP key.
Figure 19.72
The Window menu has
been pulled down. The
check mark in front of
STACKED indicates that it
is the currently active
window. The Sales History
chart has been selected,
and will become active
when the mouse button is
released.

Show Cllpboerd
Rrrenge All
Hide
IJnhldP•••
I For &rephlng
2 PIE CHART

When you a re done printing charts, press XQ to quit Excel and return to the Macintosh
Finder. Depending on what you have done, you may see d ialog boxes asldng you if you want to
save changes to some of the items you have open. Click on e ither the Yes or No button to
complete the Quit process. Be aware that changing the print orientation to Landscape is a
modification to the graph a nd should be saved if you want the change to be retained.

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.

Must the val ues you want to graph be entered on the spreadsheet before you may view or display the graph?
Are the main graph titles placed above or below the graph?
What data range is used to supply the labels for the X-axis?
What data range is used to supply the names of the slices for a pie chart?
Are the data values different for line and bar charts, or may one set (or group of sets) of data be displayed in e ither
format?
What will happen if you select the range A2:F3 of the For Graphing spreadsheet and create a column chart? What does
this chart look like? Is this what you expected would happe n?
To create a multi-line cha rt, what is the minimum number of rows that must be selected?
What purpose do legends serve on a graph?
How does a stacked bar chart show the comparison of values versus the way a standard bar chart shows the comparison of
values?
Create a line graph of the following data:
Year
1978
1979
1980
198 1
1982
1983

Sales
$51 ,000
$ 54,500
$ 62,500
$69,000
$ 79 ,250
$ 85 ,875
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11. Create a bar graph of the following data:
Year
1978
1979
1980
1981
1982
1983

Profit
$ 1,121
$2,302
$ 3,265
$4,100
$4,877
$ 5,541

12. Turn the line chart you made in Exercise 10 into a bar chart.
13. Turn the bar chart you made in Exercise 11 into a line chart.
14. Create a pie chart of the following data:
Sales by Division in Millions of Dollars
Division
Northwest
Southwest
Midwest
Northeast
Southeast

Sales
$ 1.5 million
$ 2.2 million
$ 1.8 million
$ 2. 1 million
$ 1.1 million

Create the following spreadsheet for Problems 15 through 19.
A

B

c

D

E

F

G

H

10TAL
10TAL
PERCENT PERCENT PERCENT
2
CURRENT
CURRENT CURRENT CHANGE
CHANGE
CHANGE
3 YEAR ASSETS INVEN'IORY
LIAB.
RATIO
ASSETS INVEN'IORY
LIAB.
4 1980
1327.0
542.8
1.49i
889.3
5 1981
1418.4
583.7
1.462
970.0
7.54%
6.89%
9.07%
6 1982
1432.7
578.6
976.8
1.467
1.01%
0.70%
-0.87%
7 1983
1575.9
603.4
1.487
1059.6
10.00%
4.29%
8.48%
8 1984
1703.0
1.464
656.9
1163.6
8.07%
8.87%
9.82%
1778.5
9 1985
663.9
1232.7
1.443
4.43%
1.07%
5.94%
10 1986
1886.6
1.433
691.6
1316.5
4.18%
6.08%
6.80%
11 1987
2001.3
720.5
1406.1
1.423
6.08%
4.18%
6.80%
The cell formula for E4 is (B4/D4), or Current Assets divided by Current Liabilities. This cell should be copied for
theE column. The formula for F5 is ((B5-B4)/B4). This can be copied into cells G5 and H5, and then down the F, G and
H columns. Use Range formatting to make the Year column display as an integer; the Current Assets, Inventory and
Current Liabilities columns display as fixed decimal with one digit to the right of the decimal point; the Current ratio as
fixed decimal with three digits; and the three percent change columns display in percent format with two digits to the right
of the decimal.
15.
16.
17.
18.
19.

Create a line chart of the current ratio column.
Create a multi-bar chart of the Total Current Assets, Inventory and Total Current Liabilities columns.
Create a multi-line chart of the three percent change columns.
Create a pie chart of the 1983 current assets, inventory and current liabilities values.
Print the graphs you created in Problems 15 through 18.

CHAPTER

AN INTRODUCTION
TO HYPERCARD

-

CHAPTER OBJECTIVES:

Upon completion of this chapter, the student will:
•
•
•
•

Create a new stack.
Create buttons.
Create fields.
Add graphics to a card.

• Link cards.
• Create and modify a HyperTalk script.
• Print a stack.

-

2 0.1 WHAT IS HYPERCARD?

HyperCard is an application that in some ways resembles a database management program. It
lets you create files, called stacks in HyperCard, that contain records, called cards, that in tum
contain fields.
Like a database manager, HyperCard lets you sort its cards based on the contents of a field.
You may find specific cards based on the contents of its fields. Of course, you can generate
printed copies of cards or a report of the whole stack.
This is where the resemblance between a database management program and HyperCard
ends.
HyperCard lets you link cards in any way you feel is appropriate for the information with
which you are working. For example, you may have a stack in which you are recording the
history of the development of artistic styles. It is possible to link a card that contains information
about a particular artist to cards that contain:
•
•
•
•

samples of his work,
information about the style of printing used,
information about other artists of the same time period, and
information about the society and culture of the time in which he lived.

686

CHAPTER TWENTY -

AN INTRODUCTION TO HYPERCARD

Another stack might be a your address book and appointment calendar. The links you might
see for this stack a re illustrated in Figure 20.1.
Figure 20.1

The arrows show the
possible links among the
various cards of this stack.

All of these different types of information may be in one single stack, or in several different
stacks. It does not matter to HyperCard. It can get information from multiple stacks as easily as
it can from a single stack.
It should be apparent that, since a stack can hold different formats of information, the re are
no fixed rules regarding the fields of a stack. You will see that no two cards of a single stack
necessarily have the same fields. The ability to vary the contents and layout of each card in a
stack is a very powerful feature of HyperCard .
Another powerful feature of HyperCard is the button. Buttons should be fam iliar to you as a
Macintosh user. You know about the Yes and No buttons , Cancel and OK buttons, and several
others that may appear in dialog boxes.
A HyperCard button can serve the same functions as these traditional Macintosh buttons.
Additionally, a HyperCard button can be made to perform any task you want. This is because
you may attach a series of commands to the button . These commands are written in the HyperCard language, called HyperTalk. A group of commands attached to a HyperCard item is called
a script.
The final feature that makes Hype rCard a powerful tool is that scripts may be attached to
any HyperCard item. You may attach a script to stacks, cards, fields or buttons. Thus, not only
can you make HyperCard perform a task when you click on a button, but when you click on a
field , open a stack, click on a card, go to a different card, or at almost any time you want.
HyperCard performs these tasks when an event occurs. The most common event is the
mouseUp . The mouseUp event is detected by Hype rCard whenever you release the mouse button. Another event is openStack, which is the event that can cause something to happen when the
stack is opened. Both these events will be used later in this chapter.

-

2 0.2 LAUNCHING HYPERCARD

HyperCard works easiest on a computer that has a hard disk. If your Macintosh does not have a
hard disk, boot it with the disk labelled HyperCard StartUp. HyperCard is set as the start-up
program on this disk, and will start running automatically. If you do not have a disk labelled
HyperCard StartUp, then boot your Macintosh with a System Start-Up disk, a nd insert the
HyperCard and Stacks disk into one of the computer's disk drives.
If you are using a machine with a hard disk you will not need to insert the HyperCard
program disk into a disk drive. Rather, locate the HyperCa rd folder, and open it so you can see
the HyperCard program icon. Place a disk (see Chapter 3 for how to initialize a new disk) with
at least 200K available space into another one of your Macintosh's disk drives, if you have one
available. This disk will be used for saving your work. If you do not have a free floppy disk
drive, keep this disk available. You will need it for data storage.
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In these instructions, [cr] means to push the Return key on your computer's keyboard
(remember, this is NOT the Enter key). A X in front of a letter (e.g., XX) means to hold down
the Command key while pressing the given letter. Letters enclosed in square brackets (e.g.,
[TAB] or [ENTER]) mean to push that key on the keyboard , and not to type out the word .
Finally, the phrase "Click the mouse on ..." means to move the mouse pointer to the specified
item and push the mouse button once. The phrase " Double-click the mouse on ..." means to
move the mouse poi nter to the specified item and double-click the mouse button. The word
"drag" means to select an item, be it a n icon or the menu selection bar, and move the mouse
while the mouse button is pressed.

WHAT

To Do

WHY

You ARE DotNG IT
Figure 20.2

If the disk's icon is closed, double-cl ick
on it with the mouse pointer.

Open up the disk icon onto the desktop.

Locate the HyperCard folder on the
desktop. If it is closed, double-click on
it with the mouse pointer.

Open the folder containing the HyperCard program.

The HyperCard p rogram
icon.

Locate the HyperCard program icon
inside the disk window (Figure 20.2).
Move the mouse pointer to the HyperCard icon and double-click the mouse
button.

Launch HyperCard. Remember, if you are having trouble
with the double-click, you may select the Excel icon with
a si ngle click, then use the Open command on the File
menu (or XO) to launch Excel.
After a brief pause you will see the HyperCard Home
card. Note the hand icon pointing to the words Home
Card at the top of the screen. This is the mouse icon, and
is called the Browse tool in HyperCard.
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Figure 20.3
The initial Home card. The
Browse tool is pointing to
the words Home Card.
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2 0.3 THE HOME CARD AND HOME STACK

Everything that you do with HyperCard revolves around the Home card. The Home card is the
first card of a small stack called the Home stack. The Home card that is shipped with HyperCard
has several buttons on it that link it to other stacks. Most HyperCard stacks have buttons that take
the user back to the Home card. There is even a command on one of the HyperCard menus to
return you to the Home card . As a result, it is very difficult to get totally lost when using
Hype rCard. You can always return to Home.
In addition to the Home card you are looking at, the Home stack contains several other cards
used by HyperCard. Some of these cards are used to tell HyperCard the names of folde rs that
contain other stacks, applications and documents. As you use and modify HyperCard, the contents of these cards will change. Either you will make changes, or HyperCard itself will make
changes.
The last card of the Home stack is the User Preferences card. With this card you can tell
Hype rCard how much control you want to have over it. By setting the User Preferences level to
the lowest possible level , called Browsing, you severely limit what can be added or changed on a
stack. In fact , at the Browsing level, all you can do is look at the conte nts of stacks and click on
buttons. The opposite of the Browsing level is the Scripting level. This level of HyperCard user
is able to create new cards and stacks, change the information on cards and write scripts for
items on the cards .

-

2 0 .4 FINDING AND USING HYPERCARD BUTTONS

Generally you will find that Hype rCard buttons that are intended for your use are easy to locate
on any g iven card. For example, the Home card has 22 buttons. There is a button underneath
each of the 20 icons on the card , and the two arrows at the bottom cente r of the card are buttons.
If you are ever in doubt about the location of a button on any particular card, you may
quickly find it by using the Option-3€ key. This will draw a dotted li ne a round each button on the
card. Using the Option-3€ key lets you locate buttons on a card that may not be obviously there
when you first look at the card.
To use a Hype rCard button requires no special effort. They operate in the exact same
fashion as all the Macintosh buttons you are familiar with. To activate a button simply place the
mouse pointe r, or Browse tool, over the button and single click the mouse. You never have to
double-click a button.
You should still have the Home card d isplayed on your sc reen at this time.

WHAT

TO Do

3€ [OPTlONJ

WHY

You ARE

DOING IT

Hold down the Command key and press the Option key.
This key combination will reveal the location of all the
buttons on the current card. You can see that they have
dotted outlines.
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Figure 20 .4
The 22 buttons on the
Home card have been
outlined.

Whi le HyperCard recogni zes both a first and last card on
all stacks, they are functionally connected to each othe r.
Thus, the card previous to the first card on any stack is
the last card of that stack. The card after the last card is
the first card of that stack. The Home stack is li ke all
other stacks in this regard.
Position the Browse tool on the rightpointing a rrow at the bottom of the card .

You are going to move forward in this stack. This is a
typical ··next card " button . The next card button can have
a ny icon associated with it, just as any button may have
a ny icon . Generally, however, you will find that a next
card butto n somehow points to the right . suggesti ng
movement in that direction.

Figure 20.5
The Browse tool has been
placed on the arrowhead
at the bottom of the card.

C lick the mouse button .

The right a rrow is a button that will move HyperCard to
the next card in the stack. In fact , this button has a small
script associated with it that tells HyperCard to go to the
next card in the stac k. You will see this sc ript later in this
c hapte r. At present, you should see the card that te lls
HyperCard whe re to look for stac ks.
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Figure 20.6
The second card of the
Home stack.
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file Edit &o

Look for S1acks in:
:HyperCard Stacks:
:More St11cks:
:My St11cks:
:Help Stacks:
:lde11 Stacks:
HyperCard & Stacks:More Stacks:
HyperCard Help:Help Stacks:
HyperC11rd Ideas: Idea Stacks:

Click on the next card button three more
times.

Figure 20.7
The User Preferences card
is the last card of the
Apple Computer, Inc.
distributed Home stack.

You should now be on the card called User Preferences.
This is the last card of the Home stack.

.,

&o

User Preferences
User Name:
User Leuel:
OBrowslng
®Typing

0

TeHt Rrrows

OPalntlng
ORuthoring
OSc:rlptlng

Click on the next card button once.

Since the User Preferences card is the last card in the
stack, the next card button will return you to the first
card of the stack.

Position the Browse tool on the left
pointing arrow head.

This is a previous card button. Just as the typical next
card button suggests mov ing in a forward direction, the
typical previous card button suggests movement in the
backward di rection.
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Figure 20.8
The Browse tool is
positioned on the previous
card button.

Click the mouse buuon.

Cl ick on the previous card button four
more times.

Since you were on the first card of the stack. the previous
buuon will take you to the last card. lis script is to go to
the previous card in the stack. You shou ld once again see
the User Prefe rences card.
After clicking on the previous button four times, you
should once again have the Home card displayed .

Figure 20.9
The Browse tool is on the
Address icon.

Now you are ready to try using a button that has been
linked to anothe r stack.
Place the Browse tool on the icon
labelled Address.

You are going to go to the Address Book.

C lick the mouse bullon once.

T his butlon has a script that te ll s HyperCard to go to a
speci fi c stack. After clicking on this buuon you should
see the first card of the Address stack.

,. •

.,

File Edit &o

Figure 20.10
The first card of the
Address stack.

This is the first Cllrd of the Address

stt~ck.

Note that there are six icons on the left side of this card.
They are all buuons. The top one. a picture of a house,
will return you to the Home card.
Figure 20.11
The Browse tool is
positioned on the house
icon. This button will
return you to the Home
card.

692

CHAPTER TWENTY -AN INTRODUCTION TO HYPERCARD

Figure 20.12
The Stack Ideas button.

C lick o n the house icon at the top left of
the card .

Return to the Home card .

Clic k o n the Stack Ideas butto n .

Take a look at another stack.
If you are using H yperCa rd w itho ut a hard disk, the n
HyperCa rd will not be able to immediately locate this
stack. Instead , you will see a dia log box s imilar to the
o ne shown in Fig ure 20. 13 , asking where to find this
stack .

Figure 20.13
This dialog box appears
when HyperCard is unable
to locate a stack that it has
been told to open.

Where Is Stack Ideas?

I(g) Hypercard I
~ (g) Hyperterd

[' IIUIIll'

Eject

Orlue
Open
Cancel

To open this stack you must insert the d isk labelled
Hype rCard Ideas. Use the drive and eject buttons as necessary so that you can insert this disk into a dis k drive.
Once this disk is in the disk drive , ope n the folder called
Idea Stacks. In the list of stack names that the n appears,
click o n the name Stack Ideas, the n click o n the Open
button . You will now have ide nti fied the stac k and its
location fo r H yperCard.

Figure 20.14
The first card of the Idea
stack. It is one of several
cards that make up the
index to the complete
stack.
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Note that this card also has an icon of a house on it,
although it is different from the one found on the Address
stack. The house icon, which is a button, is fo und at the
top left of the card. There is also a next card button at the
bottom right corner of the card. It is not an arrow, but
rather a hand pointing to the right.
You can see that there is not a previous card button on
this card . The designer of this stack did not want to give
you direct access to the previous card from the first card
of the stack. The reason for this is that the last card of
this stack is not part of the index. It is, in fact , the card
displayed if you click on the balloon at the top right of
the current card.
C lick on the balloon at the top right corner of the Idea Stack card .

This button will take you to a card that tells you about the
Idea stack, and a little bit about how to use the stack.
Figure 20.15
The Browse tool is on the
balloon at the top right
corner of the Idea Stack
card.

.,

Figure 20.16
This is the About card of
the Idea Stack.

About stack Ideas...
This stcck is c collection of ccrds which ccn be used
as idees or templctes for erecting new stccks.
Go to one you like end choose New Steck from the
File Menu.
The stcck you crecte is complete end reedy to use,
or to further customize by pcint ing, cdjusting
fields, or pcsting buttons.
Copyright • 19a7
Apple Computer, lno.

Click on the Home button at the top left
of this card.

You are done with this stack fo r the time being.
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2 0.5 OTHER WAYS TO MOVE AROUND IN STACKS

As you saw on the first card of the Ideas Stack, there is not always a previous card button
displayed or avai lable on a card. The previous and next card buttons are items that are placed on
a card by the person who creates the stack. Thus. it is reasonable to assume that the creator of
the Ideas Stack did not want you to be able to go backwards in the stack from its first card.
When you are creating stacks yourself. you may fo rget to place a previous or next butlon
onto a card. Fortunately, HyperCard provides other ways for getting around in your stacks
through the Go menu. You will try them now.

WHAT

To Do

Pull down the Go menu.

WHY

You ARE DOING

IT

The commands on this menu are used for moving around
in stacks.

Figure 20.17
The Go menu has been
pulled down.

Home
Help
Recent

ICH

First
Preu
NeHt
Last

881
882
883
X4

Find•••

ICF

an

88R

The first command found on the Go menu is Back. With
this command you can trace backwards th rough the cards
you have looked at, regardless of the stack they are in.
Drag the mouse down to the Back command and release the mouse button.

You will be retu rned to the About Stack Ideas card.
HyperCard knows that this was the card you were looking
at before you returned to the Home Card. It does not
matter that the card is not in the same stack as the Home
Card.
Note that this command may be executed by using the
:l€ - key. The tilde (-) is found to the left of the space bar
on the standard keyboard. and to the left of the numeral I
on the extended keyboard.
Go back another card. This is the first card of the Stack
Ideas stack.
Go back another card. You should return to the Home
card. since that was the card you were looking at when
you decided to use the Stack Ideas stack.
Go back one more card. You should now be on the first
card of the Address stack.

Pull down the Go menu.

Once again look at this menu .

Macintosh Productivity Tools

Drag the mouse down to the Home
command.

The second command is Home. Note that you may use
the ~H key to execute this command.
Figure 20.18

38-

The Home command has
been selected.

381

38R
381
382
383
384
Find...
Messa e

38F
38M

Release the mouse button.

The Home command will return you to the Home Card.

Pull down the Go menu and d rag the
mouse down to the Recent command.

This command will take you to the Recent display. On
this display, HyperCard will show you miniature versions
of the last 42 unique cards you have looked at. Note that
this command may be executed with the ~R key. Card
images are placed on this display automatically. You do
not have to do anything special when you create your own
stacks.
Figure 20.19

The Recent command has
been selected.

Home
Help

First

Preu

Release the mouse button.

••

NeHt
Last

382
383
384

Find...
Messa e

38F
38M

Execute the recent command .
Figure 20.20

The current Recent display.
The border around the
image of the Home card
means that that is the card
you were looking at when
you executed the Recent
command.
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There arc eight cards displayed here at this time. Even
though several cards have been viewed more than once,
they are displayed here only once . To max imize the number of cards that appear on the recent display, only
unique occurre nces of cards appear here. Thus, even
though the Home card has been viewed several times. it
appears here onl y once.
You can see that the Home card has a frame around it ,
indicating that it is the current card.
Position the mouse on the image of the
About Stack Ideas card.

This card image appears directly below the Home card
image. You want to go to this card.

Figure 20.21

The mouse pointer is now
positioned on the card you
want to go to.

C lick the mouse button.

By clicking on the card image, you are instructing HyperCard to go to that card. Once again, you are looking at
the About Stack Ideas card .

Pull down the Go menu and drag the
mouse down to the Next command .

The Fi rst, Prev, Next and Last commands on the Go
menu also provide you with a way to get around stacks
when you have not put buttons to give you these functions
on the cards of your stack.

Figure 20.22

The Next command has
been selected.

Bact

a-

Home
Help
Recent

a1

aH

aR

First

at

Preu

a2

Last

a4

Find...
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Menage aM

The Next command, which may be executed by using
3C3. will take you to the next card in the stack. It was
suggested earlie r that the About Stack Ideas card is the
last card in this stack, so the next card should be the first
card.
Release the mouse button.

Go to the next card. Once again you should see the first
card of the Stack Ideas index.
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X3

Go to the next card. This command key has the same
effect as pressing on the next card button that is located
at the bottom right of the card. You should now be on
card 2 of the Stack Ideas index.

X3X3

Two more presses of the Next command will bring you to
the fourth card of this stack. You can see that this card of
the Stack Ideas Index has a previous button, but not a
next button at the lower right corner of the card .

Figure 20.23
The fourth card of the
Stack Ideas index does not
have a next card button.

X3

' a

Go to the next card , even though there is no next card
button. This appears to be another form of the address
card, with several buttons placed at the bottom of the
card, rather than on the left s ide of the card.

File

Edit

.,

Go

Figure 20.24
This is the fifth card of the
Stack Ideas stack. You got
to it by using the Next
command.

Royce Walthrop
217 Crocker Lane
Hillsdale, Ohio 44704
(216)555-3452
Work: General Sprocket
(2 16)555-7654

Pull down the Go menu and drag the
mouse down to the First command.

The First command , which may be executed by using the
X I key, will take you to the first card in the current stack.

Figure 20.25
Home
Help
Recent

Preu
NeHt

Last
Find...

•H

•1
•a
•2

.3

•4

•r

The First command has
been selected.
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Release the mouse button.

You will return to the first card of this stack.

Pull down the Go menu and drag the
mouse down to the Prev command.

The Prev command will take you to the previous card in
the stack . It may be executed by using the X2 key.

Figure 20.26
The Prev command has
been selected. Prev is short
for the word previous.

Last

X4

Find...

IIF

XM
Release the mouse button.

You will now, once again, be on the About Stack Ideas
card . You already knew that this card was the last card of
the stack, which is why it is prev ious to the first card .
Always remember that the cards in all stacks "wrap
around ", so you can get to the last card by goi ng backwards from the first, or the first card by going forwa rds
from the last.
Go to the previous card . This is a suggestion for a note
pad. It has a quote from Winston Churchill on it.

Figure 20.27
The current card, a note
pad suggestion.

"Now this is not the end.
It is not even the beginning
of the end. But it is, perhaps,
the end of the beginning."

Winston Churchill
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Pull down the Go menu and drag the
mouse down to the Last command.

This command will take you to the last card in the current stack. It may be executed by pressing the 3€4 key.
Figure 20.28
The Last command has
been selected.

Flnt

Preu

••

a2

NeHt

Release the mouse.

Once again, the About Stack Ideas card will be displayed.

:ICH

Use the Home command to return to the Home card. You
may, of course, click on the home icon at the top left corner of this card to accomplish the same thing.

-

20.6 SETTING THE HYPERCARD USER PREFERENCE
LEVEL

Be fore continuing, you should modify the User Pre ference level at which you are working.
There are five user levels, each incorporating all the capabilities of the previous level , and
adding capabilities of its own. By setting the highest possible user level, Scripting, you will have
complete control over HyperCard and the stacks you use. At this level you are able to use the
painting tools and their associated menus, create new buttons and fields, and add scripts to the
stacks. The lowest possible level , Browsing, simply lets you look through stacks , but not make
any changes.

WHAT

TO Do

Click on the previous card button at the
bottom of the Home card.

WHY

You ARE DotNG IT

You want to go to the last card in the Home stack. This
card lets you set the User Preferences level. You saw this
card when you were exploring the Home stack.
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Click on the Browsing button.

Set the user level to the lowest possible level.

Figure 20.29

The Browsing user level
has been selected. Only
three items now appear
on the menu bar.

User Prefereocea
UserN11me:
User Leuel:

.J@ Browsing
'(0Typlng

0
0
0

Plllntlng
Authoring
Scripting

When you select the lowest possible user level, only three
options will appear on the menu bar, File, Edit and Go.
Move the Browse tool to the User Name
area on this card.

Figure 20.30

The Browse tool will not
change to an /-beam when
the User level is set to
Browsing.

The User Name is a text field on this card. You are
allowed to enter your name into the Home Card. However, the Browse user level does not allow changes to
anything on any card. The Browse tool does not change
to the 1-beam that lets you enter text into text fields, as
you will see in a moment.

..

•

File

Edit

&o

UserPJ
User N11me:

;a,

User Leuel:
®Browsing

Click the Browse tool on the Scripting
button.

Give yourself full powers. The menu bar now has the
Tools and Objects menus added to it, and other options
appear in the User Preferences box.
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Move the Browse tool back to the User
Name field.

r

a

File Edit

Go Tools

Note that the mouse now changes to the 1-beam, indicating that it is located inside a field , and that you may type
into the field.

,

s

0

User Preferences

I

UserName:
User Leuel:

0 Browsing

0

Typing

OPalntlng

0

0
0

TeHt Hrrows

0

Blind Typing

Figure 20.31
The User Level has been
changed to Scripting,
adding Tools and Objects
to the menu bar. The
Browse tool has changed
to the /-beam, since the
mouse has been positioned over a text field
into which you may type
information.

Power Keys

Huthoring

®Scripting

If you want to ente r a User Name, click the mouse button
once to get a blinking cursor in the User Name field.
Once you have the blinking cursor, you may type an entry
for User Name.

r

*

File Edit

Figure 20 .32
The mouse button has
been clicked, making the
blinking cursor appear in
the User Name field. Once
the cursor is showing in a
field, you may type text
into that field.

Go Tools Objects

User Pn:
User Name:

I

I

User Leuel:

Click on the Next Card button.

Return to the Home Card.

-

2 0.7 THE CARD BACKGROUND
HyperCard works in layers, as well as in User Preference levels. So far you have been looking at
HyperCa rd 's card layer. This is the layer that most of the HyperCard activity you have seen so
far happens. The re is, however, a second layer called the background.
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The background is beneath the card. Think of the card as being transparent. This means that
anything placed on a background can be seen when you look at the card. The exception to this is
when you place an opaque object on the card over part of the background. The the background
may hold buttons and fields , just as the card over it does. The advantage of the background is
that it may be shared by many, or even all, the cards of the stack. This means that, if every card
in a stack is to pe rform the same task, you do not have to create and place buttons an9 fields on
each new card. The buttons and fields are created once, on the background, and are there for aJI
the cards as they are created and added to the stack.
Before you continue, make sure that you are looking at the Home card.

WHAT

TO Do

WHY

Pull down the Edit menu and drag the
mouse down to the last command ,
Background.
Figure 20.33
The Edit menu has been
pulled down and the
Background command
selected.

You ARE DoiNG

IT

You are going to go to this card 's background. Note that
you may use the :M:B key to execute the Background
command.

Go Tools

Db

Undo

acz

[ut

:Jl<K
>l!<[

[ DIHJ

aeu

Paste Button
(INU

Release the mouse button.
Figure 20.34
The Home Card's
background. Only the
previous and next card
buttons remain. The menu
bar is striped, indicating
you are working on the
background.

New Card
Delete Card
Cut Card
Copy Card

81N

Teat S1~Jie.. .
ll<H kgt ound

>l!<T
u ll

Go to the Home card 's background.
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The first thing you should notice about the background of
the Home card is that nearly all the buttons that connect
to other stacks are gone. Only the previous and next card
buttons remain at the bottom of the card.
Next look at the menu bar. It is striped . This is a visual
indication that you have selected the background.
The image of a stack of cards on a gray background that
you are now looking at is in the background. If it was on
the card itself, it, like the buttons, would have disappeared when you executed the background command.
X[OPTION]

Hold down the Command and Opt ion keys. Remember
that these two keys will cause HyperCard to display the
outlines of the buttons on the current card.
Figure 20.35

The card buttons are
outlined.

r--, D [--~ -,-l
[--]
=--, ,~ ;
___
L_JL_jD DDD
D OD D D
DCJ
J

••

Note that the outlines around the Next and Prev card
buttons are heavier than all the rest of the button outlines.
This indicates that these two buttons are on the background of the card.

XB

You are done looking at the card background for now .
The Background command is a toggle. If you are already
looking at the background , executing the command agai n
will cause you to leave it.

-

2 0.8 CREATING A NEW STACK

Now that you know how to move around in stacks and you know about the background, it is time to
create a stack of your own . You will then learn how to place graphics, buttons and fields onto cards
and backgrounds. The stack that you create will be used to keep track of people's birthdays.
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When you create a new stack you may have HyperCard duplicate the current card's background. This is helpful when you want to make a stack of a sing le card , such as those found in
the Ideas Stack, o r if you want to make an e mpty copy of an existing stack , retaining all the
background informatio n.
At this time you will not copy the background whe n you create a new stack. Even thoug h the
Next and Prev card buttons are of value, and might be worth copying , we want to create a stack
with no graphics on the background card . Thus, when you c reate the stack, you wi ll not copy the
background.

WHAT

To Do

Pull down the File menu and drag the
mouse down to the New Stack command.

WHY

You ARE DoiNG IT

This is the first command option found on the File menu .

Figure 20.36
The New Stack command
has been selected.
saue a Copy •••
Compact Stack
Protect Stack •.•
Delete Stack •••
Page Setup •.•
Print Card
Print Stack..•
Print Report•••

Release the mouse button.

88P

Execute the command. You will now see the New Stack
dialog box.

Figure 20.37

Ieil Hypercard Stacks I

The New Stack dialog box.

D

flddre~s

.l:!. CJ HARDPAC 40

Cl D<t1 eDool:
D fill.' lodt.>,l
D llorne
D lllJPet"Coh
D Pttone

New stack name:

(

Ejec1

J

New
Cancel

181 Copy current background

Note that beneath the New Stack name box is a check box
that lets you retain the current card's background. It is
presently checked , which tells HyperCard to copy the
background.
Click on the check box in fro nt of Copy
current background.

Remove the check from this checkbox. You do NOT want
the current background to be copied .
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Click on the Eject and Drive buttons as needed to located
your disk in a disk drive.
Name this stack MY STACK.

MY STACK

Figure 20.38

Ieg Hypercard Stacks I
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[) nome
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J

DtiL•e

New

New stack name:

IMY STRC!CI
0

The dialog box has been
completed. Note that the
checkbox has been
cleared. You do NOT want
to copy the current card's
background.

PRC

Cancel

Copy current background

Click on the New button.

Create the stack.
Since you did not copy the background, you should now
have a completely empty display, except for the menu bar
and Browse tool.

r

a

File

Edit

Go Tools

Objects

.,

Figure 20.39

Your new stack has
nothing on it.

-

20.9 CREATING A NEW BUTTON AND ESTABLISHING
A LINK

Creating a button is a simple task. All you do is use the New Button command found on the
Objects menu. As you wi ll see late r, you must take care when you create a new button, o r any
object for that matter, to place it on the desired "surface", either on the card or the card's
background .
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A L ink is a button that , th rough its script, links the current card to a nother card. Generally,
you link to a card othe r than the next o r previous one in the current stack, although these would
be legitimate links. In this section, you w ill add a new butto n to the Hom e card so that it can be
linked to the stack you have just created. This button will then let you go directly to your stack.

WHAT

To Do

XH

WHY

You ARE DoiNG

IT

The Go Home command. You may also find this command on the Go menu. You want to be on the Home
card , s ince this is where the button that will link to your
stack is to be placed .
Earlier you set the user level for HyperCard to Scripting.
Thus, the menu bar should contain the items File, Edit,
Go, Tools and Object. If not , return to the User Prefe rences card of this stack and click on the Scripting button,
then return to the Home card.

Pull down the Objects menu and drag
the mouse down to New Button.

Figure 20.40
The New Button command
has been selected on the
Objects menu.

Release the mouse button.

The New Button command will create a new button on
the current card. S ince we have NOT selected the background , this button will be placed on the card . We will
create a background button later in the chapter.

Cent Info•••
Bkgnd Info•••
Steck Info•••

>Kc •

Dl1ng

CIO~ l'r

~l'nd

Fa11he•· >K<·

By releasing the mouse button, you will create a new button. It will appear in the center of the card , and have the
words New Button displayed on it.
Note, in Figure 20 .4 1, that all the buttons have solid outlines. When you create a new button, you temporarily
leave the browse mode, and ente r the button editing
mode. When in this mode , all the buttons are identified
by the solid outlines.
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File

Edit

Go

.,

Tools

Ea Home Card ~

Drag the New Button to the lower right
side of the card .

Figure 20.41
The New Button has been
placed at the center of the
current card.

Perform this drag as you normally would . Place the
mouse pointer on the center of the new butlon, press and
hold the mouse button and then drag the item to its new
location. You will see later that if you try to drag a button
using one of its corners you will re-shape the button,
rather than dragging it.
You should notice two things . First, the New Button outline is a moving dashed line. Th is is to let you know
which particular button has been selected. Selected
buttons do not appear in inverse.
Next, you should notice that the mouse pointer is no
longer the hand, or browse tool. When you are working
in either the button editing mode as you are now , or the
field editing mode, the mouse pointer returns to the
familiar arrowhead. The pointing hand browse tool is displayed only when you are in HyperCard's browse mode.
Figure 20.42
The new location of this
button is the lower right
corner of the Home card.
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Pull down the Objects menu and drag
the mouse down to the Button Info ...
command.

This command will give you a dialog box that will let you
change the text on the button, the shape, and do other
things to the selected button.

Figure 20 .43
The Button Info command
has been selected.

Card Info•••
Bkgnd Info.. .
Stack Info.. .
Bring Closer ••
Send farther •New Button
New Field
New

Release the mouse button.

You will now have the button information dialog box fo r
the selected button. In the future, you should try to
double-click on the selected button to get this dialog box.

Figure 20.44
The New Button dialog
box.

Button Name:
Card button number: 21

Style:

card button 10: as

0

~Show

transparent
Oopaque
0 rect angle
O shadow
®round rect
O check boH
0 radio button

name

0

Auto hlllte

(

Icon ...

~

I

( LlnkTo... )
Script...

I

OK

,

( Cancel

At present, the Button Name box is selected. We will
start here by changing the name of the button.
My Stack

Change the name of this button to My Stack.

Click on the Shadow style button on the
right side of the dialog box.

You want to have the button shown on the card. This style
will add a slight drop shadow to the button. It is a little
bit more visually interesting than a plain rectangle.
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Figure 20 .45
Button Nome: ~..IM_y:;._s_tu_c_~=--------'
Cord button number: 21
Style:
card button 10: 85

0 transparent
Oopoque
Orectongle

181 Show name

0
(

Ruto hlllte
Icon...

( LlnlcTo...

~shadow

0 round rect

J

Ocheclc boH
0 radio button

I

l

Script ..•

Note the two changes in
the dialog box.

J( Cancel

OK

Click on the LinkTo ... button.

You are now going to tell HyperCard what you want it to
do when this button is pressed. Your desired action is to
go to anothe r stack, MY STACK, when this button is
pressed . The LinkTo button creates a small script to perform this task.
When you cl ick on the Link To button, you will see a
small dialog box, which instructs you to " Go to destination, then aim link at" followed by some options (Figure
20.46).

IIIIUIIIEURI

W 1.

i1

·!ii&HH

......

mmenil

'-----r---J (

XR

This Stacie ) [ Cancel

Figure 20.46
The Link dialog box.

Go to destination, then aim llnlc at:

I
Select the Recent command. You should be able to identify your stack on the recent screen. It is the only miniature card that is completely blank. If you have been
following the instructions exactly as presented, the MY
STACK card should be at the extreme right of the second
row of miniature cards.

Figure 20.47
The mouse pointer is '
positioned on the blank
card of MY STACK.
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C lick on the blank card on the recent
page.

This will open the stack. The Link dialog box will
return.

Click on the T his Stack button.

You want the button you have created to link to the stack,
not the specific card.
After you complete the link, you will be returned to the
Home card. Note that you are still in the button editing
mode. You can tell this because all the buttons are outli ned, and you have the standard mouse pointer, not the
browse tool, displayed.

Double-click on the My Stack button.

It was mentioned before that the double-click on a button
while in button editing mode was equivalent to using the
button info command on the Objects menu. You should
now see the button dialog box.

Click on the Script button.

You want to look at the script created by the Link button.

Figure 20.48
The script of the My Stack

,. a

File Edit &a

,

Tools Objects

button.
Script of card button ld 85 • "My Stack"

I
Find

OK

[cancel]

Th is script starts with the "on mouseUp" command.
This command says that when the mouse button is
released with the browse tool on the button, do the following commands. The next command is the link that
you have created, go to stack " MY STACK". Finally, the
"end mouseUp" tells HyperCard that there is nothing
else you want it to do when the mouse button is released.
Click on the OK button at the bottom
right of the screen.

You are down looking at the script.
Now that you have established the link , it is time to try it
to see if it works. To do this, you must leave the button
editing mode and return to the browse mode. This is
done by using the Tools menu.
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Pull down the Tools menu .

This is a different type of menu, in that it is not words. It
is also a " tear off menu". You will see this feature in a
moment.
Figure 20.49
The Tools menu has been
pulled down. In this figure
the Button tool is selected.

This menu is one of the most important HyperCard
menus. Across its top are the three tools used to manipulate and build stacks. From left to right they are the
browse tool (which you have been using), the button tool
(used fo r editing and manipulating buttons) and the field
tool (used for editing and manipulating fields).
Select the browse tool and release the
mouse.

Below these tools are the graphic tools, used for drawing
graphic images on cards and backgrounds. The browse
tool is the pointing hand at the top left of this menu. A
tool is selected by pointing at it with the mouse pointer.
You can tell when a tool has been selected because the
border around it will flash.
When you re lease the mouse button , the browse tool will
return.

Click on the My Stack button.

You are going to test the link you have created. You
should now be on your stack.

-

20.10 COPYING EXISTING BUTTONS

You can see how easy it is to create a new button, and create a link for that button. Sometimes,
however, it is more efficient to copy an existing button. For example, it is easier to copy the
button to return to the Home card, or the next card or previous card buttons, with their associated icons and scripts, than to create these buttons from scratch .
You will copy three buttons to place on the background of the current card of MY STACK.
You will copy a Home button, a Next Card button and a Previous Card button.

WHAT

To Do

WHY

You ARE DOING lr

XH

Return to the Home card.

Click on the Button Ideas button on the
Home card.

This button will link you to a stack with many buttons
that may be copied.
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Figure 20.50

The Button Ideas button
on the Home card.

After locating the stack, you will see the Button Ideas
Index card.
Figure 20.51

The button ideas stack
index card.
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Click on the first row of icons.

This row, labelled First, Previous, Next , Last, Return , is
a button that will take you to a card that holds a variety
of different buttons for moving around in a stack.

Pull down the Tools menu.

Before you can copy a button, you must be operating in
button editing mode, and not the Browse mode. All the
buttons on this card will execute their scripts if you click
the browse tool on them.

With the Tools menu pulled down, drag
the mouse pointer over the Return
buttons.

This menu is a tear off menu. When you move the mouse
pointer far enough, an outline of the menu will start to
flash.
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Figure 20.52
The Tools menu is going to
be torn off the menu bar
and placed on top of the
current card.
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Release the mouse button.

r

•

The menu will be torn off the menu bar and placed at a
location on the card permanently in view. It is NOT part
of the card, but really above it in a convenient location.
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Figure 20.53
The Tools menu is now
permanently available.
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You may move the torn off menu around on the screen by
dragging it with its me nu bar. It may be put away by
clicking on its close box. You may tear off this menu as
often as you want , but only one copy of it will remain
displayed at any time.
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The advantage of the tear off menu is that it is always
showing, making it easier to change the tools you are
using.
Click on the button tool.

The button tool is the center of the three tools shown at
the top of the menu. To work with a button, the button
tool must be selected. If not, when you try to select a
button for copying, it will execute its script , rather than
becoming selected .

Click on the largest hand pointing to the
right.

This is a next card button. You are going to use hands
instead of arrows.

Figure 20.54
The Next Card hand button
has been selected.

If you are unsure of the action this button will take when
cl icked on, then you should check its script. Let's do this
now for this button.
Double-click on the selected button.

The double-click will open up this button's dialog box.

Figure 20.55
This button is called Next.

Button Name:
~================

Card button number: 28

style:

Card button ID: 74

® transparent

0Show name

Oopaque
0 rectangle
Oshadow
Oround rect
Ocheck boa
0 radio button

0 Auto hlllte
[

Icon...

[ Llnklo...

1
1

Script.. .

Click on the Script button.

Figure 20.56
The script of the Next
button.

l

OK

J [ Cancel

You want to confirm that the action this button will take
is to go to the next card. You can see that this is what the
script tells it to do.
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•

File Edit Go Tools Objects

Script of card button ld 74 • "Neat•
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Click on the Cancel button.

You are done looking at the information for this button.
You will now return to the card.

Pull down the Edit menu.

Because you have a button selected, this menu will have
references to buttons, such as Cut Button, or Copy
Button.

Drag the mouse down to the Copy
Button command.

You can see that the Copy command may, as with most
Macintosh applications, be executed by using the XC
key.
Figure 20.57
The Copy Button command
has been selected.

Cleer Button
New terd
Delete Cerd
Cut Cerd
Copy Cerd

liN

Teut S1yle •••

>l!<T
188

Release the mouse button .

The selected button will now be copied to the clipboard.

XR

Go to the recent cards display.
Locate the card that represents the stack you are creating.
It is still the completely blank card at the end of the second row.

Click on the card for your stack.

You are returning to your stack. It is worth pointing out
that the Tools menu , which you tore off the menu bar
earlier, remains on the display, even though you have
changed stacks.

XB

The Background command . You want to put this button
onto the card's background so that it appears on all the
cards you create in this stack. The menu bar should
become striped.
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Pull down the Edit menu and select
Paste Buuon.

The Paste command, which may be executed by the :M:V
key, reads Paste Buuon, si nce a button is currently in the
cl ipboard for pasting.

Figure 20.58
The Paste Button command
has been selected on the
Edit menu.

New Car d
Dele t e Car d
c ut card
Copy Card

ICN

l PHt Styl e...

l}(<l
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Release the mouse buuon.

Paste the button onto the card's background.

Drag the new buuon to the lower right
corner of the card.

You want to posit ion the next card buuon at the bottom
right corner of the stack.
You now want to copy the prev ious card buuon fro m the
button ideas stack, and place it at the bottom left corner
of this background. To do so, you could return to the
Home card , then select button ideas and then the desi red
card from the stack's index. This is all time-consuming.
It would be faster to use the Recent command to return
d irectly to the card holding the button you want. An even
easier way to return to the card with the buuons is by
using the Back command. Remember that this command,
31:- or use the Go menu, returns to the previous card you
looked at.
Use the Go Back command to back up one card. You
should once again have the card with the next and previous buttons d isplayed. T his was the last card you looked
at before going to the blank card in MY STACK.

Click on the la rgest left-poi nting hand.

Figure 20.59
The left-p ointing hand w ill
be used for the Previous
Card button.

You should still be in the button ed iting mode. That is,
the buuon tool s hould be the selected one on the torn off
Tools menu. If not, select the buuon tool before you click
on the le ft-poi nting hand.
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XC

The Copy Button command from the Edit menu.

XR

The Recent command. You are not using the Back command to get to your card at this time.

Click on the image of the MY STACK
card.

Go back to your new stack.

XB

Go to the card's Background .

XV

The Paste Button command from the Edit menu. Paste
the card onto the background .

Drag the previous card button to the
lower left corner of the card.

Place the previous card button at the lower left of this
card 's background.

XR

Go to the Recent cards display.

Click on the index to the Button Ideas
stack.

This card should be the first card image of the third row
of cards on the Recent display. You are returning to the
index because you are going to get a home button, rather
than a next or prev ious card button. The Button Ideas
index should now be displayed.
Figure 20 .60
The mouse pointer is on
the Button Ideas Index
card in the recent display.

C lick on the Browse tool at the top left
of the torn off Tools menu.

Before you can go to the Home and Bus iness buttons
card, you must change from editing buttons to browsing.

C lick on the Home, Business line of the
Button Ideas index card .

You want to get a Home button.
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Figure 20 .61

This is the Home, Business
buttons card. The torn off
Tools menu is still
displayed.
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C lick on the Button tool at the top center of the torn off Tools menu.

You must select the Button tool before you can copy a
button . When you do this, all the buttons on the curre nt
card will become outlined.

Click on the top left Home icon of the
s ix displayed.

This is the home button you want to use on your stack.
Of course, all six of the home buttons you see here perform the exact same task. When you click on this button,
it will become selected. If you find that you are looking
at the Home card, then you fai led to click on the button
tool.

Figure 20.62

A Home button has been
selected.

,. •

File

Edit

Home.
.· · ········ :

l~l

L.....\;

Go Tool

Busines~

~

~

~0

~~
The Copy Button command .
You must go Back two times to get to your stack. Of
course, you may use the Recent command at this time if
you want.

XB

Don't forget that you want to place this button on the
card 's bac kground.
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XV

The Paste Button command from the Ed it menu.

Drag the Home buuon to the bottom
center of this card.

Place the Home button.

Click on the Browse tool on the Tools
menu.

You are going to try the buttons. This cannot be done
when you are editing buttons.
When you select the Browse tool , you will automatically
leave the background. You should no lo nger see striping
on the HyperCard menu bar.

Click on the close box at the top left
corner of the Tools menu.

r

a

File Edit

liD Tools

Put away the Tools menu . You may tear it off the menu
bar again whenever you need it.

,

Objects

Click on the Home button at the bottom
center of the MY STACK card.

Figure 20.63
The stack that you have
created so far.

You should now be returned to the Home Card .

-

2 0.11 CREATING NEW FIELDS

Fields a re created in the exact same fashion as buttons. Simply pull down the Objects menu and
select the New Field command. Il is possible for a text field to have a script associated with it,
just as do buttons. At this time, however, we will not create scripts for the text fields created.

WHAT

To Do

WHY

You ARE DOING IT

Click on the MY STACK buuon.

You are going to add the field to your stack, not to the
Home card.

XB

You are going to add this field to the card's background.
The menu bar should now be striped.
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Pull down the Objects menu and drag
the mouse down to the New Field
command.

You want to c reate a new field on the background of your
stack.

~

Figure 20.64
The New Field command
has been selected.

#

•

•••••

Button Info •••
Field Info...
Card Info •••
Bkgnd Info•••
Stack Info •••
011ng

Clo~er

~end

fln1her

New Button

....

·-

New Backgnfimd

Create the new field. It will appear in the middle of the
card.

Release the mouse button .

Figure 20.65

r.

~

A new field has been
created. If you pull down
the Tools menu you will
see that the Field tool has
been selected.

• "rile·
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Pull down the Objects menu and select
the Field Info command.

This command will let you set the field style , change the
fie ld 's font , and modify the field's script. Just as you may
double-cl ick on a button with the button editing tool to
get to the Button Info dialog box, you may double-click
on a field with the field editing tool to get to the Field
Info dialog box.

Release the mouse button.

You want to use the Field Info dialog box.

Macintosh Productivity Tools

Figure 20.66
The initial Field Info dialog
box.

Field Name: I~:...I

_ _ _ _ _ _ _,_J

Bkgnd field number: I
Bkgnd field ID: 4
0 Loc:k TeHt
0Show Lines
0 Wide Margins
ORuto Tab

~

Style:
®transparent
Oopaque
Orec:tangle
Oshadow
Osc:rolllng

[ Font... )

l

( Sc:rtpt... )

OK

J[ Canc:el)

Click on the Shadow style button on the
right side of the dialog box.

You want to have the field visible on the card, and have a
drop shadow.

Name

Type the word Name into the Field Name box.

Figure 20.67
The Field Info dialog box
has been changed.

Field Name:lLN_a_m_~:....__ _ _ _ _...J
Bkgnd field number: I
style:
0 transparent
Oopaque
Orec:tangle
®shadow
0 scrolling

Bkgnd field ID: 4
OLoc:k TeHt
0Show Lines
0 Wide Margins
ORuto Tab
[ Font... )
( Sc:rtpt ... )

l

OK

J[ Canc:el)

C lick on the Font button at the lower
left of this dialog box.

You want to change the way text will be displayed in this
field. You should now have the Font dialog box.
Figure 20.68

style
OBold
Oltallc
OUnderllne
ooutllne
0Shadow
ocondense
OEHtend
Rllgn
®Left
OCenter
0Right

~

GJ

Rthens
Ruant liarde
Bookman
Cairo
Chicago
Courter
Heluetlca
London
Los Angeles
Mobile
Monaco

[cancel)

Line
Height

liE

I

1116

Sample

The Font dialog box. You
may change the style,
alignment, size, line height
and the font to be used by
the field with this dialog
box.
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Click on the Bold check box .

You want the text in this field to be boldfaced, rather than
plain.

Click on the 18 size.

You want the text to be in a larger type size.

Figure 20.69
The font that will appear
in this field has been
changed. You can see the
results of the change by
looking at the sample at
the lower right side of the
dialog box.

Height

1111

1124

Isample

Click on the OK button.

You are finished making changes to this field.

Position the mouse pointer at the lower
right corner of the fie ld .

If you place the mouse pointer on any one of the field's
corners, you may change the s ize and shape of the field.

.................................................

Figure 20 :10
Note the location of the
mouse pointer on the field
that has been created.

Drag the corner of the field up so that
only one line is showing, and right so
that the field is about three inches wide
on the screen.

Remember that you drag by pressing and holding the
mouse button before you move the mouse.

u·············...· ·········;··...··=·····...--... ~~1

Figure 20.71
The shape of the field has
been changed.

Position the mouse pointer in the center
of the field.

If you place the mouse pointer in the cente r of the field,
you may drag the field to a new location on the card.

Drag the field up to be about a quarter
of an inch below the menu bar.

You want to position the field near the top of the card.

Figure 20.72
The field has been placed
near the top of the card.
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Pull down the Objects menu, select the
New Field command and release the
mouse button.

You want to create a second new field on the card. You
should still be working on the background of this card .
Remember, if you are worki ng on the card 's backgrou nd
the menu bar will be striped.

Double-click on the fie ld you have just
created.

You should now have the Field Info dialog box for this
field .

Click on the Rectangle button .

You want the style of this fie ld to be a rectangle. That is,
you want a box around the field.

Birthday

Enter Birthday for the Field name.

Click on the OK button.

You are done with the Field Info dialog box.

Drag the lower right corner of this field
up so you can see only one ruler line in
the field , and left to make the field
about one inch wide.

C hange the size of this fie ld.

Drag this field up so it is about half an
inch below the first field you created.

Reposition this field on the card.

~:

., · ·rile· · £.i11 · ·&o ·roois ·oi.j8iis · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · · .,

Figure 20.73
The current card.

(·························:

Pull down the Objects menu , select the
New Field command and release the
mouse button.

You want to create a third new fie ld on the card.

Double-cl ick on the field you have just
created.

You should now have the Field Info dialog box for this
field.
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Click on the Show Lines check box on
the left side of the dialog box.

You want lines to appear in the field so that it appears
similar to ruled paper. The lines that you have seen in the
two fields you have created already will not be displayed
when you are using the browse tool.

Click on the Rectangle style button.

You want this field to be a rectangle.

Mise Info

Type this text into the Field Name box.

Click on the OK button.

You are done with the Field Info dialog box.

Drag the lower right corner of this field
down and to the right to fill the bottom
portion of the card.

You want this field to cover the majority of the card .

Figure 20 .14
The card now has three
fields.
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2 0.12 ADDING GRAPHICS TO THE CARD

You a re now ready to add graphic images to the card. You may import graph ics from the
scrapbook or thro ugh the clipboard , from other cards or stacks, or you may draw them using the
pai nting tools that are part of HyperCard.

WHAT

To Do

Pull down the Tools menu and tear it
off.

WHY

You ARE DOING IT

You want to have access to the tools on the Tool menu. A
good place to put th is torn off menu is on top of the field
you j ust created . Do not place it on the le ft side of the
card , since that is where you are going to add graphics
and other items.
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Figure 20 .75
The Tool menu has been
torn off the menu bar and
placed where it can be
easily used.

---d

..
Click on the large A at the bottom left
of the Tools menu.

This tool will let you place text on the card , or, as in the
present case, on the card 's background. The text can not
be edited , since it is turned into a graphic image.
Since the A tool is one of the graphic tools , the menu bar
will change. The Objects option will disappear, to be
replaced by Paint, Options and Patterns.
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Figure 20 .76
The menu bar has changed
since you have selected a
graphic tool.
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The mouse pointer should now be the familiar 1-beam.
This cursor shape is used when you are entering text.

725

726

CHAPTER TWENTY - AN INTRODUCTION TO HYPERCARD

Pull down the Edit menu and drag the
mouse down to the Text Style command.

This command. since you have selected a text tool, is
now active. It may be executed by pressing the a€1" key.

. . . . . . . .. .... . .

Figure 20 .77
The Text Style command
has been selected.

Go Tools Pe
88Z

[U t

[Optj
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Paste Button 88U
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New Card
Delete Card
Cut Card
Copy Cal"d

88N

Release the mouse button.

You wi ll once again see the fo nt dialog box. This is the
same dialog box you saw when you were changing the
font to be used in the Name field.

Scroll the fon t list until you locate the
New York font.

You want to type using this font.

Click on the New York font in the font
list.

By clicki ng on this font you are making it the active font
for the text tool you have selected.

Click on the Al ign Right button.

T his button is at the lower left corner of the dialog box.
It will cause the characters to push backwards as you
type, rather than the cursor moving to the right.

Clic k on a point size of 18 in the size
box.

You want the font to be larger than the 12-point size.

Figure 20.78
Th e Font dialog box before
you complete it with the
OK button.
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0 Underline
0 Outline
0Shadow
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Click on the OK button.

You are done modifying the font you want to have appear.

Position the I-beam just to the left of the
left edge of the first field on the card .

This is where you want text to start appearing as you
type.

Figure 20 .79
Note the position of the
/-beam cursor.
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Click the mouse button.

When you click the mouse button, the blinking insertion
cursor will appear. You are now ready to type.

Name

Type the text "Name". As you type, the letters will move
left from the insertion point.

r • •, •
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Nam~~~------------~

Click the !-beam to the left of the second field on the card.

You are going to label this field.

Birthday

Type the text " Birthday " .

Click the !-beam to the left of the third
field on the card, level with the top of
the field.

You are going to label the last field.

Mise

Type the text " Mise".

,. · ., · ·ri•e· ·Ecili · ·&a • rooii ·Pal
Name

Figure 20.80
The word "Name" has
been added to the
background of this card.

Figure 20.81
The three text items have
been created on the card's
background.

Birthday
Mise!

Click on the paint brush tool.

This tool lets you draw shapes as if you had a Paint
Brush. You may vary the size and shape of the brush.
This is different from the pencil tool, which only draws
fine lines.
Figure 20.82
The Paint Brush tool has
been selected.

727

728

CHAPTER TWENTY -

AN INTRODUCTION 10 HYPERCARD

Pull down the Options menu and drag
the mouse down to the Brush Shape
command.

This command will let you change the shape of the brush
with which you are going to paint.

Figure 20.83

The Brush Shape command
has been selected.

Polygon Sides ...
Drew Filled
Draw Centered
Draw

Release the mouse button.

You are going to change the shape of the paint brush.
You will now see the brush shape choices. Note the box
around one, indicating the current brush shape in use by
HyperCard. The mouse pointer is pointing to the brush
shape we want, third from the left and second down .

Figure 20 .84

The brush shape options.
The mouse pointer is
pointing to the brush
shape we want to use.
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Pos ition the mouse pointer as it is in
Figure 20.84.

You want to select this brush shape.

Click the mouse button.

Select this brush shape.

Position the brush to the right of the
Birthday fie ld .

This is where you want to start drawing.

Drag the brush in a wavy pattern to the
right of the card.

To drag the brush, press and hold the mouse button while
you move the mouse.
If you do not like the results of your work, click on the
eraser tool , which is to the right of the paint brush on the
Tools menu . Drag the eraser over the portion of your
work you want to erase . You must press the mouse button
as you drag the eraser to have it erase your art.
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Name

Figure 20.85

Some art has been added
to the card.

Birthday

Mise

...

Click on the oval tool.

This tool will let you make circles and ovals on the card.
Figure 20.86

The oval tool has been
selected.

Position the mouse above the wave.

When you move the mouse, it will become a cross hair.

Drag the mouse down and to the right,
making an oval.

Once again, you must press the mouse button before
moving the mouse to obtain the desired result.

................ ..,

Figure 20.87

An oval has been created.
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Select the Paint Can tool.

This tool is used to fill graphic objects with a selected
pattern. The object must be closed, as the oval you just
created, or the paint will leak out when you pour it.

Figure 20.88

The paint can tool has
been selected.

Pull down the Patte rns menu and select
the pattern at the bottom right corner of
the menu .

This menu is also a tear off menu. As you select a pattern , a flickering outline will appear around your
selected.

Figure 20.89

The bottom right pattern
is being selected.

Position the paint can mouse pointer
inside the oval.

You are going to fill the oval with the selected patte rn.

Figure 20.90

Note the location of the
paint can mouse pointer.

Click the mouse button.
Figure 20 .91

The oval has been filled
with the selected pattern.

Pour the paint.

.................. .,
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This tool lets you select and manipulate graphic items on
the card.

Click on the Selection tool.

Figure 20.92
The Selection Tool has
been selected.

Position the selection tool cross hair
mouse pointer above and to the left of
the filled oval.

You are going to select the oval.

Press and hold the mouse button, and
drag the mouse down and to the right so
that a box surrounds the filled oval.
Then release the mouse button.

When you select an item , a moving dashed line will be
around it.

-.:

Figure 20.93
The oval has been
selected.

.
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XC

The Copy command from the Edit menu. Since you are
working with a graphic, the menu actually reads Copy
Picture.

XV

The Paste command from the Edit menu. Again, the
menu actually reads Paste Picture.
You have pasted a duplicate of the filled oval on top of the
original.

Place the mouse pointer inside the moving dashed box.

When you position the mouse pointer inside the selected
area, it will return to the familiar arrowhead. You may
now use it to drag the selected item.

Drag the selected area left on the card,
placing it next to the graphic " Name".

When you drag this graphic, the original will remain in
place. If you had selected the graphic and moved it, without the copy and paste process, then you would be moving the original graphic , rather than a copy of the
graphic.

6o . rooitt .i>iairit" •options ..Patterns •••••••••••••••••• .,
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Figure 20.94
The graphic has been
duplicated and moved.
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Click on the Browse tool.

You are now going to return to the Home card and select
a g raphic from another stack to add to your current card.

Click on the close box on the Tools
menu.

This menu will be in the way, so return it to the menu bar
by clicking on its close box.

Click on the Home button.

Return to the Home card .

Click on the Art Ideas button.

This stack has a variety of drawings that can be copied
into your stacks.

Figure 20.95
The Art Ideas button is
going to be pressed.

Click on the Holidays, Seasons button
in the center column of items on this
card .
Figure 20.96
The Browse tool is on the
Holidays, Seasons button.

r

We are looking fo r an appropriate picture to copy onto
our stack.

.,

S File Edit Go Tools Objects

0 lndex1
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~ . . , .• Houuhold A.cttv_
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1'\111c, Rtc«"dl, T•s-
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Note that there is a birthday cake pictured near the center
of this card.
Pull down the Tools menu and select the
Lasso tool.
Figure 20.97
The Lasso tool will be
selected.

This tool lets you select irregul ar shapes.

Macintosh Productivity Tools

Drag the lasso around the cake.

As always, you must press the mouse button while dragging it to get the desired effect.
Figure 20.98
The mouse button is being
held down, so that the line
that the lasso has traced
surrounding the cake
image can still be seen.
When you release the
mouse button, the edge of
the cage will start to
flicker.

XC

Copy the picture into the clipboard.

XR

Go to the Recent display. Note that the image of your
stack, at the right side of the second row, now includes
the information that has been placed on it. The recent
d isplay is dynamic. It shows the current status of the
cards on it.

Click on the card image representing
your stack.

You will return to your stack.

XB

Go to the card 's background.

XV

Paste the object from the clipboard into the current stack.

Drag the graphic left and place it in the
space to the left of the third fie ld.

Do not leave this graphic under the third field! If you lose
it, then you will have to change the s ize of the third field
so that the graphic becomes vis ible. Then use the lasso to
select the graphic and reposition it. Finally, you will have
to re-s ize the field back to what it should be.

XB

Leave the background. The menu bar should no longe r
be striped .

Pull down the Tools menu and select the
Browse tool.

You are fi nished putting graphics on the card .

r

•

File

·~·

Edit

&o

Tools

Name

Birthday

Mise

.,

Objects

·CIIID·

Figure 20.99
The card you have created.
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2 0.13 USING THE STACK

You a re now ready to use the stack you have created . Yo u w ill e nter several people's names and
bi rthdays. To do th is, you w ill learn how to add new cards to the stack you have created . Since
all the butto ns, fields and artwork you have placed on this card are o n the background , they will
appear on any new card you create. If you want fie lds, buttons o r g raphics to be sha red by
several cards, then they must be placed on the background.
If, when you c reate a new card, something disappears, then it was not placed o n the
background. To fix this, start by returning to the first card . Next, select the ite m using the
appropriate tool (butto n, fie ld o r g raphic). Use the Cut command (X X o r use the Edit menu) to
re move it fro m the card a nd place the item onto clipboard . Activate the backg round with the XB
key. Finally, Paste the item onto the background (XV o r use the Edit menu). If the ite m is a
fie ld, any text it conta ins will be deleted whe n it is placed o nto the background .

WHAT

To Do

WHY

Position the mouse pointer in the Name
field and click the mouse button.

Figure 20.100
The mouse is inside the
Name field. Note the
cursor at the left edge
of the field.

r

You ARE DoiNG IT

When you place the mouse into the field , it will turn into
an I-beam. When you click the mouse button, the blinking cursor will appear at the left of the field .

lit File Edit &o Tools Objects

·&IIIIa·

r.________..

Name ~,~,II....

....

.,

Mary Smith

Enter the name.

[TAB]

Use the Tab key to move the blinking c ursor to the next
field, Bi rthday. You may, of course, use the mouse to
position the 1-beam in the fie ld and click the mouse
button to place the cursor in the field.

07118/8 1

Enter Mary 's birthday.

[TAB]

Move the cursor to the last field .

poster

Enter " poster" into this field. This is a reminder of what
you bought Mary fo r he r birthday last year.
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a

File

Edit

•@I•

,

Go Tools Objects

Name !Mary

Figure 20.101
The completed card.

srw,,_th_____.

·CIIIID·

Birthday
Mise

Pull down the Ed it menu and select the
New Card command.

You are ready to add a second card to the stack. Note that
the New Card command may be executed with the X N
key.

Go Tools Db.

Figure 20.102
The New Card command
has been selected.

( ut

:•:H

[ DPIJ
:•:C
Paste Picture ICU
[IPI!Ir

Delete Cord
Cut Cord
Copy Cord
TPHt S1yle...
Bock round

:•:f
ICB

Release the mouse.

Create a new card . If any parts of the card , othe r than the
text you have created , disappears, then you created that
item o n the card layer, rather than the background layer.
See the comment at the beginning of this section for
instructions on how to fix this.

Click the mouse in the Name field.

You are going to add another Name.

Alex Jones [TAB]

Enter a name and move the cursor to the next field .

03/12/8 1 [TAB]

Enter a bi rthday and move the cursor to the next fie ld .
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book

Enter a reminder of what you gave Alex on his last
birthday.

Figure 20 .103
The completed card.

r

•

File Edit

·&liD·

.,

&o Tools Objects

Name ~,.,J_o_n_e_s_ _ _ __.

·IIIID·

Birthday
Mise

•
XN

C reate a third card.

C lick the mouse in the Name field .

You are going to add another Name.

Anne Larson [TAB]

Enter a name and move the cursor to the next fie ld.

02/ 10/8 1 [TAB]

Enter a birthday and move the cursor to the next field.

book

Enter a reminder of what you gave Anne on her last
birthday.

Figure 20.104
The completed card.

•

File Edit

·&liD·

&o Tools Objects

Name IAnne Larson

Birthday
Mise

~~,----------------~

.,
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Click on the Next Card button at the
bottom right corner of the card.

You s hould now see Mary Smith 's card . As you add new
cards, they are placed after the card you have showing.
You have been placing new cards at the end of the stack,
thus the next card is the first one in the stack at this time.

Click on the Next Card button two more
times.

You have cycled through the stack, and you are once
again looking at Anne Larson's card.

C lick on the Next Card button one more
time.

You once again are looking at the first card.

XN

Add a new card. Since you are looking at Mary Smith's
card, this new card will be physically placed into the
stack after her card and before Alex Jones' card. You
may want to click on the Next and Previous buttons to
verify this. When you are done, return to the blank card.

Click the mouse in the Name field.

You are going to add another Name.

Peter Zarnak [TAB]

Enter a name and move the cu rsor to the next field.

10/22/80 [TAB]

Enter a birthday and move the cursor to the next fie ld.

necktie

Enter a reminder of what you gave Peter on his last
birthday.

r

.,

li File Edit lio Tools Objects

Name IPete~~Z_a_rn_a_k______~

Figure 20.1 OS
The completed card.

•IIIID·

Birthday
Mise

-

20.14 THE MESSAGE BOX

The Message box is a way for you to give commands to HyperCard , and fo r HyperCard to give
you messages. Many of the capab il ities of HyperCard are not found on a ny menu, and must be
entered as a command through the message box. One command that is on a menu is the Find
command. It, however, makes use of the message box to ask you what you want to find. In this
section, you will learn how to use the message box, and the Find command.
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WHAT

To Do

Pull down the Go menu and drag the
mouse down to the Find command.

Figure 20. 106
The Find command has
been selected.

WHY

This menu has both the Find and Message commands on
it. They are the last two commands on this me nu.

·-

Tools Objl
Batie
Home
88H
Help
881
Recent
88R
First

Preu
NeHt
Last

Release the mouse button.

Figure 20.107
The message box appears
at the bottom of the
screen.

Anne

You ARE DotNG IT

XI
882
883
X4

Execute the Find command. When you do this, themessage box will automatically appear, since HyperCard
needs some information from you-what it is you want
found. In the message box is the word find and a pair of
double quote marks. The cursor is blinking inside the
quote marks.

--------·--·---------··------------··

t-------- ------------·------·-······1---- -

Enter Anne into the find dialog.

Figure 20.108
The object of the Find has
been entered into the
dialog box.

[cr]

Press the return key to activate the find. The message box
will disappear, and Anne's card will appear on the
screen. Note that a box surrounds the name Anne. This
is the target of the Find command.

Macintosh Productivity Tools

s

r

File

·GIIIIJ·

Edit

Go Tools

.,

Objects

Name IAnne! Larson

·CIIIIJ·

Figure 20.109
Anne 's card has been
found. The text that was
searched for has been
enclosed in a box.

Birthday jo211ota1

Mise

.b.Q.Qk

~F

You want to do another find . The message box will
re-appear with the last item you search for selected. By
typing now, the selected text will be replaced .

book

You want to locate the people to whom you have given a
book.

[cr]

Do the fi nd . Anne's card stays on the screen, s ince you
gave he r a book.

[cr]

Press the return again. This signals HyperCard to perform the last Find command again.
Alex Jones' card should now be on the screen.

[cr]

Tell HyperCard to once again repeat the Find command .
You will return to Anne Larson's card.

~M

Recall , when you had the Go menu pulled down (Figure
20.106), that the Message command can be executed
with this key. The message box should appear.

Select the complete contents of the message box.

You want to completely change the instruction you are
giving HyperCard.

..s:;

Figure 20.110
All the text in the Message
box has been selected.
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hide menubar

Type the command " hide menubar" into the message
box.

[cr]

Execute the command. The menu bar at the top of the
screen will disappear.

Figure 20 .111
The menu has been
hidden.

·CIIIID·

Name !Anne Larson

Birthday

·-·

.,

Mise

J SOiii!rM

l h~a menubar

IMIDE!

I

Click on the message box·s close box.

Put away the message box.

Click on the Home button.

Return to the Home card. The menu bar will return.
There is a command associated with returning to the
Home card that turns on the menu.
You may turn on the menu if it is missing with the command "show menubar" .

-

2 0.15 SCRIPTS

The Hide menuBar command and Show menuBar command are examples of script commands.
You may execute script commands one at a time by entering them into the message box, as you
have seen. You may also c reate a script that belongs to a particular HyperCard item. This item,
when the correct action is take, will then perform the script for you.
The sc ript commands , called HyperTalk, are many and varied . HyperTalk is the topic of
several commercial books, and will not be covered in great detail here . However, we will look at
a few simple scripts and make modifications to them. There is some information about the
various Hype rTa lk commands found in the Help stacks . Click on the Help button on the Home
card, then select the HyperTalk page to get started. You should also look at the information
found in the Release Notes stack for the version of HyperCard you are using . This stack includes
information that is not in the HyperCa rd manuals.
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WHAT

To Do

WHY

You ARE DotNG IT

Click on the Button Ideas button.

You are goi ng to copy a button that has a pre-written
script.

Click on the Home, Business button.

This card has a Sort button at the bottom right. It will let
us sort the cards in the stack into alphabetical order.

Pull down the Tools menu, select the
button tool and release the mouse.

To copy a button, you must be editing buttons and not
browsing.

Click on the Sort button.

This button is found at the lower right corner of this card .
Figure 20.112
The Sort button has been
selected.

:l€C

Copy the button.

:l€R

Select the Recent display.

Click on one of the cards of the stack
you have created.

It does not matter which card you select, since you will
be placing this button on the stack's background. This
will make it available to all the cards you have created.

:l€B

Select the Background. The menu bar should become
striped.

:l€V

Paste the button o nto the card.

Drag the Sort button down and place it
between the Home and Next Card
buttons.

Place this button at the bottom of the screen with the
other buttons you have on the background.

~

~

Double-click on the Sort button.

~

1~.!

~..

Figure 20.113
The Sort button has been
placed between the Home
and Next Card buttons.

You want to look at the script for this button. This
double-click will access the Button Info dialog box. If
you have trouble, use the Objects menu to get this dialog.
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You want to look at the sc ript for sorting.

Click o n the Script button.

Figure 20.114

r • •,

The script associated with
the Sort button.

••File·

• icilt ••6o . Tooii . o~jects· • . • ••••• ••.•• ••• •

.
Script of blcgnd button ld 7 • "Sort•
on IIOUSaUp
..._.. "Sort all eards af this stod< aeeot'dl"9 la : •
el th "F i r s t - · or "Last-· or "Canee l "
If It Is "F i r s t - ·
lMn sort bo,j first ooord af first line of field I
else If It I s " Last taM"
lMn sort bo,j last ooord of first line of field I
end IIOUSaUp

~

This script is reasonably self-explanatory. The Answer
comma nd w ill generate a dia log box with three butto ns :
Fi rst Name, Last Name and Cancel. If you click on the
First Name Button, the stack is sorted by the first word
in the first field o n the card, the name fiel d . If you cl ic k
on the Last Name button, the stack is sorted on the last
word in the first field. There is no command to be carried out if the cancel command is se lected, so nothing
will happen.
Click o n the OK button.

You are done looking at the script.

XB

Yo u are done with the background .

Pull down the Tools menu , select the
Browse tool a nd release the mo use
button.

You want to use the stack.

C lick on the Sort button .

Try this butto n. The d ialog box de scribed above will
appear.

Figure 20.115

This dialog box is created
by the script found on the
Sort button.

,. a

File

Edit

•GilD•

Go

Toots

.,

Objects

Name !Mary Smith

~CIIIID~

......-..

Bi

Sort all cards of this stack according to:
( First Name ) ( Last Name~

a
..

I

Cancel

,
....

...._....
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C lick on the Last Name button.

You want the cards ordered by last name.
After a brief pause, Alex Jones' card will appear. It is
now the first card in the stack.

XI

This is the Go First command. Nothing should change,
since you are al ready looking at the firs t card.

Click on the Next Card button.

Anne Larson 's card follows Alex 's card.

Click on the Next Card button.

Here is Mary Smith's card.

Click on the Next Card button.

The last card in the stack is now Peter Zarnak's.

Click on the Next Card button .

You have returned to the beginning of the stack.
Now you are going to create a new button and write a
s imple script.

XB

You want to place the button on the background.

Pull down the Objects menu, select the
new button command and release the
mouse button.

Remember that when you create a new button , HyperCard automatically selects the button tool for you.

Drag the new button to the space
between the Previous Card and Home
buttons.

You are keeping all the buttons on this card on the
bottom.
Figure 20.116
The new button has been
created and placed at the
bottom of the card.

1~1 r;;;~-~-~-ii·~-~'1

..

Double-click on the new button.

You wan! to make changes to the button using the button
info dialog box.

Find

Change the name of this button to Find.

Button Name:

F_ln_~:,...__ _ _ _ _ _-J

L.l

Bkgnd button number. 5

Style:

Bkgnd button 10: 8

0

Cl ick on the Scri pt button.

Figure 20.117
The button has been
renamed.

transparent

You are going to edit the script for this button. The script
for a new button automatically supplies you with the "on
mouseUp" and "end mouseUp" commands used to activate the script whe n the button is clicked.
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This is the command you want HyperCa rd to execute.

doMenu Find ...

You may have HyperCard perform any menu command
by giving it the command doMenu fo llowed by the menu
item exactly as it appears on the menu. If you pull down
the Go menu , you will see that the Find command is fo llowed by three periods. These three periods must be
included here.
Figur e 20 .118
The script you are creating.

Script of bkgnd button ld B • "Find"
on

-.up

doi1WIU FInd .. .
end -.up

Click on the OK button.

You are done with this script.
You will return to the card background.

Use the mouse to change the shape of
the button .

Figure 20.119
The new button has had
its size changed and its
position adjusted.

Just as you changed the shape of fie lds by g rabbing them
on a corner, you may change the shape of the button.
Make this button narrower and taller.

J

XB

Leave the card 's background .

Pull down the Tools menu, select the
Browse tool and release the mouse
button.

You are ready to try the button.

Click on the Find button .

If you have properly created this button, the Message box
will appear with the Find command you have used in it.

Click on the message box's close box.

In effect, you are cancelling the execution of the Find
command.

Pull down the Objects menu and select
the Stack Info command.

You want to modify the script for this stack.

Figure 20.120
The Stack Info command
has been selected.

DuHon Info•.•
rleld Info ...
Cerd Info •.•
Bkgnd Info •..

Dting Clo~er
Send Fat1her

l!(c ·
>j{<-

New Button
New Field
New Background
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Release the mouse button.

Look at the Stack Info dialog box.
Figure 20.121
The Stack Info dialog box.

Steck Name:
Where: HRRDPRC 40:Hypertard 1.2.2:Hypercard
Steck contains 4 cards.
Steck contains 1 backgrounds.
Size or Stack: 16 K
Free In Stack: 9 K

l

OK

J(Cancel J

Click on the Script button.

You are going to add a script to the stack. Since this is
not a button, there is no command shell already displayed
on this script.

on openStack [cr]
hide menuBar [cr]
end openStack [cr]

Type this three line script. Press return at the end of each
line. HyperCard will create indentations for you as the
script is typed.

r

•

File Edit

.,

&o Tools li@§IM

Figure 20.122
The completed script.

Script or stack HRRD PRC:Hypertard:Hypertard Stec:ks:MY STRCK

~

on cpenStaek
hide ....ecr
Mel cpenStaek

I
Click on the OK button.

You are done with this script.

Click on the Home button.

Return to the Home card. The script you just created will
execute only when you first open the stack. To test it , you
must leave the stack and return to it.

Click on the MY STACK button.

Return to your stack. The menu bar should now be
hidden.

XM

Tell HyperCard to give you the Message Box. At present,
we want to use the menu bar.

Select any text in the message box.

You want to completely replace the current content of the
message box.

show menubar [cr]

Enter this command. The menu bar should now return to
the top of the screen.

Click on the message box's close box.

Put away the message box.
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2 0.16 PRINTING YOUR STACK

It is a simple task to print the stack you have created. The re are three print options. One to print
the card presently displayed on the screen, one to print the complete stack , and one to generate a
columnar report. All the print commands are found on the File menu.
If your compute r is not attached to a printer, you will not be able to complete this sectio n.

WHAT

To Do

Pull down the File menu and select the
Print Card command.
Figure 20.123
The Print Card command
has been selected.

WHY

You ARE DOING IT

You want to print just the current card. You may use the
XP key to print a single card at any time.

Edit 6o Tools
New Stack•••
Open Stack...
110
saue a Copy•••
Compact Stack
Protect Stack...
Delete Stack•••

Quit H perCard IIQ

Release the mouse button.

Print the card. No printe r dialog box will appear. The
card will simply be printed .
When the printi ng is done, continue.

Pull down the File menu and select the
Print Stack command.
Figure 20.124

This command will print all the cards in the stack.

Edit &o Tools

The Print Stack command
has been selected.

110

Compact Stack
Protect Stack•••
Delete Stack•••
Page Setup•••
Prtnt Card

liP
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Release the mouse button.

Execute th is command. The Print Stack dialog box will
appear.

.,

Edit Go Tools

0 Manual paper feed

~Fast

Coples:l • l

I

laser printing

OK

I

Cancel

1

Figure 20.125
The initial Print Stack
dialog box.

0 No space between cards
0 Print one card per page

---- ..

.:ill

®Print full size cards

0 Print half size cards
0 Print quarter size cards
® Standard format

0 Split-page format

Header: 1m:! !!11!9 ~

You can see that you have several options as to how the
cards will be printed . The initial format prints two full
sized cards on a page.
Click on the quarter size cards bunon.

r

.,

li-Edlt &o Tools Objects

~

Print Stack...
Coples:l • l
0 Manual paper feed
~Fa st laser printing

••••
·~-••••
••••
••••
••••
••••
::11::11::11::11

Header: 1m:! !!1 1!9 ~

~
~

This format will put 32 cards o n a page. This is a great
paper saver. If, however, your cards have a lot of fine
detail, o r you selected a small type font for some of the
fields , you will find the output difficult to read.

I

I

OK

( Cancel

I
1

,;

0 No space between cards
0 Print one card per page
0 Print full size cards
0 Print half size cards
<!:l(rlnt quarter size cards
® Standard format

0 Split- page format

I ~

...

Figure 20 .126
The quarter size cards
option has been selected.
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This format wi ll put eight cards on the page. It is a reasonable compromise between two cards on a page and
32. Even cards with fi ne detail will be legible, although
there may be some loss of detail.

Click on the Half size cards button.

Figure 20.127
The half size cards option
has been selected.

,

Edit 6o Tools
Print Stack...
Coples:l•l
0 Manual paper feed
181 Fast laser printing

........... ...

?W?W
-:.

.:
-:.

0

OK

I

Cancel

No space between cards

0
0

Print one card per page
Print full size c:ards
~rlnt half size cards
O,rlnt quarter size cards

-:~

.:

.:-... -:~
-=~

® Standard format

-:..... "'-: =iilii'
.: IIIIIP. .: ~

Header:

I

0

Split-page format

lib 1!11!9 ~

If you want to see what your stack looks like when
printed in this format, click on the OK button. Otherwise, click on the Cancel button.
Pull down the File menu and select the
Print Report command.
Figure 20.128
The Print Report command
has been selected.

This command will print a columnar report of the fields
in the stack.

Tools
Open Stack...
Saue a Copy ...

KO

Compact Stack
Protect Stack ...
Delete Stack.. .
Page Setup ...
Print Card
Print Stack...

Release the mouse button.

8CP

Execute the Print Report command. You will now see the
Print Report dialog box.
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Edit

,

Go Tools

Print report... Coples:l•l
0 Manual paper feed

Figure 20.129

The initial Print Report
dialog box.

Arrange fields In:
Qlebels
®Columns
QRows:

EB

Print teNt fields from all cards:
0 In the entire~ toclc
® With the current background
Which fields:
0 ( urd tiPI11s
Selected hou•lrnirn

I
Header:

In (!) 1!9 ._.

Print the names of:
181 Cards
181 Fields

~

...

You can see that initially, HyperCard will se lect all the
fields for printing, and that it d ivides the page into evenwidth columns.
Click on the Cards c heck box at the bottom right of the dialog box.

You do not want the name of cards to be included in the
report. The report layout will change, now showing o nly
three fields to be printed.

Shift-click Mise Info in the field list.

Hold down the shift key before you cl ick o n the Mise
Info fie ld na me. This w ill leave the o ther two fie lds
selected. If you forget to hold down the s hift key, simply
click on the Name field , then shift-clic k on the Birthday
fi eld.

,

Edit Go Tools
Print report... Coples:l•l
0 Manuel paper feed

Arrange fields In:
QLebels
®Columns
QRows:

I
I

OK

Efj Effil~

Print teNt fields from ell cards:
(_; In the entire ~toclc
® With the current background

I
I

Header:

...

In(!) 1!9 ._.

I

Cancel ]

Figure 20.130

The two fields to be
printed are selected,
and the Print the names of
Cards box has been
unchecked.
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Use the mouse to point at the vertical
line in the center of the sample page
layout.

You may adjust the widths of the report columns by draging the vertical li nes representing the column boundaries
either left or right.

Drag the column line right.

You want to give more space to the Name field, and less
to the Birthday field.

Figure 20.131
The column widths of the
report have been changed.

Edit Go Tools
Print report... Coples:l•l
D Manual paper feed

~·---n

Header:

I!J ffi !a ...

..
Click on the OK button.

Print the report.

-

2 0.17 BEFORE YOU QUIT

This complete chapter you have been placing information on the background of the stack you
created. This is because of the nature of the information that was placed on each card. Each card
needed the same information: Name , Birthday and Misc. Placing the fields and buttons onto the
background layer meant that they would appear on each new card in the stack.
You may also place fields, buttons and graphic information onto the card layer itself. You
can tell when you are looking at the card layer, the menu bar is not striped . This is HyperCard 's
normal state.
The difference between the two layers is simple. The fields, buttons and graphics that are
placed on a background are shared by all the cards that share the background in a particular
stack. Fields, buttons and graphics that are on the card layer belong to only that card. That is, if
you place a button on a card, then create a new card. the button will not appear on the new card.
If you go back to the prior card, where the button was created, the button will still be on it! A
button , field or graphic created on a card , stays with the card until it is removed from the card.
Thus, if rather than the graphic of the birthday cake, you want to put a scanned photograph of
each person in the space to the left of the Mise field , those images would be placed on each card .
If you place an image on the background, then it will appea r on all the cards.

Macintosh Productivity Tools

The key issue when dec iding if you should place something onto the background o r the card
layer is to determine which information should be com mon to all the cards that share a particular
background, and which info rmation is applicable o nly to a single card . If the information (or
informa tion category) is common, such as the Name field or the next card button, the n it belongs
on the card background . If the information is unique to a particula r card , such as the person 's
photog ra ph, or a button to play dig iti zed speech by the person , then it belongs o n the card itself.

-

2 0.18 QUITTING HYPERCARD

All the work you have done has automatically been saved by Hype rCard . When you quit, you do
not have to execute a save command.
Th is complete c hapte r you have been putt ing these items onto the card background. Before
you quit, you may want to try putting buttons, fields o r graphics o nto a card . Try this to see what
happens.

WHAT

To Do

Pull down the File menu and select the
Quit HyperCard command.

WHY

You ARE DotNG

IT

You are ready to leave HyperCard . Note that the Quit
HyperCard command may be executed with the XQ key.

Edit 6o Tools
New Steck...

Open Stect...
Seue e Copy...

110

Fi gure 20.132
The Quit command on the
File menu has been
selected.

Compect Steck
Protect Stect..•
Delete Steck ...
Pege Setup ...
Print Cerd
Print Steck...
Print Report...
Ou1t

Release the mouse button.

llype1~

ill !I

liP

"0

Execute the Quit command. You will be returned to the
Macintosh Finder.

751

752

CHAPTER TWENTY -

AN INTRODUCTION TO HYPERCARD

EXERCISES
I.
2.
3.
4.
5.
6.
7.
8.
9.
10.
II.
12.
13.
14.

What does the User Preferences card of the Home Stack control?
What two keys do you hold down to locate all the buttons on a card?
When looking at the outlines of all the buttons on a card, how can you tell a background button from a card button?
What is the command key used to select the card's background?
What is the adva ntage of using a background?
Are Next and Previous card buttons required on all cards?
When you create a new stack, is it possible to duplicate the background of an existing stack, or must you re-create a
background?
What does the Go Recent command display, and what does it let you do?
Do you think that you could manually write the script created by the Link To comma nd on the button information dialog
box, or must the script be created by the Link To button itself?
Add a button to the stack you created to sort the cards based on the birthday field. When sorted, what is the order of the
cards? Why?
Do you think that it is possible to give the Sort command to the stack by using the message box? Why or why not?
Add a button to MY STACK to create a new card so that you do not have to use the menu command.
Why do you think all the buttons a nd fields on the stack you c reated were placed on the background? Why do you think
almost all the buttons on the Home Card are on the card , and not the background?
Create a stack to help you keep track of your tape, LP or CD library. You may want to include on the cards information
such as the title of the recordi ng, the a rtists, the songs a nd a brief evaluation of it .
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GLOSSARY
Abandon To stop work on a document without first saving it. Thus, any changes, additions to or deletions from the document are discarded, or abandoned.
Absolute cell address Applies to electronic spreadsheets. When a cell containing the address of another cell is copied, the copy retains the exact same cell
reference address in the copy. See also Relative cell address.
Applications Software Programs created to perform a specific task, such as accounting or word processing.
ASCU American Standard Code for Information Interchange. Pronounced '~K-EE." It defines the meaning of each eight-bit pattern than makes up a byte.
Binary Digit (Bm The most fundamental unit of information dealt with by the computer. It may be compared to an on/off switch. Either a bit is on, or it is
off. Bits are combined to represent information in the computer.
BIT See also Binary Digit.
Bit Map A graphic image in which the picture is composed of on or off bits on the page or computer screen.
Bit-Map font A type font that has a particular point size defined with instructions for the printer to tell it exactly which dots to print and which not to print.
If you use a bit-map font in a nonoutline size, you will have jagged edges and generally poor results. See also Outline fonts, Laser fonts.
Boilerplate To combining prewritten paragraphs to create a document, filling in only the appropriate name or other customizing information.
Boot disk A disk containing the information necessary to load the computer's operating system and to start a computer running.
Boot up Derived from "pull oneself up by one's bootstraps." This means to start the computer and have it load a new copy of it's operating system.
Business graphics Charts and graphs intended to display numeric information, such as bar, line and pie charts.
Byte A single character of information composed of eight BITs. The on/off pattern of the bits defme what any given byte means.
CeO A fundamental portion of an electronic spreadsheet capable of holding text, numbers or instructions for arithmetic computations.
Cell address The name given to each cell of an electronic spreadsheet. Each cell has a unique address composed of the name of the column in which the cell
is located and the number of the row in which the cell is located.
Central Processfng Unit (CPU) The portion of the computer that carries out most of the work. It performs all the calculations and controls the flow of
information within the machine through the use of the Operating System.
Character field A field in a database that holds text information. Numbers placed into a character field are treated as if they were words and may not be
manipulated arithmetically.
Circular reference This occurs when spreadsheet cell references form a circle. For example, cell AI uses cell F3 in its formula, cell F3 uses cell H2, and
cell H2 uses cell A l.
CHck To press and immediately release the button on the mouse. Used to select items on the display after positioning the mouse pointer on top of the desired
item. See also Double-click, Shift-click and Drag.
Column heading The information at the top of a column of information in a database or other report that describes the content of the column.
Command Key A key on the computer's keyboard that behaves in a fashion similar to the shift key in that it works in conjunction with other keys. It creates a
character that may or may not be displayed, but that the computer recognizes and acts on regardless. It has X on it on the Macintosh keyboard.
Compiler A special program that turns what a programer writes in a specific programming language into the machine language required by the computer for
program execution. The compiled program is stored as object code by the computer and executed on demand by the user. Program execution is fast when
compared to execution of an interpreted program.
Computed field A field in a database that is the arithmetic result of two or more fields in the database.
CPU See Central Processing Unit.
Date fields A field in a database that will hold only calender dates. Date fields let the user perform date arithmetic, such as determining how many days have
passed since an invoice was mailed.
Database A collection of related information.
Database Management System (DBMS) A program for creating, manipulating and generating reports of the contents of databases.
DBMS See Database Management System.
Desk Accessory (DA) A program that is alWays available on demand, even when another program is running. It is activated through the Apple menu. Typical
·
desk accessories are: calculator, key caps, find file, alarm clock, chooser and control panel.
Desktop On the Macintosh, the working area of the screen. You can see icons on it.
Development Software Programs used to create and maintain programs for general and/or specific purposes.
Dialog Box A dialog box is the text that the Macintosh, or a program, places on the screen with information or with requests for action. The computer is
carrying on a dialog with the user through this box.
Directory The area of the disk reserved during the format process to hold the information about the contents of the disk. Sometimes called the VTOC.
Disk Operating System (DOS) System software that has overall control of the computer. It controls the communication and flow of information between the
CPU and the rest of the computer and peripherals, (i.e. disk drives and printers).
Dot-matrix printer An impact printer that forms letters with a series of pins rather than with a fully formed letter such as used by a standard typewriter.
Double-click 1b press and release the mouse button two times in rapid succession. Used to open selected icons or activate items on the display after
positioning the mouse pointer on top of the desired item. See also Click, Shift-click and Drag.
Drag To press and hold the mouse button after positioning the mouse pointer on an item, and then moving the mouse, thereby moving the item on the
desktop. See also Double-click, Click and Shift-click.
.
EPROM Erasable Programmable Read Only Memory. Programmable Read Only Memory that may be erased and reprogrammed.
FAT See File Allocation 'Thble.
Field The smallest unit of information in a database. One item of information about a complete unit. See also Record.
File A collection of records. One or more files comprise a database.
File structure The combination of field names, the type of information the fields will hold, and the size of each field that defmes a database file.
File AUocation Table (FAT) The FAT is a portion of the disk reserved by the operating system to keep track of those sectors of the disk that are presently in
use (allocated) storing information, and those sectors that are not in use, or available.
Filling lines The process of adding blanks between words to make the right margin of the text even, or right justified. The line becomes "filled.. with blanks
to accomplish justification.
Film recorder A device used to photograph a computer's display.
Font A typeface.
Format See Initialize.
Global Referring to the complete document, database or spreadsheet.
Global command An action or command that operates on the complete spreadsheet or document.
Hard sector A type of floppy disk. Hard-sectored disks have more than one index hole punched in the disk media. See also Soft sector.
ffidden rde A flle stored on a disk, but the file's icon does not appear in the disk's window.
Icon A graphic representation of items in the computer, such as programs, data flles or disk drives.
Impact printer A printer that causes the letters to appear by physically pressing the ribbon onto the page with the print head. A typical impact printer is a
dot-matrix printer. See also Nonimpact printer.
Index A method of organizing the records of a database for rapid access based on the information contained in one or more fields of the database.
Initialize The process of preparing a floppy disk for use by the computer by placing information magnetically onto the disk for its future use.
Input The act of entering information into the computer so the machine may process the information.
Input Devices Hardware used to send information into a computer for processing.
Insert mode When word processing, the typing mode in which existing text moves aside to make room for new characters as they are typed. See also Replace
mode.
Install The process of telling a computer program about your specific hardware setup.
Integrated software A program or group of programs that are specifically designed to share information and files.
Interpreter A special program that translates a program for a computer to execute "on the fly." Program execution is slow when compared to execution of a
compiled program.
Keyboard template A piece of plastic or cardboard that fits over or sits next to the computer's keyboard with summary information describing what action
keys (especially the Function keys) perform when the keys are used within a specific program.
Key field A field in a database record that gives the user direct access tQ specific records, such as part numbers or social security numbers.
LAN See Local Area Network.

Laser font A type font designed to work with one of the Apple laser printers. They send PostScript commands to the printer to draw the letters. This means
that you may use any point size you want and not have the letters printed with jagged edges. See also Bit-Map fonts and Outline fonts.
Line editor A type of word processor that allows the user to make changes to the text. The text must then be processed by a formatter to create the desired
output.
Local Area Network Commonly referred to as a LAN, the Local Area Network provides a physical link between several microcomputers, allowing them to
send data to one another and to share devices such as hard disk drives and printers. Most LANs are within a single building or offices. Some, however, are
as large as a college campus.
Logical fields A field in a database that can hold one of two values, true or false.
Macro A series of commands or other typing that is played back by the computer when you press a single key. If the macro consists of commands, the
computer follows the commands as if you were typing them at the keyboard.
Memo field A field in a database that holds large amounts of text but generally cannot be searched or manipulated in the same fashion as character fields.
Microsecond One millionth of a second.
Millisecond One thousandth of a second.
Mother Board The main printed circuit board inside the computer into which most of the parts are inserted.
Mouse The physical device that sits on the top of your desk, attached to the computer and used to move the mouse pointer arrowhead and other cursors on the
Macintosh display.
Nanosecond One billionth of a second.
Nonimpact printer A printer that causes the letters to appear without physically touching a ribbon to the paper, such as a laser printer. See also Impact
printer.
Number crunching Performing a large volume of arithmetic computations.
Numeric Field A field in a database that will hold numbers only.
Object Code The output, or results, of compiling a program. It is an unchangeable version of the program in machine code. If there is an error in the
program, the program's source code must be modified, then compiled again, producing a new version of the object code.
Operating System Utility A program used to help you manage the overall operations of the computer and your information.
Outline fonts A font size that has a bit-map definition. When looking at font size lists on pull down menus, the outline fonts are the desirable ones to use,
since the Macintosh screen is bit-mapped.
Output Computer display or printed results of a computation or other computing process, or sending those results to another computer or internal process for
further action.
Output devices Hardware used by the computer to send information to other computers or to display the information in human rea~ble form.
Pane When you split the main spreadsheet text window into two parts, each part is called a window pane.
Password A word or phrase used to gain access to a computer system.
PC Board Printed Circuit Board.
PROM Programmable Read Only Memory. Once the PROM has been programmed, it may not be changed and acts like a ROM.
Pull Down menu A menu as found on the menu bar at the top of the Macintosh display. By positioning the mouse pointer on the menu name and pressing the
mouse button, the menu will appear to be pulled down from the top of the screen.
RAM See Random Access Memory.
Random Access Memory (RAM) Memory in the computer used to store the program and active data (such as a word processing document or electronic
spreadsheet) while the program is executing. Some programs require more RAM than others.
Range A rectangular group of cells in a spreadsheet that represents a subset of the complete spreadsheet.
Read Only Memory (ROM) Computer memory in which programs are permanently encoded. Programs stored in ROM execute very fast. Only parts of the
computer's operating system are stored in ROM.
Recalculation Recalculation occurs when one or more cells of an electronic spreadsheet is changed. The electronic spreadsheet updates all the values
displayed as a result of a change in the contents of one or more cells. Recalculation may be automatic or manual. The former takes place whenever any
spreadsheet cell is changed. The latter only when the user tells the spreadsheet to recalculate.
Record A collection of fields that completely describe one item in a database.
Relative cell address Applies to electronic spreadsheets. When a cell containing the address of another cell is copied, the copied reference retains the same
relative distance in rows and columns between the copy and the newly referenced cell. See also Absolute cell address.
Replace mode When word processing, existing text is typed over, or replaced, as you type new text.
ROM See Read Only Memory.
Root directory The master directory of a disk. It may contain data flies, programs, and folders.
ScaUng Determining the low and high values of the Y..axis on a chart and the amount of space, both in numeric units and in physical display, to be placed
between the intermediate values displayed on the axis.
Screen Editor A type of word processor, typically of the what you see is what you get genre.
Shift-click To press and release the mouse button while holding down the shift key. Used to select multiple icons or items on the desktop or in some dialog
boxes: See also Double-click, Click and Drag.
Soft sector The type of floppy disk. Only one index hole is punched in a soft sectored disk. See also Hard sector.
Software Sets of instructions for the computer to carry out are called programs. Programs generically are referred to as software.
Sort A method of organizing the records of a database into a fogical sequence based on the information found in one or more fields.
Source code The original, uncompiled list of program statements. The source code is the input to a compiler, which produces object code for the computer
to execute. Source code may also be input into an· interpreter for execution.
Spreadsheet model An interdependent group of spreadsheet cells that perform computations to provide the user with information. The model may be one to
forecast sales or to estimate the impact of a price change on manufacturing costs.
Spreadsheet template A prewritten spreadsheet model that performs a specific task into which you place your own data.
Stand-alone graphic program A program that does no task other than creating graphics.
Stream Editor A program that scans flies for every occurrence of a particular character combination and changes it into another character combination.
Structure See File structure.
Synchronize The two panes of a split spreadsheet window scrolling together.
Systems Software Programs which supervise the overall operation of the computer and how it communicates with the rest of the world.
'Thxt window The portion of the monitor used to 'display the document on which you are working. 'I)'pically, the complete document is larger than the
window.
'Iemplate See Spreadsheet template and Keyboard template.
Throughput The amount of information that is processed by a single computer. The faster the computer works, the more information in can process, the
greater the throughput.
Unsynchronize The two panes of a split spreadsheet window scrolling independent of one another.
User friendly This term is applied to software which behaves the way the novice user expects it to behave without long hours of study of the manuals. It
implies that the software is easy to use, yet still very powerful.
Utility Software Program development aids and hardware/software management aids. Named because they perform utilitarian tasks, such as copying disks,
or unerasing erased flies.
Video recorder See Film recorder.
Volume Thble of Contents (VTOC) Pronounced Vee-Talk. The area of a floppy disk reserved by the Disk Operating System to hold the information about
what is stored on the disk.
V'IOC See Volume Thble of Contents.
What if Term applied to the manipulation of cells of an electronic spreadsheet model to determine the effect of changes on the overall model.
Window See Text Window.
Write-protect Physically modifying a floppy disk so that the computer cannot change or erase the contents of the disk. If the disk is not write-protected, the
contents of the disk may be changed, added to or deleted.
Write-protect tab The small rectangular slide on the side of a disk. If not covering the hole, the disk is write-protected. If the hole is covered, the disk is not
write-protected.
WYSIWYG Stands for "What you see is what you get." A type of word processor in which the way text is displayed on the screen is exactly the way it will be
printed.
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Alarm Clock, 82-85
alert box, 55
Apple menu, 82
Appleshare, 86
application software, 21-22
background printing, 89
bar code, II
BIT. 6, 7
Bit-map toots, 79-80
booting up, 25-26
budgeting, 327-328
Calculator, 86
calendar date, 82
cards. punched, 10
CDEV, 76,91
cell, 326
see also Excel
chart (Excel)
pie, 660-668
single variable, 652-655
stacked bar, 674-677
see also Graph
Chooser, 78, 82, 86-90
Clipboard, 81,105,147-148
close box, 45-47
COBOL, 5
command key, 41-42
compiler, 5, 19, 20
Control Panel, 78, 82, 91-97
Copy command, 81
copying between disks, 61-65
cursor movement (Word), 138-139
Cut command, 81
DA See Desk accessory
data types, 493-495
database
defined,487-488
file structure, 520
space requirements, 520
database management system
command language, 491
file organization, 491-492
menu-driven, 489-490
programming languages, 490-491
spreadsheet, 497
types, 489
uses, 488-489
date, 82
decimal tabs (Word), 244-245
desk accessory, 78, 82
Desktop, 27, 29, 54
moving items on, 36-37
Desktop Pattern, 93-94
desktop publishing (Word), 277
columns, 286-287
toots, 279-284
illustrations, 288-289
new page, 316
page layout, 284-288
photographs, 288-289
planning, 278-279
Position option, 313-315, 319-321
section options, 300-303
development software. 18-19
dialog box, 55
digital plotter, 646
disk, 24-25
backing up, 69-71
copying complete, 69-71
copying to another. 61-65
ejecting, 42
initializing, 54-58
re-initializing, 113-116
removing documents, 71-74
disk drive, 14, 25
disk storage, 14
DOS, 18,25
Duplicate command, 68-69

EDVAC, 4
ENIAC. 3
Erase Disk option, 114-116
Excel
absolute copy. 401-406
adding lines. 433-435
averaging range, 388-390
built-in functions, 407-410
cell, changing, 345-346
cell, copying, 379-385
cell. moving. 435-438
cell. naming, 332
cell edit line, 330
cell location, current, 332-333
chart, column, 652-655
chart, labeling, 656-660
chart, line, 652-655
chart, pie, 660-668
chart, saving in Scrapbook, 677-679
chart, stacked bar, 674-677
closing spreadsheet, 361-362
column, changing width, 447-451
conditional action function, 393-394
Count function, 391
cursor movement, 333-335
database
creating, 498-50 I
Find command, 509-511
Form command, 511-515
selecting records, 504-509
sorting, 501-504
deleting rows or columns, 438-439
Fill command, 379-384
font, changing, 452-454
format, clearing, 429-431
formatting spreadsheet, 421-426
formula cell, 343-346
function macro, 477-478
GOTO command, 333-335, 375-378
graphics, 649
page setup, 680
printing, 679-682
using in Word, 677-679
graphs, legend, 670
graphs, multiline/multibar, 668-674
Help, 364, 409-410
If function, 393-394
inserting blank rows, 431-432
label cells, 341-343
Lookup function, 395-400
macro, 461-462
macro, autoexec, 483-485
macro, creating, 467-471
macro, naming, 471-474
macro sheet, 466-467
macro to print, 474-477
menu bar, adding to, 479-483
menu levels. 331
moving average, 389-390
nesting functions, 406
new worksheet, 358-359
Page Preview. 352
P..tge Setup, 353-355
print area, changing, 355-358
printing spreadsheet, 350-355, 410-411
quitting. 364-365
range. clearing, 392-393
range. creating. 336-338
range, defined, 336
range. defining, 440-447
range. formatting, 426-429
range. named, 339-340, 440-447
recalculation status. 454-457
retrieving spreadsheet, 369-374, 416-418
row, changing height, 452
saving spreadsheet, 347-350
starting, 330-332
status bar, 33 I

Excel (continued)
summing ranges, 386-388
text cells, 341-343
value cell, 343
window, changing, 360-361
window, moving, 375-378
window, splitting, 415-416, 418-421
field (database), 492-495
file (database), 492-495
file menu, 43-44
file server, 9
Filemaker II
Browse mode, 535
Custom menu, 622
data entry, 535-545
data entry screen, modifying, 530-534
Delete Multiple command, 591-594
Delete Record command, 591-594
editing data, 552-554
fields, defining, 521-528
fields, modifying, 587-590
file structure, 520
changing, 528-530
Find command, 579-586
graphics, entering, 537-545
graphics in layout, 605-612
Help, 558-559
If function, 525
indexing, 564-565
layout, changing, 547-552
Layout command, 530-534
layout, creating, 570-574
layout screen, customizing, 597-605
physical order. 545-546
printing file, 554-558
quitting, 560
removing records, 591-594
report layout, 612-621
retrieving file, 565-570
script, creating, 622-626
script, editing, 628-630
script, executing, 627-628
selecting records, 579-586
sorting, 564-565, 575-579
space requirements, 520
starting, 517-519
film recorder, 643
Finder, 18, 25-26, 52
Find File, 82, 97-100
floppy disk, 14-15
folder, 44, 52
copying, 64
creating and naming, 58-60
moving contents, 65-67
Font/DA Mover, 107-113
fonts, 78-80, 100, 279-284
selecting (Word), 132-133
footnotes (Word), 229-236
form letter (Word), 266-274
formula, 326
FOIITRAN, 5
Get Info command, 77, 121
graph
area fill, 637
multiline/muhibar. 636, 668-674
stacked bar. 637
see also chart
graphics
digital plotter, 646
film recorder, 643
in word processing, 263-266
LCD panel, 640
overhead transparency, 644-645
photographs, 641-642
programs, 638-639
slides, 64 I -643
slideshow, 647-648
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Graphics (continued)
types, 633-636
uses, 637
video projection, 640
see also Excel
hard disk, 14, 26
hierarchical/network database, 491-492
Hollerith code, 10
Hypercard
background, 750-751
Browse tool, 687
button, 686
button, copying, 711-719
buuon, creating new, 705-711
buuons, finding, 688-693
card, 685
card, adding graphics, 724-733
card background, 701-703
field, 685
field, creating new, 719-724
Find command, 737-740
Go menu, 694-699
Home card, 688
Home stack, 688
HyperTalk, 686, 740
Link, 705-711
message box, 737-740
quitting, 751
Recent command, 695
script, 686, 740-745
stack, 685
stack, adding new cards, 734-737
stack. creating new, 703-705
stack, moving in, 694-699
stack, printing, 746-750
stack, using, 734-737
starting, 686-687
User Preferences, 688
setting, 699-701
HyperTalk, 686, 740
icon, 27-30
name, changing, 60
opening, 44-45
selecting and deselecting, 32-36
INIT, 76
input, 6, 25
input devices, 9-11
internal clock, 7, 82
interpreter, 19
kerning, 284-285
keyboard, 28, 100-105
Key Caps, 82, 100-105
LAN,9
laser fonts, 79-80
leading, 284-285
light pen, 10-11
local area network, 9
machine code, 19
machine language, 4
macro (spreadsheet), 461-462
see also Excel
mailing list (Word), 266-274
mainframe, 7
margin changes (Word), 189-194
mass storage, 13
memory requirements
changing, 121
menu, 38-40
menu bar, 30, 37
microcomputer, 8
minicomputer, 8
mouse, 28, 30-32
double-clicking, 44-45
dragging, 34-35
tracking speed, 96

Multifinder, 89, 119-121
object code, 20
operating system, 18, 76
purpose, 25
operating system utility, 21
optical scanner, II
output, 6, 25, 86
output devices, 12
overhead transparency, 644-645
paper tape, 10
peripherals, 9
Photo Caption (Word), 312
power, defined, 6-7
printer, 86-90
printer types, 12
printing text (Word), 156-158
programming languages, 18-19
RAM, 7
range (spreadsheet), 336
record (database), 492-495
relational database, 491-492
ROM, 25
scaling, 639
Scrapbook, 82, 105-106
screen designer, 21
screen editor, 126
scroll bar, 52-54, 177-178
server, 9
software, defined, 17
source code, 20
Speaker Volume, 92
spelling verification, 125
spreadsheet
calculation, 329
database, 497
defined, 325-326
macro, 461-462
memory space, 329
uses, 326-327
see also Excel
Startup, 118-119
storage, mass, 13
stream editor, 21
System, 25-26
System File, 78
System Folder, 52, 75-78, 86
systems software, 17-18
tab stops (Word). 241-245
tape, magnetic, 13-14
terminal, 11-12
text editor/formauer, 126-127
thesaurus, 125
title bar, 45-46
trash can, 71-74
typefaces, 279-284
changing (Word), 294-299
UNIVAC, 4
utility software, 21
View menu, 116-118
window, 28, 44, 45
changing size, 49-51
moving, 48-49
Word, 7
Beginning of Line. 179
block, copying, 202, 206-207
block, defining. 198-199
block, deleting. 207-209
block, moving, 200-202, 305-310
block, saving. 202-205
border, 236-240
box, 236-240
centering text. 197-198
Change option, 224-227
Character command, 294-299
closing a document. 158-159

Word (continued)
copying blocks, 202, 206-207
cursor movement, 138-139, 170, 178-180
Cut option, 200-202
defining block, 198-199
deleting blocks, 207-209
deleting text, 144-146
endnotes, 229-236
End of Line, 179
Find option, 184-186, 228
font selection, 132-133
footnotes, 229-236
formlette~266-274

graphics, 263-266
created by Excel, 677-679
hanging indentation, 245-250
headers and footers. 253-256
Help, 161-163
inserting text, 139-142
justification of text, 195-197
line spacing, 194-195
locating text, 184-186
mailing list, 266-274
Margin Set, 154
margins, 134-135
changes, 189-194
menu level, 131
moving blocks, 200-202, 305-310
new document, I 59-160
page break, 250-251
Page Down, 179
Page Number Placement, 154
page numbers, 251-253
Page Up, 179
Page View, 153-156
paragraph spacing, 188-189
Paste option, 201
Photo Caption option, 312
Position option, 313-315, 319-321
print enhancements, 207-209
printing text, 156- I 58
Print Preview, 153-156
quitting, 164-165
reformatting text, 187-188
replacing text, 139-142
restoring deleted text, 146-150
retrieving documents, 171-176
ruler line, 134-137
saving blocks, 202-205
saving text, 150-153
search function, 184-186
section options, 300-303
selecting text, 142-144, 181-183
spell checker, 214-219
starting, 130-132
style sheet, 256-263, 303-304
tab stops, 134-135, 241-245
text scrolling, 170, 176-178
text window, 170
Undo command, 207-209
word wrap, 135-137
zoom, 154
word processing
advantages, 124
cursor, 128-129
fonts, 196
text storage. 128
text window, 128
types of programs. 126
see also Word
word wrap. 135-137
write-protect tab, 25
Zapf Dingbats, 102
zoom box, 45-47

